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Vorbemerkungen des Übersetzers DM3ML

Zur Erzeugung dieser PDF-Datei habe ich mir zuerst das Inhaltsverzeichnis der 
neuen nach dem Wikipedia-System aufgebauten N1MMLogger-Hilfe ausgedruckt 
und dann die einzelnen Kapitel aufgerufen, sie kopiert und nach der Vorlage des 
Inhaltsverzeichnisses zu einem MS-WORD-Dokument zusammengebaut. Dieses ist 
vor allem zur korrekten Realisierung der vielen Links innerhalb des Textes nötig. 
Wenigstens konnte ich damit die Bilder 1:1 übernehmen und musste sie nur in 
Ausnahmefällen getrennt einfügen.
Im Verlauf der letzten vier Monate habe ich mich durch den Text gegraben. 
Anfängliche Hoffnungen, ich könnte von den schon gemachten Übersetzungen der 
N1MM-Hilfe eine Menge übernehmen, haben sich schnell zerschlagen. Es blieb mir 
nichts anderes übrig, als alles einzeln zu übersetzen. 
Die gesamte Hilfe-Datei habe ich dann jeweils in Open Office 3.1 eingelesen und 
damit eine PDF-Datei erzeugt. Open Office macht das im Gegensatz zu anderen 
Programmen kostenlos und ohne Randbemerkungen, belegt dann aber eine Weile 
voll meinen Rechner. Die Umwandlung in eine PDF-Datei stellt sicher, dass alle 
Bilder übernommen werden und jeder, der einen PDF-Leser hat, die Hilfe auch lesen 
kann. Er ist nicht auf Microsoft angewiesen.
Einen Nachteil hat die PDF-Umwandlung mit Open Office: Die Links innerhalb des 
Dokuments funktionieren nur bis zu den Überschriften 1. und 2.Ordnung. Wenn Sie 
bei einem Link aus dem Inhaltsverzeichnis wieder im Inhaltsverzeichnis landen, ist 
nicht MS-WORD, sondern Open Office und sein PDF-Konverter daran schuld. 
Die einzelnen Übersetzungsschritte habe ich ab 120 übersetzten deutschen Seiten 
jeweils auf der Seite mit meinen Übersetzungen (siehe www.mydarc.de/dm3ml) mit 
dem Hinweis xxx in Deutsch und yyy in Englisch als Zwischenstand angeboten.

Bitte beachten: 
Das große Kapitel mit den vielen Contesten habe ich NICHT übersetzt. Der Text ist 
auch in englisch halbwegs verständlich, die Zahl der Conteste ist gewaltig und nur 
wenige sind allgemein interessant. Wenn jemand die Übersetzung einer konkreten
Contestbeschreibung braucht, bitte ich ihn um eine Email. Ich baue dann diese 
Übersetzung nachträglich in die N1MM-Hilfe ein. 

Wie üblich entschuldige ich mich für alle Übersetzungs- und Tippfehler und bitte um 
Hinweise zur Fehlerbeseitigung. Bei der N1MM-Hilfe habe ich wegen des 
Sprachgemischs auf eine Rechtschreibprüfung verzichtet. 
Ebenfalls üblich ist der Hinweis, dass ich für durch meine Übersetzung 
hervorgerufene Schäden an Leib und Seele des Operators und seiner Geräte keine 
Haftung übernehme.
Ich untersage ausdrücklich die kostenpflichtige Weiterverbreitung dieser 
Übersetzung. Sie kann aber – mit Quellenangabe – kostenlos weiter gegeben 
werden.

Eike, DM3ML, aus Dresden in Sachsen 

Meine Emailadresse finden Sie unter http://www.dm3ml.de

April 2010

11.04.2010

http://www.mydarc.de/dm3ml
http://www.mydarc.de/dm3ml
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Überblick und Installation (Overview and 
Installation)

Schnelldurchlauf (Quick Tour) (unbedingt lesen!) 

10 Schritte zum erfolgreichen Loggen (Ten Easy Steps to Successful 
Logging)

Schritt 1: Einstellen ( Step 1. Setup)

 

Stellen Sie Verbindungen zum Transceiver und zum Packet- oder Telnet-DXCluster 
her (Tools/Configure). Sie werden beeindruckt sein, was passiert, wenn ein Spot vom 
DXCluster einläuft.  Ohne eine CAT-Steuerung und eine Verbindung zu einem 
DXCluster wird Sie das Programm enttäuschen.

Schritt 2: Fenster anordnen (Step 2. Adjust Window Positions)

Ziehen Sie die Fenster an die gewünschte Stelle und korrigieren Sie ihre Größe. 
Öffnen Sie – falls nötig – die Fenster nacheinander über das 'Window' - Menü. 
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Schritt 3: Soundkarte und CW-Interface anschließen (Step 3. Connect the 
Sound Card and the CW interface)

Verbinden Sie die Soundkarte mit Ihrem Transceiver, um Sprachdateien  (*.wav) 
abspielen oder Verbindungen aufzeichnen zu können. Stecken Sie die CW-Tastung 
an die serielle, eine parallele oder eine USB-Schnittstelle. Siehe Kapitel Interface 
(interface section ) für Möglichkeiten. 

Schritt 4: Rufzeicheneingabe (Step 4. Entering a Call)

 

Jetzt kann’s mit dem Log losgehen. Voreingestellt ist das General log  (DX) wie im 
Bild gezeigt. Wollen Sie ein QSO loggen? Geben Sie das Rufzeichen in das 
Eingabefenster (Entry Window) ein, z.B. N1MM. Beobachten Sie das Prüf-Fenster 
(Check window ). Ab 2 Zeichen - hier N1- bekommen Sie eine Liste mit – aus 
Contesten - bekannten Rufzeichen. Sie können N1MM in dieser Liste anklicken und 
es wird in das Rufzeichenfeld übernommen. In die RS(T)-Felder wird eine 
Voreinstellung (59/599) eingetragen und der Cursor steht im Namensfeld.

Schritt 5: Weiterschalten mit der Leertaste (Step 5. Using the Space Bar 
to Tab)

Es geht auch anders. Klicken Sie auf die Löschtaste (Wipe) und löschen Sie den 
aktuellen Eintrag. Der Cursor steht wieder im Rufzeichenfeld. Geben Sie N1MM ein 
und drücken Sie auf die Leertaste. Die RST-Felder werden wieder automatisch 
gefüllt und der Cursor steht im Namensfeld. Geben Sie Tom ein. Wenn Sie wieder 
die Leertaste drücken, bleiben Sie ausnahmsweise weiter im Namensfeld, denn ein 
Name kann auch Leerzeichen zur Trennung enthalten. Bei den anderen Feldern 
kommen Sie mit der Leertaste in das nächste Feld. Diese Funktion ist bei Contesten 
sehr nützlich.

Schritt 6: TAB-Taste verwenden (Step 6. Using the Tab Key)

Mit der TAB-(Tabulator)-Taste kommen Sie ohne Einschränkung vorwärts und mit 
gedrückter Shift-Taste rückwärts von Feld zu Feld und erreichen auch die 
voreingestellten RST-Felder, wenn Sie hier etwas ändern wollen.
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Schritt 7: Bandskalen, DXSpots und sonstiges (Step 7. Bandmaps, Spots 
and Other Cool Stuff)

 

Wenn Sie die CAT-Steuerung Ihres Transceivers richtig angeschlossen haben, 
sehen Sie zwei Bandskalen (Bandmaps) mit den an den VFOs A und B eingestellten 
Frequenzen und Sendearten. In diese Skalen wollen wir jetzt DX-Meldungen holen 
und benötigen dazu eine Verbindung zu einem DX-Cluster über Packet oder das 
Internet. Klicken Sie im Menü Windows auf den Eintrag Packet. Das Packet-Fenster 
hat je eine Karteikarte für eine Packet- oder eine Telnet-Verbindung. Ist Ihr TNC 
richtig angeschlossen und konfiguriert, klicken Sie auf die Packet-Karte und geben in 
das einzeilige Eingabefenster neben den Reiter ein ‚C DB0MDX’ (oder ‚c db0mdx 
db0dsd’). Im Fenster darunter können Sie die Verbindungsaufnahme verfolgen. 
Klicken Sie nach erfolgreichem Connect zum DX-Cluster auf die Taste SH/DX. 
Voreingestellt auf dieser Taste ist ‚sh/dx/30’, voreingestellt ist auch die Verfallszeit 
der Meldungen auf 60min.
Für einen Telnet-Connect muss Ihr Rechner im Internet eingeloggt sein. Der 
gewünschte Server wird bei der Konfigurierung eingestellt, über das Menü rechts 
oben angewählt und mit einem Klick auf die Taste CONN gerufen. Sie können es 
auch mal mit sh/dx/100 probieren. Wenn Sie nicht alle 100 Spots sehen, liegt das 
daran, dass die Verfallszeit von 60 Minuten schon abgelaufen ist.

Schritt 8: DXSpots auswerten (Step 8. Spots are Fun)
Bei den DX-Spots in den Bandskalen stehen Gradangaben. Sie geben die 
Antennenrichtung korrekt an,  wenn Sie unter Configure > Change Your Station Data 
die Koordinaten Ihres Standorts richtig eingetragen haben. Klicken Sie einmal auf 
eine DX-Clustermeldung in der Bandskala. Das Rufzeichen erscheint über dem 
Rufzeichenfeld im Eingabefenster und wird mit der Leertaste in dieses Feld 
übernommen. Leeren Sie das Rufzeichenfeld mit Wipe, drehen Sie die Abstimmung 
am Transceiver hin und her. Wenn Sie dem Spot auf 300 Hz nahe kommen, wird das 
Rufzeichen wieder über das Rufzeichenfeld übernommen. Mit der Leetaste wird es 
wieder eingetragen. Löschen Sie es wieder und klicken Sie jetzt zweimal auf eine 
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Clustermeldung, der Transceiver wird auf die gemeldete Frequenz gestellt und das 
Rufzeichen sofort ins Rufzeichenfeld eingetragen. Bestätigen Sie es mit der 
Leertaste, werden die voreingestellten Rapporte eingetragen und der Cursor steht im 
Namensfeld. 
Mit den Tasten CTRL-UP und CTRL-DOWN können Sie von Spot zu Spot schalten, 
und mit den AUF (UP)- und RUNTER (DOWN)- Tasten ohne CTRL (Strg) können Sie 
die Frequenz am Transceiver um 100 Hz (in SSB) oder 20 Hz (in CW) ändern 
(einstellbar). Es gibt noch mehr Möglichkeiten, gehen Sie zu Tastenzuordnungen in 
den Kapiteln Tastenkurzliste  (Key Assignments Short List   ) und   
(Tastenzuordnungen (Key Assignments). 

Schritt 9: QSO speichern (Step 9. Actually Logging Contacts)
Sie haben Rufzeichen und Name ins Logeingabefenster eingetragen. Drücken Sie 
jetzt auf ENTER, das QSO wird abgespeichert und erscheint zu Kontrolle im 
Logfenster.
Wenn Sie jetzt das gleiche Rufzeichen erneut im Logeingabefenster eingeben, 
passiert etwas : Das QSO von zuvor erscheint im bisher leeren unteren Teil des 
Logfensters und ein dickes DUPE ist im rechten Teil des Logeingabefensters zu 
sehen. DUPE heißt DOPPELT und ist wichtig für Conteste, bei denen Doppel-QSOs 
ein Fehler sind. Haben Sie das QSO trotzdem abgespeichert, können Sie mit einem 
Rechtsklick auf das QSO im Logfenster „Delete contact“ (QSO löschen) wählen.

Schritt 10: Finale (Step 10. The Exciting Finale)
Hören wir lieber hier beim Schnelldurchgang auf. N1MMLogger ist ein umfangreiches 
Programm mit sehr vielen Möglichkeiten. Sie können eine Menge an Einstellungen, 
Anpassungen, Zuweisungen machen, Sendearten wählen, Conteste vorbereiten und 
Punktzahlen ausrechnen oder auch die neuesten Länder, Sektionen und Koordinaten 
eintragen. Lesen Sie dieses Handbuch in Ruhe und spielen Sie die Möglichkeiten 
durch.
Halten Sie sich vor allem an die Werkzeuge, lernen Sie, wie Sie die Punktzahl neu 
berechnen (rescore), sehen Sie sich die Statistiken an und, holen Sie sich die 
neueste Länderliste CTY.DAT oder stellen Sie Ihre persönliche Konfiguration ein.

Schritte 11: CW und WAV-Aufzeichnungen (Step 11. CW and WAV 
Recordings)

Hallo, ich habe noch etwas vergessen, deswegen dieser Schritt 11: Mit einem CW-
Interface können Sie die F-Tasten mit vorzüglichem CW nutzen, die auch dann 
laufen, wenn Sie inzwischen etwas anderes in einem anderen Fenster machen. Die 
gleichen Tasten können Sie in einem SSB-Contest dazu benutzen, getrennt 
vorbereitete WAV-Dateien z.B. zum CQ-rufen zu starten. Hier gelten die gleichen 
technischen Regeln für das Interface zwischen Soundkarte und Transceiver wie für 
Sendearten wie PSK und RTTY. Sie können auch die NF Ihres Transceivers für eine 
spätere Kontrolle aufzeichnen. Informieren Sie sich unter Interfacing, wie Transceiver 
und Computer aneinander angepasst werden müssen.

Last Modification: 05 October 2009 06:51:06 EDT by n4zr. 
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Überblick und Einführung (Overview and Introduction)

 

Das Programm N1MMLogger ist ein kostenloses Programm (Freeware)  und in 
erster Linie für das Loggen von Contesten und Dxpedtionen gedacht. Es ist kein 
generelles Logprogramm mit der Suche nach bestätigten QSOs für Diplome u.ä. 
Sehen Sie sich die Eigenschaften ( Features ) an.

 Sind Sie ein neuer Nutzer? 

Lesen Sie zuerst den Schnelldurchlauf und informieren Sie sich dann vor allem über 
die Tastenzuordnung. Gehen Sie dann zu den unterstützten Contesten und suchen 
Sie Ihren Transceiver in dem Kapitel zu den unterstützen Transceivern. 

Sie können den N1MMLogger unter Windows 98/ME/NT/2000/XP/Vista und 
Windows 7 verwenden. DOS und Windows 95 werden nicht mehr unterstützt.  

1. N1MMLogger-Diskussionsgruppen (N1MM Logger Discussion Groups)

In diesen Gruppen werden die Eigenschaften, die Programmprobleme und die Ideen 
für den N1MM Free Contest Logger diskutiert. 

• General group: Mitteilungen zum generellen Programmgebrauch 
(einschließlich der CW- und SSB-Conteste) werden in der General Group  
diskutiert.

• Digital group: Mitteilungen für spezielle Digimode-Probleme (einschließlich 
der digitalen Conteste) werden in der Digital Group   diskutiert. 
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Generell sollten die Mitteilungen nicht über Kreuz gepostet werden, um keine 
Verwirrungen zu erzeugen und sowohl Nutzer als auch Entwickler anzuregen, Ihre 
Meinungen an der richtigen Stelle mitzuteilen. Auf der Empfängerseite bei N1MM 
werden die Mitteilungen auch wenn Sie in der falschen Gruppe gelandet sind, den 
richtigen Sammelordnern zugefügt.

Das Entwicklungsteam verfolgt beide Foren und antwortet im zugehörigen Forum. 
Schreiben Sie sich in dem Sie interessierenden Forum ein.

  Digital Operator 

Die digitalen OPs sollten sich sowohl in der General Group als auch in der Digital 
Group einschreiben, auch wenn sie nicht an CW und SSB interessiert sind, denn es 
gibt eine Menge an interessanten Mitteilungen, die beide Gruppen betreffen. Diese 
Adressen sind interessant:
 

General program issues Digital program issues 
(einschl. CW- und SSB-Conteste) (einschl. digitale Conteste) 

Post message
(Postadresse) N1MMLogger@yahoogroups.com N1MMLogger-

Digital@yahoogroups.com 
Subscribe
(Einschreiben)

N1MMLogger-
subscribe@yahoogroups.com

N1MMLogger-Digital-
subscribe@yahoogroups.com 

Unsubscribe
(Austreten)

N1MMLogger-
unsubscribe@yahoogroups.com

N1MMLogger-Digital-
unsubscribe@yahoogroups.com 

List owner
(Listenbesitzer)

N1MMLogger-
owner@yahoogroups.com

N1MMLogger-Digital-
owner@yahoogroups.com

2. Dokumentation (Documentation)

Die Dokumentation ist in zwei Varianten abrufbar: 

• Im Internet unter N1MM Logger wiki website, wählen Sie dort unter 'Help 
files' den Punkt 'View Help files'. 

• Als PDF-Datei N1MMLogger.pdf ab Version 3 lesbar mit dem Adobe Acrobat 
Reader 

Sie können zu der PDF-Datei aus dem Programm heraus zugreifen. Speichern Sie 
die PDF-Datei im N1MM-Verzeichnis. 

3. Programmspezifikationen (Programming Specifics)

Das Programm sollte unter Minimalanforderungen unter alles aktuellen Versionen 
von Windows laufen (siehe Kapitel PC-Anforderungen (PC Requirements) zu 
Einzelheiten) : 

• Geschrieben in Visual Basic 6.0 ohne aftermarket controls. 
• Verwendet eine freie DLL für die Steuerung der LPT-Schnittstelle und eine für 

CRC32. 
• Die Datenbank verwendet Access 2000. 
• Verwendet MMTTY für Soundcard-RTTY (FSK und AFSK). 
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• Verwendet MMVARI für Soundcard-PSK (PSK31, PSK63 und die anderen 
MMVARI-Modi). 

4. Programmentwicklung (Program Development)

N2AMG, PA1M und ich (N1MM) entwickeln das Programm. Es ist ein kooperatives 
Unternehmen. Falls Sie Programmier-Fan sind, können Sie gern mitmachen. Sie 
sollten Ihre eigene Kopie von Visual Basic 6.0 PE oder EE haben. Eine Kopie von 
Access 2000 ist hilfreich, aber nicht unbedingt nötig. Der Quellcode wird an 
Interessenten weitergegeben, die an der Entwicklung des Projekts mitarbeiten 
wollen.  

Last Modification: 18 December 2009 20:30:23 EST by K8UT. 

Eigenschaften von N1MMLogger (N1MM Logger Features)

 

• Es werden alle großen HF-Conteste einschließlich von generellem DX- 
Loggen, DXPeditionen, DXSatellit und VHF/UHF-Conteste unterstützt.

• Mit der Soundkarte können Sie WAV-Dateien einkoppeln und über ein DVK-
Interface z.B. von W9XT wiedergeben.

• Automatische CW-Tastung 
• RTTY mit MMTTY  ,   PSK31 mit MMVARI und Digimodes mit externen TNCs 

wie HAL DXP38, PK-232 und anderen 
• Das Programm speichert die Größe und Position der Fenster - wie vom Nutzer 

vorgegeben – ab. 
• Die Hauptfenster (Logeingabefenster), Log, Bandskalen  ,   Packet, Prüfen 

(Check), verfügbare Multis und QSOs (Available Mults and Q's  )   und das 
digitale Interface sind nicht-modal, d.h, sie können in diesen Fenstern 
arbeiten, ohne das Fenster, in dem sie vorher waren, schließen zu müssen. 

• Das Angebots-Fenster für verfügbare Multis und QSOs (Available Window) 
zeigt anhand der einlaufenden DXSpots die auf den einzelnen Bändern 
angebotenen neuen Stationen und Multis an und hilft damit bei der Planung 
eines Bandwechsels. Farbige Tasten zeigen, auf welchem Band der aktuelle 
Kontakt benötigt wird. 
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• Klicken Sie auf eine DXCluster-Meldung im Packet-Fenster (Packet), um den 
Transceiver auf diese Station nach Frequenz und Sendeart zu setzen. 

• Über das CAT-Interface werden Transceiver von Kenwood, Yaesu (z.B.: FT-
1000, FT-1000MP, FT-990, FT-920 und andere), Icom und Elecraft gesteuert. 
Siehe  unterstützte Transceiver (Support Radios)

• Gemeldete Stationen erscheinen im Logeingabefenster über dem 
Rufzeichenfenster, wenn Sie in die Nähe dieser Station abstimmen. Mit einem 
Klick auf die Leertaste wird das Rufzeichen in das Rufzeichenfeld 
übernommen. 

• Sendearten-abhängige Feinverstimmung über die Tastatur 
• Automatische Berechnung der Antennenrichtung und des Sonnenauf- und 

untergangs bei der Gegenstation
• Rufzeichenprüfung (Check partia  l  ) 
• Packet & Telnet-Unterstützung   – die Meldungen aus beiden Quellen 

erscheinen automatisch aufgefrischt in den Bandskalen 
• Filterung der DXSpots möglich 
• Geben von CW über die Tastatur ist möglich 
• Unterstützung von zwei Transceivern (SO2R) oder von zwei VFOs eines 

Transceivers 
• Multiplikator-Fenster  
• LPT  -Schnittstelle   zur Steuerung von Antennenwahlschalter, Transceiver-

Auswahl und PTT (Win95/98/ME/NT/2000/XP) 
• Multi-  Nutzer-Betrieb   
• Export von Cabrillo-Logs 
• Export/Import von ADIF-Logs 
• Alle Daten werden in einer Access 2000 Datenbasis abgelegt und stehen für 

die weitere Verarbeitung und zur Integration mit anderen Programmen bereit 
• Betrieb mit zwei Monitoren möglich (ab Win98 aufwärts)
• Aufzeichnung der TCVR-NF als WAV-Datei. Wiedergabe nach Rechtsklick auf 

den Logeintrag. 
• Aussteuerungsanzeige für die Aufzeichnung 
• Stapelspeicher für S&P-Betrieb 
• Stapelspeicher für Rufzeichen 
• Anzeige der S&P-Rufzeichen lokal in der Bandskala (Rufzeichen werden nach 

Frequenzwechsel gelöscht) 
• Alle HF-Bänder einschließlich 60m und VHF-Bänder bis ins GHz-Gebiet 

werden unterstützt 
• Unterstützung von Transverter-Betrieb (SHF-Bänder bis10, 24, 47, 76, 142 

und 241 GHz) 
• Unterstützung des Winkey von K1EL 
• Antennenumschaltung   per Programm
• SO2R/SO2V  -Unterstützung    einschließlich der Soundkarten 
• Nutzer-editierbare Bandpläne für CW, SSB und Digimodes 
• Statisti  k   für verschiedene Auswertungen
• Erzeugung von CW über einen Seriell-USB-Konverter 
• Seriennummererzeugung für Multi-Multi-Stationen 
• Rotor-Steuerung   (N1MM Rotor, LP-Rotor oder ARSWIN) 
• Grayline  -Programm   
• Multi-Nutzer: automatische Resynchronisierung und Wiederverbindung 
• Serial-Nummer-Server für SO2R & Multi-Nutzer- koordiniert die 

Seriennummern für die einzelnen Transceiver 
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• Log-Austausch, kann Logs wiederherstellen 
• Unterstützung der microHAM-SO2R-Protokolls 
• Bringt das Programm in der Vordergrund, wenn der VFO abgestimmt wird 
• Dxpedition-Modus 
• … und vieles andere 

Last Modification: 22 September 2009 16:16:44 EDT by K8UT. 

Anforderungen an den PC (PC Requirements)

1. Minimale Hardware-Anforderungen (Minimum Hardware 
Requirements)

Das Logprogramm ist so entworfen, dass es schon mit einer minimalen Konfiguration 
arbeiten kann. Es gibt allerdings bei den verschiedenen Windows-Versionen 
unterschiedliche Anforderungen in Bezug auf den CPU-Takt und den 
Speicherbedarf. Sie werden unter u.U. Probleme mit der Leistungsfähigkeit bei 
Rechnern mit niedriger Taktfrequenz beim CW- und RTTY-Betrieb feststellen, vor 
allem dann, wenn gleichzeitig mehrere DXCluster-Meldungen einlaufen oder der 
Rechner andere Programm zu bedienen hat. N1MMLogger muss nicht unbedingt auf 
der letzten Schrottkiste laufen.

Als minimale graphische Auflösung werden 1024 x 768 Bildpunkte vorausgesetzt. 
N1MM Logger läuft auch noch mit 800 x 600 Bildpunkten, der Platz reicht dann aber 
nicht für alle benötigten Fenster. Für die CAT-Steuerung, die CW-Tastung und die 
PTT wird eine freie COM-Schnittstelle benötigt. Für CW sollte aber ein Winkey-
Interface vorgesehen werden. Für die Tastung von MMTTY wird eine zusätzliche 
COM-Schnittstelle benötigt.  

USB-Seriell-Konverter und Geräte mit einem USB-Interface werden über virtuelle 
COM-Schnittstellen gesteuert. Die SO2R-Steuergeräte werden meist über eine LPT-
Schnittstelle gesteuert. Alternativ dazu werden die SO2R-Steuergeräte von 
microHAM und K1XM von N1MMLogger unterstützt. LPT-USB-Konverter können 
unter N1MMLogger NICHT verwendet werden.

Sie finden nähere Informationen mit Interface-Kapitel (Interfacing). 

2. Unterstützte Betriebssysteme (Supported Operating Systems)

• Windows 98 
• Windows ME 
• Windows NT 
• Windows 2000 
• Windows XP 
• Windows Vista 
• Windows 7 
• und möglicherweise weitere Windows-Versionen 

Linux und andere Betriebssysteme werden NICHT unterstützt. 
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Last Modification: 01 January 2010 15:38:59 EST by n4zr. 

N1MMLogger installieren und aktualisieren (Installing and 
Upgrading N1MM Logger)

1. Instruktionen zur Erst-Installation (First-Time Installation 
Instructions)

Hollen Sie sich den Full Installer hier  . Starten Sie die Datei Full Installer:

 

Nach einiger Vorrede können Sie wählen, welche Teile des Programms 
N1MMLogger installiert werden sollen: 
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Falls Sie keinen Grund haben, Teilprogramme abzulehnen, lassen Sie die Auswahl 
wie vorgegeben. Wichtig sind die DLPORTIO-Treiber für die für CW, PTT und SO2R 
benötigten Schnittstellen.  

 Installation unter Vista oder Windows 7 
N1MMLogger unterstützt nur die 32-Bit-Versionen von Vista und Windows 7. Falls 
Sie N1MMLogger unter Windows Vista oder Windows 7 installieren wollen, müssen 
Sie einige spezielle Schritte beachten, da N1MMLogger voreingestellt in das 
Programmverzeichnis schreibt. Sie haben drei Möglichkeiten:

• Starten Sie das Programm Full Installer, den N1MMLogger und alle 
Programme zur Aktualisierung immer zuerst als Administrator. Falls Sie der 
einzige Nutzer Ihres Rechners sind und Sie keine anderen Nutzer eingerichtet 
haben, sind Sie als Administrator voreingestellt. Falls Sie individuelle Nutzer 
eingerichtet haben, klicken Sie rechts auf das Programm-Icon und wählen Sie 
„Starten als Administrator“. Haben Sie die Aktualisierung abgeschlossen, 
können Sie in Zukunft den N1MMLogger als einfacher Nutzer starten. 

• Loggen Sie sich als Administrator immer dann ein, wenn Sie N1MMLogger 
installieren oder starten wollen. Hat Ihr PC beim Start kein Icon für einen 
ADMINISTRATOR im Angebot, müssen Sie sich einen Administrator-Account 
einrichten. Gehen Sie so vor: 

o Gehen Sie zur Kommandoeingabe über das Startmenü und geben Sie 
‘cmd’ ein. Drücken Sie dann Ctrl+Shift+Enter oder klicken Sie auf die 
Start-Kugel, wählen Sie Alle Programme > Zubehör, klicken Sie rechts 
auf das Command Prompt und wählen Sie ‘Starten als Administrator’. 
Tragen Sie in das Feld ein: net user administrator /active:yes. 
Fahren Sie den Rechner herunter, starten sie ihn wieder und loggen 
Sie sich als Administrator ein. Sie sollten dem Administrator zur 
Sicherheit ein Passwort zuteilen.
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• Schalten Sie die Betriebssystemeigenschaft, die normalerweise verhindert, 
dass im den Programmbereich geschrieben werden kann, ab. Sie heißt User 
Access Control (UAC)(deutsch:Benutzerkontensteuerung). Eine Dauer-
Abschaltung ist nicht zu empfehlen.

Hinweis DM3ML: LOGGER32 empfiehlt aus diesem Grund, das Programm nicht im 
Verzeichnis PROGRAMME, sondern in einem eigenen Verzeichnis z.B. 
C:\LOGGER32 zu installieren. 

 

• Wenn Sie auf die Taste Install klicken, wird der Full Installer 
o Alle benötigten Dateien für den N1MMLogger auf Ihrem Rechner 

installieren 
o Systemdateien aktualisieren, wo dieses benötigt wird 

 Do Not Overwrite Newer System Files  (keine neueren Systemdateien 
überschreiben)
Bei der Installation wird Ihr Computer melden, dass die zu installierenden Dateien 
bereits vorhanden und neuer als die zu installierenden sind. Beantworten Sie die 
Frage, ob sie überschrieben werden sollen, mit NEIN. 

Nach der Installation werden Sie getrennt gefragt, ob DLPORTIO installiert werden 
soll. Folgen Sie den unten stehenden Instruktionen: 
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Zuerst werden Sie gefragt, ob die neueste Version installiert werden soll. 

 

Klicken Sie auf die Taste Download und holen Sie sich die neueste Version.  Starten 
Sie dann diese Version. Sie installiert die neueste Version. Sie brauchen ungefähr 2 
Minuten für diesen Schritt.

Hat der Computer, auf dem Sie den N1MMLogger installieren keine Verbindung zum 
Internet, müssen Sie sich diese Version mit einem Internetcomputer getrennt holen, 
diese Datei auf Ihren PC kopieren und hier starten. Sie finden nähere Angaben im 
Abschnitt Zusätzliche Installations-Hinweise. 
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2. Erst-Start (Using the Program the First Time)

• Stellen Sie als Erstes Ihre Stationsdaten ein: 
o Beim Erststart sollte N1MMLogger in dem Stationsdialog starten
o oder öffnen Sie das Menü Config > Change Your Station data 

• Konfigurieren Sie danach die Schnittstellen für die CAT-Steuerung und den 
Zugriff zu einem DXCluster über Packet oder Telnet (Internet) mit  

o Config >Configure ports, Telnet Address, Other 
• Sie können die Tasten im Packet-Fenster Ihren Wünschen anpassen
• Mit Alt+H kommen Sie zur (englischen) Hilfe 
• Mit der Leertaste schalten Sie bevorzugt zwischen den Felder im 

Logeingabefenster durch  
• Lesen Sie das Kapitel Schnelldurchlauf (Quick Start Guide) 
• Lesen Sie in diesem Handbuch vorzugsweise die Kapitel  

o Schnellstart (  Quick Tour  ) 
o Programm einstellen (Setting up the Program) 
o Eingabefenster (Entry Window) 
o Tastenzuordnung (Key Assignments) 
o Grundfunktionen (Basic Functions) 
o Tastenzuordnungs-Kurzliste (Key Assignments Short List) 

 Drucken Sie sich diese Liste griffbereit aus! 

3. Zusätzliche Installations-Hinweise / Programm aktualisieren 
(Subsequent Install Instructions / Upgrading to a New Program 
Version)

Sie bekommen als Mitglied einer N1MM-Gruppe regelmäßig eine Email mit der 
Ankündigung einer neuen Version.  

  Bezeichnungen der N1MM-Dateien
 
Das Voll-Installationsprogramm heißt N1MM-Fullinstaller.exe. Aktualisierungen 
heißen N1MM-newexe mit einem Suffix mit dem dazu gehörenden Datum. Die 
aktuelle Version des Full Installer enthält ebenfalls eine Datumsangabe und ersetzt 
die jeweils ältere Version.  

• Holen Sie sich die jeweils neueste Version der Aktualisierungsdatei 
newexeVx.x.xxx, z.B.N1MM-newexeV9.12.0.exe. Die Bezeichnung steht für 
die erste Aktualisierungsdatei des Dezembers 2009. Sie kommen zu dieser 
Datei über die Email der Yahoo-Gruppe  oder diese Internetseite (this web 
page). Wählen Sie dort die gewünschte Aktualisierung:

o Hier finden Sie die neuesten Exe-Dateien und andere benötigte 
Dateien 

o Öffnen Sie diese Dateien und kopieren Sie diese in das N1MMLogger-
Verzeichnis über die älteren Dateien. 

o Wird im Programmverzeichnis eine neue Datei cty.dat angeboten, 
wählen Sie das Menü Tools >Import country list from downloaded 
file 

o Sie finden die Versions-Nummer Vx.x.x im Namen der Datei 
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o Es reicht, wenn Sie die jeweils neueste Aktualisierungsdatei 
installieren. Die älteren Aktualisierungdateien können Sie übergehen.  

  Aktualisierungsphilosphie 
 
Viele von uns haben sich angewöhnt, immer mindestens eine Version im Rückstand 
zu bleiben, um möglichen Fehlern der neuen Version aus dem Weg zu gehen. Da 
N1MMLogger aber relativ oft - bis zu 50 Mal im Jahr - aktualisiert wird, ist das 
Gegenteil der Fall. Nutzen Sie jeweils die neueste Version. Hier sind 
Fehlermeldungen und Verbesserungen realisiert und ausreichend getestet worden. 
Machen Sie Fehlermeldungen nur, wenn Sie sicher sind, die neueste Version 
installiert zu haben.

4. Programm de-installieren (Uninstalling the Program)

• Zur De-Installation von N1MMLogger gehen Sie so vor: 
o Gehen Sie zur Windows-Systemsteuerung > Software, suchen Sie in 

der Tabelle N1MMLogger und wählen Sie „Entfernen“.  
o Entfernen Sie anschließend das N1MMLogger-Verzeichnis mit allen 

restlichen Dateien (meist c:\Program Files\N1MM Logger)  

Last Modification: 19 December 2009 20:40:45 EST by n2ic. 

Programm einrichten (Setting up the Program)

Wenn Sie das Programm nutzen wollen, sollten Sie sich über den Anschluss des/der 
Transceiver, des Packetclusters, der Telnetverbindung und auch der Konfigurierung 
des aktuellen Contest informieren. Die folgenden Abschnitte zeigen die benötigten 
Einstellungen. Gehen Sie dann zu den Kapiteln Grundfunktionen (Basic Functions), 
Tastenzuordnungen (Key Assignments) und dem Schnelldurchlauf (Quick Tour), 
um die ersten Tests machen zu können.  

  The Configurer 
Das Wort Configurer kommt in diesem Dokument öfter vor. Sie erreichen den 
Configurer über Config >Configure Ports, Telnet Address, Other 

1. Stationsdaten einstellen (Setup Station Information)

Gehen Sie zu Config > Change Your Station Data. Geben Sie Ihr Rufzeichen ein. 
Viele der Felder werden für Contest-Daten benötigt. Voreingestellt sind die Daten für 
N1MM. Ersetzen Sie diese Daten durch Ihre eigenen Werte. Wichtig ist die korrekte 
Angabe der Stationskoordinaten für die Berechnung der Antennenrichtung und der 
Entfernung. Die Email-Adresse kann für eine Fehlermeldung verwendet werden.

2. CAT-Steuerung einstellen (Setup Radio Control)

N1MMLogger geht erst so richtig, wenn ein Transceiver über die CAT-Steuerung 
angeschlossen ist. Gehen Sie so vor: 
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• Prüfen Sie im Kapitel Unterstützte Transceiver (Supported Radios), ob Ihr 
Transceiver unterstützt wird 

• Wird er unterstützt 
o Verbinden Sie den Transceiver mit Ihrem Computer. Mitunter reicht ein 

serielles Kabel, meist wird aber ein zusätzliches Interface benötigt 
o Gehen Sie im  Configurer zum Menü Hardware 
o Wählen Sie die serielle Schnittstelle, an die der Transceiver 

angeschlossen ist und stellen Sie für diese Schnittstelle die Parameter 
(Baudrate, Datenformat und Protokoll) mit der Taste Set ein 

o Übernehmen Sie diese Daten mit einem Klick auf die Taste  OK. 
 Sie finden die einzustellenden Werte im Handbuch Ihres 

Transceivers (jeweils Schnittstelle UND Transceiver auf die 
gleichen Werte einstellen!)

 Weitere Informationen finden Sie im Kapitel Unterstützte 
Transceiver (Supported Radios). 

o Wählen Sie den VFO A und prüfen Sie, ob die am Transceiver 
eingestellte Frequenz in der zum VFO A gehörenden Bandskala 
angezeigt wird. 

3. Einstellung Packet/Telnet (Setup Packet/Telnet)

Sie benötigen eine Verbindung zu einem DX-Cluster, um die Bandskalen mit DX-
Meldungen zu füllen. Stellen Sie eine Verbindung über Packet oder Telnet zu einem 
DXCluster über die Karteikarte  Configurer >Hardware her. Für Telnet benötigen 
Sie einen Internetzugang. Wählen Sie unter Configurer >Hardware einen Telnet-
DXCluster aus: 

• Gehen Sie zu  Configurer >Hardware 
• Wählen Sie unten einen Telnet-DXCluster. Voreingestellt ist AB5K. 
• Schließen Sie den Configurer und öffnen Sie das über Window 

>Packet/Telnet >Telnet das Packet-Fenster. 
o Sie können in der Zeile Type: Kommandos eingeben. Die Antwort des 

DXClusters erscheint im Textfenster 
o Informieren Sie sich im Kapitel Packet-Fenster (Packet window) über 

Kommandos, Ausgaben usw.
o Die Verbindung zu einem Telnet-DXCluster wird in der Regel durch 

Senden des Rufzeichens mit der Rufzeichentaste unten ganz rechts 
hergestellt.

o Ist die Verbindung hergestellt, erscheinen die DXCluster-Meldungen in 
den Bandskalen. 

Mit der Karteikarte Hardware stellen Sie die Verbindungen zu einem Packet-TNC ein: 

• Der TNC ist an einer seriellen Schnittstelle des Rechners anzuschließen 
o Prüfen Sie die Verbindung zum TNC vorher mit dem Dienstprogramm 

Hyperterminal, um die Hardwarefunktion sicher zu stellen 
• Gehen Sie zur Karteikarte Configurer >Hardware 
• Wählen Sie die serielle Schnittstelle, an die der TNC angeschlossen ist, aus.
• Klicken Sie auf die zugehörige Taste Set und stellen Sie im sich öffnenden 

Menü die Werte für Baudrate und Datenformat ein. 
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• Schließen Sie den Configurer und öffnen Sie mit dem Menü Window 
>Packet/Telnet >Telnet das Packet-Fenster 

o Geben Sie in der oberen Zeile Type: die Kommandos für den TNC ein. 
Die vom TNC ausgegebenen Daten laufen im TX-Fenster darunter ein.
Hinweis DM3ML: Geben Sie ein benötigtes ESC als Shift+ESC ein. Es 
wird als schwarzes Karo zurückgegeben. Ein ESC ohne Shift setzt den 
Cursor in das Log-Eingabefenster. 

o Gehen Sie zum Kapitel Packet-Fenster (Packet window) für weitere 
Einzelheiten, z.B. die Herstellung einer Verbindung mit TAPR/TF oder 
WA8DED-Software usw. 

o Wenn die Verbindung zwischen TNC und DXCluster hergestellt ist, 
erscheinen die DX-Meldungen in den Bandskalen.

4. Einstellung von PTT und CW ( Setup PTT-ing the Rig/Sending CW)

Um die PTT zu aktivieren und die CW zu tasten, haben Sie drei Möglichkeiten: 

• Über die parallele Schnittstelle: 
o Bauen Sie sich ein Interface mit zwei Schalttransistoren  für die PTT- 

und die CW-Leitung. Pin 16 der Schnittstelle wird für PTT und Pin 17 
für CW verwendet. Einzelheiten entnehmen Sie bitte dem Kapitel 
Interfacing. 

o Gehen Sie zu Configurer >Hardware 
 Wählen Sie die parallele Schnittstelle LPT für CW/Other aus.  
 Klicken Sie auf die Taste Set und stellen Sie im sich öffnenden 

Menü die Werte für CW-speed (Grundeinstellung 
Gebegeschwindigkeit), PTT-delay (Verzögerung zwischen PTT 
und erstem CW-Zeichen) sowie die Schnittstellenadresse unter 
CW/Other port address ein

 Die CW/Other Port Address finden Sie unter der Windows-
Systemsteuerung > Hardware > Gerätemanager > 
Anschlüsse (COM und LPT) > Schnittstelle > Ressourcen 

 Wählen Sie den/die zu tastenden Transceiver aus (Radio/VFO 
setting > 1, 2 oder beide (Both) 

 Klicken Sie auf OK 
o PTT und CW sollten jetzt funktionieren
o  

• Über die serielle Schnittstelle: 
o Bauen Sie sich ein Interface mit zwei Schalttransistoren  für die PTT- 

und die CW-Leitung. In der Regel wird das Signal RTS für die PTT und 
das Signal DTR für CW verwendet.

o Gehen Sie zu Configurer >Hardware 
 Wählen Sie unter der vorgesehenen COM-Schnittstelle 

CW/Other aus. 
 Klicken Sie auf die Taste Set und wählen Sie Ihre Einstellungen 

für CW-speed (Grundeinstellung Gebegeschwindigkeit), PTT-
delay (Verzögerung zwischen PTT und erstem CW-Zeichen) 
sowie die Schnittstellenadresse unter CW/Other port address 

 Wählen Sie die Signalleitungen für PTT und CW aus. 
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 Die CW/Other Port Address finden Sie unter der Windows-
Systemsteuerung > Hardware > Gerätemanager > 
Anschlüsse (COM und LPT) > Schnittstelle > Ressourcen  

 Wählen Sie den/die zu tastenden Transceiver aus (Radio/VFO 
setting > 1, 2 oder beide (Both) 

 Haben Sie ein Winkey-Interface ausgewählt, wird eine feste 
Baudrate vom Programm eingetragen.  

 Klicken Sie auf < OK > 
o PTT und CW sollten jetzt funktionieren

• Über eine USB-Schnittstelle 
o Sie benötigen einen USB-zu-seriell-Konverter. Stellen Sie ihn wie eine 

serielle Schnittstelle ein. 
o Nicht jeder Konverter schaltet die RTS- und die DTR-Leitung wie 

benötigt. Testen Sie am besten einen ausgewählten Konverter vor dem 
endgültigen Einsatz.

o Ermitteln Sie die Schnittstellen-Nummer über die Windows-
Systemsteuerung > System > Hardware> Gerätemanager > 
Anschlüsse (COM/LPT) 

5. WAV-Dateien für SSB vorbereiten (Setup WAV Files (SSB))

Sie können in einem SSB-Contest die Funktionstasten im Eingabefenster mit vorher 
erzeugten WAV-Dateien belegen. Vom Programm werden zwei Arten von Dateien 
verarbeitet: 

• WAV-Dateien, die den Funktionstasten zugeordnet sind 
• Sound-Dateien, die aus dem Rufzeichen der Gegenstation erzeugt werden:  

o Aus Einzeldateien für Buchstaben und Ziffern zusammengesetzte 
Rufzeichen 

o Sendung des vollen Rufzeichens oder Zahlengruppen, die in einem 
vorbereiteten WAV-Verzeichnis gefunden wurden 

6. CW-Mitteilungen senden (Sending Messages in CW)

Sie müssen zwei Sachen vorbereiten:  

• Erzeugen Sie die CW-Texte mit dem Menü Config >Change 
Packet/CW/SSB/Digital Message Buttons >Change CW Buttons. In der 
Tabelle ist Platz für 2x 12 Texte, die den 12 Funktionstasten F1 bis F12 
zugeordnet sind. Der erste 12er-Block enthält die Texte für den Run-Betrieb, 
der zweite Block die Texte für den S&P-Betrieb. Sind weniger als 9 Tasten im 
S&P-Bereich nicht belegt, wird der zugehörende Text aus dem Run-Bereich 
gesendet.
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• Überprüfen Sie, ob im Menü  Configurer >Function Keys jeder F-Taste die 
richtige Bedeutung zugewiesen worden ist. Z.B. ist F1 die CQ-Taste mit dem 
Text 1, ihr muss im Menü unten die Funktion “CQ-Taste” zugewiesen worden 
sein (ist voreingestellt).  

 

Das Zeichen # ist der Platzhalter für die Seriennummer. Es gibt weitere Platzhalter-
Kürzel. Sie finden diese Zeichen im Kapitel  Macros.
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7. Einstellung der Kontrollnummer (Setup 'Sent Exchange')

Die zu sendende Kontrollnummer (Seriennummer, Zonennummer,  Provinz o.ä,) wird 
im Menü File >Open Log in Database >Contest tab "Sent Exchange" für den 
jeweiligen Contest eingestellt. Sie erscheint als Macro {EXCH}  und wird der Taste 
F2 zugeordnet. Hier wird der Rapport (Standard 5NN) plus {EXCH} gesendet. Beim 
WWDX-Contest sendet eine DL-Station z.B. 5NN14.

8.  Anpassung der Kontrollnummer (Setup the Exchanges)

By Jamie, WW3S 

• Nehmen wir an, Sie wollen unter WW3S einen RTTY-Contest mitmachen 
• Gehen Sie zu Configurer >Function Keys 

o Sie wollen den Ablauf mit der ENTER-Taste (ESM = Enter Sends 
Message) steuern und tauschen dazu die Tasten F5 und F3 

 Sie weisen der Funktion End of Qso Key die Taste F5 zu
 und legen das Rufzeichen der Gegenstation His call auf F3 

o Dann gehen Sie zu Config >Change Packet/CW/SSB/Digital  
Message Buttons >Change CW Buttons 

 Die Festtexte werden ab F1 aufsteigend angezeigt 
 Ändern Sie den Text der Taste F4 in &WW3S in der einen Spalte 

und in WW3S in der anderen Spalte. Das & gibt an, was als 
Tasteninhalt anzuzeigen ist 

o Ändern Sie F2 in 599, US-Staat und CQ-Zone 
o Bei mir wird 599-599 PA PA 05 05 BK gesendet

Hinweis DM3ML: Viele Programme suchen nach einem freistehenden 
‚599 ’ oder der Zone (hier 05), vermeiden Sie daher solche 
Kombinationen wie 599-599, da hier das Leerzeichen als Trennung 
fehlt. 

Was erreichen Sie?  

• Wenn Sie die Funktion ENTER sendet den Text (ESM) von N1MMLogger 
verwenden, müssen die F-Tasten in der richtigen Reihenfolge mit dem Menü 
Configurer >Function Keys eingestellt sein, sonst funktioniert das ESM 
nicht. (Anmerkung DM3ML: Sie schalten mit ENTER in Abhängigkeit vom 
Zustand der Felder im Eingabefeld von F-Taste zu F-Taste weiter)

• Setzen Sie die Taste F3 so, dass die Funktion End of qso realisiert wird, z.B. 
bei mir TU QRZ DE WW3S WW3S TEST 

• F1 wird auf CQ CQWW TEST DE WW3S WW3S TEST gesetzt. 

Sie können diese Anordnung auf bei CW-Contesten verwenden. 

9. Funktionstasten für den ESM-Modus einstellen (Setup Function Keys 
for Enter Sends Message (ESM) mode)

Unten sehen Sie eine ESM-Einstellung von Jose, CT1AOZ. 

Stellen Sie die Funktionstasten unter Configurer >Function Keys so ein:
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Voreingestellte Funktionstasten
F1 CQ key F5 His Call Key F9 
F2 Exchange key F6 QSO B4 Key F10 
F3 End of QSO Key F7 F11 
F4 My Call Key F8 Again Key F12

Haken Sie in der Karteikarte Functions keys alle Felder bis auf Monitor via PC 
speaker an. 

Tragen Sie jetzt unter Config >Change Packet/CW/SSB/Digital Message Buttons 
>Change CW Buttons diese Macros ein. Die gleiche Einstellung wird bei SSB und 
RTTY verwendet:  

Running mode S&P mode 
Button 
Caption

CW message / .WAV file 
/Text to Send

Button 
Caption

CW message / .WAV file 
/Text to Send 

F1 CQ CQ CQ ** F1 QSY PSE QSY QRL * 
F2 Exch <<< ENN >>># F2 Exch <<< ENN >>># 
F3 TU TU * F3 TU * 
F4 My * F4 My * 
F5 His ! F5 His ! 
F6 QSOB4 ! QSOB4 TU * QRZ F6 QSOB4 ! QSOB4 DE * 
F7 His/TU ! TU F7 Corr ! TU 
F8 Again ! AGN PSE * F8 Again ! AGN PSE * 
F9 F9
F10 F10
F11 F11
F12 F12

Jose schreibt: Sie werden mit dieser Lösung bestimmt zufrieden sein und die 
Leistungsfähigkeit des Programms unter ESM ausnutzen.  

10. Parameter für die Kommandozeile (Command Line Parameters)

Sie können die eingestellten Parameter in einer Datei <name>.ini (hier SO2R.ini)  
sichern und eine bestimmte Einstellung mit der Kommandozeile "C:\Program 
Files\N1MM Logger\N1MM Logger.exe" SO2R.ini wieder starten.

Last Modification: 05 October 2009 06:55:44 EDT by n4zr. 

Grundfunktionen (Basic Functions)

Sie werden bei der Nutzung des Programms Standardroutinen z.B. zum Ändern der 
Frequenz, des Bands und der Sendeart finden. Informieren Sie sich weiterhin über 
Tastenzuordnungen, Programm einrichten, das Logeingabefenster und den 
Schnelldurchlauf. Für den Contest selbst werden Begriffe wie CQ-Rufen (Running 
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mode), Suchen und Anrufen (S&P) und die das Loggen nur mit ENTER ('Enter 
Sends message) beschrieben. Sehen Sie auch bei Tipps und Tricks zum 
Betriebsablauf nach.    

1. Hilfe (Help)

Für fast jedes Fenster gibt es eine Hilfe-Funktion. Klicken Sie rechts in das Fenster 
und wählen Sie im sich öffnenden Menü den Punkt Hilfe (Help). Die Hilfe zum 
Logeingabefenster erreichen Sie über die Hilfe im Hauptmenü oder mit der der Taste 
ALT-H. Die Hilfe für die Tastenzuordnung kann ebenfalls direkt über die Hilfe im 
Logeingabefenster gerufen werden. Sie können jedes Hilfe-Kapitel mit einem Klick 
auf die Drucktaste ausdrucken. Sie erreichen aus einem Fenster die zu dem Fenster 
gehörende Hilfe, so dass Sie nicht lange suchen müssen.
Haben Sie die PDF-Ausführung der Hilfe können im Adobe-Reader nach einem 
Begriff suchen. Wenn Ihr Computer mit dem Internet verbunden ist, können Sie mit 
dem Menüpunkt Searching Help using Google (Hilfe mit Google suchen) in der 
letzten Version der N1MM-Hilfe nachsehen. Diese Hilfe geht am schnellsten und ist 
am aktuellsten. 

2. Durchlauf durch die Eingabefelder (Going Through the Entry Window 
Fields)

Verwenden Sie bevorzugt die Leertaste anstelle der TAB-Taste um von Feld zu Feld 
des Eingabefensters zu kommen. Mit der Leertaste übergehen Sie Felder mit 
vorgegebenem Inhalt wie das RST-Feld, das normalerweise nicht geändert wird. 
Einzelheiten zur Leertaste finden Sie im Kapitel Tastenzuordnungen. Mit der TAB-
Taste oder Shift+TAB-Taste erreichen Sie alle Felder. 

3. Fenstergröße anpassen (Resizing Windows)

Sie können die Fenster von N1MMLogger beliebig anordnen und in der Größe 
verändern. Nur die Bandskala hat eine minimale Breite. Die gewählten 
Fensterpositionen werden bei einem ordentlichen Programm-Ende abgespeichert 
und beim Wiederöffnen hergestellt. Wenn Sie das Eingabefenster schließen, wird 
das gesamte Programm beendet. Alle QSOs werden auf der Festplatte unmittelbar 
nach Abschluss der Eingabe gespeichert.

4. Neuen Contest auswählen (Select New Contest)

Zum Start eines neuen Contests gehen Sie zum Menü File >Open Log in Database. 
Wählen Sie im Menü oben links einen Contest aus der angebotenen Liste mit einem 
Mausklick. Sie werden nach den Einzelheiten zu diesem Contest gefragt. Die von 
N1MMLogger angebotenen Conteste finden Sie im Kapitel Unterstützte Conteste 
(Supported Contests). Gehen Sie zur der Webseite des Contests und informieren 
Sie sich über die neuesten Regeln. Die Einstellung der einzelnen Conteste wird im 
Kapitel Contesteinstellungen (Contest Setup Instructions). Beabsichtigen Sie einen 
neuen Contest mit einem großen Log zu fahren, wird das Anlegen einer neuen 
Datenbank empfohlen, vor allem wenn Sie einen langsamen Rechner verwenden.
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5. Contest löschen (Delete Contest)

Gehen Sie zum Contestdialog unter File >Open Log in Database, markieren Sie 
den ausgewählten Contest und klicken Sie auf die Taste < Delete >. 

6. Länderliste auswählen (Select Country file)

Sie müssen die neue Länderliste erst aus dem Internet abholen und dann in einem 
zweiten Schritt in die aktuelle Datenbank Ihres PC importieren. Wenn Sie eine neue 
Datenbank angelegt haben, müssen Sie hier auch die neueste Länderliste 
importieren. Die Länderliste wird in jeder Datenbank gespeichert.

• Holen Sie sich mit Tools >Download latest country file (wl_cty.dat)  
(Internet) die neueste Länderliste wl_cty.dat aus dem Internet

o Achten Sie auf den Namen wl_cty.dat. Diese Datei enthält eine 
zusätzliche Länderinformation. 

• Importieren Sie diese Länderliste mit Tools >Import country list from 
downloaded file 

o Bevor Sie die Länderliste nicht importiert haben, kann Sie von 
N1MMLogger nicht verwendet werden.

7. Datei Master.dta auswählen (Select Master.dta file)

Diese Datei wird aus den Logs zahlreicher großer Conteste erzeugt und enthält die 
Rufzeichen der weltweit aktiven Contester. Sie kann zur Rufzeichenprüfung und zur 
Vervollständigung von zweifelhaften Rufzeichen verwendet werden. Legen Sie in der 
Contesteinstellung fest, welche Master.dta-Datei Sie verwenden wollen. 

• Holen Sie sich die Master-Datei mit Tools >Download Latest Check Partial  
file (Master.DTA) (Internet) 

o N1MM Logger unterstützt die Datei im CT-Format 
• Legen Sie bei der Contesteinstellung unter File >Open Log in Database 

>Karteikarte Associated Files  die zu verwendende Datei Master.dta fest
o Klicken Sie auf die Taste < Change > neben dem Namen der 

Master.dta-Datei zur Übernahme der eingetragenen Datei 

8. Frequenz ändern (Changing Frequency)

Für die Frequenzänderung mit N1MMLogger gibt es verschiedene Möglichkeiten. 
Voraussetzung für diesen und die folgenden Abschnitte ist eine funktionierende 
CAT-Steuerung 

• Drehen Sie am Abstimmknopf Ihres Transceivers, der Zeiger auf der aktuellen 
Bandskala folgt der Transceiverskala 

• Geben Sie eine Frequenz in das Rufzeichenfeld des Logeingabefensters ein, 
z.B. 14200,5 und der Transceiver wird auf 14.200,5 MHz eingestellt. Die 
Sendeart ergibt sich aus der unter Configurer >Mode Control >Karteikarte 
Settings festgelegten Zuordnung der Sendeart zu Frequenzbereichen.

• Geben Sie eine Frequenz in das Rufzeichenfeld des Logeingabefensters ein, 
z.B. 14200,5 und der Transceiver wird auf 14.200,5 MHz eingestellt.
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• Geben Sie einen Offset in das Rufzeichenfeld ein, z.B. +3 und der Transceiver 
wird 3 kHz höher, hier auf 14203,5 gesetzt 

• Geben Sie einen Offset ohne Vorzeichen ein, z.B. 123 , dann geht der 
Transceiver auf eine Frequenz von ‚Bandanfang + 123 kHz’, 

o Wenn Sie einen Schrägstrich  /  vor den jeweiligen Offset setzen, wird 
der zweite VFO B in der Frequenz gesetzt, z.B.: /14200,5    /+3    /123 
und gleichzeitig aktiviert

• Klicken Sie auf einen DX-Spot in einer Bandskala, der VFO wird dorthin 
geschaltet. 

• Klicken Sie auf einen DX-Spot im Packet/Telnet-Fenster
• Klicken Sie rechts in das Logfenster und wählen Sie Jump to this frequency 

(springe zu dieser Frequenz). Der VFO wird auf die Frequenz dieses QSOs 
gestellt.

• Klicken Sie auf ein Rufzeichen im Angebots-Fenster ' Available Mult's and 
Qs' und der VFO wird auf die zugehörige Frequenz gestellt. 

• Wechseln Sie das Band mit einem Klick auf eine der Tasten im Angebots-
Fenster 'Available Mult's and Qs'

• Tragen Sie einen Frequenzversatz in das Rufzeichenfeld des Eingabefensters 
ein um auf Split zu schalten. Siehe Abschnitt Splitbetrieb in diesem Kapitel 

• Verwenden Sie eine der vielen Tasten bzw. Tastenkombinationen um die 
Frequenz, das Band, den VFO oder den Transceiver zu wechseln. Siehe 
Kapitel Tastenzuordnungen (Key Assignments). Diese Tastenkombinationen 
sollten Sie durchprobieren:

Ctrl+Alt+Pfeil nach 
unten

Ctrl+Shift+Bild nach 
unten

Ctrl+Pfeil 
nach 
unten

Ctrl+Alt+Q Ctrl+Pfeil 
links Alt+Q 

Ctrl+Alt+Pfeil nach 
oben

Ctrl+Shift+Bild nach 
oben

Ctrl+Bild 
nach oben 

Bild nach 
oben

Ctrl+Pfeil 
rechts Alt+F8 

Ctrl+Shift+Pfeil nach 
oben

Ctrl+Shift+Pfeil nach 
unten

Ctrl+Bild 
nach 
unten

Bild nach 
unten Alt+F10 Alt+F11 

Ctrl+Shift+Alt+Pfeil 
nach oben

Ctrl+Shift+Alt+Pfeil 
nach unten

Ctrl+Pfeil 
nach oben Shift+Alt+Q Alt+F11

Pfeil 
nach 
oben

Ist kein Transceiver angeschlossen, haben die Pfeiltasten Bild nach oben/Bild nach 
unten keinen Effekt. Sie werden bei Überschreitung der Bandgrenzen gewarnt. 
Dieser Effekt kann bei fehlerhaften Eingaben auftreten:

. 
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9. Bandwechsel (Changing Band)

Sie können das Band so wechseln:

• Umschalten am Transceiver  
• Ctrl+Bild nach oben – Gehe ein Band höher. WARC-Bänder werden bei 

Contesten übergangen. 
• Ctrl+Bild nach unten - Gehe ein Band tiefer. WARC-Bänder werden bei 

Contesten übergangen
• Geben Sie eine Frequenz ins Rufzeichenfeld des Logeingabefensters ein : 

14200,5 schaltet auf 14.200,5 MHz 
• Klicken Sie auf eine Bandtaste im Angebots-Fenster Available Mult's and &' 

Qs  
• Klicken Sie auf einen DX-Spot im Angebots-Fenster  Available Mult's and &' 

Qs  
• Klicken Sie auf einen DX-Spot im Packet/Telnet-Fenster 

10. Sendeart ändern (Changing Mode)
• Umschalten am Transceiver 
• Klicken Sie in der Bandskala auf das Sendeartenfeld oben rechts. Die 

Sendearten werden zyklisch durchgeschaltet (CW > SSB > RTTY) 
• Geben Sie in das Rufzeichenfeld die Sendeart mit CW, LSB, USB, RTTY, AM, 

FM, DIGI, PSK oder SSTV ein 
o Bei der Umschaltung des Transceivers auf digitale Sendearten gibt es 

in der Regel Probleme mit der Zuordnung der Sendearten wie  PSK, 
RTTY oder SSTV zu den am Transceiver einstellbaren Sendearten. 
Gehen Sie zum Menüpunkt Config >Config Ports, Telnet Address, 
Other >Karteikarte Mode Control und tragen Sie hier die Zuordnung 
zwischen Sendeart und Mode-Einstellung am Transceiver ein.  

11. Operatorwechsel (Changing Operator)
• Ctrl-O – Öffnet den Dialog für den Eintrag des Operator-Rufzeichens. 

Voreingestellt ist das Rufzeichen aus dem Stationsdialog. Der Operator ist nur 
für die Klasse Multi-OP interessant. 

• Geben Sie OPON in das Rufzeichenfeld ein, um den OP-Dialog zu öffnen . 

12. CW-Gebegeschwindigkeit einstellen (Setting CW Speed)
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Sie können die Gebegeschwindigkeit über das Eingabefenster einstellen. Das 
Einstellfenster dafür ist nur bei CW sichtbar. Die Geschwindigkeit kann für jeden VFO 
bzw. Transceiver getrennt eingestellt. Sie können die Geschwindigkeit auch mit den 
Tasten Bild nach oben und Bild nach unten oder mit den Pfeilen neben dem 
Einstellfensters ändern.

13. Splitbetrieb (Split Operation)
Wenn Sie auf einer anderen Frequenz senden als Sie empfangen ist das 
Splitbetrieb. Split wird gearbeitet, wenn seltene Stationen ungestört auf ihrer 
Sendefrequenz gehört werden wollen oder wenn der Bandplan keinen 
Gleichwellenverkehr zulässt (z.B. im 40m-Band zwischen EU und USA) . Sie können 
den Splitverkehr auf der Bandskala sehen. Der dicke blaue Pfeil steht auf Ihrer 
Empfangsfrequenz, die rote Marke auf Ihrer Sendefrequenz. Bei Splitbetrieb werden 
beide Frequenzen auch am Kopf der Bandskala angezeigt, die Sendefrequenz steht 
unter der Empfangsfrequenz. Im Eingabefenster steht in dicken grauen Buchstaben 
das Wort Split.
Die eingegebene Splitfrequenz wird überprüft, ob sie ins aktuelle Band fällt, bevor 
der VFO gesetzt wird. Falls die Frequenz außerhalb des Bandes liegt, erscheint im 
Eingabefenster eine Fehlerwarnung und der VFO wird nicht gesetzt. Wenn Sie auf 
die Empfangfrequenz oben in der Bandskala klicken, werden Sende- und 
Empfangsfrequenz zyklisch vertauscht.

 Splitbetrieb im Run-Modus

Wenn Sie auf  'Running mode’ geschaltet haben, im Splitbetrieb arbeiten und 
die Empfangsfrequenz wechseln, wird nicht automatisch auf S&P-Modus 
umgeschaltet, wie beim Betrieb ohne Split.

13.1. Splitfrequenz von Hand einstellen (Setting Spit Frequencies 
Manually)

Der Splitdialog wird mit Alt-F7 gestartet oder durch die Eingabe von Frequenz oder 
Offset in das Rufzeichenfeld des Logeingabefenster und Abschluss mit Ctrl-Enter. 
In der Frequenzangabe können Kommas (bei Einstellung von Windows auf Deutsch) 
enthalten sein. Sie können folgende Eingaben machen :

• Geben Sie die Splitfrequenz direkt ein oder 
• Geben Sie den Offset vom Bandanfang ein oder 
• Geben Sie den Offset von der aktuellen Frequenz als +5, +4, 3, 6, -2, -5 etc. 

ein
• Beispiele : 

o 7050,3 Ctrl-Enter
o 220,3 Ctrl-Enter
o +5,3 Ctrl-Enter
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13.2. Splitfrequenz aus DXSpot setzen (Setting Split Frequencies 
Automatically by Packet Spots)

Ist in der DXCluster-Meldung ein Offset angegeben, wird N1MMLogger automatisch 
auf Splitbetrieb geschaltet, wenn diese Station in der Bandskala angeklickt wird.

13.3. Splitbetrieb abschalten (Resetting to non-split mode)

Der Splitbetrieb wird abgeschaltet, wenn Sie auf einen andere Frequenz oder ein 
anderes Band gehen. Folgende Möglichkeiten gibt es: 

• Gehen Sie zu einer anderen Frequenz oder einem anderen Band 
• Klicken Sie auf die Sendefrequenz oben in der Bandskala unter der 

Empfangsfrequenz 
• Klicken Sie auf die Empfangsfrequenz oben in der Bandskala
• Klicken Sie auf einen Spot in der Bandskala oder im Packet/Telnet-Fenster 
• Klicken Sie auf eine Frequenz in der Bandskala 
• Klicken Sie auf eine Bandtaste im Available Mult's & Q's-Fenster 
• Drücken Sie Ctrl+Bild nach unten oder oben 

13.4. Tastenzuordnung für Splitbetrieb (Split Operation Key 
Assignments)

 Split mit ICOM-Transceivern 

Icom-Transceiver können die VFO B-Frequenz nicht melden, wenn nicht auf VFO B. 
geschaltet wurde. Das Programm fragt nur VFO A ab aber nicht VFO B. Sie können 
VFO B nur über den Computer setzen. Um Split einzuschalten, drücken Sie ALT+F7 
und geben Sie +3 oder 215 oder 7215 ein. Sie können die gleichen Werte auch in 
das Rufzeichenfeld im Eingabefenster eintragen und mit Ctrl+ENTER abschließen. 
Schalten Sie den Split-Betrieb NUR über das Programm und die Tastatur ein, nicht 
über die Tasten am Transceiver. Nur dann bleibt Ihr Transceiver unter der Kontrolle 
des Programms.  

Alt+F7 : Setzt die Splitfrequenz oder den Offset von der aktuellen Frequenz beim 
aktiven Transceiver. Der Splitbetrieb wird abgeschaltet, wenn Sie bei einem leeren 
Splitfenster auf ENTER oder OK drücken. Drücken Sie ESC oder klicken Sie auf 
Cancel um die Spliteinstellung zu verlassen. 

Alt+S – Mit dieser Eingabe wird die Empfangsfrequenz auf die Sendefrequenz 
gesetzt, aber der Transceiver bleibt auf Splitbetrieb geschaltet. Mit dieser Einstellung 
kann der OP anstelle des kleinen und schlecht einzustellenden RIT-Knopf die 
Hauptabstimmung zur Suche nach zu arbeitenden Stationen benutzen. Der 
Transceiver bleibt auf der Sendefrequenz stehen und Sie können mit der leichter zu 
bedienenden Hauptabstimmung den Splitbereich abgrasen. Die Taste ALT+S 
arbeitet wie RIT löschen. Sie funktioniert nur beim VFO-A. Mit den Zweit-RX-
Transceivern IC-756/7800 können nicht auf SUB ohne Empfang mit beiden VFOs 
arbeiten. Stellen Sie in diesem Fall den RX auf Main und TX auf SUB, dann 
funktioniert ALT+S. 
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Die Funktion “Reset RX freq when running split" im Config-Menü arbeitet mit 
ALT+S zusammen. Wenn sie angewählt wurde, erzeugt das Programm nach jedem 
Logvorgang ein ALT+S und gleicht Empfangs- und Sendefrequenz aneinander an. 
Die genaue Folge ist: RX-Frequenz = TX-Frequenz, QSO loggen, TU-Text senden. 

Ctrl+S: Das erste Ctrl-S schaltet den Splitbetrieb ein, jedes weitere schaltet zwischen 
RX-Splitfrequenz  und RX auf der TX-Frequenz hin und her. Diese Möglichkeit wurde 
vor allem für den DX-Betrieb im 40m- und 80m-Band eingebaut. Sie können z.B. 
senden: "CQ CQ de N1MM listening on this frequency (7183) and 7068". Verwenden 
Sie die Ctrl+S-Taste um zwischen 7183 und 7068 für USA und DX-Anrufen hin und 
her zu schalten. 

Ctrl+Alt+S : Schaltet den Split-Betrieb ein und aus. Im Eingabefenster erscheint 
'Split', wenn der Splitbetrieb aktiv ist.

Ctrl+Enter : Mit dem Abschluss einer in das Rufzeichenfenster eingegebenen 
Frequenz durch Ctrl+Enter setzen Sie die Splitfrequenz.

Toggle split operation : Wenn Sie auf den Empfangsfrequenz oben in der 
Bandskala klicken, vertauschen Sie Empfangs- und Sendefrequenz. 

Schalten Sie im Splitbetrieb das @-Macro aus, das sonst die Empfangsfrequenz 
ansagt.

  Split-Beispiel
Klicken Sie nicht auf Spots im Packet-Fenster. Klicken Sie auf Spots in der 
Bandskala oder im Angebots-Fenster. Überprüfen Sie die Frequenz im 
Logeingabefenster, ob Sie u.U. in einem verbotenen Bandbereich senden wollen, 
speziell auf 40 und 80m. Klicken Sie einmal auf einen Spot. Falls Sie keine 
Splitanzeige sehen, hören Sie auf den rufende Station. Wenn Sie sagt "listening 
214.5" geben Sie 214.5 in das Rufzeichenfeld ein und schließen Sie mit Ctrl+ENTER 
ab. Ihr Sender wird auf diese Frequenz gesetzt und Sie können im Splitbetrieb 
anrufen. 

14. CQ rufen (Running Mode)
Im “Running mode” rufen Sie CQ und erwarten Anrufe anderer Stationen. Sie sitzen 
auf einer festen Frequenz und suchen nicht nach anderen Stationen. Das Programm 
markiert Ihre aktuelle Frequenz als CQ-frequency in der Bandskala und im 
Logeingabefenster ist ein Haken im kleinen Fenster Running. Der Running mode hat 
seinen eigenen Satz von Funktionstasten F1 bis F12. In den Funktionstasten ist der 
Text zu sehen, der ihnen in der F-Tastentabelle unter Button Caption zugeordnet 
worden ist. Ein zweiter Satz der gleichen Funktionstasten ist für den Modus „Suchen 
und Rufen“ (S&P = Search and Pounce) – Modus vorgesehen. Sie können diesen 
Satz aus dem Running-Modus mit den Tasten Shift+F1 bis Shift+F12 erreichen. 
 
Sie kommen in die Running mode mit :

• Einem Klick auf CQ-frequency in der Bandskala 
• Wenn Sie den Transceiver auf die CQ-frequency  im gleichen Band 

abstimmen 
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• Mit einem Druck eine F-Taste mit Shift+Fx  im S&P-Modus. Diese Zuordnung 
kann mit Config > Karteikarte Function Keys geändert werden  

• Mit der Zeichenkette "CQ" in einer der Tastentexte oder Funktionstastentexte 
oder im Namen einer WAV-Datei in SSB 

• Einem Mausklick (Haken) in das Feld Running

Wenn Sie die CQ-Frequenz verlassen, wird der Haken im Feld Running entfernt, 
das Programm schaltet auf S&P und die Funktionstasten F1-F12 bekommen die 
S&P-Belegung. Mit einem Klick auf die CQ-Frequenz in der Bandskala kommen Sie 
zurück zu Running. Es gibt nur EINE CQ-Frequenz pro Band. Falls Sie die VFOs 
umschalten, kommen Sie u.U. von Running- in den S&P-Modus. Mit dem Wechsel 
zwischen den VFOs können Sie zwischen Running- und S&P-Modus umschalten.
Eine Ausnahme bildet der Splitbetrieb, Hier bleibt der Sender auf der CQ-Frequenz 
und Sie können die Empfangsfrequenz verändern.

• Mit der Taste Einf( Insert) oder ; wird das Rufzeichen der Gegenstation 
gefolgt vom Inhalt der Exchange-Taste gesendet (Hinweis DM3ML: Vorsicht 
mit dem ‘;’, das liegt auf einer amerikanische Tastatur woanders) 

• ' : Sendet den TU-Text und loggt das QSO (Hinweis DM3ML: Auch hier 
ausprobieren!) 

• F4 : Sendet das eigene Rufzeichen 

15. Suchen und Anrufen (Search and Pounce Mode (S&P))

Der S&P-Modus ist das Gegenteil von Running-Modus. Im S&P-Modus suchen Sie 
andere Stationen und rufen sie an. Die Sendefrequenz ist nicht fest, sie rufen nicht 
CQ, sondern richten sich nach der Gegenstation. Die Running-Anzeige ist ohne 
Markierung, die F-Tasten sind mit den für S&P-Betrieb programmierten Texten 
belegt. Die Tasten des Running-Modus können mit Shift-F1 bis Shift-F12 erreicht 
werden. Schon wenn Sie die Shift-Taste drücken, werden die Texte in den F-Tasten 
umgeschaltet.
Haben Sie im S&P-Modus Shift-F1 gedrückt, startet der CQ-Ruf, das Programm 
schaltet in den Running-Modus und bleibt dort. Jeder Druck auf F1 löst einen 
weiteren CQ-Ruf aus
Im S&P-Modus können Sie mit der Taste F1 einen CQ-Ruf starten und damit vom 
S&P-Modus in den Running-Modus wechseln. Ab sofort startet dann die Taste F1 
einen CQ-Ruf im Running-Modus. Wollen Sie im S&P-Modus bleiben, müssen Sie 
eine andere S&P-Taste mit einem CQ-Macro programmieren. belegen und mit dieser 
die Umschaltung auslösen.
Wenn Sie im S&P-Modus ein Rufzeichen in das Eingabefeld eingegeben haben und 
die Meldung DUPE bekommen, wird das Rufzeichen bei einem QSY gelöscht, aber 
in die Bandskala eingetragen.

  Tipp
Sie können eine belegte Frequenz mit ALT+M markieren. Hiermit können Sie 
Stationen, die nicht am Contest teilnehmen oder auf Grund der Regeln nicht 
gearbeitet werden können, markieren. Sie brauchen dann beim Drehen übers Band 
nicht auf ein Rufzeichen zu warten.
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15.1. Sind Sie im S&P- oder im Running-Modus? (How to check if 
you are in Running mode or in S&P mode?)

Sie sehen den Status an diesen Anzeigen:

• Das Feld Running ist angehakt oder leer 
• Die Eingabefelder sind weiß (running) oder gelblich (S&P), im Schnell-Edit-

Modus sind sie blau 
• Im grünen Ball unterhalb des Rufzeichenfeldes steht "Ru" oder "SP"  
• Sie sehen unterschiedliche Texte in den Tasten für Running oder S&P. 
• Über dem Rufzeichenfeld steht im Running-Modus  "CQ-Frequency" . In der 

Bandskala ist die "CQ-Frequency" fett markiert. 

Sie können zusätzlich den Tasten F1 im Running- und im S&P-Modus einen 
deutlichen Unterschied geben. Taufen Sie die eine F1-Taste als F1 – RUN und 
setzen Sie in die F1-Taste für S&P (F13..) den Text F1 - S/P. F1 wird in der Regel als 
CQ-Taste verwendet, so dass sie nicht unbedingt mit CQ beschriftet werden muss. 

16. CQ-Taste (CQ Key)

Die Verwendung der Taste F1 als CQ-Taste wird im Menü Configurer > Karteikarte 
Function festgelegt. Mit F1 wird sowohl im Running- als auch im S&P-Modus ein 
CQ-Ruf gestartet. Ohne weitere Vorkehrungen schaltet ein CQ aus dem S&P-Modus 
in den Running-Modus um. Wollen Sie im S&P-Modus bleiben, müssen Sie den Text 
in  Taste F1 mit dem Macro {S&P} ergänzen, wenn Sie im S&P-Modus bleiben 
wollen.  

17. Kontrollnummer einstellen (Set up the Sent exchange message(s))

Was im Contest auszutauschen ist, steht in den Contest-Regeln. Das kann eine 
Seriennummer ab 001 aufwärts, eine CQ- oder ITU-Zone, eine 
Provinzkennzeichnung oder ein DOK sein. Sie finden für die von N1MMLogger 
unterstützten Conteste eine Übersicht im Kapitel Contesteinstellungen (  Setup   
Contests) unter dem Eintrag ‚Set Exchange’. Für Conteste mit einer erweiterten 
Kontrollnummer gibt es spezielle Macros z.B. TIME2 für spezielle Digi-Conteste. 

Unten sehen Sie ein Beispiel für eine Kontrollnummer aus Rapport + Seriennummer 
+ CQ-Zone wie 599 023 04. 

Normalerweise verwenden Sie die Taste F2 für die Kontrollnummer (Exchange) und 
programmieren Sie mit 599 {EXCH}. Dann müssen Sie in der Contesteinstellung 
unter "Sent exchange" eine 001 eintragen. Diese Nummer wird als Seriennummer 
gewertet und mit jedem QSO erhöht. Oder Sie tragen als Macro für die Taste F2 die 
Zeichenkette 599 # # 04 ein, dann wird die Seriennummer zweimal gesendet und 
dann einmal die Zone (hier 04).  

Bitte beachten Sie: 

1. Das Macro {EXCH} enthält nicht den Rapport (599). Diesen müssen Sie zusätzlich 
programmieren. Das Feld "Sent exchange" wird für die Cabrillo-Datei herangezogen 
unabhängig davon was Sie als {EXCH}-Macro verwenden. Sie können daher unter 
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"Sent exchange" kein 599 eintragen, weil dann die Cabrillo-Datei durcheinander 
kommt. Wollen Sie nicht unter allen Umständen ein 599 senden, können Sie die 
Macros {SENTRST} oder {SENTRSTCUT} verwenden. Ihr Inhalt wird dann aus dem 
Inhalt des Rapportfeldes im Eingabefensters gebildet. 

2. Wollen Sie zwischen Running- und S&P-Modus unterschiedlich strukturierte 
Kontrollnummer senden, brauchen Sie nur die zugehörigen Tasten unterschiedlich 
programmieren, z.B. Run F2 als {TX} 599 # # 04 {RX} und the S&P F2 mit {TX}
{ENTER} ! TU 599 # # # 04 {RX} . 
Beachten Sie, dass im Run-Modus die Kontrollnummer als Folge F5 (Rufzeichen der 
Gegenstation = !) und F2 (Kontrollnummer) gesendet wird. In S&P wird nur die Taste 
F2 mit der Kontrollnummer gesendet, daher wurde hier das Rufzeichen der 
Gegenstation mit ‚!’ zusätzlich eingebaut.

3. Legen Sie im Menü Config >Configure Port, Telnet Address, Other >Function 
Keys fest, wie in CW Ihre Kontrollnummer gesendet werden soll. Wenn Sie einen 
Haken in das Feld "Send leading zeros in serial numbers (e.g. TT7)" machen, 
wird die Seriennummer verkürzt aber dreistellig gesendet. Aus ‚007’ wir ‚TT7’

18. F-Tasten-Konvention (Function Key Conventions)

Abgeleitet aus dem Programm CT gibt es eine F-Tasten-Konvention bei 
N1MMLogger und anderen Contest-Programmen. Sie lautet:

 F1 = CQ
 F2 = Kontrollnummeraustausch (exchange)
 F3 =TU/QSL/QRZ 
 F4 = eigenes Rufzeichen (your call)
 F5 = Rufzeichen der Gegenstation (his call)

Der Ablauf bei ESM-Modus (Durchschalten mit ENTER) baut auf dieser Konvention 
auf. Was unter ESM aktuell gesendet wird, hängt vom Zustand der Eingabefelder ab. 
Wenn Sie ESM schon unter CW nutzen, sollten Sie den gleiche Ablauf auch in SSB 
verwenden. Hier ist ein Ablaufplan als Beispiel:  

ESM-Modus: S&P - CW oder SSB ESM-Modus: Run - CW oder SSB 
1. <EINTER> sendet F4 (eigenes Call) 1. <ENTER> sendet  F1, "CQ" 

2. <ENTER> sendet F2 
(Kontrollnummer+Loggen)

2. Rufzeichen eingeben, dann 
<ENTER>, sendet F5 (Rufzeichen der 
Gegenstation + Kontrollnummer) 

*Hinweis* : Geben Sie in  SSB in die Taste F5 ein Leerzeichen anstelle des 
Rufzeichens der Gegenstation ein und sprechen Sie das Rufzeichen der 
Gegenstation anstelle des Leerzeichens, sonst übergeht N1MMLogger die Taste F5 
und sendet die F2-Mitteilung 

3. Geben Sie empfangene Kontrollnummer 
ein, dann <ENTER>, gesendet wird F3 
(QSL/QRZ/TU) und das QSO wird geloggt

3. Geben Sie empfangene 
Kontrollnummer ein, dann <ENTER>, 
gesendet wird F3 (QSL/QRZ/TU) und 
das QSO wird geloggt

Die Macros hängen von der Sendeart ab, nicht vom CONTEST. Sie sollten sich 
unterschiedliche Sätze für CW und SSB anlegen
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73, Ted W4NZ 

19. Sprachdateien aufzeichnen und wiedergeben (Set Up N1MM to 
Record and Playback Voice Recordings (recording on the fly))

Sie sollten Ihr Mikrofon über die Soundkarte laufen lassen. Die meisten Soundkarten 
erlauben diesen Betrieb und bieten zusätzlich einen 20dB-Vorverstärker für Heil- und 
ähnliche Mikrofone. Sie können Sprachaufzeichnungen machen und wieder abrufen. 

Gehen Sie so vor :

1. Schließen Sie Ihr Mikrofon am Mic-Eingang der Soundkarte an 
2. Schließen Sie den Kopfhörer Ihres Headsets am Soundkartenausgang an 
3. Wählen Sie Voreinstellungen in der Karteikarte Configurer >  Audio  
4. Öffnen Sie die Windows-Regler für die Wiedergabe so, dass Sie die Ihre 

Stimme über die Mikrofoneingabe im Kopfhörer hören können 
5. Wählen Sie unter Windows das Mikrofon als Quelle der Aufzeichnungen 
6. Stellen Sie den N1MMLogger auf SSB und starten Sie den Running-Modus. 

Vorher haben Sie in der F1-Taste einen Dateinamen eingetragen. 
7. Drücken Sie Ctrl+Shift+F1, sagen Sie etwas, z.B. den CQ-Text. Drücken Sie 

wieder auf Ctrl+Shift+F1. In der Statuszeile des Eingabefensters haben Sie 
die Texte 'recording started' während der Aufzeichnung und 'recording 
saved' nach dem Ende der Aufzeichnung gesehen

8. Drücken Sie die Taste F1 und hören Sie sich die aufgezeichnete Datei im 
Kopfhörer an 

9. Stellen Sie den NF-Pegel beim Aufzeichnen so ein, dass der aufgezeichnete 
Text die gleiche Lautstärke wie die direkte Eingabe vom Mikrofon hat 

Wenn Sie dieses Problem gelöst haben, verbinden Sie Ihre Soundkarte mit dem 
Transceiver, entweder direkt an eine ACC-Buchse, über einen Trenntrafo oder ein 
komplexeres Interface wie den Rigblaster o.ä.  

19.1. WAV-Dateien senden (Playing WAV Files)

Mit den F-Tasten können Sie vorbereitete WAV-Dateien abrufen um CQ zu rufen 
oder standardisierte Rapporte auszugeben. Die WAV-Dateien können an einer 
beliebigen Stelle der Festplatte stehen. Für Ihren Aufruf ist die volle Datei-
Bezeichnung anzugeben.
Editieren Sie die F-Tasten für einen SSB-Contest so:

• CQ mit der Datei C:\Program Files\N1MM logger\wav\cq.wav 
• Voreingestellte Kontrollnummer mit der Datei C:\Program Files\N1MM 

logger\wav\5905.wav 
• Senden des Rufzeichens der Gegenstation mit den Macro ‘!’ 
• Senden der Kontrollnummer mit dem Macro ‚#’ 
• Soll das Rufzeichen aus einer F-Taste nicht gesendet werden, fügen Sie ein 

Leerzeichen anstelle des Macros ein (meist Taste F5) 
• Ein möglicher Text ist ##!C:\Program Files\N1MM logger\wav\

{operator}\thanks.wav 
o Mit oder ohne führende Nullen wie ausgewählt 

11.04.2010



N1MM-Contest Logging Software Seite 55 von 470 Übersetzung der Hilfe von Eike, DM3ML

o Nur eine WAV-Datei kann pro Zeichenkette abgespielt werden und 
muss am Ende der Zeichenkette stehen 

Mit dem Macro {OPERATOR} können Sie jedem Operator seine individuellen WAV-
Dateien zuordnen, wenn Sie die Dateien so bezeichnen: wav\{OPERATOR}\cq.wav. 
Im Multi-OP-Contest kann damit jeder OP seine eigenen Texte abrufen. Im Beispiel 
ist ‚wav’ ein Verzeichnis unterhalb des Installationsverzeichnisses von N1MMLogger. 
Sie können auch ein getrenntes Verzeichnis wie: "C:\wavfiles\cq.wav" angeben. Das 
Macro {OPERATOR} ersetzt den aktuellen OP und ist nur bei den SSB-Tasten 
verwendbar. 

• CQ mit der aktuellen OP-Stimme abrufen: C:\Program Files\N1MM 
logger\wav\{OPERATOR}\cq.wav 

• Rufzeichen der Gegenstation mit der aktuellen OP-Stimme abrufen: 
{OPERATOR}\! . Dazu muss die Buchstabiertabelle mit der aktuellen OP-
Stimme auf der Karteikarte Files unter Letters im Configurer eingetragen 
sein. 

• Standard-Rapport mit der aktuellen OP-Stimme abrufen aus: C:\Program 
Files\N1MM logger\wav\{OPERATOR}\5905.wav 

Sie können mehrere WAV-Dateien durch Komma trennen und nacheinander abrufen, 
z.B.: C:\Program Files\N1MM logger\wav\{operator}\blank.wav,C:\Program 
Files\N1MM logger\wav\{operator}\number.wav# 

Sie finden nähere Einzelheiten im Kapitel Macros unter {OPERATOR}-
Macrobeispielen und beim ARRL- Sweepstakes contest. 

Stellen Sie sicher, dass Sie bei der Contesteinstellung mit File >Open Log in 
Database >Mode Category als Sendeart SSB (oder Mixed) eingetragen haben und 
nicht CW. Überprüfen Sie auch die Karteikarte Audio im Configurer. Schalten Sie im 
Splitbetrieb die Empfangsfrequenzansage mit dem @-Macro ab. 

Hinweis DM3ML : Wenn Sie das Rufzeichen und/oder den Rapport per PC 
ausgeben, werden die einzelnen Buchstaben und Ziffern aus einem Verzeichnis 
‚Letters’ entnommen, in dem WAV-Dateien für alle Buchstaben (A.wav bis Z.wav) 
und alle Ziffern (0.wav bis 9.wav) enthalten sein müssen. Dieser Zusammenbau 
dauert in der Regel deutlich länger und hört sich nicht gerade flüssig an.  

19.2. WAV-Dateien aufzeichnen (Recording WAV Files)

Stecken Sie das Mikrofon direkt an die Soundkarte. Starten Sie das 
Aufzeichnungsprogramm von Windows, stellen Sie sicher, dass der Mic-Kanal 
angezeigt wird und überprüfen Sie die Wiedergabe über den Lautsprecher. Stecken 
Sie dann das Mikrofon an den Rigblaster und den Rigblaster an die Soundkarte. 
Stellen Sie dann am Rigblaster die Wiedergabelautstärke ein. 
Überprüfen Sie den Aufzeichnungskanal und ob die NF vom Mikrofon in der 
Aussteuerungsanzeige zu sehen ist. Starten Sie dann die Aufnahmefunktion des 
Windows-Programms. Testen Sie die Aufnahme und die Wiedergabe einer 
aufgenommenen WAV-Datei. 
Jetzt können Sie die Prozedur über N1MMLogger starten. Nehmen Sie die zu den F-
Tasten gehörenden WAV-Dateien mit der Tastatureingabe Ctrl+Shift+F-Taste auf 
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und beenden Sie sie mit der gleichen Kombination. Verfolgen Sie Start und Stopp 
der Aufnahme in der Statuszeile des Eingabefensters. 
Überprüfen Sie abschließend, ob die PTT den Transceiver bei Start einer WAV-Datei 
einschaltet. Sie können die PTT auch manuell oder per VOX aktivieren.  

N1MMLogger unterstützt nur WAV-Dateien im Standard-PCM-Format. ADPCM-
Dateien müssen Sie in das Format Standard-PCM konvertieren. Weitere 
Informationen finden Sie im Kapitel Vor dem Contest (Before the contest). 

  Tipp: Verwenden Sie N1MMLogger, um Ihre WAV-Dateien aufzunehmen! Die 
aufgezeichneten Dateien werden an genau der Stelle abgelegt, wo sie beim Contest 
benötigt werden und sie haben das benötigte Format.
 
 

 Realtek HD-Soundkarten 
Wenn Ihr Rechner eine Realtek HD-Soundkarte hat, können Sie die ‘on-the-fly’-
Aufzeichnung mit N1MMLogger nicht machen. Sie müssen einen externe 
Anwendung wie den Windows Sound Recorder oder Audacity nehmen. 

19.3. Soundkartensteuerung im Configurer (Soundcard Control in 
Configurer)

Stellen Sie unter Config >Configure Port, Telnet Address, Other  auf der 
Karteikarte Audio die für die WAV-Dateien zu verwendende Soundkarte ein. 
Informieren Sie sich im Kapitel Configurer . 

  Soundkartenprobleme
 
Oft ist nichts zu hören, wenn eine WAV-Datei abgespielt werden soll. Prüfen Sie 
dann, ob die WAV-Datei richtig adressiert und vorhanden ist. Hören Sie sich die 
Sounddateien vorher mit einem Windows-Programm an. Die Abspielamplitude kann 
mit den Windows-Reglern eingestellt werden.  

20. Fehler schnell korrigieren (Quick Edit)

Wenn Sie das letzte schon abgespeicherte QSO korrigieren wollen, drücken Sie 
Ctrl+Q (Quick Edit) anstelle von Ctrl+Y (Edit last contact). Die Daten werden wieder 
in das Eingabefenster geholt. Mit ENTER werden die korrigierten Daten 
abgespeichert, mit ESC wird die Änderung verworfen. Die Farbe im Eingabefenster 
ändert sich bei Quick Edit in blau.

War das drittletzte QSO fehlerhaft? Drücken Sie Ctrl+Q dreimal. Es gelten die 
gleichen Regeln wie oben. 

  Datenprüfung bei Quick Edit 
Im Gegensatz zur normalen Eingabe werden die Eingaben unter Quick Edit nicht 
auf Richtigkeit überprüft. Seien Sie daher bei der Korrektur sorgfältig. 
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21. Bedeutung der Farben (Meaning of Colors)

Im Eingabefenster, der Bandskala, dem Prüffenster und bei den Multis sehen Sie 
Rufzeichen in unterschiedlichen Farben. Diese Farben haben folgende Bedeutung:

 

22. Multiplikatoren und QSOs (Multipliers and QSOs)

Das Programm zeigt an verschiedenen Stellen, ob ein Rufzeichen ein neues QSO, 
ein neuer Multi oder eine Doppel-Verbindung (Dupe) ist. Die angezeigten Farben 
finden Sie in der Tabelle im vorherigen Abschnitt.  

• Fenster
o Eingabefenster (Entry window)

 Das Rufzeichen oberhalb des Rufzeichenfelds zeigt die Farbe 
für neues QSO, Multi(s) oder Dupe 

 Das Rufzeichen im Rufzeichenfeld zeigt die Farbe  für neues 
QSO, Multi(s) oder Dupe  

o Angebotsfenster (Available Mults and Qs window): die Taste hat die 
Farbe für neues QSO, Multi(s) oder Dupe 

o Prüffenster (Check window): die Rufzeichenfarbe zeigt neues QSO, 
Multi(s) oder Dupe 

 Mul: Multi auf diesem Band 
 Q: neu auf diesem Band 

 Beispiel: Mul: 15 20 Q: 160 80 40 10 > Multi auf 15 und 
20 Meter und neues Call auf den anderen Bändern

o Bandskala: Die Rufzeichenfarbe steht für neues QSO, Multi(s) oder 
Dupe  

• Farben
o Blau: QSO 
o Rot: Einfacher Multi, z.B. im CQWW neues Land ODER neue Zone 
o Grün: Doppelter oder mehrfacher Multi: z.B. im CQWW neues Land 

UND neue Zone  
o Grau: Dupe 

23. Verbindung mit einem Telnet-DXCluster (Connecting to a Telnet 
Cluster)

• Gehen Sie zur Karteikarte Telnet im Packet/Telnet-Fenster 
• Wählen Sie einen Telnet-DXCluster im Menü in der oberen rechten Ecke aus 

o Sie können diese Liste im Menü im Configurer unter Config 
>Configure Ports, Telnet Address, Other >Hardware tab, Select < 
Edit  anpassen und editieren 

• Klicken Sie auf die Taste unten rechts mit ihrem Rufzeichen oder geben Sie 
Ihr Rufzeichen in der Kommandozeile oben in der Mitte ein und schließen Sie 
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die Eingabe mit ENTER. Klicken Sie nicht auf die Taste CONN, die ist nur für 
Packet-Betrieb gedacht.

24. Log sichern (How to Save the Log)

Sie benötigen keine Logsicherung. Jedes geloggte  QSO wird unmittelbar  auf der 
Festplatte in der Datei ham.db gespeichert. Hier werden alle Conteste zusammen mit 
den Einstellinformationen abgelegt. Wenn Sie einen neuen Contest anfangen, richten 
Sie ihn mit File >New Log in Database ein. Sie können auch getrennte 
Datenbanken für verschiedene Rufzeichen und verschiedene Conteste anlegen. In 
der Regel reicht aber eine Datenbank für zahlreiche Conteste und tausende QSOs 
aus. Falls Sie diese Daten sichern wollen, machen Sie von dieser Datenbank eine 
Sicherheitskopie.

25. Funktionstasten-Macros (Function Key Macros)

Die ersten 12 Funktionstasten sind dem RUN-Modus zugeordnet. Haben Sie darauf 
folgend nur 7 S&P-Tasten belegt, wird bei den Tasten F8 bis F12 im S&P-Modus der 
bei den RUN-Tasten eingetragene Text gesendet. Haben Sie  z.B. die Taste F12 
unter RUN mit dem Macro {WIPE} (=Eingabefenster löschen) belegt und die Taste 
F12 unter S&P ist leer, wird dort bei einem Druck auf F12 auch das Eingabefeld 
gelöscht.  

Wollen Sie eine leere F-Taste erzeugen, geben Sie ein Leerzeichen ein. 

Wollen Sie mit einer Taste von S&P auf RUN umschalten, geben Sie der ersten 
S&P-Taste F1 den Namen CQ und als Text QRL? (Pete's Trick). Wenn Sie die S&P-
Taste  F1 drücken wird QRL? gesendet und  N1MMLogger geht in der RUN-Modus. 
Ist die Funktion CQ automatisch wiederholen aktiv, kann der RUN-Betrieb 
losgehen. 

26. Fensterpositionen speichern und wiederherstellen (Save and Restore 
Window Positions)

Die Fensterpositionen können Sie mit den Menüpunkten Tools >Save Window 
Positions' abspeichern und mit Tools >Restore Window Positions 
wiederherstellen. Diese Funktion ist interessant, wenn mehrere OPs an einer Station 
ihre individuelle Fensteranordnung vorbereitet und während des Contests wieder 
herstellen wollen. Der Operator-Wechsel wird mit Ctrl+O vorgenommen. Der neue 
Operator kann nun mit 'Restore Window Positions' seine vorher mit 'Save Window 
Positions' abgespeicherte Fensteranordnung wieder abrufen.

  Einstellungen für Sendeart abspeichern 
Sie können die Fensteranordnung auch getrennt nach Sendearten wie RTTY, CW 
oder SSB abspeichern. Mit save / restore window positions wird die 
Fensteranordnung für die jeweils aktuelle Sendeart abgespeichert. Dieses 
Abspeichern funktioniert nicht bei mehreren OPs, Sie können aber Ihre individuellen 
Einstellungen an der Ein-Mann-Multi-Sendearten-Station abspeichern. 
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27. Tabellen editieren (Editing Lookup Tables)

Im Programm gibt es zahlreiche Tabellen, z.B. für die Funktionstasten, die Telnet-
DXCluster, Abkürzungen u.a. Sie können diese Tabellen editieren, Einträge löschen 
oder neue hinzufügen.  

• Wollen Sie eine Reihe löschen, klicken Sie auf das am weitesten links 
befindliche Feld der Reihe. Der „Stift“ springt dorthin, die Reihe wird markiert. 
Drücken Sie dann auf die Taste Delete (Entf) der Tastatur. 

• Um eine Reihe hinzuzufügen, klicken Sie auf den “Stern” in der untersten 
leeren Reihe. Eine Reihe kann nur dann hinzugefügt werden, wenn alle Felder 
der Reihe ausgefüllt worden sind. Nach Ausfüllen der Reihe wird automatisch 
eine neue leere Reihe angeboten

• Wollen Sie einen Reiheninhalt editieren, klicken Sie das Feld an und ändern 
Sie den Text. 

28. Daten sichern und wiederherstellen ( Backup and Restore)

Die von dem Programm verwendeten Informationen werden zum Teil in der 
Datenbank, zum anderen in den INI.Dateien und in zusätzlichen Unterverzeichnissen 
gespeichert. Ein Beispiel sind die WAV-Dateien für die F-Tasten. Die 
Buchstabiertabelle befindet sich im Verzeichnis Letters. Wenn Sie eine 
Datensicherung machen wollen, reicht es nicht aus, nur die Datenbanken *.mdb zu 
sichern, Sie müssen zusätzlich mehrere Verzeichnisse abspeichern. Die beste 
Lösung ist, dass gesamte N1MMLogger-Verzeichnis mit allen Unterverzeichnissen 
zu sichern (Beispiel 1). Im Beispiel 2 wird eine Teilsicherung gezeigt. 

28.1. Beispiel 1: Datensicherung des gesamten N1MMLogger-
Verzeichnissen auf dem gleichen Rechner (Full 
backup/restore on same computer - backup and restore the 
whole N1MM logger subdirectory)

• Sichern Sie das gesamte N1MMLogger-Verzeichnis 
• Stellen Sie das gesamte N1MMLogger-Verzeichnis wieder her 

28.2. Beispiel 2: Teil-Sicherung/-Wiederherstellung auf dem 
gleichen Rechner (Partial backup/restore on same computer - 
make a partial backup and restore)

Sie sollten alle Einstellungen (Textdateien, WAV-Dateien) zusätzlich zu den 
Datenbanken (*.mdb) auf einem externen Speicher (CD, DVD, USB-Stick) speichern, 
falls Ihr Rechner mal total abstürzt. 

• Sichern Sie diese Dateien: 
o Die Datenbanken enthalten alle Contest-QSOs, die 

Stationsinformationen und die Texte der F-Tasten 
o N1MM Logger.ini 

 Enthält die Windowseinstellungen, Transceivereinstellungen, 
RTTY-Einstellungen u.ä. vom Configurer, sowie die Angaben 
zum letzten Contest 
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o Wav-Dateien 
 In den F-Tasten verwendete WAV-Dateien, so wie die 

Buchstabier-WAV-Dateien aus dem Verzeichnis Letters 
 Aufgezeichnete  QSOs, sie werden in einem Unterverzeichnis 

unter N1MMLogger gespeichert und können sehr groß werden 
o weitere? 

  Backup und Restore sind keine Kopier-Funktion  

Mit der Datensicherung und Wiederherstellung können Sie N1MMLogger NICHT auf 
einem neuen Computer zum Laufen bringen. Sie müssen in jedem Fall auf dem 
neuen Computer eine volle Installation starten. 

28.3. Installation auf einem anderen Computer (Installing on a 
Different Computer)

Wenn Sie einen anderen Computer für N1MMLogger einrichten wollen, müssen Sie 
als erstes eine volle Installation starten, um alle *.dll-, *.ocx- und andere Dateien an 
die richtige Stelle zu bringen und sie unter Windows zu registrieren. Danach (!) 
können Sie die gesicherten *.mdb-Dateien und anderen Dateien über die nach der 
Installation eingerichteten Dateien kopieren und damit die Einstellungen vom 
vorhergehenden Rechner übernehmen. 

Sie müssen aber die Konfiguration bezüglich der Schnittstellen, der verwendeten 
Verzeichnisse, der Bildschirmauflösung usw. auf dem neuen Computer überprüfen. 
Möglicherweise bekommen Sie ein paar Probleme.  

Copy, zip, cd/rw usw. 

Mit WinZip oder einem ähnlichen Programm können Sie Dateien auf etwa 10..25 % 
komprimieren und damit besser archivieren. Mit dem Menüpunkt File > Copy (and 
compact) database können Sie die Datenbank ebenfalls kleiner machen. Hier 
werden vor dem Kopieren als gelöscht markierte Einträge, die aber noch in der 
Datenbank vorhanden sind, endgültig entfernt.  

Ein guter Weg ist es, eine Kopie des gesamten N1MMLogger-Verzeichnisses auf 
einer CD zu speichern. Eine weitere Möglichkeit ist der Abzug auf einer anderen 
Rechner-Festplatte oder auf einer Festplatte im PC-Netz.

29. Grundfunktionen für RTTY (Basic Functions for RTTY)

Hier sind vier RTTY-Betriebstipps von Rick, N2AMG 

1. Verwenden Sie die Maus, um ein Rufzeichen in das Eingabefeld zu 
übernehmen. Klicken Sie auf das Rufzeichen im RX-Fenster und es wird 
übernommen. Klicken Sie dann auf die empfangene Kontrollnummer und 
sie wird in das Feld Exchange übernommen.  Oder verwenden Sie die 
Taste Insert (Einfg), um ein Rufzeichen aus dem Grab-Fenster in das 
Eingabefeld zu setzen und ihr Rufzeichen zu senden. Das spart Zeit.
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2. Wenn Sie auf ein Rufzeichen klicken und es in das Rufzeichenfeld des 
Eingabefensters setzen, müssen Sie eigentlich noch auf die Leertaste 
drücken, um in das nächste Eingabefeld zu kommen.  Brauchen Sie nicht! 
Gehen Sie zu Window >Digital Interface und dann zu Setup >Settings 
und wählen Sie Send space after callsign click. Wählen Sie auch Setup 
>'Rt click= Return NOT Menu' 

3. Versuchen Sie Rt click= Return NOT Menu einzuschalten. Diese 
Einstellung bewirkt, dass ein rechter Mausklick im RX-Fenster ein ENTER 
erzeugt. Sie brauchen also im ESM-Modus nicht die Maus wegzulegen 
und ENTER auf der Tastatur zu drücken. Die Maus macht alles.  

4. Maus aufsetzen (Hover mode): Sie können den Mauszeiger ohne Klick 
auf ein Rufzeichen setzen und es wird übernommen. Sie können diesen 
Modus im Digital-Fenster mit dem Menü Setup >'Turn Hover Mode 
On/Off' aktivieren.

Last Modification: 05 October 2009 07:00:06 EDT by n4zr. 
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Erweiterte Funktionen (Advanced Functions)

Im Kapitel Grundfunktionen (Basic Functions) haben Sie die Standardroutinen wie 
den Frequenzwechsel, Bandwechsel und Sendeartenwechsel kennen gelernt. In 
diesem Kapitel werden wir Sie mit weiteren Möglichkeiten bekannt machen. Sie 
werden diese Möglichkeiten seltener nutzen, sollten Sie aber kennen.

1. Unterstützung von Mobilbetrieb (Mobile/Rover Support)

Bei den ARRL-VHF-Contesten gibt es eine Teilnehmerklasse „Rover“ für 
Mobilstationen, die innerhalb des Contests den Standort wechseln. N1MMLogger 
unterstützt diese Klasse mit der "Rover"-Kategorie und dem "RoverQTH". 

Das RoverQTH kann eingetragen werden  

• Im Stationsfenster. Dieser Eintrag wird automatisch korrigiert, wenn Sie die 
Methoden zum Eintrag des RoverQTH verwenden.

• Mit einem Rechtsklick in das County- oder Gridfeld im Multiplikatorfenster 
window 

• Mit der Eingabe ROVERQTH + Enter in das Rufzeichenfeld des 
Eingabefensters 

Das aktuelle RoverQTH wird im Eingabefenster angezeigt und aktiviert, wenn Sie in 
der Operator-Kategorie ROVER eingetragen haben. 

1.1. So arbeitet Mobile/Rover (How Mobile/Rover Works)

Tragen Sie unter File > Open Log in Database >Contest tab >Mode Category  die 
Kategorie "Rover" ein.

Geben Sie "roverqth" in das Rufzeichenfeld des Eingabefelds ein. Es öffnet sich ein 
Menü, wo sie den County-Kenner mit 3..4 Buchstaben eintragen und mit ENTER 
abschließen. Damit wird das aktuelle QTH geändert. Das QTH wird an der oberen 
Begrenzung des Eingabefelds angezeigt. Mit dem Macro {ROVERQTH} wird der 
jeweils aktuelle Standort ausgegeben. Beachten Sie auch die RoverQTH-Spalte im 
Log. Sie können mit diesem Werkzeug Ihren neuen Standort sowohl im Log als auch 
in den F-Tasten anpassen. Es wird ein korrektes Cabrillo-Log erzeugt.  

Das RoverQTH kann bis zu 10 Zeichen lang sein, aber die meisten Cabrillo-Logs 
geben nur fünf oder sechs Zeichen aus. Das Macro {ROVERQTH} sendet das 
RoverQTH. 

2. Rufzeichenvorgeschichte nachsehen (Call History Lookup)

In verschiedenen Contesten kann die Kontrollnummer im Voraus bestimmt werden, 
wenn das Rufzeichen bekannt ist. Diese Kontrollnummer wird dann schon in das 
Kontrollnummernfeld eingetragen und muss nur noch verifiziert werden. In den US 
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Sweepstakes Contesten werden die Check-Nummer (Jahr der Lizenzierung 
zweistellig) und die ARRL-Sektion in der Rufzeichengeschichte abgespeichert. 

Bei der Vorbereitung auf einen Contest können Sie die Datei mit der Vorgeschichte 
angeben und welche Felder dort erfasst sind. Ist keine Vorgabe gemacht, wird die 
Vorgeschichte im Eingabefenster eingetragen:

Eine Vorausschau wird dann gemacht, wenn der Cursor im Rufzeichenfeld steht und 
die Leertaste oder ENTER (bei ESM) gedrückt wurden. In VHF-Contesten wird aus 
dem ermittelten Lokator die Antennenrichtung in der Bandskala, dem Multi-Fenster, 
dem Info-Fenster und dem Eingabefenster berechnet.

  Nur ein Rufzeichen in der Tabelle möglich 
Die Vorgeschichtstabelle kann immer nur eine Vorgeschichte zu einem Rufzeichen 
abspeichern. Es bleibt so lange darin, bis es durch einen neuen Eintrag ersetzt wird 
und unabhängig vom aktuellen Contest. Die Vorschau kann generell abgeschaltet 
werden. 
Die Vorschautabelle ist nur einmal als separate Tabelle  per Datenbank abgelegt und 
heißt CallHist. Im Eingabefenster können Sie per Menü die Vorschau steuern: 

• Config >Call History Lookup 

Schaltet die Rufzeichengeschichte ein oder aus. In dieser Tabelle können 
Namen, Lokator, Sektion, Staat, Alter und ähnliches während des Contests 
gespeichert und abgerufen werden. Diese Einstellung kostet einige 
Rechenleistung. Die Tabelle wird mit 'Import Call History' gefüllt und sie 
muss für den Contest vorbereitet und zugewiesen sein. Vorkehrungen 
wurden für diese zusätzlichen Einträge getroffen: State, Geburtsdatum und 
CK. Die Werte stehen in der Tabelle, haben aber keinen Einfluss auf das 
Log. 

• Menü File >Import >Import Import Call History 

Mit dieser Option können Sie Informationen zu Rufzeichen wie Name, 
Provinz, Alter, Lokator u.ä. zu einem Rufzeichen von früheren Contesten 
her importieren, falls eine entsprechende Datei vorhanden ist. In RTTY gibt 
es z.B. die Namendatei RTTY_friends. Informieren Sie sich in den Kapiteln 
Vor dem Contest und Conteste auf VHF und höher. Informieren Sie sich 
über die zur Verfügung stehenden Listen und importieren Sie als erstes. 
Sie überschreiben die aktuelle Callhist-Tabelle. Für UKW-Conteste gibt es 
eine europäische Lokator-Liste. Ein europäischer Contest ist der VHFReg1 
für den diese Rufzeichenliste mit QTH-Kennern genutzt werden kann.

• Menü File >Import >Export Call History 

Exportiert die Information in die Call History-Tabelle. Diese Tabelle kann 
nur über 'Import Call History' gefüllt werden.

• Menü Tools >Update Call History with Current Log 
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Aktualisiert die ausgewählte Vorschautabelle während des Contests aus 
dem aktuellen Log. Es werden Kontakte hinzugefügt oder aktualisiert, 
wenn das Rufzeichen bereits in der Tabelle steht. Für die beiden 
Lokatorfelder ist das Verfahren davon abweichend. Sind bereits zwei 
Lokatoren in der Tabelle eingetragen und ein neuer dritter Lokator wird 
festgestellt, wird der jeweils zweite (älteste) Eintrag mit dem neuen Lokator 
überschrieben. Der neue Lokator wird an die erste Stelle gesetzt. Bei 
einem neuen zweiten Lokator wird der erste an die zweite Stelle 
geschoben und dafür der neue Lokator als erster eingetragen. Ein 4-
stelliger Lokator wird durch einen 6-stelligen Lokator überschrieben, wenn 
die ersten vier Stellen identisch sind.  

2.1. Rufzeichengeschichte erzeugen (Creating a Lookup File for 
Importing into CallHist Table)

Die Importfunktion benötigt eine Textdatei mit dieser Struktur: Callsign (15), Name 
(25), Grid1 (6), Grid2 (6), Section (5), State (5), CK , Birthdate. In Klammern steht 
die maximale Feldlänge. Als Trennzeichen sind Komma, Semikolon, Zwischenraum 
oder Gleichheitszeichen gestattet. Die Trennzeichen können gemischt sein, müssen 
aber innerhalb einer Zeile gleich sein. Das Rufzeichen (Callsign) muss vorhanden 
sein, die anderen Einträge sind wahlfrei. Es kann auch eine der von RTTY-
Contestprogrammen bekannten Datei friends.ini eingelesen werden. Für CK muss 
ein Integer stehen und für Birthdate (Geburtsdatum) ein Datum.
Für eine fehlendes CK muss ein -1 stehen, sonst sind Werte zwischen 00 bis 99 (von 
den ARRL Sweepstakes) erlaubt. Aus dem Geburtsdatum kann für den AA-Contest 
das Alter ermittelt werden. Das Datum muss im Format jjjj-mm-dd (z.B. 1980-12-31) 
eingetragen sein.

Beispiele für Einträge in der Rufzeichengeschichte sind:

Call+Name Call+Lokator(en) Call+US-Staat 
N1MM,Tom PI4GN,,JO33II,JO33jf, N1MM,Tom,,,,CT 
N2AMG;Rick PA5DD=Uffe=JO22ic= K3ZO;Fred;;;;MD 
WW3S=Jamie PA1T,Timon,JO33jf,

oder 

K1CC,RICH, FN31,FN32,,, -1,1900-01-01
KG1D,LES ,,,,, -1,1900-01-01
N1MM,TOM,FN31,,CT,CT,61, 1949-10-01
# this is comments (line starts with a #)
W1RM,PETE ,,,,,-1 1960-01-01 

• Das Rufzeichen wird unbedingt benötigt
• Wird der Lokator benötigt, aber der Name ist nicht bekannt, wird zweimal ein 

Trennzeichen gesetzt. Ist nur ein Lokator (Grid) bekannt, wird für den zweiten 
Lokator ebenfalls ein Trennzeichen gesetzt, wenn weitere Angaben folgen.

• Beim Beispiel mit ‘State’ wird für jeden fehlenden Eintrag (im Beispiel vier) ein 
Komma gesetzt 
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• Die Zahl der Zeilen ist nicht begrenzt. Bei einem Europa-VHF-Contest 
kommen über 50 000 Zeilen zusammen. Auf der N1MM-Webseite finden Sie 
eine solche Datei von PA1M unter Downloads > Other Files. 

• Sobald Sie die Leer- oder TAB-Taste nach einer Rufzeicheneingabe drücken, 
wird in der Tabelle nach den Daten gesucht.  

• Sie können in die Rufzeichengeschichtstabelle Kommentare einbauen. Die 
Zeile muss mit einem # anfangen 

• Die Sweepstakes benötigen Section und CK, der 10m-Contest benötigt den 
State und NAQP benötigt Name & State. PAbeker benötigt die holländische 
Section,  VHFREG1 benötigt die Felder Grid1, Grid2 und Name etc.  Benötigt 
der Contest keine solche Angaben, haben Sie Pech! 

• Um festzustellen, ob der Contest Ihrer Wahl auf die Rufzeichengeschichte 
zugreift, sollten Sie einen Eintrag mit unverwechselbaren Daten erzeugen und 
dann das zugehörige Rufzeichen in das Eingabefeld eintragen und 
Leerzeichen oder TAB drücken. Sie sehen dann, welche Daten unten im 
Eingabefeld erscheinen. 

• Carel, PC5M, hat das Werkzeug 'Thucydides' geschrieben, mit dem 
Rufzeichengeschichtsdateien erzeugt werden können. Sehen Sie unter 
Drittprogrammen (Third Party Software) nach. 

2.1.1. Tip 1 von Kenny, K2KW

Wer kein Datenbank-Fan ist, kann eine Tabelle relativ leicht mit Excel herstellen. 
Teilen Sie die Daten aus einem alten Log auf die oben beschriebenen Spalten auf. 
Sie können ein Log auch als Textdatei nach Excel importieren. Erzeugen Sie eine 
Tabelle mit den 8 Datenfeldern und dazwischen 7 Felder mit einem Komma. Sie 
haben dann 15 Spalten. Verwenden Sie in der 16.Spalte die EXCEL-Funktion 
Verketten (z.B. fx=VERKETTEN(A1;B1;C1;D1;E1;…). Mit dieser Funktion werden die 
Daten der 15 Spalten in der 16.Spalte als lange Zeichenkette zusammengefasst. Die 
16.Spalte wird dann als ASCII-Datei exportiert und bildet die gewünschte 
Rufzeichengeschichte.

2.1.2. Tip 2 von Tom, N1MM

Gehen Sie ins Logfenster und wählen Sie ‘Select All' und geben Sie die Daten dann 
mit Copy > 'Copy Generic Print String' aus. Die Daten kommen in die 
Zwischenablage von Windows und können von dort nach Excel kopiert werden.  

2.1.3. Tip 3 von Thomas, PA1M

Verwenden Sie 'Thucydides' von Carel, PC5M . Sie können eine  separate 
Datenbank aufbauen, in der alle QSO-Daten oder die Daten von anderen history.txt 
– Dateien gespeichert werden. Thucydides hat alle Felder von Contesten, z.B. ARRL 
states, German DOK's, Dutch provinces usw.. Sie können Ihre Logs importieren und 
separat abspeichern. Wenn Sie für einen bestimmten Contest eine Datei history.txt 
mit speziellen Angaben benötigen können Sie Thucydides instruieren, welche Daten 
Sie benötigen. Thucydides ändert die Logdaten nicht, sie können sicher damit 
arbeiten. Die Nutzung ist auf Conteste begrenzt, die eine Rufzeichengeschichte 
verarbeiten können. 
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2.2. Rufzeichengeschichte aktualisieren (How to update the Call 
History)

N1MM verwendet die Rufzeichengeschichte NICHT automatisch und ändert sie auch 
nicht ohne einen weiteren Eingriff. Sie können Sie auf zwei Wegen aktualisieren: 

1. Verwenden Sie das Menü Tools > 'Update Call History with current log'. 
Die aktuelle Rufzeichengeschichte wird mit den Daten des aktuellen Contests 
aktualisiert.  

2. Exportieren Sie die alte Rufzeichengeschichte und verwenden Sie ein 
externes Programm, um sie mit neuen Daten zu mischen. Importieren Sie 
dann die neue Rufzeichengeschichte wieder. 

Beispiele für Dateien zur Rufzeichengeschichte finden Sie auf der N1MM-Webseite 
unter Downloads > Other files. 

  Sichern einer alten Rufzeichengeschichte 
Wenn Sie eine neue Datei der Rufzeichengeschichte importieren, wird die alte Datei 
in der Datenbank gelöscht. Machen Sie vorsichtshalber vorher eine Kopie der alten 
Rufzeichengeschichte. 

3. Auf einem Band mit zwei Transceivern senden (Transmit on same 
band with two radios)

In einigen Contesten wie dem IARU-Contest ist es erlaubt in CW und SSB zur 
gleichen Zeit in einem Band zu senden. Um in dieser Klasse teilzunehmen müssen 
Sie die Kategorie auf Multi-Multi und  die Sendeart auf Mixed einstellen. Sie können 
zu gleichen Zeit CQ-Rufen ohne dass die Transceiver gegenseitig blockiert sind. 
Entfernen Sie unter Config > Multi User Tools den Haken bei Force Other Station 
to Stop Transmitting when I Transmit .

Die Interlock-Methode arbeitet bei Paketverzögerungen von bis zu 400 ms. Wenn 
zwei Operator gleichzeitig die Taste F1 drücken, fangen beide Stationen an zu 
senden, prüfen aber innerhalb von 100ms, ob die andere Station auf dem gleichen 
Band in der gleichen Sendeart arbeitet. In diesem Fall schaltet die Station mit der 
höheren Nummer zurück auf Empfang und bekommt die Mitteilung: "Another station 
is already sending". Natürlich werden beide Stationen bei einer höheren 
Paketverzögerung entsprechend länger senden, aber in der Praxis dauert das 
höchstens 100-200 ms ( zuzüglich der PTT-Verzögerung) und es passiert nur wenn 
beide Stationen (Run- und Multistation) auf dem gleichen Band und in der gleichen 
Sendeart senden und die OPs die F1- oder eine andere Sendetaste zur gleichen Zeit 
drücken. 

4. Der Schalter Dicke Station gegen Kleines Licht (Big Gun versus Little 
Pistol switch)

Eine Einstellung im Configurer > Karteikarte Function Keys ist 'ESM only sends 
your call once in S&P, then ready to copy received exchange'. Hier wird im S&P-
Modus nur einmal das eigene Rufzeichen gesendet und der Cursor nach ENTER 
gleich in das Contestnummernfeld gesetzt. Wenn Sie aber mehrmals anrufen, 
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müssen bis Sie dran kommen, schalten Sie diese Funktion aus. Sie ist nur bei 
Stationen sinnvoll, die wissen, dass sie in der Regel gleich drankommen. 

 Big Gun Tipp 
Sollten Sie eine Dicke Station sein, aber doch manchmal nicht gleich drankommen, 
programmieren Sie die Taste F8 anstelle von ‘again’ mit Ihrem eigenen Rufzeichen. 
Dann wird im ESM-Modus Ihr Rufzeichen mit ENTER noch einmal gesendet, der 
Cursor steht aber schon im Nummernfeld. 
73 de Ted W4NZ 

5. Im Run-Modus (für DX-Expeditionen) oder im S&P-Modus bleiben 
(Staying in Run Mode (great for Dxpeditions) or in S&P mode)

Als Dxpedition wollen Sie sich zu jeder Zeit im Run-Modus bleiben und nicht in den 
S&P-Modus gehen. Oder Sie wollen nur andere Stationen anrufen und ständig im 
S&P-Modus bleiben. Sie können diese Zustände mit der Taste Alt+F11 hin- und 
herschalten.  In der Statuszeile steht dann bei einer Dxpedition die Zeile ‚Run/S&P 
auto-toggle disabled’ = Dxpedition mode. Zurück steht dann dort 'S&P and Run 
Mode enabled'. 

6. Sofort-Start (Auto Send)

Mit Autosend ( Ctrl+Shift+M ) wird auf Senden geschaltet, sobald Sie eine 
bestimmte Anzahl an Zeichen in das Rufzeichenfeld eingetragen haben und dabei 
sind das Rufzeichen vollständig einzugeben. Die minimale Zahl ist n= ‘1’. Eine ‘0’ 
schaltet diese Funktion ab. Die Funktion ist nur im Run-Modus wirksam. 
Die Regel ist:  

1. Gesucht wird der erste Buchstabe des Rufzeichens 
2. Gesucht wird die letzte Ziffer im Rufzeichen 
3. Mit dem n-ten Buchstaben nach 2. wird mit dem Senden angefangen 

Ein Beispiel für eine Schwelle mit n=2 ist: 

• W4WYP schaltet nach Eingabe des Y auf Senden 
• S57AD schaltet nach Eingabe des D auf Senden
• KH6/WA4WYP schaltet nach Eingabe des Y auf Senden und erkennt das ‘/’ 
• WA4WYP/4 schaltet nach Eingabe des Y auf Senden (/4 hat keinen Effekt) 

WYP, WWYP und WAWYP erfüllen die Bedingung für den Sofort-Start nicht. 
Vorgestellte Prefixe wie KH6/ werden ignoriert und lösen den Sofort-Start nicht aus. . 

7. ESM-Modus: ENTER sendet die Texte (Enter Sends Messages (ESM) 
Mode)

Haben Sie "Enter Sends Messages" in der Konfiguration aktiv geschaltet, brauchen 
Sie nur noch ein paar Mal die ENTER-Taste drücken, wenn Sie ein QSO abwickeln 
wollen. Der Modus ESM arbeitet sowohl im Run- als auch im S&P-Modus, natürlich 
mit den zugehörigen Macros. Sie können den ESM-Modus auch mit Ctrl+M 
einschalten. 
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Hinweis DM3ML: Bei ESM-Betrieb wird ausgehend vom Zustand der Felder des 
Logeingabefensters die unten erklärte Statustabelle abgearbeitet.

7.1. Grundfunktionen von ESM (Basic ESM Functionality)

Ist das Rufzeichenfeld im Logeingabefenster leer, wird nach einem ENTER ein CQ 
gesendet. Sie erhalten einen Anruf und geben das Rufzeichen ein. Das nächste 
ENTER sendet das Rufzeichen der Gegenstation und die Kontrollnummer. Der 
Cursor geht ins Nummernfeld. Die Gegenstation sendet die Kontrollnummer, die Sie 
in das Nummerfeld eintragen. Das dritte ENTER bestätigt den Empfang, sendet QRZ 
und das QSO wird geloggt. Danach geht’s es von vorn los.  

Ein typisches QSO von N1MM im Run-Modus im CQ WW CW Contest sieht so aus: 

• Das erste ENTER sendet CQ N1MM 
• PA1M ruft an, Eintrag ins Rufzeichenfeld "PA1M" 
• Das zweite ENTER sendet "PA1M 5NN T5". Das Programm hat die Zone 14 

von PA1M schon automatisch eingetragen 
• PA1M sendet "599 14" , Sie kontrollieren, ob die Zone stimmt 
• Das dritte ENTER loggt das QSO und sendet "TU  QRZ de N1MM" 

PA1M arbeitet als S&P-Station, verwendet aber auch ESM:  

• PA1M hört CQ de N1MM und trägt "N1MM" ins Rufzeichenfeld ein
• Das erste ENTER sendet "PA1M". Das Programm hat schon “05” als Zone 

eingetragen 
• N1MM sendet "PA1M 5NN T5". PA1M kontrolliert, ob die Zone stimmt 
• Das zweite ENTER sendet "599 14" 
• N1MM sendet "TU QRZ de N1MM". Das QSO ist komplett. 

N1MM muss dreimal ENTER eingeben, PA1M zweimal. Beide mussten nur das 
jeweilige Rufzeichen eintragen. In anderen Contest wie dem WPX muss auch noch 
die Kontrollnummer gehört und eingetragen werden. In allen Fällen wird aber die 
Arbeit mit der Tastatur durch ESM auf ein Minimum reduziert. 

In der Hektik können Sie aber mitunter den Überblick verlieren, was das Programm 
als nächstes beabsichtigt. Um den aktuellen Status anzuzeigen, ändern die 
Funktionstasten im Logeingabefenster abhängig vom aktuellen Status Ihre Farbe in 
Blau um anzuzeigen, welcher Text als nächster gesendet werden wird, um Sie auf 
dem Laufenden zu halten. 

Sie werden mitunter aus dem Rhythmus kommen. Sie können dann wie bisher mit 
den F-Tasten weiter machen und ein QSO zu Ende bringen. Beenden Sie das QSO 
mit ALT+ENTER, damit wird das QSO geloggt, aber nichts gesendet. Mit dem 
nächsten QSO können Sie wieder im ESM-Modus weiter machen. 
Der Cursor bleibt im Rufzeicheneingabefeld solange wie Sie: 

• Nur ein Prefix und höchstens einen Buchstaben als Suffix eingegeben haben.
• Der Prefix mit einem Buchstaben und einer Ziffer eingegeben wurde
• Der Prefix bestehend aus einer Ziffer, einem Buchstaben, wieder einer Ziffer 

und dann einem Buchstaben des Suffixes eingegeben wurde 
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Sie brauchen bei ESM die Zwischenraumtaste nur, wenn Sie zwischen dem 
Rufzeichen und dem Kontrollnummernfeld hin- und herschalten und einen Fehler 
verbessern wollen. 

  Ein CQ unterbrechen 
Wenn Sie während eines CQ-Rufs ein Zeichen in das Rufzeichenfeld eingeben, wird 
unter ESM der CQ-Ruf angebrochen, wenn Sie in der Konfiguration unter 
Configurer >Function Keys >ESM only sends your call once in S&P gewählt 
haben. 

Wenn alle Daten des QSO fehlerfrei eingetragen sind, arbeitet ESM wie in den 
Beispielen angegeben. Sind einzelne Daten unvollständig, werden abhängig vom 
aktuellen QSO-Status mit jedem ENTER andere auf den F-Tasten vorprogrammierte 
Texte abgerufen bis das QSO komplett ist und geloggt werden kann.
Welche Texte bzw. Tasten abgerufen werden entnehmen Sie der folgenden 
Zustandstabelle: 

RUN-Modus S&P-Modus
Rufzeichenfeld Kontrollnummernfeld ENTER sendet ENTER sendet 
Leer Leer CQ (F1) My Call (F4) 

Neues Call 1.Versuch Leer oder ungültig His Call + Exch 
(F5 + F2) My Call (F4) 

Neues Call wiederholt Leer oder ungültig Again? (F8) My Call (F4) 

Neues Rufzeichen Gültig, vor dem Senden His Call + Exch 
(F5 + F2)

Exchange (F2) 
+ Loggen 

Neues Rufzeichen Gültig, nach dem 
Senden

End QSO + Log 
(F3 + Loggen)

Sendet nichts + 
Loggen 

DUPE-Rufzeichen Leer oder ungültig QSO B4 (F6) nichts 

DUPE-Rufzeichen Gültig, vor dem Senden QSO B4 (F6) Exchange (F2) 
+ Loggen 

DUPE-Rufzeichen Gültig, nach dem 
Senden

End QSO + Log 
(F3 + Loggen) nichts

DUPE zum Ersten, Work 
Dupes nicht aktiv Leer oder ungültig His Call + Exch 

(F5 + F2) QSO B4 (F6) 

DUPE wiederholt, Work 
Dupes nicht aktiv Leer oder ungültig Again? (F8) QSO B4 (F6) 

DUPE arbeiten erlaubt Gültig, vor dem Senden His Call + Exch 
(F5 + F2)

Exchange (F2) 
+ Loggen 

DUPE arbeiten erlaubt Gültig, nach dem 
Senden

End QSO + Log 
(F3 + Log It) nichts

 Again? (F8) 

Wenn Sie in ESM und im S&P-Modus sind und der Cursor nicht im Rufzeichenfeld 
steht, aber die Kontrollnummer noch nicht vollständig ist, sendet das Programm die 
Taste F8 ‘Again?’. 

Steht über dem Rufzeichenfeld ein DUPE-Rufzeichen, wird das Rufzeichen in das 
Rufzeichenfeld übernommen und hell getastet. 
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Welcher Text gesendet wird, legen Sie beim Editieren der Texte für den Run-Modus 
und den S&P-Modus für die Funktionstasten CQ Key, Exchange Key, My Call Key, 
usw.) im Menü Config > Change Packet/CW/SSB Digital Message Buttons fest. 
Sie können 24 Texte editieren, die ersten zwölf gehören zum Run-Modus, die 
nächsten 12 zum S&P-Modus. Jede Senderart (CW, SSB, Digital) hat ihren eigenen 
Textsatz, die mit dem Programm abgespeichert werden. Überprüfen Sie die 
Einstellungen vor einem Contest. Sie können den Text einer einzelnen Taste auch 
während eines Contest mit einem Rechtsklick auf die Taste im Logeingabefenster 
ändern.

7.2. Cursor am Weiterschalten ins nächste Feld hindern (How to 
Prevent the Cursor from Moving to the Next Exchange Field)

Wenn Sie bei ESM im Run-Modus sind und das Rufzeichen der Gegenstation noch 
nicht vollständig haben, aber mit ENTER senden, springt der Cursor in das 
Kontrollnummernfeld. Sie müssen das Rufzeichen aber noch vollständig eingeben 
oder korrigieren: 

Lösung 1:  Wenn Sie ENTER unter ESM im Run-Modus eingeben, wird an die Stelle 
des Cursors ein hell getastetes ? gesetzt. Wenn Sie z.B. ein ‘J’ an dieser Stelle 
eingeben, ändert sich das Fragezeichen und Sie können das komplette Rufzeichen 
z.B. G4UJS eingeben. Wenn Sie die Leertaste drücken, wird das ? ebenfalls hell 
getastet und Sie können das Rufzeichen ohne Entf oder Rückschritt (Backspace) 
korrigieren. 

Lösung 2: Geben Sie ein ? als Rufzeichen ein 
Bei einem Fragezeichen im Rufzeichenfeld bleibt der Cursor im Rufzeichenfeld und 
tastet das ? hell.

7.3. Senden des Rufzeichens oder der Kontrollnummer in SSB 
überspringen (How to Skip Sending the Callsign or Exchange 
Field (SSB)?)

Um zu verhindern, dass die PTT nach dem Einstellen auf ESM in SSB aktiviert wird, 
geben Sie ein Leerzeichen ein. Das Programm schaltet dann die PTT nicht zu und 
simuliert die Aktivierung der Leertaste. 

  Achten Sie auf die lila gefärbte Taste:
Wenn Sie die ENTER-Taste gedrückt haben, wird die nächste zu sendende Taste lila 
hinterlegt. Gefällt Ihnen die Wahl von N1MMLogger nicht, können Sie eine andere 
Taste drücken.  

8. Ein QSY löscht das Rufzeichen und spottet das Call in der Bandskala 
(QSYing Wipes the Call & Spots QSO in Bandmap)

Haben Sie in der Konfiguration Config >QSYing Wipes the Call & Spots QSO in 
Bandmap aktiviert, wird ein Rufzeichen, das Sie schon im Rufzeichenfeld hatten, 
aber nicht erreicht haben, bei einer Frequenzänderung aus dem Rufzeichenfeld 
gelöscht und als Spot fett markiert in die Bandskala gesetzt. Dieser Spot wird nur 
lokal eingetragen, aber NICHT über den DXCluster gesendet. Jedes Rufzeichen, das 
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länger als 3 Zeichen ist, wird in die Bandskala eingetragen. Sie können dann später 
zu diesem Rufzeichen zurückkehren und es erneut versuchen.
Mit dieser Methode kann eine MULT-Station auch eine Bandskala mit Rufzeichen für 
die meist besser ausgerüstete RUN-Station füllen.

Machen Sie mal folgendes: 

• Stimmen Sie auf 21200 ab 
• Geben Sie VU2PTT ein 
• Verstimmen Sie den Transceiver 
• VU2PTT wird auf 21200 fett markiert gespottet, das Rufzeichenfeld wird 

gelöscht 
• Stimmen Sie auf 21208 ab 
• Geben Sie G4UJS ein 
• Drehen Sie den VFO weiter 
• G4UJS wird auf 21208 fett markiert gespottet. Das Rufzeichenfeld wird 

gelöscht 
• Machen Sie weiter, so lange Sie Lust haben 
• Gehen Sie zurück und arbeiten Sie mit Ctrl+Pfeil nach oben bzw. unten die 

Bandskala nach den noch nicht gearbeiteten Stationen durch

Wenn Sie einen Haken bei Config >Spot all S&P QSOs gemacht haben, werden 
alle diese Stationen, wenn Sie sie gearbeitet haben, im DXCluster gespottet.

Hinweis DM3ML: Seien Sie so nett und schalten diese Funktion NICHT ein! 

9. Rufzeichen-Stapelspeicher (Single Operator Call Stacking)

Sie können erkannte Rufzeichen mit Macros oder Tastenkombinationen in einen 
Stapelspeicher schicken und von dort wieder abrufen. Diese Kombinationen sind 
{SOCALLSTACK}, {STACKANOTHER}, CTRL+ALT+G, {LOGTHENPOP} und 
ALT+D. Die ersten drei schicken Rufzeichen in den Stapelspeicher, die letzten zwei 
rufen Sie von dort wieder ab. Diese Macros arbeiten nur im RUN-Modus, die 
Rufzeichen im Stapelspeicher werden in der Bandskala neben der CQ-Frequenz 
angezeigt. Der Stapelspeicher kann in CW, Phone und in Digimodes verwendet 
werden und ist kompatibel mit Handtastung oder ESM. Er kann im SO1V, SO2V und 
SO2R-Modus und bei M/M-Stationen verwendet werden.

{SOCALLSTACK} oder {STACKANOTHER} oder CTRL+ALT+G
Der Operator kann Teil-Rufzeichen, die ein hell getastetes ? enthalten, oder volle 
Rufzeichen in den Stapelspeicher schicken. Die beiden Macros {SOCALLSTACK} 
und {STACKANOTHER} unterscheiden sich geringfügig: 

{STACKANOTHER} oder die Tastenkombination CTRL+ALT+G schicken ein 
Rufzeichen in den Stapelspeicher und leeren das Rufzeichenfeld. 

{SOCALLSTACK} arbeitet als einfaches Stapel-Macro. Beim ersten Aufruf von 
{SOCALLSTACK} wird das erste Rufzeichen in den Stapelspeicher geschickt und 
das Rufzeichenfeld geleert. Wenn ein zweites Rufzeichen eingegeben und 
{SOCALLSTACK} erneut aktiviert wird, werden die beiden Rufzeichen miteinander 
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vertauscht. Das zweite Rufzeichen wird in den Stapelspeicher geschickt und das 
erste Rufzeichen wieder in das Rufzeichenfeld geholt.

{LOGTHENPOP}, ALT+D: Die Rufzeichen werden mit verschiedenen Methoden 
wieder aus dem Stapelspeicher geholt. Das aktuelle Rufzeichen wird geloggt und mit 
{LOGTHENPOP} ein Rufzeichen aus dem Stapelspeicher geholt oder mit ALT+D aus 
dem Stapelspeicher entfernt. ALT+D ist dann nützlich, wenn das Rufzeichen aus 
einem Telnet-Spot kommt. Das nächste Rufzeichen steht über dem Rufzeichenfeld 
bereit, wenn CQ nicht aktiv ist. Mit einem Leerzeichen wird das Rufzeichen über dem 
Rufzeichenfeld in das Rufzeichenfeld übernommen und aus der Bandskala gelöscht. 

ESM-Automatisierung: Im Configurer kann auf der Karteikarte Function Key die 
Taste Next Call (nächstes Rufzeichen) definiert werden, die das Macro 
{LOGTHENPOP} zusammen mit dem Info-Text für die ESM-Automatisierung enthält. 
Mit der letzten Option im Menü kann die Funktion ESM-SOCallstacking abgeschaltet 
werden. 

SOCALLSTACK-ESM-Beispiel: Die Taste F9 ist mit dem Macro 
{STACKANOTHER} oder {SOCALLSTACK} belegt. Die Taste F10 enthält die 
Kombination: {LOGTHENPOP}TU NW {F5} {F2}. An Stelle von ‚TU NW’ kann unter 
SSB eine entsprechende WAV-Datei gerufen werden z.B.:
{LOGTHENPOP}C:\Program Files\N1MMLogger\wav\{operator}\TnxNow.wav {F5} 
{F2} 

Weisen Sie unter Config >Function Key der Taste F10 die Funktion "Next Call" zu. 

Wählen Sie den RUN-Modus und aktivieren Sie ESM. Zwei Stationen rufen Sie an: 
N2IC und K3CT. Geben als erstes K3CT ein, drücken Sie dann F9, geben Sie als 
zweites N2IC ein und drücken Sie ENTER. N2IC erhält die Kontrollnummer, gibt 
seine, die mit einem weiteren ENTER abgespeichert und bestätigt wird. Dann kommt 
unmittelbar danach K3CT und erhält seine Kontrollnummer. 

SOCALLSTACK: Nicht ESM-Beispiel: Programmieren Sie die Tasten wie oben. 
Wählen Sie den RUN-Modus. Geben Sie K3CT ein, drücken Sie F9, geben Sie dann 
N2IC ein und drücken Sie die programmierte Exchange-Taste, meist ‘;’. Diese Taste 
ist mit F5 & F2 programmiert. Übernehmen Sie den Rapport von N2IC und drücken 
Sie dann F10. Der Rapport von N2IC wird abgespeichert, das Rufzeichen K3CT aus 
dem Stapelspeicher geholt und ihm die nächste Kontrollnummer gesendet. 

Wenn mehrere Rufzeichen im Stapelspeicher stehen, werden Sie der Reihe nach mit 
F10 aus dem Stapelspeicher geholt. Ist der Stapelspeicher geleert, wird ein normales 
‚TU’ gesendet. Bei einem Logfehler wird die Prozedur bis zur Korrektur unterbrochen. 
Die Reihenfolge, in der die Rufzeichen aus dem Stapelspeicher geholt werden, hängt 
von der internen Sortierreihenfolge und nicht von der Reihenfolge der Eingabe ab.

9.1. Zusätzliche Informationen (Additional SOCALLSTACK 
Information)

Das eigene Rufzeichen muss in der Stationsinformation eingetragen sein. Das 
eigene Rufzeichen wird nicht in der Bandskala angezeigt. 
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Wird in den Stapelspeicher ein Rufzeichen aus einem Telnet-Spot eingetragen, 
können Sie es mit ALT+D entfernen. 
Das SOCallstacking überlappt sich etwas mit dem M/M-Stapelspeicher, wo ein 
zweiter OP dem ersten OP Rufzeichen in das Eingabefenster stellen kann. 

9.2. Stapelspeicher im Digital-Betrieb (Digital Call Stacking)

Im Menü für das digitale Interface finden Sie einen Punkt zum Ein- oder Ausschalten 
des Stapelspeichers: 

• Ist der Stapelspeicher ausgeschaltet, wird der Zustand vor dem Einschalten 
des Stapelspeichers hergestellt 

• Der Stapelspeicher arbeitet nur im RUN-Modus und nur mit gültigen 
Rufzeichen 

• Mit einem einfachen Klick auf ein Rufzeichen im RX-Fenster oder mit ALT+G 
wird ein Rufzeichen in den Stapelspeicher übernommen

• Steht kein Rufzeichen im Rufzeichenfeld des Logeingabefensters wird das 
Rufzeichen in dieses Feld übernommen 

• Steht bereits ein Rufzeichen im Rufzeichenfeld wird das neue Rufzeichen mit 
einem einfachen Klick auf ein Rufzeichen im RX-Fenster oder mit ALT+G in 
das Rufzeichenfeld übernommen und das bisher darin befindliche Rufzeichen 
in die Bandskala und in den Rahmen über dem Rufzeichenfeld gesetzt.

Dieses Verfahren ist dann nützlich, wenn Sie von zwei Stationen angerufen werden 
und diese nacheinander arbeiten wollen. Verwenden Sie in diesem Fall im ESM-
Modus nicht die Taste ENTER, sondern belegen Sie ein F-Taste mit dem Macros: 
{TX}{ENTER}! {LOGTHENPOP} TU NW {F5}{F2}{RX} 

Mit ALT+Einfach-Klick auf ein Rufzeichen im digitalen RX-Fenster oder Ctrl+Alt+G 
wird ein Rufzeichen direkt in den Stapelspeicher und in die Bandskala geschickt. Sie 
können jede beliebige Anzahl von Rufzeichen in den Stapelspeicher schicken und 
diese Stationen dann nacheinander arbeiten.

Wenn Sie von 3 oder 4 Stationen zur gleichen Zeit angerufen werden, verwenden 
Sie das einfache Alt+G, um das erste Rufzeichen in das Rufzeichenfeld zu holen. 
Holen Sie die nächsten Stationen mit ALT+Klick oder Ctrl+Alt+G in den 
Stapelspeicher. Verwenden Sie eine F-Taste, die mit {TX}{ENTER}! 
{LOGTHENPOP} TU NW {F5}{F2}{RX} programmiert ist, um diese Stationen, der 
Reihe nach zu arbeiten. Beenden Sie das letzte QSO mit der Taste F3 oder mit 
einem ENTER im ESM-Modus.

{LOGTHENPOP} funktioniert nicht, wenn der CQ-Ruf aktiv ist.

Doppel-Klick auf ein Rufzeichen: Ein Doppelklick auf ein Rufzeichen hat Vorrang 
gegenüber den oben angegebenen Übernahmemöglichkeiten und setzt ein 
Rufzeichen unabhängig von der Vorgeschichte in das Rufzeichenfeld.

Macro {LOGTHENGRAB}: Logg den aktuellen Kontakt und holt das im 
Stapelspeicher oben stehende Rufzeichen aus D1. Funktioniert nur im RUN-Modus. 
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Macro {STACKANOTHER}: Arbeitet wie Ctrl+Alt+G für den Stapelspeicher, kann 
aber in einem Macro verwendet werden. 

Haben Sie eine F-Taste gedrückt, die mit {TX}{ENTER}! {LOGTHENPOP} TU NW 
{F5}{F2}{RX} programmiert ist, aber der Stapelspeicher ist leer, wird nur der in der 
Taste TU programmierte Text gesendet. 

9.3. Anzeige des Folge-Rufzeichens (How to Tell Visually Which Call 
Will be Put in Next)

Steht "CQ Frequency" über dem Rufzeichenfester, sehen Sie in die Bandskala.

Mit {LOGTHENPOP} wird die Routine {SOCALLSTACK} aufgerufen. 
{SOCALLSTACK} entfernt die Überschrift "CQ Frequency" und holt das nächste in 
der Bandskala neben der CQ-Frequenz stehende Rufzeichen aus dem 
Stapelspeicher. 

Das Gleiche passiert, wenn Ihr Rufzeichen gespottet wird. Ihr Rufzeichen wird über 
dem Rufzeichenfeld angezeigt, aber nicht in das Rufzeichenfeld übernommen. Sollte 
es trotzdem passieren, haben Sie Ihr Rufzeichen in den Stationsdaten falsch 
eingetragen. Mit {LOGTHENPOP} oder {SOCALLSTACK} wird dieses Rufzeichen 
entfernt und das nächste Rufzeichen aus dem Stapelspeicher geholt. 

Falls Sie {SOCALLSTACK} auf einer F-Taste programmiert haben, wird das aktuelle 
Rufzeichen gegen das nächste Rufzeichen aus dem Stapelspeicher ausgetauscht. 
Ist kein Rufzeichen im Stapelspeicher, wird das aktuelle Rufzeichen in den 
Stapelspeicher geschickt und das Rufzeichenfeld geleert. Mit einem neuen Druck auf 
diese F-Taste wird das Rufzeichen vom Stapelspeicher wieder in das Rufzeichenfeld 
geschickt. 

10. Stapelspeicher im M/M-Modus im gleichen oder unterschiedlichen 
Bändern (Call Stacking (same or different bands) - Multi-User 
Mode)

Ein Rufzeichen kann beim Multi-Nutzer-Betrieb von einem Transceiver an den 
anderen gemeldet werden, unabhängig davon, ob die Zielstation auf dem gleichen 
oder einem anderen Band arbeitet. Ein Zweit-OP kann interessante Station suchen 
und sie in Ihren Stapelspeicher schicken, damit Sie sie der Reihe nach abarbeiten 
können. 

• Um anzuzeigen, welche Station Sie auf den Stapelspeicher schicken können, 
klicken Sie rechts auf den “Spielball” im Info-Fenster und wählen Sie das Ziel 
für den Stapelspeicher mit der Option "Target for call stacking".

• Sie können nur ein Rufzeichen auf einmal in den Stapelspeicher schicken. Ist 
der Stapelspeicher leer, können Sie ein Rufzeichen speichern. 

• Nachdem bei der Zielstation das Rufzeichen im Eingabebereich des 
Logfensters angezeigt wurde, muss die Partnerstation das Rufzeichen vor der 
Eingabe eines anderen Rufzeichens manuell löschen. Es wird nicht 
automatisch gelöscht. 
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Stapelspeicher für ein Rufzeichen im gleichen Band , aber nicht auf der gleichen 
Frequenz: Übernehmen Sie Rufzeichen und Frequenz mit einem Klick in die 
Bandskala. 

Wenn die Station auf der gleichen CQ-Frequenz in der Stapelspeicher geschickt 
wird, sehen Sie das übertragene Rufzeichen über dem Rufzeichenfeld. 

11. Der Seriennummern-Server (Serial Number Server)

N1MM logger unterstützt eine einheitliche Folge von Seriennummern in den Modi 
SO2R, MS, M2 und MM. 

Die Seriennummer wird reserviert im 

• S&P-Modus, wenn der Cursor das Rufzeichenfeld verlässt und in das 
Kontrollnummernfeld springt oder mit F2 die Kontrollnummer gesendet wird. 
Die Nummer wird hochgezählt nach Leertaste, TAB-Taste, ENTER im ESM-
Modus oder Betätigen der Taste F2 (Kontrollnummer senden). Damit 
verhindert, dass zur Kontrolle auf DUPE ins Rufzeichenfeld eingegebene 
Rufzeichen schon den Zähler erhöhen.

• RUN-Modus bereits nach Eingabe eines Zeichens in das Rufzeichenfeld. In 
SSB wird meist schon auf Senden geschaltet, bevor das komplette 
Rufzeichen in das Rufzeichenfeld eingegeben worden ist. Dann wird dem OP 
noch während der Eingabe die zugehörige neue Kontrollnummer angezeigt.

In SO2R und SO2V wird nach Alt+W (Löschen/wipe) oder einem QSY die bereits 
eingetragene Seriennummer für das nächste QSO wieder eingegeben. 

Bedingt durch die Art, in der der Nummern-Server läuft, sind diese Funktionen zu 
beachten: 

• Die Seriennummer, die an die zweite Station ausgegeben wurde, kann unter 
Umständen veraltet sein, wenn bei der ersten Station eine Nummer benötigt 
wird. Dieser Zustand kann nur bei bestimmten Programmaktionen passieren, 
wenn bei der ersten Station mehrere QSO gemacht wurden und bei der 
zweiten eine reservierte Nummer nicht verbraucht wurde. Im Log wird in der 
zeitlichen Reihenfolge eine Nummer übersprungen. Ich glaube, damit kann 
man leben.  

• Aus ähnlichen Gründen können abhängig von den Aktionen der OPs einzelne 
Seriennummern verloren gehen, wenn z.B. bei einem OP der Rechner 
abgestürzt. Auch hier können nicht ausgegebene Nummern im Gesamtlog 
fehlen. 

• Wichtig ist auf jeden Fall, dass alle vergebenen Seriennummern korrekt 
abgespeichert und keine Nummern doppelt vergehen werden, N1MMLogger 
erfüllt dieses Kriterium. 

• Es kommt vor, dass Seriennummern übersprungen werden, z.B. wenn ein 
QSO nicht zustande gekommen ist. Die Contest-Kommittees akzeptieren 
diesen Zustand.  

• Die höchste Seriennummer, die vergeben werden kann, ist 32767. Die 
höchste empfangbare Seriennummer ist 99 999. 

11.04.2010



N1MM-Contest Logging Software Seite 76 von 470 Übersetzung der Hilfe von Eike, DM3ML

 Wonach sehen die Contestveranstalter? 
Bei den meisten Veranstaltern hat die Reihenfolge der Seriennummern Vorzug 
gegenüber der genauen zeitlichen Reihenfolge. Speziell bei einem 2-Sender-Betrieb 
ist diese Forderung schwer zu erfüllen, denn einem QSO wird die aktuelle Zeit 
zugeordnet, wenn es geloggt worden ist. Hier geht die zeitliche Reihenfolge vor der 
Reihenfolge der Seriennummern. Reservierte Seriennummern gehen verloren, wenn 
ein QSO beim SO2R/SO2V nicht erfolgreich abgeschlossen werden kann. Die 
Contestveranstalter sollten sich diesen Gegebenheiten stellen.

12. Meldung der Contestergebnisse in Echtzeit (Contest Reporting 
Application)

Wenn Sie auf der Karteikarte Other im Configurer einen Haken bei Start Contest 
Reporting Application machen, werden die im Contest aktuell erreichten 
Ergebnisse an eine Webseite gemeldet, auf der auch andere Stationen ihren Stand 
anzeigen. Diese Webseite(n) werden in verschiedenen Reflektoren publiziert.

 Bericht anhalten (Stop Reporting) 
Solange Sie die Berichte nicht anhalten, werden ihre Berichte unabhängig von ihrer 
Contestteilnahme abgeschickt, auch wenn Sie nur zum Spaß ein paar QSOs fahren. 
Wenn Sie das Berichtsprogramm starten, sehen Sie dieses Fenster: 

 

In der Mitte des Fensters läuft ein Sekundezähler rückwärts. Hat er den Stand 0 
erreicht, wird Ihr Stand an die mit Setup programmierte Webseite geschickt. Im 
Status-Fenster oben rechts wird der Programmstand oder eine Fehlermeldung 
ausgegeben. Eine kleine Taste rechts neben dem Statusfeld zeigt die Antwort auf die 
letzte Sendung an und kann für die Fehlerbehebung verwendet werden. In der Mitte 
des Fensters wird die Version angezeigt.

• Stop Send / Send Score: Schaltet das Senden der Punktzahl ab oder zu 
• Get Scores: Mit dieser Taste können Sie die Ergebnisse der anderen 

eingeloggten Stationen abrufen und ansehen 
• Setup:  öffnet den Einstelldialog (siehe unten) 

Beachten Sie, dass unmittelbar nach dem Programmstart die erreichte Punktzahl 
abgeschickt wird. 
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Sie können diese Einstellungen vornehmen:  

• Score Post Time (min): Gibt die Zeit vor, die zwischen den einzelnen 
Meldungen vergehen. Möglich sind 2, 5, 10,15,30 und 60 Minuten. Sie können 
die Meldung auch von Hand mit Send Score starten. 

• Score Posting URL:  Enthält die Webseite, an die der Stand gemeldet wird 
• Score Reading URL: Enthält die Webseite, von der Stand der anderen 

Stationen abgeholt werden soll 
• Listening IP: Enthält die IP-Adresse des PC, auf dem der N1MMLogger läuft 

und das Log geführt wird. Adresse wird von N1MMLogger eingetragen. 
• Listening Port: Port, von dem N1MMLogger seine Daten schickt. Wird von 

N1MMLogger eingetragen 

• Defaults: Trägt die voreingestellten Werte ein 
• Cancel: Verwirft die vorgenommenen Einstellungen 
• OK: Übernimmt die vorgenommenen Einstellungen 

Während großer Conteste sind mehrere solcher Webseiten aktiv. Die von Gerry, 
W1VE , zusammengestellte Liste sieht so aus:  

 

Sie können die Ergebnisse unter http://live.getscores.org  abrufen.
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Wenn Sie Wünsche, Beschwerden oder Anregungen zu dieser Seite haben, 
schreiben Sie an gerry@w1ve.com. 

13.-Contest mit einer anderen Nummer als 001 starten (Starting a Contest 
with a Number Other Than 001)

Hat ein Contest mehrere Teile, die mit Nummern abweichend von 001 gestartet 
werden, gehen Sie so vor: 

1. Machen Sie das erste QSO und übertragen Sie es mit der Nummer 001 ins 
Log. Korrigieren Sie dann die Contestnummer dieses QSOs mit Ctrl+Y auf 
den richtigen Wert. Ab diesem Stand wird die richtige Nummer vergeben.
oder

2. Machen Sie als erstes ein Blind-QSO mit der Nummer 001. Editieren Sie dann 
das QSO mit der korrekten Seriennummer. Löschen Sie später dieses Blind-
QSO.  

14. Zwei-Sender-Betrieb SO2R (Single Operator 2 Radios (SO2R))

Mit SO2R können Sie – richtig eingerichtet – zusätzlich QSOs und Multis in Ihr Log 
bringen. Sie hören mit dem zweiten Transceiver auf Stationen, während Ihr erster 
Transceiver CQ ruft. 

Einzelheiten finden Sie im Kapitel SO2R

15. Unterstützung des Fußschalters (Footswitch Support)

Für verteilte Multi-Stationen wurde ein Werkzeug für den Fußschalter eingebaut. 
Speziell bei IARU-Contest-HQ-Stationen sind mehrere Stationen verteilt über eine 
ITU-Zone aktiv, aber es darf nur eine Station per Band gleichzeitig senden, obwohl 
meist eine RUN- und eine Multi-Station per Sendeart und Band aktiv sind. 
Sie können direkt an Pin 15 der parallelen Schnittstelle einen Fußschalter 
anschließen. Dieser Fußschalter steuert wie ALT+T die PTT des angeschlossenen 
Transceivers. Der aktivierte Fußschalter einer Station blockiert die PTT-Steuerung 
aller über Internet oder WLAN angeschlossenen Stationen auf dem gleichen Band. 

Zwei-Monitor-Betrieb (Two Monitor Support)

Original by Joe Natale, K1JN 

Anforderungen (Requirements)

• Windows 98 oder höher 
• Zusätzliche Videokarte oder Videokarte mit zwei Ausgängen 
• Zusätzlichen Monitor 

Überblick zum 2-Monitor-Betrieb (General Two Monitor Operation)

Es ist kein Problem, mit zwei Monitoren zu arbeiten und wenn Sie einmal damit 
angefangen haben, werden Sie nicht zu einem Monitor zurückkehren wollen. 
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Das Betriebssystem übernimmt die Arbeit für beide Monitore. Es verhält sich, als 
würde ein Monitor mit doppelter Schirmbreite angeschlossen sein. Sie können die 
einzelnen Fenster mit der Maus beliebig über die mechanische Grenze eines 
Monitors hinüber zum anderen Monitor schieben. Sie können die 
Fenstereinstellungen getrennt für die beiden Monitore vornehmen und Monitore 
unterschiedlicher Größe und Auflösung verwenden.
Auch bei Laptops können Sie meistens mit einem zusätzlich angeschlossenem 
Monitor als Zweit-Monitor arbeiten.

Am besten ist es, den linken Monitor als Haupt-Monitor einzurichten und rechts 
davon den zweiten Monitor aufzustellen, weil Programme mitunter Schwierigkeiten 
mit negativen Positionszahlen haben. N1MMLogger unterstützt negative 
Positionszahlen.

Lohnt sich ein zweiter Monitor? (Is it Worthwhile to use Two 
Monitors (and what if they have a different size)?)

Sie können einen zweiten Monitor für um die 100€ kaufen. Hat Ihre Videokarte 
bereits einen zweiten Monitorausgang entstehen keine weiteren Kosten. Es ist kein 
Problem z.B. einen 17”- und einen 15”-Monitor anzuschließen. Setzen Sie dann bei 
N1MMLogger das Packet-Fenster, die Ergebnisanzeige (Score) und das Info-Fenster 
auf den kleineren Monitor.
Prüfen Sie im BIOS-Setup, ob der Videoausgang des Motherboards u.U. durch 
Einbau einer weiteren Videokarte abgeschaltet worden ist. Schalten Sie ihn für den 
Zweit-Monitor wieder zu.  

Einstellung für zwei Monitore (Two Monitor Setup)

• Installieren Sie – falls benötigt – zweite Videokarte, Die meisten neuen 
Videokarten haben schon einen Zweitausgang. Dann brauchen Sie keine 
weitere Videokarte. Stecken Sie den zweiten Monitor an.

• Software 
o Starten Sie den PC 
o Windows findet die neue Videokarte und installiert den Treiber dafür 

oder fordert den mitgelieferten Treiber an. Mitunter teilt Windows Ihnen 
schon mit, dass Sie den Desktop auf den zweiten Monitor erweitern 
können. 

o Klicken Sie im Desktopfenster des Hauptmonitors rechts auf eine leere 
Stelle des Bildschirms. Wählen Sie im sich öffnenden Menü die Spalte 
Eigenschaften. Das Fenster ‚Eigenschaften der Anzeige’ öffnet sich. 
Klicken Sie auf den Karteikarten-Reiter Einstellungen. Sie bekommen 
die Monitore 1 und 2 angeboten. Klicken Sie auf den Monitor 2 und 
machen Sie einen Haken in das Feld Windows-Desktop auf diesen 
Monitor erweitern. 

o Ziehen das Feld mit Monitor 2 dahin, wo das Gerät mechanisch 
angeordnet ist (links oder rechts vom Hauptmonitor 1).

 Wenn Sie auf OK geklickt haben, wählen Sie “Einstellung sofort 
wirksam werden lassen”. Das Hintergrundbild Ihres Desktops 
erscheint auch auf dem Zweitmonitor und Sie können den 
Mauszeiger auch auf den zweiten Schirm ziehen. Ein 
Bildschirmschonerprogramm läuft nur auf dem Monitor 1.
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Öffnen Sie N1MMLogger mit den gewünschten Fenstern und ziehen Sie die 
ausgewählten Fenster mit der Maus auf den Monitor 2. 

Das Bild zeigt ein Beispiel von K1JN aus dem CQ WPX-CW-Contest. Der linke 
Monitor hat 17" und ist auf 1024 x 768 Pixel eingestellt. Der rechte Monitor ist ein 
15"-er mit 800 x 600 Pixeln.

 

Die N1MMLogger-Fenster sind wie folgt verteilt:

Monitor 1 (links) Monitor 2 (rechts) 
Beide Bandskalen Packet/Telnet-Fenster 
Logfenster Info-Fenster 
Logeingabefenster Multis und QSOs im Angebot 
Rufzeichenprüfung Ergebnisübersicht (Score)

Last Modification: 29 September 2009 05:44:28 EDT by K8UT. 
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Kontesteinstellung und –Konfiguration 
(Contest Setup and Configuration)

Stationsdialog (Station Dialog)

Wählen Sie Config >Change Your Station Data 

Der Stationsdialog sieht so aus:  

 

Die Felder sind durchweg selbsterklärend. N1MMLogger benötigt zum Erzeugen 
eines fehlerfreien Cabrillo-Logs ihre korrekten Stationsdaten. Vor allem das 
verwendete Rufzeichen muss stimmen. Zur Berechnung der Antennenrichtung 
müssen die eigenen Koordinaten richtig eingetragen sein. 

• ARRL Section: Hier wird bei US-Stationen die korrekte Abkürzung des 
Bundesstaates eingetragen. Tragen Sie als Nicht-US-Station hier DX ein.

• Latitude = Breite und Longitude = Länge. Südliche und östliche Gradzahlen 
werden negativ eingetragen. 

• Bei VHF-Contesten muss der WW-Lokator (Grid Square) 6-stellig 
eingetragen werden. Aus ihm wird hier die Antennenrichtung berechnet.
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• Länge und Breite werden korrigiert, wenn sich der WW-Lokator ändert und 
umgekehrt. 

• Club: Tragen Sie den vollen Clubnamen ein, also nicht YCCC sondern 
Yankee Clipper Contest Club. Lassen Sie den Eintrag frei, wenn Sie nicht 
Mitglied in einem Club sind oder der Name Ihres Clubs dem 
Contestkommittee nicht bekannt ist. 

• E-Mail address und SMTP server address werden für Fehlermeldungen per 
Email verwendet. 

Last Modification: 09 December 2009 14:29:49 EST by K8UT. 

Konfigurations-Dialog (Configurer Dialog)

Der Konfigurations-Dialog oder kurz Configurer geht über eine Anzahl von 
Karteikarten. Mit dem Configurer werden die Eigenschaften des N1MMLoggers 
eingestellt. Die Einstellungen werden in der Datei N1MMLogger.ini abgelegt. Für 
verschiedene Conteste und Stationsaufbauten können Sie sich verschiedene ini-
Dateien anlegen. Die Daten zur Programmierung der Funktionstasten, die Telnet-
DXCluster, die Rufzeichengeschichte und die Länderinformationen stehen in der 
Datei ham.mdb und jeder neuen Datenbank, die Sie anlegen.

Um die ini-Dateien zu sehen, müssen Sie in der Windows-Systemsteuerung unter 
Ordneroptionen auf der Karteikarte Ansicht den Haken vor der Option Erweiterungen 
bei bekannten Dateien ausblenden entfernen. Lassen Sie sich nicht durch Datei "N1MM 
Logger.ini.init" beirren, sie wird bei der Installation entpackt und kann vom Nutzer 
nicht modifiziert werden. 

1. Karteikarte Config >Hardware 

Mit dieser Karteikarte stellen Sie Ihre Interfaces zu dem/den Transceivern, die 
Telnet-Verbindungen und die CW-Tastung ein.  Falls Sie eine der Möglichkeiten nicht 
verwenden, stellen Sie sicher, dass dort als Schnittstelle None angewählt worden ist. 
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1.1. Einstellung der Hardware (Hardware setup)

 

Das Programm unterstützt 8 serielle Schnittstellen (COM 1-8) und drei parallele 
Schnittstellen (LPT1-3). Sie können jeder dieser Schnittstellen ein Gerät oder ein 
Interface zuordnen. Verwenden Sie nur Schnittstellen, an denen ein Gerät 
angeschlossen ist. Stellen Sie sonst None ein!

• Radio: Hier stellen Sie die CAT-Steuerung für Transceiver ein
• Digital:  Über diese Schnittstelle werden die Digimode-Programm 

(MMVARI/MMTTY/TNC) gesteuert 
• Packet: An dieser Schnittstelle ist ein Packet-Kontroller angeschlossen 
• CW/Other: Diese Schnittstelle können Sie für einen Transceiver, ein digitales 

Interface, einen Packet-Kontroller oder eine CW-Tastung anschließen. 
Verwenden Sie diese Schnittstelle für die PTT-Tastung Ihres Transceivers.

• Details:  Hier werden abhängig vom Verwendungszweck die verwendeten 
Signale der Schnittstelle, Baudrate und Datenformat nach Klick auf die Set-
Taste eingestellt

• SO1V:  Single Operator 1 VFO, ein Transceiver mit einem VFO wird 
verwendet 

• SO2V:  Single Operator 2 VFO, ein Transceiver mit beiden VFOs wird 
verwendet 

• SO2R:  - Single Operator 2 Radio, zwei Transceiver werden verwendet
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1.2. Beispiele für SET-Einstellungen (Set button examples)

 

 

• Com7: angesteuert wird ein ICOM-Transceiver mit der Adresse 6EH, sein 
Interface wird nicht aus der Schnittstelle gespeist (RTS und DTR=Off). Würde 
das Interface aus der Schnittstelle mit Spannung versorgt, müssten beide 
Leitungen auf Always On gesetzt werden.

• Com5: An diese Schnittstelle ist ein Winkey-CW-Taster angeschlossen
• Com3: Diese Schnittstelle schaltet die PTT-Leitung von Transceiver 1
• LPT1: schaltet zwischen die PTT-Leitung zwischen Transceiver 1 und 2 um 

Je nach Verwendungszweck werden verschiedene Felder angezeigt. Für die 
Steuerung digitaler Interfaces werden diese Abfragen angeboten: 

• Speed: Baudrate des peripheren Gerätes (meist 9600, 19200 oder 38400 Bd)
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• Parity. Prüfbit N (kein Prüfbit), E (Even = Gerade) oder O (Odd = ungerade), 
meist N 

• Data Bits: Zahl der Datenbits, meist 8 (mitunter 5 oder 7) 
• Stop Bits: Zahl der Stopp-Bits, voreingestellt ist 2, möglich sind 1 oder 1,5) 

Hinweis: Datenrate und Format müssen mit dem angeschlossenen Gerät 
übereinstimmen. Mitunter muss das Gerät an einem anderen PC voreingestellt 
werden. Sehen Sie im Handbuch des Geräts nach! Für die Datenübertragung über 
die RS-232-Schnittstelle werden in aller Regel die Signale TxD und RxD gegen 
Masse verwendet. 

Weitere Signale der Schnittstelle lassen sich für statische Steuerungen verwenden:

• DTR: -Pin 4 des DB9-Steckverbinders kann wie folgt eingestellt werden: 
o PTT:  schaltet den Transceiver auf Senden 
o CW: tastet den Transceiver in CW 
o Always on:  Immer auf High (+3..+12V) 
o Always off: immer auf Low (0V) 
o Handshake: wird für die Steuerung des Datenaustauschs verwendet

• RTS: Pin 7 des DB9-Steckverbinders kann wie folgt eingestellt werden  
o PTT:  wie DTR 
o Always on:  wie DTR
o Always off:  wie DTR
o Handshake:  wie DTR

 Windows 98-Nutzer 
Falls Sie Probleme haben, gehen Sie zur Systemsteuerung > System > 
Gerätemanager > COM-Schnittstellen > erweiterte Einstellungen und stellen Sie 
ON/XOFF auf NONE. Hiermit wird die Funktion Handshake abgeschaltet.

• Icom Addr (hex): bei ICOM haben die Transceiver eine hexadezimale 
Adresse. Bis zu vier Transceiver können auf einer Leitung des Interfaces 
parallel arbeiten. Tragen Sie den Hexadezimalwert ein, also z.B. 70, nicht 70H 
für einen IC-7000. Sehen Sie im Handbuch Ihres Transceivers nach. Das 
gleiche gilt für die Signalparameter wie Baudrate u.a.(s.o.) 

• Radio Nr: Nummer des Transceivers in Ihrer Stationsanordnung
o In SO1V ( ein Tcvr, ein VFO) 

 Die Wirkung des Backslash ( \ ) ist gesperrt und kann kein 
zweites Logeingabefenster öffnen

 Die Tasten PAUSE und Ctrl+Rechter Pfeil sind gesperrt. Eine 
zweite Bandskala kann nicht geöffnet werden. 

 Der Transceiver wird automatisch als Nummer 1 gesetzt
o In SO2V ( ein Tcvr, zwei VFOs) 

 1 – beide VFOs werden vom angeschlossenen Transceiver 
genutzt

 2 - VFO-A gehört zum Transceiver, VFO-B wird von Hand 
gesteuert 

 Both – beide VFOs werden von Hand gesteuert
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 Vergessen Sie nicht die LPT-Tastung von Radio 1 
(voreingestellt) auf BOTH umzustellen. Sonst können Sie 
den VFO-B nicht tasten 

 Wenn Sie 1 oder 2 einstellen, aktiviert die PTT nur den 
dazu gehörenden VFO (nur in SO2V) 

o In SO2R wählen Sie 1 oder 2 abhängig, welche CAT-Steuerung 
welches Transceivers angeschlossen ist 

 Wenn eine LPT-Schnittstelle als " CW/Other port" mit Radio = 
Both eingestellt und die andere LPT-Schnittstelle als " CW/Other 
port" mit Radio = 2 eingestellt wurde, werden die Banddaten für 
den zweiten Transceiver an die zweite Schnittstelle geschickt.

 Wenn Sie eine Schnittstelle als Winkey CW/Other mit einem 
externen SO2R-Kontroller verwenden, muss die LPT-
Schnittstelle mit der niedrigsten Nummer auf RADIO = BOTH 
eingestellt werden (sie steuert 14) 

• PTT Delay (mSec):  gibt die Zeit vor, die zwischen dem Aktivieren der PTT 
und dem ersten CW-Zeichen oder dem Abspielen einer WAV-Datei vergehen 
soll. 

• Radio PTT via command:  Wird gewählt, wenn die PTT des 
angeschlossenen Transceivers über ein CAT-Kommando geschaltet werden 
soll. Verwenden Sie diese Einstellung, wenn die PTT im Vorlauf gegenüber 
dem ersten CW-Zeichen oder dem Senden einer WAV-Datei in SSB 
geschaltet werden soll. Die voreingestellte Vorlaufzeit beträgt 40ms und kann 
unter 'PTT delay (mSec)' eingestellt werden.

• Allow ext. interrupts:  Erlaubt externe Unterbrechungen, wenn die 
Schnittstelle für einen RigBlaster verwendet wird. Setzt den Fokus in das 
Logeingabefenster und stoppt den CQ-Ruf, wenn der mit dem Rigblaster 
verbundene Fußschalter betätigt wird. 

• Winkey:  Wird gewählt, wenn ein Winkey – CW-Geber angeschlossen ist. Es 
müssen keine Schnittstellendaten (Baudrate, Prüfbit, Datenformat) 
eingetragen werden. Sie liegen fest. Der Winkey-Geber kann auf der 
Karteikarte Winkey konfiguriert werden. Die Winkey-Angaben werden nicht 
angezeigt, wenn die Schnittstelle für ein digitales Interface oder einen 
Transceiver verwendet wird.

• MK2R: Unterstütz einen mictroHAM MK2R SO2R-Kontroller, wenn für die 
Steuerung das Protokoll einer seriellen Schnittstelle verwendet wird. Wird der 
SO2R mit MK2R/MK2R+ nur über die USB-Schnittstelle gesteuert: 

o Ist DVK ausgewählt, wird die DVK des MK2R/MK2R+ verwendet 
o Abgeschaltet, wenn die Schnittstelle für ein digitales Interface oder 

einen Transceiver verwendet wird 
o Informieren Sie sich im Kapitel Unterstütze Hardware unter MK2R 

• CW/Other Port Addr:  spezifiziert die Schnittstellenadresse für serielle und 
parallele Schnittstellen 

o Werden sowohl RTS als auch DTR für die PTT-Steuerung angewählt, 
werden beide Leitungen mit der unter 'PTT delay' eingestellten 
Verzögerung geschaltet 

o Packet verwendet als Handshaking RTS + XON/XOFF 
o Verwenden Sie ein über die Schnittstelle gespeistes CAT-Interface, 

setzen Sie DTR und RTS auf ‚always on’ 
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o Sie finden die einzustellende Adresse über die Windows-
Systemsteuerung > System > Gerätemanager > COM/LPT-
Schnittstellen > Eigenschaften 

 LPT Port Nummern 
Bei N1MMLogger/SO2R und LPT CW müssen Sie die niedrigste LPT-Schnittstellen-
Nummer mit dem CW-Ausgang für BEIDE Transceiver belegen, wenn sie in 
Zusammenhang mit konventionellen LPT-SO2R-Boxen (DXD, KK1L, N6BV, etc.) 
oder microHAM MK2R/MK2R+ in LPT verwendet wird. Die LPT-Schnittstelle muss 
mit den Leitungen für CW, PTT und die TX/RX/Split-Umschaltung muss mit dem 
SO2R-Kontroller verbunden werden. Ist der N1MMLogger mit CW an zwei LPT-
Schnittstellen konfiguriert (erste LPT = Radio1 und zweite LPT = Radio2) wird CW 
nur am aktiven Ausgang ausgegeben. 

Wenn Sie CW einstellen und Ihr Transceiver hat zwei VFOs, setzen Sie sie auf 
Radio 1. Der Port Radio 1 CW wird für den ersten Transceiver verwendet. Wollen Sie 
auch den zweiten Transceiver tasten, setzen Sie dort den CW-Port für Radio 2. 

• DVK : DVK-Interface für MK2R, W9XT & andere DVKs. Auch die 
Aufzeichnung wird vom Programm unterstützt

o Wenn DVK gewählt wird, ist die Antennenauswahl über die LPT-
Schnittstelle abgeschaltet, da die DVK-Pins und die Antennenauswahl 
sich überlappen 

o Verwendet Sie eine externe DVK müssen Sie alle Funktionstasten im 
RUN- und S&P-Modus mit der Datei empty.wav belegen. Sie dürfen 
nicht leer gelassen werden. 

o microHAM MK2R: wenn DVK gewählt wurde, verwendet N1MMLogger 
dessen DVK-Funktionen anstelle der eigenen DVK-Unterstützung 

• FootSwitch mode (Fußschalter):  über Pin 6 der seriellen Schnittstelle und 
Pin 15 der parallelen Schnittstelle. Einzustellen ist: 

o None – Kein Fußschalter
o ESM Enter : Ein Klick auf den Fußschalter bewirkt das Gleiche wie ein 

ENTER im ESM-Modus 
o Typing Focus: Ein Klick auf den Fußschalter wechselt den Eingabe-

Fokus
o Switch Radios: Ein Klick auf den Fußschalter schaltet zwischen den 

Transceivern im SO2R-Betrieb um 
o Normal:  Der Fußschalter schaltet die PTT und wird automatisch mit 

dem richtigen Transceiver verbunden. Mit dem Loslassen des 
Fußschalters wird der Fokus in das Logeingabefenster gesetzt

o F1: Der Fußschalter hat die gleiche Wirkung wie die Taste F1 
o F2: Der Fußschalter hat die gleiche Wirkung wie die Taste F2 
o F3: Der Fußschalter hat die gleiche Wirkung wie die Taste F3 
o F4: Der Fußschalter hat die gleiche Wirkung wie die Taste F4
o F11: Der Fußschalter hat die gleiche Wirkung wie die Taste F11
o F12: Der Fußschalter hat die gleiche Wirkung wie die Taste F12
o Band lockout: Sperrt bei M/M-Stationen das zweite Signal auf dem 

gleichen Band. Die PTT-Steuerung muss diese Steuerung erlauben. 
Diese Einstellung stoppt Auto-CQ und CQ-Duelle.
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Per parallele Schnittstelle können mehrere Fußschalter, pro serielle nur ein 
Fußschalter angeschlossen werden. Für den DSR-Eingang (Pin 6, seriell bzw. Pin 15 
parallel) wird ein Ziehwiderstand nach +12V benötigt.  

2. Einstellung des TelnetClusters mit Config >Telnet Cluster

• Telnet Cluster: Wählen Sie hier Ihren Wunsch-Telnet-DXCluster. Er wird vom 
Telnet-Fenster aus connectet.

o Ctrl+D: löscht einen Eintrag in der Tabelle 
• Taste Edit: Sie können in der Liste Telnet-DXCluster ergänzen oder löschen 

o File 
 Import...: Importiert eine Textdatei mit Packet/Telnet-DXClustern 
 Export...: Gibt Ihre Liste der Packet/Telnet-DXCluster in eine 

Textdatei aus 

2.1. Weitere Informationen (Other Information)

Sie können die PTT-Leitung über das CAT-Interface zum Transceiver tasten. Wenn 
Sie die parallele Schnittstellen LPT1..3 verwenden, erhalten Sie zusätzliche 
Informationen. Informieren Sie sich im Kapitel Transceiverschnittstellen (Radio 
Interfacing). 

2.2. Windows NT/2000/XP (32 bit OS)

Um unter den genannten 32-Bit-Windows.Betriebssystemen mit den seriellen und 
parallelen Schnittstellen arbeiten zu können, benötigen Sie eine spezielle DLL-Datei, 
die über das Programm Port95nt.exe. Einen Link zu dieser Datei finden Sie im 
Kapitel Download.  
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3. Einstellung der Dateien mit Config >Files Tab

 

Mit dieser Tabelle können Sie den Pfad zur Buckmaster-Rufzeichendatenbank 
einstellen, wenn diese vorhanden ist.  

3.1. Beschreibung der Felder (Files Field Descriptions)

• Callsign database path: Hier können Sie die Adresse der Buckmaster-
Rufzeichendatenbank eintragen, wenn Sie darüber verfügen sollten. Tragen 
Sie einen Backslash \ als erstes Zeichen ein und dann den Pfad zu Ihrer CD. 
Sie können auch den vollen Pfad eingeben, z.B. E:\HAM0\ , wenn die CD im 
Laufwerk E eingelegt ist. Kopieren Sie von der CD die Datei HAMCAL32.DLL 
in das N1MMLogger-Verzeichnis. Auf älteren CDs finden Sie diese Datei im 
Verzeichnis \API\WINDOWS. Auf neueren CDs kann es an einer anderen 
Stelle stehen 

• Recorded wav file path: Über diesen Pfad finden Sie die von N1MMLogger 
aufgezeichneten WAV-Dateien unter dem Namen des jeweiligen Contests. 

• Letters file path: Hier wird der volle Pfad zu den vorbereiteten 
Buchstabierwort-Dateien eingetragen, z.B. C:\program Files\N1MM 
Logger\wav\{operator}\ . Sie können damit für jeden Operator eine 
Buchstabiertabelle mit seiner Stimme anlegen. Ein Dezimalpunkt wird in der 
WAV-Datei Point.wav gespeichert. 
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4. Konfiguration der F-Tasten (Config >Function Keys Tab)

 Function 
keys for each message are set here.

4.1. Beschreibung der Einstellungen (Function Keys Field 
Descriptions)

• Monitor via PC speaker (Win98/ME only): Die CW-Zeichen werden über 
den PC-Lautsprecher ausgegeben (geht nur unter Windows 95, 98, ME, ist 
unter  NT/2000/XP nicht möglich) 

• Send Corrected Call (Before End of QSO Msg): Wurde das Rufzeichen der 
Gegenstation während des QSOs vor der ‘End of QSO Message’ korrigiert, 
wird es mit der ‘End of QSO message’ noch einmal gesendet, z.B. 'PA1M TU 
DE N1MM' anstelle von 'TU DE N1MM'. 

• Send Partial Calls: nur in CW: Wenn Sie hier einen Haken machen, wird nur 
der korrigierte Teil des Rufzeichens (Prefix oder Suffix) noch einmal gesendet. 
Falls nicht angehakt, wird das komplette Rufzeichen gesendet 

• Work Dupes when Running: Sie können mit dieser aktivierten Funktion im 
RUN-Modus Stationen mehrfach arbeiten, die Taste QSO B4 wird nicht 
automatisch ausgelöst. Normalerweise werden DUPEs angewiesen, zu 
diesem Punkt gibt es eine Diskussion unter 'Off topic' . 

• Use Contest Word Spacing for CW: Voreingestellt wird beim Contest mit 
einer verkürzten Wort-Pause unter N1MMLogger gearbeitet. Die Wortpause 
wird von 7 Punkten auf 6 Punkte verkürzt, wenn Sie hier einen Haken setzen. 
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• Send Cut Numbers: Die Verkürzung von Ziffern kann auch mit Ctrl+G 
eingeschaltet werden. Ziffern werden dann auf A, N, T, O, E, S, U, W, G 
verkürzt.  Die Verkürzung funktioniert nur, wenn Nummern ausgetauscht 
werden. 

• Send leading zeros in serial numbers: Führende Nullen der 
Kontrollnummern werden ausgegeben. In CW wird dann TT1 gesendet, in 
RTTY 001. 

• Stop Sending CQ when Callsign changed: Die Eingabe eines Zeichens in 
das Rufzeichenfeld beendet den CQ-Ruf 

• ESM only sends your call once in S&P, then ready to copy received 
exchange: Wenn Sie eine “dicke” Station sind und sicher sein können, dass 
die Gegenstation Ihr Rufzeichen beim einmaligen Senden aufnimmt, wählen 
Sie diese Funktion. Müssen Sie als „blindes Huhn“ mehrfach rufen, wählen 
Sie diese Funktion nicht. Im ersten Fall wird der Cursor nach dem ersten 
ENTER gleich in das Kontrollnummernfeld gesetzt. 

• String to use on CW between his call key and exchange key (default is 
one space): Zeichenkette zwischen Rufzeichen der Gegenstation und 
Kontrollnummer, z.B. ' ur '. Normalerweise wird ein Zwischenraum genommen.

• Keycode of Ins Key Substitute:  Der Einfg-Taste (Taste Ins) kann ein 
bestimmter ASCII-Kode zugeordnet werden. Setzen Sie den Cursor in das 
Feld und drücken Sie die Taste, die Sie anstelle der Einfg-Taste verwenden 
wollen. Voreingestellt ist 186. Auf einer deutschen Tastatur hat die Taste Einfg 
den Kode 45. Die Verwendung der +-Taste des Nummernfeld wird nicht 
empfohlen, auch Kombinationen mit den Tasten Shift, CTRL, Alt  sind nicht 
gestattet.

• Keycode of TU/Log Key Substitute: Gleiche Funktion wie bei der INS-Taste. 
Voreingestellt ist 222, der (englische) Apostroph. 

• Cut Number Style:  Sie können verschieden Abkürzungen für Ziffern in CW 
wählen: 

o T1234567890 (leading T): die führende Null wird als T gesendet, aus 
007 wird TT7 und aus 030 wird T30 

o O1234567890 (leading O): die führende Null wird als O gesendet, aus 
007 wird OO7 und aus 030 wird O30 

o T123456789T (all T): alle Nullen werden als T gesendet, aus 007 wird 
TT7 und aus 030 wird T3T 

o O123456789O (all O): alle Nullen werden durch ein O ersetzt. Aus 007 
wird OO7 und aus 030 wird O3O 

o T12345678NT (TN) – alle Nullen werden durch ein T ersetzt, alle 
Neunen durch ein N. Aus 097 wird TN7 und aus 090 wird TNT 

o T12345678NT (ON) – alle Nullen werden durch ein O ersetzt, alle 
Neunen durch ein N. Aus 097 wird ON7 und aus 090 wird ONO 

o TA2345678NT (TAN) : alle Nullen werden durch T ersetzt, alle Neunen 
durch N und alle Einsen durch A. Aus 091 wird TNA und aus 190 wird 
ANT 

o TA234E678NT (TAEN): alle Nullen werden durch ein T, alle Neunen 
durch ein N, alle Einsen durch ein A und alle Fünfen durch ein E 
ersetzt. Aus 091 wird TNA und aus 1590 wird AENT. 

o TAU34E67DNT – Aus Null, Eins, Zwei, Fünf, Acht und Neun wird T, A, 
U, E, D, N oder T  (DM3ML: Na, Gut Holz!!)
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4.2. Zuordnung von Funktionstasten (Remapping Function Keys)

Sie können – speziell im ESM-Modus - bereits programmierten Tasten eine andere 
Bedeutung in der Zustandstabelle zuweisen. Der Schlüsselbegriff der 
Zustandstabelle steht links, die voreingestelle Taste selbst rechts. Die Zuordnung 
kann nur für RUN und S&P gemeinsam erfolgen. 

• CQ Key - F1 
• Exchange Key - F2 
• End of QSO Key - F3 
• His Call Key - F5 
• My Call Key - F4 
• QSO B4 Key - F6 
• Again Key - F8 (kann abgestellt werden) 
• Next Call Key – ist normalerweise nicht aktiv (Abarbeiten einer 

Warteschlange)

ESM 
Mode

Work 
dupes 
when 
running

Mode Taste 
QSO B4 

Taste 
Again Aktion Ergebnis der Aktion 

On
Keine 
DUPEs 
arbeiten

Run gesperrt F-Taste DUPE Rufzeichen 
eingegeben

Sendet AGN nach 
ENTER 

On DUPEs 
arbeiten Run gesperrt gesperrt DUPE Rufzeichen 

eingegeben

Sendet EXCH nach 
ENTER, Station wird 
gearbeitet und mit 
ENTER geloggt 

On
Keine 
DUPEs 
arbeiten

S&P gesperrt F-Taste DUPE Rufzeichen 
eingegeben

ENTER hat keine 
Wirkung, keine Taste 
wird blau markiert

On
Keine 
DUPEs 
arbeiten

S&P gesperrt gesperrt DUPE Rufzeichen 
eingegeben

ENTER hat keine 
Wirkung, keine Taste 
wird blau markiert

On DUPEs 
arbeiten Run - gesperrt

DUPE Rufzeichen 
eingegeben. 
Fehler bei den 
QSO-Daten

Sendet EXCH nach 
ENTER

On
Keine 
DUPEs 
arbeiten

Run - gesperrt Fehler bei den 
QSO-Daten

Sendet EXCH nach 
ENTER

On - S&P - gesperrt Fehler bei den 
QSO-Daten

Sendet EXCH nach 
ENTER. Nach 
Korrektur der Daten 
wird das QSO 
geloggt. Es wird 
nichts gesendet
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5. Einstellung der Digimode-Technik (Config >Digital Modes Tab)

 

Auf der Karteikarte für die Digimode-Technik werden die externen Programme wie 
MMTTY und externe Kontroller und ihre Schnittstellen eingestellt. 

5.1. Feldbeschreibung für die Digimodes (Digital Modes Field 
Descriptions)

• Digital Interface 1 / 2 (Digitales Interface 1/2)
o TU type (Soft-/Hardware-Auswahl) 

 None (keine)
 Kontroller wie KAM, PK232, PTC und andere externe TNCs 
 Soundcard   (Soundkarte) für MMTTY oder MMVARI mit einem 

Soundkartenprogramm 
o Port, Speed, Parity, Data Bits, Stop Bits, Flow Control: Baudrate, 

Datenformat und Protokoll für den externen Kontroller 
• DI-1 MMTTY Mode | DI-2 MMTTY mode 

o Wählen Sie hier, ob unter MMTTY mit AFSK oder FSK gesendet wird
o Haben Sie FSK gewählt, müssen Sie die serielle Schnittstelle direkt bei 

MMTTY einstellen. Informieren Sie sich unter MMTTY support. 
• DI-1 MMTTY Path | DI-2 MMTTY Path 

o Tragen Sie hier das Verzeichnis ein, in dem die MMTTY-Maschine zu 
finden ist

o MMTTY muss nicht im gleichen Verzeichnis wie N1MMLogger stehen. 
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o Sie können mit der Taste 'Select' die Verzeichnisse durchsehen und 
den Speicherort von MMTTY anwählen 

o DI-1 steht für das erste Digital-Interface, DI-2 für das zweite 
o Sie können für beide Interfaces je ein getrenntes MMTTY starten 

6. Einstellung weiterer Funktionen (Config >Other Tab)

 

Die Karteikarte Other erlaubt die Einstellung verschiedener Funktionen und Modi. 

6.1. Feldbeschreibung für die Karteikarte Other (Other Tab Field 
descriptions)

• Packet Spot Time (min):  Gibt vor, wie lange ein DXSpot in der Bandskala 
stehen bleibt. Voreingestellt sind 60 Minuten, Sie können einen anderen Wert 
eintragen.

• Repeat time in millisecs:  Gibt vor, in welchem Abstand ein automatischer 
CQ-Ruf wiederholt wird (Auto CQ). Voreingestellt sind 1,8 s (1800 ms). Sie 
können jeden Wert bis 32767 in Millisekunden oder Sekunden eintragen. Tipp 
DM3ML: Nehmen Sie Millisekunden, dann haben Sie kein Problem mit dem 
Komma. Sie können diese Einstellung auch mit Ctrl+R oder 'Config | Set CQ 
repeat time' aus dem Logeingabefenster rufen.

• Default # Spots in SH/DX/# : Zahl der mit SH/DX in der Bandskala 
abzurufenden DX-Spots. Voreingestellt sind 30. Die im Telnet-Fenster 
eingestellte Zahl wird von dieser Einstellung nicht beeinflusst. Sie kann aus 
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dem Logeingabefenster mit dem Menü 'Config menu | Edit Packet/Telnet 
Buttons' eingestellt werden.

• SSB Tuning Tolerance (Hz): Stellt in SSB die Ablage in der Bandskala ein, 
ab der ein Rufzeichen in den Rahmen über dem Rufzeichenfeld übernommen 
wird oder die Verstimmung, ab der das Rufzeichenfeld bei einem 
Frequenzwechsel wieder geleert wird. Voreingestellt sind 300 Hz. Möglich 
sind Werte zwischen 0 und 20000 (20 kHz). 

• CW Tuning Tolerance (Hz): Stellt in CW die Ablage in der Bandskala ein, ab 
der ein Rufzeichen in den Rahmen über dem Rufzeichenfeld übernommen 
wird oder die Verstimmung, ab der das Rufzeichenfeld bei einem 
Frequenzwechsel wieder geleert wird. Voreingestellt sind 300 Hz. Möglich 
sind Werte zwischen 0 und 20000 (20 kHz). 

• RTTY Tuning Tolerance (Hz): Stellt in RTTY die Ablage in der Bandskala ein, 
ab der ein Rufzeichen in den Rahmen über dem Rufzeichenfeld übernommen 
wird oder die Verstimmung, ab der das Rufzeichenfeld bei einem 
Frequenzwechsel wieder geleert wird. Voreingestellt sind 300 Hz. Möglich 
sind Werte zwischen 0 und 20000 (20 kHz).  

• CW Weight: Verhältnis von Punkt- zu Pausenlänge in CW (zwischen30-70%) 
Voreingestellt ist der Wert 50. Dieser Wert wird auch für Winkey übernommen. 

• SSB Up/Down Arrow Incr (kHz): Sprungweite in SSB für die Tasten Pfeil 
nach oben und Pfeil nach unten. Stellen Sie keinen kleineren Werte als das 
Raster Ihres Transceivers. Ältere ICOM-Transceiver können nur 100Hz. Im 
Zweifelsfall haben die Tasten keine Wirkung.

• CW Up/Down Arrow Incr (kHz): Sprungweite in CW für die Tasten Pfeil nach 
oben und Pfeil nach unten. Stellen Sie keinen kleineren Werte als das Raster 
Ihres Transceivers. Üblich sind Rasterwerte von 10 Hz.

• PgUp/PgDn Incr (kHz):  Frequenzsprungweite für die Macros {PGUP} und 
{PGDN}

• Primary CW speed Step: Sprungweite für die Einstellung der 
Gebegeschwindigkeit mit den Tasten Bild hoch und Bild runter im 
Logeingabefenster 

• Secundary CW speed Step:  Zweiter Wert für die Sprungweite der 
Gebegeschwindigkeit mit den Tasten Shift+Bild hoch und Shift+Bild runter. 
Die Tasten ALT+Bild hoch und ALT+Bild runter stellen die 
Gebegeschwindigkeit am inaktiven Transceiver/VFO im SO2R/SO2V-Modus 
ein

• Keep log of all QSOs to facilitate recovery of log: Erzeugt eine 
Sicherungsdatei des Logs und speichert alle QSOs in einem Contest. Falls 
Ihre Datenbank abstürzt können Sie mit dieser Datei eine neue Datenbank für 
den aktuellen Contest wieder aufbauen und den Contest fortsetzen: 

o Wenn Sie diese Funktion aktivieren wird für jeden Contest ein 
Sicherungslog angelegt

o Die Datei wird nach jedem neuen Eintrag geschlossen und für einen 
neuen Eintrag wieder geöffnet 

o Zur Sicherheit dürfen Sie den Namen des Sicherungslogs nicht ändern 
 Der Name ist dem Contest eindeutig zugeordnet, sie können die 

Logs nicht mischen 
 Ein Beispiel ist ‘CQWWCW - 2005-09-19.TRN' 

o Zur Wiederherstellung müssen Sie das Sicherungslog in eine NEUE 
Datenbank importieren, um zu verhindern, dass sich altes und 
fehlerhaftes Log mit der Sicherungsdatei gegenseitig behindern
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o Verwenden Sie 'File > Import > Recover QSOs from a Transaction Log' 
um die Sicherungsdatei zu importieren 

o Wenn Sie ein Sicherungslog (transaction log) laden wird automatisch 
ein neues Sicherungslog angelegt. Vermeiden Sie es daher auf jeden 
Fall Sicherungslogs zu vermischen. Nehmen Sie immer das letzte Log. 

• Start Contest Reporting Application: Mit dieser Funktion werden Ihre 
aktuellen Contestergebnisse an eine weltweite Datenbank geschickt. Auf 
diese Weise können andere Teilnehmer während eines Contest sehen, wo sie 
im Vergleich zu den eigenen Ergebnissen stehen. 

• Mute mic on supported radios:  Das Mikrofon wird für die Dauer der 
Übertragung einer WAV-Datei gesperrt. Hängt davon ab, ob der gesteuerte 
Transceiver diese Möglichkeit installiert hat. Voreingestellt ist die Sperre 
abgeschaltet. Unterstützt werden die Transceiver Tentec Orion und Elecraft 
K3. 

• Format for DXSpider Cluster: Sendet abhängig vom verwendeten DXCluster 
das richtige Format für SH/DX, z.B. für einen DXSpider das Kommando 
SH/DX/30 on 20. Es wird SH/QRZ anstelle von SH/BUCK gesendet. Um 
festzustellen, welches Format Ihr DXCluster verwendet senden Sie die 
Abfrage SH/VER. Ein DX-Spider anwortet mit DX Spider Cluster. 
Voreingestellt ist diese Option nicht aktiviert.

• Auto-Completion Mode: Ergänzt Rufzeichen automatisch so wie die 
Adressleiste im Internet-Explorer. Wenn Sie den Teil eines Rufzeichens 
eingeben, wird in der Masterdatei nach einem passenden Rufzeichen gesucht. 
Falls ein passendes gefunden wird, wird der Rest ergänz und hell getastet. 
Sie können es annehmen oder weiter eingeben. Während Sie eingeben, wird 
der hell getastete Bereich überschrieben oder korrigiert. 

• Use Reverse CW: Wenn Sie auf CW umschalten, wird Ihr Transceiver auf 
CW-R (Reverse-CW) gesetzt
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7. Einstellung von Winkey (Config >Winkey Tab)

 

Die Karteikarte Winkey steuert den K1EL Winkey keyer.  Dieses Gerät kann allein 
oder mit einem Rechner gesteuert zusammen mit dem Microham Microkeyer oder 
RigExpert arbeiten. Diese Funktionen beeinflussen das Winkey-Chip und die 
angeschlossene Hardware. Informieren Sie sich im Handbuch zu Winkey über die 
möglichen Einstellungen. 

Winkey wurde von K1EL und G3WGV entwickelt. Aufgabe von Winkey ist in erster 
Linie die CW-Tastprobleme unter Windows im Multitaskingbetrieb abzustellen. Die 
Baugruppe erhält die auszugebenden Texte im ASCII-Format und setzt sie 
autonomom in saubere CW-Signale um. Winkey benötigt eine eigene serielle 
Schnittstelle. Die Ansteuerung erfolgt über USB und eine dort konfigurierte virtuelle 
COM-Schnittstelle Winkey kann auch separat als CW-Geber verwendet werden.

Weitere Informationen erhalten Sie über die Linkseiten und im Kapitel Unterstützte 
Hardware (Supported Hardware) page. Der Bereich für das Winkey-Potentiometer 
ist von 10 wpm bis 55 wpm eingestellt. Mit Winkey können Sie auch die PTT-Leitung 
schalten, auch in anderen Sendearten. Diese Funktion ist erst ab Winkey-Version 10, 
21 und höher verwendbar. 
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7.1. Beschreibung der Winkey-Felder (Winkey Field Descriptions)

• Keying Mode: Wählen Sie Iambic A, Iambic B, Ultimatic oder Semi-Automatic. 
Voreingestellt ist Iambic-B. 

• Autospace: Erzeugt automatisch eine korrekte Zeichenpause von drei 
Punktlängen, wenn beim Geben eine Pause von länger als einer Punktlänge 
gemacht. 

• Pot is wired with two leads: Das Potentiometer ist mit nur zwei Leitungen 
anstelle von 3 Leitungen angeschlossen. Lassen Sie das Feld frei, es sei 
denn, sie haben das Gerät selbst zusammengebaut und das Pot so 
angeschlossen. 

o Pin 5 Function: Wählt die Funktion von Pin 5. Voreingestellt ist es als 
PTT-Leitung, kann aber auch als Mithörton und 2. CW-Ausgang 
verwendet werden oder gar nichts. Entnehmen Sie Einzelheiten dem 
Winkey-Handbuch. 

• Sidetone Frequency:  Mithörton, voreingestellt ist 469 Hz. 
• Reverse Paddles: Vertauscht die Paddles der Taste (für Linkshänder) 
• Ignore Winkey Speed Pot: Die Einstellung des Pots am Winkey-Gehäuse 

wird ignoriert 
• Lead Time: Vorlaufzeit zwischen Winkey-PTT-Aktivierung und erstem CW-

Zeichen in 10ms-Inkrementen bis 2,55 Sekunden. Gehen Ihnen bei der TX-
Umschaltung der erste Punkt oder Strich verloren, setzen Sie diese Zeit auf 
mindestens 10ms. Eine ‚1’ entspricht 10 ms.  

• Tail Time: Nachlaufzeit in 10ms-Inkrementen bis 2,55s bei der Umschaltung 
von Senden auf Empfang. Eine ‘1’ entspricht 10ms. Bei einer ‘0’ schaltet die 
PTT sofort ab, wenn kein Zeichen mehr zu senden ist. 

• First Character Extension: Das erste Element eines Zeichens wird in 10ms-
Schritten bis 2,55 Sekunden verlängert. Sollte nur bei alten Geräten mit einer 
längeren TX-Umschaltzeit verwendet werden und ist durch ein Experiment zu 
bestimmen. 

• Keying Compensation:  Bei QSK-Tastung mit Geschwindigkeiten von >30 
WpM werden Punkte und Striche in 1ms-Schritten verlängert um die 
Relaisumschaltzeiten zu kompensieren.  

• Hang Time: Haltezeit für die PTT nach dem Ende der CW-Sendung in 
Abhängigkeit von der Gebegeschwindigkeit mit 1, 1.33, 1.67 oder 2 
Buchstabenpausen (keine Zwischenräume). Die Tail Time muss dabei auf 
Null gesetzt werden. 

• Winkey 2 
o Sidetone: Erzeugt einen Mithörton in jedem Fall (Taste+PC) 
o Paddle only sidetone: Erzeugt einen Mithörton nur beim Geben mit 

der Taste 
o Use 2nd output: Verwendet den 2.Ausgang zur Tastung 

  CW-Geschwindigkeit für Winkey einstellen 
Sie können die Gebegeschwindigkeit für Winkey entweder im Logeingabefenster von 
N1MMLogger in 2 Wpm-Schritten oder am Potentiometer des Winkey-Geräts 
einstellen. Wird das Pot nicht deaktiviert, können Sie die Gebegeschwindigkeit mit 
den N1MMLogger-Reglern ändern, aber sobald Sie am Pot des Winkey drehen, wird 
die dort eingestellte Geschwindigkeit sowohl für N1MMLogger als auch die Taste 
übernommen.
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Tipp von DM3ML: Regeln Sie die Gebegeschwindigkeit ausschließlich mit dem 
Winkey-Pot. 

 Einstellung der CW-Wichtung: Gehen Sie zur Karteikarte Other und wählen Sie 
einen Wert zwischen 30 und 70%. 

7.2. Winkey beim N1MMLogger einstellen (How to Set Up Winkey in 
N1MM Logger)

Wählen Sie bei der Schnittstellenauswahl für eine Schnittstelle die Funktion 
CW/Other. Klicken Sie auf Set. Machen Sie einen Haken bei Winkey. Gehen Sie 
dann zur Karteikarte Winkey und machen Sie die weiteren Einstellungen. Wenn Sie 
Winkey zur PTT-Steuerung verwenden, müssen Sie Vor- und Nachlaufzeit auf dieser 
Karteikarte eintragen. Es ist zweckmäßig eine Vorlaufzeit zu verwenden und die 
Nachlaufzeit in Abhängigkeit von der Gebegeschwindigkeit einzustellen. 

8. Einstellung der Sendearten (Config >Mode Control Tab)

 

Die Sendeartensteuerung übersetzt die Contest-Sendearten in die Einstellung, die 
am Transceiver dafür einzustellen ist, speziell für die Digimodi. Sie legt auch fest, 
welche Sendeart im Log eingetragen wird und woher diese Angaben kommen.
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8.1. Beschreibung der Felder für die Sendeartensteuerung (Mode 
Control Field Descriptions)

• Mode recorded in log: Gibt vor, woher die ins Log einzutragende Sendeart 
genommen wird: 

o Use radio mode: es wird die am Transceiver eingestellte Sendeart 
verwendet 

o Follow band plan (voreingestellt). Die Sendeart wird dem Bandplan 
für die eingestellte Frequenz entnommen 

o Use contest mode or bandplan: die Senderart wird der 
Contesteinstellung entnommen (eindeutig bei Contesten in einer 
Sendeart, bei ‘mixed’ wird die Sendeart aus dem Bandplan genommen. 

o Use contest or radio mode: die Sendeart wird der Contesteinstellung 
bei nur einer Sendeart entnommen, sonst wird die am Transceiver 
eingestellte Sendeart genommen 

o Always: es wird die in das Feld eingetragene Sendeart genommen 
(CW, SSB, RTTY, PSK31, PSK63). 

• Mode sent to radio: Bestimmt, welche Sendeart an den Transceiver 
geschickt wird 

o Don't change radio mode : es wird keine Sendeart an den 
Transceiver geschickt 

o Follow mode recorded in log (voreingestellt):  Die für das Log oben 
ausgewählte Sendeart wird an den Transceiver geschickt 

o Except change 
 Log mode RTTY to Radio mode: setzt die Log-Sendeart RTTY 

in die vom Transceiver verstandene oder dort benötigte 
Sendeart um, z.B. für RTTY wird USB oder LSB bei AFSK-
Tastung eingestellt 

 Log mode PSK to Radio mode - setzt die Log-Sendeart PSK in 
die vom Transceiver verstandene oder dort benötigte Sendeart 
um, z.B. für PSK wird USB oder LSB bei AFSK-Tastung 
eingestellt 
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9. Einstellung der Antennensteuerung (Config >Antennas Tab)

 

Mit der Karteikarte Antennas kann ein Antennenwahlschalter in Abhängigkeit vom 
eingestellten Band automatisch umgeschaltet werden. Die Steuerung geschieht über 
eine parallele Schnittstelle in Zusammenarbeit mit einem Antennenschalter wie dem 
Top-Ten-Gerät. Der abzuschickende Code wird in der Tabelle den verschiedenen 
Antennen zugewiesen. Ein Beispiel für den Top-Ten-Schalter finden Sie unter 
Interfacing. 

Mit ALT+F9 können Sie zwischen den für dieses Band eingetragenen Antennen 
durchschalten. Gibt es dort nur eine Antenne, wird nicht weiter geschaltet. Wenn Sie 
auf ein anderes Band umschalten, wird jeweils die Antenne mit dem niedrigsten 
Code angeschaltet. Der Name der aktivierten Antenne steht in Statuszeile des 
Logeingabefensters. 

• Code : Signalkombination an der LPT-Schnittstelle (4 Bits = 0..15) 
o Zu jedem Code gehört EINE Antenne unabhängig vom Band. 
o Der Code ergibt sich aus den Pegeln an den Pins 9, 8, 7 und 2. 

• Antenna: Beschreibung der Antenne als Text 
• Bands: Bänder, auf denen die Antenne verwendet werden soll, Bandangaben 

durch Komma trennen (Achtung: Unterschiede zwischen engl. und deutscher 
Windows-Einstellung möglich). 

• Rotor Port(s): Serielle Schnittstelle des zugehörigen Rotors in der 
N1MMLogger-Aufstellung. Es können bei gestockten Antennen mehrere 
Rotoren durch Komma getrennt angegeben werden 
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• Offset:  Verwendbar, wenn die Antennen um 90° versetzt montiert sind oder 
der Sturm die Antenne auf dem Mast verdreht hat. Der Offset kann bei der 
Rotoreinstellung eingetragen werden.  

• Bidirect: Mit einer 1 wird die 180°-Antennenrichtung eingeschaltet, z.B. bei 
einer Step-IR-Antenne. Normal: 0 

• Start UDP port for Rotor Program:  Einstellung der UDP zwischen 
Rotorprogramm und N1MMLogger. Voreingestellt ist der UDP-Port 12040 und 
muss bei beiden Programmen den gleichen Wert haben 

• Start Rotor Program:  Startet das Rotor-Programm automatisch zusammen 
mit N1MMLogger. Sie müssen es aber von Hand wieder herunterfahren. 

 LPT Port-Konflikt 
Wenn Sie die DVK anwählen, funktionieren auf dem dazu gehörenden LPT-Port die 
Pins für die Antennenauswahl nicht. Sie überlappen sich mit der DVK. 

10. Einstellung der Soundkarten (Config >Audio Tab)

 

Bei der Verwendung von zwei Soundkarten für den SO2R-Betrieb informieren Sie 
sich im Kapitel SO2R. Das gezeigte Bild bezieht sich auf eine SO2R-Einstellung

1 – Eine Soundkarte, ein Transceiver, kein SO2R

• Mit einer Soundkarte werden WAV-Dateien abgespielt, der Audioausgang des 
Transceivers mitgeschnitten und das Mikrofon beim Abspielen der WAV-

11.04.2010



N1MM-Contest Logging Software Seite 103 von 470 Übersetzung der Hilfe von Eike, DM3ML

Dateien stumm geschaltet. Nur der obere Teil des Fensters muss ausgefüllt 
werden. Der untere Teil ist abgeschaltet. 

2 – Eine Soundkarte, zwei Transceiver, keine SO2R-Soundkarte

• Die Soundkarte spielt die WAV-Dateien für beide Transceiver ab und zeichnet 
beide auf. Nur der obere Teil des Fensters muss ausgefüllt werden. Der 
untere Teil ist abgeschaltet. 

3 – Eine Soundkarte, zwei Transceiver, Soundkarte für SO2R, nur CW 

• SO2R mit einer Soundkarte nur für CW 
• Die Kopfhörer werden nicht umgeschaltet 
• Sie müssen ein Kabel für den CD/Aux-Eingang der Soundkarte anfertigen, um 

diese Einstellung verwenden zu können 
• Sie müssen Ihre Transceiver als SO2R in der Karteikarte Hardware einstellen 
• Beide Teile des Fensters sind auszufüllen (TX Sound Card und QSO-Record 

+ Rx Sound Card)  
o Die Schnittstelle TX Radio Input Port im oberen Teil ist abgeschaltet 

deselected. 

4 – Zwei Soundkarten, zwei Transceiver, Soundkarte für SO2R 

• Voller SO2R-Betrieb mit Audioumschaltung mit zwei Soundkarten 
• Die Kopfhörer werden umgeschaltet 
• Sie benötigen ein Kabel für den CD/Aux-Eingang der Soundkarte 
• Sie müssen die SO2R-Transceiver auf der Karteikarte Hardware definieren 
• Der obere und der untere Teil des Dialogs (s.o.) müssen ausgefüllt werden 

(Tx-Soundkarte und QSO-Aufzeichnung+Rx-Soundkarte)  
o Der TX-Radio-Eingang im oberen Teil wird nicht aktiviert 

 Nicht alle Soundkarten sind geeignet 
Mit dem Configurer können Sie Parameter einstellen, die u.U. von der Soundkarte 
nicht unterstützt werden. Verwenden Sie nach Möglichkeit die Einstellung 16 bit, 
11025 Hz/sec.  

• Tx Sound Card and QSO Recording Setup: - Nehmen Sie am besten die 
voreingestellte Soundkarte als TX-Soundkarte. Der CD-Eingang wird für TX 
nicht verwendet und dadurch nicht belegt. Wenn Sie die voreingestellte 
Soundkarte für RX verwenden, wird einer der Transceiver an den sonst 
ungenutzten Aux-Eingang gelegt.  

o Select Device: Wählt die Soundkarte aus, mit der WAV-Dateien 
gesendet (DVK) und die QSO mitgeschnitten werden

o Select Input Line:  Wählt die Eingangsleitung für die Aufzeichnung 
aus. Falls Ihr Mikrofon an der Soundkarte angeschlossen ist, wählen 
Sie den MIC-Eingang 

o Select Line to Mute: Wählen Sie die Leitung aus, die beim Abspielen 
von WAV-Dateien stumm geschaltet werden soll, das ist meist der MIC-
Eingang. 
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o Recording Bits:  Sie können eine 8-, 16- oder 24-Bit-Aufzeichnung 
wählen. Wenn Ihre Soundkarte die Bitrate nicht verarbeiten kann, 
erhalten Sie einen Error 4 beim Start der Aufzeichnung. 

 Wählen Sie 8 oder 16 Bits, sie werden in der Regel verarbeitet 
und die entstehenden Dateien sind nicht so groß und haben eine 
ausreichende Qualität

o Recording Sample Rate:  Abtastrate, 11025 Hz/s sind ein guter Wert 
o Radio Input Port: Leitung an die der NF-Ausgang des Transceivers 

angeschlossen ist, meist der LIN-Eingang. 
o Max Recording Length (secs): maximale Länge einer WAV-

Aufzeichnung. Wird sie überschritten wird die Aufzeichnung 
abgebrochen. Voreingestellt sind 30s 

o Recording channels:  Zahl der Aufzeichnungskanäle, 1 oder 2 

Der Ausgang der WAV-Dateien ist in jedem Fall der Lautsprecherausgang der 
Soundkarte. 

• Rx Sound Card Setup (verwendet für die SO2R-Kopfhörerumschaltung): 
Für SO2R benötigen Sie zwei LIN-Eingänge. In der Regel verwenden Sie 
dazu die CD/Aux-Eingänge. Stellen Sie ein Stereokabel her. Diesen Teil 
können Sie nur mit den Konfigurationen 3 oder 4 verwenden, sonst sind sie 
inaktiv und grau hinterlegt. 

o Device: Wählen Sie die zweite Soundkarte
o Left Radio Input Port: Stellen Sie die Eingangsleitung des links 

stehenden Transceivers ein. Meist ist das LINE IN oder CD/Aux. 
o Right Radio Input Port: Stellen Sie die Eingangsleitung des rechts 

stehenden Transceivers ein. Meist ist das LINE IN oder CD/Aux. 
Verwenden Sie unterschiedliche Eingänge für den linken und den 
rechten Transceiver! 

Last Modification: 28 December 2009 15:22:54 EST by ve3ki. 

Starten Sie einen neuen Contest/Öffnen Sie ein existierendes 
Contestlog (Start a New Contest Log / Open an Existing 
Contest Log)

 Datenbanken oder Logs 

N1MMLogger erzeugt Datenbanken innerhalb derer die Logs abgelegt werden. 
Dabei ist Datenbank der Oberbegriff. In der oder den Datenbank(en) werden die 
Logs gespeichert. Für jeden Contest wird ein neues Log angelegt.
Die Datenbanken entsprechen einem Dateiverzeichnis, die Logs einer Datei in 
diesem Verzeichnis. Sie können festlegen, wie Sie die Datenbanken anlegen und 
diese Datenbanken einem Contest-Typ zuordnen. Angeführt seien drei Beispiele: 

1. DATABANK nach CONTEST-TYP:  Für verschiedene große Contestarten werden 
getrennte Datenbanken angelegt, z.b. Datenbanken (Database) unter den Namen 
CQ WW. MDB / ARRL DX.MDB / ARRL 160.MDB und CQ WPX.MDB. 
Wollen Sie einen Contest dieser verschiedenen Typen starten, gehen Sie zu File  
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>Open the Database und wählen den passenden Typ. Wählen Sie dann File >New 
Log und öffnen Sie ein Log für den nächsten Contest. So kann z.B. Ihre Datenbank 
CQWWW.mdb die CW, Phone und RTTY-Logs von 2007, 2008 und 2009 enthalten. 
Nehmen Sie die Datenbank MISCELLANEOUS.MDB (VERSCHIEDENES.MDB) für 
kleinere Conteste. 

2. DATABANK nach Kalenderjahr, z.B. K8UT 2008.MDB, K8UT 2009.MDB oder 
K8UT 2010.MDB. Erzeugen Sie eine neue Datenbank mit dem Menü File > New 
Database. Speichern Sie die Logs eines Jahres in dieser Datenbank. 

3. DATABANK für jeden Contest. Manche Stationen erzeugen für jeden Contest eine 
eigene Datenbank mit File > New Database und erzeugen innerhalb dieser 
Datenbank mit File > New Log das neue Contestlog. Bei vielen Contesten wird diese 
Art der Buchführung mit der Zeit unübersichtlich. 

Sie können die Logs auch nach Sendearten oder Frequenzbereichen ordnen, Ihrer 
Phantasie sind keine Grenzen gesetzt.  

Sie finden die von N1MMLogger unterstützten Conteste im Kapitel Unterstützte 
Conteste (Supported Contests). 

Der Contesttyp DX kann für eine Dxpedition genommen werden. Es sind alle 
Sendearten möglich (mixed). Wenn Sie nur SSB oder nur CW gewählt haben, 
werden nur QSOs in diesen Sendearten akzeptiert. 
Alle Fenster haben diese Austrittstasten: 

• Ok : Verlassen Sie das Fenster, die eingetragenen Daten werden gespeichert. 
• Help : Starten Sie die Hilfe für das aktuelle Fenster 
• Cancel : Verlassen Sie das Fenster. Alle Änderungen werden verworfen und 

nicht gespeichert 

 Sent Exchange (Kontrollnummer eingeben) 
Geben Sie hier KEINEN Signalrapport ein!  

1. Start mit neuem Contestlog (Start a new contest log)

Wählen Sie im Menü File >New Log in Database. 

• Wählen Sie den Contest im Menü Log Type mit einem Klick auf die Pfeiltaste
• Tragen Sie die für diesen Contest benötigten Daten auf den Karteikarten 

Contest und Associated Files ein. 
• Die für diesen Contest voreingestellten Werte werden auf der Karteikarte 

Contest bereits eingetragen (Sendeart, Kontrollnummer)  
• Log Type: Hier steht der Name des Contests
• Start date: Datum des Contestbeginns. Das Datum dient dazu, verschiedene 

Conteste des gleichen Typs auseinander zuhalten. 
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Informieren Sie sich über aktuellen Contestregeln. Bekannte Daten enthält das 
Kapitel Contesteinstellungen (Contest Setup Instructions). 

2. Öffnen eines vorhandenen Logs (Open an Existing Contest Log)

Wählen Sie das Menü File >Open Log in Database um ein schon angefangenes 
Contestlog weiter zu führen. Sie können Änderungen auf den Karteikarten Contest 
and Associated Files vornehmen, falls das nötig ist.

 

Wollen Sie ein Contestlog löschen, markieren Sie es wie oben angezeigt und 
drücken Sie dann die Taste Entf auf der Tastatur.  
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3. Contesteinstellungen (Contest Specific Information)

 

Entsprechend dem gewählten Contest werden verschiedene Werte voreingestellt. 

3.1. Karteikarte Contest (Tab: Contest)

• Operator Category: Wählen Sie entsprechend der Ausschreibung: 
o SINGLE-OP 
o SINGLE-OP-ASSISTED 
o MULTI-ONE 
o MULTI-TWO 

 Sie müssen die Stationen 1 und 2 im Log spezifizieren. Diese 
Einstellung wird beim Programmstart abgefragt 

o MULTI-MULTI 
o SCHOOL-CLUB 
o CHECKLOG 
o SINGLE-OP-PORTABLE 
o ROVER 
o MULTI-UNLIMITED 
o MULTI-LIMITED 

• Band Category: Hier wird das verwendete Band eingetragen: 
o ALL 
o 160M 
o 80M 
o 40M 
o 20M 
o 15M 
o 10M 
o LIMITED 
o CHECKLOG 

• Power Category: Leistungsklasse entsprechend der Ausschreibung: 
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o HIGH 
o LOW 
o QRP 
o MEDIUM 

• Mode Category: Sendeart: 
o CW 
o SSB 
o RTTY 
o PSK 
o MIXED 

• Overlay Category: Weitere Kategorien entsprechend der Ausschreibung: 
o N/A (voreingestellt) = keine Angaben
o ROOKIE 
o BAND-LIMITED 
o TB-WIRES (tri-bander and wires) 
o OVER-50 
o HQ 
o NOVICE-TECH 
o EXPERT 

In der Kategorie Overlay kann es Kombinationen geben, z.B. im CQ-WPX CW und 
CQ-WPX-SSB können ROOKIE, BAND-LIMITED, TB-WIRES gewählt werden. Bei 
STEW-PERRY kann man OVER-50 wählen. Im IARU-HF gibt es die Kategorie HQ 
und im PACC die Kategorie NOVICE-TECH. 

• Sent Exchange: Kontrollnummer OHNE Rapport, wie Seriennummer, Zone, 
Staat oder Provinz. Als Rapport wird 59(9) angenommen. Der Rapport kann 
aber im Logeingabefenster abweichend editiert werden. Wird hier ein Rapport 
eingetragen, wird ein ungültiges Cabrillo-Log erzeugt.

• Operators: Hier werden bei Multistationen mehrere OPs eingetragen, sonst 
der OP aus den Stationsdaten. Mit der Taste 'Update Ops from Log' werden 
die während des Contests eingetragen Rufzeichen der Operatoren 
übernommen. 

• Soapbox comments: Kommentare zum Contest. Der Text wird bei einem 
neuen Contest gelöscht. 

• Section Lists (Sektionsliste), speziell für US-interne Conteste, wird nur bei 
diesen Contesten angezeigt

o Selection list: State for Log Type QSOPARTY 
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• Taste Show Rules (Contestregeln aus dem Internet anzeigen): Geht zu der 
Seite des Contestveranstalters, falls bekannt.  

3.2. Tab: Zugehörige Dateien (Associated Files)

 

• Master.DTA Filename: Das ist eine Datei mit Conteststationen, die aus 
eingesandten Logs erzeugt worden ist. Sie kann Stationen weltweit enthalten 
oder auf spezielle Conteste zugeschnitten sein. Sie ist im Internet zu finden 
und dient zur Komplettierung von nur teilweise aufgenommenen Rufzeichen.  

 Sie sollten vor jedem Contest die Länderdatei CTY.DAT auf den neuesten Stand 
bringen. Gehen Sie zu Tools >Download latest country file (wl_cty.dat)  
(Internet). Importieren Sie nach dem Abholen der Datei diese mit Tools >Import 
country list from downloaded file nach N1MMLogger.

• SSB Function Key (CW Function Keys-, Digital Function Keys-) 
Filename: mit diesem Eintrag können Sie den Speicherort für die Datei der F-
Tasten in der Sendeart angeben, für die Sie früher Contest-spezifisch eine 
Datei angelegt haben. Mit Change können Sie eine Datei auswählen. Mit 
Clear wird der Eintrag gelöscht. 

Last Modification: 21 December 2009 11:06:08 EST by K8UT. 
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Fenster (Windows)

Logeingabefenster (Entry Window)

Das Logeingabefenster kann so aussehen: 
 

 

Sie kommen auf zwei Wegen von Feld zu Feld: 

• Tab (vorwärts) oder Shift+Tab (rückwärts) schaltet von Feld zu Feld in einer 
Standardsequenz 

• Mit der Leertaste kommen Sie zu den Eingabefelder, für die eine Eingabe 
erwartet wird. Die anderen Felder, in denen keine Änderung erwartet wird, 
werden übersprungen. 

 Tipp 
Sie sollten immer die Leertaste nehmen, um sich Arbeit zu sparen. 

1. Tastenzuordnung (Button Assignments)

• Wipe / Alt+W: Löscht alle Eingabefelder 
• Log It Enter: Speichert das aktuelle QSO. Beim Editieren abgeschaltet. 
• Edit: Sie können zum aktuellen QSO zusätzliche Angaben eintragen 
• Mark / Alt+M: Markieren der aktuellen Frequenz als “Belegt” in der Bandskala, 

wenn dort z.B. eine Station arbeitet, die nicht im Contest mitmacht 
• Store / Alt+O: Station selbst in der Bandskala spotten. Wird fett angezeigt. 
• Spot it / Alt+P:  Spottet das QSO im angeschlossenen DXCluster 
• Buck:  Daten des aktuellen Rufzeichens von der Buckmaster-CD abrufen. 

Falls die Datei hamcall32.dll nicht gefunden wird, wird bei www.qrz.com 
nachgefragt. 

• Tasten F1 bis F12: sendet den für die Tasten programmierten CW-Text, ruft 
in SSB die programmierten WAV-Dateien und sendet den programmierten TX 
in den Digimodes. Die Tasten sind für RUN- und S&P-Modus doppelt belegt 
und werden automatisch umgeschaltet. Der Text des nicht aktiven Modus 
kann mit Shift+F-Taste abgerufen werden.  

• Shift+F1 through Shift+F12: Abruf der Texte des anderen nicht aktiven 
Modus (siehe oben). 
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• Esc: bricht die Aussendung des mit einer F-Taste abgerufenen Textes. Stoppt 
die Aufzeichnung oder die Wiedergabe einer Audiodatei.

• Running / Alt+U:  schaltet die "Running' box" und damit den RUN-Modus 
ein bzw. aus.  

• CW speed:  Zeigt die aktuelle Gebegeschwindigkeit in WpM an. Diese 
Geschwindigkeit kann mit den Pfeiltasten erhöht oder erniedrigt werden. Die 
gleiche Änderung erreichen Sie mit den Tasten Bild hoch und Bild runter auf 
der Tastatur. Die maximal einstellbare Gebegeschwindigkeit ist 98 wpm... 

2. Editiermöglichkeiten für Rufzeichen und Kontrollnummer 
(Callsign/Exchange Editing Features)

• Space Bar (Leertaste): schaltet den Cursor zwischen den Arbeitsfeldern (in 
der Regel Rufzeichen und Kontrollnummer) hin und her 

• Tab:  schaltet den Cursor ins nächste Feld vorwärts 
• Shift+Tab:  schaltet den Cursor zurück 
• Home : setzt den Cursor an den Anfang des jeweiligen Eingabefeldes 
• End: setzt den Cursor an das Ende des jeweiligen Eingabefeldes  
• Question mark (Fragezeichen) (?): Sendet ein ? und tastet das ? bei der 

nächsten Eingabe hell. Sie senden z.B. N?MM und das Fragezeichen wird hell 
getastet, so dass Sie es korrigieren können. Ein doppeltes Fragezeichen, z.B. 
DL?K?A tastet den Bereich zwischen beiden Rufzeichen hell und alle drei 
Zeichen können korrigiert werden. 

• Left/Right Arrow (Pfeil links/rechts): Bewegt den Cursor um eine Position 
nach links oder rechts 

• Backspace (Pfeil zurück): löscht das links neben dem Cursor stehende 
Zeichen 

• Delete: löscht das Zeichen rechts neben dem Cursor 
• Shift+Home (Shift+Pos1):  tastet den Bereich vom Cursor bis zum Anfang 

des Eingabefelds hell 
• Shift+End (Shift+Ende):  tastet den Bereich vom Cursor bis zum Ende des 
• Shift+arrow key (Shift+Pfeiltaste): Tastet die Zeichen entsprechend der 

Tastenrichtung hell. Das erste eingegebene Zeichen löscht das hell getastete 
Zeichen 

 Hinweis 
Im Kapitel Tastenzuordnungen (Key Assignments) finden Sie alle vom Programm 
verwendeten Tasten. 

3. Weitere Informationen (Other Info)

Running / Alt+U : Markieren Sie diesen Kontakt als Teil des Run-Modus (bei S&P-
Betrieb) 

"Running" is automatisch eingeschaltet, 

• Wenn Sie auf den Eintrag CQ-frequency in der Bandskala klicken
• Wenn Sie mit dem VFO in die Nähe der CQ-frequency kommen 
• Wenn Sie die Taste F1  (die CQ-Taste) drücken 
• Wenn Sie auf den grünen Punkt in der S&P-Anzeige klicken 
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4. Anzeigen in der Statusleite (Status Bar Information)

• Left pane (linke Seite)
o Nach Eingabe eines Rufzeichens sehen Sie hier Land, Zone und 

Kontinent 
o Sonst wird dieser Bereich für aktuelle Statusinformationen 

(Fehlermitteilungen, Connectmeldungen usw. benutzt) 
• Middle pane (mittlerer Bereich): Anzahl der QSOs /Multis/Zonen im Contest 

abhängig von der Ausschreibung
• Right pane (rechte Seite): aktuelle Punktzahl

5. Rufzeichenfarben (Callsign Colors)

Die Rufzeichen werden im Rufzeichenfeld und im Rahmen darüber farbig dargestellt. 
Die Farben haben diese Bedeutung:  

Rot Einfacher neuen Multi (im CQWW neue Zone ODER neues Land)
Grün Doppelter neuer Multi (im CQWW neue Zone UND neues Land) 
Blau Neue Station  

Grau Dupe (schon gearbeitet) oder nicht im Contest arbeitbar (falscher Kontinent 
u.ä.) 

6. Die LEDS rot und grün (The Red and Green dots (LEDs))

Unterhalb des Rufzeicheneingabefelds befinden sich zwei Pseudo-LEDS die grün 
und rot leuchten und einen internen Schriftzug anzeigen können. Die LED zeigen 
den aktuellen Stand von N1MMLogger und geben dem Operator eine schnelle 
Informationen darüber was gerade passiert.

6.1. Verwendete Farben (Dot/LED colors used)

Grüne LED – Der VFO/Transceiver steht auf Empfang und die Tastatur ist bereit.  

• Ru zeigt an, dass sich die Station im RUN-Modus befindet. SP zeigt an, dass 
sich die Station im S&P-Modus befindet. 

o Mit einem Klick auf die grüne LED können Sie zwischen Ru und SP hin 
und her schalten. 

• Der Empfang und die Tastatur kann zwischen den VFOs/Transceivern 
umgeschaltet werden  

o Mit einem Mausklick in einen freien Raum eines der Logeingabefenster 
o Mit der Taste \ (backslash) . Hinweis DM3ML: Code einstellen bzw. 

beachten (Ländereinstellung der Tastatur) 
• Um sowohl den Sende- als auch den Empfangs-Fokus zu wechseln drücken 

Sie die Tasten Ctrl+linker Pfeil/Ctrl+rechter Pfeil 

Rote LED – Zeigt den für TX zuständigen VFO/Transceiver 

• Sie können den TX-Fokus mit der Taste Alt+F10 umschalten 
• Um sowohl den Sende- als auch den Empfangs-Fokus zu wechseln drücken 

Sie die Tasten Ctrl+linker Pfeil/Ctrl+rechter Pfeil 
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• Während des Sendens kann der TX-Fokus nicht geändert werden
• Wenn der VFO den TX-Fokus hat, zeigt die LED dunkelrot. Wenn dieser VFO 

sendet, zeigt die LED ein helles Rot. 
• Innerhalb der roten LED wird ein R (Repeat) angezeigt, wenn der wiederholte 

CQ-Ruf aktiv ist 
• Innerhalb der roten LED wird ein D (Dueling CQ) angezeigt, denn das CQ-

Duell aktiv ist (SO2R-Betrieb) 

7. Logeingabefenster (The Entry Windows)

Wenn zwei VFOs/Transceiver aktiv sind, werden zwei Logeingabefenster und zwei 
Bandskalen angezeigt. Sie benötigen beide Logeingabefenster, um QSOs mit 
beiden VFOs/Transceivern machen zu können! 

Das Standard-Logeingabefenster ist immer geöffnet. Es ist dem VFO-A bei SO2V 
oder dem linken Transceiver bei SO2R zugeordnet. Das zweite Logeingabefenster 
gehört zum VFO-B bzw. dem rechten Transceiver. Das zweite Eingabefenster wird 
mit einem Backslash ‚\’ geöffnet.  

Nehmen die beiden Logeingabefenster zu viel Platz nebeneinander ein, positionieren 
Sie das erste Fenster (VFO-A) oben und das zweite (VFO-B) darunter oder ziehen 
Sie die Fenster in ihrer Größe. Mit der Backslash-Taste oder Ctrl+Pfeiltaste 
links/rechts schalten Sie zwischen den Fenster um.  
Die meisten SO2R-Operatoren rufen mit VFO-A (Tcvr 1) im RUN-Modus CQ und 
suchen mit dem zweiten im S&P-Modus nach Multis oder Stationen. Diesen Zustand 
zeigen die LEDs der beiden Fenster an.  

  

Wenn Sie mit dem VFO-B die Bandskala durchkurbeln, werden Ihnen die dort 
angezeigten Stationen oberhalb des Rufzeichenfeldes angeboten. Sie können sie mit 
der Leertaste in das Rufzeichenfeld holen. Bekommen Sie einen Anruf im linken 
Fenster, schalten Sie mit der \-Taste oder Ctrl+Pfeil links/rechts zwischen den 
Fenstern um. Machen Sie das QSO links. Im rechten Fenster bleibt der Zustand 
erhalten, bis Sie das QSO dort gemacht haben oder durch ein QSY das Rufzeichen 
wieder gelöscht wird. Sie können das Rufzeichenfeld auch mit ALT+W oder Ctrl+W 
frei machen. Das im Rufzeichenfeld stehende Rufzeichen wird dann in die Bandskala 
gesetzt. Sie können die Fenster mit der Maus auf eine kleinere Größe ziehen und 
z.B. die F-Tasten unsichtbar machen. 
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Ist das rechte Logeingabefenster nicht offen, wird es nach einem Klick in die rechte 
Bandskala geöffnet.  

Einzelheiten finden Sie im Kapitel SO2R . 

 Tipp 
Im  SO2V-Betrieb  (ein Transceiver - two VFOs = 'normale' Operation) müssen 
QSOs, die Sie mit dem VFO-A machen in das erste Logeingabefenster eingetragen 
werden und QSOs mit dem VFO-B in das zweite Logeingabefenster gemacht 
werden. Wenn Sie beide Bandskalen auswerten, müssen Sie zwischen den 
Logeingabefenstern hin- und herschalten. Tragen Sie ein Rufzeichen aus der rechten 
Bandskala in das linke Logeingabefenster ein, rufen Sie auf der falschen Frequenz 
an. Wählen Sie das richtige Logeingabefenster!

8. Weitere Funktionen (Other Features)

• In der Statuszeile werden zu einem Rufzeichen das Land, die 
Antennenrichtung und Entfernung angezeigt. Für die Berechnung der 
Antennenrichtung wird erst in der Rufzeichengeschichte (Call history) 
nachgesehen - falls zugeschaltet - und wenn das Rufzeichen dort nicht 
gefunden wird, wird die Mitte des jeweiligen Staates zur Berechnung 
herangezogen. Bei VHF-Contesten wird die Entfernung aus dem WW-Lokator 
(Gridsquare) berechnet. 

• Wenn es sich um eine DUPE-Station handelt, wird das Rufzeichen bei einem 
Frequenzwechsel automatisch gelöscht und das Rufzeichen in die Bandskala 
gesetzt. 

• Wenn das eingegebene Rufzeichen ein Fragezeichen enthält, tastet der 
Cursor das Fragezeichen hell und neue eingegebene Zeichen überschreiben 
das Fragezeichen. Sind Sie im ESM-Modus bleibt der Cursor im 
Rufzeichenfeld bis das Call richtig eingegeben worden ist. Ein Rufzeichen mit 
Fragezeichen kann nicht geloggt werden. 

• Ein Klick in das Seriennummerfeld hat die gleiche Wirkung wie ein Druck auf 
die Leertaste. Der Cursor springt in dieses Feld. 

• Wenn beide Bandskalen geschlossen sind, werden Frequenz und Sendeart in 
der Titelleiste des Eingabefensters vor dem Contestnamen angezeigt. 

• Wenn Sie abstimmen und in die Nähe eines Rufzeichens in der Bandskala 
kommen, wird dieses Rufzeichen über dem Rufzeichenfeld angezeigt. Ist das 
Rufzeichenfeld leer, können Sie dieses Rufzeichen mit der Leertaste in das 
Rufzeichenfeld übernehmen. Auch mit einem Klick auf das Rufzeichen über 
dem Rufzeichenfeld können Sie es übernehmen und den Inhalt des Feldes 
überschreiben. Der Frequenzabstand, ab dem ein Rufzeichen aus der 
Bandskala übernommen wird, wird auf der Karteikarte Other eingestellt.

• Set Frequency in callsign field: Sie können die Frequenz des VFO-A in das 
Rufzeichenfeld eingeben. Geben Sie entweder die genaue Frequenz oder 
eine Ablage ein. Dezimalpunkt und Komma sind erlaubt. Setzen Sie vor die 
Frequenz einen Schrägstrich / wird der VFO-B gesetzt. Ebenfalls möglich ist 
die numerische Eingabe einer Splitfrequenz. Siehe Kapitel Grundfunktionen 
(Basic Functions). 

• Set Mode in callsign field : Geben Sie die Sendeart in das Rufzeichenfeld 
ein. Erlaubt sind CW, USB, LSB, SSB, RTTY, AM, FM, PSK oder SSTV. 
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• Ctrl+P: Spottet das im Rufzeichenfeld stehende Rufzeichen über die 
bestehenden Verbindung zu einem DXCluster. Sie werden nach einem 
Kommentaar gefragt. Steht im Rufzeichenfeld kein Rufzeichen, wird das letzte 
geloggte Rufzeichen verwendet. Macros  können in den Kommentar 
eingebaut werden. 

• Ctrl+O: Eingabe des aktuellen Operators, vor allem bei Multi-Betrieb. Sonst 
wird das Call aus der Stationsbeschreibung genommen. Wurde das Log für 
den Multi-Operator betrieb eingerichtet, wird bei Programmstart nach dem 
ersten Operator gefragt. Sie können auch OPON in das Rufzeichenfeld 
eingeben, um die Operatorabfrage zu starten. 

• Auto-call completion: Fall aktiviert, wird das Rufzeichen aus der master.dta-
Datei oder dem aktuellen Contestlog vervollständigt, falls ein eindeutig 
zutreffendes Rufzeichen erkannt wird. Der ergänzte Teil wird hell getastet und 
nach weiteren Eingaben überschrieben oder kann er akzeptiert werden.  

• Auto-CQ:  Mit  Alt+R können Sie den automatischen CQ-Ruf ein- oder 
ausschalten. Sie sehen das Ergebnis in der Statusleiste. Der CQ-Ruf kann mit 
ESC abgebrochen werden. 

o Ctrl+R:  setzt die Wiederholzeit in Sekunden oder Millisekunden 
 CQ muss im Text an erster Stelle stehen, sowohl im CQ-

Text in CW oder im Namen der WAV-Datei in SSB oder 
im Macro bei Digitalmodi. 

 CQ muss in der F-Taste an erster Stelle in allen Modi 
stehen. 

 Ein 'R' steht in der roten Status-LED, wenn der automatische 
CQ-Ruf eingeschaltet ist 

o Die Wiederholzeit gibt die Zeit zwischen Ende des ersten CQ-Rufs und 
Start des zweiten CQ-Rufs vor.  

 Bei einer externen DVK erfolgt keine Rückmeldung des Endes 
eines CQ-Rufs, so dass dort kein CQ wiederholt wird. 

• Ctrl+Shift+Fx:  Mit dieser Kombination wird der zur gedrückten Taste 
aufgesprochene Text aufgezeichnet. Die gleiche Kombination beendet die 
Aufzeichnung. Die Aufzeichnung kann für die Tasten F1 bis F12 erfolgen. 

• Ctrl+Alt+Fx:  Aufzeichnung des DVK-Speichers 1 bis 4 für die Tasten D1 bis 
F4. Die externe DVK muss über eine LPT-Schnittstelle angeschlossen und 
konfiguriert werden. 

o Wenn Sie eine externe DVK verwenden, müssen alle RUN- und S&P-F-
Tasten mit einer Datei empty.wav belegt sein, sie dürfen nicht leer 
bleiben. 

• Enter sends messages:  Mit der 'Enter mode' oder 'ESM' mode werden 
entsprechend einer Zustandstabelle mit der Taste ENTER die zum aktuellen 
QSO-Status passenden Mitteilungen abgerufen. Einzelheiten finden Sie im 
Kapitel Grundfunktionen (Basic Functions) 

• Automatically Spot all S&P QSOs: Spottet alle aktuellen QSO, funktioniert nur 
im S&P-Modus. Anmerkung DM3ML : Bitte NICHT verwenden!  

• "Quick Edit" (Ctrl+Q/Ctrl+A): Schnelles Editieren eines früheren QSOs 
o Ctrl+Q:  ein QSO zurück
o Ctrl+A:  ein QSO vorwärts 
o Enter: Abschluss des Editierens, zurück zum Loggen 
o Bei Quick Edit ist die Hintergrundfarbe des Logeingabefenster blau 

hinterlegt. Das QuickEdit beginnt beim markierten letzten QSO und Sie 
können rückwärts und vorwärts gehen 
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o Hinweis; Beim Editieren findet keine Sinnfälligkeitskontrolle wie beim 
normalen Loggen statt. Machen Sie Ihre Arbeit sorgfältig! 

• Das Programm gibt eine Warnung ab, wenn es annimmt, dass die Uhr des 
Computers falsch geht. 

• Call Stacking:  Rufzeichenstapelspeicher. Funktioniert nur im 'Multi-User 
Mode'. Siehe Kapitel Erweiterte Funktionen (Advanced Functions). 

• Using both VFOs when 'Running': Falls aktiviert wird wenn Sie mit dem 
Haupt-VFO CQ rufen und mit dem anderen hören (Split-Betrieb) nach jedem 
QSO die RX-Frequenz auf die TX-Frequenz zurückgesetzt. Sie können damit 
die Hauptabstimmung als RIT verwenden. 

• Automatic antenna selection:  Falls Sie diese Funktion aktivieren, werden 
die Antennen entsprechend der Zuordnungstabelle automatisch angeschaltet. 
Sie können dann mit der Taste ALT+F9 alle als Antennen FOR THAT BAND 
eingetragenen Antennen durchschalten, falls Sie mehrere Antennen für ein 
Band definiert haben. Die angewählte Antenne wird in der Statusleiste 
angezeigt. Angefangen wird jeweils mit der Antenne, die die niedrigste 
Nummer hat.  

• Alt+' (Alt+Hochkomma) schaltet zwischen dem schmalen und dem breiten 
Filter des Transceivers hin und her. Welche Filter genommen werden sollen, 
können Sie im Menü der Bandskala auswählen. 
Hinweis DM3ML : Codeunterschiede beim Hochkomma zwischen englischer 
und deutscher Tastatur ausprobieren. 

• Taste Pause:  schaltet zwischen den Transceivern hin und her und ordnet sie 
der Tastatur zu 

• Update timestamp qso: Zeitkorrektur im Log durch Eingabe der Zeit in das 
Rufzeichenfeld beginnend mit einem T gefolgt von 4 Ziffern 

• Sie bekommen eine Warnung, wenn Sie an der Abstimmung drehen, bevor 
das QSO im Logeingabefenster geloggt worden ist. 

• Exchange field validation: Überprüfung der Eingabefelder

CQ Zone Nur Ziffern gestattet, dazu tab, space, backspace 
Section Nur Buchstaben und Ziffern gestattet
Exchange Nur Buchstaben und Ziffern gestattet
Grid Nur Buchstaben und Ziffern gestattet
Power Nur Buchstaben und Ziffern gestattet

• K1TTT's-Rufzeichenüberprüfung installiert: Überprüfung auf ein korrektes 
Rufzeichen. Warnung im Prüffenster (Check window), falls ein Fehler 
angenommen werden kann. Verwendet werden die Regeln aus der Datei 
CALLSIGN.PAT. Die Regeln betreffen nur Rufzeichen auf HF (ohne WARC) 
und nur CW and SSB. Weitere Einzelheiten finden Sie im Kapitel 
Rufzeichenprüfung (Call Checking  )  .   

• Wenn Sie SH/DX in das Rufzeichenfeld eingeben, wird es an das DXCluster-
Programm weitergeleitet. 

• Show windows when radio frequency changed: Mit dieser Funktion wird 
das N1MMLogger-Programm bei einem Frequenzwechsel wieder in den 
Vordergrund geholt, wenn Sie unterdessen andere Programme wie einen 
Internet-Explorer u.ä. laufen gelassen haben, wenn 

o Ein Transceiver angeschlossen ist 
o N1MMLogger nicht vorher minimiert worden ist 
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Diese Funktion ist voreingestellt und immer aktiv. 

9. Funktionstasten (Function Keys)

9.1. Überblick (General)

Im Logeingabefenster finden Sie 12 programmierbare Tasten. Sie entsprechen den 
12 F-Tasten auf der Tastatur (F1-F12). Die Tasten sind doppelt belegt. Der erste 
Satz mit 12 Tasten ist dem RUN-Modus zugeordnet, der zweite Satz ist dem S&P-
Modus zugeordnet. Es ergeben sich insgesamt 24 Tasten. Bei den im S&P-Modus 
nicht belegten Tasten wird die Einstellung vom RUN-Modus gesendet.

Mit dem Menüpunkt Configurer > Configure Ports > Others > Functions Keys 
können Sie einzelnen F-Tasten eine andere Funktion zuweisen (remapped keys).

Die Funktionen werden nacheinander ausgeführt, d.h. die Texte von in Folge 
gedrückten F-Tasten werden nacheinander gesendet (CW & SSB).

Wenn Sie den Mauscursor auf eine der Tasten setzen, wird der gesendete Text 
angezeigt.

9.2. RUN-Modus und S&P-Modus

In den Tasten erscheinen die zu dem gewählten Modus gehörenden Titeln, die bei 
der Konfiguration eingetragen wurden. Die Anzeige kann durch das Drücken der 
Shifttaste vertauscht werden. Aus den Titeln des RUN-Modus werden dann die Titel 
des S&P-Modus und umgekehrt. 

Der RUN-Modus wird eingeschaltet, wenn Sie auf die CQ-Frequenz abstimmen oder 
einen CQ-Ruf starten (Taste F1). Es gibt jeweils eine CQ-Frequenz per Band. Die 
Umschaltung der VFOs hat je nach Vorgeschichte auch das Umschalten vom S&P-
Modus in den RUN-Modus oder umgekehrt zufolge. 

Wenn Sie die VFO-Frequenz weg von der CQ-Frequenz verstimmen, wird 
N1MMLogger automatisch in den S&P-Modus geschaltet. Wenn Sie den VFO zurück 
auf die CQ-Frequenz einstellen, kommen Sie wieder in den RUN-Modus. Auch ein 
Klick in der Bandskala führt zurück in den RUN-Modus. In der grünen LED links wird 
Ru angezeigt. Eine Ausnahme ist der Splitbetrieb, wenn Sie mit einem VFO senden 
und mit dem anderen empfangen. Hier findet keine Modus-Umschaltung statt.

Voreingestellte F-Tasten 
F1 CQ F5 Call der Gegenstation F9 frei- 
F2 Kontrollnummer F6 QSO B4 F10 frei 
F3 Ende des QSOs F7 frei F11 frei 
F4 Eigenes Call F8 Wiederholen (Agn) F12 frei

Die oben angezeigten Funktionstasten sind voreingestellt und werden vor allem im 
ESM-Modus in dieser Einstellung benötigt. Mit dem „Remapping“ lassen sich im 
Configurer andere Tasten diesen Funktionen zuweisen. 
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Programmieren Sie mindestens die 12 Tasten für den RUN-Modus und anschließend 
die benötigten Tasten für den S&P-Modus. Für den S&P-Modus müssen Sie nicht 
alle 12 Tasten programmieren. Für nicht programmierte Tasten im S&P-Modus wird 
die Programmierung des RUN-Modus übernommen. Sie können mit gedrückter Shift-
Taste den Modus vertauschen. Die Belegung der F-Tasten ist aus dem populären 
CT-Programm aus DOS-Zeiten übernommen. 

Welcher Text in den F-Tasten angezeigt und gesendet wird, hängt vom aktuellen 
Modus ab. Beachten Sie die Anzeige, ob Sie im RUN- oder im S&P-Modus sind.

Wenn Sie im S&P-Modus sind, kommen Sie mit der Taste F1 (CQ) automatisch in 
den RUN-Modus. Wenn Sie diese Umschaltung nicht wollen, müssen Sie unter S&P 
im Text der Taste F1 das Macro {S&P}  einbauen.

Beachten Sie, dass Sie alle 12 RUN-Tasten programmieren müssen, wenn die S&P-
Tasten an der richtigen Stelle erscheinen sollen. Bei den S&P-Tasten brauchen Sie 
nur so weit Einträge machen, wie ein getrennter Text gegenüber dem RUN-Modus 
benötigt wird. Sie können z.B. 12 RUN-Tasten und 3 S&P-Tasten konfigurieren. Im 
S&P-Modus senden dann die Tasten F4..F12 den gleichen Text wie die RUN-Tasten.
 
Alt + F11: Mit dieser Taste können Sie das automatische Umschalten vom RUN in 
den S&P sperren. Normalerweise sind Sie auf der CQ-Frequenz im RUN-Modus. 
Wenn Sie den VFO verstellen, kommen Sie automatisch in den S&P-Modus. Mit der 
Taste ALT+F11 bleiben Sie im RUN-Modus oder im S&P-Modus unabhängig davon, 
was Sie am VFO einstellen. Für Dxpedtionen ist dieses Verhalten sinnvoll. In der 
Statusleiste sehen Sie die Anzeige Run/S&P autotoggle disabled (oder enabled)

10. Andere Tasten (Other Keys)
Taste Funktion Aktion 

Insert Rufzeichen der 
Gegenstation+Kontrollnummer Sendet Taste F5+F2 

; Rufzeichen der 
Gegenstation+Kontrollnummer Sendet Taste F5+F2

Alt+Enter Sendet QSO-Ende (F3) und loggt 
das QSO 

. Ende des QSOs (F3) Sendet QSO-Ende (F3) und loggt 
das QSO

Ctrl+Alt+Enter N/A

Loggt ein normalerweise ungültiges 
QSO und fragt nach einem 
Kommentar. Wird kein Kommentar 
eingegeben, wird der Text Forced 
QSO als Kommentar eingegeben. 
Die Empfangsfrequenz wird auf die 
Sendefrequenz gesetzt. Sie können 
sich mit View>Notes das QSO 
später ansehen und korrigieren

Hinweis: Die Tasten ; and ' wurden dem Programm später hinzugefügt, um die 
Eingabe zu erleichtern. Die Tasten liegen auch auf unterschiedlichen Tastaturen 
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etwa an der gleichen Stelle. Den Zeichen können im Configurer unter Function keys 
andere Tasten zugewiesen werden. 

11. Dateimenü (File Menu Selections)
 Hinweis 

Die Datenbanken bei N1MMLogger sind einfache Access 2000-Datenbanken mit der 
Erweiterung *.mdb. In jeder Datenbank werden null, ein oder mehrere Contestlogs 
gespeichert. Jeweils nur ein Log kann zu gegebener Zeit angesehen oder editiert 
werden. 

• New log in database:  Erzeugt ein neues Contestlog in der aktuellen 
Datenbank 

• Open log in database: Ein bereits existierendes Log wird in der aktuellen 
Datenbank geöffnet. 

• New Database:  Eine neue Datenbank wird eingerichtet. Wählen Sie einen 
sinnvollen Namen für den vorgegebenen Namen new.mdb. Ab sofort wird 
diese neue Datenbank mit dem Programmstart geöffnet. Wenn Sie mit Open 
Datebase eine vorhandene Datenbank öffnen, wird diese Datenbank beim 
nächsten Programmstart geöffnet. Viele Conteste können in einer Datenbank 
gespeichert werden. Wir empfehlen Ihnen, beim Laden einer neuen 
Programmversion auch eine neue Datenbank zu eröffnen. Sie sollten öfter 
eine Datensicherung durchführen und speziell die Datenbanken mit ihren 
QSOs gut aufheben.

• Open Database:  Öffnet eine existierende Datenbank 

 Warnung 

In einer Datenbank werden auch die Stationsinformation, die DXCluster, die 
Funktionstasten u.ä. gespeichert. Wird eine neue Datenbank eingerichtet, werden 
diese Daten in die neue Datenbank von der aktiven bisherigen Datenbank kopiert. 
Änderungen werden in der jeweils aktiven Datenbank gespeichert. Prüfen Sie daher, 
ob beim Öffnen einer älteren Datenbank die dort eingestellten Werte noch gültig sind. 
Sie können die Aktualisierung auch mit der Import/Export-Funktion der 
DXClustertasten und der F-Tasten vornehmen, die extra gespeichert werden können.

• Copy (and Compact) Database:  Kopiert die Datenbank in eine neue 
Datenbank und komprimiert die Einträge. Ändern Sie den Name von new.mdb 
in einen Namen Ihrer Wahl. Mit der Komprimierfunktion können Sie gelöschte 
Conteste endgültig aus einer Datenbank entfernen. Die originale Datenbank 
wird dabei nicht geändert und wie bisher beim Programmstart gestartet. Wenn 
Sie auf die neue Datenbank umschalten wollen, verwenden Sie den 
Menüpunkt Open Database.  

• Copy This Contest to Another Database: Der Contest und seine 
Einstellungen werden in die andere Datenbank kopiert. Existiert diese 
Datenbank noch nicht, müssen Sie eine Datenbank mit New Database 
erzeugen und dann erst kopieren. 
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• Repairing a corrupted database (Internet): Reparatur einer beschädigten 
Datenbank: Das ist ein Link zu einer Microsoft-Internetseite, die erklärt, wie 
eine beschädigte Datenbank repariert werden kann. Sie können von dort das 
Programm Jetcomp.exe abholen. Dieses Programm ist auch auf der N1MM-
Internetseite unter 'Other files' zu finden. 

• Import 
o Import ADIF from file... : Lädt eine ADIF-Datei in die aktuelle 

Datenbank. Die Contest-Identifikation muss mit dem aktuellen Contest 
übereinstimmen, sonst ist ein Import nicht möglich. Sehen Sie bei 
Problemen bei den FAQs auf der N1MM-Homepage nach. 

o Import Call History...: Wenn Sie viele Contest mitmachen, haben Sie 
sicher viele der Stationen gearbeitet und deren Information empfangen. 
Das kann der Lokator, der Name oder die Zone sein. Für verschiedene 
Conteste gibt es Daten zu den Rufzeichen. Informieren Sie sich in den 
Kapiteln Vor dem Contest (Before the Contest) und UKW-Contest (VHF 
and Up Contesting)  zu der Rufzeichengeschichte.
Achtung: Beim Import einer Rufzeichentabelle wird die vorhandene 
Liste überschrieben. Wenn Sie den alten Bestand aufheben wollen, 
dann exportieren Sie erst die vorhandene, bevor Sie eine neue Liste 
importieren,. 

o Import State and Province abbreviations...:  Mit diesem Menüpunkt 
können Sie Staats- und Provinzabkürzungen, die in vielen Contesten 
und QSO-Parties verwendet werden, importieren. Der Import ist nur 
nötig, wenn Änderungen in der Datei StatesAndProvinces.sec 
vorgenommen worden oder Sie mit der internen Hilfe Cal lAreas 
Staats- oder Provinznamen geändert haben. Machen Sie nach einer 
Änderung mit dem Menüpunkt Rescore eine Neuberechnung der 
Punktzahl in Ihrem Log.  
 

o Import Packet/Telnet Buttons from file...: Sie können die 
Einstellungen aller Tasten der DXCluster-Seite (Packet/Telnet) in einer 
Datei mit der Endung  *.mc abspeichern und diese Datei mit diesem 
Menüpunkt wieder importieren, wenn Sie z.B. den Standort oder den 
Rechner gewechselt haben.
 

o Import Telnet Clusters...:  Mit diesem Menüpunkt können Sie eine 
früher abgespeicherte Liste der DXCluster und ihrer Daten im Format 
*.txt wieder importieren. Die Datei enthält den DXClusternamen und 
seine Adresse getrennt durch ein Komma, z.B.
- GB7UJS,gb7ujs.shacknet.nu:7373 oder
-  K1TTT.NET,K1TTT.NET 

o Import Function Keys to file: Mit diesem Menüpunkt können Sie eine 
früher abgespeicherte Datei mit der Programmierung der F-Taste 
(*.mc) getrennt nach der Tastenart wieder importieren. Sie können 
diese Dateien mit einem Texteditor bearbeiten. Diese Möglichkeiten 
haben Sie: 

 SSB Function Keys... 
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 CW Function Keys... 
 Digital Function Keys... 

o Recover QSOs from a Transaction Log...: Log von einem 
Transaction-Log wieder herstellen. Ein Transaction-Log wird erzeugt, 
wenn Sie auf der Karteikarte Other im Configurer die Option 'Keep log 
of all QSOs to facilitate recovery of log' aktiviert haben. Informieren 
Sie sich im Kapitel Configurer. 

• Export 

 Tipp
 
Unter "Save File" wird Ihnen der Name callsign.txt vorgeschlagen. Wählen Sie hier 
einen Namen mit Ihrem Rufzeichen, z.B. bei N1MM/P den Namen "N1MM_P.txt". 
Einen Schrägstrich versteht Windows in Dateinamen nicht. 

o Export ADIF to file 
 Export ADIF to file...: Gibt das Contestlog als ADIF-Datei aus. 

Sie können es damit zu anderen Contestprogrammen 
übertragen. Gelöschte QSOs (Deleted QSOs) werden nicht 
exportiert. Sie können Sie mit 'DELETEDQS' exportieren. 

 Export ADIF to file by date...: Exportiert die Contest-QSOs in 
zeitlicher Reihenfolge z.B. für die Diplomarbeit. Es kann ein 
Startdatum vorgegeben werden, sonst wird der 1900-01-01 
(yyyy-mm-dd) als Startdatum genommen.  Exportiert wird nur der 
aktuelle Contest.

 

o Export ADIF to file by date from ALL contests...: Exportiert alle 
QSOs aus allen Contesten in zeitlicher Reihenfolge, wenn der aktuelle 
Contest vom Typ DX ist. 
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 Export ADIF to file by Multi-User Station Number: Erzeugt 
eine ADIF-Datei aller QSOs einer Station einer Multi-User-
Gruppe, wenn Sie DX loggen. Es muss eine Stationsnummer 
angegeben werden. 

o Export Cabrillo to file...: Erzeugt ein Cabrillo-Log, um das Contestlog 
abschicken zu können. Im Kopf des Cabrillo-Logs stehen die 
Stationsdaten entsprechend der Einstellung unter 'Config | Change 
Your Station Data’ und die Contesteinstellungen unter File > Open 
Log in Database. Ebenfalls stimmen muss die Operator Category wie 
Multi-Two, wo getrennte Kontrollnummernsätze erzeugt werden und die 
Stationsnummern bei Multi-Multi-Stationen.
 

o Export to File (Generic) 
 Export to File (Generic), order by QSO Time (normal)... – 

Erzeugt eine generische Datei unter dem Namen callsign.txt 
vom Contestlog in zeitlicher Reihenfolge geordnet nach der Zeit. 
In manchen Fällen lässt es sich als Contestlog verwenden. Das 
Log kann in Exceldateien oder in Logprogramme ohne ADIF-
Import eingelesen werden. Es lässt sich mit einem Texteditor 
lesen und bearbeiten. 

 Export to File (Generic), order by Band... Erzeugt eine 
generische Datei unter dem Namen callsign.txt vom Contestlog 
in geordnet nach Bändern und innerhalb der Bänder in zeitlicher 
Reihenfolge. In einigen Fällen wird so ein Log vom 
Contestmanager  bei UKW-Contest angenommen. 

o Export EDI to file by band... : Erzeugt für europäische UKW-Conteste 
eine EDI-Datei. Für jedes Band wird ein getrennte Datei erzeugt. 

o Print Score Summary to File...: Druckt eine Summendatei der 
Contestpunkte unter dem Namen Callsign.SUM, z.B. N1MM.SUM. Die 
Datei kann mit einem Texteditor bearbeitet werden. 

o Export Call History...:  Exportiert die Call History-Tabelle. Diese 
Tabelle kann nur mit der Option Import Call History gefüllt werden.

o Export Packet/Telnet Buttons to file...: Exportiert die Packet/Telnet –
Tasten in die eine Datei *.mc (Import siehe oben). 

o Export Telnet Clusters...: Exportiert die Daten der DXCluster in eine 
Datei mit dem Namen *.txt. Die Datei kann aufgehoben und mit der 
Importoption (s.o.) wieder eingelesen werden. Der voreingestellte 
Name ist 'Clusters.txt'. 

o Export Function Keys to file: Exportiert die programmierten F-Tasten 
getrennt nach CW, SSB und Digimodes in eine Datei mit der Endung 
*.mc. Sie können sich auf diese Weise für jeden Contest einen Satz mit 
Tastenbelegungen abspeichern und mit der Importoption (s.o.) wieder 
laden. Die Dateien können mit einem Texteditor bearbeitet werden. Der 
Tastennamen darf nicht länger als 9 Zeichen sein, der Text pro Taste 
darf 70 Zeichen nicht überschreiten. Sie können diese Dateien 
erzeugen:

 SSB Function Keys... 
 CW Function Keys...  
 Digital Function Keys... 
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• Recently used contests/databases : Liste der zuletzt benutzten Conteste und 
Datenbanken. Die Liste hat maximal neun Einträge.  

• Exit Alt+F4: Mit dieser Tastenkombination bzw. Menüpunkt wird das 
Programm beendet. Sie werden gefragt, ob das Ihr Ernst ist: 

 

12. Edit-Menü (Editieren) (Edit Menu Selections)

• Wipe Out Entry Fields Ctrl+W : Ctrl+W löscht das Logeingabefenster wie 
Alt+W

• Edit Last Contact Ctrl+Y : Editiert das letzte QSO, alle Felder können 
geändert werden 

• Add a Note to Last/Current Contact Ctrl+N : Zum letzten geloggten QSO 
oder zu dem QSO im Eingabefenster kann ein Kommentar abgespeichert 
werden 

• Edit Current Contact : Öffnet einen Dialog, mit dem alle Felder des aktuellen 
QSOs editiert werden können. Den gleichen Effekt erzielen Sie mit einem 
Doppelklick in das Logeingabefenster. 

• Quick Edit Previous Contacts (Back) Ctrl+Q und Ctrl+A: Schnelledition 
früherer QSOs. Mit Ctrl+Q springen Sie ein QSO zurück, mit Ctrl+A ein QSO 
vorwärts. Das Logeingabefenster wird blau hinterlegt angezeigt. Zur 
Übernahme der Änderung benutzen Sie die Save-Taste im Editierfenster, zum 
Abbrechen die ESC-Taste auf der Tastatur. 

• Increase Received NR by 1 Ctrl+U:  Erhöhen der empfangenen 
Kontrollnummer um Eins. Nehmen Sie diese Taste, wenn Sie in einem Pileup 
warten, bis Sie endlich dran sind... 

• Find/Find Again Ctrl+F:  Suchen nach einem Rufzeichen, das im 
Logeingabefenster steht, im Log. Mit weiteren Ctrl+F können Sie weitere 
QSOs suchen. 

13. View-Menü (Anzeige) (View Menu Selections)

• Max Rates: Zeigt die höchsten QSO-Raten je Minute, je 10 Minuten und je 60 
Minuten innerhalb eines Contest an. Diese Ergebnisse werden in einer 
Textdatei oder nach einem Rechtsklick in der Windows-Zwischenablage 
gespeichert (Copy text to Clipboard). 

• Off Times : Zeigt die Pausen an, jeweils mit Beginn und Ende und die Anzahl 
der Minuten. Auch die Gesamtzeit in Minuten, Stunden und Tagen wird 
angezeigt und einem Operator zugeordnet. Auch die Zeit zwischen 
Contestbeginn und erstem QSO wird als Pause gewertet. Eine Warnung wird 
ausgegeben, wenn QSOs vor dem Contest gefunden wurden. Diese 
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Ergebnisse werden in einer Textdatei oder nach einem Rechtsklick in der 
Windows-Zwischenablage gespeichert (Copy text to Clipboard).  

• Runs: Zeigt  alle Runs. Das sind die Zeiten zwischen den Bandwechseln 
einschließlich der Pausen. Diese Ergebnisse werden in einer Textdatei oder 
nach einem Rechtsklick in der Windows-Zwischenablage gespeichert (Copy 
text to Clipboard).  

• Suspect Calls: Zeigt verdächtige Rufzeichen nach den Kriterien des K1TTT-
Rufzeichentests. Die Ergebnisse werden in einem Fenster angezeigt. Diese 
Ergebnisse werden in einer Textdatei oder nach einem Rechtsklick in der 
Windows-Zwischenablage gespeichert (Copy text to Clipboard):
  

•  

• Suspect Zones: Verdächtige Zonen werden angezeigt. Zonen in den USA 
und in Canada werden nicht erfasst. Die erste Angabe ist die Zone vom 
Contest, die zweite von der Länderdatei cty.dat file loaded. Die Ausgabe 
erfolgt in einem Fenster. Diese Ergebnisse werden in einer Textdatei oder 
nach einem Rechtsklick in der Windows-Zwischenablage gespeichert (Copy 
text to Clipboard).  

 

• Varying Zones : Geänderte Zone. Die erste Zone stammt vom aktuellen 
Contest, die zweite von einem anderen Contest in einer bestehenden 
Datenbank. Der Inhalt kann als Textdatei mit einem Klick auf die Taste Save 
gespeichert werden. 
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• Passed QSOs : Zahl der weitergegebenen QSOs per Operator, angezeigt 
wird das Band, die Zahl der QSOs und die Multis. 

• Cross Check Exchanges: Überprüfung möglicher Fehler der 
Kontrollnummern und Lokatoren. WWLokatoren bei QSOs über mehr als 
700km. Werkzeug zum Finden von Tippfehlern. 

• Unique calls not in Master.dt: Erzeugt eine Liste von einmal auftretenden 
Rufzeichen, die nicht in der Datei master.dta des N1MMLoggers stehen: 

 

• Notes : Öffnet ein Fenster, in dem alle während eines Contests eingegebenen 
Notizen zu einzelnen QSOs angezeigt werden. Die Notizen helfen bei der 
Contestauswertung in Zweifelsfällen. Sie können den Inhalt in einer Text-Datei 
(*.txt) mit einem Klick auf die Save-Taste speichern oder mit einem 
Rechtsklick in die Zwischenablage zur Weiterverarbeitung schicken. 

• Statistics : Zeigt die Statistik für den angewählten Contest. Mehrere 
Auswahlmöglichkeiten werden angeboten. Informieren Sie sich im Kapitel 
Statistik. Sehen Sie während des Contest nach der Statistik und eine Station 
ruft sie, können Sie ruhig anfangen das Rufzeichen einzutippen. Die Zeichen 
gehen ins das Logeingabefenster und die Statistik wird in den Hintergrund 
geschoben.  

 Hinweis
 
Alle Show-Anforderungen können nur bedient werden, wenn eine gültige 
Rufzeicheninformation im Rufzeichenfeld oder darüber vorhanden ist (= aktuelles 
Rufzeichen). 

• Show Last 10 Spots:  Die letzen 10 DXSpots für das Rufzeichen im 
Rufzeichenfeld oder - wenn es leer ist -  für das Rufzeichen oberhalb davon 
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werden angezeigt. Die Abfrage wird an verbundenen DXCluster geschickt. 
Voraussetzung ist eine aktive Verbindung zu einem DXCluster.

• Show Buck/Packet:  Die Buckmaster-Information für das aktuelle Rufzeichen 
wird vom angeschlossenen DXCluster abgerufen. Voraussetzung ist eine 
aktive Verbindung zu einem DXCluster.

• Show Station:  Die Stationsinformation für das aktuelle Rufzeichen wird vom 
angeschlossenen DXCluster abgerufen. Voraussetzung ist eine aktive 
Verbindung zu einem DXCluster.

• Show QSL/Packet:  Die QSL-Information für das aktuelle Rufzeichen wird 
vom angeschlossenen DXCluster abgerufen. Voraussetzung ist eine aktive 
Verbindung zu einem DXCluster.

• Show Sunrise/Sunset:  Die Information zu Sonnenauf-/untergang für das 
aktuelle Rufzeichen wird vom DXCluster abgerufen. Die Information wird auch 
im Info-Fenster angezeigt. Voraussetzung ist eine aktive Verbindung zu einem 
DXCluster.

• SH/DX Current Call or Spot: Die DX-Information zum aktuellen Rufzeichen 
wird vom DXCluster abgerufen. Voraussetzung ist eine aktive Verbindung zu 
einem DXCluster.

• Show QRZ (Internet):  - QRZ.com wird über Ihren Internetbrowser für das 
aktuelle Rufzeichen aufgerufen. Voraussetzung ist ein aktiver Internetzugang.

• Show Google (Internet):  Über Ihren Internetbrowser wird bei Google nach 
dem aktuellen Rufzeichen nachgesehen. Voraussetzung ist ein aktiver 
Internetzugang

• Show Buck (Local):  Auf der Buckmaster -CD in Ihrem PC wird nach dem 
aktuellen Rufzeichen nachgesehen. Voraussetzung ist die zugehörige 
Installation.  

• Set Font:  Ändert den Zeichentyp im Logeingabefenster. Wenn Sie Arial 
wählen, bleibt das Rufzeichen über dem Rufzeichenfeld in MS Sans Serif. Ein 
netter Zeichentyp ist Monaco. 

14. Tools-Menü (Werkzeuge) (Tools Menu Selections)

• Rescore Current Contest:  Berechnet den aktuellen Contest neu. Sollte 
gemacht werden, wenn die Datei CTY.DAT im Nachhinein geändert wurde 
oder wenn QSOs editiert, hinzugefügt oder gestrichen wurden. Kann zu jeder 
Zeit auch während des Contest gemacht werden. Es läuft aber relativ 
langsam. 

• Rescore last N Hours: Berechne die letzten N Stunden neu. Läuft relativ 
langsam. 

• Download Latest Check Partial file (Master.DTA)(Internet): Öffnet Ihren 
Internetbrowser um die neueste Datei Master.dta abzuholen. Der Link stellt 
eine Verbindung zu Seite Super Check Partial her. Wählen Sie die 
gewünschte Datei auf der Karteikarte Associated Files im Dialog unter 'File  
> Open Log in Database'  und speichern Sie sie in das N1MMLogger-
Verzeichnis. Die Datei wird zu Rufzeichenprüfung im Check-Fenster nach 
Eingabe von mindestens zwei Zeichen eines Rufzeichens in das 
Rufzeichenfeld verwendet. 

• Tune (CW mode) Ctrl+T : Schaltet Ihren Transceiver in den CW-Modus, 
aktiviert die PTT und drückt zum Abstimmen die Taste. Beenden Sie das 
Abstimmen mit der ESC-Taste oder einem erneuten Ctrl+T. Der Transceiver 
wird auf die vorher eingestellte Sendeart zurückgesetzt.
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•  Download latest country file (wl_cty.dat)(Internet):  Öffnet Ihren 
Internetbrowser und stellt eine  Verbindung zur Seite http://www.country-
files.com/cty/ her, von der Sie neueste DXCC-Länderdatei wl_cty.dat abholen 
können. Anschließend müssen Sie diese Datei mit dem Werkzeug 'Tools > 
Import country list from downloaded file' in N1MMLogger einlesen. 

• Import country list from downloaded file: Siehe vorhergehender 
Menüpunkt. Prüfen Sie die Aktualität Ihrer Länderdatenbank mit der Abfrage 
bei Help > About N1MM logger. Das Datum der letzten cty.dat steht ganz 
unten in der Liste.  

 Hinweis
 
Holen Sie sich am besten vor jedem Contest die neueste Datei  WL_CTY.DAT aus 
dem Internet. 

• Add call to country:  Treffen Sie während des Contests auf ein 
Sonderrufzeichen, das durch die Datei cty.dat nicht einwandfrei einem 
bestimmten Land zugeordnet wird, wählen Sie diesen Menüpunkt und ordnen 
Sie das Rufzeichen einem bestimmten Land über den Prefix zu. Die Änderung 
gilt so lange, bis sie eine neue cty.dat-Datei laden. Meist ist das 
Sonderrufzeichen dort aber schon eingearbeitet. Nach der Zuweisung 
berechnet das Programm den Multi und die Antennenrichtung richtig.

• Tune to beacon for this band: Mit diesem Werkzeug wird Ihr Transceiver auf 
die Bakenfrequenz der NCDXF-Bake abgestimmt und auf CW geschaltet. In 
der Statuszeile des Logeingabefensters wird die aktuelle aktive Bake, ihre 
Leistungsstufe und die Antennenrichtung für SP und LP angezeigt. Siehe 
auch  http://www.ncdxf.org/Beacon/BeaconSchedule.html 

• Update Call History with Current Log:  Aktualisiert die Datei call history mit 
den QSOs des aktuellen Contests. Es werden sowohl Kontakte hinzugefügt 
als auch die Daten vorhandener Rufzeichen aktualisiert. Bei den 
WWLokatoren wird falls ein neuer dritter Lokator bekannt wird, der bisherige 
zweite überschrieben. Ist nur ein 4-stelliger Lokator eingetragen und der neue 
ist 6-stellig, wird der 6-stellige übernommen.  

• Turn Rotor Alt+J : Dreht den Rotor auf die zu dem Rufzeichen im 
Rufzeichenfeld gehörende Richtung. Ist dieses Feld leer, aber es steht ein 
Rufzeichen im Rahmen darüber, wird die Antenne zu diesem Rufzeichen 
gedreht. In der Statuszeile steht die gewünschte SP-Antennenrichtung.  Mit 
Alt+L wird die Antenne auf die LP-Richtung gedreht.

• Stop Rotor Ctrl+Alt+J:  Hält den Rotor an 
• Packet Window Tools:  Öffnet das Menü für das Packet-Fenster aus dem 

Logeingabefenster heraus. Das Packet-Fenster muss dabei nicht geöffnet 
sein.

• Program Execution Logging (nur bei der Fehlersuche) 
o Exportiert alle Schritte in die Spurendatei (Trace) *.trc. Schicken Sie 

diese Datei bei schwereren Programmproblemen wie großen 
Verzögerungen an die Programmierer zur Fehlersuche. 

 Gesperrt (Disable) 
 Alles (All) 
 Nur ein Eintrag pro Programm/Fenster/Dialog  
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• Save Window Positions: Abspeichern der Fensterpositionen in der INI-Datei. 
o Die Fensterpositionen werden automatisch bei einem fehlerfreien 

Programmende abgespeichert. 
o Die Fensterpositionen können für jeden Operator abgespeichert 

werden. Wählen Sie mit Ctrl+O den Operatoreintrag und drücken Sie 
dann auf  'Save Window Positions'. 

• Restore Window Positions:  Wiederherstellen der Fensterpositionen aus der 
INI-Datei mit der zuletzt abgelegten Konfiguration. 

o Sind die Fensterpositionen per OP abgespeichert und Sie kommen neu 
an den Rechner dann tragen Sie mit Ctrl+O Ihr Rufzeichen ein und 
klicken Sie dann auf 'Restore Window Positions'. So kann im Multi-
OP-Betrieb jeder OP seine individuelle Konfiguration abrufen.  

 Hinweis
 
Informationen zum Rotor finden Sie im Kapitel Rotorsteuerung  

15. Konfigurations-Menü (Config Menu Selections)

• Configure Ports, Telnet Address, Others:  Kurz als 'Configurer' 
bezeichnet. Hier stellen Sie alle Schnittstellen und das Programmverhalten 
ein. 

• Change Your Station Data:  Einstellung der Daten der eigenen Station, 
Rufzeichen, Adresse und QTH-Koordinaten. Unbedingt unmittelbar nach dem 
ersten Start sorgfältig einstellen! 

• Change Sub Bands: Einstellung der Bandgrenzen für die Sendearten. Die 
Sub-Bandgrenzen werden in den Bandskalen lila markiert. Wenn Sie ein 
anderes Subband anklicken, wird auch die Sendeart gewechselt, wenn Sie 
den Menüpunkt 'Config > Configure Ports, Telnet Address, Others > 
Karteikarte Mode Control > Follow band plan (default’ aktiviert haben. Der 
Bandplan wird wie folgt abgefragt: Digital? Falls nein, CW? Falls nein, dann 
CW. Hinweis DM3ML: Sollte sich im Contestgetümmel eine bestimmte 
Sendeart weiter ausbreiten, korrigieren Sie für diesen Contest das Subband. 

Hinweis: Voreingestellt ist der Bandplan der Region 2 (USA/Canada). Als Europäer 
müssen Sie den Bandplan korrigieren, speziell für das 40m-Band. 

o CW Sub Bands: Siehe Beispiel. Hier ist der CW-Bereich auf 7000 bis 
7035 kHz für Europa eingestellt. Darüber wird automatisch SSB 
gewählt, falls keine anderen Subbänder eingestellt wurden.  

o SSB Sub Bands: Subband für SSB, voreingestellt, falls kein CW-
Subband 

o Digital Sub Bands: Subband für die Digimodes 
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• Clear INI file settings:  Löscht die Datei N1MM logger.ini . Alle Einstellungen 
gehen verloren und müssen neu gemacht werden. Nur bei Configurer-
Problemen verwenden. 

• Find all windows (move to within 800 *600):  Alle Fenster werden auf einen 
Schirm mit den Abmessungen 800 x 600 geholt. Werkzeug, wenn Fenster 
verloren gegangen sind, von höherer auf niedrigere Auflösung oder von 2 
Monitoren auf einen Monitor umgeschaltet wurde. 

• Enter Sends Messages (ESM mode) Ctrl+M:  Aktiviert den ESM-Modus. Alle 
Ausgaben werden anhand einer Zustandtabelle mit ENTER abgerufen. 
Sorgfältig vorbereiten und testen!  

• AutoSend Threshold Ctrl+Shift+M:  Start der Sendung nach der Eingabe 
einer bestimmten Anzahl von Zeichen eines Rufzeichens nach einer Ziffer, Die 
untere Schwelle liegt bei einem Buchstaben. Funktioniert nur im RUN-Modus. 
Siehe Kapitel Erweiterte Funktionen. 

• Spot all S&P QSOs:  Schickt alle S&P-QSOs an den DXCluster, soweit sie 
noch nicht in der eigenen Bandskala stehen. Wird jedes Mal abgeschaltet, 
wenn das Programm beendet wird (DM3ML: ..und sollte gar nicht 
eingeschaltet werden).  

• QSYing wipes the call & spots QSO in bandmap:  Ein Rufzeichen im 
Rufzeichenfeld wird bei einem QSY gelöscht und das Rufzeichen fett markiert 
in die Bandskala als lokaler DXSpot gesetzt. Sie können dieses Rufzeichen 
dann später wieder finden und zu arbeiten versuchen.  

• Do not run on CQ-frequency:  Wenn Sie QSY gemacht und zu der alten CQ-
Frequenz zurückgekehrt sind, wird hier RUN gesperrt und Sie bleiben im S&P-
Modus. Nützlich für Sprint-Conteste mit stetigem Frequenzwechsel.

• Show non-workable spots:  Zeigt auch im Contest nicht zu arbeitende 
Stationen, zweckmäßig beim S&P-Modus um diese Stationen zu übergehen.

• Reset Rx freq when running split:  Wenn Sie mit getrennten VFOs senden 
und empfangen (Split-Betrieb), wird mit dieser Funktion nach jedem RUN-
QSO der RX-VFO auf die Frequenz des TX-VFOs zurückgesetzt. Sie können 
dann im RUN-Modis den größeren Knopf der Hauptabstimmung anstelle des 
kleinen RIT-Knopfes verwenden. 

• Dual Rx always on: Nur bei  der Yaesu FT-1000-Serie und der Serie Icom 
IC-756, IC-781 ,IC-775 und IC-7800 : Hier können Sie den Zweitempfänger 
mit Alt+F12 ein- und ausschalten.

o Wenn angewählt - 
 Yaesu FT-1000-Serie: Der Sub-RX ist an (blinkende grüne RX-

LED) 
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 Icom IC-756-Serie, IC-781 ,IC-775 und IC-7800 only: Der Zweit-
RX wird nicht ausgeschaltet, wenn Sie mit dem Ctrl+Linkspfeil 
oder PAUSE von SUB auf Main schalten. 

o Wenn nicht angewählt: Der SUB-RX wird ausgeschaltet (RX-LED aus) 
• CQ Repeat Alt+R: Schaltet die automatische Wiederholung des CQ-Rufs ein 

und aus. Sie können den Ruf mit ESC stoppen. Bei einem Wechsel von RUN- 
zum S&P-Modus wird der CQ-Ruf automatisch abgeschaltet.  

• Set CQ repeat time Ctrl+R:  Einstellung der Wiederholzeit des automatischen 
CQ-Rufs in Millisekunden oder Sekunden. Voreingestellt sind 1,8 s. 

• Call History Lookup:  Mit dieser Funktion aktivieren Sie die Tabelle mit der 
Rufzeichengeschichte (Call History table). In der Tabelle können Daten wie 
Name,  GridSquare (WWLokator), Section, State, Age usw. enthalten sein. Sie 
können diese Daten nach jedem Contest abspeichern und für einen neuen 
verwenden. Sie benötigen dafür etwas Rechenzeit, da nach jeder 
Rufzeicheneingabe in dieser Tabelle nachgesehen wird. Die Tabelle wird mit 
der Funktion 'Import Call History' gefüllt werden. 

• Record QSOs:  Sie können die QSOs in CW oder SSB mitschneiden. Tragen 
Sie den Pfad für diese Datei unter 'Configurer' > Karteikarte Files ein. Mehr 
Informationen erhalten Sie im Kapitel Tipps und Tricks (Tips and Tricks). 

• Change Packet/CW/SSB/Digital Message Buttons Alt+K: Mit dieser 
Funktion können Sie die F-Tastensätze für Packet/CW/SSB/Digital editieren. 
Die Texte für die Tasten für Packet, CW, SSB und RTTY dürfen 255 Zeichen 
lang sein. Mit Alt+K kommen Sie direkt zu den CW/SSB/RTTY-Tasten 
abhängig von der aktuellen Sendeart. Verwenden Sie Ctrl+D um eine Zeile in 
der Tabelle zu löschen oder klicken Sie rechts in die Tabelle und wählen Sie 
aus dem Menü 

o Change CW Buttons: Ändert den Inhalt der CW-Tasten. Ein ‚&’ in der 
Tastenüberschrift erzeugt einen unterstrichenen Buchstaben, der als 
Kurzruf zusammen mit der ALT-Taste verwendet werden kann. Ist so 
ein Kurzruf bereits definiert z.B. in einem Menü, wird der jeweils erste 
genommen. Informieren Sie sich Kapitel Macros zu Einzelheiten.

o Change SSB Buttons - Ändert den Inhalt der SSB-Tasten. Weiter wie 
unter CW.

o Change Digital Buttons : Ändert den Inhalt der Digimode-Tasten 
Weiter wie unter CW. 

• Multi-User Mode:  Startet die Arbeit über ein Netz unter N1MMLogger (Multi-
PC-Arbeit) 

• Multi-User Tools:  Menü mit den Multinutzer-Werkzeugen (siehe Kapitel 
Multinutzer-Werkzeuge). 

• Edit Station Computer Names:  Edition der angeschlossenen Stationen 
nach Nummer und IP-Adresse im Multinutzer-Modus 

• Change Operator Ctrl+O:  Wechsel der Operator-Rufzeichens. Das 
Programm startet mit dem im Stationsdialog eingetragenen Rufzeichen. 
Geben Sie "OPON" in das Rufzeichenfeld ein und anschließend Ihr 
Rufzeichen. 

• Change Exchange Abbreviations: Ändert die voreingestellten Abkürzungen 
o Change ARRL Section Abbreviations:  Änderung in der Liste der 

gültigen ARRL-Sektionen 
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o Change QSO Party Abbreviations:  Änderungen in der Liste der 
QSO-Party-Abkürzungen 

• SO2R : Einstellungen zu SO2R > siehe Kapitel SO2R  
o Dueling CQ's Ctrl+B:  Schaltet das CQ von einem Transceiver auf den 

anderen um bis jemand anruft. Wird für CW und SSB unterstützt. Bei 
einem QSY von mehr als 200Hz wird es abgeschaltet. 

o Set Dueling CQ Repeat Time:  Einstellung der Wiederholzeit 
o Advanced SO2R Ctrl+Shift+I : Schaltet den Fokus bei 'Advanced 

SO2R' auf den sendenden Transceiver, wenn die Eingabe 
abgeschlossen wurde 

o Advanced SO2R Delay Time Ctrl+Shift+N:  Verzögerungszeit für 
Advanced SO2R. 

o Focus on Other Radio Ctrl+Shift+K: Steuert den Fokus auf das 
jeweilige Eingabefenster 

o Toggle CTRLFx Macro Ctrl+Shift+L: Dieses Makro erlaubt dem 
Nutzer auf einem anderen Transceiver zu senden (nur in CW) 

o TX Lockout: Sendersperre des Transceivers auf dem gleichen Band 
 Multi-TX:  Voreingestellt. Startet CQ auf Tcvr A, nächstes CQ 

auf Tcvr B. Beide sind aktiv. Keine Sperre. 
 First one wins:  Startet CQ auf Tcvr A, Pause, CQ auf Tcvr B. 

Solange TcvrA aktiv ist, wird Tcvr B ignoriert, auch wenn eine F-
Taste für ihn gedrückt wird. 

 Last one wins:  Startet CQ auf Tcvr A > Pause > CQ auf Tcvr B. 
Das CQ auf Tcvr A wird abgebrochen, sobald Sie eine F-Taste 
für Tcvr B drücken.. 

o Toggle SO2R Mode (Soundcard) Ctrl+I: schaltet die Soundkarte um

• WAE - Special commands for the WAE DX contest only 
(Spezialkommandos für den WAE): 

o Toggle WAE QTC mode Ctrl+Z:  Schaltet zwischen WAE- QTC-
Modus und QSO-Modus hin und her. Siehe Einzelheiten unter 'Setup 
Contests' for WAE 

o WAE Received QTC Confirmation: Bestätigung des QTC-Empfangs 

16. Fensteranzeige-Auswahl (Window Menu Selections)

• Available Mult's and Q's: Anzeige der bereitstehenden Multis und QSOs . 
Einzelheiten finden Sie im Kapitel Bereitstehende Multis und QSOs (Available 
Mult's and Q's-Fenster). 

• Bandmap Ctrl+B:  Zeigt die Bandskala an. Einzelheiten finden Sie im Kapitel 
Bandskalen (Bandmap Window) . 

• Check: Zeigt das Rufzeichenprüffenster an. Einzelheiten finden Sie im Kapitel 
Rufzeichenprüffenster (Check Partial Window). 

• CW Key Ctrl+K: Öffnet das Fenster zur direkten CW-Eingabe, Mit einem 
weiteren Ctrl+K oder ENTER wird das Fenster wieder geschlossen. Geben 
Sie den zu sendenden CW-Text in das Fenster ein. Mit einem ESC wird die 
Ausgabe abgebrochen.  
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• Digital Interface : Öffnet das Fenster für das digitale Interface 
(RTTY/MMTTY/PSK). Einzelheiten finden Sie im Kapitel Digitale Sendearten 
(Digital chapters). 

• Entry Window : Öffnet das Logeingabefenster 
• Gray Line : Öffnet eine Weltkarte mit der Anzeige der Dämmerungslinie (nur 

für Windows NT, 2000, XP oder jünger). Einzelheiten finden Sie im Kapitel 
zum  Grayline-Programm. 

• Info : Öffnet das Info-Fenster.
• Log Ctrl+L: Öffnet das Logeingabefenster, schaltet zwischen groß und 

minimiert hin und her.   
• Multipliers by Band : Öffnet die Anzeige “Multis je Band” (multipliers by 

band). 
• Packet: Öffnet das Packet/Telnet-Fenster 
• Score Reporting: Meldet die aktuelle Punktzahl an einen wählbaren Reflektor 

(Score Reporting). 
• Score Summary: Zeigt die aktuelle Punktzahl an (Score Summary Dialog) 
• Visual Dupesheet : Anzeige der Doppel-QSOs (Visual Dupesheet window). 

Mit Ctrl+Tab können Sie den Fokus zwischen Logeingabe- und Packet-Fenster 
umschalten. Sind andere Fenster mit einem Eingabefenster geöffnet, schaltet 
Ctrl+Tab im Kreis zwischen diesen Fenstern um.  

17. Hilfe-Menüs (Help Menu Selections)

• Help Alt+H: Öffnet die englische Version dieser Hilfe. Mit Alt+H öffnen Sie 
das Kapitel der englischen Hilfe zu dem Fenster, aus dem sie die Hilfe 
angefordert haben. Sie müssen die gesamte englische Hilfe getrennt von der 
N1MM-Homepage herunterladen und die Datei im N1MMLogger-Verzeichnis 
anspeichern. Die Windows-Hilfe und das Handbuch werden getrennt gepflegt, 
folgen der Programmentwicklung aber so nah wie möglich. Wenn Sie eine 
neue Programmversion laden, sollten Sie sich auch eine neue Version der 
Hilfe holen. Die jeweilige Version sehen Sie auf dem Titelblatt der Hilfe bzw. 
des Handbuchs.  

• Search Help using Google (Internet):  Öffnet Google und sucht nach Hilfe 
im Internet 

• Key Assignments Help:  Zeigt das Kapitel der Tastenzuordnung in der 
Hilfedatei. 

• Manual:  Zeigt die englische PDF-Version der Hilfe. Diese Hilfe kann 
ausgedruckt werden. Laden Sie die PDF-Datei getrennt von der Homepage 
und speichern Sie sie in dem N1MMLogger-Verzeichnis. Dort können Sie die 
Hilfe mit dem Acrobat Reader öffnen. Wenn Sie auf Help-> Manual klicken 
wird der Adobe Acrobat Reader geöffnet und das Handbuch geöffnet.

• Contest rules for this contest (Internet):  Sucht im Internet nach den 
Regeln des aktuellen Contests  

• ARRL Contest Calendar Page(Internet): Öffnet den ARRL-Contestkalender 
aus dem Internet 

• N1MM Logger Home Page(Internet):  Öffnet die N1MMLogger-Homepage 
aus dem Internet 
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• Download Help (English version) (Internet):  Holt die Hilfe von der 
N1MMLogger-Homepage 

• Yahoo Discussion Group (Internet): Öffnet die Yahoo Discussion Group 
zu N1MMLogger im Internet 

• Report Bugs/Request Features/Request Support(Internet):  Stellt die 
Verbindung zur N1MMLogger-Webseite zum Bericht über Programmfehler 
oder –Verbesserungen her 

• Email Problem Report(Internet): Sendet einen Problembericht per Email an 
Tom, N1MM. Im Report sollten ausführliche Angaben zum verwendeten PC, 
der Programmkonfiguration und des aufgetretenen Problems enthalten sein.  

• View Revision History (Internet): Zeigt die Entwicklungsgeschichte des 
Programms aus dem Internet 

• View Revision History (last downloaded): Zeigt die zuletzt abgeholte 
Entwicklungsgeschichte von der Festplatte. Hier wird keine Internetverbindung 
benötigt. 

• View Error Log: Anzeige der Fehlerdatei 'Errorlog.txt', die vom Programm 
erzeugt wurde. Die Fehlerdatei wird aktualisiert, wenn das Programm einen 
Fehler erzeugt. Die Datei kann zur Klärung der Fehlerursache herangezogen 
werden. 

• Report Score to 3830 (Internet): Geht zur Internetseite 3830, die die 
Ergebnisse der Conteststationen sammelt 

• About N1MM logger Vx.x.xxx : Zeigt den About Dialog. Sie sehen Tom’s, 
N1MM, Antennenmast mit einer Cushcraft X9 oben drauf! 

Last Modification: 07 October 2009 07:42:49 EDT by n4zr. 

Das Log (Log)

Ihr Log kann etwa so aussehen:  

 

• Im oberen Teil wird das Log angezeigt. Im unteren Teil (gelb hinterlegt) sind 
die QSOs zu sehen, die Sie mit der Station im Rufzeichenfeld des 
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Logeingabefensters bereits hatten (hier PA7MM). Die QSOs sind in beiden 
Fenstern nach Datum und Zeit geordnet. 

• Sie können die Trennlinie zwischen den beiden Bereichen mit der Maus 
ziehen. Wenn Sie das gesamte Fenster verkleinern oder vergrößern, werden 
beide Bereiche prozentual geändert.  

• In der oberen Leiste wird Datum, Uhrzeit (UTC) und aktueller Contest 
angezeigt. 

• Wenn Sie in einer Mult-OP-Umgebung arbeiten wird angezeigt: 
o Das Operator-Rufzeichen
o Die  zugeteilte Transceiver-Nummer
o Ein Gruppeneditieren ist im Multinutzer-Modus nicht erlaubt 
o Ein QSO kann nur von der Station editiert werden, die dieses QSO 

gemacht hat 
o Es wird eine Spalte im Log mit der Angabe Run1Run2 hinzugefügt 

Die Einstellungen des Logfensters werden beim Programmende abgespeichert. 

Die Seriennummer wird bei Contesten, in denen eine Seriennummer gegeben wird, 
immer OHNE führende Nullen in das Log eingetragen, auch wenn sie mitführenden 
Nullen gesendet wurde. Beim Ausdruck des Logs werden die führenden Nummer 
aber wieder eingefügt. 

Tastaturzuordnungen (Keyboard Assignments)

• Enter :  Editiere den ausgewählten Kontakt 
• Delete (Ctrl+D): Lösche den ausgewählten Kontakt 

Mauszuordnungen (Mouse Assignments)

• Linksklick (Left mouse button click) 
o Einfachklick auf den Titel einer Spalte (Single click on column title) 

Ändert die Reihenfolge der QSOs in der Reihenfolge der Spalte in 
aufsteigender Reihenfolge. Ein zweiter Einzelklick kehrt die 
Sortierrichtung um (absteigend). 

o Doppelklick auf ein QSO (Double click on a contact): Schnelledition 
des QSOs  

• Rechtsklick (Right mouse button click) 
o Rechtsklick auf ein QSO (Right-click on a contact) öffnet dieses 

Menü: 
 Schnelleditieren eines QSOs (Quick Edit Contact): Das 

angeklickte QSO wird ins Logeingabefenster geholt. Mit Ctrl+Q 
wird das QSO davor, mit Ctrl+A das QSO dahinter geholt. 
Korrigieren Sie das QSO und schließen Sie das Editieren mit 
ENTER ab oder verwerfen Sie die Änderung mit ESC. Während 
des Editierens sind die Felder des Logeingabefensters blau hell 
getastet. 

 Edit Contact: QSO in getrenntem Fenster editieren 
 Delete Contact (Ctrl+D):  QSO aus dem Log entfernen 
 Play Contact:  Haben Sie die Audioaufzeichnung eingeschaltet, 

können Sie mit dieser Taste die zum dem QSO gehörende 
WAV-Datei abspielen. Liegt ein WAV-Datei nicht vor, ist der 
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Menüpunkt grau dargestellt. Die WAV-Datei wird über die 
voreingestellte Soundkarte wiedergegeben. Achten Sie darauf, 
dass diese Datei nicht über Ihren Transceiver ausgesendet wird! 

 Jump to this frequency: Der VFO wird auf die Frequenz dieses 
QSOs gesetzt 

 Graph Q rates up to this entry:  Hier werden die Daten für 
QSOs/Zeit für die letzten 30 oder 60 Minuten bis zu diesem QSO 
ausgegeben. 

 

 Ein weiteres Menü öffnet sich, in dem Sie wählen können: 

 Periode: 30 oder 60 Minuten 
 Zahl der Balken 6, 10, 15, 20 
 QSO-Zähler 
 Stundenrate (Q's/hr) 
 Rate je 10 min 
 Rate je 20 min  
 Rate je 30 min 

o www.qrz.com : Abfrage bei www.qrz.com zu dieser Station. Eine 
Internetverbindung muss bestehen.  

o Change All Contact Timestamps by a Fixed Amount : alle QSO-
Zeiten um einen festen Betrag verschieben 

 Geben Sie die Zeitdifferenz ein mit + oder - in Minuten 
 Geht die Korrektur über eine Tagesgrenze hinweg, wird auch 

das Datum geändert.  
 Hinweis: Sie sollten vor der Änderung das Log getrennt sichern, 

um gegen einen Bedienfehler abgesichert zu sein.  
o Change Operator : Änderung des Operators für dieses QSO im Multi-

Betrieb zeilenweise. Die Änderung kann nicht rückgängig gemacht 
werden. 
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o Change Mode: Änderung der Sendeart für die markierten Zeilen. Die 
Änderung kann nicht rückgängig gemacht werden. 

o Change Rx Tx Frequency (and band) :Änderung der Arbeitsfrequenz 
für die markierte(n) Zeile(n). Die Änderung kann nicht rückgängig 
gemacht werden. 

o Change Station Number: Änderung der Stationsnummer für die 
markierte(n) Zeile(n). Die Änderung kann nicht rückgängig gemacht 
werden. 

o Find all contacts with a station : Zeigt alle Contest-QSOs mit einer 
Station an  

o Set Start oder Stop Interpolation Time Row: Ist Ihre Uhr stehen 
geblieben, können Sie einem Block an QSOs mit Start- und Endezeit 
eine Zeitstaffelung zuordnen. Siehe Kapitel Nach dem Contest ('After 
the contest'). 

o Rescore from this point on : Neuberechnung der Punktzahl von 
diesem QSO an bis zu Ende des Logs 

o Delete custom column widths: Rücksetzen der Spaltenbreiten auf 
den voreingestellten Wert 

o Show Mode: Anzeige der Sendeart hinter allen Spalten ein/aus 
o Show Date: Anzeige des Datums vor der Uhrzeit ein/aus 
o Select All: Alle QSOs für eine Sammelausgabe markieren 
o Copy (Kopieren)

 Copy Generic Print String: QSO(s) normal in die 
Zwischenablage kopieren  

 Copy ADIF String: QSO(s) als ADIF-Datei in die 
Zwischenablage kopieren

o Set Font:  Schrifttyp im Log-Fenster einstellen 
o Help: Hilfe zum Logeingabefenster abrufen 

Last Modification: 04 October 2009 06:06:12 EDT by K8UT. 
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Bandskalen (Bandmaps) 
Ihre beiden Bandskalen könnten so aussehen:  

 

 

Das Fenster der Bandskala ist einem VFO oder einem Transceiver zugeordnet. Es 
werden entweder beide VFOs eines Transceivers oder der jeweils aktive VFO von 
zwei Transceivern angezeigt. Sie können die Bandskalen in der Höhe und Breite 
ziehen und die Skalenteilung in der Bandskala u.a. mit dem Mausrad 
zusammendrängen oder auseinander ziehen (Zoom – oder +). 

1. Ein-Transceiver-Szenario (One radio scenario)

Bei einem Transceiver gehören die beiden Bandskalen zu VFO-A und VFO-B. VFO-
A wird links und VFO-B rechts angezeigt. Sie können die VFOs mit einem Klick in die 
zugehörige Bandskala wechseln oder mit Ctrl+Linkspfeil Ctrl+Rechtspfeil 
umschalten. Die jeweils aktive Bandskala ist im Kopf blau hinterlegt.

2. Zwei-Transceiver-Szenario (Two radio scenario)

Hier gehören die Bandskalen zum linken und zum rechten Transceiver. Die Anzeige 
entspricht Punkt 1. 

3. Anderes (Other)

• Informieren Sie sich zur Bedienung der Bandskalen über die weiter unten 
aufgeführten Zuordnungen der Maus und der Tastatur 
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• Im RUN-Modus wird die CQ-Frequenz fett hervorgehoben angezeigt. Die 
Anzeige erscheint automatisch beim Umschalten auf den RUN-Modus mit der 
F1-Taste. 

Zum Rufzeichen eines DXSpots wird die Antennenrichtung angezeigt. Ein DXSpot, 
der jünger als drei Minuten ist, wird mit dem Zusatz NEW markiert. Arbeitet die 
gespottete Station im Splitbetrieb, wird die Ablage (QSX) dreistellig zusätzlich 
angezeigt. Die Antennenrichtung wird nur für Stationen außerhalb des eigenen 
Landes mit Ausnahme von Kanada und USA ausgegeben. 
Anmerkung DM3ML: Die Antennenrichtung wird aus der Länderliste bezogen auf den 
jeweiligen Landesmittelpunkt berechnet. Bei UKW-Contesten wird der Lokator 
herangezogen und die Richtung genauer berechnet.

• Sie sehen in der Titelleiste der Bandskala, welcher VFO/TCVR aktiv ist. 
• Die Frequenzanzeige zeigt die am VFO eingestellte Frequenz. Bei Splitbetrieb 

wird darunter in kleinerer Schrift die Empfangsfrequenz zusätzlich angezeigt. 
• DXSpots mit einem "BUST" im Kommentar werden nicht angezeigt 
• Sind beide Bandskalen geschlossen, wird die Frequenz im Logeingabefenster 

vor dem Contestnamen angezeigt 
• In lebhaften Contesten können zu viele Calls in der Bandskala stehen. Ziehen 

Sie die Skala dann mit dem Menü (Zoom), den +/-Tasten im Nummernfeld 
oder mit dem Mausrad auseinander. 

• Neue Rufzeichen auf einer Frequenz erscheinen oberhalb des/der alten 
Rufzeichen 

• Ein einfacher Multi wird rot angezeigt, z.B. eine neue Zone oder ein neues 
Land im WWDX-Contest. Ein nicht zählendes Rufzeichen erscheint grau.  

• DXSpots für Länder mit unbekanntem Rufzeichen wie TX5A in 2006 werden 
dem Land zugeordnet, zu dem sie dem Prefix nach gehören. Lieber ein 
falsches Land als ein verlorener Multi! 

• Ein ‘¤ ‘ zeigt an, dass für dieses Land Angaben zum Sonnenauf-/untergang 
vorhanden sind. 

• Die Spots vom Programm CWSkimmer werden mit einem "#" markiert (siehe 
linkes Bild oben). Falls das Spotter-Rufzeichen Ihr Rufzeichen ist, wird der 
DXSpot mit einem ‚!’ markiert. 

4. Farbe der DXSpots (Colors of the incoming spots):

• Blau: QSO 
• Rot: Einfacher Multi z.B. neues Land ODER neue Zone im WWDX-C 
• Grün: Doppelter Multi  z.B. neues Land UND neue Zone im WWDX-C 
• Gray: Dupe, schon gearbeitet oder kein Punktlieferant 
• Fett -  Selbstgemeldeter DXSpot. Wenn Sie ein Rufzeichen in das 

Logeingabefeld eintragen, die Station aber nicht erreichen und weiter drehen, 
wird dieses Rufzeichen fett markiert in der Bandskala eingetragen. Sie können 
es dann später noch einmal versuchen. 

5. Tastaturzuordnungen (Keyboard Assignments)

• Mouse wheel (Mausrad):   ändert den Zoom in der aktiven Bandskala 
KEYBOARD focus. 
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• Numeric keypad + key (+ Taste im Nummernfeld):  Dehnt die Skala, die 
Spots in der aktiven Bandskala werden auseinander gezogen 

• Numeric keypad – key (- Taste im Nummernfeld):  Die Skala wird 
zusammen geschoben und in der aktiven Bandskala mehr Spots angezeigt 

• Shift - Numeric keypad + key (Shift mit + Taste im Nummerfeld):  Die 
Skala in der inaktiven Bandskala wird auseinander gezogen

• Shift - Numeric keypad – key (Shift mit - Taste im Nummerfeld):  Die Skala 
in der inaktiven Bandskala wird zusammen gedrückt.  

Sprung zu den Spots mit aktivem VFO/TCVR (Jump to Spots on active 
radio/VFO) 

• Ctrl+Pfeil nach unten:  Sprung zum nächsten DXSpot nach unten (höhere 
Frequenz) 

• Ctrl+Pfeil nach oben: Sprung zum nächsten DXSpot nach oben (niedrigere 
Frequenz) 

• Ctrl+Alt+Pfeil nach unten: Sprung zum nächsten Multi nach unten (höhere 
Frequenz) 

•  Ctrl+Alt+Pfeil nach oben: Sprung zum nächsten DXSpot nach oben 
(niedrigere Frequenz) 

Sprung zu den Spots mit inaktivem VFO/TCVR (Jump to Spots on non active 
radio/VFO) 

• Ctrl+Shift+Pfeil nach unten:  Sprung zum nächsten DXSpot mit der höheren 
Frequenz und Sprung über die CQ-Frequenz, wenn die VFOs auf dem 
gleichen Band sind. Gilt für SO2V/SO2R, bei SO1V abgeschaltet. 

• Ctrl+Shift+Pfeil nach oben:  Sprung zum nächsten DXSpot mit der 
niedrigeren Frequenz und Sprung über die CQ-Frequenz, wenn die VFOs auf 
dem gleichen Band sind. Gilt für SO2V/SO2R, bei SO1V abgeschaltet 
Shift+Ctrl+Alt+Pfeil nach unten: Sprung zum nächsten Multi mit der höheren 
Frequenz. Gilt für SO2V/SO2R, bei SO1V abgeschaltet 

• Shift+Ctrl+Alt+Pfeil nach oben: - Sprung zum nächsten Multi mit der 
niedrigeren Frequenz. Gilt für SO2V/SO2R, bei SO1V abgeschaltet. 

• Shift+Alt+Q: Sprung zur letzten CQ-Frequenz mit dem inaktiven VFO/TCVR 

6. Tastenzuordnung (Button Assignments)

• Narrow/Wide (Schmal/breit): Umschaltung der Filter im Transceiver (Tcvr-
abhängig) 

• CW/USB/LSB/RTTY/PSK/AM/FM (Umschaltung der Sendeart): Sendearten 
werden der Reihe nach durchgeschaltet (Tcvr-abhängig) 

• RIT Offset (-0.08): Mit einem Klick wird die RIT wieder auf 0 gesetzt. 
• RIT : RIT ein/aus  (Mausklick)
• XIT : XIT ein/aus (Mausklick)

7. Mauszuordnungen (Mouse Assignments)

Links-Klick-Menü (Left-click menu) 

• Klick auf eine Frequenz: Der aktive VFO wird auf diese Frequenz gesetzt 
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• Shift+Klick auf eine Frequenz in der inaktiven Bandskala (nur bei SO2R): 
Der inaktive VFO wird auf diese Frequenz gesetzt. Der Fokus des 
Logeingabefensters wird nicht geändert.  

• Shift+Klick auf ein Rufzeichen in der inaktiven Bandskala (nur bei SO2R): 
Das Rufzeichen wird in das inaktive Logeingabefenster gesetzt und die 
Frequenz des inaktiven VFOs eingestellt. 

• Klick auf ein Rufzeichen: Das Rufzeichen wird in das aktive 
Logeingabefenster gesetzt und die zugehörige Frequenz am VFO eingestellt. . 

• Doppelklick auf ein Rufzeichen: Das Rufzeichen wird in das aktive 
Logeingabefenster gesetzt, dessen Inhalt wird überschrieben und die 
zugehörige Frequenz am VFO eingestellt.  

• Klick auf einen Skalenstrich: Sprung zu dieser Frequenz
• Klick auf eine Frequenzangabe: Sprung zu dieser Frequenz
• Rechter Klick auf ein Rufzeichen: Öffnet ein Menü zu diesem Rufzeichen 

(s.u.). Das Rufzeichen wird kursiv und unterstrichen angezeigt
• Rechtsklick in die Bandskala: Öffnet ein Menü. Die rufzeichenbezogenen 

Menüpunkte sind grau dargestellt und unwirksam 

Wenn Sie rechts in eine Bandskala klicken, öffnet sich das folgende Menü:

• Zoom In (Numeric Pad +): Bandskala dehnen 
• Zoom Out (Numeric Pad -): Bandskala zusammenschieben 

• Go to Bottom of Band: Gehe an den Anfang des SSB/CW-Subbands 
• Go to Top of Band: Gehe an das Ende des SSB/CW-Subbands 

• Why don't I see spots? (Show packet filters): Warum sehe ich diesen 
DXSpot nicht? >> Hinweis auf die Einstellung des Packet-Filters: 

 

• Packet Spot Timeout : Anzeigedauer der DXSpots in der Bandskala. 
Voreingestellt ist 60 Minuten. Bei großem Andrang Zeit kürzer einstellen.

• Selected Spot - Remove this spot from the bandmap: Der angeklickte Spot 
wird aus der Bandskala entfernt 

• Remove Packet Spots: Verschiedene Wahlmöglichkeiten zum Entfernen 
ausgewählter DX-Spots
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o This band only, Leave Self Spots : entfernt die über Telnet/Packet 
angekommenen DXSpots für das aktuelle Band, lässt die 
selbstgespotteten Spots aber stehen 

o Remove All Spots, This band only: Löscht alle DXSpots für dieses 
Band 

o Remove Packet Spots, ALL BANDS, Leave Self Spots. Entfernt die 
DXSpots für ALLE Bänder, lässt die selbst gespotteten Spots aber 
stehen

o Remove All Spots, ALL BAND: entfernt alle DXSpots aller Bänder 
bands. 

Die folgenden Menüpunkte setzen voraus, dass ein Rufzeichen ausgewählt und 
markiert wurde:

• Turn Rotor: Dreht die Antenne in die angegebene Richtung zu dem 
ausgewählten Rufzeichen 

• Show Last 10 Spots:  Die letzten 10 DXSpots für dieses Rufzeichen werden 
angezeigt 

• Show/Buck Packet:  Ruft die Buckmaster-Information für das Rufzeichen 
vom DXCluster ab. Wählen Sie bei einem DXSpider-Cluster das Kommando 
SH/QRZ > siehe Telnetfenster

• Show Station: Ruft die Stationsinfo beim DXCluster ab > siehe Telnetfenster 
• Show QSL/Packet: Ruft die QSL-Info beim DXCluster ab > siehe 

Telnetfenster 
• Show Sunrise/Sunset: Ruft die Sonnenaufgangs/-untergangszeiten auf der 

Basis der importierten Länderdatei beim DXCluster ab > siehe Telnetfenster 
und Info-Fenster 

• Show Buck/Internet : Ruft bei www.QRZ.com die Info zu dieser Station ab > 
siehe Internet Explorer 

• Show Buck Local: Ruft die Daten der Station aus der lokalen Buckmaster-
Datenbank ab, falls diese installiert ist. 

• Set transceiver offset frequency:  Einstellung der Frequenzanzeige, wenn 
ein Transverter verwendet wird. Die eingestellte Ablage wird gespeichert und 
bei einem Programmneustart wieder aktiviert. Wenn Sie mit ALT+F7 in den 
Splitbetrieb schalten, müssen Sie die Frequenz des Transceivers und nicht 
des Transverters eingeben, Sie Kapitel UKW-Conteste (VHF and Up 
contesting) zur Einstellung und Berechnung der Frequenzablage.
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• Set transceiver timeout time: Einstellung der Totzeit für die CAT-Steuerung. 
Voreingestellt sind 10 Sekunden, in denen der Transceiver auf eine Abfrage 
spätestens geantwortet haben muss. Sie können eine kürzere Zeit einstellen. 
Eine negative Zahl setzt die Totzeit auf 10s. Die kleinste Zeit, die eingestellt 
werden kann, ist 5s. 

• Set transceiver filter codes: Sie werden nach den Codes für das schmale 
und das breite Filter gefragt. Informieren Sie sich im Handbuch Ihres Geräts. 
Der Kode muss dezimal eingegeben werden. Für den FT1000MP z.B. statt 0 0 
0 0 8C ist 0 0 0 0 140 (8C hex) einzugeben. 

Um zu den voreingestellten Werten zurück zu kommen, geben Sie ein Leerzeichen 
ein und schließen Sie es mit OK ab. Sie können ein {CR} in den Filtercodes 
verwenden, das durch das WR-Zeichen ersetzt wird. Möglich sind diese 
Einstellungen:  

o CW Wide 
o CW Narrow 
o SSB Wide 
o SSB Narrow 
o Digi Wide 
o Digi Narrow 

• Bring to foreground when made active: Bringt die aktive Bandskala in den 
Vordergrund. Bei wenig Platz auf dem Monitor können Sie die Bandskalen 
damit übereinander setzen. 

• Reset Radios: Startet die Verbindung zu dem oder den Transceivern neu, 
wenn sie abgebrochen ist. Wählen Sie 'Retry' um die Verbindung wieder 
herzustellen oder klicken Sie rechts in die Bandskala und wählen Sie im Menü 
"Reset Radios".  

 

• Help: Zeigt die Hilfe zu den Bandskalen an 

Hinweis : Wird ein Kommando an das Packet/Telnet-Fenster gesendet, wird die 
Verbindung genutzt, die aktuell hergestellt ist.

Wenn Sie mit einem DXSpider-Cluster verbunden sind, wählen Sie beim Configurer 
auf der Karteikarte Other die Option 'Format for DX Spider cluster'. 

Mauszeiger auf einen Spot setzen (Hovering with the mouse over a spot) 

Wenn Sie den Mauszeiger auf einen DXSpot setzen, öffnet sich ein kleines Fenster 
mit zusätzlichen Informationen zu diesem Spot mit diesen Einzelheiten: 
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• Exakte vom Spotter gemeldete Frequenz 
• Rufzeichen des Spotters 
• Seit der Absendung des Spots vergangene Zeit 
• Kommentare zu dem Spot 
• Standardprefix der gespotteten Station 

Wenn Sie den Mauszeiger auf das blaue Dreieck in der Skala setzen, wird die 
genaue am Transceiver eingestellte Frequenz angezeigt. 

8. Beispiel für die Nutzung der Bandskala (Example bandmap usage)

von Tom, N1MM 

Im Modus Search & Pounce (S&P) wird das Rufzeichen aus der Bandskala, auf dem 
oder in dessen Nähe der Transceiver steht (vom Nutzer einstellbare Abstimmtoleranz 
(tuning tolerance) in den Rahmen oberhalb des Rufzeichenfeldes im 
Logeingabefenster gesetzt. Ist das Rufzeichen grau gefärbt, haben Sie diese Station 
schon gearbeitet oder dürfen sie nicht arbeiten.

Ein Tipp für den CQ WPX-Contest, der keine definierten Multis hat: Gehen Sie in den 
S&P-Modus und klappern Sie die Bandskala mit den Tasten Ctrl+Pfeil nach unten 
vom Bandanfang bis Ende des Subbandes ab und gegen Sie dann mit Ctrl+Pfeil  
nach oben wieder zurück. Hören Sie, dass eine Station gerade ein QSO angefangen 
hat, gehen Sie zur nächsten und nehmen Sie den Rest beim nächsten Durchlauf mit. 
Haben Sie beim Durchtasten eine freie Frequenz gefunden, können Sie hier in den 
RUN-Modus umschalten und CQ rufen.

Gibt es in einem Contest Multis, sind diese rot markiert. Grasen Sie zuerst mit 
Ctrl+ALT+Pfeil nach unten die Bandskala nach Multis von unten nach oben ab und 
gehen Sie dann Ctrl+ALT-Pfeil nach unten wieder zum Bandanfang, ehe Sie mit 
Ctrl+Pfeil nach oben/unten die blauen noch nicht gearbeiteten Station anrufen. 

Holen Sie sich das im Rahmen über dem Rufzeichenfeld stehende Rufzeichen mit 
der Leertaste in das Rufzeichenfeld und schalten Sie nach einem erfolgreichen Anruf 
weiter mit der Leertaste in das Kontrollnummernfeld. Speichern Sie das QSO mit 
ENTER ab.  Informieren Sie sich ausführlich über die verschiedenen 
Tastenzuordnungen vor einem Contest!

Lebenszeit der DXSpots (Spots and the time shown) 

Wenn Sie den Mauszeiger auf einen DXSpot setzen, wird die seit dem Spotten 
vergangene Zeit angezeigt. Welches Zeitformat verwendet wird, hängt von der 
Herkunft des DXSpots ab. Es gibt eine Zeit für „normal“ gespottete Rufzeichen und 
eine Zeit für die mit SH/DX abgerufenen DXSpots. Das Programm verarbeitet die 
DXSpots verschieden:  

• Normal einlaufende Spots werden der PC-Uhrzeit markiert, wenn sie 
eintreffen. Damit werden unterschiedliche Laufzeiten und DXClusterzeiten 
ausgeschlossen. 
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• Mit SH/DX abgerufene Spots werden mit der DXCluster-Zeit übernommen, 
wobei darauf geachtet wird, dass diese Zeit nicht später ist als die aktuelle 
PC-Zeit. 

Rote Linien markieren die Frequenzen der US-Lizenzklassen (Red lines 
indicating US license frequencies) 

Rote Linien in den Bandskalen markieren die Bereiche für die Klassen Extra, 
Advanced und General der US-Lizenzen. Da niedrigere Lizenzklassen nur in oberen 
Bereichen der Bänder arbeiten dürfen, sollten Sie diesen Stationen eine Chance 
geben und in diese Bereiche in Ihre Aktivität einbeziehen, sonst gehen diese 
Stationen leer aus.

Sie finden die Linien bei  

• SSB: 3775, 3850, 7225, 14175, 14225, 21225 and 21300. 
• CW: 3525, 7025, 14025 and 21025. 
• Keine Linien auf 160 m und 10 m 

Last Modification: 01 October 2009 09:43:37 EDT by n4zr. 

Packet/Telnet-Fenster (Packet)

Ihr Packet-Fenster könnte so aussehen :  

 

Sie können die Tasteninhalte unten im Fenster mit einem Rechtsklick darauf ändern 
oder den Menüpunkt Config > Change Packet/CW/SSB/Digital Message Buttons 
> Change Packet/Telnet Buttons aufrufen. Die Statusanzeige ist in der Titelleiste 
zu sehen. Der Fokus wird auf das Telnetfenster gesetzt, wenn Sie eine der 12 
Tasten anklicken.

Alle ankommenden DXSpots werden in die Bandskalen geschickt, auch die mit 
SH/DX abgerufenen. Ist im DXSpot eine Split-Information enthalten wird sie ebenfalls 
erkannt und ausgegeben. Klicken Sie einen solchen DXSpot an, wird Ihr Transceiver 
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in den Splitbetrieb geschaltet. Das Programm erkennt diese Angaben zum 
Splitbetrieb: UP, U, DOWN, DN, D und das Wort QSX. Beispiele sind QSX 3.838, 
QSX 4, UP 5, DOWN 2, U 5, D4, U4, DN4, UP4, DOWN4, QSX7144 usw. Wo immer 
es möglich ist, werden Sendeart, Staat/Provinz, WWLokator u.ä, aus dem DXSpot 
und seinem Kommentar extrahiert. Ist der WWLokator bekannt, wird er zur 
Berechung der Antennenrichtung und der Entfernung herangezogen. Die Daten 
erscheinen in der Bandskala, im Info-Fenster, im Fenster der angebotenen DXSpots 
und im Logeingabefenster. 

Wurde die Karteikarte Telnet ausgewählt, kann ein Telnet DXCluster aus dem 
vorbereiteten Menü rechts oben im Fenster gewählt werden. Mit Close Port wird die 
Telnetverbindung beendet. Die Telnet-DXCluster werden im Configurer auf der 
Karteikarte Hardware eingestellt. 

Das Packet/Telnet-Fenster sendet aller neun Minuten ein CR an den 
angeschlossenen DXCluster (“Tote-Mann-Taste”). Wenn Sie eine Meldung an den 
DXCluster senden, wird dieser Zähler rückgesetzt. 

1. Verwendete Farben (Colors used)

• Blau: Normalen DXSpot 
• Rot: Talk-Meldung  
• Lila: WWV-Meldung 
• Schwarz: alle anderen Meldungen, wie SH/DX-Antworten, Begrüßung usw. 

2. Voreingestellte Tastenbelegung (Initial Button Assignments)

Sie können 12 Tasten mit Festtexten belegen. Sie sind wie folgt voreingestellt: 

Tastentext Kommando Beschreibung Packet Telnet 
BYE BYE DXCluster verlassen OK OK 

CONN C PE1M-7
Verbinden zu einem Packet-DXCluster, 
wie z.B. C PE1M-7. Konfigurieren Sie 
diese Taste mit Tools >Change 
Packet Buttons'.

Connect Keine 
Funktion 

DI/N DI/N
Anzeige neuer DXSpots, bei CLX-
DXClustern Kommando ungekürzt 
geben: directory/new

OK OK 

SH/DX SH/DX/30 Anzeige der letzten 30 DXSpots OK OK 
USERS SH/U Anzeige der eingeloggten Stationen OK OK 
WWV SH/WWV Anzeige der WWV-Daten OK OK 

10M SH/DX/30 
10

Anzeige der letzten 30 DXSpots auf 
10m OK OK 

15M SH/DX/30 
15

Anzeige der letzten 30 DXSpots auf 
15m OK OK 

20M SH/DX/30 
20

Anzeige der letzten 30 DXSpots auf 
20m OK OK 

40M SH/DX/30 
40

Anzeige der letzten 30 DXSpots auf 
40m OK OK 

80M SH/DX/30 Anzeige der letzten 30 DXSpots auf OK OK 
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80 80m

PA1M {MYCALL}
Absenden des eigenen Rufzeichens 
zum Einloggen bei einem Telnet-
DXCluster

Keine 
Funktion Connect

• Close Port : Beendet die laufende Telnet-Sitzung 

3. Tastatur-Zuordnungen (Keyboard Assignments)
 >>  Kommandos und andere Eingaben erfolgen in dem schmalen Fenster rechts 
neben den Karteikartenreitern Packet/Telnet. Der Cursor muss in diesem Fenster 
stehen (linker Mausklick!) 

• Ctrl+C: Sendet Ctrl+C an einen TAPR TNC. 
• Ctrl+Z : Sendet Ctrl+Z an einem TAPR TNC. 
• Shift+ESC: Wichtig bei einem Kommando an einen WA8DED/TF-Firmware 

TNC
 Wichtig:  Mit einem einfachen ESC geht der Fokus zurück an das 
Logeingabefenster. Shift+ESC wird z.B. bei der direkten Eingabe eines 
Connect-Kommandos benötigt, wie ‚Shift+ESC C DB0ERF ENTER’

4. Mauszuordnungen (Mouse Assignments)

• Linksklick
o Einfach: Stelle den aktiven VFO auf diesen DXSpot 
o Shift+Klick: Stelle den inaktiven VFO auf diesen DXSpot 
o Doppelklick: Das Rufzeichen des DXSpots wird in das Rufzeichenfeld 

des Logeingabefensters gesetzt 
o Ctrl+Einfachklick: Setze den inaktiven VFO auf die Frequenz des 

DXSpots und schalte ihn auf aktiv 
• Rechtsklick ruft dieses Menü auf: 

o Why don't I see spots? (Show packet filters) (Warum sehe ich keine 
DXSpots > Anzeige des Packetfilters): Anzeige der aktuellen 
Einstellung des Filters (angehakte Meldungen werden nicht angezeigt) 

o Configure Ports, Telnet Address, Other : Ruft den Configurer 
o Edit Telnet Cluster List: Ruft die Liste mit den eingestellten 

DXClustern. Die Liste kann editiert werden (lösche, ändern, 
hinzufügen) 

o Change Packet/Telnet Buttons : Änderung des Tastentitels und des 
Inhalts. Wenn Sie ein ‘&’ vor einen Buchstaben im Tastennamen 
setzen, können Sie diese Taste mit einem Kurzruf ALT+Bu rufen." 

o Close Port : Beendet die aktuelle Verbindung 
o Specify Comment for All Spots: Allen eigenen DXSpots wird ein 

fester editierbarer Kommentar hinzugefügt. Gilt nur für die aktuelle 
Sitzung. Kommentar z.B. PACC oder WWDX

o Auto logon : Mit dem Programmstart loggt sich N1MMLogger 
automatisch bei einem DXCluster ein. Bei einem Telnet-DXCluster wird 
die Taste F12 und bei einem Packet-DXCluster die Taste F2 mit dem 
Inhalt ‘c <dxcluster> genommen. Hatten Sie sich bei der letzten Sitzung 
bei je einem Telnet- und einem Packet-Cluster eingeloggt, wird der 
DXCluster genommen, bei dem Sie zuletzt waren. 
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o Packet Spot Timeout : Anzeigedauer für die DXSpots. Voreingestellt 
ist 60 Minuten. Jeder andere Wert kann gewählt werden. 

o Remove Packet Spots, Leave Self Spots : alle DXSpots vom 
DXCluster werden entfernt, die selbst gespotteten Stationen bleiben 
stehen 

o Remove all spots : Alle DXSpots werden aus der Bandskala entfernt, 
es verschwinden ebenfalls die Angaben im Fenster der möglichen 
Multis und QSOs. 

o Packet Filters: mit den Filtern können Sie vorgeben, welche Art von 
DXSpots angezeigt und welche unterdrückt werden sollen: 

 Allow HF : DXSpots von Frequenzen unterhalb 30 MHz werden 
angezeigt 

 Allow WARC : DXSpots von den WARC-Bändern werden 
angezeigt 

 Allow VHF : DXSpots von Frequenzen oberhalb 30 MHz werden 
angezeigt 

 Allow spots from my country only : nur DXSpots, die aus dem 
eigenen Land kommen, werden angezeigt 

 Allow spots from my continent only:  nur DXSpots, die aus 
dem eigenen Kontinent kommen, werden angezeigt

 Allow only spots from specified call areas - nur DXSpots, die 
aus einem bestimmten Rufzeichengebiet kommen, werden 
angezeigt. Die Rufzeichengebiete können im nächsten 
Menüpunkt festgelegt werden. Das Rufzeichengebiet wird durch 
den Landesprefix und eine Ziffer festgelegt, z.B. passt WB1KK in 
das Rufzeichengebiet K1 (K + 1) 

 Enter call areas (currently): Rufzeichengebiete hintereinander 
eingeben, z.B. K1 K2 K3 K4 getrennt durch je ein Leerzeichen 
und abgeschlossen mit OK. 

 Allow spots for this contest's mode(s) only: nur DXSpots mit 
der zum Contest passenden Sendeart, bei mixed kann "not digi" 
gewählt werden. 

 Change Subbands for mode filter: Für die Sub-Bänder ist eine 
Bereichsangabe von..bis in kHz möglich. Für digitale Sendearten 
ist kein Bereich voreingestellt, Sie können das nachträglich 
machen. Die Sub-Bänder werden durch violette Linien in der 
Bandskala angezeigt. Sie können sie Sub-Bänder mit Config > 
Configure Ports, Telnet Address, Others > Karteikarte Mode 
Control > Follow band plan aktivieren. Die Abfrage erfolgt in 
der Reihenfolge Digital? > falls nicht, CW? Falls nicht, dann 
SSB! 

Voreingestellt ist der US-Bandplan. Für Europa müssen Sie den Bandplan 
korrigieren, speziell auf 40m. 

 Change CW Bands: Der Bereich 7000 bis 7035 ist als 
CW (Europa) eingestellt. Alles darüber wird, solange kein 
digitales Subband eingerichtet worden ist, als SSB 
gewertet. 

 Change SSB Bands : Falls nichts anderes gefunden 
wurde, ist SSB voreingestellt 
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 Change Digital Bands: die digitalen Subbänder werden 
genommen 

o Set Font: Schrifttyp im Packet/Telnetfenster. Zu empfehlen sind feste 
Typen wie Fixedsys, Courier, Anadale Mono mit durchgestrichenen 
Nullen 

o Copy: Ein mit gedrückter linker Maustaste markierter Textbereich wird 
nach einem Rechtsklick kopiert und kann in ein anderes Programm 
übergeben werden. Die Markierung verschwindet nach dem 
Kopierkommando.  

o Help: Holt aus dem Internet die Hilfe für dieses Fenster

Hinweis: Die Menüpunkte Allow spots and Allow HF/VHF/WARC geben, vor 
welche DXSpots in die N1MMLogger-Fenster übernommen werden. Die DXSpots 
erscheinen nach wie vor im Packet/Telnetfenster, nur ihre Weiterverarbeitung wird 
gesteuert. Sie können aber weitere Filter direkt bei Ihrem DXCluster über 
entsprechende Kommandos einstellen.  

5. Spezialtasten (Special keys):

• Mit gedrückter Ctrl-Taste schicken Sie einen angeklickten DXSpot zum 
inaktiven VFO/Transceiver und aktivieren diesen (wichtig bei SO2V/SO2R).

6. Macrotasten (Macro keys)

Sie können bei der Programmierung der 12 Tasten unten im Fenster und bei dem 
abzusendenden Kommentar Macros verwenden, z.B. bei der Verwendung von 
Shift+F9. Einzelheiten entnehmen Sie dem Kapitel Macros.

Verwendbar sind Macros wie {CTRL-M}, {WAIT}, {GRIDSQUARE}, {MODE}, {ZONE} 
und {QTH}. 

Im Packet-Fenster können Sie z.B. das Macro  

{CTRL-M}{WAIT}C PE1M-7{WAIT}PA1M 

auf eine Taste legen und den Connect zum DXCluster starten. Normalerweise wird 
ein ENTER nach jedem Kommando gesendet. Bei manchen Systemen kann es 
dadurch Probleme geben. 

7. Telnet-Adressenliste editieren (How to add/edit/delete a Telnet cluster)

Sie kommen auf drei Wegen zum Menü Change Telnet Cluster List :  

• Klicken Sie rechts in das Packet/Telnet-Fenster und wählen Sie Edit Telnet 
Cluster List

• Gehen Sie zu Config > Change Telnet Cluster List 
• Wählen Sie Config > Configure Ports, Telnet Address, Others > 

Karteikarte Hardware und klicken Sie auf die Taste Edit. 

Sie können in der freien Zeile unten in der Liste weitere Telnet-Adressen eintragen 
oder nach einem Markierungsklick einen Eintrag editieren oder ihn mit einem Druck 
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auf die Tastaturtaste Entf löschen. Bei der jeweils aktiven Zeile wird eine Hand 
angezeigt. 

8. Einstellung des Telnet-Clusters (How to setup and connect a Telnet 
cluster)

 Klicken Sie auf den Karteikartenreiter Telnet.
 Ergänzen die Adresse des Telnet-Clusters mit Config > Change Telnet Cluster 

List. Geben Sie als Adresse entweder einen Namen wie gb7ujs.shacknet.nu 
oder eine IP-Adresse ein. Eine übliche Portnummer ist die 23.

 Klick Sie in das Clustermenü oben rechts und wählen Sie aus der Adressliste 
den gewünschten Telnet-Cluster aus

 Klicken Sie dann auf die Taste F12. Ihr Rufzeichen wird an den Telnet-Cluster 
gesendet und in der Regel wird eine Verbindung hergestellt. Beachten Sie die 
Antwort im Empfangsfenster. Werden weitere Eingaben wie ein Passwort 
angefordert, geben Sie diese in der schmalen Spalte neben den 
Karteikartenreitern in der Mitte oben ein. 

 Der Telnet-Cluster hört jetzt auf weitere Kommandos wie SH/DX, SH/WWV 
usw. 

9. Verbindung zu einem Packet-Cluster über einen TNC (How to setup 
and connect a cluster using a TNC)

 Klicken Sie auf den Karteikartenreiter Packet
 Geben Sie das Kommando zum Connecten entweder direkt in die Zeile neben 

dem Karteikartenreiter ein: Shift+ESC C <digi> ENTER oder verwenden Sie 
die richtig programmierte Taste F2.

 Beachten Síe die Antwort des Packet-Clusters im Empfangsfenster und 
machen Sie – wenn nötig – weitere Eingaben im Kommandofenster in der 
Mitte oben.

10. Verbindung automatisch herstellen (Auto connecting a cluster)

• Stellen Sie die Verbindung zu einem Telnet- oder Packet-Cluster wie 
beschrieben her.

• Klicken Sie rechts in das Packet/Telnet-Fenster und wählen Sie im sich 
öffnenden Menü den Punkt Auto Logon 

• An sofort wird mit jedem Programmstart diese Verbindung hergestellt. 
• Sollte die Verbindung getrennt werden, müssen Sie sie manuell wieder 

herstellen
• Ein CR wird alle 9 Minuten gesendet (Toter-Mann-Knopf) 

11. Stationen spotten (Spotting stations)

Abzusendende DXSpots werden aus dem Logeingabefenster heraus ausgelöst. Die 
Station im Rufzeichenfenster – oder wenn es leer ist – die Station vom QSO davor 
werden gespottet mit 

• Alt+P 
• Ctrl+P zuzüglich Kommentar. 
• Mit der Aktivierung von Spot all S&P QSOs unter 'Config'. 

11.04.2010



N1MM-Contest Logging Software Seite 150 von 470 Übersetzung der Hilfe von Eike, DM3ML

Die gespottete Frequenz wird auf eine Kommastelle aufgerundet.  

12. Multinutzer-Einstellung (Multi-User setup)

In einem Netz mit mehreren Stationen wird nur die Master-Stationen mit dem 
DXCluster verbunden. Die Master-Station leitet ein und aus gehende DXSpots an die 
und von den im Netz angeschlossenen Stationen weiter.  

13. Computer in einem lokalen Netz (Computers on a LAN)

Sie können Telnet-Cluster auch über einen Proxyserver oder einen Router erreichen. 
Versuchen Sie zuerst, denn DXCluster direkt über ein Windows-Telnetprogramm 
anzusprechen. Wenn das funktioniert, geht es auch mit N1MMLogger. Der Telnet-
Port 23 sollte in jedem Fall offen sein. 

14. Packet über die Soundkarte (Packet via the soundcard)

Verschiedene Stationen benutzen das Programm AGWPE zum Empfang von 
Packetmeldungen über die Soundkarte. N1MMLogger kann nicht direkt mit AGWPE 
zusammenarbeiten. Es gibt aber Zusatzprogramme, die mit AGWPE über Telnet-
Adressen mit N1MMLogger zusammenarbeiten können. Versuchen Sie es mit 

• TelMgr by LU7DID 
• Telnet interface by IZ4AFW 

15. Unterstützte Packet-Cluster (Supported Packet clusters):

• AR-Cluster von AB5K 
• Clusse von  OH7LZB (nicht voll unterstützt, nur ankommende DXSpots) 
• CLX von DJ0ZY und DL6RAI 
• DX-Spider von G1TLH 

o DX-Spider verwendet ein anderes SH/DX-Format, schalten Sie unter 
Configurer / Other auf 'Format for DX-spider support'.  

• DXnet von F5MZN (Kompatibilität unbekannt)
• PacketCluster von AK1A 
• Wincluster Lite von KH2D 
• Weitere  

16. CW Skimmer

CW Skimmer von Alex, VE3NEA, hat einen eingebauten Telnet-Server mit der 
Lokaladresse 127.0.0.1:7300. Sie können diese Adresse in der Telnetliste eintragen. 
Die CWSkimmer-DXSpots sind mit einem "#" markiert. Falls ein Spot das eigene 
Rufzeichen enthält, wird es mit einem "!" markiert. Im Multis     und QSOs - Fenster   
wird die Markierung in die Richtungsspalte gesetzt. U.U. müssen Sie dieses Fenster 
breiter ziehen, um die Markierung sehen zu können. 

Last Modification: 04 October 2009 06:06:56 EDT by K8UT. 
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Rufzeichenprüffenster (Check)

1. Möglichkeiten (Features)

• Im Prüffenster werden die Rufzeichen aus der Datei MASTER.DTA angezeigt, 
die teilweise oder ganz mit dem im Rufzeichenfeld des Logeinagbefensters 
eingetragenen Rufzeichens übereinstimmen.  

• Das Prüffenster wird erst gelöscht, wenn das erste Zeichen eines neuen 
Rufzeichens eingegeben wird. 

• Alle Rufzeichen werden in Großbuchstaben angezeigt
• Damit das Prüffenster arbeitet, muss bei der Vorbereitung des Contestes eine 

möglichst aktuelle Datei MASTER.DTA geladen und angegeben sein. Sie 
finden verschiedene Dateien hier. Sie sollen die weltweite Datei wählen. 
Tragen Sie den Speicherplatz der Datei unter Associated Files im Fenster 
der Contest-Einstellung ein. 

In der Titelzeile des Prüffensters sehen Sie, ob es sich um eine neue Station oder 
einen neuen Multi für das aktuelle Band handelt:  

• 2X: - Doppel-Multi, Land und Zone (bei WWDX) 
• Mu: -Multi 
• Q: Station auf diesem Band schon gearbeitet 
• Beispiel: Mul: 15 20 Q: 160 80 40 10: Multi auf 15 und 20 m, schon 

gearbeitet auf 160, 80, 40 und 10m. 

Hinweis: Damit die Titelzeile richtig funktioniert, muss das Fenster Available Mults 
and Q's geöffnet sein.

Das Prüffenster hat zwei Bereiche: 

• Oberer Bereich: Rufzeichen schon im Log 
• Unterer Bereich: Rufzeichen in der Master-Datei gefunden

 

Links: Programm 
gestartet, aber 
noch kein 
Rufzeichen 
eingegeben. 
Angezeigt wird der 
Status der Master-
Datei

Rechts: Keine 
Master-Datei 
gefunden. Gehen 
Sie zu Tools > 
'Download latest 
Check partial file 
(Master.DTA) 
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Links: Keine 
Übereinstimmungen 
gefunden

Rechts: Schon 
gearbeitet!!

 

Wenn Sie rechts in das Fenster klicken, können Sie die Option "Show N+1 calls" 
aktivieren. Dann werden auch Rufzeichen angezeigt, die sich um eine Ziffer oder 
einen Buchstaben vom eingegebenen Rufzeichen unterscheiden. Sie können u.U. 
dann doch noch ein Rufzeichen im QRM identifizieren.  

• Das gefundene Rufzeichen in der Liste wird fett markiert, wie PA1M weiter 
unten. 

• Die ebenfalls zu PA1M passenden Rufzeichen wie PA1MR, PA1MV und 
andere werden normal angezeigt. Ist die Option N+1 aktiv, wird die jeweilige 
Differenz fett markiert (siehe unten). 

N+1 nicht aktiviert PA1M steht im 
Rufzeichenfeld N+1 aktiviert

 

Links: In der 
ersten Zeile steht 
links kein 
Rufzeichen > 
PA1M noch nicht 
gearbeitet.

Rechts: PA1K 
wurde schon 
gearbeitet.
Weitere Rufzeichen 
weichen um eine 
Stelle von PA1M 
ab. Differenz fett 
markiert

 

2. Farbe der Rufzeichen (Colors of the callsigns)
Blau Neues Rufzeichen auf diesem Band 
Schwarz Dupe, schon gearbeitet oder nicht arbeitbar in diesem Contest

3. Tastaturzuordnungen (Keyboard Assignments)

• Alt+Y : holt das erste Rufzeichen der Prüfliste in das Rufzeichenfeld des 
Logeingabefensters 
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4. Mauszuordnungen (Mouse Assignments):

• Linker Mausklick auf ein Rufzeichen in der Liste > Rufzeichen wird ins 
Rufzeichenfeld übernommen

• Rechter Mausklick: Ein Menü wird geöffnet 
o Show N+1 Calls . siehe oben  
o Set Font : Auswahl des Schrifttypes für das Prüffenster 
o Help: Aus dem Internet wird die Hilfe für dieses Fenster geholt- Show 

the help file for this window. 

5. Suche mit Platzhaltern (Wildcard search)

Falls ein oder mehrere Zeichen in einem Rufzeichen im Rufzeichenfeld unbekannt 
sind, kann an ihrer Stelle ein ‚?’ eingebaut werden, z.B. N?MM oder N1?. Mindestens 
zwei aufeinander folgende Zeichen des Rufzeichens müssen bekannt sein. Mit M?M 
funktioniert die Suche nicht.  

Das Rufzeichen kann auch mit einem Fragezeichen beginnen, z.B. ?1M liefert KN1M 
und N1MM. Die Option N+1 macht das automatisch. Es können auch zwei 
Fragezeichen stehen, z.B. ??1M 

Beispiele: 

PA?M passt zu PA1M, PA7MM usw.  P?1M passt zu PA1M, PG1M, PF1MO usw. . 
P?3 funktioniert wegen der fehlenden zusammenhängenden zwei Zeichen nicht. ?
1M passt zu N1MM, KN1M, PA1M usw.. 

Last Modification: 19 December 2009 09:16:37 EST by n4zr. 

Angebotsfenster (Available Mults and Qs)

Im Fenster Available Mults and Qs werden ähnliche Angebote gemacht (beginnend 
mit Version 9.12.5): 
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1. Der Kopf (The Header)

In der Kopfzeile stehen die zur Verfügung stehenden Multis (10) und QSOs (20). Sie 
können mit einem Rechtsklick ein Menü öffnen, in dem Sie die Eigenschaften der 
Anzeige wählen können. Der Fokus auf dieses Fenster ist nur aktiv, wenn Sie direkt 
in das Fenster klicken.  

2. Die Bandtasten (The Band Buttons)

Links steht die Anzahl der per DXSpot gemeldeten möglichen Multis und rechts die 
Anzahl der möglichen neuen Stationen jeweils je Band. Sie können anhand der 
angegebenen Zahlen auf das Band mit dem höchsten Angebot schalten. Das ist vor 
allem gegen Contestende oder bei Bandöffnungen interessant, wenn noch nicht 
erreichte Stationen/Multis gesucht werden. Rechts oben ist ein Wechsel auf 10m zu 
empfehlen, während links das 6m-Band offen ist. 

Mit roten Zahlen ist das Band mit dem größten Angebot markiert. Die WARC-Bänder 
werden nur angezeigt wenn allgemeines Loggen als DX oder Dxpedition ausgewählt 
wurde. Die VHF-Variante (links) wird bei einem VHF-Contest oder einer VHF-Aktivität 
angezeigt.  

Jede der Bandtasten ändert die Farbe, wenn ein Rufzeichen in das Rufzeichenfeld 
eingetragen wird. Die Farbe (grün, rot, blau oder schwarz) zeigt an, ob es sich um 
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einen Doppel-Multi (grün), einen einfachen Multi (rot), eine neue Station (blau) oder 
um eine nicht zu arbeitende Station (DUPE, nicht wertbar) (schwarz) handelt. Die 
Anzeige gilt für die jeweils aktive Sendeart. Das aktive Band ist fett in der Taste 
markiert

3. Multi-Liste (Multiplier List box)

Die Liste unter den Bandtasten zeigt die vom DXCluster eingelaufenen QSOs. Sie 
hat vier Spalten: Rufzeichen, Frequenz, Antennenrichtung (Dir), Sendeart (Mode) 
und UTC-Zeit (TS) im Format “mm-dd hhmm”. Mit einem Klick auf den Spaltenkopf 
wird der Spalteninhalt aufsteigend und beim nächsten Klick absteigend sortiert. Die 
Splitspots sind mit (±) neben der Frequenz markiert. Die Spots vom lokalen 
CWSkimmer haben ein (!) rechts neben der Antennenrichtung und die Spots von 
anderen CWSkimmern ein (#). Der Sonnenauf-/untergangsindikator (¤) wird – soweit 
vorhanden – neben die Antennenrichtung gesetzt und weißt auf ein mögliches 
Grayline-QSO hin. Es gilt die gleiche Farbkennzeichnung wie oben, DUPEs werden 
nicht angezeigt. 

4. Tastaturzuordnungen (Keyboard Assignments)

• Mit Ctrl+Pfeil nach oben/unten können Sie sich durch die Liste schalten 

5. Bandtasten-Zuordnungen (Band button Assignments)

• Linksklick auf eine Bandtaste: Schaltet den linken VFO/Transceiver auf den 
ersten Spot dieses Bandes. 

• Rechtsklick auf eine Bandtaste: Schaltet den rechten VFO/Transceiver auf 
den ersten Spot dieses Bandes. 

o Hinweis: Sind Sie mit beiden Logeingabefenster im selben Band 
(SO2V) wird das Rufzeichen in das Logeingabefenster gesetzt, das 
nicht im Fokus ist. 

6. Bandtastenhintergrundfarbe (Band button background colors)

• Blau: mögliches QSO
• Rot: Einfacher Multi 
• Grün: Doppelter Multi 
• Grau: Dupe 

7. Mauszuordnungen (Mouse Assignments)

• Linksklick auf ein Rufzeichen in der Liste 
o SO1V 

 DXSpot geht zu VFO-A 
 Shift + einfacher Linksklick: kein Effekt. 

o SO2V + "Basic VFO Selection" (siehe Rechtsklick-Menü weiter unten) 
 Gewählt werden kann “Basic VFO Selection" oder "Advanced 

VFO Selection"  
 Falls "Advanced VFO Selection" gewählt wurden: 

 Einfacher Linksklick: schickt den DXSpot zum VFO-A. 
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 Shift + einfacher Linksklick: schickt den DX-Spot zum 
VFO-B. 

o SO2V + "Advanced SO2V VFO Selection":
 Einfacher Linksklick 

 Wenn beide VFO's nicht auf dem gleichen Band sind, wird 
der DXSpot an den aktiven VFO geschickt.  

 Wenn ein VFO auf diesem Band ist, wird der DXSpot an 
diesen VFO geschickt. 

 Shift + einfacher Linksklick:  die VFOs werden vertauscht 
o SO2R + "SO2R Focus Follows Spot": 

 Der Transceiver, an den der DXSpot geschickt wird, wird der 
aktive Transceiver. Ist diese Option nicht gewählt, wird der 
Fokus nicht geändert. 

 Einfacher Linksklick: 
 Falls beide Transceiver nicht auf dem Band sind, wird der 

DXSpot an den inaktiven Transceiver geschickt. 
 Ist einer der Transceiver auf dem Band, wird der DXSpot 

an diesen Transceiver geschickt.
 Shift + einfacher Linksklick: Tauscht die VFO-Wahl 

gegeneinander aus 
o Doppelklick: Der aktive VFO wird auf diese Frequenz gesetzt und das 

Rufzeichen in das Rufzeichenfeld eingetragen. Ein dort stehendes 
Rufzeichen wird überschrieben. 

• Linksklick in eine Spaltenüberschrift: Sortiert die Spalte aufsteigend, nach 
einem zweiten Klick absteigend. 

8. Rechtsklick-Menü (Right-Click menu)

Mit einem Rechtsklick in das Available-Fenster öffnet sich ein Menü: 

• Delete Spot: Löscht markierten DXSpot nach einem Rechtsklick auf ein 
Rufzeichen in der Liste 

• Advanced SO2V VFO Selection (radio dependent): Legt fest, wie sich beim 
SO2V ein einfacher Linksklick auf einen DXSpot in der Bandskala auswirkt 
(siehe oben). Die Option ist grau und unwirksam, wenn kein SO2V gewählt 
wurde. 

• Enable right click QSY on spot: Wenn aktiv, wird der inaktive VFO nach 
einem Rechtsklick auf einen DXSpot programmiert, aber der Eingabefokus 
ändert sich nicht. 

• SO2R Focus Follows Spot: Legt fest, wie sich beim SO2R-Betrieb ein 
Linksklick auf ein Rufzeichen in der Bandskala auswirkt (siehe oben). Die 
Option ist grau und unwirksam, wenn kein SO2R gewählt wurde. 

•
• Turn Rotor:  Der Rotor dreht die Antenne in Richtung dieses Rufzeichens 

Die restlichen Tasten funktionieren immer:  

• 1 - Show Focus Radio/VFO: Zeige nur DXSpots, die sich auf den aktiven 
VFO/Transceiver beziehen 
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• 2 - Show Non-Focus Radio/VFO: Zeige nur DX-Spots, die sich auf den 
inaktiven VFO/Transceiver beziehen 

• 3 - Show Both Radios/VFOs:  Zeige alle DXSpots auf den Bändern, auf 
denen beide VFOs/Transceiver stehen 

• 4 - Show All Bands: Zeige alle Spots auf allen Bändern. 
• 160 – Zeige nur Spots auf diesem Band 
• 80 - Zeige nur Spots auf diesem Band
• 40 - Zeige nur Spots auf diesem Band. 
• 20 - Zeige nur Spots auf diesem Band. 
• 15 - Zeige nur Spots auf diesem Band
• 10 - Zeige nur Spots auf diesem Band
• Show Q's_Mults: Umschalten zwischen allen DXSpots und Nur-Multis 

• Help : Holt die Hilfe zu dieser Seite aus dem Internet 

Wenn Sie den Mauszeiger auf einen Spot setzen, werden verschiedene 
Informationen zu diesem Spot angezeigt (Frequenz, Spotter, Zeit und Kommentar).

Last Modification: 19 December 2009 06:52:12 EST by n4zr. 

QSO editieren (Edit Contact)

Wenn Sie ein QSO markieren und dann rechts anklicken öffnet sich das 
Editierfenster:  
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Mit diesem Fenster können Sie alle Daten eines abgespeicherten QSOs korrigieren 
oder ergänzen. Die Felder 'Country Prefix', 'Mult 1' und 'Mult 2' lassen sich nicht 
ändern, werden aber bei einer Re-Kalkulation neu belegt. 

Folgende Sendearten im Feld Mode sind erlaubt: 

CW, CW-R, LSB, USB, RTTY, rtty-L, rtty-U, RTTY-R, AM, FM, PSK31, PKT, PAC2, 
GTOR, FSK31, PSK31, PSK63, PSK125, MT63, DIGI, BPSK, bpsk, SSTV, mfsk-L, 
mfsk-U, MFSK, MFSK8, MFSK16, HFSK, MTTY, THRB, ASCI, HELL, Q15, PCW. 

Die Länderzuweisung spielt außer für die “claimed score” keine Rolle. Sie erscheint 
auch nicht im Cabrillo-Log. Es gibt auch keine Abzüge für fehlerhafte Angaben. Das 
Programm soll Sie aber auf benötigte Multis im Contest hinweisen. 

 Tipp 
Wenn das Programm sich weigert, ein QSO nach Ihren Wünschen zu loggen, dann 
loggen Sie es so, wie das Programm es wünscht und korrigieren Sie anschließend 
das QSO durch Editieren.

Beispiel: Eine KG4-Station gibt einen US-Staat als Kontrollnummer, N1MMLogger 
meint aber, es wäre Guantanamo und weißt die Eingabe ab. Geben Sie eine Zahl als 
Kontrollnummer ein und korrigieren Sie später das QSO. Der Fehler liegt in der 
Regel in der Datei CTY.DAT, die nicht auf dem neuesten Stand ist.

Wenn Sie vor dem Abspeichern eines QSOs mit Pfeil nach oben/unten zum 
nächsten QSO weiterschalten, werden Sie gefragt, ob die Änderungen übernommen 
werden sollen: 

 

• Yes:  JA, Änderungen speichern. 
• No : NEIN, Änderungen nicht speichern 
• Cancel : Zurück zum vorigen QSO, Änderungen werden nicht gespeichert.

Sie können eine Zeitgabe für das markierte QSO mit einem Thhmm im 
Eingabefenster korrigieren. Siehe Kapitel Nach dem Contest. 

1. Tastenzuordnungen (Button Assignments)

• Update: Übernehme die Änderungen und gehe zurück zu letzten QSO im Log
• Delete : Lösche das QSO aus dem Log. Sie werden um eine Quittung 

gebeten: 
 Yes, QSO wird die Datei DELETEDQS 'contest übergeben' 
 No, keine Löschung 
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o Im Multi-Nutzer-Modus können Sie nur an dieser Station gefahrene 
QSOs löschen, sonst erhalten Sie Mitteilung: 

 "You may not delete contacts logged by another station while in 
Multi-User mode. Ask station #radionumber to delete it. Delete 
not performed!" 

• Help : Holt die Hilfe für dieses Fenster aus dem Internet 
• Exit : Beendet den Editier-Dialog 
• Pfeil nach oben/unten: Gehe zum nächsten QSOs nach oben/unten 

2. Wie wird ein QSO dauerhaft gelöscht (How to permanently delete a 
contact?)

• Ein QSO löschen: 
o Markieren Sie das QSO im Log und klicken Sie auf Delete. Sie werden 

um eine Quittung gebeten: 
 Yes, QSO wird die Datei DELETEDQS 'contest übergeben' 
 No, keine Löschung 
 Sie können immer nur ein QSO auswählen.  

 

• Alle QSOs löschen: 
o Wählen Sie DELETEDQS 'contest' nach der Funktion Open Log in 

database im Menü File.
o Löschen Sie "DELETEDQS" contest mit der Entf-Taste auf der 

Tastatur. Sie werden um eine Bestätigung gebeten.  

3. Wie kann ein gelöschtes QSO wieder hergestellt werden? (How to 
recover a deleted QSO?)

Das geht nicht so einfach. Sie können die QSOs aus der Datei 'DELETEDQS' 
contest als ADIF-Datei ausgeben. Reduzieren Sie in einem Texteditor diese Datei 
auf das/die QSOs, die sie wiederherstellen wollen. Lesen Sie die ADIF-Datei 
anschließend mit der Import-Funktion in das aktuelle Contest-Log wieder ein.

Sie können auch den DELETEDQS-Contest öffnen, ein oder mehrere QSO mit links 
markieren und dann mit einem Rechtsklick den Menüpunkt 'Copy/ADIF String' 
wählen, der das/die QSO(s) in die Zwischenablage bringt. Anschließend öffnen Sie 
das aktuelle Contestlog und wählen dort 'Paste contacts'.
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4. Warum umspeichern und nicht löschen? (Why move and not delete?)

Ein gelöschtes QSO ist nicht unwiederbringlich verloren. Es wird in die Datenbank 
DELETEDQS-Contest geschickt, aus der es – wenn nötig – wieder geholt werden 
kann. Nur wenn das Log DELETEDQS als Ganzes gelöscht wird, ist das QSO 
endgültig verloren. Ein Grund für die Umspeicherung eines gelöschten QSOs ist das 
Verhalten von Microsoft-ACCESS, das einen einmal belegten Speicherplatz erst 
wieder freigibt, wenn das Compact-Kommando gegeben wurde. Da kann ein QSO 
auch umgespeichert werden.

Last Modification: 01 October 2009 09:49:49 EDT by n4zr. 

Info-Fenster (Info)

Das Info-Fenster sieht etwa so aus: 

 

Sie können das Info-Fenster mit dem Menü Window > Info öffnen. 

1. Überblick (General)

Sie erhalten folgende Informationen:  

• Eigenes Rufzeichen und zu sendende Kontrollnummer im Kopf 
o Bei einem Nummerncontest wird die nächste zu sendende 

Kontrollnummer angezeigt z.B. 59 002
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• Zeile 1: Rufzeichen aus der Bandskala, dem Rufzeichenfeld oder dem 
Rufzeichen darüber. Falls keins zutrifft, wird das letzte Rufzeichen genommen 

• Zeile 2 und 3: Länderinformation, Zone, Kontinent, Antennenrichtung SP, 
Entfernung in Meilen und km, Antennenrichtung LP 

• Zeile 4: Sonnenauf-/untergang, Lokalzeit bei der Gegenstation
o Für K, VE, UA und VK wird wegen der verschiedenen Zeitzonen keine 

Lokalzeit angezeigt
• Zeile 5 : Nachrichten aus dem Packet-Fenster (Announces, Talk u.a.)
• Zeile 6: WWV-Nachrichten und WWV-Statistik

• QSO-Raten:
o Raten (links):  aktuelle Rate / Zielrate / Bandwechselinformation 

 Die Bandwechselinformation und der Bandzähler werden 
versteckt, wenn Single- oder Multi-Multi-Betrieb eingestellt ist. 

 Aktuelle QSO-Raten in Echtzeit 
 Taste für den Import und die Einstellung von Zielvorgaben

o Graph (Mitte): Zeigt die Daten als Balkendiagramm (QSO-Zahl, 
Stundenrate, Durchschnitt für 30 oder 60 Minuten) 

o Anzeige des Aufzeichnungspegels (Mitte) für das Mitschneiden von 
QSOs. Die Funktion 'Record QSOs' im Menü  'Tools' muss dazu aktiv 
sein. 

o Info-Bereich (rechts)
 Rufzeichen des aktuellen Ops rechts unten fett. Einstellen mit 

Ctrl+O. 
 Bandwechselzähler abhängig vom Contest und der Sektion 

 10 min: Zählt rückwärts nach Bandwechsel 
 Beginnt mit dem Zählen erst nach dem ersten 

Bandwechsel 
 Ein Stopplicht gesteuert vom Zähler leuchtet grün/gelb/rot 

vor einem farbigen Hintergrund
• Mult-Run-Anzeige : Zeigt MULT oder RUN beim Multi-One oder 1 oder 2, 

wenn Multi-Two gewählt wurde 
o Nur angezeigt wenn Multi-User und Operator Category = Multi-One 

gewählt wurde 
o Multiplier oder Run-Station kann mit Ctrl+Alt+M hin und her geschaltet 

werden

• Multi-User Section:  Zeigt die Multi-User-Information (siehe unten)
o Wird nur angezeigt wenn Multi-User Mode gewählt wurde 

• Nachrichten-Bereich 
o Computername, IP-Adresse und Port, wenn Multi-User. 
o Winkey-Version  
o Nachrichten von anderen Stationen im Netz werden groß dargestellt, 

um sie besser lesen zu können 
o Pass- Frequenzen > 100000 kHz werden ohne Dezimalpunkt 

angezeigt. 
o Wenn Sie von einer Station außerhalb des Netzes gespottet werden, 

werden Spotter und Kommentar angezeigt. Ein netter Gag ?! 
o Usw.
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2. Mauszuordnungen (Mouse Assignments)

• Klicken Sie rechts in einen der Teile des Fensters. Der Klick auf ein Objekt 
schaltet die Anzeige ein oder aus, Einige Teile haben ihr eigenes Menü:

o Gespottetes Rufzeichen oberhalb des Eingabefeldes: Zeigt Land und 
Info zu der gespotteten Station. 

o CountryInfo: Zeigt Land der Station im Rufzeichenfeld 
o Sunrise/Sunset: Sonnenauf-/untergang und Lokalzeit der Station im 

Rufzeichenfeld 
o Messages: Talk-Nachrichten aus dem Packetfenster 
o WWV Messages: WWV-Meldungen 
o Rates Section: Anzeige der QSO-Raten
o Multi-User Section: Anzeige der Multi-Nutzer 
o Help: Holt die Hilfe für dieses Fenster aus dem Internet
o Clear Message Window: Löscht die Nachrichten im Info-Fenster 

Wenn Sie im Multi-Nutzer-Modus auf das rote oder grüne Icon klicken, öffnet sich ein 
neues Menü. Siehe unten.. 

3. QSO-Raten (Rate information section)

Im mittleren Teil des Info-Fensters werden die QSO-Raten angezeigt. Bei der 
Anzeige werden DUPE-QSOs mitgezählt. Bei null QSOs wird nichts angezeigt. Die 
folgende Information wird angezeigt:

• Linke Teil
o Überschrift + Angabe QSOs je Multi (x mult = y.y Q's) 
o Rate der letzten 10 QSOs in QSOs je Stunde 
o Rate der letzten 100 QSOs in QSOs je Stunde 
o Rate der letzten laufenden Stunde ab hh:mm in QSOs je Stunde 
o Rate der letzten vollen Stunde ab hh:00 in QSOs je Stunde 

• Mittlerer Teil
o Balkenanzeige der QSO-Rate der letzten 60 Minuten 
o Pegelanzeige für die QSO-Aufzeichnung. Nur aktiv bei eingeschalteter 

Aufnahme 'Record QSOs' im Menü 'Tools'. 

• Rechter Teil 
o Band Chgs: Zahl der Bandwechsel seit Contestbeginn bei Multi-Single-

Betrieb:
 Wird mit Beginn der Stunde auf Null gesetzt und ist frei
 Zählt die Bandwechsel bei jedem Computer nur bei Multi-Two 
 Bandwechsel werden nicht gezählt, wenn die gearbeitete Station 

auf einem anderen Band ein neuer Multi war 
o xx min Bandzähler: Zählt rückwärts von xx Minuten nach 0 und wird 

bei jedem Bandwechsel und dem ersten QSO dort wieder auf den 
Anfangswert gesetzt. 

 Hinweis: Es gibt nur einen Bandzähler und der läuft bei der 
RUN-Station. Die Multi-Station muss manuell auf die Zeit achten. 
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Farben des Fensterhintergrunds: Der Hintergrund wechselt in Abhängigkeit von den 
vorgegebenen Contestzielen für die QSO-je-Stunde-Raten (Goal) seine Farbe

• Rot - < 50% des Ziels 
• Gelb - < 51-99% des Ziels 
• Grün - 100+% des Ziels 

4. Tasten

• Import Goals: Verwenden Sie diese Taste, um Ihre Vorgaben für die zu 
realisierenden QSO-Stundenraten für diesen Contest einzutragen. Sie können 
die Vorgaben aus einer Textdatei importieren oder zum Druck oder als 
Textdatei ausgeben.  

• Goal =  Editieren Sie die Stundenraten manuell. Die Stunden sind von 0 bis 
23 durchnummeriert. Fehlt eine Stunde, wird die nächst niedrige genommen.

5. Echtzeitgrafik der QSO-Raten (Real Time graphical rate display)

Die grafische Ausgabe unterstützt den Operator oder das Contest-Team bei der 
Entscheidung zu einem Band-, Sendearten- oder Antennenwechsel usw.

• In der Grafik werden die QSO-Raten über eine kürzere Zeit visuell 
ausgegeben. Die Skala ist nicht geteilt, genauere Werte stehen in den 
Fenstern links davon. Im Fenster wird die Zielvorgabe als schwarze Linie 
eingeblendet um auf einen Blick zu sehen, ob die aktuelle QSO-Rate über 
oder unter der Zielvorgabe liegt. 

• Mit einem Rechtsklick können Sie die Eigenschaft der Grafik wählen:  
o Länge der angezeigten Periode: 30 oder 60 Minuten 

 Anzahl der Balken: 6, 10, 15 oder 20  
 Jeder Balken steht für die in dem Zeitbereich erreichte QSO-Zahl 

über die letzten 10, 20 oder 30 Minuten 
• Die Balken gelten für die aktuelle Station. Beim SO2R-Betrieb haben die 

Transceiver 1 und 2 unterschiedlich gefärbte Balkens für beide Geräte. Beim 
Multi-Betrieb werden die Raten der anderen Station NICHT angezeigt, auch 
wird kein Unterschied bei mehreren Ops an einer Station gemacht. 

• Die Anzeige erfolgt nahezu in Echtzeit und benötigt kaum eine zusätzliche 
Rechenleistung. Sie läuft auch auf langsameren Rechnern.

• Die Anzeige startet erst, wenn QSOs abgewickelt werden. 

6. Zielvorgabe für einen Contest einstellen (Setting a goal for the contest)

Die meisten Stationen wollen beim aktuellen Contest mehr QSOs als beim gleichen 
Contest im letzten Jahr machen. Sie können sich für den aktuellen Contest Vorgaben 
machen, die Sie einhalten möchten. Sie können die QSO-Zahlen des Vorjahres-
Contests importieren und sie nach oben korrigieren. 

Haben Sie den Contest vom Vorjahr in der aktuellen Datenbank kann das Programm 
die QSO-Zahlen berechnen und anzeigen. Diese Werte können Sie als Vorgabe für 
den aktuellen Contest übernehmen und anpassen.
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7. QSO-Zahlen einstellen (Setting the QSO numbers)

Sie müssen vorher den neuen Contest mit 'File, Open Log in Database' eingerichtet 
haben. Rufen Sie im Info-Fenster den Zielvorgaben-Import (Goal Import) auf:. 

 

• Wählen Sie die Taste  'Import Goals' im Info-Fenster, um die Daten aus 
einem Log oder einer Textdatei zu importieren: 

o Import Bands 
 Wählen Sie alle Bänder (All) oder 160m, 80m, 40m, 20m, 15m 

und/oder 10m 
o Log: Importiert die Daten von einem früheren Contest

 Wählen Sie 'Choose a File' und markieren Sie das Log 
des gewünschten vorherigen Contest oder  

 Wählen Sie einen Contest mit ‚Select Contest'. 
 Sie können auch die Zahlen eines anderen Contests 

verwenden 
o Text File:  importiert die Vorgaben aus einer Textdatei

 Die Daten können in der Textdatei durch Zwischenräume (*.txt) 
oder Komma (*.csv) abgetrennte Daten verarbeiten 

 Wählen Sie die Datei im Dateimenü aus 
 Die Datei muss für ‚Allband’ so organisiert ein: 1.Feld 

Tag/Stunde im Format dhh (von 100 bis 323) und im 
2.Feld die stündliche Allband-Rate 

 Die Datei muss für den  bandweisen Import so organisiert 
sein: 1.Feld Tag/Stunde im Format dhh und in den 
folgenden Feldern die Stundenraten für die Bänder 160, 
80, 40, 20, 15 & 10. 

• Mit einem Klick auf die Taste 'Goal ' können Sie Stundenraten von Hand in 
die Tabelle eintragen. Ohne Import ist die Tabelle leer.  

o Die Tagangabe d kann 1,2 oder 3 betragen, die Stundenangabe hh von 
0 bis 23. 

o Die Tagangabe d ist der laufende Tag eines Contest. Die Stunde hh ist 
die UTC-Stunde des aktuellen Contests, z.B. der ARRL Sweepstakes 
beginnt sonnabends um 2100z. Die erste Stunde ist also 121. Die letzte 
Stunde der Sweepstakes ist am Montag um 0200z, also 302. 

o Die Zielvorgaben können von Hand eingegeben werden. Die 
Zielvorgaben gelten immer so lange bis für eine neue Stunde neue 
Vorgaben gemacht werden.  
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o Beispiel: 112 steht für den ersten Tag 12h UTC. Der letzte Eintrag gilt 
für den zweiten Tag um 09 UTC. 

 
 Tipp 

Die Zielvorgaben gelten für die jeweilige Datenbank und NICHT für einen einzelnen 
Contest in einer Datenbank. Für mehrere Conteste in einer Datenbank können keine 
contestbezogenen Vorgaben gemacht werden. Am besten, Sie verwenden je 
(großen) Contesttyp getrennte Datenbanken. 

8. Multi-Nutzer-Information (Multi-User information)

8.1. Überblock (General)

Im unteren Teil des Info-Fensters werden alle während eines Contests benötigten 
Informationen ausgegeben. Diese Information sieht so aus: 

 

• Stations-Icon rot oder grün
o Grün:  Verbunden 
o Rot:  nicht verbunden
o Hellles Rot: das Programm war nicht in der Lage, die andere Maschine 

für eine gewisse Zeit zu erreichen 
 Das Programm bemüht sich, die Verbindung wieder 

herzustellen. Ist sie wiederhergestellt, wird die Anzeige wieder 
grün und alle ist OK. 

 Wenn diese Anzeige während eines Contests auftritt, liegt das 
möglicherweise an zuviel HF im Shack oder auf den 
Netzwerkkabeln 

o Ein rechter Klick auf die Icons öffnet ein Menü
• Station 

o Name der Station, eingegeben unter Config > Edit Station Computer 
names' 

• Pass frequency 
o Frequenz, auf der die Station gemeldete (passed) Stationen zu 

empfangen wünscht 
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o Pass frequencies > 100000 kHz (=über 100 MHz) wird kein 
Dezimalpunkt angezeigt 

• Run 
o Aktiv > die Station arbeitet im RUN-Modus 
o Nicht aktiv: die Station arbeitet im Modus Searching & Pouncing 

• Operator 
o Operator an der Station 
o Das Rufzeichen wird ROT, wenn gesendet wird

• Last 10 
o QSO-Rate in Qs/h für die letzten 10 QSOs

• Last 100 
o QSO-Rate in Qs/h für die letzten 100 QSOs 

• Current Freq 
o Arbeitsfrequenz
o Anzeige der Sendeart wie CW, SB, FM (nur bei mixed) 

* 

8.2. Mauszuordnungen (Mouse Assignments)

• Ein Rechtsklick auf das rote oder grüne LED-Icon öffnet ein Menü 

• Call for Help (Ruf um Hilfe): Bei der ausgewählten Station erscheint diese 
Meldung:  "Station x needs assistance". Bei der angewählten Station 
wird die Datei Assist.wav abgespielt. Der rufende OP kann ohne aufstehen 
zu müssen einen Hilferuf absenden. 

• Help: Holt die Hilfe für dieses Fenster aus dem Internet 
• Send Message: Schickt eine Nachricht an die ausgewählte Station. Die 

Nachricht erscheint rot im Infofenster der adressierten Station. 
• Target for Call stacking : Das Rufzeichen wird in den Stapelspeicher 

geschickt. Einzelheiten zu dem Stapelspeicher finden Sie im Kapitel 
Logeingabefenster. 

• Pass current/last QSO : Setzt das laufende QSO in das Eingabefenster 
oder nimmt das letzte QSO, wenn das Eingabefenster leer ist.

• Show Status : Zeigt den Verbindungsstatus für alle Verbindungen an:  

 

• Close Connection : Beendet die Netzwerkverbindung für die eigene Station 
• Open Connection : Öffnet die Netzwerkverbindung für die eigene Station. 

Geht nur wenn der Status mit rot angezeigt wird. 
• Prevent Automatic Reconnect Attempts: Verhindert automatische Versuche 

zur Wiederherstellung einer Verbindung. Das Programm versucht es sonst 
aller 30 Sekunden.
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Last Modification: 01 October 2009 09:48:53 EDT by n4zr. 

Ergebnisse (Score)

Unten sehen Sie Ergebnislisten für drei verschiedene Conteste. Sie werden 
abhängig von der Contestausschreibung erzeugt:  

CQWWSSB PACC VHFREG1 

 

 

 

Öffnen Sie zum Ansehen der Ergebnisliste das Menü Windows > Score 
Summary. Sie können die Ergebnisliste den ganzen Contest über mitlaufen lassen. 
Es zeigt den jeweils aktuellen Stand. Die Liste wird auch aktualisiert, wenn Sie QSO 
hinzufügen oder streichen. 

Die Liste links gehört zu einem Contest in einer Sendeart, in der Mitte lief ein Contest 
im Mixed-Mode und rechts ist ein europäischer UKW-Contest (2m) zu sehen.  

1. Mauszuweisungen (Mouse Assignments):

• Mit einem rechten Mausklick öffnet sich ein Menü: 
o Copy all:  Kopiert die Ergebnisliste in die Zwischenablage
o Print to file:  Die Ergebnisliste wird in eine Datei geschickt 
o Help:  Holt die Hilfe zu diesem Fenster aus dem Internet 

Last Modification: 04 October 2009 06:08:40 EDT by K8UT. 

Multis je Band (Multipliers by Band)

In diesem Fenster können Sie sich die je Band erreichten Multis ansehen:
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Öffnen Sie das/die Multifenster über das Menü Windows> Multipliers oder 
Ctrl+J aus dem Logeingabefenster. Je nach Contest werden die erreichten Multis 
(rote Felder) und die noch nicht erreichten Multis (weiße Felder) angezeigt. Was 
genau angezeigt wird, hängt von den Contestbedingungen ab. Oben sind die Länder 
Europas und die erreichten Zonen über alles zu sehen. Die Kontinentlisten sind über 
die Karteikartenreiter oben im Fenster auswählbar. Bei zu großem Angebot können 
Sie mit dem Scrollbalken unten die Tabelle durchsehen. 

Bei den meisten Contesten werde alle möglichen Multis angezeigt. Ist bei einem 
Contest die Zahl der möglichen Multis deutlich größer als die Zahl der erreichbaren 
wie beim IOTA-Contest werden nur die erreichten Multis angezeigt. Die neuen Multis 
werden dann in einer neuen Zeile eingetragen.

Unbekannte Sektionen werden geloggt, aber im Rufzeichenbereich mit UNK 
markiert.

• Die Anzahl der Blöcke per Band hängt von der verwendeten Sendeart ab. 
o CW, SSB, RTTY : je Band ein Block 
o MIXED : zwei Blöcke je Band, weiß = CW, grau = SSB 

• Die Zahl der Bänder hängt ab
o Vom ausgewählten Contest, meist 6 Bänder 
o Von der Filterbox im Dialog Multiplier by Band unten im Multifenster 

• Die Filterbox hat zwei Bereiche: Bänder links und Sendearten rechts. Durch 
die Kombination der Einstellungen ergeben sich verschiede Anzeigevarianten. 
Sie werden bei der Einrichtung des Contests voreingestellt. 

• Beispiele:  
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o Bänder (links): Auto + Sendearten (rechts): Auto 
 Meist werden alle 6 HF-Bänder angezeigt(160 80 40 20 15 10) 
 Zwei Blöcke je Band bei Mixed

o Bänder: HF+WARC + Sendeart: SSB , z.B. bei Dxpedition
 9 Blöcke (160 80 40 30 20 17 15 12 10) 

o Bänder: HF+WARC + Sendeart: Mixed , z.B. bei Dxpedition
 18 Blöcke jeweils CW und SSB und die Bänder(160 80 40 30 20 

17 15 12 10) 

• Überblick zu den WWLokatoren (Grid square)
o Wird bei UKW-Contesten angezeigt
o Wenn Sie auf ein Großfeld klicken, wird die Darstellung auf dieses Feld 

zentriert 
o Das eigene Großfeld wird weiß oder dunkelgrün angezeigt 

1. Tastenzuordnungen (Keyboard Assignments)

• Ctrl+J : Schaltet zwischen Länderlisten, Zonen, Sektionen u.a. durch
o Wenn das Multifenster noch nicht geöffnet ist, wird es geöffnet 

• Ctrl+Shift+J : Öffnet oder minimiert das Fenster Multiplier-by-band 
• Ctrl+Alt+J : Schaltet die Kontinente durch 

2. Mauszuordnungen (Mouse Assignments)

• Linksklick auf Multis/Abkürzungen 
o Wenn Sie auf Abkürzungen klicken, wird im Logeingabefenster das 

Eingabefenster mit der richtig geschriebenen Bezeichnung gefüllt. Ein 
bereits dort stehender Eintrag wird überschrieben. Seien Sie 
aufmerksam! 

o Funktioniert nur in (US-internen) Contesten, bei denen das 
Kontrollnummernfeld 1 für Counties oder Sektionen verwendet wird. 

• Rechtsklick in das Fenster öffnet ein Menü: 
o Show Zones/Countries : 

 Länder (Countries) angewählt: Die Zone für das Land wird 
angezeigt 

 Zone angewählt: Die zu der Zone gehörenden Länder werden 
angezeigt 

o Show Calls Worked: Zeigt alle Rufzeichen aus diesem Land oder 
dieser Zone 

o Set Grid center: Es öffnet sich ein Fenster, in das Sie einen 
WWLokator vierstellig eintragen. Auf diesen Lokator wird die Anzeige 
zentriert. 

o Help: Holt die Hilfe für diese Seite aus dem Internet 

3. Transceivertastenzuordnung (Radio Button Assignments)

• Country:  Zeigt die auf dem gewählten Band gearbeiteten Länder 
• ZN : Zeigt die auf dem gewählten Band gearbeiteten Zonen 
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• Sect: Zeigt die auf dem gewählten Band gewählten Sektionen
• Other: Zeigt andere mögliche Multis, die auf dem gewählten Band gearbeitet 

wurden 
o in UKW-Contesten wird ein Überblick der WWLokatoren angezeigt 

• Auto:  Bänder-Filter (links) 
o Auto : Zeigt alle im Contest möglichen HF-Bänder, in der Regel 6 
o HF : zeigt die 6 HF-Bänder
o VHF : zeigt alle UKW-Bänder ab 50 MHz aufwärts 
o HF + WARC : zeigt alle HF-Bänder einschließlich der WARC-Bänder 
o All separate bands: zeigt einzelne Bänder ab 1.8, 3.5, 7 ....bis zu 241 

GHz 
• Auto : Sendearten-Filter (rechts)

o Auto : zeigt die zum Contest gehörende Sendeart (CW, SSB, Mixed, 
Digi) 

 Ein Block je Band, wenn nur eine Sendeart gewählt wurde 
 Zwei Blöcke je Band bei Mixed (CW/SSB). 

o CW : nur CW-QSOs 
o SSB : nur SSB-QSOs
o Dig : nur Digimode-QSOs 
o Rev : abwechselnd CW oder SSB, ein Block je Band

• Reset: setzt beide Filter zurück auf Auto 

4. Farben (Colors)

• Weiss: noch nicht gearbeitet
• Rot : Gearbeitetes Land/Zone/Großfeld 

Last Modification: 04 October 2009 06:09:11 EDT by K8UT. 

Statistik (Statistics)

Öffnen Sie die Statistik mit dem Menü View > Statistics aus dem Logeingabefenster 
heraus. Sie können die Statistik während des Contests oder nach einem Contest 
erzeugen. 

 Tipp 
Wenn Sie das Fenster während des QSO-Fahrens öffnen, geben Sie ruhig das 
Rufzeichen auf der Tastatur ein. Das Statistikfenster wird in den Hintergrund 
geschoben und die Zeichen landen im Rufzeichenfeld. 

1. Überblick (General)

Sie können mit dem Statistikfenster fast alle Daten aus der Datenbank des Contests 
auswählen und sich in einem Fenster anzeigen lassen. Diese Felder können Sie 
selektieren:  

Felder Zeile Spalte Bemerkungen 
Band Y Y
Operator Y Y OP-Vergleich, sinnvoll nur bei Multi-Operator-Betrieb 
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Hour Y N
RadioNr Y Y Nur sinnvoll bei mehreren Transceivern 
Mode Y Y Bei Contesten im Mixed-Modus 
CountryPrefix Y N worked number of stations per country or mode 
Zone Y Y
Section Y Y Kann auch ARRL-Sektion, Oblast, Provinz.. sein 
CK Y N Zweistellige Zahl in Sweepstakes, Jahr der Erst-Lis
Prec Y Y "Precedence" in Sweepstakes, Eintrittsklasse 
Points Y Y
Mult1 Y Y Multi 1 im Contest (z.b. Country)
Mult2 Y Y Multi 2 im Contest (z.B. Zone)
Mult3 Y Y Multi 3 
WPXPrefix Y N
GridSquare Y Y 4-stelliger WWLokator 
Run1Run2 Y Y Bei SO2R verwendbar 
MiscText Y N Contest-Info 
ContactType Y Y Leer = QSO, "D" = dupe, "N" = nicht arbeitbar 
Day Y Y Tag des Contests (1..3)
Mult & Band Y Y
Exchange1 Y Y z.B: QTC im WAE

2. Tastenzuordnung (Button Assignments)

• Row : Wähle eine Zeile 
• Column : Wählen eine Spalte 
• Refresh ; Auffrischen der Anzeige nach neuen oder geänderten QSOs 

3. Datei-Menü (File Menu)

• Print : Statistik wird auf einen Drucker ausgegeben. Schrifttyp wählbar. 
• Print to File : Tabelle in Datei abspeichern 

4. Beispiel für eine Statistik (Example statistics)

Row Column Usage Description 
CountryPrefix Band Always QSOs per country per band 
Hour Operator Multi User QSOs per hour per operator 
Band Operator Multi User QSOs per band per operator 
GridSquare Band Grid contests QSOs per gridsquare per band 
Band Exchange1 WAE and some other Show RQTC & SQTC info
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Last Modification: 03 October 2009 11:41:40 EDT by K8UT. 

Doppelübersicht (Visual Dupesheet)

Öffnen Sie die Doppelübersicht mit dem Menü Windows > Visible Dupesheet

 

Mit der Doppelübersicht können Sie ohne Eingabe des Rufzeichens in das 
Rufzeichenfeld sehen, ob Sie eine Station schon gearbeitet haben. Diese Darstellung 
ist besonders für schnelle und kurze Conteste wie den NA-Sprint gedacht. Die 
Tabelle ist nach Ziffern im Call geordnet.

• Jeder VFO/Bandskala hat seine eigene Doppelübersicht bezogen auf das 
Band, in dem der VFO steht. Es werden zwei Übersichten angezeigt, auch 
wenn VFO-B nicht benutzt wird. Schließen Sie die nicht benötigte-

• Die 10 Spalten laufen von 1 bis 9,0. Ist eine Spalte voll, wird sie in der 
Nachbarspalte getrennt mit einer gestrichelten Linie fortgesetzt. 

• Innerhalb der Spalte sind die Rufzeichen nach dem Suffix geordnet.  
• Wollen Sie die Doppelübersicht eines bestimmten Bandes sehen, stellen Sie 

den VFO auf dieses Band. 
• Suchen Sie nach Doppel-QSOs gehen Sie in die Spalte, sehen Sie dann nach 

dem Suffix und dann nach dem Prefix 
• Bei RTTY brauchen Sie die Doppelübersicht nicht. Dort werden Dupes schon 

im RX-Fenster markiert. 
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• Die Doppelübersicht reicht für maximal 600 Station je Band. Danach erfolgt 
eine Fehlerausschrift. Bei langsameren Rechnern kann ab 300 Rufzeichen die 
Anzeige verzögert erfolgen.  

• Es gibt KEINE Mauszuordnungen oder Menüs. 
• Die Doppelübersicht ist nicht für Mixed-Betrieb und für Conteste, in denen die 

Station nur einmal unabhängig vom Band gearbeitet werden darf (ARRL 
Sweepstakes) geeignet. 

Last Modification: 12 December 2009 17:38:48 EST by n2ic. 
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Digitale Sendearten (Digital Modes)
Übersicht zu RTTY und PSK31 (General RTTY and PSK Information)

N1MMLogger kann zusammen mit den Programmen MMTTY und MMVARI in 
RTTY und PSK31 und/oder mit einem externen TNC in weiteren Sendearten für 
Conteste eingesetzt werden. 

1. RTTY-Einstellungen (RTTY Information)

Wählen Sie an Ihrem Transceiver diese Einstellungen: 

• Audio processing (Kompressor, Höhenanhebung, Equalizer) : aus  
• Wählen Sie für Tastung in AFSK die Einstellung LSB 
• Für RTTY und (A)FSK-Tastung je nach Transceiver FSK, AFSK, LSB-D, PKT-

LSB, ... 
• Baudrate: 45,45 Bd
• Shift: 170 Hz , je nach TNC auch 200 Hz 
• Setzen Sie am TNC 'Mark' auf 2125 Hz und 'Space' auf 2295 Hz 
• Stellen Sie den NF-Pegel bei AFSK-Tastung so ein, dass die ALC gerade 

nicht mehr anspricht
• Nehmen Sie die Ansteuerung auf etwa 50% zurück, um die Endstufe zu 

schonen 
• Lesen Sie das Kapitel Interfacing und die dortigen Tipps 
• Stellen Sie die Empfangsbreite auf 250 - 500 Hz ein. 

1.1. Übliche RTTY-Frequenzen (Common RTTY Frequencies)

Contests USA (kHz) USA (kHz) Europe/Africa 
(kHz)

Japan 
(kHz) 

Common Common DX 
frequency Common Common 

1800 - 1810/1835 - 
1845 1800 - 1810 1838 - 1843 1838 - 1843

3570 - 3600 3580 - 3600 3590 3580 - 3620 3520 - 
3530 

7025 - 7100 7025-7050/7080 - 
7100 7040 7035 - 7045 7025 - 

7040 
10120 - 10150 10140 - 10150

14060 - 14120 14080 - 14100 14080 - 14100
18100 - 18110 18100 - 18110

21060 - 21150 21080 - 21100 21080 - 21120
24910 - 24930 24920 - 24930

28060 - 28150 28080 - 28100 28050 - 28150
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1.2. Übersicht zu RTTY (General RTTY Information)

Der 5-Bit-Baudot-Kode mit seinen 25=32 Möglichkeiten erlaubt die Darstellung von 26 
Buchstaben und 6 Steuerzeichen. Mit zwei Steuerzeichen wird zwischen dem 
Buchstabenregister (Bu/Ltrs) und dem Zahlenregister (Zi/Figs) hin und her 
geschaltet, um einen weiteren Zeichensatz mit den 10 Ziffern und 16 Sonderzeichen 
(Punkt, Komma, Fragezeichen usw.) zu ermöglichen. 

Bei QRM kann es vorkommen, dass ein Zeichen zur Registerumschaltung verloren 
geht. Dann werden Buchstaben als Ziffern oder Ziffern als Buchstaben ausgegeben. 
Ein Rapport von 599 erscheint dann als TOO und 73 als UE. Das gleiche gilt für 
Seriennummern in Contesten. 

Sie können bei MMTTY die Registerumschaltung von Hand auslösen. Eine weitere 
Einstellmöglichkeit bietet die Option „Unshift on Space (UOS)“, die automatisch bei 
einem Zwischenraum, der in beiden Registern gleich kodiert ist, in das 
Buchstabenregister zurückschaltet. N1MMLogger bietet weiterhin die Möglichkeit der 
Überkreuzdekodierung, wenn man den Mauszeiger auf den unverständlichen Text 
setzt. Verwenden Sie beim normalen QSO die UOS-Funktion, aber schalten Sie 
diese bei einem Contest ab, bei dem vorzugsweise Zahlen ausgetauscht werden.

2. PSK Information

2.1. Übersicht zu PSK (General PSK info)

Wenn Sie in PSK arbeiten wollen:  

• Halten Sie die Macros kurz!. 
o PSK ist um 1/3 langsamer als RTTY; verschlechtern Sie Ihre Datenrate 

nicht langen Macros 
• Verwenden Sie wo immer möglich Kleinbuchstaben! 

o PSK ist in einem Varicode kodiert. Kleinbuchstaben sind deutlich kürzer 
als Großbuchstaben. 

Stellen Sie Ihren Transceiver so ein: 

• Audio processing (Kompression, Höhenanhebung, Equalizer): aus 
• Wählen Sie die Sendeart USB oder eine passende Einstellung am 

Transceiver wie PSK, DATA-A o.ä. 
• Beachten Sie die Linearität Ihres Signals und vermeiden Sie eine 

Übersteuerung. PSK ist sehr empfindlich.
o Wählen Sie den AFSK-NF-Pegel so, dass die ALC noch nicht anspricht
o Wählen Sie einen Ausgangspegel der Endstufe von maximal 50% der 

möglichen Leistung 
o Informieren Sie sich im Kapitel Interfacing 

• Ein Abstand zu einer Nachbarstation von 100 Hz ist ausreichend
• RX-Filter : bis hinunter zu 100 Hz bei schwierigen Situationen, bis hinauf zu 

2,4 kHz bei der Suche nach Stationen. Im RUN-Modus können Sie 100Hz- 
oder 250Hz-Filter fest einschalten. 
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2.2. Übliche PSK- und Digimode-Frequenzen (Common PSK and 
Digital Frequencies)

Die PSK31-Aktivitätbereiche liegen in aller Regel am unteren Ende des jeweiligen 
Digimode-Bereichs im IARU-Bandplan. Eine Ausnahme ist nur das 10m-Band, um 
den US-Anfängerlizenzen eine Chance zu geben.. 

Band Digimode-Bereich (kHz) PSK Frequenzen (kHz) Bemerkungen 
160 meter 1800 - 1810 / 1838 - 1843 1807 / 1838 1807 in Region 2 
80 meter 3575 - 3585 3580 
40 meter 7030 - 7040 / 7060 - 7085 7035 / 7080 7080 in Region 2 
30 meter 10130 - 10145 10142 WARC, kein Contest 
20 meter 14065 - 14090 14070 
17 meter 18100 - 18110 18100 WARC, kein Contest
15 meter 21060 - 21090 21080 
12 meter 24920 - 24930 24920 WARC, kein Contest
10 meter 28110 - 28125 28120 
Last Modification: 28 December 2009 16:43:03 EST by ve3ki 

Überblick zu den digitalen Sendearten und Optionen (Digital  
Overview and Features)

Der Digimode-Teil von N1MMLogger wurde von Rick Ellison, N2AMG, 
programmiert und wird auch von ihm betreut.

1. Überblick (Digital Overview)

N1MMLogger kann dank seiner Flexibilität auch in zahlreichen digitalen Sendearten 
verwendet werden. Das Interface arbeitet mit MMTTY, MMVARI und allen externen 
TNCs zusammen. Dieses Kapitel gibt Ihnen einen Überblick über die digitalen 
Sendearten, die Tastaturfunktionen, die Macros usw. In den folgenden Kapiteln 
erhalten Sie Informationen zu   MMTTY  , MMVARI und externen TNCs. 

 Probleme? 
Gehen Sie zum Abschnitt für Digimodes bei den Frequently Asked Questions (FAQ) 

2. QSOs fahren (Making QSOs)

2.1. Ein digitales Signal erzeugen (Make a Digital Mode 
Transmission)

• Reduzieren Sie die anderen Fenster, speziell das Packet/Telnet-Fenster um 
Platz für das Fenster für das digitale Interface zu schaffen.

• Gehen Sie zum Menü Window > Digital Interface und öffnen Sie das Digitale 
Fenster (DI). Ziehen Sie das Fenster nach Größe und Anordnung an eine 
Stelle Ihrer Wahl.
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• Haben Sie MMTTY oder MMVARI gewählt, werden zwei Fenster geöffnet. Sie 
zeigen die MMTTY/MMVARI-Maschine und das Digitale Fenster (DI). Wenn 
Sie mit einem TNC arbeiten wird nur das Digitale Fenster geöffnet.

• Der empfangene Text wird im RX-Fenster (oben) ausgegeben. Mit einem 
Linksklick auf ein Rufzeichen wird dieses übernommen (Grab). Mit einem 
Rechtsklick in das RX- oder das TX-Fenster wird ein Menü geöffnet. 

• Mit der Taste Einfg (Insert) wird das hell getastete Rufzeichen übernommen 
und dieses Rufzeichen gefolgt von der Kontrollnummer gesendet.

• Ein Doppelklick auf ein Rufzeichen im Rufzeichenfeld des DI schickt das 
Rufzeichen in das Rufzeichenfeld des Logeingabefensters.

• Ein Rufzeichen wird im Empfangstext automatisch erkannt. Dazu muss die 
Zeichenkette mit einem Leerzeichen beginnen und mit einem Leerzeichen 
enden. Die erste Zeichenkette in einer Zeile wird nicht als Rufzeichen erkannt. 
Die roten und grünen Linien im Wasserfall zeigen den optimalen 
Empfangsbereich für RTTY-Signale an. Die rote Linie steht bei 1500 Hz und 
die grünen Linien bei 1000 und 2000 Hz.

• Der Zeitzähler im DI schickt bei über 5 Sekunden langer Inaktivität den Fokus 
zurück in das Logeingabefenster. Er wurde eingebaut, weil MMTTY/MMVARI 
dazu neigen, den Fokus in ihrem Fenster festzuhalten und nicht frei zu geben. 

2.2. Wichtig zu wissen (Digital Need to Know)

• Wenn das Rufzeichen im Logeingabefenster schon das Rufzeichen aus dem 
empfangenen Text enthält, wird das empfangene Rufzeichen nicht in die 
Rufzeichenliste im Digitalen Fenster gesetzt. 

 Fokus behalten 
Der Fokus wird automatisch an das Logeingabefenster gegeben, wenn ein 
Rufzeichen im RX-Fenster des DI angeklickt wird

• Mit gedrückter Ctrl (Strg)-Taste wird bei einem Einfachklick das Rufzeichen 
unter allen Umständen in das Rufzeichenfeld übertragen.

• Klicken Sie in das Feld des Logeingabefensters, in das Daten übertragen 
werden sollen. Halten Sie dann die Ctrl-Taste gedrückt und klicken Sie im RX-
Fenster des DI auf die Zeichenkette, die in das Fenster übernommen werden 
soll. 

• Im ESM-Modus wird mit der Leertaste der Fokus in das Logeingabefenster 
geschickt.

• "-" werden vom jeweils angeklickten Text z.B. Kontrollnummer entfernt 
• Die CQ-Wiederholzeit zählt von dem Augenblick 

o zu dem MMTTY oder MMVARI mit dem Senden aufhören 
o bei dem bei einem externen TNC mit dem Aussenden eines Textes 

begonnen worden ist, denn es gibt keine Möglichkeit den Augenblick 
festzustellen, bei dem der externe TNC mit senden aufhört.

• Zu dem Macro {RX} gehört automatisch eine Zeilenschaltung (CR/LF), um die 
Texte besser lesbar zu machen

• Während des Sendens können Sie keine Rufzeichen aus dem RX-Fenster 
des DI übernehmen.

• Empfangene Zeilenschaltungen (LF) im Text werden durch einen 
Wagenrücklauf (CR) ersetzt, um die Blockbildung im Empfangsfenster zu 
verhindern.
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 Auto-CQ mit einem TNC 
Stellen Sie die Wiederholzeit auf mindestens 9..10 Sekunden oder länger ein 
(abhängig von der Länge des CQ-Rufs), sonst schaltet das Programm gar nicht mehr 
auf Empfang. 

 TX-Puffer im TNC löschen
Ergänzen Sie Ihr Kommando zum Abbruch des Sendens um einen Löschbefehl für 
den TX-Puffer des TNCs. Sonst wird der Rest des Puffers beim nächsten 
Umschalten auf Senden vor den gewünschten Text gesetzt und gesendet. 

 CQ anhalten 
Schalten Sie die Option Config >Function Keys >Stop Sending CQ when 
Callsign changed auf Aus. Falls Sie die Option eingeschaltet lassen, wird bei jeder 
Eingabe eines Rufzeichens in das Rufzeichenfeld ein Abbruch-Kommando an den 
TNC gesendet. 

3. Tipps zum QSO-Fahren (Tips for Making QSOs)

Während des Contests laufen alle Daten wie Rufzeichen und Kontrollnummern im 
Digitalen Fenster (DI) ein. Diese Daten müssen in die Felder des Logeingabefensters 
übertragen werden. Auch Ihre Sendungen müssen ausgelöst werden. Dazu können 
Sie wie in CW oder SSB die gleichen Tasten wie die Einf (Insert)-Taste verwenden. 
Im DI gibt es weitere Möglichkeiten wie die Rufzeichenliste, die GRAB-Taste, weitere 
Macros und den Rechtsklick mit der Maus.

3.1. Cursor-Aufsetz-Modus (Using Hover Mode)

• Halten Sie den Mauszeiger auf ein Rufzeichen im RX-Fenster des DI-
Fensters. Haben Sie die Option 'Right click send Enter' gewählt, wird dieses 
Rufzeichen in das Logeingabefenster geschickt, da Rufzeichen gesendet und 
durch die Kontrollnummer ergänzt (im RUN-Modus) oder Ihr Rufzeichen wird 
gesendet (im S&P-Modus). Klicken Sie dann links auf die empfangene 
Kontrollnummer. Sie wird in das Kontrollnummernfeld des Eingabefensters 
übernommen und mit einem Rechtsklick wird anschließend das TU (im RUN-
Modus) oder die eigene Kontrollnummer (im S&P-Modus) gesendet und das 
QSO geloggt. 

o Hinweis: Sie können Ihr eigenes Rufzeichen nicht aus dem RX-Fenster 
übernehmen, es ist sinnvollerweise gesperrt.  

o Der Cursor-Aufsetz-Modus wird in Zusammenhang mit der Option 
'Rt Click = Return NOT Menu' verwendet. Mit einem Rechtsklick in 
das DI wird ein Return bzw. ENTER ausgelöst und KEIN Menü 
aufgerufen. 

3.2. Der Ratenbeschleuniger (The Rate Improver ): Right Click = 
Enter NOT Menu

Aktivieren Sie den ESM-Modus und schalten Sie im Einstellmenü (Setup) des DI die 
Option "Right Click = Return not menu" ein. Probieren Sie sie zumindest einmal 
aus. Der Vorteil ist, dass Sie beim QSO-Fahren die Maus nicht aus der Hand geben 
müssen. Sie können die QSO-Rate deutlich erhöhen und brauchen das Auge nur auf 
das DI zu richten. 
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Das Verfahren läuft so: 

• RUN-Modus 
o Klicken Sie rechts in das RX-Fenster des DI > CQ wird gesendet
o Erhalten Sie einen Anruf, klicken Sie links auf dieses Rufzeichen 
o Klicken Sie rechts und Ihre Kontrollnummer wird gesendet 
o Klicken Sie links auf die empfangene Kontrollnummer
o Klicken Sie rechts und TU wird gesendet und das QSO geloggt 
o Klicken Sie erneut rechts in das DI und der nächste CQ-Ruf wird 

gestartet. 
o

• Im S&P-Modus läuft der ESM-Modus analog ab und entspricht den Angaben 
im ESM-Kapitel.  

PA2AMG meint: 
Im Contest habe ich die rechte Hand an der Maus und der Zeigefinger der linken 
Hand pendelt zwischen den Taste ESC und F1. Mit der ESC –Taste breche ich das 
CQ-Senden ab, wenn mich eine Station anruft und mit der F1-Taste starte ich den 
nächsten CQ-Ruf.  73 de Rick

4. Wenn’s nicht so klappt ..(Do You Have... (what to check when it does 
not work))

Beachten Sie diese Tipps, um Probleme beim RTTY-Betrieb zu vermeiden:  

• Ergänzen Sie alle F-Tasten mit den Macros {TX} am Anfang und {RX} am 
Ende 

• Tragen Sie bei der Contest-Konfiguration "always RTTY" in der Karteikarte 
Mode Control des Configurers ein

• Wählen Sie den DI-Typ auf der Karteikarte Digital Modes 
• Tragen Sie den richtigen Pfad zum Programm MMTTY in der Karteikarte 

Digital Modes ein
• Mehr? 

4.1. Zuweisungen zur Taste Insert (Einfg) (Insert Key Assignments)

Mode ESM-
Modus Die Taste Ins (Einfg) löst folgendes aus: 

RUN 
und S&P AUS

1. Übernahme (Grab) eines Rufzeichens aus der Rufzeichenliste, 
falls das Rufzeichenfeld leer ist. Sonst wird das dort stehende 
Rufzeichen genommen 
2. Füllt Kontrollnummerfeld aus  
3. NO DUPE: Sendet F5 (Hiscall) + F2 (Exchange). Bei DUPE: 
wird nichts gesendet 
4. Setzt den Cursor in das nächste Kontrollnummerfeld, falls mehr 
als eine Kontrollnummer ausgetauscht wird 

RUN EIN
1. Übernahme (Grab) eines Rufzeichens aus der Rufzeichenliste, 
falls das Rufzeichenfeld leer ist. Sonst wird das dort stehende 
Rufzeichen genommen
2. Füllt Kontrollnummerfeld aus  
3. NO DUPE: Sendet F5 (Hiscall) + F2 (Exchange).) oder 
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3. DUPE 
-WorkDupes aktiviert: Sendet F5 (Hiscall) + F2 (Exchange).
-WorkDupes nicht aktiviert: Sendet F6 (QSO b4)
4. Setzt den Cursor in das nächste Kontrollnummerfeld, falls mehr 
als eine Kontrollnummer ausgetauscht wird
5. Tastet die Taste F8 (Agn) hell 

S&P EIN
1. Übernahme (Grab) eines Rufzeichens aus der Rufzeichenliste, 
falls das Rufzeichenfeld leer ist. Sonst wird das dort stehende 
Rufzeichen genommen
2. Füllt Kontrollnummerfeld aus  
3. NO DUPE: Sendet F4 (Mycall) oder 
3. DUPE 
- WorkDupes aktiviert: Sendet F5 (Hiscall) + F2 (Exchange).
-WorkDupes nicht aktiviert: Sendet F6 (QSO b4)
4. Nach Übernahme der Kontrollnummer sendet INSERT F5-F2 
** ein erneutes INSERT wiederholt F5-F2 
5. Setzt den Cursor in das nächste Kontrollnummerfeld, falls mehr 
als eine Kontrollnummer ausgetauscht wird

4.2. Einstellung der F-Tasten im Logeingabefenster (Configuring the 
Entry Window Function Keys)

• Wie bei CW und SSB unterstützt das Logeingabefenster die Modi RUN und 
S&P. 

• Die PSK- und RTTY-Macros können in den Texten der F-Tasten eingebaut 
werden 

• Die Tastentexte werden mit dem Menü Config > Change 
Packet/CW/SSB/Digital Message Buttons > Change Digital Buttons 
editiert 

• Nachfolgend sehen Sie ein Beispiel: 

 

4.3. Macro-Tasten (Macro Keys)

• Im Fenster DI können Sie weitere 8, 16 oder 24 Tasten programmieren
• Mit einem Rechtsklick auf eine Taste öffnen Sie das Menü zum Editieren
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• Diese Tasten unterscheiden nicht nach RUN- oder S&P-Modus. Sie haben in 
beiden Modi die gleiche Funktion. 

• Beachten Sie bei der Programmierung der Tasten die benötigten Macros zur 
RX/TX-Umschaltung.  

• Sie können programmierte Tasten als Macros in anderen Tasten und auch in 
den Tasten des Logeingabefelds verwenden.

Beispiele für die Macro-Programmierung finden Sie im Kapitel Macros. 

Speziell für die externen TNCs gibt es eine Reihe an speziellen Macros. Informieren 
Sie sich im Kapitel Digital - External TNC support. Lesen Sie zu den Macros auch 
in den Kapiteln  MMTTY und MMVARI. 

5. Namen ermitteln (Name Lookup)

Sie können den Digimode-Contest ein wenig mit dem Namen der Gegenstation 
auflockern. Es gibt diverse Dateien mit einer Liste mit dem zu einem Rufzeichen 
gehörenden Namen. Gehen Sie so vor: 

• Importieren Sie eine solche Text-Datei:  
o Die Datei 'Friend.ini' aus dem populären RTTY-Programm von WF1B 

kann direkt importiert werden 
o In der Rufzeichengeschichte (Call History) gibt es eine ähnliche Datei 

im Format Rufzeichen <Komma> Namen z.B. N1MM,TOM
• Wählen Sie Config >Call History Lookup 
• Verwenden Sie das Macro {NAME}, um den Namen der Gegenstation zu 

senden. Der Name wird in der Rufzeichengeschichte nachgesehen, wenn das 
Rufzeichen im Rufzeichenfeld steht und Sie die Leertaste drücken.  

Ein Beispiel für den Einbau der Datei Friend.ini aus dem WF1B-Programm: 

• Wählen Sie File >Import >Import Call History 
• Wählen Sie die Datei Friend.ini . Ändern Sie dazu den Dateityp auf All Files 

(*.*). Sonst sehen Sie nur Textdateien *.txt. 
• Klicken Sie auf die Taste'Open'.button. Die Rufzeichen mit den Namen 

werden importiert. Mit dem Import werden die alten Inhalte der Tabelle 
gelöscht. Wollen Sie diese retten, geben Sie sie vorher mit File > Export 
>Export Call History und mischen Sie sie in einem Editor mit der Datei 
Friends.ini und lesen Sie sie dann erst neu ein.

• Sie können den Import in der Statusleiste des Logeingabefensters verfolgen. 
Angezeigt werden der Status und die Anzahl der importierten Rufzeichen.

6. Ausgabe der empfangenen Texte in eine Datei (Output RX Data to a 
Text File)

Sie können den in das RX-Fenster eingelaufenen Text mit MMTTY oder mit 
N1MMLogger in einer Datei abspeichern.

• N1MMLogger: Klicken Sie rechts in das RX-Fenster und wählen im sich 
öffnenden Menü die Option Output to Text File 
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• MMTTY: Bei MMTTY geht es etwas umständlicher. Gehen Sie in das 
Verzeichnis, in dem MMTTY gespeichert ist und öffnen Sie es außerhalb von 
N1MMLogger als allein stehendes Programm. Wählen Sie dort File > Log RX 
und schließen Sie das Programm wieder. Ab sofort wird bei jedem Start von 
MMTTY (auch aus N1MMLogger heraus) eine Datei mit Datum des aktuellen 
Tages eingerichtet wie z.B. 031103.txt. MMTTY erzeugt für jeden Tag eine 
eigene Datei. Diese Art der Datensicherung kann nützlich bei der Suche nach 
einem Rufzeichen, einer Kontrollnummer oder bei einem Rechnerabsturz sein.

7. SO2R-Betrieb (Single Operator 2 Radios (SO2R))

N1MMLogger unterstützt SO2R unter RTTY. Sie können jede Kombination von zwei 
MMTTY-Fenstern, zwei TNC-Fenstern oder eine Kombination von MTTY mit einem 
TNC für den SO2R-Betrieb einrichten. Informieren Sie sich über die SO2R-
Einstellung im SO2R-Kapitel.

Last Modification: 26 September 2009 15:07:55 EDT by K8UT. 

Einstellung der Digimodes (Digital Setup)

1. Überblick (Setup Overview)

Sie müssen die für den Digimode-Betrieb benötigten Geräte, Programme und 
Schnittstellen einrichten. Sie müssen diese Einstellungen an verschiedenen Stellen 
des N1MMLoggers und u.U. auch bei den benutzten Programmen MMTTY und/oder 
MMVARI oder dem externen TNC vornehmen.
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1.1. Einstellung des Configurers (Setting Up the Configurer)

 

Es bedeutet: DI = Digital Interface 

• Öffnen Sie den Configurer: Config >Configure Ports, Telnet Address,  
Other) 

• MMTTY 
o Gehen Sie zur Karteikarte Digital Modes 

 TU Type: Soundcard 
 DI-1/2 MMTTY Mode: Wählen Sie die Tastung AFSK oder FSK 
 DI-1/2 MMTTY Path: Tragen Sie den Pfad zur Datei 

MMTTY.EXE ein

• MMVARI 
o Gehen Sie zur Karteikarte Digital Modes 

 TU Type: Soundcard 

• External TNC 
o Gehen zur Karteikarte Hardware 

 Wählen Sie: Digital für eine serielle Schnittstelle, an die der 
TNC angeschlossen ist

 Falls Sie zwei TNCs anschließen wollen, benötigen Sie 
zwei freie COM-Schnittstellen für Digital 
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 Die niederwertige COM-Schnittstelle gehört zum Interface 
DI-1, die höherwertige zum Interface DI-2 

o Gehen Sie dann zur Karteikarte Digital Modes 
 TU Type: Other 
 Set other parameters accordingly: Tragen Sie die für den TNC 

benötigten Interfacedaten ein wie: Baudrate 9600 , Datenformat 
8N1, Protokoll Xon-Xoff 

• Speichern Sie die Konfiguration mit < OK > ab.

2.  Das DI-Fenster (The Digital Interface – Window)

Jedem Digital-Interface ist ein DI-Fenster zugeordnet. Es sieht für MMTTY, MMVARI 
oder einen TNC nahezu gleich aus:  

 

Öffnen Sie das DI-Fenster mit dem Menü Windows > Digital Interface. Haben Sie 
zwei digitale Interfaces eingerichtet, öffnet sich ein Menü, mit dem Sie das zweite DI-
Fenster öffnen können. In der Überschrift wird die aktuelle Arbeitsfrequenz berechnet 
aus VFO-Frequenz +/- RTTY-Markfrequenz angezeigt. Die Tasten im Fenster haben 
diese Bedeutung:  

• TX : Indikator für den aktiven Transceiver, wichtig beim SO2R-Betrieb 
• Letters/Figs : Reverse Darstellung eines markierten empfangenen Textes (Bu 

<> Zi-Umschaltung)
• MouseOver: Zeigt den aktuell unter dem Mauszeiger stehenden Text 
• Oberes Fenster (RX-Fenster): Hier läuft der empfangene Text ein und aus 

diesem Fenster holen Sie das Rufzeichen in das Logeingabefenster. Mit 
einem einfachen Linksklick wird das Rufzeichen über das Rufzeichenfeld 
geholt. Jedes erkannte Rufzeichen wird in das Grab-Fenster rechts unten 
gesetzt. Falls der LTRS/FIGS-Konverter aktiviert ist, wird jeder Text, auf den 
der Mauszeiger gesetzt wird, in der Zeile oben links revers dargestellt. Wenn 
Sie auf die farbige links neben dem RX-Fenster klicken, können Sie den Text 
aus dem RX-Fenster bis zu 2000 Zeilen rückwärts nachlesen. Mit einem 
weiteren Klick wird der inzwischen empfangene Text in das RX-Fenster 

11.04.2010



N1MM-Contest Logging Software Seite 186 von 470 Übersetzung der Hilfe von Eike, DM3ML

ausgegeben. Wenn Sie die Ausgabe in das RX-Fenster anhalten, können Sie 
den Text von dort kopieren.

• Unteres Fenster (TX-Fenster): Hier können Sie Text eingeben, um eine 
Sendung vorzubereiten oder während des Sendens nachschreiben. Wenn Sie 
auf die TX-Taste klicken, wird der Cursor in das TX-Fenster gesetzt und der 
dort stehende Text wird gesendet. Sie haben zwei Zeilen Platz in diesem 
Fenster. Seine Größe kann nicht verändert werden.

• Callsign Textbox and Grab (Rufzeichenübernahme, Greif-Fenster): Ein 
Rufzeichen, das im empfangenen Text erkannt worden ist (links und rechts ein 
Leerzeichen), wird in das Greif-Fenster geschickt. Mit der Taste Grab können 
Sie ein Rufzeichen aus diesem Fenster in den Rahmen über dem 
Rufzeichenfeld des Logeingabefensters transportieren. Das aktuellste 
Rufzeichen ist hell getastet. Im Greif-Fenster können bis zu 10 Rufzeichen 
stehen. DUPEs werden nicht in dieses Fenster geschickt.

 Rufzeichen wird nicht in die Greif-Liste übernommen 
Falls das Rufzeichen schon im Rufzeichenfeld des Logeingabefensters steht, wird es 
nicht in die Greif-Liste übernommen. 

• Macro-Tasten: Sie können im DI-Fenster maximal 24 Tasten programmieren. 
Gehen Sie dazu im DI-Fenster zu Setup > Settings oder klicken Sie rechts 
auf die zu programmierende Taste. Die Breite der Tasten wird dynamisch der 
DI-Fenstergröße angepasst. 

• Clr RX : Löscht das RX-Fenster. Kann auch mit dem über einen Rechtsklick 
erreichbare Menü gemacht werden.

• Align : Mit dieser Taste können Sie ein RTTY-Signal in die Mitte des 
Durchlassbereichs Ihres Filter schieben. Voraussetzung ist eine 
funktionierende CAT-Steuerung. NF-Lage und VFO-Frequenz werden so 
korrigiert, dass das gewünschte Signal auf die voreingestellte NF-
Vorzugsfrequenz z.B. 2100 Hz gezogen wird. 

• TX: Startet die RTTY-Sendung. Die Taste wird nur bei MMTTY angezeigt. Sie 
ist ROT wenn auf Senden geschaltet wurde. 

• RX: Beendet die RTTY-Sendung nach Ausgabe des im TX-Fenster stehenden 
Textes. Die Taste wird nur bei MMTTY angezeigt. Sie ist GRÜN, wenn das 
Gerät auf Empfang steht. 

• Grab: Übernimmt das ausgewählte Rufzeichen aus dem RX-Fenster in Greif-
Liste und setzt es in das Rufzeichenfeld des Logeingabefensters.  Wenn Sie 
auf ein anderes Rufzeichen klicken, wird dieses Rufzeichen übernommen. 
Diese Funktion können Sie nur mit der Maus ausführen. Im Sendezustand des 
DI-Fensters ist eine Übernahme von Rufzeichen nicht möglich. 

Sie können gleichzeitig 2 DI-Fenster geöffnet haben. Klicken Sie rechts in das erste 
DI-Fenster und wählen Sie Open 2nd RTTY Window. Sie können, falls der NF-
Ausgang Ihres Transceivers doppelt beschaltet ist, das Signal sowohl unter MMTTY 
als auch mit einem TNC mitlesen oder Sie können 2 Transceiver mit 2 TNCs laufen 
lassen und zwischen beiden hin und her schalten. Sie können im zweiten DI-Fenster 
auch andere Macros als im ersten DI-Fenster programmieren. 
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2.1. Rufzeichenfarbe (Callsign coloring) 

Ein in der Datei Master.dta gefundenes Rufzeichen wird farbig markiert in das Greif-
Fenster übergeben. Sind in einer Zeichenkette zwei Rufzeichen enthalten, wird das 
letzte Rufzeichen hell getastet. Die hell getasteten Rufzeichen sind dadurch bereits 
markiert und können mit einem Klick übernommen werden. 

2.2. Mauszuordnungen (Mouse Assignments)

• Linksklick 
o Einfacher Klick auf ein Rufzeichen: transportiert es in das Greif-

Fenster und in das Logeingabefenster 
o Einfacher Klick auf eine Kontrollnummer: transportiert die 

Kontrollnummer in das Kontrollnummernfeld des Logeingabefensters.
Voraussetzung: das Rufzeichenfeld muss gefüllt sein! 

o Doppelklick auf ein Rufzeichen: transportiert es in das Greif-Fenster 
und überschreibt ein bereits im Rufzeichenfeld des Logeingabefensters 
stehendes Rufzeichen 

o Ctrl+Einfachklick: schickt die angeklickte Zeichenkette unabhängig 
von ihrem Inhalt in das Logeingabefenster 

o Shift+Einfachklick: der Text aus dem RX-Fenster wird in das reverse 
Register (Bu<>Zi) umkodiert und in das Logeingabefenster geschickt 
(nur bei RTTY) 

• Rechter Mausklick in das RX-Fenster 
o Öffnet ein Menüfenster, aber nur wenn die Option 'RT Click = Return 

NOT menu' NICHT gewählt ist! 
 Clear RX:  Löscht das Empfangsfenster mit maximal 10000 

Zeichen 
 Output to Text File : Schickt den empfangenen Text in eine 

Datei mit dem Namen RTTY1.txt 
 Help : Holt die Hilfe für dieses Fenster aus dem Internet 

• Rechter Mausklick in das TX-Fenster
o Öffnet ein Menüfenster, aber nur wenn die Option 'RT Click = Return 

NOT menu' NICHT gewählt ist! 
 Clear TX : Löscht das TX-Fenster 
 Paste : Setzt den Text aus dem Zwischenspeicher in das TX-

Fenster 
• Rechter Mausklick in das GRAB (Greif)-Fenster 

o Ein Menü wird geöffnet: 
 Clear List : Die Greif-Liste wird gelöscht 
 Clear Selected Call:  Das markierte Rufzeichen wird gelöscht

2.3. Tastatur-Zuordnungen (Keyboard Assignments)

• Alt+T : Schaltet zwischen TX und RX hin und her, der Cursor wird in das 
aktive TX-Fenster gesetzt 

• Ctrl+K : Schaltet zwischen RX und TX hin und her, öffnet das Fenster zur 
Texteingabe über die Tastatur

• Alt+G:  Übergibt das letzte erkannte Rufzeichen aus der Greifliste an das 
Logeingabefenster und löscht dieses Rufzeichen aus der Liste 
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• Ctrl+Links/Rechts-Pfeil:  Wenn zwei Transceiver und zwei DI-Fenster offen 
sind, wird mit Ctrl+Linkspfeil zum linken Transceiver und mit 
Ctrl+Rechtspfeil zum rechten Transceiver und den zugehörigen DI-Fenstern 
umgeschaltet. DI1 gehört zum Transceiver 1 (Bandskala A) und DI2 gehört 
zum Transceiver 2 (Bandskala B). 

3. Menüs in den DI-Fenstern (The Digital Interface - Menu Selections)

Jedes der DI-Fenster hat in der Kopfleiste einige Menüs. Sie hängen von der Art des 
gewählten Interfaces ab, die Unterschiede sind aber minimal. Die untenstehenden 
Ausführungen gelten daher für alle Interfaces. 

3.1. Soundkarte als Interface ausgewählt (Selection: Soundcard as 
Interface)

• Setup (Einstellungen)
o Settings:  Einstellung des digitalen Interfaces, siehe Setting up the 

Digital Interface weiter unten
o Bring to Foreground when made Active: Bringt das DI-Fenster in den 

Vordergrund, auch wenn der Fokus im Logeingabefenster steht. Sie 
können mit dieser Option das/die DI-Fenster und die zugeordnete 
RTTY-Maschine sehen, auch wenn der Fokus im Logeingabefenster 
steht.

o SoundCard (Soundkarte)
 Receive Mixer : Zeigt den Windowsmixer (ausgenommen von 

Vista) für den Empfangskanal 
 Transmit Mixer : Zeigt den Windowsmixer (ausgenommen von 

Vista) für den Sendekanal.
o Setup MMTTY : Das Setup von MMTTY wird geöffnet. Nur sichtbar, 

wenn mit MMTTY gearbeitet wird.
o AFC On/Off with CQ : Die AFC (automatische Frequenzabstimmung) 

wird bei CQ-Sendungen oder eine TU-Nachricht eingeschaltet
o NET On/Off with Run Change : Im RUN-Modus ist die Net-Option 

(Senden auf der nachgeführten Empfangsfrequenz) ausgeschaltet und 
im S&P-Modus eingeschaltet. 

o Turn Hover Mode On/Off : Falls eingeschaltet, wird ein Rufzeichen, 
auf das der Mauszeiger gesetzt wird,  in das Rufzeichenfeld des 
Logeingabefensters gesetzt.

 Diese Option ist nützlich, wenn mit der Option 'Right click send 
Enter' gearbeitet wird. Sie setzen den Mauszeiger auf das 
gewünschte Rufzeichen, klicken rechts, das Rufzeichen wird in 
das Rufzeichenfeld gesetzt und danach dieses Rufzeichen und 
die dazu gehörende Kontrollnummer gesendet. Danach klicken 
Sie links auf die empfangene Kontrollnummer der Gegenstation, 
klicken wieder rechts und senden die TU-Nachricht und Loggen 
das QSO > Rechtsklick > Linksklick > Rechtsklick und das QSO 
steht im Log… 

 Diese Mauszeigermethode wird in Zusammenhang mit der 
Option  'Rt Click= Return NOT menu' verwendet.
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o RT Click = Return NOT menu : Wenn gewählt, wird bei einem 
Rechtsklick kein Menü geöffnet, sondern ein ENTER erzeugt (siehe 
ESM-Modus und Hover-Mode im vorigen Abschnitt)

o Send Text File : Ein Dateimenü wird geöffnet, aus dem Sie eine zu 
sendende Text-Datei auswählen können

o Enable Digital Call Stacking : Freigabe des Greif-Fensters- 
• Interface 

o MMTTY : Wählen Sie  MMTTY oder Other (TNC) als Interface 
o MMVARI : Wählen Sie MMVARI als Interface 

• Open 2nd Digital Window : Öffner das zweite DI-Fenster. Sie müssen dazu 
im Configurer auf der Karteikarte Digital Modes ein zweites Digital-Interface 
eingerichtet haben.

• Help: Ruft die zu der Seite gehörende Hilfe aus dem Internet ab

3.2. Interface OTHER ausgewählt (Selection: OTHER)

Dieses Interface wird gewählt, wenn ein externer TNC angeschlossen werden soll:

• Setup 
o Settings : Einstellung der Anschlusswerte für einen TNC (siehe 

Setting up the Digital Interface) 
o Load TNC Settings File : Eine Datei 'SETTINGS.TXT' mit 

vorbereiteten Werten für den TNC kann geladen werden. Für den PK-
232 finden Sie ein Beispiel auf der Webseite, wenn Sie 'Other Files' 
wählen. 

• Mode 
o RTTY : RTTY wählen 
o PSK : PSK wählen
o Help : Hilfe für diese Seite aus dem Internet holen 

4. Einstellung des digitalen Interfaces (The Digital Interface – Setup)

Mit diesem Dialog werden die Programme MMTTY und MMVARI eingestellt. Gehen 
Sie zu Setup > Settings , um die unten wiedergegebenen Fenster zu öffnen. Alle 
Einstellungen müssen nach Abschluss mit einem Klick auf die Taste Save 
abgespeichert werden.  

4.1. Karteikarte General MMTTY-Setup (Tab: General/MMTTY Setup)

Diese Karteikarte hat Einstellmöglichkeiten für alle Interfacearten (Soundkarte/TNC) 
und einige spezifische Einstellungen für MMTTY und MMVARI.
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• Use Auto TRX Offset in DI1: Addiert oder subtrahiert die NF-Markfrequenz 
von der VFO-Frequenz und erzeugt so eine auf die Markfrequenz bezogene 
Frequenzanzeige in der HF-Lage für das DI 1.  

o DXSpots werden dadurch auf der exakten Frequenz erzeugt und beim 
Anklicken entsprechend verarbeitet. Verwenden Sie z.B. eine 
Markfrequenz von 2125 Hz und arbeiten in LSB, wird beim Anklicken 
einer auf 14080 kHz gespotteten Station Ihr VFO auf 14082,125 kHz 
gestellt und das RTTY-Signal erscheint innerhalb Ihres ZF-Filters in 

o der NF-Lage bei 2125 Hz. 
• Use Auto TRX Offset in DI2 : Gleiches Verfahren für DI 2 
• Add Callsign to Bandmap on Alt+G: MMTTY und PSK: Nach Greif-

Kommando ALT+G  wird das Rufzeichen in die Bandskala gesetzt
• Remove Excess Linefeeds from RX Window:  Überflüssige 

Zeilenschaltungen werden aus dem RX-Fenster entfernt 
• Send Space on Using Grab : Nach Übernahme eines Rufzeichen in das 

Greif-Fenster wird ein Leerzeichen gesendet 
• (MMTTY) Send HamDefault on Run to S&P change : nur bei MMTTY: Beim 

Umschalten von S&P- auf den RUN-Modis wird MMTTY auf die 
voreingestellten HAM-Werte zurückgesetzt. 

• (MMTTY-MMVARI) Turn AFC Off when switching to S&P : Die AFC wird 
beim S&P-Betrieb abgeschaltet. Meistens wird im RUN-Modus auf Net off und 
AFC on geschaltet, um die eigene Frequenz unverändert zu lassen, aber 
neben der eigenen Frequenz anrufende Stationen mit zu schreiben. Im S&P-
Modus wird aber eher Net on und AFC off genutzt, damit starke Stationen 

11.04.2010



N1MM-Contest Logging Software Seite 191 von 470 Übersetzung der Hilfe von Eike, DM3ML

das eigene Signal nicht von der schwachen angewählten Stationen auf sich 
ziehen. 

• Do Not add Dupes to Grab Window : Die Übernahme von DUPE-Stationen 
in das Greif-Fenster wird gesperrt. 

• Send Space on Using Grab: Nach Übernahme eines Rufzeichens aus dem 
Greif-Fenster wird ein Leerzeichen gesendet, um den Cursor vom 
Rufzeichenfeld in das Kontrollnummernfeld zu schicken 

• If QSY Wipes call is checked Clear Grab Window on QSY : bei einem 
Frequenzwechsel wird das Greif-Fenster und das übernommene Rufzeichen 
gelöscht 

• QSY will clear Grab Window : bei einem Frequenzwechsel wird das Greif-
Fenster gelöscht

• Callsign Validity Routines (Rufzeichenbestätigung)
o Use Generic Routines : alles, was wie ein Rufzeichen aussieht, wird 

hell getastet
o Use master.dta File:  nur Rufzeichen, die in der Datei Master.dta zu 

finden sind, werden hell getastet. 
o Use Search routine to find Master.dta in Garbage Text : auch der 

Mülltext wird nach Rufzeichen durchsucht
• Digital Interface Window Colors (Farbe der Fenster)

o Sie können für das RX-, das TX-Fenster, den Wasserfall und das 
eigene Rufzeichen im RX-Fenster eine gewünschte Hintergrundfarbe 
einstellen 

• Digital Interface RX Window Font Selection (Schrifttyp im RX-Fenster): 
Wählen Sie Set Font für die Einstellung. Die Einstellung wird erst nach 
Schließen des Fensters und erneutem Öffnen wirksam. 

• MMTTY Window Settings (Einstellung des MMTTY-Fensters)
o Normal MMTTY Window : Das MMTTY wird in normaler Größe 

angezeigt. Sie müssen dazu N1MMLogger erneut starten.
o Small MMTTY Window - Das MMTTY wird in kleiner Größe angezeigt. 

Sie müssen dazu N1MMLogger erneut starten.
o Give MMTTY help Starting : MMTTY wird ein- und ausgeschaltet 

• On Top Settings (In den Vordergrund setzen)
o MMTTY always on Top : MMTTY wird immer vor allen N1MMLogger-

Fenstern angezeigt. N1MMLogger muss zum Einschalten neu gestartet 
werden. Wird N1MMLogger minimiert, bleibt das MMTTY-Fenster 
stehen.  

o MMVARI always on Top - MMVARI wird immer vor allen 
N1MMLogger-Fenstern angezeigt. N1MMLogger muss zum 
Einschalten neu gestartet werden. Wird N1MMLogger minimiert, bleibt 
das MMVARI-Fenster stehen.  

o Preferred RTTY Interface : Stellen Sie Ihr RTTY-Vorzugsinterface ein: 
MMTTY, MMVARI oder TNC 

• Shift Frequency Compensation : für Transceiver mit Shift Frequency 
Compensation 

o Enabled : Shift Frequency Compensation erlaubt 
o Offset Frequency : Ablagefrequenz eingeben 

• Alignment Frequency - (MMTTY und PSK) 
o MMTTY : Markfrequenz bei RTTY auf die ein Signal mit der Alignment-

Funktion gezogen werden soll (Align-Taste) 
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o MMVARI : Mittenfrequenz des Signals, auf die ein Signal mit der Align-
Taste gezogen werden soll.  

 RTTY : RTTY- Alignmentfrequenz in MMVARI 
 Zählen Sie 85 Hz zur Markfrequenz dazu, z.B.  stellen Sie 

statt 2000Hz hier 2085Hz ein
 Other : Alignmentfrequenz für andere Modi als RTTY

• Save Configuration : Konfiguration abspeichern. Wollen Sie die 
Einstellungen verwerfen, schließen Sie das Fenster mit einem Klick auf das 
Kreuz rechts oben. 

4.2. Tab: MMVARI-Einstellungen (MMVARI Setup)

 

• MMVARI Engine (MMVARI-Maschine)
o Waterfall/Spectrum/Misc Color palette : Farbpalette für den 

Wasserfall: Sie können die Farbabstufungen zwischen Rauschen und 
starkem Signal nach Ihrem Geschmack einstellen. Klicken Sie die 
einzelnen Farbfelder an und wählen Sie Ihre Wunschfarbe. Mit der 
Taste Default kommen Sie zurück zu den voreingestellten Werten.

o Squelch Level: (Rauschsperre) : Mit der Rauschsperre können Sie 
leise Signale von der Dekodierung sperren. Es werden erst Signale 
über der Sperre dekodiert. Mit der Einstellung 0 ist die Rauschsperre 
unwirksam. 
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o High Pass Filter (Hochpassfiler) : Dieses Filter unterdrückt Signale mit 
niedrigen Frequenzen, wie Brummen u.ä. Wird in der Regel nicht 
benötigt.  

o Spectrum Lower Frq : unterste Frequenz von Spektrum/Wasserfall
o Spectrum Upper Frq : oberste Frequenz von Spektrum/Wasserfall 
o CW ID 

 Enable : Falls aktiv kann am Ende jeder Sendung eine CW-
Kennung (CWID-String) in A2 gesendet werden. Sonderzeichen 
können entsprechend der roten Zuordnungen eingebaut werden.

o AFC Search Range : Bereich, in dem die AFC versuchen soll, auf ein 
RTTY-Signal abzustimmen 

o Sense Level : Stör/Signal-Verhältnis eines Signals, auf das die AFC 
noch reagieren soll. Bei einer AFC-Bandbreite <= 50Hz unwirksam. 

o Use TNC Software for control : COM-Steuerung wird dem externen 
TNC-Programm überlassen. Bei einem externen TNC kann die interne 
Soundkarte verwendet werden.

o Digital Output Level : Ausgangspegel der Soundkarte digital zwischen 
0 und 32767. Voreingestellt ist die Mitte mit 16384 

• DI1/DI2 MMVARI Soundcard (Soundkartenauswahl für DI1 und DI2)
o MMVARI Soundcard # 

 Input Souncard# : Nummer der RX-Soundkarte für MMVARI, 
falls im PC mehr als eine Soundkarte eingebaut sind (max. 4) 

 Input Channel : Verwendeter Kanal Mono, Links, Rechts 
 Output Souncard# : Nummer der TX-Soundkarte, wenn mehr 

als eine Soundkarte eingebaut sind (max. 4)
o FIFO 

 RX : spezifiziert den RX FIFO. Werte zwischen 4 bis 32 
 TX : spezifiziert den TX FIFO. Werte zwischen 4 bis 32

o Clock - Soundkartenabgleich 
 RX : Abgleichwerte für den RX-Kanal 
 TX Offset - Abgleichwerte für den TX-Kanal  relativ zum RX-

Kanal 
 Graphical Adjustment : Grafischer RX-Taktabgleich mit WWV

 1. Stellen Sie den RX auf einen Zeitzeichensender und 
verfolgen Sie die 1000Hz-Ticks im Spektrum 

 2. Läuft die Linie nach links oder rechts weg, korrigieren 
Sie den Soundkartentakt, bis die Linie senkrecht läuft 

 3. Klicken Sie auf die Taste, um den Korrekturwert 
abzuspeichern 

• MFSK 
o Handling Center Frequency : Signalmittenfrequenz wird verwendet. 

Wenn nicht aktiviert, wird die Bereichsanfangsfrequenz verwendet 
o Use Metric Level Squelch : Verwendet den metrischen Signalpegel 

als Schwelle, sonst wird der S/N-Wert verwendet 
• # of MMVARI channels : Zahl der MMVARI-Kanäle, die verwendet werden 

sollen (2, 3 oder 4) 
• Save Configuration : Konfiguration abspeichern. Wollen Sie die 

Einstellungen verwerfen, schließen Sie das Fenster mit einem Klick auf das 
Kreuz rechts oben. 
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4.3. Karteikarte Macros (Tab: Macro Setup)

 

• Digital Macro Set : Wählen Sie Interfacetyp und Fensternummer zu Beginn. 
Editieren Sie Macros und Tastenbeschriftungen für 

 SouncardPSK : Macros für PSK unter MMVARI
 SoundcardRTTY : Macros für RTTY unter MMVARI und 

MMTTY 
 Other : Macros für den TNC. 

o Klicken Sie auf die zu bearbeitende Taste 
o Geben Sie den gewünschten Text in das Feld 'Macro Text' ein
o Geben Sie der Taste einen Titel mit dem Feld 'Macro Caption' 
o Klicken Sie auf die Taste 'Save Macro', um das Macro für diese Taste 

abzuspeichern
o Die Taste enthält jetzt den gewählten Titel 
o Sie können vorgegebene Macros aus dem Fenster 'Available Macros' 

in Ihren Macro-Text einbauen 
o Wenn Sie einen TNC verwenden, müssen Sie die Macros RX, TX und 

ESC getrennt und TNC-spezifisch definieren (z.B. RX=Ctrl-Y).
• Load Macros : Import eines vorher erzeugten Macros-Satzes aus einer Datei 

*.mc. 
• Save Macros ; Abspeichern eines erzeugten Macro-Satzes als Datei *.mc. 
• # of Macros : Hier legen Sie fest, wie viel Macro-Tasten angezeigt werden 

sollen 0, 8, 16 oder 24 
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• Save Configuration : Konfiguration abspeichern. Wollen Sie die 
Einstellungen verwerfen, schließen Sie das Fenster mit einem Klick auf das 
Kreuz rechts oben. 

4.4. Karteikarte WAE-RTTY-Konfiguration (Tab: WAE RTTY 
Configuration)

Dieses Menü wird nur angezeigt, wenn Sie einen WAE RTTY fahren wollen. 

 

• RQTC : Unter RQTC stehen die 4 Nachrichten, die beim Empfang eines QTC 
benötigt werden

• SQTC - Unter SQTC stehen die 4 Nachrichten, die beim Senden eines QTC 
benötigt werden 

• Default Number of QTC to Send (voreingestellte QTC-Zahl) : 10 
• Wenn Sie nach einem einzelnen QTC nachfragen, müssen Sie 

o Alles Daten dieses QTC löschen oder 
o Nur die falschen Daten löschen oder 
o Nur die Nachfrage senden 

• Save Configuration : Konfiguration abspeichern. Wollen Sie die 
Einstellungen verwerfen, schließen Sie das Fenster mit einem Klick auf das 
Kreuz rechts oben. 
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Last Modification: 03 October 2009 11:09:43 EDT by K8UT. 

Programm MMTTY für RTTY (Digital - MMTTY for RTTY support)
Das MMTTY-Soundkarten-Interface basiert auf der MMTTY-Maschine von Makoto 

Mori, JE3HHT.  

1. MMTTY Windows

Wenn Sie MMTTY starten werden zwei Fenster geöffnet 

• Das DI-Fenster
o Es ist nahezu identisch für MMTTY, MMVARI und externe Interfaces, 

siehe 'Digital - External TNC Support' 
• Und das Fenster der MMTTY-Maschine- 

o Hier gibt es zwei Varianten, die im Digital Interface Menu unter 
Settings gewählt werden. 

 Kleines Fenster (small window): 

 

 Großes Fenster (large window)

 

2. MMTTY holen, konfigurieren und testen (Download, Configure and 
Test MMTTY)

2.1. MMTTY holen ( Download MMTTY)

• Holen Sie sich die neueste Version von MMTTY (siehe Links chapter)
o Sie benötigen mindestens die Version 1.64 oder höher 
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• Installieren Sie MMTTY auf Ihrem Computer, vorzugsweise in ein eigenes 
Verzeichnis. Verwenden Sie keine MMTTY-Version von vor dem 7-Juli 2002. 

• Die Datei NewExe von N1MMLogger enthält die Datei XMMT.ocx für die 
Zusammenarbeit mit MMTTY ab Version 1.64 und sollte sich nach der 
Aktualisierung im Verzeichnis von N1MMLogger befinden. 

2.2. MMTTY konfigurieren (Configure MMTTY)

2.2.1. FSK-Tastung (FSK KEYING)

1. Wählen Sie Config >Ports, Telnet Address, Other >Karteikarte Digital Modes  

o Wählen Sie die Soundkarte für den Empfang 
o Wählen Sie beim digitalen Interface MMTTY Mode FSK 
o Tragen Sie den Pfad des MMTTY-Verzeichnisses ein, vorzugsweise 

nicht das N1MM-Verzeichnis
o Gehen Sie zur Karteikarte 'Hardware' 
o Machen Sie bei der zur FSK-Tastung vorgesehenen COM-Schnittstelle 

einen Haken bei digital port 

2. Speichern Sie die Einstellung und verlassen Sie das Setup. Wenn MMTTY schon 
installiert ist bekommen Sie u.U. eine Fehlermeldung, dass die COM-Schnittstelle 
nicht geöffnet werden kann.

3. Gehen Sie zum Menü Windows > Digital Interface. MMTTY wird geladen. Gehen 
Sie dort zu 'Option/Setup' 

o Öffnen Sie die Karteikarte TX und geben Sie auch dort die für die FSK-
Tastung vorgesehene COM-Schnittstelle an

o Schließen Sie den Setup-Dialog 
o Schließen Sie das Fenster 'Digital Interface' , um die MMTTY-

Einstellungen zu speichern.  

4. Ab diesem Zeitpunkt holt sich MMTTY die Daten für die COM-Schnittstelle aus 
seiner eigenen Einstelldatei.  

Andere Möglichkeit: 

1. Starten Sie MMTTY im allein stehenden Modus und stellen Sie COM1 als TX-
Schnittstelle ein. Schließen Sie MMTTY

2. Stellen Sie unter N1MMLogger im Menü Config >Ports, Telnet Address, Other 
>Karteikarte Hardware die digitale Schnittstelle COM1 ein und wählen Sie dort RTS 
= PTT. 

3. Gehen Sie dann zur Karteikarte 'Digital Modes' und wählen Sie MMTTY mit FSK 
anstelle von AFSK

4. Speichern Sie die Einstellungen ab und schließen Sie N1MMLogger. MMTTY 
verwendet jetzt COM1 zur FSK-und PTT-Tastung. 
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2.2.1.1. RIGBlaster als Interface für FSK in der Kombination N1MM/MMTTY (Using the 
RIGblaster Interface for FSK with N1MM/MMTTY Combination)

Voreingestellt ist FSK via MMTTY mit TXD. Sie müssen die Jumper im RIGBlaster-
Interface umstecken. Stellen Sie zuerst sicher, dass MMTTY allein stehend richtig 
funktioniert. Danach sollten Sie das digitale Interface in N1MMLogger für MMTTY 
einrichten können und die Soundkarte für den Empfang auswählen. Wenn Sie PTT 
per CAT-Steuerung realisieren können, lassen Sie die PTT-Einstellung inaktiv und 
steuern Sie den Transceiver über die CAT-Steuerung. 

2.2.2. AFSK KEYING

1. Öffnen Sie den Configurer (Configure Ports, Telnet Address, Other in the 
Config menu). 

• Gehen Sie zur Karteikarte 'Digital Modes' 
 Wählen Sie eine Soundkarte als Interface 
 Wählen Sie als Digital Interface MMTTY Mode AFSK 
 Stellen Sie den Pfad zum MMTTY-Verzeichnis ein. Es sollte ein 

anderes Verzeichnis sein als das N1MMLogger-Verzeichnis. 
• Gehen Sie zur Karteikarte 'Hardware'  

 Machen Sie einen Haken bei der COM-Schnittstelle, die Sie für 
das digitale Interface verwenden wollen (digital port). 

2. Speichern Sie die Auswahl und verlassen Sie das Einstellmenü.

SO2R : Sie benötigen zwei separate Kopien von MMTTY und zwei COM-
Schnittstellen. Die zweite COM-Schnittstelle muss eine höhere Nummer als die erste 
haben. Informieren Sie sich im Kapitel SO2R. 

3. MMTTY testen (Testing MMTTY)

MMTTY läuft auch als allein stehendes Programm. Sie können MMTTY unabhängig 
von N1MMLogger testen. 

4. Betrieb mit zwei Transceivern (Two Radio Setup)

Sie benötigen zwei separate Soundkarten. For 2 radio operation where you are using 
2 separate soundcards. Wählen Sie die Soundkarten anhand ihrer Nummer aus. Die 
Einstellung erfolgt über die Karteikarte RX im Menü Option/Setup beim Programm 
MMTTY: Haben Sie die Einstellung nicht korrekt gemacht, wird der beim Transceiver 
2 einlaufende Text im DI1 mitgeschrieben. 

Wenn Sie eine Soundkarte mit dem rechten und dem linken Kanal verwenden, hilft 
es mitunter die Soundkarte für Transceiver auf  -1 und die Soundkarte für 
Transceiver 1 auf 0 zu setzen. 
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5. MMTTY verwenden (Using MMTTY)

• Die Macros für MMTTY unterscheiden sich von den Macros für einen TNC. 
Wichtig sind die Macros für Sende-Empfangsumschaltung. Sie benötigen die 
Macros TX ON {TX} oder TX OFF {RX}. 

• Für MMTTY benötigen Sie kein spezielles Abbruch-Kommando. Nehmen Sie 
die ESC-Taste, um eine Sendung abzubrechen. 

• Mit den TX- und RX-Tasten können Sie freien Text in das TX-Fenster 
eingeben. 

• Wird MMTTY gestartet, werden die zuletzt verwendeten Einstellungen zum 
Programmende wieder geladen. 

5.1. RTTY abstimmen (How to Tune RTTY)

• Stellen Sie Ihren VFO so ein, dass die beiden Spitzen eines Signals im 
Spektrum mit den beiden gelben Linien übereinstimmen.

• Schalten Sie das X-Y-Scope zu. Die beiden Lissajou-Figuren sollten ein 
senkrecht stehendes Kreuz bilden.  

• Stellen Sie mit der HAM-Taste die richtigen Werte für Shift und Markfrequenz 
ein. 

• Schalten Sie die AFC ab, wenn eine starke Station neben dem eingestellten 
Signal versucht, die Abstimmung an sich zu ziehen. 

• Testen Sie die von MMTTY angebotenen Bandpassfilter und das Kerbfilter 
(Notch) zur Unterdrückung von störenden Signalen 

• Stellen Sie sicher, dass am Transceiver LSB gewählt worden ist.

MMTTY schickt u.U. etwa aller 20 Minuten periodisch eine Meldung, dass es den 
Kontakt zur Soundkarte verloren hat und dekodiert dann kein RTTY mehr. Stellen Sie 
dann die Prioritätseinstellung auf der Karteikarte Misc von high auf highest.

5.2. Verwendung von AFC und NET (When Should I Use AFC and 
NET)

• Die AFC (automatic frequency control) bewirkt eine automatische 
Scharfabstimmung auf ein RTTY-Signal. 

• Die Einstellung NET bewirkt, dass Sie unter AFSK genau an der Stelle 
senden, an der Sie das RTTY-Signal der Gegenstation empfangen. Driftet die 
Gegenstation oder hat sie Sie ein Stück neben Ihrer eigenen Frequenz 
angerufen, wird auch Ihr Sendesignal mitgezogen. Bei FSK-Tastung wird die 
Sendefrequenz NICHT mitgezogen.

• Wenn Sie die Option AFC On/Off with CQ aktivieren, wird bei einem CQ-Ruf 
die AFC ein- und beim Suchen im S&P-Modus ausgeschaltet. 

Tipp von DM3ML: Lassen Sie AFC eingeschaltet, schalten Sie aber NET bei einem 
eigenen CQ-Ruf aus, um auf der eigenen Frequenz zu bleiben, aber im S&P-Modus 
ein, um eine Station möglichst genau, auf Ihrer Frequenz anzurufen. 
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5.3. CAT-Steuerung auf das RTTY-Signal bezogen ( Why to Use 
"Auto Update TRX Offset w/Mark Freq.")

• Die voreingestellte Mark-Frequenz ist 2125 Hz. Ist die Option Auto Update 
TRX Offset w/Mark Freq. Aktiviert, wird bei Anklicken eines Spots in der 
Bandskala die Frequenz am VFO so eingestellt, dass das gemeldete RTTY-
Signal bei 2125Hz im Wasserfall erscheint. Der VFO wir je nach 
Seitenbandlage 2125Hz tiefer (USB) oder höher (LSB) eingestellt. Nach dem 
verlassen des digitalen Fensters wird die Option wieder abgeschaltet.

Last Modification: 03 October 2009 11:10:25 EDT by K8UT. 

MMVARI für PSK und andere Sendearten (Digital - MMVARI for PSK 
and Other Modes)

1. Das MMVARI-Interface (The MMVARI Interface)

Das MMVARI-Soundkarten-Interface basiert auf der MMVARI-Maschine von Makoto 
Mori, JE3HHT. 

Die MMVARI-Maschine unterstützt die Sendearten PSK31, PSK63, PSK125, RTTY 
(U/L) und MFSK (U/L), sowie spezielle Codes für die asiatischen Sprachen mit 2-
Byte-Codierungen (MBCS) je Schriftzeichen.  

Die MMVARI-Maschine muss nicht getrennt installiert werden. Sie wird mit 
N1MMLogger zusammen ausgeliefert und ist als Digi-Programm im DI-Fenster 
voreingestellt.  

1.1. Das MMVARI-Interface-Fenster (The MMVARI Interface Window)
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Sie finden im MMVARI-Fenster mehrere Bereiche. Die genaue Frequenz wird aus 
der VFO-Frequenz +/- NF-Frequenz gewonnen und im DI und in der MMVARI-
Maschine in der Überschrift angezeigt. Sie sehen diese Anzeigen: 

• TX : Wird rot, wenn mit diesem Fenster auf Senden geschaltet wurde. 
• Letters/Figs : Invertiert die Dekodierung des mit der Maus markierten Text 

zwischen Bu- und Zi-Register 
• MouseOver : Zeigt den Text an, auf dem der Mauszeiger steht. 

• Receive Windows 1 and 2: (Empfangsfenster 1 und 2): Beide Fenster 
arbeiten auf die gleiche Art und können dafür verwendet werden, Rufzeichen 
aus dem Fenster zu greifen (to grab) und Sie in das Greif-Fenster (Grab) zu 
setzen. Sie unten zu Einzelheiten.

Links neben den RX-Fenster sehen Sie eine farbige Leiste. Diese Leiste hat zwei 
Aufgaben. Sie markiert das aktuell als Sendefenster arbeitende Fenster. Die Leiste 
wird rot, wenn gesendet wird. Wenn Sie auf die Leiste klicken, wird die Textausgabe 
in das Fenster angehalten und Sie können den Text bis zu 2000 Zeilen rückwärts 
durchrollen. Sie können Text markieren und abspeichern. Nach einem weiteren Klick 
auf die Leiste wird der inzwischen eingelaufene Text in das Fenster nachgeliefert.

Sie können mit zwei Methoden ein Rufzeichen aus dem empfangenen Text in das 
Logeingabefenster und das Greif-Fenster übertragen. Mit einem einfachen Klick wird 
ein erkanntes Rufzeichen in das Logeingabefenster gesetzt. Immer dann, wenn ein 
Rufzeichen im einlaufenden Text erkannt wird, wird es in das Greif-Fenster 
geschoben. Mit der Grab-Taste können Sie es aus dem Greif-Fenster holen.

Mit einem Klick auf eine empfangene Kontrollnummer wird diese in das 
Kontrollnummernfeld des Logeingabefensters kopiert, wenn dort bereits ein 
Rufzeichen eingetragen ist. 

Sie können mit einem Linksklick auf ein Signal im Spektrum oder im Wasserfall auf 
dieses Signal abstimmen und anschließend das Rufzeichen übernehmen. 

Die beiden RX-Fenster sind in ihrer Größe durch verschieben der Trennlinie 
veränderbar. Das Sendefenster hat eine feste Größe mit zwei Zeilen. 

• Transmit window (Sende-Fenster):  Hier können Sie Text frei eingeben. 
Wenn Sie auf die TX-Taste klicken, wird der Cursor in dieses Fenster gesetzt 
und der darin stehende oder eingegebene Text gesendet. 

• Callsign Textbox and Grab (Rufzeichenliste im Greif-Fenster): Jedes im 
Text erkannte Rufzeichen (Zeichenkette mit Leerzeichen davor und danach) 
wird in das Greif-Fenster übertragen und kann mit der Taste Grab in das 
Logeingabefenster gesetzt werden. Die Rufzeichenliste kann 10 Rufzeichen 
lang sein. Das jüngste Rufzeichen steht oben in der Liste und ist hell getastet. 
Mit einem Rechtsklick in dieses Fenster können Sie alle oder ein 
ausgewähltes Rufzeichen löschen. DUPE-Rufzeichen kommen nicht in das 
Greif-Fenster.

Hinweis: Wenn ein Rufzeichen schon im Logeingabefenster steht, wird es nicht mehr 
in das Greif-Fenster übertragen. 
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• Clr RX : Mit dieser Taste löschen Sie beide Empfangsfenster. Wollen Sie nur 
ein Fenster löschen, klicken Sie rechts in das Fenster und wählen Sie eine 
Option aus dem Menü. Im RUN-Modus wirkt dieser Rechtsklick nicht, dort wird 
das F2-Macro gesendet. Sie können das Lösch-Menü aber mit einem 
Rechtsklick in das TX-Fenster öffnen. 

• TX : Schaltet auf Senden. Der Cursor wird in das Sendefenster gesetzt. 
• RX : Schaltet auf Empfang, wenn alle Zeichen aus dem Sende-Puffer 

gesendet worden sind. Sie können das Senden unmittelbar mit der ESC-Taste 
abbrechen.  

• Macro buttons:  Sie können bis zu 24 Tasten des DI mit Texten 
programmieren. Programmieren Sie diese Tasten entweder mit dem Menü 
'Setup, Settings' oder klicken Sie rechts auf eine ausgewählte Taste und 
verwenden Sie das sich öffnende Editierfenster. 

• Grab : Überträgt ein ausgewähltes Rufzeichen aus dem Greif-Fenster in das 
Rufzeichenfeld des Logeingabefensters. Dieser Transport kann nur mit der 
Maus ausgelöst werden.  

1.2. Wasserfall- oder Spektrum-Fenster (The Waterfall or Spectrum 
Window)

 

• The digital engine window : Das Fenster der MMVARI-Maschine von Makoto 
Mori, JE3HHT verfügt über maximal neun Empfangskanäle und einen 
Sendekanal. Oben im Fenster steht die Frequenz Ihres Transceivers. Die 
Anzeige folgt der Abstimmung. Sie sehen zwei Cursoren, die zu zwei 
Empfangsfenstern gehören. Der gelbe Cursor gehört zum ersten 
Empfangsfenster, der rote gehört zum zweiten Empfangsfenster. Wenn Sie 
die Frequenz des ersten Fensters ändern wollen, setzen Sie den Mauszeiger 
auf ein empfangenes Signal und klicken Sie links darauf. Wenn Sie rechts 
darauf klicken setzen Sie die Frequenz für das zweite Fenster.

Die genaue Frequenz des Hauptkanals wird im DI und in der Überschrift der PSK-
Maschine gebildet aus VFO-Frequenz +/- NF-Frequenz angezeigt. Die übrigen 
Textfelder zeigen die Frequenz der Empfangsfenster. Ebenfalls angezeigt werden 
die IMD-Werte, die gewonnen werden, wenn das Signal im Leerlauf (ohne Text) läuft. 

• Tasten oberhalb des Wasserfalls/Spektrums (Buttons above the FFT) 
o TX : Schaltet auf Senden und setzt den Cursor in das TX-Fenster. 
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o RX : Schaltet nach dem Aussenden der Zeichen aus dem Sendepuffer 
auf Empfang. Ein sofortiger Abbruch des Sendens wird mit der Taste 
ESC ausgelöst. 

o AFC : Schaltet die AFC ein oder aus. Weiss=AFC eingeschaltet. 
o NET : Schaltet NET ein oder aus. Weiss = NET eingeschaltet. Die 

Sendefrequenz folgt der Empfangsfrequenz. 
o Align : VFO und NF-Frequenz werden so verstimmt, dass das 

gewünschte Signal auf die optimale Lage im Durchlassbereich gezogen 
wird. Die gewünschte Frequenzlage wird unter Setup eingestellt. 
Hollen Sie z.B. eine Signal bei 1400Hz am Rande des Filterbereichs in 
die Mitte bei 2100Hz. 

o Mode selection : Auswahl der Sendeart 
 BPSK – MBCS= Multibyte-Kodierung für asiatische 

Schriftzeichen, mögliche Baudraten 31.25, 62.5 und 125.0 
 bpsk : Europäische Schriftzeichen, mögliche Baudraten 31.25, 

62.5 und 125.0 
 rtty-L - BAUDOT (LSB) : fest auf 45,45 Bd eingestellt
 rtty-U - BAUDOT (USB) - fest auf 45,45 Bd eingestellt 
 MFSK-L - MFSK (LSB) : Baudraten 15.625 und 31.25 
 MFSK-U - MFSK (USB) : Baudraten 15.625 und 31.25 
 GMSK : MBCS= Multibyte-Kodierung, Baudraten 31.25, 62.5 

und 125.0 
 FSK : MBCS= Multibyte-Kodierung, Baudraten 31.25, 62.5 und 

125.0 
 FSK-W :  MBCS= Multibyte-Kodierung, Baudraten 31.25, 62.5 

und 125.0 
o Speed selection : Wahl der Geschwindigkeit für BPSK: 15.625, 31.25, 

45.45, 62.5, 125.0 oder 250.0 (bps) 
o Main Channel receive frequency: Empfangsfrequenz im Hauptkanal 
o Main Channel transmit frequency: Sendefrequenz im Hauptkanal 
o Main Channel IMD setting (S/N): IMD im Hauptkanal

• Wasserfall/Spektrum (The FFT) 
o Frequenzskala in der Kopfleiste 
o Marken 

 Ziffer 1 usw.: Empfangskanal 1 usw. 
 N: Lage des Notch-Filters 
 Hellblaue Linie: angewählte Empfangsfrequenz 
 Dunkelblaue Linie: Trägerfrequenz 

• Mausklicks
o Linker Mausklick: mit einem einfachen Klick in den Wasserfall wird die 

Sendefrequenz geändert 
 Rechter Mausklick: die genaue Sendefrequenz wird angezeigt 

und ein Menü geöffnet:
 Set notch on here : setzt das Kerbfilter (Notch) auf diese 

Frequenz, angezeigt wird eine Marke mit N. Es können 
mehrere Notch-Filter gesetzt werden. 

 Delete all notches : Lösche alle Notch-Filter
 Set TX carrier on here: Setze den Träger hierher. Eine 

dunkelblaue Linie wird hier angezeigt. 
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 Turn Off bandpass Filter : Das Bandpassfilter (BPF) 
wird ausgeschaltet 

Der grüne Balken links im Fenster zeigt den Signalpegel an. Die gelbe Linie zeigt die 
Lage der Squelchs an. Mit einem Klick in den grünen Balken verschieben Sie die 
Squelchschwelle.  

• Empfangsfenster unter dem Wasserfall (Receive channels below the 
FFT) 

o Unterhalb des Wasserfalls werden die Empfangkanäle angezeigt. Die 
Zahl der Empfangskanäle kann konfiguriert werden. 

o Mode (Sendeart): Wählt die Sendeart für diesen Empfangskanal. 
Möglich sind GMSK, FSK, FSK-W, BPSK, bpsk, rtty-L, rtty-U, MFSK-L 
oder MFSK-U 

o Speed (Baudrate): Baudrate für diesen Empfangskanal: 15.625, 31.25, 
45.45, 62.5, 125.0 oder 250.0 

o Receive channel frequency : Frequenz des RX-Kanals
o Receive channel IMD setting (S/N): IMD des empfangenen Signals
o AFC: An oder Aus. Weiss = AFC eingeschaltet
o Squelch indicator : Squelch-Schwelle, kann mit der Maus gezogen 

werden. 
o Wasserfall: zeigt einen 500Hz breiten Ausschnitt des Wasserfalls um 

das gewählte Signal herum. Mit einem Klick in diesen Ausschnitt 
können Sie den Cursor auf ein anderes Signal setzen. 

o Swap : Setzt die Sendesteuerung in dieses Empfangsfenster. Der 
Balken links im Fenster wird rot, wenn das Fenster die Sendesteuerung 
übernommen hat. Kehren Sie zum Hauptfenster zurück, wird der 
Balken wieder grün. Sie können mit diesem Fenster eine in der Nähe 
Ihrer Frequenz arbeitende Station anrufen und mit der Swap-Taste 
wieder zum Hauptfenster zurückgehen. 

• Menü in der Kopfleiste (Menu at the Top) 
o BPF : Schaltet ein zusätzliches Bandpassfilter zu, um eine störende 

Station zu unterdrücken. 
 Sie können folgende Filterbreiten wählen: Wide (breit) 1000 Hz, 

Middle (mittel) 500 Hz, Narrow (schmal) 250 Hz, Ultra Narrow 
(sehr schmal) 100 Hz, Custom (kundendefiniert)(Grayed out 
(grau=nicht aktiv)) 

 Sie können das Kundenfilter, das normalerweise nicht 
aktiv (grau) ist, so definieren: Klicken Sie links in den 
Wasserfall an den gewünschten Anfang des Filters und 
ziehen Sie bei gedrückter linker Maustaste den 
Mauszeiger an die Stelle, wo das Filter enden soll. Der 
Wasserfall zeigt unmittelbar die Wirkung des Filters. Sie 
können damit eine störende Station unterdrücken.

 Die minimale Bandbreite ist 100Hz. 
 Sie können das BPF über das per Rechtsklick erreichbare Menü 

oder einen Rechtsklick in den Wasserfall  mit Turn off 
abschalten. 

 Das BPF wird beibehalten, wenn Sie die MMVARI-Maschine neu 
starten.
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o ATC : -Mit der automatischen Taksteuerung (Automatic Timing Control) 
erreichen Sie eine bessere Synchronisation auf ein ankommendes 
Signal. Lassen Sie ATC am besten immer eingeschaltet. Wenn Sie 
RTTY starten ist es in der Regle ausgeschaltet, bei MFSK wird es 
eingeschaltet. 

o FFT :  FFT bedeutet Fast Fourier Transformation. Sie wandelt das 
empfangene Signalspektrum in einen auswertbaren Wasserfall oder 
eine Spektrumanzeige um. 

 FFT type : Sie können als Anzeige Spektrum, Wasserfall, Sync 
oder Sinussignal wählen 

 FFT Width : Breite der Anzeige, wählbar 250 Hz, 500 Hz, 1000 
Hz, 2000 Hz, 3000 Hz oder nutzerdefiniert (User Defined) 

 FFT Scale : vertikale Skala des FFT: 100 dB, 60 dB, 
quadratische Skalenteilung (Square Amplitude) 

 Waterfall AGC : schaltet die automatische 
Verstärkungsregelung für den Wasserfall ein/aus 

o SHIFT : Wahl der Shift: 170 Hz, 200 Hz, 23 Hz oder nutzerdefiniert 
(User Defined), nur wählbar in RTTY und GMSK

1.3. Macros

• Bei den MMVARI-Macros müssen Sie die S/E-Umschaltung mit den Macros 
TX ON {TX} or TX OFF {RX} in die editierten Texte einbauen

• Es gibt kein Macro zum sofortigen Sendeabbruch. Verwenden Sie dazu die 
ESC-Taste

• Verwenden Sie die Tasten TX und RX in den MMVARI-Fenstern, wenn Sie 
freien Text eingeben und senden wollen.

• Bei einem Start von MMVARI werden immer die zuletzt genutzten 
Einstellungen aktiviert.

2. Einstellung des digitalen Interfaces (Setting Up the Digital Interface)

Der Einstell-Dialog gilt für MMTTY und MMVARI, dabei gelten einige Einstellungen 
nur für MMVARI, einige nur für MMTTY und die meisten für beide. Wenn Sie die das 
Menü 'Setup > Settings' im DI-Fenster öffnen, wird er für MMTTY und MMVARI 
angezeigt. Informieren Sie sich über die Einstellungen im Kapitel Einstellung der 
digitalen Sendearten (Digital Setup). 

3. PSK mit MMVARI senden (MMVARI Example: Make a PSK 
Transmission)

• Machen Sie auf dem Bildschirm Platz für das DI-Fenster indem Sie das 
Packet/Telnet-Fenster minimieren.

• Öffnen Sie mit dem Menü 'Window > Digital Interface' das Digitale Interface 
(DI) und die Wasserfall/Spektrums-Anzeige. Sie können das DI-Fenster in der 
Größe verändern und an einen gewünschten Platz ziehen. 

• Mit einem Linksklick auf ein Rufzeichen im RX-Fenster wird das Rufzeichen 
übernommen (grab). Mit einem Rechtsklick in das RX- oder das TX-Fenster 
öffnet sich ein Menü im S&P-Modus oder es wird im RUN-Modus die 
Kontrollnummer gesendet. 
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• Mit einem Druck auf die Einfg-Taste wird das hell getastete Rufzeichen 
übernommen und das Rufzeichen gefolgt von der Kontrollnummer gesendet. 

• Mit einem Doppelklick auf ein Rufzeichen im Rufzeichenfeld des DI wird das 
Rufzeichen in das Rufzeichenfeld des Logeingabefensters übertragen.

• Ein Rufzeichen wird automatisch hell getastet, wenn es als Rufzeichen vom 
Programm erkannt worden ist. Voraussetzung für die Identifikation ist ein 
Leerzeichen vor und nach einer Zeichenkette. Ein Rufzeichen am Anfang 
einer Zeile wird nicht erkannt. 

4. MMVARI-Ergänzungen (MMVARI – Other)

• Die Frequenz , die im Wasserfall/Spektrum angezeigt wird, entspricht der 
genauen Signalfrequenz. 

• Die beim Programmende aktive PSK-Sendeart wird nach einem 
Programmneustart wieder aktiviert.  

• Während des Sendens kann kein Rufzeichen aus dem RX-Fenster 
übernommen werden.

Last Modification: 26 September 2009 15:18:36 EDT by K8UT. 

Unterstützung eines externen TNCs (Digital - External TNC Support)
Das Digitale Interface arbeitet nicht nur mit MMTTY, MMVARI und externen TNCs 

wie PK232, HAL DXP38, sondern mit JEDEM TNC. Die Kommandos für einen TNC 
sind nicht vom Programm festgelegt, sondern werden vom Nutzer TNC-bezogen 
programmiert. Zu einigen TNCs finden Sie weiter unten Angaben zur seriellen 
Kommunikation, das schließt aber nicht die Verwendung anderer TNCs aus. 

1. Das Digitale Interface (DI) (The Digital Interface)

Das DI kann mit einem beliebigen externen TNC verwendet werden:
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2. Einstellungen für einen TNC mit dem Configurer (Setting Up the TNC in 
the Configurer)

1. Starten Sie den N1MMLogger! 
2. Gehen Sie zu Config >Configure Ports, Telnet Address, Other > 

Karteikarte Digital Modes 
3. Im Digital Setup 

1. Wählen Sie Other als Interface 
2. Stellen Sie das Datenformat für Ihren TNC nach dessen Handbuch ein, 

z.B.: COM4 ,9600 Baud, 8N1, RST-Xon) 
3. Speichern Sie die Konfiguration mit < OK > 

4. Öffnen Sie mit dem Menü Window > Digital Interface das DI-Fenster
5. Erzeugen Sie auf der Taste oben links das Abort-Macro. Klicken Sie rechts 

auf die Taste und tragen Sie das/die  für den TNC benötigten Kommandos für 
eine unmittelbare Umschaltung auf RX ein. 

Für den PK-232 sieht dieses Macro so aus: {Ctrl+C}R{ENTER}

1. Sie sind nun bereit RTTY mit 45,45 Baud und einer Shift von 170Hz zu 
empfangen. Sie können zusätzlich noch Macros zum Umschalten auf andere 
Datenformate programmieren oder den TNC über in das TX-Fenster 
eingetragene Texte steuern. 

Zusätzlich benötigen Sie Kodes für das Schalten auf Senden und zurück auf 
Empfang. Ein CQ-Ruf mit dem PK-232 sieht so aus: X{ENTER} CQ CQ CQ TEST 
DE {MYCALL} {MYCALL} K Ctrl+D 

3. Testen Sie Ihren externen TNC (Test Your External TNC)

• Testen Sie den TNC allein stehend 
• Informieren Sie sich in den Kapiteln über den PK-232, KAM, HAL  weiter 

unten. Ist Ihr TNC dort nicht aufgeführt, entnehmen Sie seinem Handbuch die 
benötigten Kommandos für die beschriebenen Funktionen. 

Testen Sie den TNC an der vorgesehenen Schnittstelle mit einem 
Terminalprogramm, z.B. Hyperterminal aus dem Windows-Zubehör. Übernehmen 
Sie die Schnittstellenparameter dann nach N1MMLogger. Sie sollten in der Lage 
sein, ein RTTY-Signal mitzuschreiben und auf Senden zuschalten. 

4. Zusätzliche Macros für externe TNCs (Additional Macros for the 
External TNC Interface)

Das Digitale Interface akzeptiert die unten stehenden Macros. Die Macros können 
auch im Packet-Fenster verwendet werden: 

Ctrl+A Ctrl+B Ctrl+C Ctrl+D Ctrl+E Ctrl+F Ctrl+G 
Ctrl+H Ctrl+I Ctrl+J Ctrl+K Ctrl+L Ctrl+M Ctrl+N 
Ctrl+O Ctrl+P Ctrl+Q Ctrl+R Ctrl+S Ctrl+T Ctrl+U 
Ctrl+V Ctrl+W Ctrl+X Ctrl+Y Ctrl+Z Esc Enter
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Die Macros können in allen Macro-Tasten verwendet werden. Im TX-Fenster werden 
die Tastenkombinationen bis auf die ESC-Taste akzeptiert. Anstelle von ESC muss 
die Kombination Shift+ESC eingegeben werden.

In jedem Fall muss auf der ersten Taste oben links das Abort-Kommando 
programmiert werden. Der Inhalt dieser Taste wird nach Druck auf die Taste ESC an 
den TNC gesendet und stoppt eine Sendung unmittelbar.

Ergänzen Sie die Macros mit den TX/RX-Umschaltkommandos für den TNC. Das 
sind meist Ctrl+Buchstaben-Kombinationen. Belegen Sie Tasten RX und TX mit 
adäquaten Kommandos, um bei der freien Texteingabe auf Senden und zurück auf 
Empfang schalten zu können. 

5. Einstellung des HAL-DXP38 (HAL DXP38 Setup)

von Brian, K3KO 

Es wird vorausgesetzt, dass der DXP38 seine interne Software problemlos selbst 
lädt. Dazu müssen die neuesten Versionen von der HAL website 
http://www.halcomm.com für die Dateien *.lod und *.s28 bereit stehen. Schalten 
Sie auf LSB RTTY für FSK-Tastung und auf LSB für AFSK. Sie müssen drei Phasen 
abarbeiten: Hardwareeinstellung, Softwareeinstellung und Anwendung.

5.1. Hardwareeinstellung (Hardware Setup)

Versuchen Sie am besten den DXP38 mit dem RTTY-Programm von WF1B, mit HAL 
oder einem anderen bekannten Programm zum Laufen zu bringen. Sie können damit 
die Funktion der Hardware sicherstellen, ehe Sie sich mit Programmproblemen 
herumärgern. Gehen Sie so vor: 

1. Verbinden Sie die Leitungen für PTT und FSK mit dem Transceiver 
2. Verbinden Sie den TNC mit der COM-Schnittstelle (COM1 für das HAL 

Programm)
3. Verbinden Sie den NF-Ausgang des Transceivers mit dem DXP-38
4. Falls Sie AFSK machen wollen: Verbinden Sie den NF-Ausgang des DXP-38 

mit dem NF-Eingang des Transceivers 
5. Schalten Sie die Kombination ein 
6. Konsultieren Sie das Handbuch des DXP-38 zu Einzelheiten. Der Transceiver 

muss auf FSK RTTY (LSB) oder LSB für AFSK stehen. 

5.2. Softwareeinstellungen in N1MMLogger (Software Setup in 
N1MM logger)

Bei N1MMLogger sind drei Einstellungen vorzunehmen. Stellen Sie sicher, dass Ihre 
N1MMLogger-Versionen die Hexadezimal-Kommandos an den DXP38 schicken 
kann. 

Port configuration (COM-Schnittstelle): Wählen Sie eine als digital markierte 
Schnittstellen und setzen Sie DTR/RTS auf always on. 
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Digital configuration: Stellen Sie im digitalen Konfigurationsdialog für diese 
gewählte Schnittstelle diese Werte ein: 

• 9600 Baud, 8N1 und kein handshaking 

Macros zur Initialisierung und Steuerung des DXP38 (Macro Creation required 
to initialize and control the DXP38)

• Die Macros werden nicht in den Funktionstasten, sondern in den 24 Tasten 
des DI-Fensters editiert. 

o Empfehlung: Sie können bei den Macros einiges falsch machen. 
Sichern Sie den aktuellen und funktionierenden Status regelmäßig und 
laden Sie ihn wieder, falls Sie mit neuen Macros Probleme bekommen. 

• Kommandostruktur 
o Der HAL DXP38 erwartet Kommandos in der Form von zwei Hex-Bytes. 

Das erste Byte ist eine hexadezimale 80 und das zweite Byte enthält 
das Kommando. Manche Kommandos benötigen einen zweiten Satz 
von zwei Bytes mit den Parametern. Die Kommandos sehen so aus: 
{H8084}. Die geschweiften Klammern teilen N1MMLogger mit, dass es 
sich um eine Funktion und nicht um Text handelt. Das H steht für ein 
hexadezimales Format der Zahlen. Erlaubt sind nur die Zeichen  0-9 
und A-F . Die Verwendung anderer Zeichen innerhalb der {} erzeugt 
eine Fehlfunktion, der DXP38 schaltet z.B. auf Senden und kommt 
nicht wieder zurück auf Empfang. 

o Eingabefehler sind z.B. die Verwendung der falschen Klammern () oder 
[] statt {} , einer falschen Null (O statt 0) oder falscher Zeichen 

• Macro-Programmierung 
o Klicken Sie rechts auf eine Taste im DI-Fenster, das Editierfenster für 

diese Taste öffnet sich. Geben Sie die Kommandos im richtigen Format 
ein, wie {H80xx}. Beachten Sie die Syntax mit {} und H. Speichern Sie 
die digitalen Macros unter einem sinnvollen Namen, wie 'Other 1.mc' 
ab. 

o Sie finden die HAL-Kommandos in der technischen Dokumentation des 
DSP4100 TNC auf der HAL-Website 

o Unten sehen Sie einen Ausdruck eines Beispiels 
 Das ESC-Macros steht unter der TX, RX-Definitionbox (es ist 

nicht mehr das allererste) und 
 Das INIZE-Macro ist das Initialisierungs-Macro 

 Es ist als Folge von Anweisungen programmiert
 Das letzte Kommando ist eine Umschaltung auf Empfang 

als Hex-Kommando. Die Initialisierung enthält diese 
Einstellungen: FSK, BAUDOT, 45 baud, normal FSK 
mark, normal tones, USOS on, force to letters, TX/RX 
polarity the same, diddles on, squelch level set to 15, PTT 
delay =200 ms for XMIT and 100 ms for RX, transmit text 
echo and tuning indicator on 

 Für den Squelch sind drei Werte vorbereitet. Das zweite Wort 
des Kommandos lautet 80nn. ‚nn’ ist der Squelchpegel zwischen 
00 und 99. Die Kommandos RXnorm und RXinv schalten die 
RTTY-Kodierung in die normale bzw. die inverse Lage. Echo y 
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(Echo ‘ja’)) und Echo n (Echo ‘nein’) schalten die Wiedergabe 
des gesendeten Texts im Empfangsfenster ein und aus. 

 Fnar, Fmid, Fwide stellen die Filterbandbreite auf 55Hz, 75Hz, 
und 100Hz 

 B45 stellt die Baudrate auf 45 Baud. Wollen Sie eine andere 
Baudrate einstellen, verwenden Sie das Kommando 800x mit x 
=1, 2, 3, 4, 5 für 50, 57, 75, 100, 110 Baud.

 Tun on und Tun off schalten die Abstimmanzeige ein und aus: 
 Turn On :{H805D} 
 Turn Off : {H804D} 

Das Macro INIZE sieht so aus (N1MM-Website (Other files), Datei other 1.mc:

*,-
INIZE,{H8084}{H8085}{H80D1}{H80C0}{H80DB}{H80D3}{H805B}{H8089}{H80E3}
{H8002}{H80ED}{H8001}
                     {H80E8}{H8037}{H8000}{H805D}{H8059}{H800E}
*,-
RXinv,{H804C}
RXnorm,{H805C}
Echo y,{H8059}
*,-
*,-
SQlow,{H80E8}{H8015}
SQmid,{H80E8}{H8037}
SQhigh,{H80E8}{H8045}
B45,{H80E4}{H8000}{H800E}
*,-
Echo n,{H8049}
*,-
Tun Off,{H804D}
Fnar,{H80EB}{H8000}
Fmid,{H80EB}{H8001}
Fwide,{H80EB}{H8002}
*,-
*,-
*,-
*,-
Tun On,{H805D}
TX,{H800D}
RX,{H800E}
ESC,{H8006}

und sein Ergebnis ergibt diese Ausgabe:
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Erststart:

• Starten Sie zuerst N1MMLogger 
o Setzen Sie den Cursor in das RX-Fenster des TNC-Schirms. Schalten 

Sie dann den DXP38 ein. Funktioniert die Datenübertragung, meldet 
sich der TNC mit einem  ‚@’. Erzeugen Sie dann die Macros und 
speichern Sie die Konfiguration in einer Datei wie z.B. 'Other 1.mc' 

• Weitere Starts 
o Schalten Sie den DXP38 ein und starten Sie dann N1MMLogger. 

Klicken Sie auf das INIZE-Macro. Sie sehen den Initialisierungsprozess 
wie auf dem Bild weiter oben. Falls Sie die Funktionstasten noch nicht 
definiert haben, machen Sie das jetzt. Alle Texte müssen mit einem 
{RX} abgeschlossen werden, nur das Rufzeichen im S&P-Modus kann 
ohne {RX} bleiben. Verwenden Sie das Programm jetzt wie bei einem 
CW- oder SSB-Contest. Die Rufzeichenübernahme und die Ins-Taste 
funktionieren wie im CW-Modus. Das Initialisierungskommando bringt 
den TNC in den Sende-Modus. Die anderen Macros machen das nicht 
mit der Ausnahme, dass Sie Textzeichen, Leerzeichen oder ein {TX}-
Kommando enthalten. 

5.3. Bekannte Probleme (Known Problems)

Mir sind einige gelegentliche Probleme beim Start und beim Programmende 
aufgefallen: 
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Start:  Mitunter haben DXP38 und N1MMLogger Probleme miteinander zu 
kommunizieren. Der TNC nimmt die Initialisierungskommandos nicht an. Schalten 
Sie den TNC aus und warten Sie etwa 45 Sekunden. Beenden Sie N1MMLogger. 
Schalten Sie den TNC wieder ein und warten Sie, bis er die interne Initialisierung 
abgearbeitet hat (die LED hören mit Flackern auf). Starten Sie N1MMLogger wieder. 

Programmende: Wenn N1MMLogger runter fährt schaltet der DXP38 für die Hälfte 
der Zeit auf Senden. Schalten Sie am besten den DXP38 aus ehe Sie N1MMLogger 
beenden. 

6. Einstellung des HAL-ST-8000 (nicht unterstützt) HAL ST-8000 Setup 
(not supported)

Der HAL ST-8000 TNC kann von N1MMLogger nicht gesteuert werden, das er mit 45 
Baud gesteuert werden will und N1MMLogger 110 Baud als niedrigste Baudrate 
anbietet. 

7. KAM-Einstellung (KAM Setup)

• Starten Sie Hyperterm mit den Parametern 9600 Bd und 8N1, keine 
Flusssteuerung 

• Stecken Sie den KAM an die ausgesuchte Schnittstelle 
• Schalten Sie den KAM ein
• Wenn die Meldung des KAM erscheint, geben Sie einen ‘*’ zur Feststellung 

der Baudrate ein 
• Geben Sie Ihr Rufzeichen ein 
• Schalten Sie ihn mit ‘RTTY’ in den RTTY-Modus 
• Stellen Sie sicher, dass der KAM mit XFLOW = ON auf Software-Handshaking 

eingestellt ist
• Ist die Kommunikation hergestellt, können Sie am Transceiver ein RTTY-

Signal einstellen und es mit Hyperterm mitschreiben 
• Versuchen Sie mit Ctrl+C und einem "T" auf Senden zu schalten. Schalten Sie 

mit Ctrl+C und einem "R" zurück auf Empfang. 
• Konsultieren Sie bei Problemen das KAM-Handbuch 
• Verlassen Sie Hyperterm und starten Sie N1MMLogger.

RTTY-Kommandos für den KAM TNC 

AUTOCR 0 AUTOLF ON AUTOSTRT OFF 
BKONDEL ON CD SOFTWARE CRADD OFF 
DIDDLE ON ECHO ON FILTER OFF 
FSKINV OFF INVERT OFF LFSUP OFF 
LOWTONES OFF MARK 2125HZ RBAUD 45 
SHIFT 170 SPACE 2295HZ USOS ON 
XFLOW ON XMITECHO ON

Unter N1MMLogger müssen Sie diese drei Abschnitte für die Arbeit mit dem KAM 
abarbeiten:  

1. Schnittstelle einstellen 
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o Wählen Sie im Configurer eine Schnittstelle als ‘digital’ aus.

2. Digitale Schnittstelle einstellen

o Stellen Sie für die digitale Schnittstelle diese Werte ein: 9600 Baud, 
8N1 und kein Protokoll 

3. Macros für den KAM erzeugen 

o Setzen Sie das Macro TX auf: Ctrl+C}T (schaltet auf Senden)
o Setzen Sie das Macro RX auf: Ctrl+C}E (schaltet auf Empfang)
o Setzen Sie das Macro ESC auf : Ctrl+C}R (bricht Sendung ab)
o Beispiel für einen CQ-Ruf:

 CQ macro: {TX} CQ CQ CQ DE W3PP W3PP W3PP KKK {RX} 

8. PK-232 einstellen (1) (PK-232 Setup)

• Stellen Sie sicher, dass der PK-232 auf Autobaud steht und auf RTTY 
eingestellt ist 

• Starten Sie Hyperterm mit 1200 Baud, 8N2 und ohne Flusssteuerung
• Stecken Sie den PK-232 an die gewählte Schnittstellen und schalten Sie in ein 
• Geben Sie einige "*"ein, damit der PK-232 die Baudrate von 1200 Baud 

erkennt 
• Schalten Sie den PK-232 nit dem Kommando "BAUDOT" in den RTTY-Modus. 

Er antwortet mit OPMODE now BAUDOT 
• Drehen Sie das Schwellwert-Pot im Uhrzeigersinn auf bis die LED leuchtet.
• Stellen Sie das Protokoll auf XFLOW = ON 
• Stellen Sie am Transceiver ein RTTY-Signal ein und schreiben Sie es mit. 
• Geben Sie ein "X" gefolgt von einem zu sendenden Text ein und schalten Sie 

dann mit Ctrl+C und einem "R" wieder zurück auf Empfang
• Konsultieren Sie bei Problemen das Handbuch 
• Verlassen Sie Hyperterm und starten Sie N1MMLogger.

8.1. PK-232 einstellen (2) (Setting up the PK-232)

von John VK4WPX / VK4CEJ 

Das Einstellen des PK-232 für RTTY ist einfach:  

• Öffnen Sie die 'Configurer' > Config, Configure Ports, Telnet addresses,  
Other 

• Klicken Sie auf den Karteireiter Hardware  
o Wählen Sie eine COM-Schnittstelle für den PK-232 und machen Sie 

einen Haken bei 'Digital' wie in dem Bild unten (hier COM2)
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• Gehen Sie dann zur Karteikarte Digital Modes und stellen Sie das Digital 
Interface 1 so ein wie im Bild zu sehen: 9600 Baud, 8N1 und keine 
Flusssteuerung
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Ebenfalls einfach ist die Belegung der F-Tasten:  

• Übernehmen Sie die vorhandenen Macros und ersetzen Sie das Macro {TX} ' 
jeweils mit ' Ctrl+C}Xmit{ENTER} ' 

o Ich fand, dass die Kommandos ein abschließendes {ENTER} benötigen
o Ersetzen Sie alle {RX} durch Ctrl+D} 

• Ein Beispiel für die CQ-Taste F1 ist: " Ctrl+C}Xmit{ENTER}CQ CQ CQ DE * * * 
KCtrl+D} " 

• Ein Beispiel für F5 macro "Hiscall" ist " Ctrl+C}Xmit{ENTER}! " 
o Es lässt den Transceiver im Sendezustand und Sie können weitere 

Eingaben machen
o Zum Umschalten auf Empfang geben Sie Ctrl+D 

9. Einstellung des PTC von SCS (SCS PTC Setup)

• Starten Sie ein speziell für den PTC geschriebenes Programm wie ALPHA 
(von DH7RG), XPWIN (von KF7XP), LOGGER (von K4CY) 

• Stellen Sie am PTC eine feste Baudrate mit SERBAUD 19200 ein. Verwenden 
Sie NICHT AUTO !. Schalten Sie den PTC wieder aus.

• Starten Sie  N1MMLogger und gehen Sie dort zu 'Config >Configure Ports,  
Telnet Address, Other'. Öffnen Sie die Karteikarte 'Digital Modes'. Stellen 
Sie das 'Digital Interface 1 TU Type ‘ auf 'CW/Other' und wählen Sie die 
Daten der seriellen Schnittstelle mit 19200 Baud, N-8-1-none. Stellen Sie das 
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‚Digital Interface 2 TU Type ‘auf None‘. Speichern Sie die Einstellung mit 
'OK' 

• Wählen Sie unter Windows > Digital Interface 
• Stecken Sie den PTC an die programmierte serielle Schnittstelle und schalten 

Sie ihn ein. Im Fenster muss die Statusmeldung des PTC und anschließend 
die Kommandoanforderung Cmd: erscheinen.

• Klicken Sie in das Sendefenster unten und geben Sie Escape+Shift  bau 45 
ENTER ein. Der PTC schaltet in den RTTY-Modus. Geben Sie dann 
'Escape+Shift  term 1  ENTER' ein, um das Echo im RX-Fenster 
auszugeben. 
Hinweis: Sie benötigen ESC als Einleitung eines PTC-Kommandos, müssen 
es aber als Shift+ESC eingeben, weil ein einfaches ESC den Cursor in das 
Logeinagbefenster setzt. 

• Gehen Sie im DI-Fenster zum Menü 'File > Settings' und dort zur Karteikarte 
'Macro Setup'. Wählen Sie 'Digital Macro Set' 'Other 1'. Sie sehen die drei 
Tasten TX, RX and ESC, die Sie als erstes programmieren müssen: 

o TX-Taste: Ctrl+Y}  > schaltet den PTC auf Senden. Im weiteren 
können Sie das Macro {TX} für diese Funktion verwenden

o RX-Taste: Ctrl+Y} > schaltet wieder auf Empfang. Im weiteren können 
Sie das Macro {RX} für diese Funktion 

o ESC-Taste: {ESC}CLR{ENTER}Ctrl+D}{ENTER} > dieses Macro 
bricht die Sendung ab, setzt den PTC zurück und löscht den 
Sendepuffer

• Sie können maximal 24 Tasten im DI-Fenster mit nützlichen Funktionen 
belegen, eine davon schaltet den PTC in den RTTY-Modus. Sie können Sie 
nach dem Start des DI unter N1MMLogger verwenden: 

o Tastenname: RTTY 
o Macro: {ESC}clear{ENTER}{ESC}bau 45{ENTER}{ESC}term 1{ENTER} 

• Mit weiteren Macros können Sie QSO-Texte wie !, *, DATE, TIME usw. 
programmieren. Vergessen Sie die S/E-Umschaltung mit {TX} und {RX} nicht.

• Informieren Sie sich im Kapitel zu den Macros über weitere Möglichkeiten.

Last Modification: 03 October 2009 11:11:20 EDT by K8UT 
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Einen Contest fahren (Operating a 
Contest)

Vor dem Contest (Before the Contest)

1. Beginn der Contestsaison (Start of the contest season)

Mit dem Herbst kommen die großen Conteste. Sie sollten Ihre Station auf diese Zeit 
vorbereiten. 

1.1. Für alle Stationen (All Stations)

• Drucken Sie sich die Tastenzuweisungen (key assignments) aus und heben 
Sie die wichtigen Tasten mit verschiedenfarbigen Markierstiften hervor. 

• Lernen Sie, wie man Frequenzen in das Rufzeichenfeld des 
Logeingabefenster einträgt, z.B. 14022 für einen Bandwechsel. Oder die 
letzten zwei oder drei Ziffern für einen Frequenzwechsel innerhalb eines 
Bandes wie auf 80m eine 22 für 3522 oder 795 für 3795. 

• Lernen Sie den Splitbetrieb einstellen: Auf 40m setzt ein 214+[Ctrl+ENTER] 
die Sendefrequenz auf 7214, wenn noch kein Rufzeichen eingegeben wurde. 
Ist schon ein Rufzeichen eingetragen, können Sie mit Alt+F7 die Splitfrequenz 
eingeben. Mit einem weiteren Alt+F7 ohne Eingabe einer Frequenz kommen 
Sie wieder zurück. Auch mit ESC kommen sie zurück aus dem Split-Modus.  

• Programmieren Sie die mit den Pfeiltasten erzielbaren Schrittweiten im 
Configurer.  

• Machen Sie sich mit der Rufzeichenprüfung vertraut. Fragen Sie die 
Gegenstation, ob Sie das richtige Rufzeichen übernommen haben.  

• Verwenden Sie in CW den ESM-Modus. Es reduziert den Stress und Sie 
brauchen sich keinen Kopf darüber zu machen, welche Taste Sie als nächste 
drücken müssen, vor allem wenn Sie bald einschlafen. 

• Machen Sie sich mit der Bandskala und der Rufzeichenübergabe in das 
Logeingabefeld vertraut. Achten Sie auf die fettmarkierten selbstgespotteten 
Stationen, die sie noch nicht erreicht haben und bei denen Sie es später noch 
einmal versuchen können. Sie sparen eine Menge Zeit damit. Stationen, die 
Sie schon erreicht haben, erscheinen in Grau beim Abstimmen, auch über 
dem Rufzeichenfeld, so dass Sie beruhigt weiter drehen können.

• Stellen Sie sicher, dass Sie vor dem Contest eine aktuelle Länderliste 
wl_cyt.dat aus dem Internet geholt und unter N1MMLogger installiert haben 
(Zwei Schritte nötig!!).  

• Haben Sie während eines Contests Ärger mit einer Station, die sich 
zweifelsfrei einem Land zuordnen lässt, setzen Sie das richtige Land vor das 
Rufzeichen wie W8/N8SS und loggen Sie sie mit Ctrl+Alt+Enter. Sie können 
dann einen Kurzkommentar zu dem Rufzeichen anfügen. Oder Sie gehen zum 
Menü Tools > Add call to country und ordnen Sie das Rufzeichen einem 
bekannten Land zu. Sie sollten eine Kopie der cty.dat-Länderliste an der 
Station greifbar haben.  
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1.2. Unterstützte oder Multi-Stationen (Assisted or Multi-op 
Stations)

• Mit dem Fenster der Bereitstehenden Multis und QSOs (Available Window) 
können Sie Ihre Bandstrategie steuern. Bänder mit vielen Multis und QSOs 
sind offensichtlich offen und bieten neue QSOs. 

• Eine kräftige Station kann die Bandskala nutzen und von Spot zu Spot 
springen. Stellen Sie aber sicher, dass das gespottete Rufzeichen auch das 
richtige ist. Hier werden viele Fehler gemacht. 

• Entfernen Sie fehlerhafte Rufzeichen mit Alt+D. Steht das Rufzeichen schon 
im Rufzeichenfeld, wird es mit ALT+D entfernt. Wenn Sie ein Rufzeichen ais 
der Bandskala entfernen wollen, klicken Sie dort rechts und verwenden Sie 
das passende Menü zum Streichen.  

• In ruhigen Zeiten sollten Sie die Antenne drehen, um das Band von 
gespotteten Station zu säubern. Sie können auf die Antennenrichtung (Beam 
heading) klicken und die Liste nach Antennenrichtung sortieren, um die 
Stationen mit einer minimalen Rotordrehung arbeiten zu können. Klicken Sie 
einmal in den Spaltenkopf, dann werden die Gradzahlen in aufsteigender 
Reihenfolge geordnet, bei einem zweiten Klick erfolgt die Ordnung in 
absteigender Reihenfolge. Um die Antennenrichtung zu sehen, müssen Sie 
das Available-Fenster breit genug ziehen, sonst ist die Richtungsspalte nicht 
zu sehen. 

• Stellen Sie Zeitdauer der Anzeige der Spots entsprechend den Bedingungen 
ein. In Spitzenzeiten sollten Sie auf 20min heruntergehen, in ruhigen Zeiten 
können Sie längere Zeiten einstellen. Sie können auch den Quellkontinent der 
Spots wählen, um Richtungen auszuschließen, die nicht aktuell sind.  

• Versuchen Sie es mit dem Rufzeichenstapelspeicher. Bei Multi-OPs können 
sich die Stationen gegenseitig auf Stationen aufmerksam machen oder wenn 
zwei Ops an einer RUN-Station arbeiten, kann einer dem anderen gehörte 
Rufzeichen aufbereiten. Auch bei Contesten mit über das Internet gekoppelten 
Stationen wie dem IARU-Contest ist diese Option nützlich.

73, Tom - N1MM 

2. Contestregeln überprüfen und testen (Check the Contest Rules and if 
the Contest Program Uses Them Correctly)

N1MMLogger ist ein freies Programm, es wurde von Freiwilligen geschrieben und 
nach besten Kräften getestet. Bei der großen Zahl an verschiedenen Contesten kann 
es aber vorkommen, dass N1MMLogger Fehler bei der Auslegung der Contestregeln 
macht. Bitte testen Sie N1MMLogger und überprüfen Sie, ob das Programm die 
Contestregeln in allen Punkten einhält. Machen Sie ausreichend weit vor dem 
Contest einen Probelauf und schauen Sie nach, ob sich das Programm so verhält, 
wie es sich nach den neuesten Contestregeln verhalten soll.  Wenn Sie Probleme 
feststellen, schreiben Sie uns eine Email und wir können mögliche Fehler noch vor 
Contestbeginn beheben. 

David Robbins K1TTT 
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3. Aktualisierung des Rufzeichengeschichte (Update the Call History 
Lookup File)

In zahlreichen Contesten kann man aus dem Rufzeichen die zu erwartende Kontroll-
Information ableiten. Diese wird gleich nach der Eingabe des Rufzeichens 
vorgeschlagen. Ergebnisse der Rufzeichengeschichte sind zu erwarten bei den 
ARRL-DX-Contesten (US/VE-Staat), bei Fernschreibcontesten (Name der 
Gegenstation aus der Datei Friends.ini), das Alter in den AA-Contesten oder die 
WWFelder in UKW-Contesten. In der Rufzeichengeschichte wird nachgesehen, 
wenn das Rufzeichen im Rufzeichenfeld steht und mit Leertaste oder TAB 
abgeschlossen wurde.

Aktualisieren Sie die Datei der Rufzeichengeschichte (Call History file) oder 
erzeugen Sie eine neue Datei, wenn der aktuelle Contest es ermöglicht. 
Einzelheiten zur Rufzeichengeschichte  finden Sie im Kapitel Erweiterte Funktionen 
(Advanced Functions chapter  ).   

4. Import und Export der Funktionstasten-Texte (Importing and Exporting 
Message Function Keys)

Die CW-Texte und die SSB-WAV-Dateien lassen sich in gewissem Umfang von 
Contest zu Contest übertragen oder für einen bestimmten Contesttyp vorbereiten, 
abspeichern und später wieder abrufen. 

Wählen Sie die Option File >Export >Export Function Keys to >File >CW 
Function Keys um die CW-Tasten abzuspeichern. Wählen Sie die Option File 
>Import >Import Function Keys from File >CW Function Keys um einen 
vorhandenen Satz zu importieren.

5. Bereit sein für den CQWW und andere Conteste (Getting Ready for 
CQWW (and other contests))

Top-Contester machen sich vor einem großen Contest eine Checkliste. Fügen Sie 
diese Punkte dieser Liste hinzu: 

1. Machen Sie vor dem Contest einige Dutzend Test-QSO, sowohl im S&P-
Modus als auch im RUN-Modus. Schalten Sie mit der F1-Taste vom S&P-
Modus in den RUN-Modus. Überprüfen Sie die Funktionszuweisungen im 
'Configurer > Karteikarte Function Keys ' . Klappern Sie alle benötigten F-
Tasten durch und testen Sie Ihre Funktion und den Text.

2. Testen Sie die folgenden Optionen durch, falls Sie sie verwenden wollen:  
1. ESM: QSOs mit ENTER fahren 
2. Vervollständigung von bekannten Rufzeichen (Autocompletion) 
3. Multi-OP-Contest 
4. Sende führende Nullen (send leading zeros) 
5. Wiederhole Rufzeichenkorrekturen (Send corrected call) 
6. Transceiver-CAT-Steuerung (Radio interface) 
7. Verbindung zu einem Packet-DXCluster (Packet connection) 
8. Verbindung zu einem Internet-DXCluster (Telnet connection) 

3. Aktualisieren Sie die Datei CTY.DAT (abholen, installieren und testen). 
Überprüfen Sie das Datum mut einem Klick in das Fenster About. 
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4. Holen Sie sich die neueste Datei MASTER.DTA und speichern Sie sie im 
N1MMLogger-Verzeichnis ab. 

5. Bereiten Sie die CW/SSB/RTTY-Tasten vor und testen Sie sie.
6. Überprüfen Sie Ihre Station bezüglich HF-Einstreuungen. Halten Sie 

Klappferrite bereit.
7. Machen Sie sich mit den Contestregeln vertraut und füllen Sie den Contest-

Dialog entsprechend aus. Geben Sie beim CQWW unter Exchange nur die 
Zonennummer ein. 

8. Machen Sie eine Probeausgabe des Cabrillo-Logs und sehen Sie, nach ob die 
Daten korrekt sind. 

9. Synchronisieren Sie die Uhrzeit des/der PC(s) mit der genauen Internetzeit mit 
einem Programm wie Dimension 4 und wiederholen Sie die Synchronisation 
falls benötigt regelmäßig während des Contests. 

10. Legen Sie einen Ausdruck der Tastenzuordnungen ("Key Assignments") 
bereit. Sie finden ein ausdruckbares Exemplar auf der N1MM-Website unter 
'Downloads' im Abschnitt 'Other Files'. 

73, & GL in the contests 

Tom Wagner - N1MM 

6. WAV-Dateien für einen SSB-Contest aufzeichnen (How to Record WAV 
Files for the Function Keys Used in SSB Contests)

von Tom, N1MM. 

1. Ich verwende das Programm Cool Edit 96 
2. Lassen Sie am Anfang der Aufzeichnung eine leere Strecke von 5 Sekunden
3. Zeichnen Sie alle Zeichenketten und Redewendungen hintereinander ohne 

Pause auf einer WAV-Datei auf. Nehmen Sie jeden Text mindestens zweimal 
auf.  

4. Speichern Sie diese Datei als Rohversion ab.
5. Verwenden Sie die Rauschreduktionsfunktion des Programms. Beziehen Sie 

sich bei der Einstellung auf das leere Stück am Anfang und lassen Sie dann 
die Rauschreduktion über die ganze Datei laufen.

6. Speichern Sie die behandelte Datei als “rauschreduziert” ab. 
7. Versuchen Sie es dann mit Bassreduzierung, Höhenanhebung, Kompression 

und ähnlichen Werkzeugen. Machen Sie immer eine Zwischenspeicherung. 
8. Teilen Sie erst zum Schluss die Datei in die einzelnen Nachrichten und 

suchen Sie sich die jeweils beste Version heraus 

Mit der Hintereinander-Aufzeichung werden die Einschalt- und Abschaltspitzen 
vermieden und Wortklang und –fluss wirken einheitlicher und von gleicher 
Lautstärke,

Uffe, PA5DD, hat weitere Empfehlungen zu diesem Thema: 

Ein anderes brauchbares Programm ist Audacity. Es ist Freeware. Mit ihm kann 
man die Datei auf einen einheitlichen Pegel bringen. Um diese Einstellung zu 
machen, zeichnete ich einen 10 Sekunden langen 800 Hz-Ton auf, wies ihn der 
Taste F7 zu und speicherte die Datei unter cal.wav ab. Wenn ich die Kompression 
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abschalte und diese Datei auf meinen Transceiver gebe, kann ich dort die optimale 
Aussteuerung einstellen. Anschließend kann ich die Kompression wieder zuschalten 
und eventuell noch ein bisschen aufdrehen.  

 Audicity Anomaly 
Wenn Sie SSB-Aufzeichnungen mit AUDACITY machen, müssen Sie eine 
Sampling-Rate von 44100 Hz einstellen. Sonst bekommen Sie Splatter am Ende 
jeder Aufzeichnung.  

Ordnen Sie Teildateien im  Verzeichnis N1MMLogger\wav an und geben Sie ihnen 
diese Namen: 

• cq.wav 
• <eigenes Rufzeichen>.wav 
• 59.wav usw. 

Wenn Sie die Buchstabierwörter für Buchstaben, Zahlen und Sonderzeichen 
erzeugen, müssen Sie sie im Verzeichnis N1MMLogger\letters ablegen. 

Beispiele:

• 1 = letters\1.wav 
• 2= letters\2.wav usw… 
• ? = letters\query.wav 
• / = letters\stroke.wav 

Mario, S56A, N1YU, hat diese Aufzeichnungen erzeugt

• Ich zeichnete CQ CONTEST FROM S56A S56A CONTEST, S56A, THANKS 
S56A, THANKS 599 15 in einer Sitzung auf. 

• Ich verwendete den 20 dB MIC-Vorverstärker der Soundkarte und sprach 
einige Worte vor der eigentlichen Aufzeichnung, damit sich die ALC 
einschwingen konnte. Ich verwendete 8 Bit/11K sampling 

• Anschließend stellte ich den grafischen Equalizer auf 125 Hz cutoff, flat 
settings on 250 and 500 Hz, +7 dB on 1 kHz, +14 dB on 2 kHz and - 18 dB on 
4 kHz 

• Der Ausgang wurde auf eine flache Hüllkurve optimiert und normalisiert. Das 
Ergebnis ist kein HiFi, aber optimierter SSB-Klang. 

 Windows-Töne 
Wenn Sie WAV-Dateien senden wollen, müssen Sie in der Windows-
Systemsteuerung die Windows-Töne abschalten! 

7. Fenstermarkierung hervorheben (Making the Window Focus More 
Distinctive)

von Pete, N4ZR 

Das Windows-Farbschema macht es nicht besonders einfach, unter mehreren 
geöffneten Fenstern das aktuell aktive schnell zu erkennen. Das gilt speziell im 
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SO2R-Modus. Sie können aber mit den Windows-Werkzeugen die Kennzeichnung 
des aktiven Fensters deutlicher herausheben. Gehen Sie so vor (bis Windows XP):

• Klicken Sie rechts an eine leere Stelle im Desktop 
• Es öffnet sich das Menü „Eigenschaften von Anzeige“
• Gehen Sie im Menü zur Karteikarte Darstellung 
• Wählen Sie unter Fenster und Tasten die Einstellung Windows Classic 
• Klicken Sie auf die Taste Erweitert
• Wählen Sie aus dem Menü „Titelleiste des aktiven Fensters“
• Weisen Sie dieser Leiste eine auffälligere Farbe zu, z.B. dunkelrot für aktiv 

und grau für inaktiv.
• Anschließend können Sie noch die “Rahmen für aktives Fenster” und 

“Rahmen für inaktives Fenster” Ihren Wünschen anpassen
• Speichern Sie diese Einstellungen unter einem eigenen Namen, z.B. N1MM 

ab. Wollen Sie die Einstellungen aktivieren, gehen Sie den oben 
beschriebenen Weg bis Windows Classic und wählen Sie dort N1MM.

Mit dem gleichen Menü können Sie auch die Beschriftung der Fenster auf eine 
Schriftart Ihrer Wahl ändern.

Last Modification: 26 September 2009 15:25:23 EDT by K8UT. 

Während eines Contests (During the Contest)

1. Das Szenario (The Scenario)

Sie sind gut auf den Contest vorbereitet, sie wissen, wie Sie die Frequenz, das Band 
und die Sendeart wechseln. Das Programm hat keine Geheimnisse für Sie. Sie 
brauchen nur noch QSOs und Multis zu arbeiten und Sie haben eine gute Strategie. 
Sie haben das Handbuch in Griffweite, aber Sie brauchen es nicht mehr. Die Liste 
mit den Tastenfunktionen liegt ebenfalls bereit und mit einem kurzen Blick sind Sie 
informiert.

Sie wissen, dass Ihre Version keine versteckten Mängel hat, denn Sie haben sie 
ausführlich getestet. Probleme, die Sie hatten, haben Sie den Programmierern 
mitgeteilt und die haben sie lange vor dem Contest behoben. 

Sie haben Ihre Datenbank vorbereitet, die Tasten programmiert und die WAV-
Dateien aufgenommen.  

Es kann nichts mehr schief gegen, Sie sind vorbereitet !!

2. Während des Contest festgestellte Probleme (Bugs Encountered 
During a Contest)

Sollte Ihnen entgegen den vorstehenden Worten während eines Contestes doch ein 
Problem auffallen, teilen Sie es bitte nach dem Contest oder schon während des 
Contests an Tom, N1MM, mit. Tom nimmt an vielen Contesten teil, liest aber auch 
die einlaufende Post während eines Contests und kann Ihnen Tipps geben.
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. 

Sie können während eines Contests die Probleme unter den Notizen zu einem QSO 
ablegen und nach dem Contest mit View > Notes durchsehen. 

Last Modification: 26 September 2009 15:27:00 EDT by K8UT. 

Nach dem Contest (After the contest)

Nach dem Contest sind die Punkte berechnet worden und das Log wurde 
abgeschickt. Trotzdem gibt es mitunter noch Arbeit:  

1. QSOs nach dem Contest eintragen (Entering QSOs After the 
Contest)

Das Programm stellt Ihnen einige Werkzeuge zum schnellen Eintragen eines 
Papierlogs zur Verfügung. Dabei können Sie Zeiteingabe über die Interpolation 
vereinfachen, was vor allem bei der Eingabe eines Blocks interessant ist, denn die 
meisten Veranstalter sind bei der Uhrzeit relativ großzügig. Bei der Eingabe von 
wenigen QSOs können Sie aber bei der alten Methode bleiben.

1.1. QSOs von Hand eingeben (Enter QSOs)

Vorschlag zu einem Verfahren mit Eingabe in das Logeingabefenster: 

• Geben Sie die Bandfrequenz ein, dann ENTER 
• Geben Sie nacheinander Rufzeichen und Kontrollnummer wie beim Contest 

ein. Machen Sie sich keine Gedanken über die Uhrzeit. Die kommt noch.
• Geben Sie bei einem Bandwechsel wieder zuerst die Frequenz ein und dann 

die QSOs auf diesem Band. 

Beispiel:
   7000 Enter
   W1ABC 35 CT Enter
   W2XYZ 55 MA Enter
   14000 Enter
   W5JOE 42 TX Enter
   ... 

1.2. Datum/Zeit korrigieren (Change Time/Date for a Single Hand-
Entered QSO)

Sie können einen Zeitstempel über das Rufzeichenfeld eingeben. Geben Sie die 
UTC-Zeit beginnend mit einem ‚T’ ein, z.B. ‘T1234 für 12:34z.  Wenn Sie den 
Zeitstempel eingeben, wird die Uhrzeit des zuletzt eingegebenen QSOs korrigiert.  

1.3. Datum/Zeit eines von Hand eingegebenen Blocks korrigieren 
(Change TIme/Date for Multiple Hand-Entered QSOs)
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 Machen Sie eine Kopie Ihres Logs und verwenden Sie nur diese Kopie für Ihre 
Korrekturen. Eine einmal gemachte fehlerhafte Zeitinterpolation kann nicht 
rückgängig gemacht werden.
 
Wollen Sie Datum/Zeit eines von Hand eingegebenen QSO-Blocks ändern, gehen 
Sie so vor: 

• Setzen Sie den Cursor auf das erste QSO des Blocks und klicken Sie einmal 
darauf. Das QSO wird hell getastet.

• Klicken Sie dann rechts in das Log 
• Wählen Sie Set Start Interpolation Time Row 
• Geben Sie die gewünschte Startzeit ein und klicken Sie auf  <OK> 
• Setzen Sie den Cursor auf das letzte QSO des Blocks, klicken Sie einmal 

links. Das QSO wird hell getastet.
• Klicken Sie rechts in das Log 
• Wählen Sie im Menü Set Stop Interpolation Time Row 
• Geben Sie die gewünschte Endezeit des Blocks ein und klicken Sie auf <OK> 

 Änderung von QSO-Zeit und Datum 
Dieses Werkzeug ändert die Zeit eines ausgewählten QSO-Blocks. Diese Änderung 
kann NICHT rückgängig gemacht werden. Haben Sie viele QSOs im 
handgeschriebenen Log oder sind sie in größeren Zeitabschnitten gemacht worden, 
teilen Sie sie in mehrere Blöcke und geben jeweils die Anfangs- und die Endzeit des 
Blocks ein. 

2. Alle QSOs um einen festen Zeitbetrag verschieben (Change All QSOs 
Time/Dates by a Fixed Amount)

 Speichern Sie Ihr Log vorher zur Sicherheit 
Sie können zwar einen Eingabefehler problemlos rückgängig machen, aber sicher ist 
sicher..
Mit diesem Werkzeug können Sie alle QSOs eines Logs um einen bestimmten 
Zeitbetrag verschieben: 

• Setzen Sie den Cursor auf das Log und klicken Sie rechts 
• Wählen Sie im sich öffnenden Menü Change All Contest Timestamps by a 

Fixed Amount 
• Geben Sie in das sich öffnende Fenster den Betrag in Minuten ein, um den 

Sie die Zeiten im Log verschieben wollen (+ oder -).

Wenn Sie dabei eine Tagesgrenze überschreiten, wird das Datum automatisch 
korrigiert. Mit der Eingabe +1440 verschieben Sie das Log um einen Tag nach vorn 
und -2880 um zwei Tage zurück. 

3. Cabrillo-Datei erzeugen (How to Create Cabrillo Files)

Das Cabrillo-Log hat sich bei den meisten Contesten durchgesetzt. Es besteht aus 
einem Kopf mit den Daten der eigenen Station und dem Log ohne Punkt- und Multi-
Angabe. Diese Werte werden beim Veranstalter einheitlich ausgerechnet. Nur eine 
„claimed score“, also die eigene Punktberechnung wird gemeldet. 

• Gehen Sie zum Menü File >Export >Export Cabrillo to file... 
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o N1MMLogger erzeugt eine contestbezogene Cabrillo-Datei 
o Sehen Sie sich die Cabrillo-Datei mit einem Texteditor an und 

überprüfen Sie die Angaben zu eigenen Station
o Stellen Sie Fehler fest, überprüfen Sie mit Config >Change Your 

Station Data und den Contestnamen mit File >Choose Which 
Contest to Log und erzeugen Sie eine neue Cabrillo-Datei 

o Für die eigene Chronik können Sie auch noch die Punkte neu 
berechnen. Wählen Sie Tools >Rescore Current Contest .

o Eine Cabrillo-Datei wird unter dem Namen <eigenes Rufzeichen>.LOG 
im N1MMLogger-Verzeichnis erzeugt. Unter diesem Namen erwartet 
der Contestveranstalter Ihr Log. Benennen Sie sie u.U. anschließend 
um.

Sehen Sie im Kapitel Technische Informationen (  Technical Information)   nach, 
welche Dateien noch aus dem Contestlog erzeugt werden können, wie ADIF-
Dateien, Punktübersicht usw. 

4. Log ausdrucken (How to Print the Log)

N1MMLogger enthält kein Werkzeug zum Ausdrucken eines Logs. Sie können aber 
mit dem Menü File >Export verschiedene Möglichkeiten zur Ausgabe eines Logs 
wählen. Mit den ADIF-Varianten können Sie das Contestlog in andere 
Logprogramme einlesen. Mit der CSV-Optionen können Sie ein Log nach EXCEL 
übernehmen und von dort ausdrucken usw.

5. Statistik erzeugen (How to Get Statistics)

N1MMLogger hat mehrere Statistikanzeigen. Sie können auch ein Werkzeug von 
I8NHJ verwenden. Sie haben diese Alternativen:

• Gehen Sie zu View >Statistics und treffen Sie dort Ihre Wahl
• Exportieren Sie das Log als ADIF-Datei in ein allgemeines Logprogramm und 

verwenden Sie die Statistikmöglichkeiten dieses Programms. 
• Verwenden Sie das Cabrillo-Ausgabeformat
• Verwenden Sie das Werkzeug I8NHJ (Freeware) um das Log zu analysieren. 

Sie finden es unter Programme von Drittanbietern (Third Party Software). 

6. Logs für ARRL-Conteste per Email abschicken (Submitting E-mail 
Logs for ARRL/CQ Contests)

ARRL und CQ möchten die Contestlogs als Cabrillo-Dateien für jeden Contest 
haben. 

• Die Cabrillo-Logs müssen den Namen <Ihr Rufzeichen> haben, z.B.: 
N1MM.log 

o Gehen Sie zum Menü File >Export >Export Cabrillo to file... 

Schicken Sie die Dateien so ab: 
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• Überprüfen Sie die Cabrillo-Datei mit einem Texteditor wie Notepad. Sehen 
Sie sich vor allem den Dateikopf an und prüfen Sie Ihre Stationsdaten. 
Korrigieren Sie sie, falls nötig. 

• Wählen Sie die zu dem Contest angegebene Email-Adresse. Sie werden im 
Internet auf den Webseiten von ARRL und CQ angegeben: 

o ARRL at http://www.arrl.org/contests/email.html 
o CQ at http://www.cqww.com 

• Tragen Sie als Subjekt diese Daten ein:  
o ARRL: Contest, Rufzeichen, Teilnehmerklasse und Output 

 Z.B.: ARRL DX CW N1MM SOA HP 
o CQ: Rufzeichen und Sendeart (SSB oder CW) 

 Z.B.: N1MM CW 
• Hängen Sie die Cabrillo-Datei als Anhang an unter dem Namen < Ihr 

Rufzeichen>.LOG . Schicken Sie das Log NICHT als Text in der Email. 
• Schicken Sie die Email ab. 
• Sie bekommen vom Log-Roboter eine automatische Antwort, entweder mit 

einer 100%-Bestätigung oder einem Hinweis auf erkanntes Problem. Beheben 
Sie das Problem und schicken Sie das Log dann noch einmal. Heben Sie die 
Bestätigung auf. 

• Logs, die nach dem Stichtag eingehen, können nur als Checklog verwendet 
werden. 

6.1. Der ARRL-Contest-Roboter (ARRL Contest Robot)

Nachstehend sehen Sie eine Standardantwort des ARRl-Contest-Roboters. Noch 
einmal: Sie müssen die Cabrillo-Logs in der Email als Anhang schicken, nicht als 
Text. 

Thank you for your participation in the contest and for submitting your log in Cabrillo 
format. While the robot appears to be able to process your log, it appears to have 
discovered irregularities in your log. These do not affect its ability to be processed but 
correcting these problems will help ensure the entry is properly scored. These 
irregularities appear in a report at the bottom of this message. You are encouraged to 
review and fix these irregularities. You may then re-send it to dxcw@arrl.org. You 
may have to resubmit your log two or three times to get everything just right. Don't 
worry, the robot replaces the previous file as long as the callsign remains the same. 
We want to make sure that we have your information right! If you have any questions 
regarding this, please contact me at n1nd@arrl.org or by phone at 860-594-0232. 

Your tracking number is 3044.dxcw. Please save this receipt until verifying that your 
log appears on the Logs Received web page at http://www.arrl.org/contests/claimed/ 

Thanks for your cooperation.
73 Dan Henderson, N1ND
5 ARRL Contest Branch Manager 

ARRL DX CONTEST LOG WARNING MESSAGE REPORT FROM THE ROBOT
CATEGORY-OVERLAY: N/A%% Line 7 was discarded. The CATEGORY-
OVERLAY: tag is not used in ARRL contests. You may delete this line from your log. 
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Teilt Ihnen der Robot mit, dass Ihr Log Fehler enthält, beheben Sie die Fehler und 
schicken es noch einmal ab, solange bis der Robot nichts mehr zum kritisieren findet.

7. QSL-Karten drucken (Printing QSL Cards)

N1MMLogger enthält KEIN Werkzeug zum QSL-Karten-Druck. Es ist ein 
Contestprogramm und überlässt das QSL-Drucken dafür prädestinierten 
Logprogrammen. Sie können mit dem ADIF-Export Ihre Contest-QSOs problemlos in 
spezielle QSL-Druckprogramme wie BV von DF3CB oder das Logprogramm Ihrer 
Wahl überführen.

8. Import des Contestlogs in Ihr Logprogramm (Importing a Contest Log 
into Your General Logging Program)

By Franki, ON5ZO 

N1MMLogger kann zwar zum DX-Loggen verwendet werden, aber es ist nicht als 
Logprogramm geschrieben worden. Es hat keine Funktionen zur QSL-Verwaltung 
oder Diplomstatistik, Sie sollten Ihre QSOs aus N1MMLogger in ein Logprogramm 
Ihrer Wahl exportieren. 
N1MMLogger gibt die QSOs eines Contests auf Wunsch in eine ADIF-Datei aus. Sie 
können diese ADIF-Datei anschließend – falls gewünscht – mit einem einfachen 
Texteditor wie Notepad oder Wordpad bearbeiten und anpassen.. Informieren Sie 
sich unter   http://www.hosenose.com/adif/adif.html über das Format eines ADIF-
Logs, die Schlüsselworte, Feldtrenner usw. 

Moderne Logprogramme können die ADIF-Logs in der Regel ohne Änderung 
importieren. Nur dann, wenn Sie z.B. die unter dem ADIF-Schlüsselwort 
<POINTS:3>178 abgelegten 178km in einem UKW-Contest einer Logspalte 
COMMENT zuordnen wollen, können Sie mit der Ersetz-Funktion aus dem ADIF-
Schlüsselwort POINTS das ADIF-Schlüsselwort COMMENT machen.
Oder Sie können z.B. 300 Contest-QSOs als ADIF-Datei übernehmen und als 
Kommentar zu jedem QSO den Eintrag <COMMENT>QSO in ARRL DX CW 2002 
einbauen. Wenn Sie die QSOs ins „große“ Log importieren, haben Sie den 
entsprechenden Kommentar. Oder Sie können, wenn Sie einen ARRL-Contest 
mitgemacht haben, den als Kontrollnummer aus den USA gesendeten Staat in die 
Logspalte State umleiten.
Ich speichere keine Normal-QSOs in N1MMLogger und fahre keine Conteste mit 
meinem normalen Log, aber führe anschließend alle QSO in einem General-Log 
zusammen und kennzeichne die QSOs.

Last Modification: 26 September 2009 15:30:28 EDT by K8UT. 

Hilfen (Help)
Hilfe-Dateien und Handbuch (Help Files and Manual)

Das Handbuch auf Basis einer Wiki-Struktur wird in Echtzeit von freiwilligen Helfern 
gepflegt, die es möglich zeitnah zu Programmänderungen aktualisieren. Sie sollten 
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sich die jeweils neueste Version des Handbuchs holen, um auf dem Laufenden zu 
sein. 

Sie werden aber sicher gern eine handhabbare Version vor Ort haben wollen, auch 
wenn Sie keinen Internetzugang haben. Dafür gibt es Versionen als Adobe-PDF oder 
Windows-.CHM-Help und für einige Sprachen auch Übersetzungen des englischen 
Originals, wie (Zusatz von DM3ML) diese deutsche Übersetzung von Eike, DM3ML. 

Informieren Sie sich über dieses Angebot unter Off-line Copies of Wiki Documents. 

Last Modification: 11 October 2009 08:38:04 EDT by K8UT. 

Tipps und Tricks (N1MM Logger Tips and Tricks)
Dieses Kapitel gibt einige Tipps und Tricks für die Programmnutzung. Die Tipps sind 
– wenn nicht anderes angegeben -  von Tom, N1MM.  

1. Bandskalen, Eingabefenster und ihre Geheimnisse (Bandmaps, 
Entry Windows and the Mysteries Thereof...)

Zwei Logeingabefenster 

So können Sie mit diesen beiden Fenstern arbeiten:  

• Schalten Sie mit dem Backslash \ zwischen den Fenster um
• Schalten Sie mit Ctrl+Pfeil rechts/links zwischen den Fenster um

Mit einem VFO auf dem einen Band und dem anderen auf dem gleichen oder einem 
anderen Band schalten Sie mit CTRL-Pfeil nach unten/oben von Spot zu Spot im 
Hauptfenster (VFO-A) und mit CTRL+Shift+Pfeil nach oben/unten im zweiten VFO 
von Spot zu Spot. Hat Ihr Transceiver einen Zweitempfänger (FT1000MP, Orion..) 
können Sie beide Spots zur gleichen Zeit hören. Schalten Sie mit CTRL-F12 um, ob 
sie nur den zur Tastatur gehörenden RX-VFO oder beide hören wollen.
Mit den Zweitempfänger beim Orion und FT-1000/MP können Sie mit dem Haupt-
VFO auf einen Station abstimmen und auf sie warten und währenddessen mit 
CTRL+Shift+Pfeil nach oben/unten auf dem zweiten VFO schon eine andere arbeiten 
oder die nehmen, die zuerst frei ist. In der Klasse SOA  (Single OP assisted) können 
Sie das auf zwei Bändern und in der Einband-Klasse auf zwei Frequenzen im 
gleichen Band machen.

Bandskalen
Der Klick auf einen DX-Spot in einer Bandskala, aktiviert die Tastatur und den VFO 
für diesen Spot und setzt das Rufzeichen über das Eingabefenster. Ein Doppelklick 
macht das gleiche, setzt aber das Rufzeichen gleich ins Rufzeichenfeld
Studieren Sie das Kapitel Tastenzuordnungen und drucken Sie es aus. Sie werden 
N1MMLogger besser nutzen können. Glauben Sie mir !
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2. Wozu sind die Bandskalen gut? (Bandmaps, What are They Good 
For...)

Bandskalen sind vor allem im S&P-Modus interessant. Sie sehen alle gespotteten 
Rufzeichen unterschiedlich gefärbt als „neue QSOs” (blau) und als “neue Multis” (rot) 
Schon gearbeitete Stationen und Stationen, die für diesen Contest nicht zählen sind 
grau gefärbt. Ziehen Sie je nach Belegung die Bandskalen mit der Zoom-Funktion 
auseinander (wenn viele Stationen gemeldet sind) oder schieben Sie die auf einen 
größeren Frequenzbereich zusammen, wenn nicht so viel los ist. Behalten Sie auch 
das Available-Fenster im Auge, das oft einen schnelleren Überblick bietet als die 
Bandskalen. Durchforsten Sie die Bandskalen mit  CTRL+ALT+Pfeil nach 
oben/unten nach neuen Multis und mit CTRL+Pfeil nach oben/unten nach neuen 
Stationen. 

Wenn Sie im RUN-Modus arbeiten, reicht ein Klick auf einen neuen Multi, um ihn zu 
arbeiten. Kehren Sie anschließend wieder mit ALT+Q zur CQ-Frequenz zurück.

3. Contest-Technik unter N1MMLogger (N1MM Logger Contest 
Technique)

Mit der oben beschriebenen S&P-Technik und den Tasten Ctrl+Pfeil nach 
oben/unten können Sie schnell eine Bandskala abgrasen. Sie können es bis auf 90 
QSOs/h mit dieser Methode bringen. Hören Sie kurz, ob die adressierte Station 
gerade ein QSO beendet hat und rufen Sie sie an. Hat sie gerade erst ein QSO 
angefangen, nehmen Sie die nächste Station und kehren später wieder zurück. 
Scheint ein Spot nicht mehr aktuell oder gar falsch zu sein, löschen Sie ihn mit 
ALT+D. 

Wollen Sie die Spots von einer anderen Sendeart nicht sehen, klicken Sie rechts in 
die Bandskala und wählen Sie Allow spots for this contest's mode(s) only in the 
packet window. Achten Sie auf 80 und 40m auf die unterschiedlichen 
Bereichszuordnungen in den IARU-Regionen. 

Variante: Sie rufen CQ, aber die QSO-Rate ist niedrig. Gehen Sie über in den S&P-
Modus und klappern Sie die gemeldeten Spots ab. Gehen Sie dann mit ALT+Q 
wieder zurück auf Ihre CQ-Frequenz.

Schalten Sie die Option "Show non-workable spots" in keinem Fall ab. Wenn Sie 
über das Band drehen, sehen Sie gleich, ob eine Station von Interesse ist oder nicht. 

Und noch ein Tipp: Sie drehen auf einen Spot, der gar nicht da ist. Nehmen Sie diese 
Frequenz gleich zum CQ-Rufen.

4. Beginn der Contestsaison (Start of the Contest Season)

Der CQWW SSB markiert den Beginn der jährlichen Contestsaison. Auch für 
N1MMLogger ist das ein Anlass Neuerungen und Verbesserungen bis zu diesem 
Zeitpunkt einzuführen und Programmmacken abzustellen. 
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4.1. Testen (Testing)

Fangen Sie rechtzeitig an, das Programm zu testen. Machen Sie sich eine Kopie der 
Vorjahres-Logs wie ham.mdb (oder wie Sie es genannt haben). Einige Probleme 
treten nur auf, wenn ein großes Log verwendet wird. Suchen Sie nach Mängeln in 
der Leistungsfähigkeit. Ich (N1MM) bin an solchen Meldungen sehr interessiert. 
Holen Sie sich von der Webseite Download > Other Files die Datei 
"TestPlan.wri" . Machen Sie bitte Vorschläge zur Verbesserung von N1MMLogger.

4.2. Tastenzuordnung (Key Assignments)

Sehen Sie sich die Tastenzuordnungen wieder einmal durch und probieren Sie die 
einzelnen Funktionen aus. Machen Sie einen Ausdruck der Liste und halten Sie ihn 
an der Station bereit. 

4.3. Enter Sends Messages (ESM) Mode

Wollen Sie erfolgreich an einem CW- oder RTTY-Contest teilnehmen, müssen Sie 
sich unbedingt mit dem ESM-Modus (Enter Sends Messages) vertraut machen. Mit 
ihm senden Sie zu jeder Situation mit einem Druck auf die ENTER-Taste die 
passende Nachricht. Schieben Sie den Test nicht auf die letzte Minute auf. Glauben 
Sie mir: Wer ESM kennen gelernt hat, liebt es! 

4.4. Zwei Logeingabefenster (Dual Entry Windows)

Probieren Sie diesen Modus aus. Mit einem Backslash \ schalten Sie zwischen den 
Fenstern um, mit Ctrl+linker/rechter Pfeil schalten Sie Tastatur und Transceiver 
und mit Ctrl+Fn und Ctrl+Enter senden Sie auf dem Transceiver, der den Fokus 
nicht hat.  

4.5. Konfugurations-Optionen (Configurer Options)

Machen Sie sich mit diesen Konfigurations-Optionen vertraut:  

• SO2V/SO2R 
• Send corrected call (Sende das korrigierte Rufzeichen)
• Send partial calls (Sende Teilrufzeichen)
• Stop sending CQ when callsign changed (Ende des CQ bei geändertem 

Rufzeichen)
• ESM only sends your call once in S&P, then ready to copy received exchange 

(bei S&P und ESM: Rufzeichen nur einmal senden, dann Kontrollnummer 
empfangenen)

• Config/QSYing wipes the call & spots QSO in bandmap (QSY löscht das 
Rufzeichen und setzt es in die Bandskala)

4.6. Selbstvervollständigung (Autocompletion Mode)

Später im Contest hören Sie eine Menge an Stationen, die Sie schon auf diesem 
oder einem Band gehört haben. Wenn Sie einen Haken bei Autocompletion mode 
im Configurer > Karteikarte Other machen, ergänzt das Programm Ihre Eingabe 
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mit dem möglichen kompletten Rufzeichen. Die Ergänzung wird hell getastet. Trifft 
sie nicht zu, müssen Sie die Zugabe mit der Entf-Taste löschen oder überschreiben. 
Mit der Leertaste wird die Eingabe übernommen.

Diese Funktion arbeitet so wie eine Adresseneingabe im Internet, wenn Sie eine 
Adresse eingeben. Probieren Sie die Funktion am besten mit einem umfangreichen 
Log mit vielen Rufzeichen aus. Machen gefällt es, anderen nicht. 

5. Log editieren (Log Editing)

Müssen Sie im Log während des Contest etwas korrigieren, gehen Sie mit Ctrl+Q im 
Log nach oben und mit Ctrl+A nach unten. Das gewünschte QSO erscheint blau 
hinterlegt im Logeingabefenster und kann dort korrigiert werden. Sie können die 
Korrektur mit ESC abbrechen oder mit ENTER übernehmen.

6. Zwangs-Loggen (Force to Log Whatever Heard)

Mit Ctrl+Alt+Enter können Sie das Programm dazu zwingen, ein QSO zu loggen, 
auch wenn im Kontrollnummernfeld noch nichts oder etwas Falsches steht. 
Gleichzeitig wird die Empfangsfrequenz auf die Sendefrequenz gesetzt. 

7. Land nicht gefunden (Country Not Found When Logging Contact (no 
mulitplier credit))

1. Sie sollten sich vor jedem Contest die neueste Datei wl_cty.dat holen.

2. Wird für ein Rufzeichen kein Land gefunden, gehen Sie zu Tools >Add Call to 
Country und tragen Sie dieses Rufzeichen unter dem ermittelten Land ein. Diese 
Ergänzung wird mit einer neuen Datei wl_cty.dat überschrieben.

3. Eine weitere Möglichkeit ist, zu dem QSO mit Alt+N eine Notiz zu machen und das 
Problem nach dem Contest nach einer Kontrolle mit View > Notes nachzusehen und 
zu beheben. 

8. Mit der F1-Taste nicht gleich CQ senden (Having F1 NOT Always Send 
CQ)

Wenn Sie die F1-Taste drücken, wird ein CQ gesendet und vom S&P-Modus in den 
RUN-Modus gewechselt. Wollen Sie das nicht, setzen Sie in den Text der F1-Taste 
in der 13. Reihe das Macro {S&P}. Dann bleiben Sie im S&P-Modus.  

9. F-Taste ruhig stellen (Silence the Function Keys)

Soll eine F-Taste keine Funktion haben, nicht auf Senden schalten und keinen Text 
aussenden, programmieren Sie sie mit einem Klick auf die Leertaste. Auch ein 
Zwischenraum ist ein Zeichen, es wird aber nicht gesendet. 
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10. Empfehlungen für S&P auf einem neuen Band (How I Recommend to 
S&P on a New Band)

1. Sehen Sie im Angebotsfenster (available window) nach. Gibt’s dort neue 
Multis?? 

2. Gibt es neue Multis arbeiten Sie sie mit der Tastenkombination Ctrl+Alt+Pfeil  
nach oben/unten ab. 

3. Arbeiten Sie alle Multis, die Sie schnell erreichen können. Warten Sie nicht zu 
lange auf ein bestimmtes hart umlagertes Rufzeichen. Versuchen Sie es mit 
anderen Rufzeichen und kehren Sie später zurück. 

4. Arbeiten Sie dann mit Ctrl+Pfeil nach oben/unten  die übrigen Stationen. 
Finden Sie eine freie Stelle, versuchen Sie es mit einem kurzen CQ. 

5. Bietet die Bandskala kaum noch neue Rufzeichen, suchen Sie das Band 
selbst ab. Schalten Sie die Option "QSYing wipes the call..." zu. Wenn Sie 
eine Station ins Rufzeichenfeld eingetragen haben, aber nicht erreichen, wird 
das Rufzeichen bei einem QSY gelöscht, aber fett markiert in die Bandskala 
gesetzt, so dass Sie sie beim nächsten Durchsuchen der Bandskala wieder 
finden können.

6. Wenn Sie nicht arbeitbare Stationen spotten, können Sie beim Absuchen des 
Bandes schnell weiter drehen. 

11. Contest-Ziele setzen (Setting Contest Goals)

Sie können sich Ziele im Contest mit der Vorgabe von QSO-Raten je Stunde setzen. 
Diese Ziele werden im Info-Fenster angezeigt und die aktuelle Stundenleistung 
dagegen gestellt. Liegen Sie mehr als 50% unter der Vorgabe, wird der Wert rot 
angezeigt, bei 50..100% in gelb und wenn Sie über 100% liegen, erfolgt die Anzeige 
in grün.

Sie können die Vorgaben aus den Werten des gleichen Contest vom letzten Jahr 
entnehmen, die Sie im laufenden Jahr natürlich überbieten wollen. Öffnen Sie das 
Log des Contests vom letzten Jahr und klicken Sie auf die Taste Import Goals. 
Wählen Sie Tag 1 oder 2 und drücken Sie auf ENTER: Die Werte werden 
übernommen. Vergessen Sie aber nicht, ein neues Log für dieses Jahr zu öffnen. Die 
Zielwerte bleiben erhalten, bis Sie sie zurücksetzen oder explizit eine neue 
Datenbank anlegen.

12. Probleme während eines Contest (Problems During a Contest)

Was sollten Sie tun? 

1. Stellen Sie sicher, dass Sie die vorherige Version von N1MMLogger, mit der 
alles zufrieden stellend gelaufen ist, noch aufgehoben haben.  

2. Stellen Sie sicher, dass Sie die aktuelle Version ausreichend in allen 
Sendearten, in denen Sie am Contest teilnehmen wollen, getestet haben. 
Loggen Sie mehrere Test-QSOs, überprüfen Sie die Tastenprogrammierung 
und nutzen Sie die Telnet/Packet-Verbindung.  

3. Wenn Sie Probleme vor dem Contest feststellen, informieren Sie umgehend 
Tom, N1MM. Er bemüht sich, bekannte Fehler noch vor dem Contest zu 
beheben. 
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4. Sehen Sie auf der update page der N1MM-Webseite nach. Hier bekommen 
Sie noch während eines Contests Tipps zur Reparatur und neue Versionen 
mit behobenen Fehlern nach einem Contest. 

13. Abstimmen mit den Pfeiltasten (Using Up/Down Arrows to Tune)

Mit den Tasten Pfeil nach oben/unten können Sie kleinere Frequenzänderungen 
am Transceiver machen. Sie sind am nützlichsten bei der Scharfabstimmung im 
S&P-Modus nach einem Klick auf einen DXSpot. 

Im RUN-Modus können Sie auf Splitbetrieb schalten und die Pfeiltasten als RIT 
verwenden. 

Die Sprungweite für die Pfeiltasten wird im Configurer > Karteikarte Other 
eingestellt. 

14. CW-Tipps (CW Tips)

14.1. Tipp für ein CW-Macro (CW Macro Tip)

Haben Sie ein Rufzeichen, das zu Hör-Irrtümern herausfordert wie 6Y2A, der oft als 
BY2A ins Log eingetragen wird, gehen Sie zu Config >Change 
Packet/CW/SSB/Digital Message Buttons >Change CW Buttons und bauen Sie 
den Text für das eigene Rufzeichen, der dort als ‚*’ steht um und machen Sie aus 
6Y2A das Rufzeichen >6<~Y2A.
Die 6 im Rufzeichen wird um 2 WPM langsamer als der Rest gesendet und ein 
zusätzlicher halber Punktabstand wird zwischen 6 und Y eingebaut. Versuchen Sie 
auch andere Kombinationen von <>~, damit sich das Rufzeichen besser hören lässt. 

14.2. Zeichenabstand im CW-Contest (Contest Spacing for CW)

Gehen Sie zu Config >Change Ports, Telnet Address, Other >Function Keys 
>Use Contest Spacing for CW. Hier ist normalerweise ein ON eingetragen. Diese 
Einstellung verkürzt den Wortabstand in der Folge "N1MM 599 5" bestehend aus 3 
Worten von 7 Bits auf 6 Bits, damit es schneller geht. Ist die Option nicht aktiv, wird 
ein Wortabstand von 7 Punktlängen generiert. 

15. Stationen doppelt arbeiten (Working Dupes)

Voreingestellt ist, dass DUPEs gearbeitet werden. Besser und schneller ist es, 
Stationen doppelt zu arbeiten, als sie abzuweisen. Wenn die Logs überkreuz 
verglichen werden, steht mitunter erst das zweite QSO mit der Gegenstation in deren 
Log und das erste wird gestrichen, dieser Punkt fehlt dann. 

Die Option "work dupes" ist im Configurer für ESM und RUN-Modus freigegeben. 
Sie gibt vor, ob die anrufende Station abgewiesen wird oder eine Kontrollnummer 
bekommt. Im ESM-Modus läuft es so ab: 

• Im Modus S&P unter Verwendung von ESM wird mit ENTER nichts gesendet. 
Sie können die Station aber mit der Taste F4 anrufen. 
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• Im RUN-Modus unter Verwendung von ESM und "Work Dupes" aktiviert, 
wird mit ENTER das Rufzeichen der Gegenstation und die Kontrollnummer 
gesendet unabhängig davon, ob es ein DUPE ist oder nicht. Wollen Sie die 
Station abweisen, drücken Sie selbst die Taste F6 mit QSOb4. 

• Wollen Sie im RUN-Modus bei nichtaktiviertem "Work Dupes" eine Station 
arbeiten, drücken Sie erst F5 und dann F2 oder weisen Sie sie mit F6 ab.

Zusammengefasst: Sie können in allen Situationen DUPEs mit den F-Tasten 
arbeiten oder abweisen. 

Ziel des Programms ist es, einen guten OP-Stil bereitzustellen. Zu diesem Stil gehört 
es, DUPEs zu arbeiten. Nur in Contesten mit einem langen Austauschtext wie bei 
den SS-Contesten in den USA ist es sinnvoll, diesen Stil zu verlassen. 

Mitunter kann diese Einstellung bei Experimenten mit dem Programm verloren 
gegangen sein. Ich empfehle daher dieses Verfahren: 

1. Bringen Sie das Programm an Ihrer Station zum Laufen 
2. Speichern Sie die INI-Datei
3. Spielen Sie dann Varianten durch 
4. Laden Sie dann wieder die in Schritt 2 gesicherte INI-Datei 
5. Ändern Sie nur noch die Einstellungen, von deren Wirkung Sie sicher sind.
6. Wenn eine Variante nicht so funktioniert, wie Sie es sich vorgestellt haben, 

gehen Sie zu einer früheren Version zurück

16. Welche DXSpot-Verfallszeit einstellen? (What Setting Should I Use for 
Packet Spot Timeout?)

Ein guter Wert ist 30 Minuten. In einem hektischen Contest gehen Sie runter auf 20 
Minuten. In einem ruhigen Contest gehen Sie höher. Mehr DXSpots bedeuten mehr 
Arbeit für das Programm. Mit einem langsameren Rechner können Sie Zeit für 
andere Aufgaben gewinnen, wenn Sie eine kürzere Zeit einstellen.

Für Testzwecke können Sie bis zu 1000 Minuten gehen.  

17. Wie sollte ich das Programm als SOA nutzen? (How Should I Really 
Use this Program if I am Single Operator Assisted (SOA)?)

Probieren Sie diese Techniken aus: 

• Connecten Sie sich zu einem DXCluster. Füllen Sie mit sh/dx/100 Ihre 
Bandskala. 

• Sehen Sie im Angebotsfenster nach dem Band mit den meisten Multis und 
QSOs. 

• Wählen Sie dieses Band und klappern Sie mit Ctrl+ALT+Pfeil nach 
oben/unten alle Multis ab. Halten Sie sich nicht zu lange bei einem Multi auf. 

• Gehen Sie dann mit Ctrl+Pfeil nach oben/unten die noch nicht gearbeiteten 
Stationen durch. Rufen Sie auf einer freien Frequenz auch mal CQ. 

• Arbeiten Sie danach die neuen Multis und Stationen ab. 
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• Wechseln Sie anhand des Angebotsfensters das Band und wiederholen Sie 
das Verfahren. Schalten Sie die Option "QSYing wipes the call & spots 
QSO in bandmap" zu. ) 

• Wenn Sie eine Station nicht arbeiten können/wollen, markieren Sie sie mit 
ALT+M als nicht arbeitbar.  

• Halten Sie die Bandskala im Auge, wenn Sie sich mit einer Station abmühen, 
vielleicht kommen Sie an eine andere schneller heran.  

18. Wie finde ich eine gearbeitete Station im Log an der ein Stück fehlt 
(How to Find a Worked Station in the Log When I Missed Parts?)

Es gibt drei Möglichkeiten, so eine Station zu finden. Die Ergebnisse erscheinen 
unterhalb des Logs gelb hinterlegt. 

• Wenn Sie die ersten drei Zeichen des Rufzeichens in das Rufzeichenfeld des 
Logeingabefensters eingeben, werden alle Stationen angezeigt, die auf dieses 
Muster passen.  

• Sie können eine Maske wie N?MM eingeben, um N1MM zu finden.  
• Oder Sie geben *1MM ein, auch dann wird N1MM gefunden. 

Kombinationen sind möglich:  

• *1?M zeigt N1MM, aber auch K1MR, J41YM usw. 
• *3? Zeigt alle Stationen mit einer 3 und einem Buchstaben danach, *3* zeigt 

alle Stationen mit einer 3 im Rufzeichen 
• *3*Z zeigt alle Stationen mit einer 3 und einem Z im Suffix an 

unterschiedlicher Stelle, z.B. K3ZO, VA3UZ usw.. Das ? steht für eine 
bestimmte Stelle, der * für eine beliebige Stelle und Zeichenzahl

Der * entspricht einer Suche in einer SQL-Datenbank. Bei langsamen Rechnern 
dauert so eine Suche ziemlich lange.  

In UKW-Contesten können Sie mit Alt+= nach Rufzeichen UND Großfeldern suchen. 

19. Datenbanken und Conteste (Databases versus Contests)

Es gibt Unklarheiten, wie die Daten von Contesten und Datenbanken geordnet und 
zu verstehen sind. Beachten Sie diese Definitionen:  

Database (Datenbank) : ist eine Datenbank von Access 2000-Format mit der 
Dateierweiterung *.mdb. In so einer Datenbank kann eine beliebige Anzahl von 
Contesten gespeichert sein. 

Contest (Contestlog) : ist ein Satz von QSOs in einer Datenbank. Die QSOs sind in 
Reihen in einer DXLOG genannten Tabelle gespeichert. Jede Reihe hat eine 
ContestNr die zu dem ContestInstance-Eintrag gehört.

Sie brauchen nicht für jeden neuen Contest eine neue Datenbank einrichten, im 
Gegenteil: alle Conteste passen in eine Datenbank. Wenn Sie allerdings eine DX-
Expedition mit einigen zehntausend QSOs planen, sollten Sie eine neue Datenbank 
dafür einrichten. 
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Mit der Option "Copy (and compact) Database" können Sie eine Datenbank, aus 
der viele QSOs oder ganze Conteste gestrichen worden sind, von den vielen 
Leerstellen, die nicht automatisch wieder freigegeben werden, befreien. Bei den 
heutigen Festplatten werden Sie aber sicher kein Speicherplatzproblem haben. 

Sie sollten aber Ihre Datenbanken regelmäßig auf einem sicheren Datenträger 
abspeichern und dort aufheben, sonst gehen Sie bei einem PC-Absturz verloren.

20. Datenbank auf eine neuere Version aktualisieren (How to Upgrade the 
Database to a Newer Version?)

Machen Sie zuerst eine Sicherungskopie. Öffnen Sie die Datenbank dann mit einem 
Programm der neuesten Version. Die Datenbank wird automatisch überprüft und 
falls nötig auf den neuesten Stand gebracht. Je nach Änderungsstand kann das 
einige Arbeit machen.

21. QSOs löschen (wichtig bei Multi-Stationen ) (Deleting QSOs 
(especially important for Multi-User))

Speziell für die Unterstützung von Multi-Nutzer-Stationen habe ich (N1MM) den 
DELETEDQS-Contest eingebaut. Wenn Sie ein QSO mit ALT+D oder der Entf-Taste 
löschen, wird es nicht direkt gelöscht, sondern in den DELETEDQS-Contest 
verschoben. Die Daten dieses Contests können Sie als ADIF-Datei ausgeben und 
ein möglicherweise versehentlich gelöschtes QSO wieder zurück gewinnen.

Nehmen Sie diesen DELETEDQS-Contest ernst. Speziell in der Multinutzer-
Umgebung kann er nützlich sein. Heben Sie diesen Contest ebenso auf, wie das 
richtige Contestlog.

Noch einmal zu den DUPEs: Loggen Sie sie ruhig, streichen Sie sie nicht aus dem 
Log. Sie schicken Ihr Log als Cabrillo-Log ohne Punktangaben. Der Veranstalter 
verarbeitet alle Logs gemeinsam und berechnet die Punkte für Ihr Log. Er teilt keine 
Strafen für doppelt geloggte Stationen aus. Eher helfen Ihnen die DUPEs Ihre eigene 
Punktzahl aufzubessern, je nach dem wann die DUPE-Station das QSO in ihr Log 
eingetragen hat.

22. Frequenzwechsel löscht Rufzeichen und setzt es in die Bandskala 
(QSYing Wipes the Call & Spots QSO in Bandmap)

Sie werden es sicher bemerkt haben: Sie haben im S&P-Modus ein Rufzeichen im 
Logeingabefeld eingetragen, aber die Station nicht erreicht und Sie drehen weiter. 
Das Rufzeichen wird gelöscht und fett markiert in die Bandskala eingetragen. Diese 
Option wird mit einem Haken bei "QSYing wipes the call & spots QSO in 
bandmap" aktiviert. 

23. Abkürzungen ändern (Exchange Abbreviations)

In vielen Contesten werden Abkürzungen für Staaten/Provinzen/DOKs usw. 
ausgetauscht. Im Log müssen sie mit einer Standardabkürzung stehen, z.B: CT für 
den US-Staat Connecticut. Mit dem Menü Config >Change Exchange 
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Abbreviations können Sie dieser Standardabkürzung weitere Bedeutungen 
zuweisen und z.B. aus CONN ein CT machen. Lassen Sie bitte die gewählten Daten 
speziell für die ARRL-Sektionen stehen und fügen Sie höchstens neue Zuweisungen 
an.  

24. Zu viele Rufzeichen in der Bandskala (Too Many Calls on the 
Bandmap!)

Wenn es in der Bandskala eng und unübersichtlich wird, können Sie den Zoom 
aktivieren und die Skala mit Zoom+ auseinander ziehen. Hier funktioniert auch das 
Mausscrollrad. 

Eine andere Möglichkeit, das Angebot zu verringern ist, die Darstellzeit der DX-Spots 
von z.B. 60 Minuten auf 20 Minuten zu vermindern. 

Oder entfernen Sie den Haken bei "Show non workable contacts" im Menü Config 
des Logeingabefensters ab. Dann werden aber auch die grau dargestellten 
Rufzeichen der schon gearbeiteten Station entfernt und die sind beim Durchsuchen 
eines Bandes doch interessant. 

25. Dämmerungslinien-Öffnungen (Gray Line Openings)

Achten Sie auf Bandöffnungen entlang der Dämmerungslinien (Gray Line), wenn Ihr 
Sonnenauf-/untergang mit dem Sonnenunter-/aufgang der Gegenstation 
übereinstimmt. Voraussetzung für eine Warnung ist, dass Sie ihre eigenen 
Koordinaten bei den Stationsdaten richtig eingegeben haben. Sie erhalten eine 
Warnung im Infofenster, wenn die Bedingung für ein Dämmerungslinien-QSOs erfüllt 
sind. Beachten Sie, dass für die Koordinaten der Gegenstation die in der Datei 
wl_cty.dat angegebenen Werte für den jeweiligen Landes- oder Gebietsmittelpunkt 
genommen werden. 

26. QSO-Bestätigung (QSO Confirmation)

In manchen Contesten wird eine Bestätigung des Empfang einer Kontrollnummer 
vorgeschrieben. Diese Bestätigung ist mit einem "QSL",”CFM”, "TU", oder "R" 
erledigt und bedeutet nicht, dass die Gegenstation die empfangene Kontrollnummer 
wiederholen muss. Sie wird sie nur wiederholen, wenn sie unsicher ist, ob sie sie 
richtig empfangen hat. 

27. Seriennummer-Contest (Serial Number Contest)

Mitunter warten Sie auf eine Station und haben deren Seriennummer 
vorausschauend in das Kontrollnummernfeld eingetragen, sind aber noch nicht dran 
gekommen. Sie können diese Nummer mit CTRL+U jeweils um ‘1’ erhöhen, bis Sie 
endlich das QSO im Kasten haben. 
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28. Transceiver beim Start noch nicht eingeschaltet (Dead Radio at 
Startup) 

Das Programm lehnt es ab, QSOs zu loggen, wenn der dazu gehörende Transceiver 
noch nicht eingeschaltet ist (Anmerkung DM3ML: passiert höchstens beim SO2R-
Modus). Überprüfen Sie in der Bandskala, ob die Frequenz richtig angezeigt wird. 
Möglicherweise kommuniziert nur die COM-Schnittstelle nicht richtig mit dem 
Transceiver, Wenn irgendetwas klemmt, öffnen Sie den Configurer und klicken dort 
auf OK. Sie brauchen nicht den N1MMLogger neu zu starten.

29. Lesen Sie die Aktualisierungs-Info (Read the Update Log)

Zu jeder Version wird ein „update log” mitgeliefert, das Sie mit einem Texteditor 
öffnen und lesen können. Informieren Sie sich über die gegenüber früheren 
Versionen durchgeführten Änderungen. Sie bekommen dabei auch Hinweise über 
abgestellte Probleme und mögliche Auswirkungen auf das aktuelle Verhalten des 
Programms.

30. Packet/Telnet-Tasten (Packet/telnet Button Setup)

Nachstehend finden Sie meine Belegung der Tasten im Packet/Telnet-Fenster. Sie 
beziehen sich auf Packet-Cluster in der Nähe meines Wohnorts, wie z.B. die 
Spezialtaste NE und die anderen Filtereinstellungen beim lokalen DXCluster. Mit der 
Taste NE wird der DXCluster angewiesen nur DXSpots aus meiner Umgebung 
(W1&W2) zu melden. 

Sie können in der Bandskala mit Tools >Clear All Spots alle DXSpots in einer 
Bandskala löschen und dann mit sh/dx/100 die 100 neuesten DXSpots abrufen. 

Tastentext Kommando 
BYE BYE 
CONN C K1TTT 
DI/N DI/N 
SH/DX SH/DX/30 
USERS SH/U 
WWV SH/WWV 
Clear NE set/filters dxorigstate/off 
Yes DX set/filters dxorigcty/off 
NE only set/filters dxorigstate/pass ny,nj,ct,ri,ma,nh,vt,me 
No DX set/filters dxorigcty/pass k,ve, xe 
No VHF set/filters vhf/reject 
K1TTT {MYCALL}

31. Langsame Rechner (Slow PC Syndrome)

Es gibt COMPAQ & Toshiba-Laptops unter Win98, die sehr langsam werden, wenn 
sie einen Piep über den Lautsprecher abgeben sollen. Gehen Sie in das Menü 
Config > Configure Ports - Function Keys und schalten Sie die Option "Monitor 
via PC speaker“ ab. (73 Uffe PA5DD 
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32. RX-Frequenz über die Tastatur ändern (Move RX Frequency from the 
Keyboard)

Bei DXpeditionen fällt auf, dass sie nach jedem QSO die Empfangsfrequenz ändern. 
Aus diesem Grund wurde bei N1MMLogger die Frequenzänderung über die Tastatur 
eingebaut. Schalten Sie auf Splitbetrieb und ändern Sie die RX-Frequenz mit den 
Pfeiltasten links/rechts. Stellen Sie die Sprungweite unter Config > Config Port..>  
Karteikarte Other ein. Sie brauchen dann nicht an der RIT oder dem RX-VFO 
drehen.  (Gerry VE6LB/VA6XDX)

33. QSOs mitschneiden (Recording QSOs)

Sie können für alle QSOs die Transceiver-NF mitschneiden und sich hinterher alle 
QSOs anhören. 

• Öffnen Sie das Config-Menü und wählen Sie 'Record QSOs' . 
• Normalerweise ist Ihr Mikrofon mit dem Soundkarteneingang ‘Mic’ und der 

Transceiver-NF-Ausgang mit dem Soundkarteneingang “Line in” verbunden. 
Sie können damit die NF aufzeichnen, ohne Änderungen an der Verdrahtung 
zu machen. Die Umschaltung wird auf der Karteikarte Audio für Aufzeichnung 
und Wiedergabe eingestellt. 

• Beachten Sie: Wenn Sie den Lautsprecherausgang des Transceivers 
verwenden, ändert sich der Pegel mit der eingestellten Lautstärke. Auch die 
Sender-Audio ändert sich mit der eingestellten Mithörlautstärke. Es gibt 
Programme mit denen Sie die benötigten Pegel speichern und wieder abrufen 
können. Siehe   Links chapter  . 

• Wollen Sie auch Ihre eigene NF aufzeichnen, müssen Sie am Transceiver den 
Monitor einschalten. 

• Die Aufzeichnung erfolgt QSO-bezogen. Sie endet mit dem QSO-Loggen. 
Dann beginnt eine neue Aufzeichnung.  

• Im Configurer können Sie auf der Karteikarte Audio eine Zeitüberwachung 
einstellen. 

• Jedes QSO wird getrennt als WAV-Datei gespeichert. Der Dateiname ergibt 
sich aus Rufzeichen-Datum-Zeit, z.B."N1MM 10-26-03 - 22 47 45.wav" 

• Die WAV-Dateien werden in einem Verzeichnis mit dem Contestnamen 
abgespeichert, z.B. C:\Program Files\N1MM Logger\CQWW\.... 

• Wav-Dateien können aus dem Contestlogfenster mit einem Rechtsklick auf 
ein QSO und Menüwahl 'Play contact' abgespielt werden. Die Wiedergabe 
kann mit ESC gestoppt werden. 

• Sie können die Wav-Dateien auch mit jedem beliebigen Soundprogramm 
abspielen, das WAV-Dateien unterstützt.  

• Sie brauchen ungefähr 1 GB pro 24 Stunden (40-50 MB je Stunde) bei 8 Bits 
und 11025 Hz/sec. Es gibt Programme, die diese Dateien noch in MP3-
Dateien umwandeln und komprimieren, aber das ist während eines Contests 
nicht sinnvoll. 

• Die Aufzeichnung wird beendet, wenn auf der Festplatte wenige als 40 MB frei 
sind. 
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• Testen Sie die Einstellungen sorgfältig. Es ist ziemlich schwierig, alle Pegel 
richtig einzustellen. Besser ist die Verwendung des NF-Ausgangs am ACC-
Ausgang. 

Last Modification: 26 September 2009 15:38:38 EDT by K8UT. 

UKW-Conteste fahren (VHF and Up Contesting)

In N1MMLogger wurde das Contesten auf UKW von 2m bis hinauf zu 241 GHz 
eingebaut. 

 

1. VHF-Einstellungen (VHF Options)

Die Frequenz wird in der Bandskala und im Logeingabefenster angezeigt. Oberhalb 
von 1 GHz wird das Band in cm angezeigt und nicht die genaue Frequenz. Sie sehen 
dann, für welches Band das QSO abgespeichert wird. 
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2. Lokator-Tasten-Zuordnung (Gridsquare Key Assignments (VHF and 
up))

• Alt+equal (=) – Wenn Sie in das Rufzeichenfenster eine Lokator eingeben 
und mit ALT+= abschließen, wird nach einer Station mit diesem Lokator 
gesucht und das Ergebnis im Check-Fenster ausgegeben.

• Alt+minus (-) : Diese Eingabe sucht nach einer Station in der 
Rufzeichengeschichte und den maximal angegebenen drei Lokatoren je 
Station.

2.1. Rufzeichengeschichte (Call History Lookup)

Informieren Sie sich im Kapitel Vor dem Contest (Before the Contest) zu der 
Rufzeichengeschichte. 

Vor allem in UKW-Contesten ist die Suche in der Rufzeichenliste sehr nützlich. Sie 
brauchen allerdings eine Liste mit Stationen, Namen und Lokator(en). Die Suche in 
der Rufzeichengeschichte wird aktiviert mit dem Menü Config >Call History 
Lookup. Wird eine Station gefunden, werden maximal zwei zugehörige Lokatoren 
und der Name angezeigt. 

2.2. Rufzeichengeschichte aktualisieren (Updating the Call History 
File)

Sie können aus einem aktuellen Contestlog mit Tools >Update Call History with 
current log' eine eigene Rufzeichengeschichte erzeugen. Eine andere Methode ist 
das Programm Thucydides von Carel, PC5M. Sie finden hier einen Link zu dem 
Programm. 

3. Die Datei VHFMaster.dta (VHF master.dta File)

Versuchen Sie, eine Master.dta-Datei für UKW zu finden. Ein gutes Werkzeug zum 
Erzeugen einer solchen Datei hat Alex, VE3NEA geschrieben. Ein Beispiel für eine 
UKW-Master.dta finden Sie unter Downloads auf der N1MM-Webseite.

3.1. Transverterunterstützung (Transverter Support)

Sie können unter N1MMLogger je Band einen Transverter eintragen. Seine 
Umsetzquarzendfrequenz wird dann zu der am Kurzwellenachsetzer eingestellten 
und per CAT gemeldeten Frequenz dazu addiert. Klicken Sie rechts in die Bandskala 
und wählen Sie Set transceiver Offfset frequency. 

Das Programm speichert den eingegebenen Offset ab.  
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• Band (kHz) : Bandanfang und Ausgangsfrequenz des Transverters 
• IF Freq (kHz) : ZF-Eingangsfrequenz für den Bandanfang 

Sie können eine Frequenzabweichungen des Transverters eintragen. Im Beispiel für 
das 70cm-Band wird die Umsetzablage des Transverters von 120Hz durch die 
Angabe 432000,12 berücksichtigt. Bei DXSpots wird dann am Nachsetzer die exakte 
Frequenz eingestellt.

Bandumschaltung (Bandup/Banddown)

Die Bandumschaltung lässt sich nicht so einfach realisieren, wie auf der Kurzwelle. 
Achten Sie darauf, dass Hard- und Software aufeinander abgestimmt sind und immer 
der richtige Transceiver mit dem richtigen Transverter aktiv ist.

4. UKW-Baken (VHF Beacons)

N1MMLogger kann die Frequenzen von Baken auf Wunsch in der Bandskala 
anzeigen. Sie werden analog zu DXSpots behandelt. Da DXSpots nur eine 
bestimmte Lebensdauer haben, muss die Bakenanzeigedauer getrennt eingestellt 
werden. Erzeugen Sie eine Baken-Datei unter dem Namen Beacons.txt. Sie kann 
so aussehen:

# Hours to stay in bandmap (mostly > 24 or > 48)
60
# Call beacon;Frequency;Grid;Comments
OZ7IGY/B;144471,1;JO55WM;
PI7CIS/B;144416,2;JO22DC;Should always be heard
DL0PR/B;144486,3;JO44JH;Switches power!
GB3VHF/B;144430.4;JO01DH;QRG with a .
ON0VHF/B;144418,5;JO20;4 digit grid

Geben Sie in das Rufzeichenfeld des Logeingabefensters das Wort BEACONS ein. 
Es öffnet sich ein Explorer-Fenster, in dem Sie die Baken-Datei auswählen und 
öffnen können. Zeilen in der Datei Beacons.txt mit einem # davor enthalten einen 
Kommentar. Der erste Zahlenwert, hier 60, bestimmt die Anzeigedauer
Eine Datenzeile beginnt mit dem Rufzeichen der Bake, dann folgen die Frequenz in 
Kilohertz, der Lokator und wahlweise ein Kommentar. Die Daten sind durch ein 
Semikolon getrennt (nicht vergessen!). 

Eine Datei mit den europäischen Baken finden Sie unter Other Files im Download-
Bereich auf der N1MM-Webseite.  
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 Die NCDXF/IARU Beacon Network 
Die Baken des NCDXF/IARU Beacon Network auf 14.100, 18.110, 21.150, 24.930 
and 28.200 sind bereits unter N1MMLogger enthalten. Wenn Sie eine der 
Frequenzen am Transceiver einstellen, wird die aktuell aktive Bake in der 
Statusleiste des Logeingabefensters angezeigt.  

5. Beispiele für einen UKW-Contest (Example Contest Setup)

Ergänzungen sind erwünscht!

5.1. Erzeugen Sie vor dem Contest (Create (days) Before the 
Contest)

• Eine neue Datei master.dta  
o Verwenden Sie das Werkzeug von Alex, VE3NEA, siehe  Links 

• Eine Datei 'N1MM logger.ini' zur Verwendung während des Contest 
o Machen Sie alle benötigten Einstellungen und ordnen Sie die Fenster 

nach Ihren Wünschen an 
o Vergessen Sie nicht die Karteikarte 'Mode Control' im Configurer 
o Wenn Sie N1MMLogger schließen werden alle Einstellungen in der 

Datei 'N1MM logger.ini’ abgespeichert 
o Kopieren Sie die Datei 'N1MM logger.ini' in eine Datei 

‘VHFsettings.ini'. 
• Eine Textdatei mit den Funktionstasten für SSB/CW

o Mit 'File > Export > Export Function Keys to file... > SSB Function 
Keys' . Taufen Sie sie auf VHFssbfunctionkeys.mc 

o Mit File > Export > Export Function Keys to file... > CWFunction 
Keys' eine Datei VHFCwfunctionkeys.mc

• Eine Textdatei mit den Packet/Telnet-Tastentexten 
o Mit File >Export >Export Packet/Telnet Buttons to file...' eine Datei 

VHFpacketbuttons.txt 
o Informieren Sie sich im Kapitel Macros über die zu VHF passenden 

Macros z.B. {GRIDSQUARE} 
• Eine Datei für die Rufzeichengeschichte mit Rufzeichen, Name und Lokatoren 

unter dem Namen VHFlookup.txt 
• Operatorbezogene WAV-Dateien für SSB mit CQ, Lokator, RST usw. Siehe 

{OPERATOR} macro im Kapitel Macros
• Die neueste Datei wl_cty.dat.Die Datei ist bei UKW nicht so interessant, sie 

ordnet aber ausgefallene Prefixe dem richtigen Land zu. 
• Ein Testlog zur Überprüfung Ihrer Einstellungen
• .... 

6. Vor dem Programmstart (Before Starting the Program)

• Kopieren Sie die erzeugte Datei master.dta in das N1MMLogger-Verzeichnis 
• Kopieren Sie die erzeugten WAV-Dateien in das WAV-Verzeichnis von 

N1MMLogger 
• Schalten Sie die Windows-Sounds mit der Systemsteuerung > Sound > 

Sounds > Keine Sounds ab 
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• Benennen Sie die Datei ' VHFsettings.ini'.um in 'N1MM logger.ini' und 
kopieren Sie sie in das N1MMLogger-Verzeichnis

• Überprüfen Sie, ob alle Einstellungen wie gewünscht funktionieren 

7. Nach dem Programmstart (After Starting the Program)

• Gehen Sie zu File >Open Log in Database und öffnen Sie die UKW-
Datenbank. 

• Import 
o Diesen Schritt brauchen Sie nur zu machen, wenn Sie immer die 

gleiche Datenbank für UKW-Conteste verwenden 
o Sie können in jeder Datenbank tausende von QSOs loggen und 

brauchen nicht für jeden Contest eine neue Datenbank anlegen 
o Importieren Sie die für den Contest angelegten Dateien für die 

Tastenbelegungen: 
 Funktionstasten für SSB und CW 

 File >Import >Import Function Keys to file... >SSB 
Function Keys für die Dateien VHFssbfunctionkeys.mc 
und VHFcwfunctionkeys.mc) 

 Packet/Telnet-Tasten 
 File >Import >Import Packet/Telnet Buttons from file... 

für die Datei VHFpacketbuttons.txt 
 Rufzeichengeschichte 

 File >Import >Import Call History File für die Datei 
VHFlookup.txt

 DXCC-Länder-Datei 
 Tools >Import country list from downloaded file. 

o Überprüfen Sie Einstellungen im Stationsdialog: Config >Change your 
Station Data, hier vor allem den Stationsstandort mit seinen 
Koordinaten, die für die Berechnung der Antennenrichtung und der 
Entfernungspunkte benötigt werden

• Überprüfen Sie Contestwahl mit File >Choose Which Contest to Log 
o Geben Sie die contestspezifische Kontrollnummer ein

• Überprüfen Sie Steuerung von CAT, PTT und CW (Karteikarte Mode Control 
im Configurer)

• Verwenden Sie Transverter, dann tragen Sie die Offsetfrequenz in die 
Bandskalen A und B ein. 

Viel Spass im Contest !! 

Last Modification: 26 September 2009 15:43:06 EDT by K8UT. 
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Referenzen (Reference)
Tastenbelegung (kurze Liste)

RUN-Modus S&P-Modus
F1 = CQ Shift+F1 = Rufe CQ und schalte auf RUN
; oder Einfg = Sende 
Rufzeichen und Rapport

Alt+U= Umschalten zwischen S&P/Run. Setze CQ-
Frequenz für Pass

' = Sende TU und logge das 
QSO Alt+Q = Gehe zurück zur CQ-Frequenz

Alt+R = CQ-Wiederholung 
einschalten

Ctrl+Up/Dn arrow = Weiter zum nächsten QSO in 
der Bandskala

Ctrl+R = Wiederholzeit 
einstellen

Ctrl+Alt+Up/Dn arrow = Weiter zum nächsten Multi 
in der Bandskala

Esc = Senden und wiederholen 
abbrechen

Allgemeine Tasten Transceiversteuerung 
Ctrl+O = Operator eingeben Alt+F10 = VFOs vertauschen
Ctrl+N = Notiz hinzufügen Alt+Q = Gehe zurück zur CQ-Frequenz
Ctrl+W oder Alt+W = 
Eingabefelder löschen, 
Seriennummer freigeben

Alt+F8 = Rückkehr zur letzten Frequenz

SPACE oder TAB = Von 
Eingabefeld zu Eingabefeld 
fields

Ctrl+PgUp/PgDn = Bandwechsel nach oben/unten

ENTER = QSO loggen oder 
weiter im ESM-Modus

CW/USB/LSB/RTTY anstatt eines Rufzeichens 
eingeben = Sendeart wechseln

Ctrl+Q/A = Schnelleditieren 
nach oben/unten

Ctrl+S = Splitbetrieb einstellen. Mit Ctrl+Alt+S – 
ein/aus

Ctrl+D = Letztes QSO löschen Ctrl+Enter = Splitfrequenz eingeben

Alt+H = Hilfe holen Alt+F7 = Setze Splitfrequenz auf eingegebenen 
Wert

Alt+K = Tastentexte editieren Alt+' = Umschalten zwischen breitem und schmalen 
Filter

Ctrl+Alt+Enter = Logge nicht 
angenommenes QSO trotzdem

Alt+F12 : Kopiere Frequenz und Sendeart zum 
anderen Transceiver oder VFO oder tausche MAIN- 
und SUB-VFO per CAT-Kommando

- Backslash ( \ ) = Tausche RX-Fokus für 
VFO/Transceiver

DX Spots und Bandskala ESM-Modus
Mausrad = Zoom hinein/hinaus Ctrl+M = ESM ein/aus
Nummermfeld- +/- = Zoom 
hinein/hinaus Einf oder ; = Sendet Rufzeichen+Nummer

Alt+D = Remove spot Enter = Send TU and log it
Alt+P = Sendet DXSpot Enter = Startet CQ noch mal...
Ctrl+P = Sendet DXSpot mit Alt+Enter = Loggen ohne weitere Sendung
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Kommentar
Ctrl+Tab = Packet-Fenster 
ein/aus Multi-Nutzer-Modus

Alt+O = Speichert QSO in der 
Bandskala Alt+Z = Schickt Passfrequenz an alle PCs

Alt+Q = Zurück zur CQ-
Frequenz auf diesem Band

SO2R Transceiversteuerung / Rotorsteuerung
Backslash ( \ )  Wechselt RX-
Fokus

FT-1000MP + FT1000D + some Icom Dual Watch 
radios Alt+F12= Schaltet 2.RX ein/aus

Pause = Tauscht 
RX/TX/Tastatur zwischen den 
Transceivern
Ctrl+Enter = Sendet nächsten 
ESM-Status auf dem anderen 
TCVR

TenTec Orion Alt+F12 = Umschalten zwischen 
Main links/Sub rechts und beiden Ohren

Ctrl+F1 to F12 = Sendet 
Tastencode auf anderem 
Transceiver

Ctrl+B = Dueling CQ's Rotor control for the callsign in the Entry 
window

` (Back-quote) = Umschalten 
Stereo/Mono an Pin5 der LPT-
Schnittstelle

Alt+J – Rotor auf SP drehen

Ctrl+I – Umschalten zwischen 
den Soundkartenmodi 
($5SO2R)

Alt+L – Rotor auf LP drehen

- Ctrl+Alt+J – Rotor anhalten
CW SSB RTTY VHF

Bild hoch = + 2WpM Ctrl+Shift+F1 
=CQ aufzeichnen

Alt+G = Hole Call vom 
Stapel

Alt+= = Suche 
nach Rufzeichen 
oder Lokator

Bild runter = - 2 WpM Ctrl+Shift+F* =F*-
Taste aufzeichnen

Alt+T = RX/TX-
Umschaltung

Alt+minus = 
Wähle anderen 
Lokator

= = sende letzte F-
Taste noch einmal

NB.Die gleichen 
Tasten beenden 
die Aufzeichnung

Ctrl+Pfeile = tausche 
DInterface

Ctrl+E = Sende 
Nachricht an 
Stationen

Ctrl+K = CW-
Direkteingabefenster

Ctrl+K = öffne 
Direkteingabefenster

Alt+Z = Setze 
Passfrequenz

Esc = Ende des 
Sendens - Esc = Ende des 

Sendens -

Last Modification: 03 October 2009 11:07:38 EDT by K8UT. 
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Tastenzuordnungen (Key Assignments)
 Hinweis: Diese Tasten funktionieren aus allen Hauptfenstern heraus 

1. Allgemeine Tastenzuordnungen (General Key Assignments)

• Space (Leertaste) : Mit der Leertaste kommen Sie im Logeingabefenster von 
Eingabefenster zu Eingabefenster. Mit Standdardwerten wie 59/599 belegte 
Fenster werden übersprungen. Die Leertaste sollte anstelle der TAB-Taste 
in der Regel verwendet werden.. 

• Tab (Tabulator)- Mit der TAB-Taste schalten Sie von Eingabefeld zu 
Eingabefeld unabhängig von dessen Inhalt 

• Shift+Tab : Schaltet rückwärts von Feld zu Feld. 
• Alt+H : Holt die Hilfe zu dem jeweiligen Fenster  
• Ctrl+Tab : Schaltet die Eingabe zwischen dem Logeingabefenster und dem 

Packet/Telnet-Fenster hin und her 
• Alt+F9 : schaltet die zu diesem Band konfigurierten Antennen durch. Die 

ausgewählte Antenne wird in der Statusleiste angezeigt 
• Alt+F4 : Beendet das Programm. Sie werden nach einer Quittung gefragt. 

2. Tasten in der aktiven Bandskala (Active Radio/Bandmap Control Key 
Assignments)

2.1. DXSpots ansteuern (Jump to Spots)
 Hinweis: Haben Sie eine feste Sendeart eingestellt, ändert sich die Sendeart mit 

den DXSpots nicht 

• Ctrl+Pfeil nach unten: Nächste Station (blau) mit höherer Frequenz 
• Ctrl+Pfeil nach oben:  Nächste Station (blau) mit niedrigerer Frequenz 
• Ctrl+Alt+Pfeil nach unten: Nächster Multi (rot)mit höherer Frequenz 
• Ctrl+Alt+Pfeil nach oben: Nächster Multi (rot) mit niedrigerer Frequenz 

2.2. Sprung zur CQ-Frequenz (Jump to CQ Frequencies)

• Alt+Q : Springt zur letzten CQ-Frequenz in der aktiven Bandskala und löscht 
die Felder im Logeingabefenster 

• Shift+Alt+Q - Springt zur letzten CQ-Frequenz in der inaktiven Bandskala und 
löscht die Felder im Logeingabefenster 

• Ctrl+Alt+Q : Springt zur zuletzt verwendeten CQ-Frequenz auf einem 
beliebigen Band und stellt den Transceiver und die Bandskala auf diese 
Frequenz. 

• Shift+Alt+Pfeil nach oben : Geht zur nächsten selbstgespotteten Station 
niedriger in der Frequenz. 

• Shift+Alt+Pfeil nach unten:  Geht zur nächsten selbstgespotteten Station 
höher in der Frequenz 

11.04.2010



N1MM-Contest Logging Software Seite 248 von 470 Übersetzung der Hilfe von Eike, DM3ML

2.3. Transceiver abstimmen (Tune the Radio)

• Ctrl+Bild hoch: Schalte auf das nächst höhere Band. WARC-Bänder werden 
in einem Contest übergangen 

• Ctrl+Bild runter: - Schalte auf das nächst niedrigere Band. WARC-Bänder 
werden in einem Contest übergangen. 

• Pfeil nach oben:  Stellt den VFO 100 Hz höher in SSB bzw.  20 Hz höher in 
CW (Werte im Configurer einstellbar) 

o FT-1000MP, FT-890, FT-920, FT-990 und FT-1000 und alle 
Kenwood-Tcvr: 

 Im S&P-Modus : RIT wird ausgeschaltet und der VFO 
abgestimmt 

 In RUN-Modus: RIT wird eingeschaltet und die RIT abgestimmt. 
• Pfeil nach unten:  - Stellt den VFO 100 Hz tiefer in SSB bzw.  20 Hz tiefer in 

CW (Werte im Configurer einstellbar. 
o Wie oben

• Alt+F7 : Stellt Splitfrequenz nach Eingabe in sich öffnendes Fenster ein. 
Abbruch mit ESC.  

• Ctrl+Enter : Ins Rufzeichenfeld eingegebene Frequenz wird als Splitfrequenz 
eingestellt 

• Alt+S : Falls im Splitbetrieb aktiv, setzt ALT+S die RX-Frequenz zurück auf 
die TX-Frequenz. Falls die Option "Reset RX frequency when running split" 
aktiv ist, wird mit jedem Loggen ein ALT+S ausgeführt. Gilt nur für den VFO-A! 

• Ctrl+S : Schaltet den Transceiver in den Splitbetrieb, wenn er sich noch nicht 
darin befindet. 

• Ctrl+Alt+S : Vertauscht TX- und RX-Frequenz im Splitbetrieb 
• Alt+F5 : Tauscht die beiden VFOs (bei SO2V) oder die beiden Transceiver 

(bei SO2R) bezüglich Frequenz und Sendeart aus. Der RX-Fokus wird auf 
den nicht aktiven Tcvr gesetzt. 

• Alt+F6 : wie Alt+F5, aber der RX-Fokus wird nicht ausgetauscht 
• Alt+F8 : Kehre zur letzten Frequenz zurück 
• Alt+' (Alt+Hochkomma) : Schaltet zwischen dem breiten und dem schmalen 

Filter hin und her 

2.4. Tastatur- und Transceiver-Fokus wechseln (Change Keyboard 
& Radio Focus)

• Ctrl+Pfeil links: Schaltet im SO2V/R-Modus alles auf den VFO-A/ linken 
Transceiver 

• Ctrl+Pfeil rechts: Schaltet im SO2V/R-Modus alles auf den VFO-B/ rechten 
Transceiver 

•  
• Alt+F10 : Schaltet die VFOs eines Transceivers um. Beim Icom 756 und 7800 

wird zwischen Haupt- und Sub-Frequenz umgeschaltet. 
o Kommando ist bei SO2R abgeschaltet 

• Pause : Tauscht Transceiver und Tastatur aus 
• Backslash ( \ ) :  Wechselt den RX-Fokus und öffnet eine zweites 

Logeingabefenster falls noch keins geöffnet ist  
o SO2V :  Ein Transceiver – zwei VFOs. Wechselt zwischen den VFOs 
o SO2R: Zwei Transceiver: Wechselt den RX-Fokus zwischen den 

Transceivern  
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2.5. Weitere Möglichkeiten (Other Nifty Tricks)

• Mausrad: Nach Klick in die Bandskala können Sie mit dem Mausrad den 
Zoom in der jeweiligen Bandskala ändern 

• +Taste im Nummernfeld: dehnt die Bandskala (weniger Stationen) 
• -Taste im Nummernfeld:  staucht die Bandkala (mehr Stationen) 
• Ctrl+T : Abstimmtaste, Dauerträger zum Abstimmen. Ende mit weiterem 

Ctrl+T oder ESC. 
• Alt+F11 : Zwischen RUN und S&P hin- und herschalten. Bzw. Bei 

Frequenzwechsel im RUN-Modus bleiben (Dxpedition) 
• Alt+F12 : Kopiert Frequenz und Senderart zum anderen VFO/Transceiver 

(Tcvr abhängig) 
o Einige Transceiver kopieren zwischen MAIN- und SUB-VFO 
o Nur bei FT-1000MP + FT1000D + Icom IC-756 series, IC-781 ,IC-775 

and IC-7800 
 Umschalten von Dual-Empfang 

o TenTec Orion 
 Umschalten zwischen Main/links und Sub/rechts und Active in 

beiden Ohren. 
• ` (backquote) : Umschalten Stereo/Mono ( LPT Pin 5) 

o Dieses Zeichen erscheint auf US-Tastaturen als Tilde ~ 
• = (Gleichheitszeichen) : Wiederholt die zuletzt gesendete F-Taste 

3. Tasten in dem/der nicht aktiven Transceiver/Bandskala (Non-Active 
Radio/Bandmap Control Key Assignments)

3.1. Sprung zu DXSpots (Jump to Spots)

• Ctrl+Shift+Pfeil nach unten: Springt zum nächsten DXSpot mit der höheren 
Frequenz und übergeht die CQ-Frequenz, wenn beide VFOs auf dem gleichen 
Band stehen. Bei SO1V nicht wirksam.  

• Ctrl+Shift+Pfeil nach oben: - Springt zum DXSpot mit der niedrigeren 
Frequenz und übergeht die CQ-Frequenz, wenn beide VFOs auf dem gleichen 
Band stehen. Bei SO1V nicht wirksam.  

• Shift+Ctrl+Alt+Pfeil nach unten:  Springt zum nächsten Multi mit der 
höheren Frequenz und übergeht die CQ-Frequenz, wenn beide VFOs auf dem 
gleichen Band stehen. Bei SO1V nicht wirksam.  

• Shift+Ctrl+Alt+Pfeil nach oben:  - Springt zum nächsten Multi Spot mit der 
niedrigeren Frequenz und übergeht die CQ-Frequenz, wenn beide VFOs auf 
dem gleichen Band stehen. Bei SO1V nicht wirksam.  

• . Shift+Alt+Q :  Setzt den inaktiven VFO/Tcvr auf die letzte dort verwendete 
CQ-Frequenz 

3.2. Transceiver abstimmen (Tune the Radio)

• Ctrl+Shift+Bild nach oben: Gehe zum nächst höheren Band 
• Ctrl+Shift+Bild nach unten: Gehe zum nächst niedrigeren Band
• Shift + Plustaste im Nummernfeld: Inaktive Bandskala dehnen 
• Shift + Minustaste im Nummernfeld:  Inaktive Bandskala stauchen 
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4. Tasten zum Loggen (Logging Key Assignments)

• Enter 
o Loggt ein QSO im ausgeschalteten ESM-Modus 
o Sendet im eingeschalteten ESM-Modus die Nachrichten entsprechend 

der Zustandstabelle des aktuellen QSOs. Die zu sendenden Tasten 
werden hell getastet. 

• Space : Schaltet zwischen den Eingabefelder weiter. Übernimmt ein über dem 
leeren Rufzeichenfeld stehendes Rufzeichen in das Rufzeichenfeld. Übergeht 
standardmässig gefüllte Felder (59/599).

• Alt+Enter : Sendet QSO-Ende und loggt das QSO. Im ESM-Modus wird 
nichts gesendet. 

• Einf oder ; : Sendet das Rufzeichen der Gegenstation und die 
Kontrollnummer (F5+F2) 

• ' - : Sendet die TU-Nachricht (F3) und loggt das QSO . 
• Alt+W oder Ctrl+W : Löscht die Felder des Logeingabefensters. Gibt eine 

reservierte Seriennummer wieder frei. 
• Ctrl+Shift+W : Löscht andere Kontaktdaten 
• Ctrl+Alt+Enter : Loggt ein “angemeckertes” QSO trotzdem und öffnet das 

Notizfenster für einen Kommentar bzw. markiert das QSO mit der Notiz 
„Forced QSO". 

• Ctrl+Y : Letztes QSO editieren 
• Ctrl+D : Letztes QSO löschen 
• Alt+O : QSO in die Bandskala setzen 
• Alt+M : Frequenz in der Bandskala als belegt markieren 
• Alt+D : Entfernt den Eintrag in der Bandskala für ein Rufzeichen, das über 

oder im Rufzeichenfeld steht 
• Alt+P : Spottet ein QSO in der aktuellen Packet/Telnet-Verbindung
• Ctrl+F : Sucht ein in das Rufzeichenfeld eingegebenes Rufzeichen im Log. 

Weiterschalten mit Ctrl+F.
• Ctrl+M: ESM-Modus ein/aus 
• Ctrl+N: Notiz zu einem QSO hinzufügen 
• Ctrl+Q : Schnell-Editieren, gehe ein QSO nach oben. Loggen der Änderung 

mit ENTER, verwerfen mit ESC. 
• Ctrl+A : Schnell-Editieren, gehen ein QSO nach unten Loggen der Änderung 

mit ENTER, verwerfen mit ESC. 
• Ctrl+U : Erhöht die im RX-Kontrollnummerfeld stehende Nummer um Eins. 
• Shift+Enter : Funktioniert nur im Multi-Nutzer-Modus und holt Rufzeichen aus 

dem Stapel-Speicher. Siehe Erweiterte Funktionen.
• Alt+U : Aktiviert den RUN-Modus. QSOs werden im RUN-Modus abgewickelt. 
• Alt+K : Ruft die Editier-Funktion für die Packet/CW/SSB/Digital-Tasten 
• Alt+Y : Übernimmt das erste Rufzeichen im Rufzeichenprüffenster (Check 

window) in das Rufzeichenfeld des Logeingabefensters 
• Ctl+G : Ändert die Art der Nummernausgabe 
• Ctrl+Shift+M : Setzt die Schwelle für die Auto-Send-Option. 
• Ctrl+Alt+G : Setzt Rufzeichen in den Stapelspeicher, wie Macro 

{STACKANOTHER} 
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5. Änderungen im Logeingabefenster (Callsign/Exchange Editing 
Features)

• Space Bar (Leertaste): Schaltet die möglichen Eingabefelder durch 
• Tab: Schaltet alle Felder des Logeingabefensters vorwärts durch 
• Shift+Tab : Schaltet alle Felder des Logeingabefensters rückwärts durch
• Home (Pos1): Setzt Cursor an den Anfang des Feldes, in dem er sich 

befindet 
• End (Ende):  Setzt Cursor an das Ende des Feldes, in dem er sich befindet 
• Fragezeichen (?) : Sendet ein ? und tastet die Stelle oder den Bereich im 

Eingabefeld, an der es steht hell. Die erste Eingabe wird an die Stelle des/der 
Fragezeichen eingesetzt. 

• Pfeil links/rechts: Bewegt den Cursor im Eingabefeld 
• Backspace : Löscht das Zeichen links vom Cursor. 
• Delete (Entf): Löscht das Zeichen rechts vom Cursor 
• Shift+Home (Shift+Pos1): Bereich zwischen Cursor und Anfang wird hell 

getastet 
• Shift+End (Shift+Ende) : Bereich zwischen Cursor und Ende wird hell 

getastet 
• Shift+Pfeiltaste:   Helltastung, wenn gedrückt. Das erste eingegebene 

Zeichen löscht und überschreibt den hell getasteten Bereich 

6. F-Tastenzuordnung (Message Key Assignments)
Die Tasten F1 bis F12 können im RUN- und im S&P-Modus mit Texten konfiguriert 
werden. In der Tabelle sind die ersten 12 Tasten dem RUN-Modus und die zweiten 
12 dem S&P-Modus zugeordnet. Die ersten 12 Tasten MÜSSEN programmiert sein, 
in der Gruppe der S&P-Tasten brauchen nur die ersten Tasten belegt sein, nicht 
programmierte Tasten senden den unter RUN programmierten Text. 
Die acht Tasten sind wie folgt vorprogrammiert: 
 
Voreingestellte Tasten

F1 CQ F2 Kontrollnummer F3 Ende des QSOs F4 Eigenes Call
F5 Call der Gegenstation F6 QSO B4 F7 - F8 Again 
F9 - F10 - F11 - F12 -

• Esc : Stoppt eine CW-Sendung oder eine WAV-Datei 
• Ctrl+R : Setzt die CQ-Wiederholzeit in s oder ms, voreingestellt 1.8 oder 1800 
• Alt+R : Schaltet die Auto-CQ-Ruf ein. ESC schaltet ihn aus  
• Ctrl+Shift+Fx : Aufzeichnung einer Sprachdatei in SSB für Taste Fx. Mit 

gleicher Kombination wird die Aufzeichnung wieder beendet. Fx=F1 bis F12. 
• Ctrl+Alt+Fx : Aufzeichnung für einen externen Voice-Rekorder mit den Tasten 

F1 to F4. 

7. CW-Tastenzuordnung (CW Key Assignments)

• Bild hoch/Bild runter: CW-Geschwindigkeit je Tastendruck +/- 2 WpM für 
aktiven VFO/TCVR 

• Shift+Bild hoch/runter: CW-Geschwindigkeit je Tastendruck +/- 2 WpM für 
inaktiven VFO/TCVR im SO2V/R-Modus
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• Alt+Bild hoch/runter: PgUp/ CW-Geschwindigkeit je Tastendruck +/- 2 WpM 
für inaktiven VFO/TCVR im SO2V/R-Modus in der Sekundäreinstellung

• Ctrl+K : Öffnet Fenster für Eingabe von CW-Text über die Tastatur. Wird mit 
Ctrl+K wieder geschlossen. Text aus dem Fenster wird bis zum Ende 
gesendet, auch wenn das Fenster vorher geschlossen wird 

• Ctrl+Shift+R : Schaltet zwischen CW normal und reverse hin und her 

8. Liste der Multis (Multipliers by Band window Key Assignments)

• Ctrl+J : Öffnet Multi-Liste und schaltet Länder, Zonen, Sektionen u.a. durch 
• Ctrl+Shift+J : Öffnet und schließt Multi-Fenster

9. Multi-Nutzer-Tasten (Multi-User Key Assignments)

• CTRL+U : Sendet Talk-Meldung an andere Station im Netz 
• Ctrl+O : Operatorwechsel 
• Alt+Z : Meldet die aktuelle Arbeitsfrequenz (Pass frequency) an alle Stationen 

im Netz 
• Ctrl+Alt+M : Schaltet zwischen RUN-Modus und Multi-Station hin und her 

10. ESM-Modus ('Enter Sends Message' mode (ESM))

• Ctrl+M : Schaltet den ESM-Modus ein/aus
• Alt+Enter : Loggen, ohne etwas zu senden

ESM-Zustandstabelle

RUN-Modus S&P-Modus
Rufzeichenfeld Kontrollnummernfeld ENTER sendet ENTER sendet 
Leer Leer CQ (F1) My Call (F4) 

Neues Call 1.Versuch Leer oder ungültig His Call + Exch 
(F5 + F2) My Call (F4) 

Neues Call wiederholt Leer oder ungültig Again? (F8) My Call (F4) 

Neues Rufzeichen Gültig, vor dem Senden His Call + Exch 
(F5 + F2)

Exchange (F2) 
+ Loggen 

Neues Rufzeichen Gültig, nach dem 
Senden

End QSO + Log 
(F3 + Loggen)

Sendet nichts + 
Loggen 

DUPE-Rufzeichen Leer oder ungültig QSO B4 (F6) nichts 

DUPE-Rufzeichen Gültig, vor dem Senden QSO B4 (F6) Exchange (F2) 
+ Loggen 

DUPE-Rufzeichen Gültig, nach dem 
Senden

End QSO + Log 
(F3 + Loggen) nichts

DUPE zum Ersten, Work 
Dupes nicht aktiv Leer oder ungültig His Call + Exch 

(F5 + F2) QSO B4 (F6) 

DUPE wiederholt, Work 
Dupes nicht aktiv Leer oder ungültig Again? (F8) QSO B4 (F6) 

DUPE arbeiten erlaubt Gültig, vor dem Senden His Call + Exch 
(F5 + F2)

Exchange (F2) 
+ Loggen 

DUPE arbeiten erlaubt Gültig, nach dem End QSO + Log nichts
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Senden (F3 + Log It)

11. Tasten im Packet/Telnet-Fenster (Packet/Telnet Key Assignments)

• Ctrl+P : Spottet eine im Rufzeichenfeld stehende Station über die aktive 
Packet/Telnetverbindung. Sie werden nach einem Kommentar gefragt. Steht 
im Rufzeichenfeld kein Rufzeichen, wird das letzte gearbeitete Rufzeichen 
genommen 

• Linksklick : Ein Klick auf einen DXSpot stellt den aktiven Transceiver auf 
diese Frequenz.. 

• Shift+Linksklick:  Der inaktive Transceiver wird auf diese Frequenz gestellt 
• SH/DX : Wenn in das Rufzeichenfeld des Logeingabefensters eingegeben, 

wird es an das Packet/Telnet-Fenster weitergeleitet 

12. Angebotsfenster (Available Window Key Assignments)

• Linksklick: Setzt den aktiven Transceiver auf diese Frequenz 
• Shift+Linksklick:  Setzt den inaktiven Transceiver auf diese Frequenz
• Doppelklick : Setzt den aktiven Transceiver auf diese Frequenz  

13. SO2R-Tasten (SO2R Key Assignments)

• Ctrl+Enter : Sendet die nächste ESM-Meldung im inaktiven Transceiver (ESM 
eingeschaltet, SO2R aktiviert. 

• Ctrl+F1 to F12 : Sendet die Nachricht der Taste Fx im inaktiven Transceiver
• Ctrl+Pfeil links:  Linker Transceiver wird aktiv 
• Ctrl+Pfeil rechts:  Rechter Transceiver wird aktiv 
• Pause : Wechsel zum  anderen Transceiver  
• Ctrl+B :  Abwechselnd CQ senden auf beiden Transceivern 
• Taste ‘ oder ~ :  Schaltet STEREO ein/aus 
• Ctrl+I : Schaltet die möglichen Soundkarten-Modi bei SO2R durch 
• Ctrl+Bild hoch/runter: Schaltet am inaktiven Transceiver die Bänder hoch 

oder runter 
• Ctrl+Shift+I : Schaltet den 'Advanced SO2R'.  
• Ctrl+Shift+N : Schaltet die 'Advanced SO2R'-Verzögerungszeit
• Ctrl+Shift+K : Fokus auf den anderen Transceiver setzen 
• Ctrl+Shift+L : Vertauscht die CTRLFx Macros. Erlaubt dem OP auf dem 

anderen Transceiver zu senden (nur in CW).

14. RTTY-Tasten (RTTY Key Assignments)

RTTY-Funktionstasten
Taste Tastennamen Aktion
F1 &CQ CQ TEST DE *
F2 &Nummer 5NN #
F3 &Call der Gegenstation !
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F4 &eigenes Call *
F5 &TU TU DE *
F6 Call/Exch ! 5NN #
F7 - -

• Alt+T : Umschalten  TX<> RX. 
• Alt+G : Rufzeichen greifen 
• Ctrl+K : schaltet auf Senden und öffnet ein Fenster zur manuellen 

Texteingabe über die Tastatur 
• Ctrl+Pfeil rechts/links:  schaltet zwischen D1 (Bandskala A) und D2 

(Bandskala B) hin und her 

15. Lokatorenabfrage auf UKW (Gridsquare Key Assignments (VHF and 
up))

• Alt+= : Sucht nach Eingabe eines Lokators in das Rufzeichenfeld nach einem 
Lokator in der Rufzeichengeschichte. Das Ergebnis erscheint im Prüffenster 
(Check window) 

• Alt+minus (-) : Schaltet die Lokatoren (max. 3) in der Rufzeichengeschichte 
durch  

16. Tasten für den Rotor (Rotator Key Assignments)

• Alt+J : Dreht Rotor auf den kurzen Weg zum Rufzeichen im Rufzeichenfeld 
oder darüber 

• Alt+L Dreht Rotor auf den langen Weg zum Rufzeichen im Rufzeichenfeld 
oder darüber 

• Ctrl+Alt+J : Hält den Rotor an 

17. Fenstertasten (Window Key Assignments)

• Ctrl+Tab : Wechselt zwischen Logeingabefenster und Packet/Telnet-Fenster 
• Ctrl+K :Öffnet  ein Fenster zur manuellen Tastatureingabe für CW und RTTY. 
• Ctrl+L : Logfenster groß oder minimiert 
• Ctrl+J : Öffnet Multifenster und schaltet Länder/Zonen(Sektionen und anderes 

durch 

18. Rufzeichenvorschau editieren (Lookup Table Edit)

• Ctrl+D : löscht eine Zeile der Tabelle  

Last Modification: 04 October 2009 21:01:36 EDT by K8UT. 

Zubehör anschließen (Interfacing)

1. Überblick (General)

Das Programm ist für zahlreiche externe Geräte an diesen Schnittstellen bereit: 
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• Serielle Schnittstellen: Sie können mit diesen Schnittstellen CW geben, die 
PTT schalten und mit Ihrem Transceiver kommunizieren. Hat Ihr PC keine 
seriellen Schnittstellen benötigen Sie USB-Seriell-Konverter. 

• Parallele Schnittstelle(n): In der Regel verwenden Sie die parallele 
Schnittstelle(n), um den Antennenauswahlschalter zu steuern. Weitere 
Signale können für CW, PTT und SO2R-Umschaltung sowie zur 
Aktivitätsanzeige verwendet werden. 

• USB-Schnittstellen: USB-Schnittstellen mit einem Seriell-USB-Konverter 
erzeugen eine virtuelle COM-Schnittstelle. Mitunter gibt es Probleme, wenn so 
ein Konverter z.B. für die CW-Tastung verwendet werden soll. Zu empfehlen 
sind komplexe USB-Geräte wie der microHAM – microKEYER. Informieren 
Sie sich im Kapitel zu der unterstützten Hardware (Supported Hardware). 

• Soundkarte: Sie benötigen die Soundkarte(n) für die Ausgabe von WAV-
Dateien in SSB und für die digitalen Sendearten. Sie können auch das NF-
Signals Ihres Transceivers über den Contest mitschneiden. 

Die Hardware-Schnittstellen haben in der Regel diese voreingestellten Adressen:  

 

Sie können die Adressen, die Ihr Rechner vergeben hat,  über Systemsteuerung > 
System > Gerätemanager > Anschlüsse COM&LPT > Schnittstelle > 
Ressourcen > E/A-Bereich auslesen. 

Portadressen außerhalb des Standards funktionieren nicht für die CW-Tastung.

 Tipp 
Weisen Sie die Nicht-Standard-Schnittstellenadresse der CAT-Steuerung die 
Standard-Schnittstellenadresse der CW-Tastung zu, wenn Sie über die Schnittstelle 
CW tasten wollen.  

2. Transceiverschnittstellen (Radio interfacing)
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3. Interface für CW-Tastung und PTT (Interfacing for CW Keying and PTT)

3.1. Parallel (LPT) Port

Löten Sie dieses einfache Schaltung direkt an den DB-25-Stecker:

 

Parallel (LPT)-Port -Belegung 

• Pin 1 - Strobe 
• Pin 16 - PTT output 
• Pin 17 - CW output 
• Pin 18 - Ground 

3.2. Serieller (COM)-Port

 
 Hinweis:
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Die CW- UND PTT-Tastung für einen Transceiver muss über die gleiche Schnittstelle 
laufen. USB-zu-Seriell-Adapter werden unterstützt. Nicht unterstützt werden USB-zu-
Parallel-Adapter.  

3.3. Schaltransistor verwenden (Using a transistor)

 

• Die Schaltung setzt den RS-232-Pegel von +3-12V im aktiven Zustand in 
einen Schalter nach Masse um.

• Verwenden Sie einen einfachen npn-Schalttransistor wie 2N2222, 2N3904, 
BC547 oder BC548. 

• Ergänzung: Schalten Sie zusätzlich einen 1 kOhm-Widerstand von der Basis 
nach Masse und überbrücken Sie ihn mit einem 10nF-C, um HF-Störungen zu 
vermeiden.  

3.4. Optokoppler verwenden (Using an OPTO-Isolator (optocoupler))

By Brian Kassel, K7RE 

Um die -12V und + 12V auf der Leitung DTR in einen Schalter nach Masse 
umzusetzen, schalten Sie eine 470 Ohm-Widerstand und eine Diode vor den 
Eingang der LED des Optokopplers, um den Optokoppler vor der negativen 
Spannung im inaktiven Zustand zu schützen. An einer LPT-Schnittstelle ist dieser 
Schutz nicht nötig, sie schaltet von 0V nach +5V.

4. Über eine USB-Schnittstelle (Via USB port)

Bei älteren Seriell-USB-Adaptern kann es Schwierigkeiten geben. Testen Sie den 
Adapter Ihrer Wahl. Sie sollten CW und PTT problemlos übertragen. 

Für eine USB-Schnittstelle ist der externe CW-Geber Winkey von K1EL zu 
empfehlen. Er bekommt seine Daten über die USB-Schnittstelle im ASCII-Kode und 
macht dadurch die CW unabhängig von der bei älteren PCs merkbaren Windows-
Zeitscheibenverarbeitung, die zu Fehlern bei der CW-Tastung führt.

Wenn Sie einen Seriell-USB-Adapter verwenden, überprüfen Sie diese 
Windowseinstellungen:  

• Systemsteuerung > System > Gerätemanager > USB-Controllers
• Öffnen Sie jeden USB Root Hub 
• Klicken Sie doppelt auf Eigenschaften > Energieverwaltung 
• Entfernen Sie den Haken vor der Option Computer kann das Gerät 

ausschalten, um Energie zu sparen. 
o In der Regel ist dieser Haken gesetzt 

• Starten Sie den PC neu, um die Einstellung wirksam werden zu lassen
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AA5AU gibt in seiner Hilfe zum Fernschreiben unter http://www.rttycontesting.com 
eine ausführliche Hilfe. Sie finden die deutsche Übersetzung unter 
http://dl0tud.tu-dresden.de/Translate/AA5AU_RTTY_PDF.zip

5. Zusätzliche Anschlüsse am Parallel-Port (Additional Parallel Port 
Interfacing)

Falls Sie eine oder mehrere parallele LPT-Schnittstelle als Hardware an Ihrem PC 
haben, können Sie eine Reihe von Funktionen über eine oder mehrere LPT-
Schnittstellen steuern. Ein USB<>LPT-Adapter wird nicht unterstützt. Die BCD-Daten 
an LPT1 gelten für Transceiver 1, die BCD-Daten an LPT2 gelten für Transceiver 2. 
Haben Sie die digitale Sprachausgabe (DVK) aktiviert, ist eine Antennenauswahl 
über die LPT-Schnittstelle nicht möglich.

An der LPT-Schnittstelle sind diese Signale interessant: 

LPT 
pin Beschreibung

1 Geschaltete Masse für PTT und CW. Stromaufnahmefähigkeit begrenzt, u.U. 
Puffer verwenden 

2 1.Bit (LSB)für den Antennenschalter. Funktioniert nur, wenn keine DVK aktiv 
ist. Stoppt beim DVK die Ausgabe.

3 Anzeige des TX-Fokus: Low wenn Fokus bei Tcvr1, High wenn Fokus bei 
Tcvr2. Komplement zu Pin14. Funktioniert nur, wenn keine DVK aktiv ist. 

4 Anzeige des RX-Fokus: Low wenn Fokus bei Tcvr1, High wenn Fokus bei 
Tcvr2. Funktioniert nur, wenn keine DVK aktiv ist.

5 Schaltet zwischen Stereo und Mono um. LOW = Mono, High = Stereo. 
Funktioniert nur, wenn keine DVK aktiv ist.

6 Funktioniert nur, wenn keine DVK aktiv ist.
7 2. Bit für Antennenschalter
8 3.Bit für den Antennenschalter
9 4.Bit (MSB) für den Antennenschalter 

14 Anzeige des TX-Fokus: High wenn Fokus bei Tcvr1, Low wenn Fokus bei 
Tcvr2. Komplement zu Pin 3. Funktioniert nur, wenn keine DVK aktiv ist

15 Eingang für Fußschalter
16 PTT-Output, High = TX ein
17 CW output, High = Taste gedrückt 
18-25 Masse für Bandschalter

6. Banddekoderausgang (Band decoder output)

Die Pins 9, 8, 7 und 2 geben die Bandinformation einen Antennenauswahlschalter 
aus. Sie werden im Configurer > Karteikarte Antennas den einzelnen Bändern 
zugewiesen. Folgender Kode entspricht dieser Tabelle: 
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6.1. Beispielkonfigurationen (Sample configs)

 

Die Einstellungen beziehen sich auf ein kommerzielles Gerät von Top Ten Devices. 
Sie können unter N1MMLogger mehrere Antenne für ein Band konfigurieren und mit 
Alt+F9 diese Einstellungen durchschalten. Vergessen Sie das Leerzeichen nach 
einer Bandangabe nicht, also 7, 3.8 und nicht 7,3.8.  

6.2. Beispielkonfiguration für zwei gestockte Antennen (Sample 
Config > Antenna for two stacked antennas)
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Die Signalverarbeitung der BCD-Ausgabe in einer Schaltung zur Auswahl der 
Antennen ist Ihr Problem. 

7. Antennenrichtungsdaten (Bearing data)

Für die Rotorsteuerung ist im Moment keine Ausgabe der Daten über den LPT-Port 
vorgesehen. 

8. Anschluss der Soundkarte (Sound card interfacing)

8.1. Bevorzugte Methode (Preferred method)

Sie sollten in jedem Fall das Mikrofon an der Soundkarte anschließen. Sie können 
dann die Funktionen “Abspielen von WAV-Dateien” und “Aufzeichnen der QSOs” auf 
einen Ritt abwickeln und haben keine Probleme mit unterschiedlichen 
Ausgangspegeln. Wählen Sie zum Anfang die Einstellung #1: „Zero or Single Card, 
One radio, No Sound Card SO2R ". 
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8.2. Eine weitere Möglichkeit (Another possible soundcard 
interface)

Diese Methode sollte NICHT verwendet werden! 

 

• Ein 8:1000 Ohm-Trafo sollte am Ausgang der Soundkarte (rechts) verwendet 
werden. Anmerkung DM3ML: …und ein Spannungsteiler 1:100 am Mic-
Eingang des Transceivers. 

9. Schnittstellen unter Windows NT/2000/XP (Serial and Parallel port 
interfacing under Windows NT/2000/XP)

Windows NT, Windows 2000, XP und ihre Varianten benötigen zur 
Schnittstellensteuerung eine spezielle DLL-Datei. Verwenden Sie PORT95NT.EXE , 
um die DLL für die parallele, die seriellen und die USB-Schnittstellen zu installieren. 
Unter Windows 95, 98 (SE) und ME wird diese DLL nicht benötigt. N1MMLogger 
benötigt hier keinen speziellen Treiber. 
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Gehen Sie bei NT/2000/XP so vor:  

• Holen Sie sich PORT95NT.EXE. Einen Link finden Sie im Installationskapitel 
• Die Datei ist etwa 1,6 MB groß 
• Starten Sie port95nt.exe. Sie müssen zum Start von port95nt.exe 

Adminstratorenrechte besitzen 
o Wählen Sie Next > Yes usw.
o Starten Sie Ihren PC neu
o Erledigt!

9.1. Alles an einer COM-Schnittstelle (Everything on one COM port)

von Uffe PA5DD. 

Sie können über die eine COM-Schnittstelle Ihres Laptops die CAT-Steuerung, die 
CW-Tastung und die PTT-Steuerung laufen lassen.  

• Verwenden Sie eine CAT-Steuerung ohne Handshake-Protokoll, das geht 
mindestens für ICOM- und YAESU-Transceiver.

• Manche Transceiver verwenden die Leitungen RTS/CTS für das Protokoll. 
Diese Leitungen würden fehlen, wenn die PTT gesteuert werden soll. Mitunter 
hilft es, diese Leitungen auf der Transceiverseite zu brücken (z.B. bei 
Kenwood). DTR und RTS bleiben dann auf der PC-Seite frei.  

• Stecker-Interfaces verwenden meist die Leitungen RTS und DTR zur 
Spannungsversorgung des Interfaces. RTS und DTR werden auf Dauer-H 
gesetzt und sind für CW und PTT nicht verwendbar. Solche Interfaces sind 
nicht verwendbar. Versuchen Sie, die Spannungsversorgung aus einer 
anderen Quelle (Steckernetzteil oder Gameport) zu speisen.

• Sind diese Bedingungen erfüllt, können Sie über die RTS-Leitung die PTT 
schalten und über DTR die CW tasten. 

9.2. Ich benötige mehr serielle Schnittstellen (I need more serial 
ports)

von Didier KO4BB 

In der Regel begrenzen die zur Verfügung stehenden Interruptsignale IRQ die 
Verwendung weiterer COM-Schnittstellen. Es gibt zwei Möglichkeiten, diese 
Begrenzung zu umgehen:  

1) Wenn Sie eine Standardhardware verwenden, können Sie die IRQ für parallele 
Schnittstellen, das Floppylaufwerk und die Videokarte umlenken, wenn diese dort 
nicht benötigt werden. Der (alte) Standard-PC kann 4 COM-Schnittstellen mit 2 IRQ 
verwenden. Wenn zwei Interfaces wie COM1 und COM3 den gleichen Interrupt 
verwenden, gibt es Probleme, wenn beide COM-Schnittstellen mit einer hohen 
Datenrate betrieben werden sollen. 
Hinweis DM3ML: Die IRQs sind in der Regel auf den (alten) Schnittstellenkarten fest 
verdrahtet. Mit einigem Geschick kann man die IRQ-Leitungen auf einer Leiterkarte 
z.B. von IRQ3 auf IRQ5 umlenken und 3 COM-Schnittstellen parallel betreiben.
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2a) Setzen Sie in Ihrem Rechner eine zusätzliche Schnittstellenkarte ein. Es gibt 
Karten mit 4, 8 und 16 Ports. Sie benötigen nur einen IRQ, den die Ports sich teilen. 
Die Schnittstellen verfügen über ausreichende Puffer, reagieren aber mitunter etwa 
langsam, so dass sie für CW nicht sonderlich geeignet sind. Auf einem schnellen 
Rechner sind sie aber gut einsetzbar. Die Karten werden mit einem zusätzlichen 
Treiber geliefert.  

2b) USB-Adapter fallen in die Kategorie der nicht standardisierten Hardware, USB ist 
auf dem Motherboard installiert,  die USB-Kommunikation läuft direkt über das BIOS 
und die USB-Treiber. Die USB-Adapter sind aber nicht unbedingt auf eine schnelle 
Reaktionszeit ausgerichtet, so dass es auch hier Probleme bei der CW-Tastung 
geben kann. Versuchen Sie, nach Möglichkeit eine richtige COM-Schnittstelle für die 
CW-Tastung zu verwenden.

Inzwischen gibt es perfekte CW-Interfaces wie Winkey von K1EL, die ihre Daten über 
eine USB-Schnittstelle erhalten und eine gute CW-Tastung realisieren. Ähnliches gilt 
für externe über USB angeschlossene Soundkarten-Adapter.  

10. Fußschalter anschließen (Hooking up a Footswitch)

Sie können einen Fußschalter an eine serielle oder die parallele Schnittstelle 
anschließen.  

10.1. Fußschalter an der Parallel-Schnittstelle (Parallel port)

Schalten Sie einen 10 kOhm-Widerstand zwischen Pin14 (+5V) und Pin15 der 
parallelen Schnittstelle. Schließen Sie den Fußschalter zwischen Pin15 und Pin18 
(Masse) an. Pin14 wird gleichzeitig für die Aktivitätsanzeige von Transceiver A und B 
verwendet, ist also nur High, wenn Transceiver A aktiv ist. Soll der Fußschalter 
immer arbeiten, müssen Sie den 10 kOhm-Widerstand an eine externen +5V-Quelle 
anschließen.  

10.2. Fußschalter an der seriellen DB9-Schnittstelle (Serial port 
footswitch information (using the 9 pin connector numbers))

Schalten Sie einen 10 kOhm-Widerstand von Pin6 zu Pin7. Setzen Sie DTR (Pin4) 
auf "Always On" und RTS (Pin7) auf "Always Off". Schließen Sie den Fußschalter 
zwischen Pin4 und Pin6 an. Die Leitungen des Fußschalters sind nicht geerdet.  

Last Modification: 01 January 2010 14:36:34 EST by n4zr. 

Macros

Macros sind Schlüsselworte, die eine Platz für einen dafür einzusetzenden Text 
oder Begriff freihalten. Das Macro ‚!’ steht z.B. für das Rufzeichen der aktuellen 
Gegenstation aus dem Rufzeichenfeld des Logeinagbefensters, das anstelle des ‘!’ in 
einen Text eingesetzt wird. Sie können die Macros an vielen Stellen, vor allem aber 
bei den programmierbaren Tasten verwenden: 

11.04.2010



N1MM-Contest Logging Software Seite 264 von 470 Übersetzung der Hilfe von Eike, DM3ML

• Funktionstasten im Logeingabefeld
• Tasten im Packet/Telnet-Fenster 
• Tasten in den Fernschreibprogrammen MMVARI und MMTTY

 Verwendung der Macros 
Nicht jedes Macro kann an jeder Stelle verwendet werden. Macros werden entweder 
durch eine Zeichenkette ersetzt oder sie lösen eine gewünschte Funktion wie das 
Macro {log}, das ein QSO abspeichert. Ein ‚*’ wird durch Ihre eigenes Rufzeichen 
ersetzt. Die Länge der Macro-Texte ist auf 1024 Zeichen begrenzt, das sind 
immerhin 12 Zeilen mit 80 Teichen.   

 Macro-Schreibweise und Länge 
Ein Macro kann in Großbuchstaben, Kleinbuchstaben oder gemischt geschrieben 
werden. Die maximale Länge ist 255 Zeichen. Beim Import und Export eines Macros 
darf es nicht länger als 70 Zeichen lang sein und die Tastenüberschrift darf 9 
Zeichen nicht überschreiten. 

1. Allgemeine Macros (General Macros)

Allgemeine Macros können überall verwendet werden. 

Allgemeine Macros
Macro Wird ersetzt durch

* Eigenes Rufzeichen, identisch mit {MYCALL}

! Rufzeichen der Gegenstation aus dem Rufzeichenfeld. Wird 
bevorzugt berücksichtigt, liegt auch auf der Taste F5

@

Erzeugt eine Sprachausgabe der aktuellen 
Empfangsfrequenz auf 100 Hz genau. Wird im Splitbetrieb 
z.B. beim CQ-Rufen auf 40m benötigt. Beispiel siehe 
C:\Program Files\N1MM logger\wav\{operator}\CQ 
Listening.wav@C:\Program Files\N1MM logger\wav\
{operator}\AndThisFreq.wav

{BEEP} Erzeugt einen Klick aus dem PC-Lautsprecher

{CALL}
Rufzeichen der Gegenstation, wie es im Rufzeichenfeld steht 
oder vom QSO zuvor. Wollen Sie ein geändertes Rufzeichen 
senden, verwenden Sie das Macro ‘!’.

{CLUSTER} Rufzeichen des DXClusters aus dem Stationsdialog

{Comment} Macro zum Anhängen eines Kommentars an das aktuelle 
oder letzte QSO

{END}

Dieses Macro in einem Text bewirkt, dass der Text erst fertig 
gestellt und dann auf einmal gesendet wird. Text nach dem 
{END} wird erst nach Umschalten auf RX berücksichtigt. 
Zweckmäßig bei Kommandos an den Transceiver über die 
CAT-Steuerung verwenden. 

# Sende die aktuelle oder die letzte Seriennummer

{EXCH}
Sende die Kontrollnummer für das letzte QSO (wenn noch 
kein neues Rufzeichen im Rufzeichenfeld steht) oder das 
aktuelle QSO (wenn ein Rufzeichen im Rufzeichenfeld steht) 

{FREQ} Frequenz im Logeingabefenster
{GRID} Eigener Lokator aus dem Stationsdialog

11.04.2010



N1MM-Contest Logging Software Seite 265 von 470 Übersetzung der Hilfe von Eike, DM3ML

{GRIDSQUARE} Lokator der Gegenstation aus dem Logeingabefenster

{GRIDBEARING} Antennenrichtung : eigener Lokator <> Lokator der 
Gegenstation

{REVGRIDBEARING} Antennenrichtung reverse

{KMGRIGDISTANCE} Entfernung in Kilometer aus : eigener Lokator <> Lokator der 
Gegenstation 

{LOG}
CW: Speichere aktuelles QSO, entspricht einem ENTER. 
Digital: Setzen Sie das Macro {LOG} nach die Umschaltung 
auf RX mit {RX}. RX-Frequenz wird auf TX-Frequenz gesetzt. 
Funktioniert nicht in SSB.

{LASTCALL} Rufzeichen der zuletzt geloggten Station

{LASTEXCH} Kontrollnummer für die zuletzt geloggte Station. Funktioniert 
nur für ROPOCO und LZOPEN, nicht für andere Conteste

{MYCALL} Eigenes Rufzeichen, identisch mit *

{NAME} Sendet den Namen der Gegenstation aus dem 
Logeingabefeld (TARA) oder aus der Rufzeichengeschichte

{NAMEANDSPACE} Wie {NAME} nur zusätzlich ein Leerzeichen

{OTHERFREQ}
Frequenz des inaktiven Transceivers. Verwendet für die 
Meldung einer Passfrequenz. Ein Komma wird in CW durch 
ein R ersetzt.

{PGDN}
Entspricht der Taste “Bild nach unten”. Frequenzwechsel um 
einen programmierten Festbetrag nach unten. Nützlich bei 
Sprint-Contesten. 

{PGUP}
Entspricht der Taste “Bild nach oben”. Frequenzwechsel um 
einen programmierten Festbetrag nach oben. Nützlich bei 
Sprint-Contesten.

{PREVNR} Sendet die Kontrollnummer des zuletzt geloggten QSOs

{LRMHZ} Frequenz des linken Transceivers/VFOs in MHz, z.B. 28 
wenn auf 28.1234 MHz

{RRMHZ} Frequenz des rechten Transceivers/VFOs in MHz, z.B. 14 
wenn auf 14.1235 MHz

{RUN} Sendet das letzte geloggte Rufzeichen und schaltet in den 
RUN-Modus

{S&P} Sendet das letzte geloggte Rufzeichen und schaltet in den 
S&P-Modus

{STEREOOFF} Das Stereobit an der LPT-Schnittstelle wird auf AUS gesetzt
{STEREOON} Das Stereobit an der LPT-Schnittstelle wird auf EIN gesetzt
{TIMESTAMP} Datum und Zeit eines QSOs im Logeingabefenster

{TX} CW/SSB: schaltet auf TX. RTTY: siehe Digimodes

{CLEARRIT}
Schaltet die RIT auf Null. Nützlich in der Taste F3 nach dem 
Ende eines QSOs. Funktioniert nicht mit allen Transceivern 
wie ICOM. 

{CTRL-A}...{CTRL-Z}
Sendet Ctrl-Zeichen an einen TNC. Erlaubt sind alle Zeichen 
zwischen A und Z. Funktioniert nicht unter MMTTY und 
MMVARI. Siehe Beispiele..

{ENTER} Sendet ein ENTER an einen TNC

{ENTERLF} Sendet ein WR+ZL an einen TNC. Verwenden, wenn ENTER 
nicht funktioniert.
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{ESC} Sendet ein ESC an einen TNC. Funktioniert nicht unter 
MMTTY und MMVARI.

{DATE} Sendet Kurzdatum im Regional-Windowsformat

{DATE1} Sendet Datum im Nordlink-TF/WA8DED-Format (dd.mm.yy)- 
z.B.  26.02.99

{SENTRST} Sendet the RST wie im Logeingabefenster eingegeben
{SENTRSTCUT} Sendet RST mit einer 9 als N, also 57N oder 5NN 

{TIME} Zeit im regionalen Windowsformat

{TIME1} Zeit im Nordlink-TF/WA8DED-Format (hh:mm:ss), z.B. 
20:36:55

{TIME2} Sendet GMT-Zeit im Format (hhmm), z.B. 2036 
{DAYTIME} Datum/Zeit im TAPR-Format z.B. 0107162036
{DATEGMT} Datum und GMT-Zeit im Format: 16-jul-01 18:36:55
{TIMEGMT} GMT-Zeit im Format: 18:36:55
{F1} - {F12} Sendet den in den Tasten F1 bis F12 programmierten Text

{SOCALLSTACK}
Mit diesem Macros können Sie bei gleichzeitig anrufenden 
Stationen ganze Rufzeichen oder Teile davon in einen 
Stapelspeicher schicken und anschließend wieder abrufen.
Siehe Erweiterte Funktionen.

{STACKANOTHER} Weitere Rufzeichen in den Stapelspeicher schicken. Geht 
auch mit CTRL+ALT+G . Siehe Erweiterte Funktionen

{LOGTHENPOP}
Nur im RUN-Modus. Beendet ein QSO, loggt die Station und 
holt das nächste Rufzeichen aus dem Stapelspeicher. Das 
empfohlene Macro lautet: {LOGTHENPOP} TU NW {F5}{F2}. 
In CW, if {LOGTHENPOP}. Erweiterte Funktionen 

{ROVERQTH} Sendet den Rover-Standort. Siehe Erweiterte Funktionen

Ein TNC-Interface akzeptiert NICHT alle Macros.  

1.1. Beispiele für das {END}-Macro ({END} Macro Examples)

Das {END}-Macro signalisiert dem Programm, dass sie auf das Macro folgenden 
Kommandos erst dann auszuführen sind, wenn das Programm von der Sendung in 
CW, SSB oder DIGI auf Empfang geschaltet hat.

Beispiel: F1 {STEREOOFF}CQ TEST *{END}{STEREOON} 

Immer wenn die Taste F1 gedrückt wird, wird das Stereo-Bit an der LPT-Schnittstelle 
auf AUS gestellt, der CQ-Ruf wird gesendet, dann wird das Stereo-Bit wieder auf EIN 
gesetzt. Der Operator kann während des CQ-Rufs voll auf dem zweiten Transceiver 
hören, danach hört er wieder beide.  

 Nach {END} noch etwas senden? 
Nein, nach dem END-Macro können Sie nur technische Anweisungen setzen. Nach 
dem {END} wird auf Empfang geschaltet und nichts mehr gesendet. Wenn Sie an 
Ihren Transceiver über die CAT-Steuerung Kommandos senden wollen, kann das so 
aussehen:

• F1 {R1 *UM0}CQ TEST *{END}{R1 *UM85} 
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• Dieses Kommando setzt die Lautstärke von Transceiver 1 (ein ORION) mit 
Beginn des CQ-Rufs auf Null und nach dem Zurückschalten auf Empfang 
wieder auf 85.  Der Monitor wird damit stummgeschaltet für die Dauer des 
CQ-Rufs. Ähnliche Kommandos können Sie an den Transceiver 2 senden-

Sie können sich damit speziell für schnelle Conteste einen Befehlssatz für RX 
stumm/in Betrieb, Monitor stumm/in Betrieb, Frequenzwechsel, QSY usw. aufbauen. 

Hexa- und ASCII-Tcvr-Macros (CATHEX and CATASC Radio Hex Macro 
Commands)

CATHEX und CATASC - Macrokommandos
Macro Ersetzt durch

{CAT1HEX 
radio_hex_command(s)}

{CAT2HEX 
radio_hex_command(s)} 

Mit diesen Macros können Sie Kommandos an die 
Transceiver 1 und 2 senden, wenn diese Hex-Daten 
akzeptieren. Der Macroname wird gefolgt von den 
Hex-Daten und wird abgeschlossen mit einer }. 
Jeweils zwei Hex-Zahlen werden gesendet, eine Null 
wird als 00 gesendet. Leerzeichen sind erlaubt. In 
einem Macro dürfen höchstens ein CAT1HEX und ein 
CAT2HEX-Kommando enthalten sein. Eine Ausnahme 
ist das Macro {END}. Danach können mehrere 
Kommandos gesendet werden, sie müssen aber durch 
ein Zeichen wie / voneinander getrennt werden. 
Mehrfachkommandos werden voneinander getrennt 
und zeitlich gestaffelt gesendet. Abhängig von der 
Verarbeitungsgeschwindigkeit können dabei 
Verzögerungen auftreten. Es sind keine Vorkehrungen 
getroffen zu prüfen, ob der Transceiver gerade auf 
Senden steht, wenn das Kommandos gesendet wird. 
Wollen Sie Antenne sicher umschalten, verwenden Sie 
das Macro {ANTRX#TOGGLE}  das eine 
Sendersperre enthält.
Beispiel für ein ICOM-Kommando : 
{CAT1HEX FEFE66E01C0102FD / 
FEFE66E01C0102FD }

{CAT1ASC 
radio_ASCII_command(s)}

{CAT2ASC 
radio_ASCII_command(s)}

Mit diesen Kommandos werden ASCII-Zeichenfolgen 
an die Transceiver 1 und 2 gesendet. Es gelten die 
gleichen Grundsätze wie bei den HEX-Kommandos für 
mehrere Kommandos. Hex-Zahlen im Kommando sind 
in < > einzuschließen.
Beispiele: 
{CAT1ASC PB1;/PB2;} 
{CAT1ASC PB1;PB2;} 
{CAT1ASC P<42>1;PB2;} 
Leerzeichen innerhalb der Kommandos sind wegen 
besserer Lesbarkeit erlaubt. Enthalten die Macros 
ASCII-Zeichen, die als Macro gedeutet werden können 
wie (*, !, #) muss an ihrer Stelle der Hex-Wert 
eingeschlossen in <> verwendet werden, z.B. statt 
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{CAT1ASC *UM0} muss das Kommando als 
{CAT1ASC <2A>UM0} gesendet werden. 

CATAHEX CATIHEX CATAASC and CATIASC Macro-Kommandos
(gehen an den aktiven (A) und den inaktiven (I) Transceiver

Macro Substituted by
Aktiver Transceiver: 

{CATA1HEX 
radio_hex_command(s)}

{CATA2HEX 
radio_hex_command(s)}

{CATA1ASC 
radio_ASCII_command(s)}

{CATA2ASC 
radio_ASCII_command(s)}

Inaktiver Transceiver:

{CATI1HEX 
radio_hex_command(s)}

{CATI2HEX 
radio_hex_command(s)}

{CATI1ASC 
radio_ASCII_command(s)}

{CATI2ASC 
radio_ASCII_command(s)} 

Mit diesen acht  Kommandos ist die flexible 
Steuerung einer SO2R-Station mit ASCII- und HEX-
Kommandos, abhängig von ihrem Status als aktiv 
und inaktiv,  möglich.
Die Kommandos sind wichtig für Stationen, die nicht 
auf beiden Kanälen den gleichen Transceivertyp 
verwenden.
Die Kommandos haben die gleiche Syntax wie die im 
vorhergehenden Abschnitt beschriebenen 
Kommandos. 

Aus dem von einer F-Taste abgesendeten Text 
werden die CAT-Kommandos extrahiert und 
entsprechend ihrem Inhalt an den aktiven bzw. den 
inaktiven Transceiver gesendet. Eine F-Tasten-Text 
kann damit für mehrere Zwecke verwendet werden. 

Ein Beispiel für ein IC-756 Pro3-Macro mit dem der 
Zweitempfänger und die RX-Antenne in Abhängigkeit 
vom Status im Tcvr1 und Tcvr2 geschaltet wird, sieht 
so aus:
{catA1hex fefe6ee0 12 00 00fd}{catI1hex fefe6ee0 12 
00 01fd}{catA2hex fefe6ee0 07 c0 fd}{catI2hex 
fefe6ee0 07 c1 fd}

{CATDELAY}

Mit diesem Kommando kann dem Transceiver Zeit 
gegeben werden, einen Kommandosatz vor dem 
Umschalten auf Senden abzuarbeiten. Das 
Kommando lautet {CATDELAY N}, wobei N die Warte 
zeit in Vielfachen von 50ms ist. Der höchste Wert für 
N ist 20 (= 1s). 
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Macros zur Antennen- und Rotorsteuerung (Antenna and Rotor Control 
Macro Commands)

Macros zur Antennen- und Rotorsteuerung 
Macro Ersetzt durch

{ANTRX1TOGGLE}

{ANTRX2TOGGLE}

{ANTRX3TOGGLE}

{ANTRX4TOGGLE}

Anwendbar bei Yaesu FT950, FTDX9000, FT2000 Icom: IC746, 
IC746Pro, IC756, IC756Pro, IC756Pro2, IC756Pro3, IC775, 
IC7700, IC7800 und Elecraft K3, TenTec Orion, Kenwood 
TS2000
Schaltet die Empfangsantenne um. Mit {ANTRX#TOGGLE} wird 
der Antenneneingang # ausgewählt. Wird die gleiche Nummer 
wiederholt gesendet, wird die Empfangsantenne an oder 
ausgeschaltet. Die Verwendung hängt vom jeweiligen 
Transceiver und seinen Antenneneingängen ab. Hat er nur eine 
getrennte RX-Antenne, kann mit dem Macro dieser Eingang 
schnell zu- oder abgeschaltet werden.

{TURNROTOR} Dreht den Rotor in die berechnete Richtung
{STOPROTOR} Stoppt den Rotor. Beachten Sie das Handbuch zu Ihrem Rotor.

4. CW-Macros (CW Macros)

CW macros are only substituted when used in substitutions for CW buttons. 

Spezielle Zeichen im CW-Text
Macro Ersetzt durch

< Erhöhe Gebetempo um 2 WpM

> Erniedrige Gebetempo um 2 
WpM

~ Verkürzter Wortabstand 
[ SK  . . . _ . _ 
] AS  . _ . . . 
+ AR. _ . _ . 
= BT   _ . . . _ 

* the ! Macro: Wollen Sie ein 
Ausrufungszeichen senden, ersetzen Sie 
es durch das Zeichen ^ 

Sonderzeichen
Macro
 

Ersetzt 
durch 

Macro
 

Ersetzt 
durch 

! *^ . . _ _ . É . . _ . . 
" . _ . . _ . Ü . . _ _ 
' . _ _ _ _ . Ä . _ . _ 
? . . _ _ . . Á . _ _ . _ 
/ _ . . _ . Ñ _ _ . _ _ 
: _ _ _ . . . Ö _ _ _ . 
; _ . _ . _ . _ . _ _ . _ 
( _ . _ _ . $ . . . _ . . _
) _ . _ _ . _ @ . _ _ . _ . 
, _ _ . . _ _ !
- _ . . . _ !

  Lesbarkeit verbessern 
 

Haben Sie ein Rufzeichen, das zu Hör-Irrtümern herausfordert wie 6Y2A, der oft als 
BY2A ins Log eingetragen wird, gehen Sie zu Config >Change 
Packet/CW/SSB/Digital Message Buttons >Change CW Buttons und bauen Sie 
den Text für das eigene Rufzeichen, der dort als ‚*’ steht um und machen Sie aus 
6Y2A das Rufzeichen >6<~Y2A.
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Die 6 im Rufzeichen wird um 2 WPM langsamer als der Rest gesendet und ein 
zusätzlicher halber Punktabstand wird zwischen 6 und Y eingebaut. Versuchen Sie 
auch andere Kombinationen von <>~, damit sich das Rufzeichen besser hören lässt. 

4.1. Beispiele für CW-Macros (CW Macro Examples)

• Sende das Rufzeichen der Gegenstation :  ! 

• Sende CQ  mit einem Macro für das eigene Rufzeichen: cq~test~de~* 
 Die Tilde ~  verkürzt die Wortpause 
 Das * steht für das im Stationsdialog eingetragene eigene 

Rufzeichen {MYCALL} 

• Sende Teile des Textes, hier die 5NN, um 6 WpM schneller als die 
Kontrollnummer, dann wieder zurück: <<5nn>>>{EXCH} 

 

5. SSB-Macros (SSB Macros)

Die SSB-Macros werden nur aktiv, wenn Sie in einer F-Taste programmiert wurden. 
SSB-Macros können durch Kommas aneinander gehängt werden. 

SSB Macros
Macro Ersetzt durch

{OPERATOR} Wählt den WAV-Datensatz für einen bestimmten Operator: 
C:\Program Files\N1MM logger\wav\{OPERATOR}\cq.wav 

5.1. Beispiele für SSB-Macros (SSB Macro Examples)

• Sendet Rufzeichen der Gegenstation:  ! 
 Das Rufzeichen wird aus den im Verzeichnis Letters 

abgespeicherten Buchstabierworten zusammengebaut und über 
die Soundkarte wiedergegeben. Auf der N1MM-Webseite finden 
Sie unter Downloads > Other Files mehrere Beispielsätze in 
unterschiedlicher Geschwindigkeit (Speed 1 bis 3). 
Die Montage funktioniert nur, wenn das Verzeichnis Letters 
entsprechend geladen wurde.  

• Erzeugen Sie für jeden Operator eigene WAV- und Letters-Dateien. Sie 
werden so adressiert:  

o CQ-Macro: 
C:\Program Files\N1MMlogger\wav\{OPERATOR}\cq.wav 

o Kontrollnummern-Macro:
C:\Program Files\N1MM logger\wav\{OPERATOR}\5905.wav

 Mit einem Operatorwechsel wird auch der Satz der WAV-Dateien 
ausgewechselt. Bereiten Sie diese Dateien vor dem Contest vor. 
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6. Macros für SO2R/SO2V-Betrieb (SO2V/SO2R Macros)

Die SO2V/SO2R-Macros können nur verwendet werden, wenn SO2R als Modus 
gewählt wurde:  

Single Op 2 VFO und Single Op 2 Radio Macros
Macro Ersetzt durch

{OTHERBAND} Sendet das Band des inaktiven VFO/Tcvr, z.B. 80
{OTHERMHZ} Sendet die Frequenz des inaktiven VFO/Tcvr in MHz z.B. 3R5

{OTHERFREQCUT} Nur für CW. Sendet die abgeschnittenen kHz der Frequenz des 
inaktiven VFO/Tcvr

{JUMPRX} Schaltet den RX-Fokus in das andere Eingabefenster. Ist nur 
ein Fenster offen, wird ein zweites geöffnet.

{WIPE} Löscht das aktuelle Eingabefenster
{ADVSO2RON} Schaltet 'Advanced SO2R' ein. Siehe Kapitel SO2R
{ASVSO2ROFF} Schaltet 'Advanced SO2R' aus. Siehe Kapitel SO2R

{CTRLFX} 

Nur für CW. Startet das Senden auf dem anderen Transceiver. 
Eine Taste kann so programmiert sein: "tu EXCH{CTRLF9}". Ist 
die Taste F9 des anderen Tcvrs mit einem CQ-Ruf belegt, wird 
dort ein CQ-Ruf gestartet. Ein-oder ausgeschaltet wird dieser 
Modus mit der Kombination Ctrl+Shift+L. Ist der Modus 
ausgeschaltet hat ein CTRLFn-Macro keine Wirkung.

{COMPJUMP} 

Wenn der RX- und der TX-Fokus zwischen zwei Transceiver 
aufgeteilt ist und der Nutzer betätigt die ENTER-Taste, wird der 
TX-Fokus zuerst auf den Transceiver mit dem RX-Fokus 
gesetzt. Die CW-Nachricht dort wird gesendet. Danach werden 
RX- und TX-Fokus auf den anderen Transceiver gesetzt. Mit 
einer weiteren ENTER-Taste wird dort die CW-Nachricht 
gesendet.
Für den Sprint-Contest ist das ein typisches Macro:
Run F3: TU {END} {COMPJUMP}

7. Multi-Nutzer-Macros ( Multi-User Macros)

Die Multi-Nutzer-Macros sind nur im Multi-Nutzer-Modus wirksam. 

Macro Ersetzt durch

{MESSAGE} Sendet eine Nachricht über die Funktionstaste an die anderen 
Stationen im Netzwerk. Siehe Beispiele.

{PASS 0}
...

{PASS 15}
Schicke die Passfrequenz an die Stationen 0 bis 15. Die 
Passfrequenz wird auf volle kHz aufgerundet. 

{PASS 1800}
...

{PASS 28000}

Setze die bandbezogene Passfrequenz der ersten dort 
gefundenen Station ein. Möglich sind PASS 1800, 3500, 7000, 
14000, 21000 and 28000

{PASSMSG 1}
...

{PASSMSG 15}
Übermittle die letzte QSO-Info von Station 0 an Station 1..15
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7.1. Macrobeispiele {MESSAGE} (Macro Examples)

Mit  einem {MESSAGE}-Macro können Sie andere Stationen im Netz auf eine 
interessante Station aufmerksam machen. Die Message erscheint im Info-Fenster in 
dicken Typen. Sie können eine bestimmte Station adressieren oder die Nummer 
durch ‘-‘ für alle Stationen ersetzen.  

{MESSAGE} Macro-Beispiele
Tastentext Macro

F8 Pass 
station

{MESSAGE}2 {TIMEGMT} {PASS 1} {CALL} {GRIDSQUARE} 
{GRIDBEARING}deg. {KMGRIDDISTANCE} km.
Message an Station 2, dass auf Passfrequenz 1 eine interessante 
Station zu hören ist

F8 Pass 
station

{MESSAGE} {TIMEGMT} {PASS 1} {CALL} {GRIDSQUARE} 
{GRIDBEARING}deg. {KMGRIDDISTANCE} km.
Message an alle Stationen mit dem gleichen Inhalt

F8 OK {MESSAGE}2 OK: Antwort an Station2: OK

8. Macros für RTTY und PSK (Digital (RTTY and PSK) Macros)

Die Macros unten in der Liste können zusätzlich zu den allgemeinen Macros 
verwendet werden. 

Macro Ersetzt durch

{TX} Schaltet auf Senden. Unbedingt nötig am Anfang eines Digi-
Macros.

{RX} Schaltet auf Empfang. Unbedingt nötig am Ende jedes Digi-
Macros!

{CLRRX} Löscht das RX-Fenster. Kann allein oder nach einem {END} 
verwendet werden.

{SCQ} Startet einen neuen CQ-Ruf z.B. nach einem TU
{GRAB} Holt das erste Rufzeichen aus der Rufzeichenliste

{DELALL} Löscht die Rufzeichenliste
{DELTOP} Löscht das erste Rufzeichen in der Rufzeichenliste
{DELSEL} Löscht das markierte Rufzeichen in der Rufzeichenliste

_ Nur in MMTTY: Unterstrich sendet Leertone
{FILE:xxxx} Sendet die Text-Datei xxxx aus dem N1MMLogger-Verzeichnis. 
{LDIGFQ} Frequenz des linken digitalen Interfaces
{RDIGFQ} Frequenz des rechten digitalen Interfaces

{PREVTIME} Sendet die im vorherigen QSO gesendete Zeit (bei ANARTS und 
BARTG-Contesten)

{ALIGN} Holt das aktuelle Signal auf die eingestellte Vorzugsfrequenz
{PROFILE0} Nur bei MMTTY. Lädt das HAM-Profil
{PROFILE1}

...
{PROFILE8}

Nur bei MMTTY . Lädt die unter MMTTY angelegten 
{PROFILE1} bis {PROFILE8}, z.B. beim Start von RUN oder 
S&P, wenn mit unterschiedlichen Profilen gearbeitet werden soll.

{HXXXX} Nur für HAL DXP38. Kommando für den HAL-TNC bestehend 
aus zwei Hex-Zahlen z.B. $80 $EA in der Form {H80EA}. Siehe 
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HAL DXP38 Info
{DI1}...{DI24} Sendet den in den Tasten D1-D24 des DI programmierten Text

{LOGTHENGRAB} Nur im RUN-Modus. Loggt das aktuelle QSO und holt das 
nächste Rufzeichen aus der Rufzeichenliste

{DIGQTCR} Für den WAE-Contest. Öffnet QTC-Empfangsfenster
{DIGQTCS} Für den WAE-Contest. Öffnet QTC-Sendefenster

 
Verwenden Sie immer {TX} und {RX} zusammen. Sonst bleibt der TX auf Senden 
stehen, bis Sie die ESC-Taste drücken.  

 TNC –Puffer nach Abbruch leeren 
Fügen Sie dem Abbruch das Macro zum Leeren des TX-Puffers hinzu. Sonst fängt 
eine neue Sendung dort an, wo sie vor dem Abbruch geendet hat und der Rest des 
Puffers wird noch gesendet.  

8.1. Macro-Beispiele für RTTY und PSK (RTTY and PSK Macro 
Examples)

Beispiel für Funktionstasten
Funktion Macro

Hole das Rufzeichen aus der Rufzeichenliste und 
sende die Kontrollnummer 

{TX}{ENTER} ! 
{LOGTHENGRAB} TU NW {F5}
{F2}{RX}

Erster Station antworten und Rufzeichen der 
nächsten Station von Rufzeichenliste holen und ihr 
die Kontrollnummer senden 

{TX}{ENTER} ! 
{LOGTHENPOP} TU NW {F5}
{F2}{RX}

Macros für den PK-232 im DI-Fenster 
Tastentext Macro

Abort {CTRL-C}R{ENTER}TC{ENTER}
TX X{ENTER}
RX {CTRL-D}

Band Up RB U{ENTER}
RxReverse RXREV T{ENTER}
Beispiele für Funktionstasten für den PK-232 im Logeingabefenster
Mode Button text Macro

Running F1 CQ X{ENTER}CQ CQ CQ TEST DE {MYCALL} {MYCALL} K 
CQ{CTRL-D}

Running F2 Exch X{ENTER} ! UR 599 {EXCH} 599 {EXCH} BK{CTRL-D}
Running F3 Tnx/Qrz X{ENTER} ! TU GL DE {MYCALL} QRZ{CTRL-D}

S&P F1 
{MYCALL} X{ENTER}! DE {MYCALL} {MYCALL}{CTRL-D}

S&P F2 Exch X{ENTER}! UR 599 {EXCH} 599 {EXCH} GL DE {MYCALL}
{CTRL-D}

Macros für den KAM 
Tastentext Macro

Abort {CTRL-C}R RTTY {ENTER}
TX {CTRL-C}T
RX {CTRL-C}E

Macros für den SCS PTC im DI-Fenster
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Tastentext Macro
Abort {ESC}CLR{ENTER}{CTRL-D}{ENTER}
TX/RX {CTRL-Y}

RX-Reverse {ESC}TR 1{ENTER}
RX-Norm {ESC}TR 0{ENTER}
45 Baud {ESC}BAU 45{ENTER}
75 Baud {ESC}BAU 75{ENTER}

Kommandos {ESC}Q{ENTER}
RTTY {ESC}Q{ENTER}BAU{ENTER}
PSK31 {ESC}Q{ENTER}PSKT{ENTER}

CW {ESC}Q{ENTER}CWT{ENTER}
AMTOR {ESC}Q{ENTER}AMTOR{ENTER}
PACTOR {ESC}Q{ENTER}PT{ENTER}
PACKET {ESC}Q{ENTER}PACKET{ENTER}

Beispiele für Funktionstasten für den SCS PTC im Logeingabefenster 
Mode Tastentext Macro
Running F1 CQ {CTRL+Y}CQ TEST DE * * * k{ENTER}{CTRL+Y}
Running F2 Exch {CTRL+Y}! HI 599 {EXCH} {EXCH} K{CTRL+Y}
Running F3 CFM {CTRL+Y}! QSL TU DE * QRZ? K{CTRL+Y}
S&P F1 {MYCALL} {CTRL+Y}! DE * * K{CTRL+Y}
S&P F2 Exch {CTRL+Y}DE * TU 599 {EXCH} {EXCH} GL DE *{CTRL+Y}
Beispiele für Funktionstasten für MMTTY im Logeingabefenster
Mode Tastentext Macro
Running F1 CQ {TX} CQ CQ CQ TEST DE {MYCALL} {MYCALL} K CQ {RX}
Running F2 Exch {TX} ! UR 599 {EXCH} 599 {EXCH} BK{RX}
Running F3 Tnx/Qrz {TX} ! TU GL DE {MYCALL} QRZ {RX}
S&P F1 {MYCALL} {TX} ! DE {MYCALL} {MYCALL}{RX}
S&P F2 Exch {TX} ! UR 599 {EXCH} 599 {EXCH} GL DE {MYCALL}{RX}

F1 CQ {TX}{ENTERLF} CQ DE {MYCALL}{RX} Send CQ
on new line 

9. Macros im Packet/Telnet-Fenster (Packet/Telnet Macros)

Die Packet/Telnet-Macros funktionieren nur in den Tasten im Packet/Telnet-Fenster. 

Macros für die Tasten im Packet/Telnetfenster
Macro Ersetzt durch
{WAIT} Warte 5 Sekunden (fester Wert)

Macros für einen Kommentar zu allen DXSpots 

Kommentar
Macro Ersetzt durch
{GRIDSQUARE} Lokator der gemeldeten Station

{MODE} Sendeart der gemeldeten Station
{QTH} QTH der gemeldeten Station (Zone/Sektion) aus Eingabefeld
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{ZONE} Zone/Sektion u.a. der gemeldeten Station aus Eingabefeld

9.1. Beispiele für Packet-Macros (Packet Macro Examples)

• DXCluster über programmierte Taste connecten (TAPR): 
o Macro: {CTRL-C}C {CLUSTER}{ENTER} 

 {CTRL-C} setzt den TNC in den Kommando-Status 
 {CLUSTER} enthält das Call des DX-Clusters 
 {ENTER} Kommandoabschluss 

• DXCluster über programmierte Taste connecten (TF/Nordlink):
o Macro: {ESC}C {CLUSTER}{ENTER} 

 {ESC} setzt den TNC in den Kommando-Status (=Shift+ESC per 
Tastatur)

 {CLUSTER} enthält das Call des DX-Clusters
 {ENTER} Kommandoabschluss

• Macro mit verketteten Kommandos (Initialisierung):  
o Macro: {ESC}I {MYCALL}{ENTER}{ESC}P 100{ENTER}

{ESC}S1{ENTER}{ESC}C {CLUSTER}{ENTER} 
 {ESC}I {MYCALL}{ENTER} Sendet eigenes Call an den 

TNC 
 {ESC}P 100{ENTER} Setzt Persistenz auf 100 
 {ESC}C {CLUSTER}{ENTER} Connect mit lokalem 

DXCluster 

• Beispiel für die Verwendung des {WAIT}-Macros: 
o Macro: {CTRL-M}{WAIT}C PE1M-7{WAIT}PA1M 

 Nach CTRL-M wird 5 sec gewartet

• Mit diesem Macro kann ein Ctrl+Z an den DXCluster als Ende einer 
eingegebenen Nachricht gesendet werden 

o F12: {CTRL-Z} 

Last Modification: 05 October 2009 16:29:13 EDT by K8UT. 

Multinutzer-Unterstützung (Multi-User Support)

N1MMLogger kann in einer vernetzten Umgebung mit mehreren Computern als 
Multi-Operator-Multi-Stationen in einem Contest verwendet werden. Maximal können 
16 Computer vernetzt werden. Die PC kommunizieren über das Netzprotokoll TCP/IP 
miteinander. Im Netzwerk muss es eine Meister-Station, den Master mit der 
Stationsnummer 0 geben 

1. Möglichkeiten (Features)

• Maximal 16 Stationen im Netzwerk, Nummer 0…15, Master ist Station 0 
• Verwendung handelsüblicher NIC-Karten und WLAN 
• Bei der Konfiguration werden IP-Adressen eingerichtet 
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• Die verbundenen Stationen können im gleichen Subnetz sein, aber auch über 
das Internet miteinander verbunden sein 

• Die Stationen können untereinander Talk-Nachrichten austauschen 
• Automatische Zeitsynchronisation 
• Austausch von Pass-Frequenzen
• DXSpots kommen über Telnet oder Packet und werden von der Master-

Station an alle angeschlossenen Station verteilt. Jede Station kann spotten. 
• Fehleranzeige, wenn eine Station Probleme hat 
• Das Info-Fenster meldet Status-Info und Optionen 
• Das Config-Menu stellt spezielle Werkzeuge zur Verfügung 
• Auto-Resynchronisation, wenn sich eine Station zuschaltet 

  Multi-Nutzer-Betrieb ausschalten 
Schalten Sie NIEMALS den Multi-Nutzer-Betrieb während eines Contests aus. 
Wollen Sie bei einem Test einen Netzwerkfehler simulieren, unterbrechen Sie die 
Ethernet-Verbindung.  

2. Konfiguration (Configuration)

Das Netzwerk sollte aufgebaut sein und funktionieren. Jeder PC sollte alle anderen 
mit Erfolg anpingen können. Es müssen nicht unbedingt alle PCs im 'Networking 
environment' (My Network Places usw.) zu sehen sein. Es hilft aber, wenn Dateien 
zwischen den PCs ausgetauscht und aktualisiert werden sollen. Die Verkabelung 
wird über CAT5-Leitungen oder drahtlose Zutrittspunkte realisiert. Ältere 
Netzwerkverbindungen über serielle Schnittstellen werden nicht unterstützt.

 Probleme mit der IP-Subnet-Adressenmaske 
Wenn Sie den Adressenbereich 10.x.x.x unter Windows XP/SP2 mit der Subnetz-
Maske 255.255.255.0 zusammen mit anderen Windowsversionen verwenden, kann 
es Probleme geben. Windows XP/SP2 hat Schwierigkeiten mit dieser 
Subnetznmaske. Verwenden Sie dann diese Subnetzmaske:  255.0.0.0. Wir 
empfehlen den Adressenbereich 192.168.x.x mit einer Subnetzmaske 255.255.255.0 

• Einstellungen auf allen PCs 
o Stellen Sie alle PCs mit ihren Transceivern so ein, als würden Sie allein 

arbeiten. Überprüfen Sie die PTT- und CW-Tastung, die WAV-Dateien 
und die Belegung der F-Tasten usw. 

o Auf allen PCs muss die gleiche Version von N1MMLogger installiert 
sein 

• Nur bei der Master-Station 
o Richten Sie hier den DXCluster-Zugriff über Packet/Telnet ein 
o Stellen Sie die Uhr des PC auf die genaue Zeit ein. Alle PCs im Netz 

synchronisieren ihre Zeit mit dem Master 
o Tragen Sie diesen PC als Station 0 in der Tabelle "Edit Station 

Computer Names" ein ! 
• Bei allen anderen Stationen 

o Wählen Sie das Telnet-Fenster für den DXCluster-Zugriff über die 
Master-Station unabhängig davon, ob die Master-Station über Telnet 
oder Packet mit einem DXCluster verbunden ist 
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• Tragen Sie mit Config >Edit Station Computer Names alle Station in der 
Tabelle "Edit Station Computer Names" ein, bevor Sie den Multinutzer-
Betrieb starten. Die Tabelle kann so aussehen: 

 

o Stn # (0-15): Stationsname. Nummer 0 bekommt die Master-Station. 
Der Stationsname nach der Nummer kann sinnvoll gewählt werden, 
z.B. ‚15m’. Dieser Eintrag hat nichts mit dem NetBIOS-PC-Namen zu 
tun. Die Einträge haben mit steigender Stationsnummer zu erfolgen. 

o Computer IP Address : Hier wird die festliegende IP-Adresse oder 
eine dynamische Adresse eingetragen. Als dynamische Adresse ist der 
Computername einzutragen. In einem N1MMLogger-Netz sollten 
statische IP-Adressen verwendet werden. Stellen Sie in den PCs das 
IP-Protokoll entsprechend ein. 

 Hinweis: In dem Beispiel haben die Stationen auf 10-160m, 15m 
und 80m eine statische Adresse und die Stationen auf 20m und 
40m eine dynamische Adresse 

o Zur Einstellung Ihres PC-Namens gehen Sie zur Windows-
Systemsteuerung > System > Systemeinstellungen > Computername 
und verwenden Sie den dort eingetragenen Namen oder ändern Sie ihn 
entsprechend Ihren Vorstellungen.

o Zur Ermittlung und Einstellung der IP-Adresse gehen Sie zur Windows-
Systemsteuerung > Netzwerkverbindungen > LAN-Verbindung > 
Eigenschaften > IP-Protokoll > IP-Adressen. Hier können Sie zwischen 
einem dynamische Adressenbezug vom Router oder eine fest 
eingestellten Adresse wählen. Für das N1MMLogger-Netz müssen Sie 
eine feste Adresse wählen, die sich mit der generellen Netzadresse 
verträgt (z.B. 192.168.x) und nur die letzte Stelle variieren (siehe 
Beispiel). 

• Auf allen PCs des Netzes muss eine identische Tabelle "Edit Station 
Computer Names" installiert werden. Vertauschen Sie keine Einträge! 

• Die Tabelle darf keinen leeren Eintrag enthalten. 

 Einstellungen kopieren 
Die Einstellung wird in der Datenbank gespeichert. Sie kann dort von den anderen 
PCs abgerufen werden. 

• Starte den Multi-User-Modus 
o Gehe zu Config >Multi-User Mode' 
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Mit dieser Auswahl geben Sie diese Option frei. 

 Nummern der Multi-Nutzer-Stationen 
Multi-2-Unterstützung: Sie müssen festlegen, welche Station als Run1 und welche 
als Run 2 arbeitet. Im Info-Fenster sehen Sie eine große blaue Ziffer, die angibt, als 
welche Station Sie arbeiten. Legen Sie im Configurer fest: Run radio 1 to use Port 
1 und Run radio 2 to use Port 2 . 

3. Multinutzer-Werkzeuge (Multi-User Tools Menu)

Das Hinzufügen und das Löschen von QSOs arbeitet automatisch. Die Bandskalen 
werden von der Packet/Telnet-Verbindung der "Master"-Station gefüllt. Weiter unten 
sehen Sie ein paar Beispiele wie das verwendet werden kann: 

Gehen Sie zu Config >Multi-User Tools 

• Multi Call Stacking Options : Sie können diese Varianten auswählen: 

o Sende Rufzeichen/Frequenz/Sendeart in den Stapelspeicher der 
Zielstation mit  Alt+I 

o Send Partner F-Keys to Stack Target VFOA/Radio 1 
o Send Partner F-Keys to Stack Target VFOB/Radio 2 
o Send Partner F-Keys to Stack Target - Disabled 

o Wipe Partner Call if Logged By Stack Target - Disabled 
o Wipe Partner Call if Logged By Stack Target - Enabled 

o Partner Logging - Disabled 
o Partner Logging - Enabled 

Anmerkung DM3ML : Da ich kein Multi-User bin und die Kommandos nicht verstehe, 
lasse ich sie lieber so stehen.

• Nachricht an andere Station schicken mit Ctrl+E : Sende die Nachricht an 
eine oder alle Stationen im Netz. Die Nachricht erscheint in dicken roten 
Buchstaben im Info-Fenster. Beginnen Sie die Nachricht mit 0-15 oder * 
gefolgt von einem Leerzeichen.  Das Programm setzt noch die Quellstation 
[Band] hinter die Nummer.

o Stationsnummer:
 * - Sendet die Nachricht an alle Stationen (auch ohne Nummer) 
 0 – Sendet Nachricht an den Master 0  
 1 – Sendet die Nachricht an Station 1 
 . . . 
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• Force Time Sync Now : Löst eine Zeitsynchronisation mit dem Master aus. 
Erfolgt sonst beim Einschalten und alle 5 Minuten.  

• Set your pass frequency Alt+Z : Schickt Ihre Passfrequenz an alle 
Stationen. Ihre aktuelle CQ-Frequenz brauchen Sie nicht zu senden, die 
kennen die Stationen im Netz schon. Mit {PASS 3} teilen Sie die Passfrequenz 
der Station 3 mit. In CW wird die Passfrequenz mit einem R für das Komma 
gesendet. Mit einer 0 wird die Passfrequenz rückgesetzt. 

 

• Send Freq/Mode to Call Stack Target Station Alt+I : Dieses Kommandos 
wurde für die Teilnehmer am WRTC-2006 eingebaut. Damit wird der VFO B 
der Zielstation auf eine bestimmte Frequenz gesetzt. 

• Log QSOs at all stations : Wenn aktiv, werden alle QSOs aller Stationen auf 
allen PCs abgespeichert. Ist voreingestellt.  

• Show Connections : Anzeige der Verbindungen aller Netzwerkstationen  

 

• Statusmeldungen 
o Connected : Verbindung zu dieses Station hergestellt 
o Listening : Station hört auf die Masterstation, aber es besteht keine 

Verbindung 
o Error : Keine Verbindung zur Master-Station, kein Multi-User-Modus 
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• Reset Serial Numbers on all Stations : Die QSO-Zähler aller 
angeschlossenen Stationen werden zum Contestbeginn auf Null gestellt, auch 
wenn schon Test-QSOs gefahren wurden.

• Resync Logs by Date : Erlaubt einem Computer alle abweichenden QSOs 
auf anderen Computern innerhalb eines Netzwerks für eine 48h-Periode zu 
erfassen: 

o Geben Sie die Startzeit eines 48h-Contests ein. 
o Der Contestname muss mit den anderen PCs übereinstimmen, z.B. 

CQWWSSB. 
o Die Resync-Funktion übernimmt nur QSOs von anderen PCs, bei 

denen ein Resync nötig ist. Das Resync arbeitet nicht bi-direktional. 
Der abfragende PC schickt keine QSOs an den anderen PC.  

o Bei einem Resync mit älteren Logs, muss der richtige Startpunkt 
eingestellt werden. Die QSOs müssen mit der korrekten 
Stationsnummer geloggt sein. Station 0 sendet nur QSOs, die von der 
Station 0 gearbeitet wurden usw.  

 

• Resync Last n Hours : Erlaubt einem Computer die abweichenden QSOs 
einer bestimmten Periode abzurufen. Die Periode wird in Stunden eingestellt.  

• Rescore last n Hours : Punkteberechnung für die letzten n Stunden 
ausführen. Läuft relativ langsam.

• Trace Multi-User Messages : Die Multi-User-Nachrichten werden in einer 
Datei mit der Endung *.TRC abgespeichert. Ein Dateiname kann eingegeben 
werden. Die Option kann für die Fehlersuche verwendet werden. 

• Force Other Station to Stop Transmitting When I Transmit : Hindert eine 
andere Station am Senden, wenn die eigene Station sendet. Wird im M2- und 
im Multi-Single-Modus verwendet. 

• Don't automatically change to S&P mode: Schaltet die automatische 
Umschaltung in den S&P-Modus bei einem Frequenzwechsel ab. 

• Set station as Run 2 : Setzt im M2-Modus eine Station als Run 2-Station 
(when in M/2) 

• Don't work non-mults : Sperrt das Loggen von Nicht-Multi-Station. Auch CQ 
darf diese Station nicht rufen.   

• Show Computer Name _ IP Address Info : Zeigt den PC-Namen und die IP-
Adresse an, wenn mit dem Programm 'IPCONFIG /ALL' gearbeitet wird. 

4. Information im Info-Fenster (Information)

Im Info-Fenster wird im Multi-Nutzer-Modus der Status des Netzes angezeigt. Ein 
Klick auf die grünen LEDs öffnet ein Menü:  
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• Connection-Status: 
o Grün - Connected 
o Rot – nicht verbunden 
o Hellrot – An der Verbindung wird gearbeitet 

• Stationsname 
• Passfrequenz: Mit einem Klick auf die Passfrequenz wird eine Nachricht an 

die ausgewählte Station geschickt. Haben Sie auf die eigene Station geklickt, 
wird der linke VFO auf die aktuelle Passfrequenz gesetzt.  

• RUN oder S&P 
• Operator 
• QSO-Rate in QSOs/h für letzte 10/100 QSOs 
• Run/Pass-Frequenz 

4.1. Regeln (Rules)

Nachfolgend werden wie Regeln für Run/Pass-Frequenzen erläutert:

• Running 
o Ich bin im RUN-Modus

 Ein Haken ist im RUN-Feld, ich sende auf der RUN-Frequenz 

• Nicht im RUN-Modus 
o Der OP hat eine RUN-Frequenz, jagt aber gerade einen Multi 

 Die RUN-Frequenz bleibt für eine Minute stehen, geht dann aber 
auf 0 

o Der OP ist nicht im RUN-Modus, hat aber eine PASS-Frequenz weiter 
oben im Band 

 Der OP muss eine PASS-Frequenz angeben 
o Schickt mir keinen auf die PASS-Frequenz, die Frequenz ist belegt 

 Der OP sollte die Passfrequenz auf 0 setzen 

4.2. Anzeige-Regeln (Displaying Rules)

Im RUN-Modus:  RUN-Frequenz wird angezeigt 

Nicht im RUN-Modus: Zeige eingestellte Passfrequenz an. Falls nicht eingestellt, 
dann verwende letzte CQ-Frequenz, falls nicht Null. 

5. Macro-Tasten (Macro keys)

siehe Kapitel Macros, speziell die Multi-Nutzer-Macros 
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6. Möglichkeiten (Features)

• Call stacking : Rufzeichenstapelspeicher. Schicke ein Rufzeichen in den 
Stapelspeicher eines anderen PC' 

o Um anzuzeigen, an welche Station Sie ein Rufzeichen in den 
Stapelspeicher schicken wollen, klicken Sie rechts auf die zugehörige 
“Billardkugel” im Info-Fenster und wählen Sie aus dem Menü das Ziel: 
"Target for call stacking". Sie können maximal ein Rufzeichen 
abschicken.  

• Prohibit transmitting (Senden sperren)
o Sperrt das Senden wenn im Modus Single Operator oder Multi-one eine 

andere Station sendet 
o Sperrt das Senden wenn im Modus Multi-two oder Multi-Multi eine 

Station auf dem gleichen Band sendet
o Siehe auch Option Force Other Station to Stop Transmitting When I  

Transmit (Andere Station abschalten, wenn ich sende) unter den 
Multi-User-Werkzeugen unter Config. 

7. Wohin Dateien abspeichern? (Where to Place the Database Files)

Speichern Sie die Logs nicht auf einem Servern sondern auf den Festplatten der 
mitmachenden Stationen.  

• Eine gemeinsame Nutzung des Logs auf einem Server funktioniert meistens 
nicht. In der Regel gibt es Probleme. Das Programm wurde nicht für diese Art 
der Speicherung entworfen. 

• Sie erreichen eine große Redundanz, wenn Sie die Logs auf allen PCs 
speichern. HF-Einstrahlungen können nicht alle Logs beeinflussen. 

• Lokaler Zugriff ist deutlich schneller. 

Sie können durchaus einen Server für Sicherheitskopien der Datenbankdateien 
*.mdb verwenden. Achten Sie aber darauf, dass das Programm und die Dateien 
geschlossen sind, ehe Sie sie transportieren. 

8. Weitere Infos (Other Info)

• Sie können nur eigene QSOs löschen. Das Löschen durch eine andere 
Station ist nicht erlaubt.  

• Station 0 sendet alle ankommenden Spots an alle Stationen in die 
Bandskalen. Verwenden Sie an den untergeordneten Stationen das 
Telnetfenster. DXCluster-Meldungen von den untergeordneten Stationen 
werden über das Telnetfenster an die Station 0 geschickt und von dort an den 
DXCluster über Telnet oder Packet weitergeleitet. Die Antwort des DXClusters 
wird wieder an alle Stationen geschickt.  

• Wird das Programm heruntergefahren, wenn andere Multi-Nutzer-Stationen 
den Zugang initialisieren, kann es zu unvorhersehbaren Zuständen kommen.  

• Beim Start werden Sie nach dem Operatorrufzeichen gefragt, soweit Sie es 
noch nicht mit Ctrl+O schon eingegeben haben. Wurde noch kein OP 
angegeben, erfolgt eine wiederholte Warnung. 

• Beim Start wird die CQ/Pass-Frequenz abgefragt 
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• Im Contest DELETEDQS werden die gelöschten QSOs abgelegt. Es handelt 
sich nicht um einen Contest, sondern um eine Möglichkeit gelöschte QSOs 
abzulegen und nachträglich zu editieren.  

• Die Verbindungen werden alle 10 Sekunden überprüft. Der Status wird unten 
im Info-Fenster angezeigt.  

• Bei einer Änderung der Datenbank, des Contests oder der Verbindungsliste 
werden alle Verbindungen getrennt und neu wieder aufgebaut.  

• Es ist auch Non-Master-Stationen erlaubt, Telnet/Packet-Ports zu schließen.  
• Die Zeitsynchronisation wird nur beim Master angezeigt. 
• Falls Sie DXSpots an Ihrer Station markieren oder speichern, werden Sie auf 

allen Stationen markiert oder gespeichert 
• Bei einem DXCluster-Kommando wird die Station angezeigt, die Kennung 

aber  nicht an den DXCluster geschickt, z.B. 20M sh/dx. 
• Bei einer abgebrochene Verbindung wird alle 30 Sekunden versucht, sie 

wieder herzustellen.  
• Mit Ctrl+Alt+M wechselt die Station den Status, z.B. zwischen RUN und 

MULTI oder zwischen RUN1 und RUN2. Der Status wird im Cabrillo-Logs 
angezeigt. 

• In der Multi-Multi-Kategorie wird im Cabrillo-Log die Stationsnummer dem 
QSO zugeordnet. In der Multi-Single-Kategorie wird RUN oder MULTI und in 
der Kategorie Mult-2  wird Run1 oder Run2 angezeigt. 

• Eine Station, die auf dem gleichen Band arbeitet, wird im Info-Fenster rot 
angezeigt.

• Bei einem SingleOP und bei Multi-one wird das sendende Rufzeichen rot 
angezeigt.

• Im Multi-User-Mode ist eine Gruppenedition im Logfenster nicht möglich.  
• Wurde bei einer Station unter Config > Multi-User tools > Don't work non-

mults eingestellt, ist das CQ-Rufen bei dieser Station gesperrt. 
• Nur die Master-Station kann automatisch einen DXCluster re-connecten, falls 

freigegeben. 

9. Beispiel für eine Multi-Nutzer-Einstellung (Example Multi-User Setup)

Das folgende Beispiel erlaubt geteilte Dateiennutzung (file sharing) und Netbios-
Lookup der beteiligten PCs (Sie können sie in der Netzwerkumgebung sehen). Diese 
Vorkehrungen sind unter N1MMLogger nicht nötig, dort reicht es, wenn sich die 
Computer gegenseitig anpingen können. Alle Zeilen mit einem ‘*’ sind nicht 
unbedingt nötig, erweitern aber die Möglichkeiten. Sie können aber die Dateien auch 
über CDs oder Disketten auf die einzelnen Rechner bringen. In diesem Fall können 
Sie auf ein Windowsnetzwerk verzichten. Das N1MM-Netzwerk benötigt nur den 
TCP/IP-Stack. 

9.1. Vor dem Contest (Before the Contest)

Master-Computer 

• Geben Sie die geteilte Dateiennutzung (File sharing) für Windowsnetzwerke 
frei (*) 

• Geben Sie die Nutzung der Festplatte des Masterstation frei (*) 
• Halten Sie alle Installationsdateien auf der Festplatte des Masters bereit (*) 
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• Speichern Sie den Rechnerzustand vor der Änderung ab, um ihn später in der 
alten Umgebung wieder verwenden zu können:

o Heben Sie die IP-Adresse zum Wiederherstellen des Zustands vor dem 
Contest gut auf 

o Notieren Sie sich den PC-Namen und die Arbeitsgruppe aus dem 
gleichen Grund(*) 

• Geben Sie dem Master die IP-Adresse laut Liste weiter unten 
o U.U. müssen den Rechner neu starten und auf Anfrage die Windows-

CD einlegen 
• Starten Sie  N1MMLogger 
• Wählen Sie eine neue leere Datenbank wie PACC2003.MDB auf dem Master 
• Starten Sie ein neues Contestlog wie z.B.  PACC 
• Konfigurieren Sie die Funktionstasten für SSB, CW und Packet 
• Geben Sie den Stationen diese Namen und IP-Adressen, z.B.:

 
o Stn#: Stationsname Computer-IP-Adresse 
o 0: master 192.168.10.10 
o 1: 160M 192.168.10.1 
o 2:   80M 192.168.10.2 

• Laden Sie die neueste Länderliste wl_cty.dat mit dem Menü Tools 
• Wählen Sie eine Datei Master.dta mit 'File >  Choose Which Contest to Log' 
• Stellen Sie ein Verbindung zu einem DXCluster über Packet oder Telnet her 
• Stellen Sie den internen Firewall ein oder legen Sie in still 

Nicht-Master-Computer (Non-master computers) 

• Installieren Sie – soweit noch nicht geschehen – die Netzwerkkarten und 
weisen Sie die TCP/IP-Adressen zu 

• Stellen Sie den internen Firewall ein oder schalten Sie in ab 
• Geben Sie Dateien für das Windowsnetzwerk frei (*) 
• Stellen Sie die I-Adressen entsprechend der Station Computer Names list 

ein
o Windows 98/ME: hier brauchen Sie die Windows-CD und müssen den 

PC neu starten
o Notieren Sie sich die frühere IP-Adresse, um den PC wieder 

zurückgeben zu können.
• Suchen Sie den Master im Windows-Netzwerk (*) 

o Verwenden Sie zum Suchen den NetBIOS-Namen des Masters 
• Installieren/Aktualisieren Sie N1MMLogger mit einer Kopie vom Master (*) 
• Kopieren Sie die Datenbank z.B. PACC2003.MDB vom Master auf diesen PC 

über das Netzwerk (*) 
• Kopieren Sie das WAV-Verzeichnis vom Master über das Netzwerk (*) 

Alle Computer (All computers) 

• Starten Sie  N1MMLogger 
• Importieren Sie die Fenstereinstellungen 
• Öffnen Sie die Datenbank z.B. PACC2003.MDB. Öffnen Sie das PACC-Log 
• Aktivieren Sie Multi-User
• Stellen Sie die Konfiguration ein (CAT, PTT, CW) 
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• Schalten Sie die Windows-Töne über Systemsteuerung > Sounds > Keine 
Sounds ab 

Immer (Always) 

• Stellen Sie sicher, dass auf allen Rechnern die gleiche N1MMLogger-Version 
läuft 

• Stellen Sie sicher, dass auf allen Rechnern der gleiche Contest gestartet ist 
• Stellen Sie sicher, dass alle Rechner auf die gleiche Zeitzone und 

Sommer/Winter-Zeit eingestellt sind. 
• Stellen Sie sicher, dass an allen Rechnern die gleichen Regionaleinstellungen 

für Zahlen, Datum, Zeit, Währung u.a. eingestellt sind 

9.2. Während des Conteste (During the Contest)

• Überprüfen Sie die Master-Zeit regelmäßig. Die anderen Stationen werden 
danach synchronisiert

• Beobachten Sie den Netzwerkstatus und machen Sie ein Reconnect/Resync 
falls nötig an allen Rechnern. Beachten Sie, dass nach einem Resync nur 
QSOs zu dem Rechner importiert werden von dem Sie importieren. Der 
Rechner,  von dem der Import kommt, wird nicht aktualisiert mit dem Log von 
dem Rechner, zu dem Sie importieren. (DM3ML:???) 

9.3. Nach dem Contest (After the Contest)

• Stellen Sie sicher, dass alle Rechner angeschlossen sind. 
• Machen Sie ein Resync auf allen Rechnern 
• Überprüfen Sie den QSOs/Multiplier-Status an allen Rechnern und 

vergleichen Sie ihn 
• Lösen Sie ein Copy & compact der Datenbank z.B.  PACC2003.MDB in das 

Backup-Verzeichnis aus 
• Setzen Sie die IP-Adressen und Windowstöne bei den ausgeliehenen 

Rechnern auf den Ursprungszustand zurück.

10. Multi-Nutzer-Log-Synchronisation (Multi-user log synchronization)

Die Logsynchronisation sollten Sie nur in größeren Abständen laufen lassen. Jede 
Station hat Ihre eigenen Logs, so dass sie nur interessant bei der Verfolgung der 
Multis ist. Sie kann aus der Synchronisation fallen, wenn die Verbindung zu einer 
Station unterbrochen war. Sie sollten die Synchronisation nur für die Zeit laufen 
lassen, in der die Verbindung unterbrochen war. Wenn eine neue Station ins Netz 
kommt, sollte ihr eine Station die Datenbank per Email schicken. Sie kann dann ihr 
Log resynchronisieren, das dauert nur ein paar Minuten. Bei einem größeren Ausfall 
kann es länger dauern. 

11. Multi-Multi über das Internet verteilt (Multi-Multi Distributed - Multi-
User via the Internet)

Sie können die Stationen auch großflächig über LAN und das Internet vernetzen. 
Allerdings benötigen Sie dazu einiges Fachwissen über IP-Adressen, Firewalls, 
Router, Porteinstellungen. NAT usw. Und Sie sollten dabei sich immer an die 
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Contestregeln halten, die weit auseinander liegende Stationen nur bei ausgesuchten 
Contesten erlauben.

Sie müssen Ihre externe IP-Adresse kennen. Wenn Sie direkt ins Internet eingeloggt 
sind, können Sie diese Adresse mit ipconfig.exe (NT, 2000, XP) oder winipcfg.exe 
(98, ME) bestimmen. Ist Ihr PC über einen Router angeschlossen ist, verwendet der 
PC  eine internen IP-Adresse zum Router und der Router hat eine externe IP-
Adresse. Mit diesem Link http://megawx.aws.com/support/faq/software/ip.asp 
bekommen Sie beide Adressen heraus. 

Wenn in einer Multi-Nutzer-Verbindung die Verbindung zusammenbricht, müssen Sie 
die IP-Adresse erneut überprüfen. Die IP-Adresse wird dynamisch per DHCP 
vergeben und wechselt von Zeit zu Zeit, auch dann, wenn Sie den PC neu starten 
oder sich neu bei Ihrem Router einloggen.  

Der Router sollte so konfiguriert sein, dass er ankommenden Datenverkehr zu Ihrer 
PC-IP-Adresse routet. Sie benötigen keine Angaben zu den Ports. Gehen Sie aber 
davon aus, dass es sich um eine Spezialistenarbeit handelt und bei der Vielzahl von 
Routern ein umfangreiches Fachwissen erforderlich ist. 

Der verwendete Eingangsport ist gleich 12070 + Stationsnummer (0-15). Der Port 
12070 wird für die Station 0, der Port 12071 für die Station 1 usw. verwendet. 

Firewall : Öffnen Sie den Port 12070 + Stationsnummer (0-15) für  den 
ankommenden Verkehr. 

Router :  Verwenden Sie den NAT, um den ankommenden Verkehr an den Ports 
12070 + Stationsnummer (0-15) an Ihre PC-IP-Adresse durchzuschalten. 

Config >Edit Station Computer Names 

• Rechner mit N1MMLogger im lokalen Netzwerk verwenden ihre lokale IP-
Adresse. Rechner außerhalb des lokalen Netzwerks verwenden ihre externe 
IP-Adresse aus dem externen Netzwerk. Der Router zum externen Netzwerk 
sollte die Portweiterschaltung zum korrekten Rechner unter N1MMLogger 
realisieren. 

• Beispiel für eine Einstellung: 
o Die Adresse 192.168.1.11 ist die lokale Adresse auf meiner Seite 

(PA1M) 
o Die ersten zwei Einträge sind die beiden Rechner von Tom (N1MM) 
o Der Router bei PA1M ist in der 'Port redirection table' so eingestellt: : 

 Service name : N1MM 
 Protocol: TCP 
 Public Port: 12072 
 12072 = 12070 + 2, das ist der Port für mein Rechner mit Zugriff 

von außen 
 Private IP: 192.168.1.11 
 Private Port: 12072 
 Active: Yes 
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Hinweis: Die genannten Adressen werden bei Tom nicht wieder verwendet.

Die Totzeit (latency) lag bei 100 ms. 

 IP-Adressen 
Die Liste der IP-Adressen ist unterschiedlich bei den angeschlossenen Rechnern. 
Stellen Sie sicher, dass die entfernte Maschine mit ihrer externen IP-Adresse und die 
lokale Maschine mit ihrer internen IP-Adresse eingetragen ist. Bei mehreren lokalen 
Maschinen hinter dem Router, sind die lokalen Adressen der lokalen Rechner 
einzutragen.  

Beispiel für PA1M
0:N1MM 64.252.138.65
1:PA1M 192.168.0.1 

Beispiel für N1MM
0:N1MM 192.168.0.1
1:PA1M 63.133.11.55 

Contest-Ethik?

Legal ist diese externe Vernetzung nur bei IARU-HQ-Stationen im IARU-Contest und 
in der Klasse CQWW "Extreme". Sonst sollten die Multi-Multi-Stationen in einem 
Radius von 500m stehen. Aber es wäre eine gute Idee ein 10m-Station in Peru, eine 
15m-Station im Senegal und eine 160m-Station auf Island zu haben. Das wäre dann 
die Contestklasse Multi-Multi Distributed

Last Modification: 14 December 2009 16:26:13 EST by n2ic. 

Ein-OP-Zwei Sender (SO2R)

1. Grundlagen (SO2R Basics)

Mit der SO2R-Technik können Sie Ihr Log um zahlreiche QSOs und Multis erweitern. 
Der Einsatz von SO2R lohnt sich vor allem in Zeiten geringer Aktivität. Sie können 
auf dem einen Band CQ rufen und auf dem anderen nach Multis suchen. Haben Sie 
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einen Multi gefunden, stoppen Sie das CQ-rufen und arbeiten schnell den Multi, ehe 
Sie weiter CQ-rufen. Bohren Sie Ihre Punktzahl mit dieser Methode deutlich auf!

Voraussetzung für eine SO2R-Station sind ausreichend voneinander montierte 
getrennte Antennen. Die beiden Transceiver müssen nicht die gleichen sein, sollten 
aber durch vorgeschaltete Bandfilter gegen die starken Signale von einem anderen 
Band geschützt werden. Werden gleiche Transceiver verwendet, verringert sich die 
Belastung des OP, er braucht nicht umzudenken. 

Der kritische Moment des SO2R-Betriebs ist das automatische Senden. Sie müssen 
die Taste bedienen oder ins Mikrofon sprechen, während Sie auf dem zweiten 
Transceiver nach Stationen suchen. Der SO2R-Betrieb kann Sie ganz schön 
anstrengen und mitunter wird Ihre Punktzahl eher geringer als besser.

N1MMLogger unterstützt auch den Modus "Single Operator 2 VFOs" oder SO2V. 
Dann können Sie abwechselnd mit den 2 VFOs arbeiten. Sie haben auch zwei 
Logeingabefenster zur Verfügung. Oder Sie können mit dem Zweit-RX Ihres 
Transceivers arbeiten, allerdings können Sie nicht gleichzeitig auf dem einen Bereich 
senden und auf dem anderen hören, so dass SO2V nicht so ergiebig ist wie SO2R. 
Beim SO2R-Betrieb müssen Sie auch die Tastung und die PTT zwischen den 
Transceivern umschalten. Unter N1MMLogger werden maximal zwei Transceiver 
unterstützt. 

Dezenter Tipp für einen neuen SO2R-Operator: Praxis, Praxis, Praxis….Sie 
brauchen eine Weile, bis Sie diesen Modus im Griff haben. 

2. Intuitive Nutzerführung (Intuitive User Interface)

N1MMLogger ist auf den SO2R-Betrieb gut vorbereitet:  

• Es stehen zwei Logeingabefenster bereit, die entsprechend der 
Stationseinrichtung angeordnet werden können. 

• Sie sehen auf den ersten Blick, welcher Transceiver aktiv ist und können ihn 
aus dem jeweiligen Fenster heraus bedienen. Im ESM-Modus wird die 
nächste aktive Taste angezeigt.

• Der Status RUN oder S&P wird durch imitierte LEDs angezeigt.

3. Unterstützte Möglichkeiten (Supported features)

N1MMLogger unterstützt alle Möglichkeiten, die Sie von einem Weltklasse-SO2R-
Programm erwarten können. Darüber hinaus gibt es diese Möglichkeiten:  

• Zwei Logeingabefenster stehen zur Verfügung. Sie sind gegeneinander 
austauschbar.  

• Die Modi RUN und S&P werden von beiden Fenstern unterstützt. Sie können 
Sie wie folgt nutzen:  

o Running / S&P 
o S&P / Running 
o S&P / S&P 
o Running / Running 
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• Ordnen Sie die Fenster so an, wie die Transceiver stehen: Oben/unten oder 
Rechts/Links 

• In jedem Fenster wird die Frequenz oben im Fenster angezeigt
• 'LEDs' identifizieren den Fokus. Der sendende Transceiver hat eine rote LED 

und hat den TX-Fokus, die grüne LED identifiziert den auf RX stehenden 
Transceiver, der den RX- und den Tastatur-Fokus hat. 

• Sie sehen an der Hintergrundfarbe des Logeingabefensters, welchen Status 
das Fenster hat: Weiß = RUN, Gelb = S&P. 

• Sie können die Frequenz des inaktiven Transceivers vom aktiven Transceiver 
aus einstellen. Setzen Sie vor die Frequenzangabe im Rufzeichenfenster ein /. 

• Der ESM-Modus wird in beiden Fenstern unterstützt.
• Die Eingabe eines Rufzeichens im Fenster des inaktiven Transceivers 

unterbricht nicht die Sendung des aktiven Transceivers 
• Mit ESC wird jede Sendung unterbrochen, aber nicht der Tastatur-Fokus 

geändert. 
• Beim Wechsel des TX-Fokus wird erst die Sendung auf dem anderen 

Transceiver beendet 
• Mit Ctrl+F-Tasten und Ctrl+Enter können Sie Nachrichten auf dem 

Transceiver senden 
• Es gibt Kurzruftasten ("Hotkey's") für spezielle Aufgaben zum Senden auf dem 

anderen Transceiver 
• Alle Tastenzuordnungen gelten für beide Transceiver 
• Unterstützt werden die SO2R-Geräte Top Ten DX Doubler, WX0B Station 

Master, Microham MK2R, YCCC SO2R und andere SO2R-Kontroller 
• Dueling CQ's sendet abwechselnd CQ auf den einen und dem anderen 

Transceiver (Ctrl+B) 
o Beide Transceiver werden in den RUN-Modus gesetzt 
o Ctrl+F1 oder Ctrl+Enter startet das Dueling CQ 
o Es werden SSB und CW CQ's unterstützt (unterschiedliche 

Senderarten in den Eingabefenstern) 
o Nach dem Beenden des Dueling CQs wird die davor eingestellte 

SO2R-Anordnung wieder hergestellt 
• Ein SO2R-Software-Transceiver-Lockout ist vorgesehen 
• Das wiederholte CQ wird beendet, wenn eine Nachricht auf dem anderen 

Transceiver gesendet wird 
• Das Macro {JUMPRX} wechselt den RX-Fokus auf das andere Eingabefenster 
• Es werden zwei Transceiver, aber nicht drei und mehr, unterstützt 
• Der SO2R-Betrieb mit keiner, einer oder zwei Soundkarten wird unterstützt 

(5$ SO2R) 
• Verwenden Sie zum Bandwechsel des anderen Transceivers die Tasten 

Ctrl+Bild nach oben/unten. 
• Im SO2R-Betrieb wird der CW-Text in der Statusleiste des 

Logeingabefensters ausgegeben 
• Der VOX-Betrieb im "$5 SO2R"-Modus übernimmt jeweils den TX-Fokus

Ein SO2R-Betrieb über ein Netzwerk wird aktuell NICHT unterstützt. 
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4. Logeingabefenster (Entry Windows)

Sie können die Logeingabefenster an eine beliebige Stelle des Bildschirms schieben. 
Meist werden Sie so angeordnet, wie die Transceiver stehen (rechts/links oder 
oben/unten). 

Wenn auf dem Schirm nicht so viel Platz ist, können Sie die Eingabefenster in einer 
verkleinerten Version anzeigen lassen. Zu empfehlen ist ein Arbeitsplatz mit zwei 
Monitoren. 

 

 

Verwenden Sie zum Öffnen des zweiten Eingabefensters die Taste \ (Backslash). 

5. Typische SO2R-Eingabefenster (Typical SO2R Entry Windows)

Die meisten Ops neigen dazu, die Eingabefenster wie in dem Beispiel unten zu 
verkleinern. Alle wesentlichen Informationen sind auch der verkleinerten Version 
entnehmbar. In der Regel wird auch der Transceiver1 zum CQ-Rufen und der 
Transceiver2 für den S&P-Betrieb genommen. Das unten stehende Beispiel zeigt 
diese Aufstellung. VFO-A ist im RUN-Modus und VFO-B im S&P-Modus: 

  

Alle Möglichkeiten, die der Single-OP hat stehen auch dem Operator im 
SO2R/SO2V-Betrieb zur Verfügung. In der Bandskala stehende DXSpots werden in 
den Rahmen über dem Rufzeichenfeld übernommen. Mit der Leertaste werden die 
Rufzeichen in das Rufzeichenfeld übernommen. Ruft Sie eine Station auf dem RUN-
Tcvr anruft, können Sie mit der Taste \ oder Ctrl+Pfeil nach links/rechts zwischen 
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den Transceivern und Eingabefeldern umschalten. Mit Alt+W oder Ctrl+W oder mit 
einem QSY wird das Rufzeichenfeld wieder geleert.

6. Die SO2R-LEDs (The SO2R dots (LEDs))

Im Logeingabefenster werden eine grüne und/oder eine rote LED angezeigt. Die 
LEDS zeigen den aktuellen Status der angeschlossenen Transceiver an und sind 
eine visuelle Statusinformation, die dem OP auf einen Blick zu jeder Zeit die Situation 
seiner Station anzeigt. 

Die grüne LED zeigt den VFO oder Transceiver, der im Moment auf Empfang ist und 
den Tastaturfokus hat. Die rote LED zeigt an, dass der VFO oder Transceiver den 
TX-Fokus hat. Sendet er nicht, zeigt die LED ein dunkles Rot, sendet er, hat die LED 
eine helle rote Farbe. Innerhalb der LEDs stehen Buchstaben, die den aktuellen 
Status anzeigen (siehe unten).

6.1. Bei den LEDS verwendete Farben (Dot/LED colors used):

Grün – Dieser VFO/Transceiver hat den RX- und den Tastatur-Fokus 

• In der grünen LED steht entweder Ru oder SP entsprechend RUN- oder S&P-
Modus. 

o Wenn Sie auf die grüne LED klicken ändert sich der Modus von Ru 
nach SP oder zurück. 

• Sie können den RX/Tastatur-Fokus zwischen VFOs/Transceivern wechseln 
o Mit einem Klick in den freien Platz eines der Logeingabefenster oder
o Mit der Taste \ (backslash) 

• Wenn Sie sowohl den Sende- als auch den Empfangsfokus wechseln wollen, 
verwenden Sie die Tastenkombination Ctrl+Rechts-Pfeil oder Links-Pfeil 

Rot- Dieser VFO/Transceiver hat den TX-Fokus, d.h. er sendet gerade oder war 
zuletzt beim Senden. Wenn das andere Eingabefenster den Tastatur-Fokus hat und 
Sie eine F-Taste dort drücken, wechselt der TX-Fokus in dieses Fenster. 

• Sie können den TX-Fokus zwischen den VFOs/Transceivern mit der Taste 
Alt+F10 wechseln 

• Wenn Sie sowohl den Sende- als auch den Empfangsfokus wechseln wollen 
verwenden Sie die Tastenkombination Ctrl+Rechts-Pfeil oder Links-Pfeil 

• Während des Sendens kann der TX-Fokus nicht gewechselt werden 
• Ist in der roten LED ein R (Repeat) zu sehen, ist auf den Wiederholmodus des 

CQ-Rufs geschaltet 
• Ist in der roten LED ein D (Dueling CQ) zu sehen, ist das Dueling CQ aktiv 

active 

7. Tastenzuordnungen für SO2R (Key Assignments (unique to SO2R))
 Klebrige Optionen ("Sticky" options) 

Der Fokus für das Fenster gegenüber und die Ctrl+Fx-Einstellungen, die entweder 
über Tastatur-Kurzrufe oder über das SO2R-Submenü des Configurers ausgelöst 
werden, können sich „klebrig“ benehmen, d.h. das Programm merkt sich die 
Einstellungen und wenn Sie es neu starten, kann es sich etwas merkwürdig 
benehmen, wenn Sie sich nicht mehr an die früher gewählte Einstellung erinnern. 
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7.1. SO2R-Tasten im Logeingabefenster (Entry Window Features)

• Backslash ( \ ) : Startet ein zweites Logeingabefenster, wenn bisher nur eins 
offen war. 

o Ein Transceiver/zwei VFOs: schaltet den RX-Fokus zwischen den 
VFOs hin und her 

o Zwei Transceiver:  - schaltet den RX-Fokus zwischen den 
Transceivern hin und her 

o
• Ctrl+Enter : Sendet die ESM-Nachricht auf dem anderen Transceiver, falls 

aktiv 
• Ctrl+F1 to F8 : Sendet den Tastentext auf dem anderen Transceiver 
• Ctrl+Linkspfeil:  schaltet TX- und RX/Tastatur-Fokus auf den linken 

Transceiver bzw. von VFO-B auf VFO-A. 
• Ctrl+Rechtspfeil:  - schaltet TX- und RX/Tastatur-Fokus auf den rechten 

Transceiver bzw. von VFO-A auf VFO-B.
• Pause : Setzt den TX- und den RX/Tastatur auf den anderen Transceiver oder 

VFO. Wenn TX- und RX-Fokus im Splitbetrieb sind, geht der TX-Fokus dort 
hin, wo der RX-Fokus ist 

• Alt+F5 : Tauscht Frequenz, Rufzeichen und Sendeart zwischen den 
Transceivern oder VFOs aus. Bei SO2R wechselt der RX-Fokus auf den 
inaktiven Transceiver 

• Alt+F6 : Identisch mit Alt+F5, nur der Fokus ändert sich nicht 
• Ctrl+B : Startet das  Dueling CQ > auf beiden Transceivern wird 

abwechselnd CQ gesendet. Beide Transceiver bekommen den RUN-Status. 
Sie können eine Wartezeit mit "Set Dueling CQ Repeat Time" im SO2R-
Menü eingeben, Sie können auch duellierende SSB- und CW-CQ's erzeugen. 

• Single quote (Hochkomma) oder Tilde (~) : Schaltet den STEREO-Modus 
ein/aus oder den PTT-Modus um.  

• Ctrl+I : Schaltet die SO2R-Modi, die vom Programm und der Soundkarte 
unterstützt werden durch. Wirkt nur im '$5SO2R'-Modus, wenn N1MMLogger 
die Soundkarte steuert. Funktioniert nicht mit einem externen SO2R-
Kontroller. 

• Ctrl+Bild hoch/runter: Schaltet die Bänder auf dem anderen Transceiver um
• Ctrl+Shift+I : schaltet erweitertes SO2R ('Advanced SO2R') ein/aus 

o Mit Advanced SO2R eingeschaltet, wird der Fokus in das 
Eingabefenster des Transceivers gesetzt, der eine Meldung gesendet 
hat. Eine Ausnahme wird gemacht, wenn im Rufzeichenfeld des nicht 
sendenden Transceivers bereits ein Rufzeichen ganz oder teilweise 
eingetragen wurde 

o Oder einfach gesagt, wenn Sie den Transceiver auf S&P-Modus setzen 
und keiner der Transceiver aktiv ist und z.B. CQ sendet, geht der Fokus 
automatisch zum S&P-Transceiver. Sie können dort abstimmen, ohne 
befürchten zu müssen, dass Ihnen der Fokus dort verloren geht. Sie 
können das empfangene Rufzeichen in das richtige Fenster eintragen. 

• Ctrl+Shift+N : Einstellung der Verzögerung für Advanced SO2R. 
o Der Nutzer kann den Fokus auf dem RUN-Transceiver stehen lassen, 

wenn dessen Sendung beendet wurde, oder kann ihn auf den S&P-
Transceiver setzen, wenn die eingestellte Verzögerungszeit abgelaufen 
ist. Bei einem CQ sollte die Wiederholzeit auf 3s und die 
Verzögerungszeit auf 2s eingestellt werden. Zum Contestbeginn mit 
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viel Betrieb an der RUN-Station sollten die Verzögerungszeit länger 
und zum Contestende bei weniger Betrieb mit Ctrl+Shift+N  kürzer 
eingestellt werden.

• Ctrl+Shift+K : FocusOther, ein weitere Methode, die von einigen Contestern 
dem "Advanced SO2R" vorgezogen wird. Wenn FocusOther aktiv ist, wird 
der Fokus automatisch zwischen dem "Run"- und dem "S&P"-Transceiver 
getauscht. Wenn der RUN-Transceiver sendet, steht der Fokus beim S&P-
Transceiver. Wenn der RUN-Transceiver mit Senden aufhört, wird der RX-
Fokus zum RUN-Tcvr gesetzt. Damit kann im S&P-Fenster ein Rufzeichen 
eingetragen werden, während der RUN-Tcvr CQ ruft.   

o FocusOther und Advanced SO2R schließen sich gegeneinander aus. 
Es gibt auch kein einstellbare Verzögerung. 

• Ctrl+Shift+L : Schaltet die Verwendung von {CTRLFx}.Macros in den F-
Tasten ein oder aus. Mit {CTRLFx} können Sie automatisch auf dem anderen 
Transceiver senden. Wenn Sie z.B. das S&P-Macro auf der Taste F4 so 
programmieren: "* {CTRLF1}", wird Ihr Rufzeichen auf dem S&P-Radio 
gesendet und gleichzeitig ein CQ-Ruf auf dem RUN-Transceiver gestartet. 

7.2. Bandskalamöglichkeiten (Bandmap features)

• Shift+Klick auf eine Frequenz (nur bei SO2R ) :  Setzt die Frequenz des 
inaktiven Transceivers ohne Änderung des TX- oder RX-Fokus. Sie können 
damit die Frequenz des inaktiven Transceivers ändern, ohne ihn zum aktiven 
Transceiver zu machen.  

• Shift+Klick auf ein Rufzeichen (nur bei SO2R): Setzt die Frequenz des 
inaktiven Transceivers ohne Änderung des TX- oder RX-Fokus. Sie können 
damit die Frequenz des inaktiven Transceivers ändern, ohne ihn zum aktiven 
Transceiver zu machen.  

7.3. SO2R-Tastenzuordnungen verwenden (Using SO2R Key 
Assignments)

Backslash ( \ ) : Wenn Sie einmal das zweite Logeingabefenster geöffnet haben, 
wird der Backslash \ (Erläuterung DM3ML: lt.LEO: Gegenschrägstrich oder 
linksseitiger Schrägstrich) Ihr liebstes Werkzeug werden. Er schaltet zwischen den 
beiden Logeingabefenstern um (Anmerkung DM3ML: Der \ ist sicher nur auf einer 
englischen Tastatur an der richtigen Stelle). Der \ schaltet den RX-Fokus zwischen 
den Transceivern 1 und 2 hin und her. Über den TX-Fokus brauchen Sie sich keinen 
Kopf zu machen, wenn Sie ein F-Taste drücken, wird automatisch dort gesendet, wo 
der RX-Fokus gerade ist.

Beispiel:  Sie rufen CQ auf Transceiver 1 und drehen auf Transceiver 2 im S&P-
Modus übers Band. Sowohl RX- und TX-Fokus stehen bei der RUN-Station1. Dann 
hören Sie jemanden im Transceiver2 und wollen sehen, ob Sie ihn schon gearbeitet 
haben. Sie drücken die Taste \, der Fokus spring in Fenster2, Sie geben das 
Rufzeichen ein uns finden, dass Sie die Station gebrauchen können. Falls am 
Transceiver1 keiner anruft, drücken Sie die ENTER-Taste (Sie haben ESM aktiviert) 
und der TX-Fokus geht zum Transceiver2 und die Station wird angerufen. Kommt sie 
zurück, drücken Sie wieder die ENTER-Taste, die Station bekommt Ihre 
Kontrollnummer und Sie loggen Sie das QSO. Sie können entweder weiter im S&P-
Modus suchen oder den Fokus mit \ zurück auf die RUN-Seite schalten.  
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Nehmen wir nun an, dass mitten im S&P-QSO auf der RUN-Seite eine Station anruft. 
Auf der S&P-Seite senden Sie gerade die Kontrollnummer. Um das Rufzeichen auf 
der RUN-Seite in das Logeingabefenster eintragen zu können, schalten Sie mit \ den 
Fokus auf die RUN-Seite und tragen das Rufzeichen in das Logeingabefenster ein. 
Inzwischen ist die RUN-Seite mit der Kontrollnummer fertig, Sie drücken die ENTER-
Taste und auf der RUN-Seite wird das Rufzeichen der Gegenstation+Kontrollnummer 
gesendet. Müssen Sie noch einmal auf die S&P-Seite, drücken Sie wieder \. Diese 
Prozedur schreibt sich leichter, als sie dann während des Contests abzuwickeln ist.

  TX-Fokus verfolgen 
Im vorigen Beispiel haben Sie keine Problem mit dem TX-Fokus, er folgt automatisch 
dem RX-Fokus immer dann wenn Sie auf die ENTER-Taste (im ESM-Modus) oder 
eine der F-Tasten drücken. Sie sollten diese Betriebsweise zu Ihrer Standard-
Prozedur erklären. 

Ctrl+Enter oder Ctrl+Fn : Mit dieser Tastenkombination können Sie benötigte 
Nachricht auf dem inaktiven Transceiver senden. Der inaktive Transceiver ist der, der 
den RX-Fokus NICHT hat. Die Tasten Ctrl+Fn oder Ctrl+Enter wechseln nur den 
TX-Fokus, der RX-Fokus ändert sich nicht. Ist die ausgelöste Nachricht gesendet, 
kehrt der Fokus automatisch zur aktiven Seite zurück. 

Die übliche Situation ist, das mit dem Transceiver1 CQ gerufen wird, aber nur wenig 
Anrufe kommen. Sie schalten mit \ den Fokus auf den S&P-Transceiver2, wollen 
aber auf dem TCVR1 noch einen CQ-Ruf starten, das können Sie mit Ctrl+F1  oder 
Ctrl+ENTER machen. Sie brauchen die Tastenkombinationen auch, wenn Sie auf 
beiden Transceivern je ein QSO zu laufen haben und den RX-Fokus dort lassen 
wollen, wo er gerade ist. Sie können auch auf der aktiven Seite Tasten so 
programmieren, dass auf der inaktiven Seite gesendet wird. Verwenden Sie dazu 
das Macro {CTRLFx}. 

Taste Pause: Falls TX- und RX-Fokus im selben Logeingabefenster sind, können 
Sie mit der Taste Pause den TX- und den RX-Fokus in das andere Fenster setzen. 
Ist der Fokus zwischen den beiden Fenstern geteilt, können Sie mit der Pause-Taste 
den TX-Fokus dorthin bringen, wo der RX-Fokus ist und damit die beiden Foki 
synchronisieren. 

Ctrl+Pfeil nach rechts und Ctrl+Pfeil nach rechts: Die Tasten setzen den Fokus 
auf den rechtes oder den linken Transceiver 

Ctrl+B : Gibt das Dueling-CQ frei. 

{CTRLFn} : Sendet das Macro Fn auf dem anderen Transceiver 

• Diese Funktion "Toggle {CTRLFx}" muss im Configurer >  SO2R-Submenu 
freigegeben oder mit Ctrl-Shift-L eingeschaltet sein. Wenn nicht freigegeben, 
werden die Macros {CTRLFx} ignoriert.  

• Ein CW-Macro wie "tu EXCH{CTRLF9}"sendet am aktiven Transceiver “tu 
EXCH” und startet am inaktiven Transceiver den dort auf der Taste F9 
programmierten Text, z.B. ein CQ. 

• Beispiel: Wenn Sie den Fokus auf der S&P-Seite haben und die Tasten 
Ctrl+F1 drücken, wird der Text der Taste F1 im RUN-Transceiver gesendet. 
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Probieren Sie die S&P-Taste F4 mit dem Text ‚*{CTRLF1}’ aus. Sie sendet am 
S&P-Transceiver das eigene Rufzeichen und startet am RUN-Transceiver 
einen CQ-Ruf. Hier sollten Sie aber einen ganz kurzen CQ-Ruf 
programmieren und den CQ-Ruf eher als Platzhalter für die CQ-Frequenz 
verwenden, denn Vorrang hat die Abwicklung des QSO am S&P-Transceiver.. 

• Sie können auch die S&P-Taste F2 mit 5NN14{CTRLF1} programmieren. 
Dadurch wird erst die Kontrollnummer im S&P-Kanal gesendet und 
unmittelbar danach ein (kurzer) CQ-Ruf auf der RUN-Seite. 

Anmerkung DM3ML: Und wundern Sie sich als Rosinenpflücker im Contest nicht 
über das merkwürdige Verhalten dieser und jener Station… 

8. Mauszuordnungen (Mouse Assignments)

• Linke und rechte Maustaste  
o Wenn Sie auf eine freie Stelle in einem der Logeingabefenster klicken, 

können Sie den RX-Fokus in dieses Fenster setzen 

9. Das SO2R-Menü im Configurer (SO2R menu (under Config))

• SO2R 
o Dueling CQ's Ctrl+B : Sendet abwechselnd CQ auf beiden 

Transceivern 
o TX Lockout : Stellt die TX-Sperre (Lockout) ein (gilt nur für die 

Digmodi) 
 Multi-TX : Voreinstellung. A und B können beide gleichzeitig 

senden (kein Lockout) 
 First one wins (der Erste gewinnt) : Startet CQ auf Tcvr A > 

Pause > CQ auf Tcvr B. Das für Tcvr B ausgelöste CQ wird 
ignoriert, weil Tcvr A schon aktiv ist.  

 Last one wins (der Letzte gewinnt): Starte CQ auf Tcvr A > 
Pause > Starte CQ auf Tcvr B. Das CQ auf Tcvr A wird 
abgebrochen, das CQ auf Tcvr B wird gesendet. 

 Toggle SO2R mode Ctrl+I (Schalte den SO2R-Modus mit 
Ctrl-I um) : Schaltet zwischen den möglichen SO2R-Modi, die 
vom Programm unterstützt werden, um. Die aktuelle SO2R-
Mode wird in der Statusleiste des Logeingabefensters angezeigt. 

 Hinweis: Ctrl+I  ist nur in der '$5 SO2R' –Mode wirksam, 
wenn N1MMLogger den NF-Weg über die Soundkarte(n) 
steuert. Es funktioniert nicht bei der Verwendung eines 
externen SO2R-Kontrollers. 

 SO2R mode: Manual: Die NF wird mit dem Fokus 
zwischen den beiden Fenstern umgeschaltet

 SO2R mode: Auto 
 Run radio = TX : Sie hören die S&P-NF in 

beiden Ohrmuscheln 
 Run radio = RX : Sie hören das linke Radio 

in der linken und das rechte in der rechten 
Ohrmuschel 

 SO2R mode: One-Rig Auto : Sie hören jeweils die 
NF des nicht sendenden Transceivers in beiden 
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Ohrmuscheln. D.h. wenn der RUN-Tcvr sendet, 
hören Sie die NF des S&P-Tcvrs und wenn der 
RUN-Tcvr auf Empfang schaltet, hören Sie wieder 
die NF des RUN-Tcvrs. 

10. Programmeinstellung (Software Setup)

So stellen Sie den SO2R- und SO2V-Modus über den Configurer ein:  

• Gehen Sie zu Config > "Configure Ports, Telnet Address, Other" > 
Karteikarte Hardware 

SO2R:

• Konfigurieren Sie die Transceiver
• Stellen Sie die Tastung ein (LPT 

oder Winkey)
• Klicken Sie auf die Taste SO2R
• Stellen Sie die Boxen für den linken 

und den rechten Transceiver ein
• Klicken Sie auf OK
• Stellen Sie N1MMLogger für den 

aktuellen Contest ein
• Wird das zweite Logeingabefenster 

nicht angezeigt, drücken Sie die 
Taste \

• SO2R: 1 Computer-Transceiver+1 
manuell gesteuerten Transceiver 
(=zwei Transceiver)

• SO2V : 1 Computer-Transceiver mit 
2 VFOs (= ein Transceiver)

SO2V:

• Konfigurieren Sie die Transceiver
• Stellen Sie die Tastung ein (LPT 

oder Winkey)
• Klicken Sie auf die Taste SO2V
• Klicken Sie auf OK. Um das Config-

Fenster zu schließen
• Stellen Sie N1MMLogger für den 

aktuellen Contest ein
• Wird das zweite Logeingabefenster 

nicht angezeigt, drücken Sie die 
Taste \

Gewählter 
Modus

Angeschlossene 
Transceiver Wahlmöglichkeiten Auswahl

SO2R keine SO2R : Links manuell, rechts 
manuell 

Wird 
automatisch 

gewählt

SO2R 1
(Kenwood)

SO2R: Links manuell, rechts 
Kenwood an COM1
SO2R : Links Kenwood an 
COM1, rechts manuell 

Wählen Sie eine

SO2R 2
(Kenwood & FT847)

SO2R: Links Kenwood an 
COM1, rechts FT847 an COM2
SO2R : Links FT847 an COM1, 
rechts Kenwood an COM2 

Wählen Sie eine

SO2V 1
(Kenwood) SO2V : Kenwood 

Wird 
automatisch 

gewählt
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10.1. CW-Tastung über die LPT-Schnittstelle (LPT keying)

Wenn Sie im SO2V-Modus arbeiten und die CW über die LPT-Schnittstelle tasten, 
muss die Radio Nr auf Both gesetzt werden.

Wenn Sie im SO2R-Modus arbeiten und eine einzelne LPT-Schnittstelle für die CW-
Tastung verwenden, muss die Radio Nr in der LPT-Konfiguration auf Both gesetzt 
werden. Sie benötigen dann eine externe Umschalteinrichtung für die Tastleitung, die 
über das Pin 14 an der LPT-Schnittstelle gesteuert wird. 

Wenn Sie im SO2R-Modus arbeiten und getrennte LPT-Schnittstellen für jeden 
Transceiver verwenden, muss die Radio Nr in den dazu gehörenden LPT-
Schnittstellen auf Radio 1 bzw. Radio 2 gesetzt werden. 

10.2. CW-Tastung über Winkey und Winkey USB (Winkey and 
WinkeyUSB keying)

Wenn Sie im SO2R-Modus arbeiten und Winkey verwenden, muss die Radio Nr in 
der Konfiguration der Winkey-COM-Schnittstelle auf Both gesetzt werden. Sie 
benötigen ein externe Umschalteinrichtung, die vom Pin 14 der LPT-Schnittstelle 
gesteuert wird.

Wenn Sie im SO2R-Modus arbeiten und den zweiten CW-Ausgang von Winkey 
benutzen, muss die Winkey-COM-Einstellung auf Radio Nr = Both gesetzt werden.

11. Unterstützung der Transceiver unter SO2R (SO2R Radio Support)

Sie können alle Transceiver unter SO2R mit N1MMLogger verwenden. Falls Sie 
einen Transceiver ohne CAT-Steuerung verwenden, stellen Sie für ihn KEINE COM-
Schnittstelle ein. Richten Sie nur für Transceiver mit CAT-Steuerung eine COM-
Schnittstelle ein. 

12. Verwendung externer SO2R-Kontroller (Using External SO2R 
controllers)

N1MMLogger ist kompatibel mit den meisten Hardware-SO2R-Kontrollern, die die 
LPT-Schnittstelle verwenden, wie der Top Ten Devices "DX Doubler" und der Array 
Solutions (von WX0B) "SO2R Master". Diese Geräte übernehmen automatisch die 
CW-Tastung, PTT-Steuerung und die NF-Leitungen jedes Transceivers, Neue 
Produkte wie der microHAM MK2R können voll über USB oder via LPT gesteuert 
werden. Der Ezmaster von Ham Radio Solutions kann nur über die LPT und nicht 
über USB gesteuert werden. 

Zum Anschluss an die LPT-Schnittstelle benötigen Sie ein gerade durchgeschaltetes 
DB-25-Kabel. Informieren Sie sich im Handbuch dieser Produkte über den 
Anschluss. Alle Produkte verwenden die gleiche Steckerbelegung an der LPT-
Schnittstelle. 

DX Doubler und SO2R Master haben eine Voreinstellung für die Programme 
"CT/TR/Writelog" und "NA". NA hat eine etwas abweichende Steuerung. Zur 
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Verwendung unter N1MMLogger müssen Sie die Einstellung für "CT/TR/Writelog" 
verwenden. 

Um die Geräte unter N1MMLogger korrekt verwenden zu können, müssen Sie 
folgende Einstellungen vornehmen:  

12.1. Tastung eines externen SO2R-Kontrollers über die LPT-
Schnittstelle ( LPT Keying with external SO2R controllers 
using LPT port):

• Gehen Sie zu Config >Configure Ports, Telnet Address, Other  
>Karteikarte Hardware  

• Wählen Sie nur eine LPT keying box  
• Klicken Sie auf die Taste "Set" für diese LPT-Schnittstelle 
• Stellen Sie Radio Nr = Both ein 
• Schließen Sie das Fenster mit einem Klick auf die Taste OK. 

 Modifikation des DX Doubler 
Es gibt mehrere Fehler auf der Leiterplatte des DX-Doublers. Gehen Sie zu 
http://www.qth.com/topten/appnotes.htm und informieren Sie sich über 
Modifikationen. 

12.2. . CW-Tastung über Winkey und Winkey USB (Using Winkey 
and WinkeyUSB)

Der ursprüngliche  WinKey verwendet zum Anschluss eine RS-232-COM-
Schnittstelle.  WinKey tastet über den internen Pin 3 den Transceiver 1 und über den 
internen Pin 5 normalerweise die PTT für einen einzelnen Transceiver. Unter 
Steuerung durch N1MMLogger kann Pin3 für die CW-Tastung von Transceiver 1 und 
Pin5 für den Transceiver 2 verwendet werden. Die für Winkey verwendete 
Schnittstelle muss auf Radio Nr = Both eingestellt werden und auf der Einstellung 
für Winkey ist die Funktion von Pin 5 auf "2nd CW" vorzunehmen. 

Der Ausgang "K" auf der Winkey-Leiterplatte geht an Transceiver 1 und der Ausgang 
"P" geht an Transceiver 2. N1MMLogger übernimmt die Umschaltung der CW-
Tastung an den jeweiligen Transceiver. 

Der neue WinkeyUSB, auch als "Winkey 2" bezeichnet hat getrennte Ausgänge für 
die CW- und die PTT-Leitungen. Die CW für den zweiten Transceiver ist als "Use 
2nd Output" auf der Karteikarte Winkey einzustellen. 

13. SO2R mit dem DX Doubler DXD (SO2R Using the DX Doubler)

13.1. Interne DXD-Jumper (Internal DXD Jumpers)
Internal DX Doubler Jumpers
Operating

Mode
Jumper

1
Jumper

2
Jumper

3
Normal 1-2 4-5 8-9
Stereo 1-2 5-6 8-9
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Der Normal Mode ist die Einstellung für CT/TR/WriteLog. N1MMLogger verwendet 
die gleichen Konventionen wie CT/TR/WriteLog. Allerdings wird im DXD-Handbuch 
nicht darauf hingewiesen. 

13.2. Möglichkeiten mit DXD&STEREO (DXD & STEREO Feature)

Der STEREO-Modus wird vom Top Ten Devices DX Doubler verwendet. Er 
funktioniert möglicherweise auch mit anderen SO2R-Kontrollern, wenn das Pin5 der 
LPT-Schnittstelle zur Umschaltung der NF-Leitungen zwischen den Transceivern 
verwendet wird. 

Der STEREO-Modus lehnt sich an die NA-Stereo-Möglichkeit, bei der über ein 
Tastaturkommando zwischen dem RUN-Transceiver in beiden Ohrmuscheln und 
dem linken Transceiver im linken Ohr und dem rechten Transceiver im rechten Ohr 
umgeschaltet werden kann. Die Umsteuerung geschieht über das Pin5 der LPT-
Schnittstelle.  

Um die STEREO-Möglichkeit mit dem DX Doubler zu verwenden, muss der DXD wie 
für CT/TR/Writelog mit Ausnahme des JUMPER 2 konfiguriert werden. Setzen Sie 
den JUMPER 2  von den PINS 4-5 um auf die PINS 5-6. Diese Konfiguration schaltet 
die Leitung von LPT-Pin 5 auf die Logik des DXD. Wenn der Schalter der DXD 
AUDIO-Steuerung auf  "Auto" gesetzt wird, wird die STEREO-Funktion mit der 
Taste Tilde ~ oder der Taste `  ein- oder ausgeschaltet. 

 DXD's Stereo-Möglichkeit freischalten 
Steht der DXD-Audio-Schalter auf PTT ist die STEREO-Möglichkeit ausgeschaltet 
und der DXD arbeitet normal im PTT-Modus. 

Die Einstellung Stereo "ON" schaltet die NF so: Radio-A/linkes Ohr, Radio-B/rechtes 
Ohr.  Stereo "OFF" bedeutet RUN-Transceiver auf beiden Ohren.  

TILDE-
Umschaltung

DXD Audio 
Mode RUN-Transceiver S&P-Transceiver

"NA" mode OFF AUTO
Beide Ohren

(TX-Fokus beim RUN-
Tcvr)

Beide Ohren
(TX-Fokus beim S&P-

Tcvr) 
"NA" mode ON AUTO Linkes Ohr Rechtes Ohr
Auto/PTT OFF PTT Linkes Ohr Rechtes Ohr

Auto/PTT ON PTT
Beide Ohren

(TX-Fokus beim RUN-
Tcvr)

Beide Ohren
(TX-Fokus beim S&P-

Tcvr)

N1MMLogger hat diese STEREO-Möglichkeit durch die Macros {STEREOON} {END} 
{STEREOOFF} erweitert. Diese Macros können in die F-Tasten eingebaut werden 
und von dort die Umschaltung nach den Wünschen des Operators automatisieren. 
Informieren Sie sich Macro-Kapitel über die Anwendung.  Trotz der Macros können 
Sie die Kanäle von Hand über die Tilde umschalten. Mit der nächsten F-Taste und 
einem STEREO-Macro wird der programmierte Status wieder hergestellt. 

Beispiel für ein  F1 – CQ: {STEREOON} CQ TEST * * TEST {END} {STEREOOFF} 

11.04.2010



N1MM-Contest Logging Software Seite 300 von 470 Übersetzung der Hilfe von Eike, DM3ML

14. Soundkartenoptionen (Sound Card options)

Für die Beschaltung und Verwendung der Soundkarten werden die  Optionen 1 bis 4 
vorgestellt und erläutert.

Option 
# Tcvr 

WAV
Dateien
senden 

Neue WAV-
Dateien
aufzeichnen 

MIC 
stumm
schalten 

Aufgezeichnet 
wird 

Kopfhörer
umschalten 

CD/Aux-
Kabel
benötigt

Kommentar

1 1 Ja Ja Ja Beide Kanäle Nein Nein Normale Ein-
Tcvr-Einstllg.

2 2 Ja Ja Ja Ein Kanal für 
jeden Tcvr Nein Nein

Externe 
Umschaltung 
benötigt

3 2 Ja Ja Ja Ein Kanal für 
jeden Tcvr

Nur
CW/Digi Ja

Externe 
Umschaltung 
für SSB 
benötigt

4 2 Ja Ja Ja Beide Kanäle Alle Modi Ja $5 SO2R

Mit zwei Soundkarten oder der $5 SO2R-Variante kommen Sie billig zu SO2R. Sie 
benötigen in Ihrem PC eine zweite billige $5-Soundkarte und ein paar Leitungen zu 
den Transceivern. Ernsthafte Anwender sollten aber eine externe 
Umschalteinrichtung vorsehen, die auch die gegenseitige Verriegelung realisieren 
kann.  

14.1. Soundkartenoption #1: Keine oder eine Soundkarte, ein 
Transceiver, kein SO2R über die Soundkarte (Sound Card 
Option #1: Zero or Single Card, One radio, No Sound Card 
SO2R)

Die Option mit einer Soundkarte und einem Transceiver gibt WAV-Dateien wieder, 
zeichnet neue WAV-Dateien auf und schaltet das Mikrofon stumm, wenn eine WAV-
Datei gesendet wird. Wählen Sie auf der Karteikarte Audio die Einstellung  '1 -  
Single Card - One radio, No Sound Card SO2R'  und füllen Sie den oberen Teil 
des angebotenen Dialogs aus. Der Sound ist zentriert und nicht einem Radio-Kanal 
zugeordnet.  
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14.2. Soundkartenoption #2: Eine Soundkarte, zwei Transceiver, 
kein SO2R über die Soundkarte (Sound Card Option #2: 
Single Card - Two radio, No Sound Card SO2R)

Kein SO2R, aber zwei Transceiver und eine Soundkarte. Beide Transceiver senden 
die WAV-Dateien und ihre NF wird aufgezeichnet. Wählen Sie auf der Karteikarte 
Audio die Einstellung '2 - Single Card - Two radio, No Sound Card SO2R' und 
füllen Sie den oberen Teil des Dialogs aus.  

 

14.3. Soundkartenoption #3: Eine Soundkarte, zwei Transceiver, 
SO2R nur für CW (Sound Card Option #3: Single Card - Two 
radio, Sound Card SO2R, CW Only)

Wählen Sie auf der Karteikarte Audio die Einstellung '3 - Single Card - Two radio,  
Sound Card SO2R, CW Only'. Füllen Sie den Dialog oben und unten im Fenster 
aus. Die Option sendet in SSB die WAV-Dateien, zeichnet die NF beider Transceiver 
auf und tastet das Mikrofon stumm. In CW wird die NF zwischen den beiden 
Transceivern umgeschaltet. 
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Sie können SO2R mit einer Soundkarte machen. Der Nachteil ist, dass die Kopfhörer 
nicht umgeschaltet werden. Sie benötigen ein extra Kabel, um den zweiten Tcvr-NF-
Ausgang an den Aux/CD-Eingang der Soundkarte anzuschließen.  
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In diesen Beispiel wird Option #3 konfiguriert. Den Windows-Mixer für die Soundkarte 
müssen Sie wie im Bild unten einstellen.

  

Die Haken für die Stummschaltung und die Balance-Regler ändern sich während 
eines CQ-Ruf, anschließend kommen Sie wieder zurück in die dargestellte Position.  
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14.4. Soundkartenoption #4: Zwei Soundkarten, zwei Transceiver, 
Soundkarten-SO2R (Sound Card Option #4: Dual Cards - Two 
radio, Sound Card SO2R)

Dank an David, K1TTT, der das benötigte Interface mit zwei billigen Soundkarten 
entwickelt hat. Sehen Sie sich das Bild an und sie werden finden, dass alles sehr 
einfach ist. Sie benötigen ein Kabel für den Aux/CD-Eingänge einer der Soundkarten. 
Wählen Sie auf der Karteikarte Audio die Einstellung '4 - Dual Cards - Two radio,  
Sound Card SO2R' on the 'Audio' tab. Füllen Sie den oberen und den unteren Teil 
des Dialogs aus.  

 

CW : Ja, es funktioniert auch für CW. CW ist nur nicht extra angegeben, da Ihnen die 
Lösungen bereits bekannt sind. Sie können separate COM-Schnittstellen, eine 
Parallel-Schnittstelle oder den USB-Anschluss verwenden, das gleiche gilt für die 
PTT-Tastung. Sie können mit Pin14 der LPT-Schnittstelle ein externes Interface 
umschalten. Die Kopfhörer werden für beide Modi genutzt.  

RTTY : Für RTTY wurden bisher keine Lösungen angegeben.
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Mode 
INPUT
Keyboard
Focus 

INPUT
CQ
Playing 

INPUT
Dual 

OUTPUT
SndCard
Left
Input 

OUTPUT
SndCard
Right
Input 

OUTPUT
Radio
Left
Dual 

OUTPUT
Radio
Right
Dual 

OUTPUT
Audio
Left
Ear 

OUTPUT
Audio
Right
Ear

Auto Left None Off Left Right Off Off L-main R-main
- Left Left Off/R-on? Mute Center Off Off/Note 1 R-main R-main/sub?
- Left Right Off/L-on? Center Mute Off/Note 1 Off L-main L-main/sub?
- Right None Off Left Right Off Off L-main R-main
- Right Left Off/R-on? Mute Center Off Off/Note 1 R-main R-main/sub?
- Right Right Off/L-on? Center Mute Off/Note 1 Off L-main L-main/sub?

One rig auto Left None Don't care Center Mute NC NC L-main L-main/sub?
- Left Left Don't care Mute Center NC NC R-main R-main/sub?
- Left Right Don't care Center Mute NC NC L-main L-main/sub?
- Right None Don't care Mute Center NC NC R-main R-main/sub?
- Right Left Don't care Mute Center NC NC R-main R-main/sub?
- Right Right Don't care Center Mute NC NC L-main L-main/sub?

Manual Left Don't care Don't care Center Mute NC NC L-main L-main/sub?
- Left Don't care Don't care Center Mute NC NC L-main L-main/sub?
- Left Don't care Don't care Center Mute NC NC L-main L-main/sub?
- Right Don't care Don't care Mute Center NC NC R-main R-main/sub?
- Right Don't care Don't care Mute Center NC NC R-main R-main/sub?
- Right Don't care Don't care Mute Center NC NC R-main R-main/sub?

NC : keine Änderung der vorgegebenen Einstellung 

Hinweis 1: Sie können ‘dual’ am nicht-CQ-rufenden Transceiver nutzen, wenn CQ 
auf dem anderen Transceiver gerufen wird, müssen es aber abschalten, wenn das 
CQ beendet wird, um zum Stereo-Empfang zurückzukehren. Sie können diese 
Variante auch beim Dueling-CQ in ruhigen Zeiten z.B. auf 20m und 40m verwenden, 
wenn Sie mit beiden VFOs auf 40m hören wollen.

15. Vom LPT gesteuerter SO2R-Kontroller (LPT port basic SO2R 
controller design)

Die Schaltung zeigt eine einfache Variante für einen SO2R-Kontroller. Er arbeitet 
zusammen mit N1MMLogger oder  Writelog im LPT-Modus zusammen. Ich habe 
eine Umschaltung für die CW-Tastung mit der LPT-Schnittstelle vorgesehen. Sie 
sollten aber besser einen WinKeyUSB verwenden (

Joe, W4TV - 5/30/2009 - Revision 1.0 
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15.1. Empfangsumschaltung (Basic SO2R LPT port - Receive 
Interface)

 

SO2R LPT Receive interface 

15.2. Sendeumschaltung (Basic SO2R LPT port - Transmit Interface)

SO2R LPT Transmit interface 

 

16. Erweitertes SO2R (Advanced SO2R)

Das erweiterte SO2R ist ein leistungsfähiges Werkzeug für SO2R-Operateur und es 
ist neu bei N1MMLogger. Es kann alternativ zu der FocusOther-Möglichkeit genutzt 
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werden. Es setzt den RX-Fokus automatisch dorthin, wo der SO2R-Operator ihn 
logisch benötigt. Die beiden Hauptszenarien des erweiterten SO2R sind:  

Das Abstimmen am S&P-Transceiver setzt den RX-Fokus dann, wenn Sie beim Multi 
suchen sind, auf den S&P-Transceiver. Wenn der RUN-Transceiver seinen CQ-Ruf 
beendet hat, wird der Fokus wieder auf den RUN-Transceiver gesetzt. 

Regeln für den Fokus beim erweiterten SO2R-Betrieb
SO2R-Regel Betriebsverhalten

Erweiterter 
SO2R-Regel #1

Drehen Sie an einem der Transceiver, wird der Fokus auf diesen 
Transceiver gesetzt, zusätzlich müssen beide Rufzeichenfelder 
leer sein 

Erweiterter 
SO2R-Regel #2

Der RX-Fokus wird auf den RUN-Tcvr gesetzt, wenn er sein CQ 
oder den F-Text gesendet hat, wenn in das Eingabefenster des 
S&P-Transceivers nichts eingetragen worden ist

Focus Anti-
Bounce

(FaB)
(Fokuspuffer)

Nachdem CQ oder F-Text auf dem RUN-Tcvr gesendet worden 
sind und der Fokus auf den RUN-Tcvr gesetzt wurde, kann der 
S&P-Tcvr erst nach 1000ms wieder den Fokus übernehmen 
passed

16.1. Theorie des erweiterten SO2R-Betriebs (Advanced SO2R 
Theory of Operation)

Der erweiterte SO2R-Betrieb wechselt den RX-Fokus nur dann, wenn in keinem der 
beiden Rufzeichenfelder ein ganzes oder teilweises Rufzeichen eingetragen worden 
ist. Ist so ein Rufzeichen eingetragen, wird angenommen, dass der OP dort ein QSO 
komplettieren will und der Fokus bleibt auf dieser Seite. 

Ausgangsszenario: Sie rufen CQ auf Tcvr/VFO A und suchen im S&P-Modus auf 
Tcvr/VFO B nach Multis. Das erweiterte SO2R setzt den Fokus auf den S&P-Tcvr 
und Sie können ein Rufzeichen in das zugehörige Rufzeichenfeld eintragen um zu 
sehen, ob es benötigt wird. Das CQ ist zu Ende und wenn kein Rufzeichen im Feld 
des S&R-Tcvrs steht, wird der Fokus auf den RUN-Tcvr in der Hoffnung, dass 
jemand angerufen hat, gesetzt. Erfolgt keine Antwort und haben Sie am S&P-Tcvr 
weiter gedreht, wird der Fokus nach 1000ms wieder auf den S&P-Tcvr gesetzt. 

Wenn Sie jetzt ein Rufzeichen in das S&P-Eingabefeld eintragen, bleibt der Fokus 
dort und Sie können das QSO am S&P-Tcvr abwickeln. Ruft inzwischen eine Station 
am RUN-Tcvr an, liegt es in Ihrer Hand, ob Sie das S&P-QSO beenden wollen oder 
den Anruf am RUN-TCVR entgegen nehmen. Schalten Sie dann mit der Backslash-
Taste \ den Fokus um. Diese Umschaltung kann auch mit dem Macro {JUMPRX} von 
einer Seite auf die andere automatisiert werden.  

Wenn jemand auf einen CQ-Ruf am RUN-Radio antwortet, der Fokus hierher schon 
zugeschaltet ist und Sie das Rufzeichen der anrufenden Station in das 
Rufzeichenfeld des RUN-Tcvrs eingetragen haben, bleibt der Fokus bis zum Ende 
des QSOs dort. Wenn Sie jetzt am VFO des S&P-Tcvrs drehen, während Sie die die 
Station am RUN-Tcvr arbeiten, bleibt der Fokus beim RUN-Tcvr, da davon 
ausgegangen wird, dass Sie das RUN-QSO nicht unterbrechen wollen. Wenn das 
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RUN-QSO abgeloggt ist, springt der Fokus wieder zum S&P-Tcvr solange nichts im 
Rufzeichenfeld des RUN-Tcvrs steht.

Fokuspuffer (Focus anti-Bounce (FaB)): Der Puffer wurde eingebaut, um dem 
seriösen SO2R-OP die Möglichkeit zu geben, auf dem S&P-Tcvr zu hören und 
gleichzeitig mit dem RUN-Tcvr zu senden. In der Regel ist der Mithörton am RUN-
Tcvr während des Sendens abgeschaltet und der OP muss nach Ende eines CQ-
Rufs am RUN-Tcvr hören können, ob eine Station anruft. Aus diesem Grund wurde 
der 1000ms-lange Fokuspuffer eingebaut, der den Fokus für diese Zeit beim RUN-
Tcvr lässt, auch wenn gleichzeitig am S&P-Tcvr abgestimmt wird und dieser 
versucht, den Fokus auf sich zu ziehen. Der OP muss während dieser Pufferzeit das 
ganze oder wenigstens einen Teil des Rufzeichens der anrufenden Station in das 
Fenster des RUN-Tcvr eintragen, um den Fokus dort festzuhalten.

16.2. Macros und Steuerung für den erweiterten SO2R-Betrieb 
(Advanced SO2R Controls and Macros)

SO2R-Macro Ergebnis

ON/OFF Macro Sie können den erweiterten SO2R-Betrieb mit den Macros 
{ADVSO2RON} {ADVSO2ROFF} in F-Tasten ein/ausschalten

ON/OFF Kurzruf Ctrl+Shift+I schaltet den erweiterten SO2R-Betrieb ein/aus

RX Focus Control
(Override)

Der Backslash (\) schaltet den Fokus immer auf die jeweils 
andere Seite. Der Fokus bleibt bis zum nächsten 
Umschaltkommando dort.

Einstellbare 
Verzögerung  Mit CTRL+SHIFT+N können Sie die Fokuspufferzeit einstellen

FocusOther Mit Ctrl+Shift+K wird auf den Modus Focus Other umgeschaltet

REGEL: Die Betätigung der Abstimmung an einem der VFOs/Tcvr holt den Fokus 
auf diese Seite, so lange nichts im Rufzeichenfeld des Logeingabefensters steht. 

Rufzeichen-
Feld A

Kontroll
nummern-

Feld A Aktion
Rufzeichen-

Feld B
Kontroll

nummern-
Feld B Aktion Fokus

Abstimmen 
A

Fokus 
wechselt 
zu A

Ausgefüllt Abstimmen 
B

Fokus 
bleibt bei 
A

Ausgefüllt Abstimmen 
B

Fokus 
bleibt bei 
A

Abstimmen 
B

Fokus 
wechselt 
zu B

Abstimmen 
A

Ausgefüllt Fokus 
bleibt bei 
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B

Abstimmen 
A Ausgefüllt

Fokus 
bleibt bei 
B

17. SO2R und MMTTY (SO2R and MMTTY)

Einstellung von zwei Kopien von MMTTY für die Nutzung im SO2R-Betrieb: 

• Installieren Sie MMTTY in zwei separaten Verzeichnissen. Sie können zwei 
verschiedene Profile einrichten.  

• Wechseln Sie in beide Verzeichnisse und starten Sie MMTTY. 
• Gehen Sie zu Options>Setup MMTTY>Karteikarte Misc . 
• Geben Sie für das erste MMTTY die erste Soundkartennummer (ID) zwischen 

0…3 ein, verwenden Sie NICHT die ‘-1’ (=Windows-Standard) 
• Verwenden Sie für die zweite Kopie von MMTTY die Nummer der zweiten 

Soundkarte 0..3 (nicht -1). 
• Schließen Sie die beiden MMTTY. Die Profile werden abgespeichert. 
• Starten Sie N1MMLogger und gehen Sie zu Configure>Karteikarte Hardware 

und geben Sie COM-Schnittstellen für Digital an. 
• Setzen Sie auf der Karteikarte  Digital beide Interfaces auf je eine MMTTY-

Kopie mit vollständigem Verzeichnispfad 
• Speichern Sie die Einstellung und schließen Sie Konfiguration. 
• Wenn Sie jetzt das Digital Interface starten, werden Sie aufgefordert, auch 

das zweite Interface zu starten. Die zweite COM-Schnittstelle, die Sie 
eingerichtet haben, schaltet die PTT für das zweite MMTTY-Interface. 

17.1. SO2R-RTTY mit einer Soundkarte ( SO2R RTTY with 1 sound 
card)

Sie können versuchen, die beiden Kanäle einer Soundkarte für die getrennte 
Dekodierung von RTTY verwenden. Tragen Sie dann die gleiche 
Soundkartennummer ein, aber bei dem einen MMTTY-Interface den rechten und bei 
dem anderen den linken Kanal. Gesendet wird bei AFSK die gleiche Information auf 
beiden Kanälen, aber bei SO2R wird jeweils nur eine PTT-Leitung aktiviert. Sie 
müssen eine spezielle Y-Leitung bauen und den linken Kanal zu dem einen 
Transceiver und den rechten Kanal zu dem anderen Transceiver führen.

Ob diese Einstellung funktioniert, hängt von der verwendeten Soundkarte ab. Testen 
Sie, ob MMTTY eine Kanaltrennung realisiert. Falls nicht, haben Sie Pech gehabt.  

11.04.2010



N1MM-Contest Logging Software Seite 310 von 470 Übersetzung der Hilfe von Eike, DM3ML

18. Beispiele für Schirmanordnungen (Example screen layouts)

Sie sehen zwei Bildschirmfotos für den SO2R-Betrieb. Beachten Sie die 
symmetrische Anordnung der beiden VFOs links und rechts. Für beide VFOs 
wichtige Angaben stehen in der Mitte, wie das Prüf- und das Logfenster. Sie haben 
die freie Wahl der Fensteranordnung, sollten aber den Bezug zur Hardware links und 
rechts auch auf dem Bildschirm berücksichtigen. 

 

Die Aufnahme oben stammt von K2KW mit einem 17"-Monitor. 
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Diese Aufnahme machte F6IRF und zeigt einen SO2R-Bildschirm mit RTTY. 

Last Modification: 20 December 2009 11:36:04 EST by n4zr. 
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Dämmerungslinien-Programm (Grayline program)
Das Programmpaket von N1MMLogger enthält ein Dämmerungslinien-Programm. Es 
läuft getrennt von N1MMLogger und kann unabhängig davon gestartet oder 
geschlossen werden. Sie können es über das Menü im Logeingabefenster starten. 

 

 

1. Menüs mit der rechten Maustaste (Right Click Menu Selections)

• Grayline contrast (Hell/Dunkel-Kontrast)
o Mit einem Schieberegler können Sie den Unterschied zwischen dem 

hellen und dem dunklen Bereich einstellen. 
• Show my Location (Zeige meinen Standort): Der Standort wird der Einstellung 

der Stationsdaten unter N1MMLogger entnommen. 
• Show Meridian Lines (Anzeige des Gradnetzes) 
• Sun (Sonnensymbol) 

o Show Sun (Anzeige der Position der Sonne)  
o Small sun : kleine Sonne 
o Medium Sun : mittelgroße Sonne 
o Large Sun : große Sonne 

• Breite der Dämmerungszone in Grad 
o Civil terminator (zivile Dämmerung): 6º 
o Nautical terminator (nautische Dämmerung): 12º 
o Astronomical terminator (astronomische Dämmerung):  18º 

 Hinweis 
Das Dämmerungslinienprogramm wurde nicht vom N1MMLogger-Team geschrieben. 
Änderungen und Fehlerbehebung fallen nicht sein Aufgabengebiet. 

Mitunter verschwindet das Bild vom Bildschirm. Dieser Effekt kann durch Fehler in 
der Einstellungsdatei *.ini des Dämmerungslinienprogramms hervorgerufen werden 
(QTH.txt). Tritt dieses Problem bei Ihnen auf, können Sie diese beide Möglichkeiten 
probieren:  

1. Klicken Sie rechts auf das Programm-Icon in der Statusleiste und wählen Sie 
"Move" (falls "Move" grau gefärbt ist, verwenden Sie zuerst "Restore" und dann 
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"Move"). Drücken Sie auf eine der Pfeiltasten der Tastatur. Bewegen Sie den 
Mauszeiger bis das Fenster wieder erscheint und schieben Sie es an die gewünschte 
Stelle. Legen Sie es mit einem Linksklick dort fest. 

oder 

2. Öffnen Sie die Datei QTH.txt mit einem Texteditor und löschen Sie die beiden 
ersten Zeilen. Nach dem Neustart des Dämmerungslinien-Programms erscheint es 
an der voreingestellten Position und Sie können es nach Ort und Größe dorthin 
schieben, wohin Sie es haben wollen.  

Last Modification: 10 December 2009 05:22:48 EST by n4zr. 

Rotorsteuerung (Rotor Control)

Die Rotorsteuerung unter N1MMLogger wird realisiert durch  

• Externe Programme 
o N1MM rotor (kommt mit N1MMLogger) 
o LP rotor (Freeware von Larry Phipps - N8LP) 

• Externe Hardware 
o ARSWIN by EA4TX 

Die Rotorsteuerung geschieht über verschiedene Wege:  

• Logeingabefenster 
o Eingabe der Beamrichtung zwischen 0 und 360 in das Rufzeichenfeld 

und Abschluss mit  Alt+J.  Beispiel: 234 Alt+J dreht den Beam auf 
234° 

o Menü Tools: entweder Rufzeichen im Rufzeichenfeld oder – wenn leer 
– Rufzeichen über dem Rufzeichenfeld

 Turn Rotor Alt+J : Dreht den Rotor auf die zum Rufzeichen 
gehörende Gradzahl  

 Stop Rotor Ctrl+Alt+J : Rotor anhalten 
o Kurzrufe über die Tastatur: entweder Rufzeichen im Rufzeichenfeld 

oder – wenn leer – Rufzeichen über dem Rufzeichenfeld
 Alt+J :  Dreht den Rotor auf die zum Rufzeichen gehörende 

Gradzahl  Richtung SP 
 Alt+L : Dreht den Rotor auf die zum Rufzeichen gehörende 

Gradzahl  Richtung LP
 Ctrl+Alt+J : Stoppt den Rotor 

• Bandskala:  Rechtsklick auf einen DXSpot und Wahl von 'Turn Rotor' im 
Menü 

• Angebotsfenster (Available Mult's and Q's window): Rechtsklick auf einen 
DXSpot und Wahl von 'Turn Rotor' im Menü 

Hinweise:

• Bei einem Rufzeichen mit weniger als drei Zeichen im Rufzeichenfeld passiert 
nichts 
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• In der Statuszeile wird die angesteuerte Richtung angezeigt, z.B. Turning 
Rotor to 123° 

• Die Antennenrichtung ergibt sich normalerweise aus dem in der Datei cty.dat 
hinterlegten angenäherten Zentrum eines Landes/Gebiets der Gegenstation. 
Ist bei einem Contest der Standort der Gegenstation als WWLokator bekannt, 
wird dieser zur Berechnung der Antennenrichtung verwendet. 

1. Grundlagen der Rotorsteuerung (Rotor Control Basics)

N1MMRotor kann bis zu 16 Rotoren je Station steuern, er steuert auch über das LAN 
angeschlossene Computer. Die Daten der zu steuernden Antennen und der diesen 
Antennen zugeordneten Rotoren sind in der Karteikarte Antenna eingetragen. 
N1MMRotor ist ein externes Programm und kann auch allein stehend verwendet 
werden.

 

Unterstützte Rotortypen

• DCU1 : keine Stop-Taste
• M2 Orion : Geschwindigkeit wird 

rechts unten in der Statusleiste 
angezeigt

• Prosistel
• AlfaSpid
• Yaesu
• RC2800P-A
• Rotor-EZ
• AlfaSpid ROT2
• Prosistel C

Alle Rotoren bis auf den DCU1 melden 
ihre Position

Obere Leiste: Unter Tools wird der Rotor-Typ angezeigt und hinter @ die aktuelle 
Antennenrichtung. In der Menüleiste werden die Menüs File, Tools und Help 
angeboten. 

Die großen Ziffern zeigen die aktuelle Rotorposition an. Ein eingestellter Offset 
erscheint in kleinen Ziffern rechts von der Richtungsanzeige. Rechts daneben zeigt 
eine Kompassrose ebenfalls die Antennenrichtung. Sie können diese Linie mit der 
Maus in die gewünschte Richtung ziehen, falls Ihre Rotorsteuerung so eine 
Voreinstellung unterstützt. In das Ziffernfeld können Sie die gewünschte Richtung in 
Grad eingeben. Mit einem Klick auf die Taste Turn beginnt der Rotor zu drehen. Mit 
der Taste Stop wird der Rotor angehalten. Die 10 Tasten können Sie mit 
voreingestellten Richtungsangaben belegen. Falls der Rotor seine 
Drehgeschwindigkeit meldet, wird sie in der Statusleiste angezeigt. Wenn der Rotor 
dreht, wird das Fenster unabhängig davon, ob es auf minimiert gesetzt ist, angezeigt. 

1.1. Menüs  (File Menu Selections)

• File 
o Always on Top: Das Fenster wird immer angezeigt 
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o Exit : Programm beenden
• Tools 

o Setup Rotors: Rotoren einstellen > öffnet das Menü 'Rotor Setup' 
(s.u.) 

o Set Current Antenna Offset 
 Der Antennen-Offset kann auf der Karteikarte Antennas im 

Configurer oder bei dem ausgewählten Rotor eingetragen 
werden. Der Offset wird zu der Rotorrichtungsanzeige addiert 
und ergibt die korrekte Antennenrichtung, wenn z.B. der Sturm 
die Antenne verdreht hat oder die Antenne gegenüber anderen 
um 90° montiert wurde.  

o Set Current Antenna Bidirectionality 
 Bidirektionale Einstellung für Dipole oder eine StepIR, um ein 

Drehen um 180° zu sparen 
o Calibrate Rotor : Rotorkalibrierung, nur wenn ein Rotor diese Option 

gestattet, wie der  M2 Orion 
o Prosistel C Config 

 Einstellung des Rotorstopps Nord oder Süd oder Verzögerung 
der Meldung 

o Set rotation limits 
 Einstellung der Drehgenauigkeit bei Rotoren mit 

Bremsproblemen. Dreht der Rotor von 0°bis 360° kann z.B. 10° 
und 350° eingetragen werden, über der Rotor nicht 
hinausgedreht wird. So ein Eintrag gilt für alle vom Programm 
gesteuerte Rotoren. 

o A new line for every setup rotor will be shown 
 Jede neue Zeile gilt für einen Rotor im Setup. 

• Help 
o Help : Holt die Hilfe für dieses Fenster aus dem Internet
o About : Zeigt die Version des N1MMRotor-Programms 

1.2. Tasten- und Maus-Zuordnungen (Button and Mouse 
Assignments)

• Manual entry field (Gradzahl von Hand eingeben):  Geben Sie die Richtung 
ein, in die der Rotor drehen soll. Das Drehen beginnt mit ENTER oder mit 
einem Klick auf die Taste Turn. Möglich: 0 bis 450. 

• Turn : Startet den Rotor  
• Stop oder Alt+S : Stoppt den Rotor, auch ESC stoppt den Rotor. 

o Diese Taste wird nur angezeigt, wenn der Rotor diese Funktion 
unterstützt. 

• F1 - F10 : Voreingestellte Tasten. Werden mit einem Rechtsklick darauf 
editiert. 

• Richtungstasten (Bearing buttons) (F1 - F10) 
o Linker Mausklick : Rotor wird auf die programmierte Gradzahl gedreht 
o Rechter Mausklick: Die in das manuelle Feld eingetragene Gradzahl 

wird für die Taste übernommen oder eine gewünschte Gradzahl kann 
eingetragen werden 
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Nur bei Rotoren, die ihre aktuelle Gradzahl melden, erfolgt eine Anzeige der Position 
während des Drehens. 

1.3. N1MMRotor allein stehend verwenden (Using N1MM Rotor 
Stand-Klone)

Gehen Sie in das N1MMLogger-Verzeichnis und suchen Sie nach dem Eintrag 
'N1MMRotor.exe'. Sie können das Programm auf Ihren Desktop ziehen und getrennt 
verwenden. Alle Eigenschaften des Programms werden unterstützt. 

1.4. N1MMRotor zusammen mit N1MMLogger verwenden (Using 
N1MM Rotor with the Main N1MM Logger Program)

Starten Sie N1MMRotor und stellen Sie für den Rotor die COM-Schnittstelle ein. 
N1MMLogger steuert den Rotor indem es UDP-Pakete an das Programm 
N1MMRotor schickt. Der ausgewählte Rotor wird sich drehen. Im Configurer und in 
der Einstellung des Rotors müssen die identischen Rotor Start Port /Starting UDP 
port# eingestellt sein. 

Soll N1MMRotor automatisch zusammen mit N1MMLogger zusammen gestartet 
werden, muss auf der Karteikarte Antennas im Configurer ein Haken bei 'Start  
N1MM Rotor Program' gemacht werden. Voreingestellt ist der UDP-Port 12040. Er 
kann auf der Karteikarte Antennas mit Starting UDP Port for Rotor Program 
geändert werden. Im Programm N1MMRotor muss der gleiche UDP-Port unter 
'Setup' im Menü Tools eingestellt werden.  

Zusatz: Das Rotorprogramm kann auch auf einem anderen Computer laufen, hier 
muss der gleiche Port auf beiden Seiten eingetragen sein.  

One rotor setup (Einstellung eines Rotors) : Das dürfte die normale Anwendung 
sein. Wenn in der Antennentabelle keine andere Einstellung gemacht wird, werden 
die Daten an den angewählten Rotor gesendet.  

Multiple rotor setup (Mehrere Rotoren einstellen): Hier müssen die Rotoren einer 
Antenne oder Antennengruppe zugeordnet werden: 

• Gehen Sie zum Configurer > Karteikarte Antennas 
• Machen Sie eine Zuordnung zwischen 16 möglichen Antennen und den 16 

möglichen COM-Schnittstellen für die IP-Adressen der Rotorsteuerung :
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N1MMRotor-Einstelldialog: 

 

N1MMLogger-Einstellung auf der Karteikarte Antennas (Config >Configure Ports, 
Telenet Address, Other >Antennas)
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Die COM-Schnittstellen müssen zur jeweiligen Antenne zugeordnet sein. Falls Sie 
mehr als einen COM-Port angeben, müssen Sie ihn umschalten.  

1.5. N1MMRotor läuft auf einem anderen Rechner (N1MM rotor 
running on another computer)

Nehmen wir an, dass N1MMRotor als Rotorsteuerprogramm auf einem anderen 
Rechner mit der IP-Adresse IP address 192.168.1.14 läuft und N1MMLogger auf 
dem Rechner mit der Adresse 192.168.1.10 läuft. 

• Stellen Sie sicher, dass N1MMRotor auf dem Rechner, wo es installiert ist und 
wo der Rotor angeschlossen ist, fehlerfrei läuft. 

• Verbinden Sie die Rechner über das Netz 
• Tragen Sie diese Daten in die Datei N1MMLogger.ini am Hauptrechner ein: 

o ExternalBroadcast   
o DestinationIPs=127.0.0.1 192.168.n.m 

• Der ExternalBroadcast sollte bereits vorhanden sein. Falls nicht, fügen Sie 
ihn ein. 

o 192.168.n.m sollte die IP-Adresse für den Rechner sein, an dem die 
Rotorsteuerung angeschlossen ist. 

• Starten Sie das Rotor-Programm nicht am Hauptrechner, es wird nicht 
funktionieren, weil der Rotor dort nicht direkt angeschlossen ist.  

• Steuern Sie den Rotor über die Tools-Menüs aus dem Logeingabefenster. 
Geben Sie die Richtung oder ein Rufzeichen ein und drücken Alt+J.  
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1.6. Gestockte Antenne drehen (Turning a Stack)

Im oben gezeigten Beispiel wird die gestockte 20m-Antenne 4 über COM3 und 
COM4 parallel und zur gleichen Zeit gedreht. Wollen Sie nur eine einzelne Antenne 
drehen, müssen Sie auf eine einzelne Antenne schalten und dann mit ALT+J diese 
Antenne drehen. 

1.7. Laufzeitfehler 126 (Run time error: 126)

Der Laufzeitfehler 126 kann durch einen Firewall hervorgerufen werden, der die 
UDP-Nachricht an 127.0.0.1 unterdrückt, die das Rotor-Programm informiert, 
welches Fenster aktiv ist. Wollen Sie diese Fehlermeldung unterdrücken, müssen Sie 
im Firewall entsprechend einstellen. Ein Nutzer fand, dass der Fehler durch das 
Programm "Port Explorer" hervorgerufen wurde. Als das Programm geschlossen 
wurde, war der Fehler weg. 

2. Externe Hard- und Software verwenden (Using external hardware or 
software)

Die Rotorsteuerung wird direkt durch diese Programme unterstützt: 

• ARSWIN by EA4TX 
• LP rotor (Freeware von Larry Phipps - N8LP) 

Die Links finden Sie hier. 

Starten Sie ARSWIN oder LP-Rotor und steuern Sie sie mit Alt+J, Alt+L oder 
Ctrl+Alt+L. 

Last Modification: 24 October 2009 07:51:18 EDT by K8UT. 

Unterstützte Hardware (Supported Hardware)

  

1. USB-Peripherie-Geräte unter Windows (Windows and External USB 
Peripherals)

Ein paar Worte zu den USB-Peripherie-Geräten : Windows kann nur einen "USB root 
hub" ... der in einem internen PCI-Steckplatz steckt, direkt ansprechen. Alle 
angeschlossenen "Root Hubs" werden parallel gesteuert. Wenn aber an diesen Hubs 
weitere externe USB-Geräte angeschlossen sind, bekommen Sie ähnlich wie die 
Blätter an einem Ast jeweils einen 16ms breiten Zeitschlitz. Hängen sehr viele 
„Blätter“ an einem „Ast“ kann es zu Zeitproblemen kommen, die zu 
Zeitüberschreitungen (time outs) führen können.  

Diese Zeitprobleme treten vor allem dann auf, wenn Teile des Programms eine 
Schnittstelle alle 50 bis100 msec abfragen (polling) und bis zur nächsten Abfrage 
kein Ergebnis eingetroffen ist. USB kann durchaus Übertragungsraten bis 240 MB/s 
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realisieren, aber die genannten Zeitverzögerungen können zu einem Problem 
werden, auf das ein Programm nicht vorbereitet ist.

Seien Sie auf diese Probleme vorbereitet, vor allem dann, wenn Sie zusätzliche 
externe Hubs und USB-Sticks angeschlossen haben. 

Hinweis DM3ML : Stecken Sie die zeitkritischen Anwendungen direkt an die USB-
Buchsen des Rechners und schließen Sie unkritische Anwendungen über externe 
Hubs an. 

73' Joe Subich, W4TV 

2. Green Heron Engineering Inc. - GH Everyware

N1MMLogger kann die Antennenrichtungsdaten direkt an das Programm Green 
Heron GH Everyware schicken. N1MMLogger muss so konfiguriert werden, dass es 
die Rotorinformation über das Netzwerk als UDP-Pakete verschickt. Tragen Sie 
diese Daten in die Datei N1MM Logger.ini ein. Diesbezügliche Informationen finden 
Sie in der Dokumentation zum Programm. Auf dem Rechner, an den der Rotor 
angeschlossen ist, muss der GH Everyware Server laufen. Auf jedem Rechner mit 
dem Programm N1MMLogger läuft GH Everyware (controller) und ist so eingestellt, 
dass es die UDP-Pakete von N1MMLogger empfängt. N1MMLogger kommuniziert 
mit dem GH Everyware Controller, aber nicht direkt mit dem GH Everyware 
Server. In der Datei N1MMLogger ini steht die IP-Adresse 127.0.0.1 für den 
Rechner, auf dem N1MMLogger arbeitet. In der Karteikarte Antennas ist die 
Rotornummer einzutragen. Beispiel: Mit der UDP-Adresse 12040 fängt das 
Rotorprogramm an. Für den an die Schnittstelle 11 angeschlossenen Rotor ist die 
UDP-Adresse 12051 (=12040+11) einzutragen. Starten Sie das N1MMRotor-
Programm NICHT, wenn Sie das Programm GH Everyware verwenden. 

3. Ham Radio Solutions - EZmaster

EZ Master wird an die LPT-Schnittstelle oder über USB angeschlossen und verbindet 
Ihren Rechner mit verschiedenen Interfaces wie Transceiver, Antennen, 
Filterumschaltung, Mikrofon, Kopfhörer usw. In den Sendearten PHONE, CW, RTTY, 
DIGITAL wird die Sprachausgabe (DVK), die CW-Tastung und die SO2R-Steuerung 
über USB / COM / Parallel Ports gesteuert. 

Hinweis : Nur die Umschaltung über LPT wird unterstützt (nicht USB!) (??? de 
DM3ML). 

Sie finden mehr Informationen auf der Webseite von Ham Radio Solutions . 

4. K1EL - Winkey

Winkey ist ein externer CW-Geber, der von K1EL und G3WGV entwickelt wurde. Der 
CW-Geber ist als externes Gerät oder als Schaltkreis in externen Zusatzgeräten, wie 
dem Ham Radio Solutions EZMaster, Microham Microkeyer oder dem RigExpert 
im Angebot. Ziel des Winkey-Gebers ist es, die durch die Zeitscheibenzuordnung 
unter Windows entstehenden Probleme beim Geben eines sauberen CW-Signals zu 
überwinden und unter allen Umständen eine gute Tastung sicher zu stellen. Winkey 
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wird vom jeweiligen Steuerprogramm mit ASCII-Zeichenkettten geladen, die es in 
CW umsetzt. Winkey wird über eine COM- oder eine USB-Schnittstelle gesteuert. 

Informationen zu Winkey finden Sie über diese Links. 

Um Winkey zu steuern, wählen Sie auf der Karteikarte Hardware eine Schnittstelle 
und dort unter den Setup die Option Winkey. Die eigentlichen Winkey-Eigenschaften 
werden auf der Karteikarte Winkey eingestellt: 

• Wählbare Mithörtonfrequenz 
• CT-Zeichenabstand einstellen 
• Gebegeschwindigkeit wird in der Statuszeile angezeigt 
• Vier Gebe-Modi sind wählbar: Iambic A, Iambic B, Ultimatic und Semi-

Automatic (Bug). Voreingestellt ist der Modus Iambic B 
• Winkey stoppt die Ausgabe, wenn die Taste gedrückt wird 
• Rufzeichenkorrektur wird unterstützt 
• Ausgangsbuchsen :  

o Zweiter CW-Ausgang 
o Mithörton 
o PTT 

• Winkey unterstützt die Steuerung von zwei Transceivern (2 CW-Ausgänge 
und zwei PTT-Ausgänge in ab Version 4)

• PTT-Vorlaufzeit und -Abfallverzögerung konfigurierbar 
• Wahlweise kann Gebetempo am Winkey-Potentiometer eingestellt werden

Auf der linken Seite der Statusleiste des Logeingabefensters werden diese Daten 
z.B.  angezeigt:  

• Winkey paddle speed = 32 
• Winkey Version = 10 

 Einige Winkey-Tipps 
- Betreiben Sie das externe Winkey-Gerät aus der internen Batterie und nicht aus der 
USB-Schnittstelle. Wenn Ihr Rechner abstürzt können Sie dann weitergeben. 
Anderenfalls fällt Ihre Tastung aus. 
- Winkey benötigt eine eigene COM-Schnittstelle. Das kann ein realer COM-Port 
oder eine feste virtuelle über USB bereitgestellte COM-Schnittstelle sein. 
-  Die Vorversion 9 von Winkey hatte einen Fehler und schaltete die CW unmittelbar 
nach der PTT ein, so dass es Probleme mit der RX/TX-Umschaltung in einer PA 
geben konnte. 
- Ab Version 10 hat Winkey keine flüchtigen Einstellungen mehr, so dass Sie es mit 
getrennter Stromversorgung ohne Rechneranschluss betreiben können.  

N1MMLogger unterstützt nur jeweils ein WinKey-Interface. Sollten Sie zwei 
Transceiver mit einem Winkey verwenden wollen, gehen Sie so vor: 

• Verwenden Sie Pin 14  derLPT-Schnittstelle für ein Relais, das CW- und PTT-
Leitung umschaltet 

• Verwenden Sie die Option von N1MMLogger für die Tastung von Tcvr1 über 
Pin3 und von Tcvr2 über Pin5. 
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Hinweis DM3ML: Mein Winkey hat zwei CW-Ausgänge und zwei PTT-Ausgänge.

4.1. Winkey einstellen (Setting up the K1EL WinKey)

Stecken Sie Winkey an eine USB-Buchse Ihres Computers. Gehen Sie dann unter 
Windows zu Systemsteuerung > System > Hardware > Gerätemanager und sehen 
Sie nach, was Windows für das Gerät "USB Serial Port (COMx)" für eine COM-
Nummer zugeteilt hat. 

Stecken Sie Winkey immer an die gleiche USB-Buchse, sonst verteilt Windows ihm 
eine andere COM-Schnittstellen-Nummer zu und markiert die bisher vergebene als 
„belegt“. Sie benötigen eine Schnittstellennummer von höchstens COM8 für 
N1MMLogger. Haben Sie keine niedrige Schnittstellennummer mehr frei, müssen Sie 
eine belegte COM-Nummern mit Windows-Werkzeugen freilenken und Winkey 
zuteilen.

Tragen Sie die COM-Schnittstelle wie oben beschrieben auf der Karteikarte 
Hardware für Winkey ein. Erlauben Sie beim Setup externe Interrupts. Stellen Sie auf 
der Karteikarte Winkey die gewünschten Parameter ein. 

5. microHAM - microKEYER

Ich denke, es kann nützlich sein, wenn ich hier meine Einstellungen unter 
N1MMLogger für einen microKEYER zusammen mit einem FT-1000MP mitteile: 

CW-Tastung 

• microKEYER-Routersoftware 
o Prüfen Sie, ob Sie eine grüne Marke bei der Software für den 

microKEYER feststellen können 
o Klicken Sie auf die Karteikarte PTT/FSK und wählen Sie WinKey PTT = 

PTT1 
o Weisen Sie im Router-Programm die Schnittstelle COM6 für die CAT-

Steuerung und COM8 für Winkey zu. Sollten diese Ports noch nicht 
vorhanden sein, erzeugen Sie sie mit der Routersoftware unter Virtual 
Port > Create. 

• Öffnen Sie N1MMLogger und gehen Sie zu Config > Configure Ports ... 
o Wählen  Sie unter COM6 die CAT-Steuerung des FT-1000MP und 

stellen Sie die Schnittstelle auf 4800/N/8/2, DTR=Always 
On/RTS=Always On ein. Klicken Sie auf  OK. 

o Wählen Sie für COM8 "CW/Other" und dann Set. Wählen Sie dort 
WinKey. Klicken Sie auf OK. 

o Wählen Sie auf der Karteikarte "WinKey" für Pin5 = PTT. Klicken Sie 
auf OK 

Damit sollte die CAT-Steuerung und CW-Tastung für den FT1000MP funktionieren. 

RTTY-Tastung 
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Port N1MM logger - Configurer MK 
Router MMTTY - Einstellung 

Com6 
FT1000MP – CAT-Steuerung / DTR + 
CTS immer EIN / PTT über CAT-
Kommando 

Radio Karteikarte Misc: TX port 
COM-TxD(FSK)

Com7 Digital DTR + CTS immer EIN FSK Karteikarte TX: PTT port 
7

Com8 WinKey Winkey

Sie können auch andere COM-Schnittstellen wählen, sie müssen nur 
unterschiedliche Nummern haben.  

73 Jim MM0BQI 

5.1. Tentec ORION + "Mute mic on supported radios"

Stellen Sie sicher, dass auf der N1MMLogger-Karteikarte Other die Option "Mute mic 
on supported radios" NICHT ausgewählt ist. Wenn diese Option angewählt ist, tastet 
N1MMLogger das Mikrofon stumm und schaltet den AUX-Eingang vom Voice-
Rekorder während einer DVK-Sendung zu.  Der microKEYER speist die DVK-NF 
über den Mikrofoneingang ein.  

5.2. ICOM-CI-V-Interfaces + Transceive on/off - Option

Eine SteppIR-Steuerung möchte bei einer Frequenzänderung informiert werden und 
benötigt die Option Transceive ON . N1MMLogger fragt dagegen den Transceiver 
selbst ab (Polling) und möchte gern die Option Transceive OFF. Gehen Sie so vor:

• Schalten Sie alle CI-V-Geräte parallel 
• Stellen Sie den ICOM-Transceiver auf Transceive OFF 
• Schalten Sie den microHAM Router auf "polling ON“
• Schalten Sie den microHAM Band Decoder auf "polling OFF"

Der microKEYER (Router) pollt nur, wenn es der N1MMLogger nicht macht. Die 
Abfragen des Routers sorgen für Datenverkehr auf dem CI-V-Bus und halten die 
SteppIR und andere Hardware auf dem Laufenden.  

Der microHAM-Band-Decoder übernimmt die Antennenumschaltung, auch die 
Umschaltung von Antennen innerhalb eines Bandes entsprechend Ihrer Vorgaben. 
Er steuert auch die Auswahl der Bandfilter unterschiedlicher Hersteller und stellt die 
Daten für Endstufen wie Yaesu (Quadra, FL-7000) oder Icom (IC-2KL, IC-4KL, IC-
PW1) bereit unabhängig von der Transceiver-Marke wie Yaesu, Kenwood, Icom, 
oder TenTec. 
Die genannten Funktionen werden auch für Nicht-ICOM-Transceiver realisiert. 
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5.3. N1MMLogger kann die RX-Frequenz nicht auslesen. Der 
microHAM-Router zeigt sie aber ohne N1MMLogger richtig an 
(N1MM can't read the RX frequency (shows as 0) - frequency 
shown fine in microHam router without N1MM logger)

N1MMLogger pollt etwas anders als der Router (VFO A und VFO B vs. "Current 
operating frequency"). Der Router findet ein "time out." 

Öffnen Sie die Steuerung des Routers > Control > Set und entfernen Sie den Haken 
bei "Disable router queries" . 

5.4.  CW-Texte werden beim Winkey abgeschnitten (Truncation of 
Messages (When Using Winkey Keyer))

Symptom: Die Texte werden fast komplett gesendet, aber das letzte Zeichen wird 
abgeschnitten und auf Empfang geschaltet. 
Lösung: Ergänzen Sie die CW-Texte am Ende mit einem Leerzeichen oder einem | . 
Das | dauert 1/3 so lang wie ein Zwischenraum.  

6. microHAM - MK2R/MK2R+

• Informieren Sie sich unter 
http://www.microham.com/Downloads/MK2R_N1MM_Setup.pdf  wie der 
MK2R+ unter N1MMLogger an die  LPT-Schnittstelle angeschlossen wird 

• Soll der MK2R+ an eine USB-Schnittstelle angeschlossen werden, lesen Sie 
"USB-only SO2R.pdf" von N4ZR im N1MMLogger-Reflektor bei Yahoo 
(http://groups.yahoo.com/group/N1MMLogger). 

Frage: Wenn ich N1MMLogger starte, erscheint die Meldung: "Winkey v2 detected, 
Only Winkey v4 and higher are supported in N1MM." 
Antwort:  Diese Meldung erscheint, wenn der MK2R+ beim Start von N1MMLogger 
noch nicht eingeschaltet ist.  

Frage: Wie viel serielle Schnittstellen werden beim vollen Betrieb mit einem MK2R 
benötigt?
Antwort:  Sie brauchen fünf Schnittstellen unter N1MMLogger: Radio 1, Radio 2, 
PTT 1, PTT2 und WinKey. Die anderen Funktionen (Packet, Rotorsteuerung usw.) 
benötigen keine Schnittstelle aus den „ersten Acht“. Das MMTTY/Digital- Interface 
teilt sich den Port mit PTT (und CW, falls Sie Winkey nicht verwenden). MMVARI 
oder MMTTY benötigen bei AFSK-Tastung keine weitere Schnittstelle. Nur wenn Sie 
die SO2R-Steuersignale den seriellen Handshake-Leitungen (RTS/CTS/DTR) 
zuweisen, benötigen Sie u.U. eine weitere Schnittstelle. Sie müssen darauf achten, 
einen entsprechend großen Block zwischen COM1 und COM8 freizuhalten bzw. 
freizulenken. 
73, Joe, W4TV 

Beispiel für eine Einstellung eines microHAM Routers 

• VOICE: Sprachumschaltung für beide Transceiver: CmCmCm 
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FT1000MP, Proset Plus an der Mikrofonbuchse angesteckt. 

N1MM Logger (6.10.9 or higher) 

• Configurer > Karteikarte Audio 
o 2 - Single Card - Two Radio, No sound card SO2R 
o Gerät wählen: USB Voice CODEC 
o Wähle Input Line: Microphone
o Wähle Leitung zum Stummtasten: Microphone
o Aufzeichnungsrate = 16 Bit 
o Abtastrate = 22050 

Ctrl+Shift+Fx zum Aufzeichnen, Fx zum Abspielen 

6.1. SO2R nur über USB (USB-only SO2R Support)

Wenn Sie den MicroHam an die USB-Schnittstelle anschließen und den “USB-only 
SO2R Support” verwenden, benötigen Sie keine LPT-Schnittstelle für den 
MK2R/MK2R+ mehr.  

Erzeugen Sie einen virtuellen COM-Port zur Steuerung Ihres MK2R unter 
N1MMLogger. Gehen Sie dann zur Karteikarte Hardware des Configurers und 
wählen Sie die COM-Schnittstelle für CW/Other. Klicken Sie auf Set und wählen Sie 
im sich öffnenden Fenster unter ‚Two Radio Protocol’ die Einstellung MK2R . 
Gehen Sie dann zu der Karteikarte SO2R im MicroHam Router und wählen Sie dort 
das ‚Microham SO2R protocol’ mit der Taste "radio button" und geben Sie die 
verwendete COM-Schnittstelle in der Menüliste an. Wenn Sie zusätzlich vom 
Programm erzeugte Banddaten verwenden wollen, ändern Sie auf der Karteikarte 
ACC die Optionen für Radio 1 und Radio 2 in "SO2R protocol controlled". Falls Sie 
Banddekoder von beiden Transceivern aus steuern wollen, verdrahten Sie die Pins 6 
bis 9 des ACC-Steckverbinders für Radio 1 und die Pins 10 bis 13 für Radio 2. 

6.2. Vorschlag für eine Einstellung (Suggested Port Setup by Joe, 
W4TV)

Der MK2R/MK2R+ arbeitet sehr gut mit sechs Schnittstellen. Die Schnittstellen sind 
mit  A bis F bezeichnet. Für A bis F ist die aktuelle COM-Nummer einzusetzen. 

MK2R/MK2R+ with 6 Total Ports 
Port Angeschlossenes Gerät 

COM A WinKey (Winkey sollte an die niedrigste COM-Nummer angeschlossen 
werden) 

COM B Radio #1 (PTT und Fußschalter optional)
COM C Radio #2 (PTT und Fußschalter optional)
COM D Digital #1 FSK und PTT für Radio #1 
COM E Digital #2 FSK und PTT für Radio #2 
COM F MK2R (Protocoll-Port)

Falls Sie keine FSK-Tastung machen, kommen Sie mit vier Schnittstellen aus. Die 
PTT wird dann über die beiden CAT-Schnittstellen geschaltet.  Der MK2R übernimmt 
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auch eine eventuelle “Handshake”-Funktion, die Leitungen RTS und DTR bleiben für 
Steuerzwecke frei.  

Die PTT-Einstellungen an COM D und COM E benötigen Sie, wenn Sie die bei 
N1MMLogger eingebaute DVK über PTT steuern wollen. Falls Sie die DVK-Funktion 
des MK2R verwenden wollen, müssen Sie die DVK-Option an der MK2R-
Schnittstelle aktivieren.  

6.3. Audio-Aufzeichnung mit N1MMLogger (On-the-Fly Recording 
from within N1MM Logger)

Wollen Sie die Audio-Aufzeichnung über die Tastenkombination Ctrl+Shift+Fx mit 
N1MM und MK2R+ verwenden, müssen Sie diese Vorkehrungen treffen: 

• Sie benötigen beim ‚MK2R SO2R protocol (USB-only)’ eine N1MMLogger-
Version 7.10.9 oder neuer 

• Haben Sie in Ihrem Rechner eine Realtek- oder Soundmax-Soundkarte auf 
dem Motherboard, müssen Sie zeitweise die Windows-Soundkarte auf ‘USB 
Voice CODEC’ umstellen und die Windowstöne abschalten. Die 
Realtek/Soundmax-Treiber lassen die Mikrofon-NF nicht zum MK2R durch, 
wenn Sie diese Einstellung nicht machen.  

7. RigExpert

Wenn Sie RigExpert Std oder Plus installieren, erzeugt es 4 virtuelle COM-
Schnittstellen auf Ihrem Rechner und die Soundkarte USB Audio Codec. Klicken 
Sie in dem mitgelieferten Programm ListRE auf "Show Serial Ports" und schreiben 
Sie sich die vergebenen Nummer für die COM-Schnittstellen für CAT und PTT/CW 
auf. Starten Sie dann N1MMLogger, gehen Sie dort zum Configurer und tragen Sie 
auf der Karteikarte Configure Ports, Telnet Address, Other unter Hardware die 
Schnittstellen ein. Einträge müssen gemacht werden für die CAT (Transceiver-
Modell, Baudrate, Datenformat) und für CW/PTT (DTR für CW und RTS für PTT). 
Wenn Sie den RigExpert Plus haben, können Sie eine getrennte COM-Schnittstelle 
für WinKey einrichten. Die Soundkarte von RigExpert wird auf der Karteikarte Audio 
als USB Audio Codec eingetragen. Beachten Sie, dass N1MMLogger nur COMs von 
COM1 bis COM8 verarbeiten kann. Falls dazwischen liegende Nummern schon 
belegt sind, müssen Sie diese mit den Windowswerkzeugen umbenennen oder ganz 
freilenken. Sie können mit dem USB-Interface jeweils nur ein Programm zur gleichen 
Zeit betreiben. Falls Sie einen älteren RigExpert - SD oder 2.2 haben, benötigen Sie 
zusammen mit N1MMLogger den zusätzlichen Treiber REAUDIO. 

Wenn der RigExpert SD unter N1MMLogger für die Sprachausgabe verwendet 
werden soll, tragen Sie auf der Karteikarte Audio den "RigExpert" als Gerät ein. 
Legen Sie dann den Pfad für die WAV-Dateien fest. Für neuere RigExpert-Modelle 
benötigen Sie den Treiber REAUDIO nicht, hier wird "USB Audio Codec" als Gerät im 
Menü ausgewählt. 
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8. Automatischer Banddekoder und DXDoubler (DXD) von Top Ten 
Devices (Top Ten Devices - Automatic Band Decoder and DX 
Doubler)

Stellen Sie die Karteikarte Antenna so ein wie es im Interface-Kapitel vorgegeben 
ist, um das voreingestellte Verhalten des Top Ten-Geräts realisieren. 

8.1. Hardware-Aktualisierung ”Beide Ohren am inaktiven 
Transceiver” gegenüber “Beide Ohren am aktiven 
Transceiver” über die Tastatur” (Hardware Update: 'Both 
Ears on the Inactive Radio' versus 'Both Ears on the Active 
(or Run) Radio' from the Keyboard)

Ich (N4ZR) wollte gern mit beiden Ohren am inaktiven Transceiver hören und 
intensiven S&P-Betrieb machen, aber wechselweise mit beiden Ohren am aktiven 
Transceiver nach leisen Anrufern neben dem dicken Signal von HC8N hören. Sie 
können das manuell machen, wenn Sie beim DXD den Audiomodus von PTT auf 
Auto schalten, aber ich wollte es lieber über die Tastatur machen.

Setzen Sie zuerst den DXD-Jumpers (2) in die Position CT/Writelog/TR/MM. Damit 
wird der Pin 5 der LPT-Schnittstelle freigelenkt. Schalten Sie dann einen 2N2222 mit 
offenen Kollektor zwischen Pin 5 und das Auto-Terminal 3 von DXD (das ist der 
Schalter für den Audio-Modus). Pin 5 steuert die Basis des Schalltransistors über 
einen 1k-Widerstand, der an das heiße Ende von R22 gelegt ist so wie beim CW-
Interface. Der Emitter liegt an der Masse-Seite von R22 und der Kollektor ist auf der 
Schalterseite von R29 angeschlossen. Das ist alles, was Sie machen müssen. 

 DX Doubler an einer anderen Schnittstelle als LPT1 
Wenn Sie den DX Doubler nicht an der Schnittstelle LPT1 anschließen, müssen Sie 
die neue Adresse ermitteln. 

73, Pete N4ZR 

9. West Mountain Radio - RIGblaster

9.1. Einstellung für CW- und Digimoden am RIGBlaster Plus (CW 
and Digital Setup RIGblaster Plus)

Setzen innen im RIGblaster Plus diese Jumper im Block P5: D9 und D12, 
entsprechend RTS für PTT und DTR für CW. Ändern Sie die Schnittstelle, an die der 
RIGblaster angeschlossen ist von DIGITAL auf OTHER. Stellen Sie unter 
N1MMLogger die Signale DTR (pin 4) für CW und RTS (Pin 7) für PTT ein. Mit dieser 
Kombination können Sie die Soundkarte für die Digimodes MMTTY, SSTV, PSK, 
Voice Key Express usw. verwenden. (by David, K1TTT) 

 CW-Dauertastung mit dem RIGblaster Pro : Bleibt CW dauert auf EIN setzen Sie 
DTR auf CW 
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9.2. SSB-Einstellung beim RIGBlaster Plus (SSB Setup RIGblaster 
Plus)

• Serielle Schnittstelle im Configurer 
o Com2 oder andere freie Schnittstelle 
o DTR: Always OFF 
o RTS: PTT 

• Am RIGblaster 
o Tx/Auto switch auf Auto. 

• Lautstärkeregler 
o Verwenden Sie den Soundkartenregler 

Mit dieser Einstellung wird das Mikrofon während der Aussendung einer WAV-Datei 
stumm getastet und die VOX arbeitet, wenn keine WAV-Datei gesendet wird. 

10. Transverter (Transverters)

Mit N1MMLogger können Transverter in der Bandskala und der VFO-Steuerung 
berücksichtigt werden. Klicken Sie rechts in Bandskala und wählen Sie die 
Einstellung der Offset-Frequenz. Geben Sie hier die XO-Endfrequenz des 
Transverters in kHz ein. Bei einem Umsetzer von 28 auf 144MHz sind das 116000 
kHz. Sie können in beiden Bandskalen unterschiedliche Offsets eintragen, wenn Sie 
mit zwei Transceiver auf zwei UKW-Bändern arbeiten. Der Offset wird abgespeichert 
und steht auch bei einem Programmneustart zur Verfügung.

11. Nicht unterstützte Hardware (Unsupported Hardware)

11.1. CW-Dekoder (CW Decoders)

Es wird keinerlei CW-Dekoder unterstützt, weder Hardware- noch Software-Dekoder. 

11.2. W5XD MultiKeyer

Der W5XD MultiKeyer wird nicht unterstützt und es gibt keine Pläne so etwas zu tun 

12. Weitere Hardware-Informationen (Other Hardware Information)

Von Joe Subich, W4TV 

12.1. USB-Soundkarten (USB Soundcards)

Den Handbüchern der unten stehenden Soundkarten ist zu entnehmen, dass sie 
unabhängige Mikrofon- und Stereo-Line-Eingänge haben:  

• Audigy 2NX External 
• Creative SoundBlaster MP3+ 
• Turtle Beach "Audio Advantage Roadie" 

Diese Niedrigpreis-Option wird ohne Handbuch geliefert, aber die Angaben im 
Internet zeigen getrennte Mic- und Lin-Eingänge:  
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• Byterunner UA-580 
o Könnte als Empfehlung für eine externe Soundkarte für Laptops gelten 

12.2. Andere Soundkarten (Other Soundcards)

• SoundBlaster Live 24 External 
o Bei dieser Soundkarte können Sie die Mic- und Line-Eingänge nicht 

parallel verwenden. Wenn ein Mikrofon angesteckt wird, wird der Line-
Eingang abgeschaltet. 

12.3. Externe gegenüber internen Soundkarten (External versus 
Internal Soundcards)

Es trifft nicht zu, dass externe Soundkarten besser sind als interne Soundkarten. Bei 
sorgfältiger Einstellung der Pegel ist kein Unterschied zwischen internen und 
externen Soundkarten festzustellen. 

Last Modification: 24 October 2009 07:06:37 EDT by K8UT. 
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Unterstützte Contest (Supported Contests)

Anmerkung DM3ML: Sie finden die Daten zu den Contesten (mittlere Spalte) in dem 
umfangreichen Kapitel Contesteinstellungen. Die Links beziehen sich auf die 
Abschnitte in diesem Kapitel, wurden aber aus technischen Gründen nicht 
angepasst. Sehen Sie im Zweifelsfall im Inhaltsverzeichnis nach.

1. Allgemeines Loggen (General Contest Logging (all modes))
Supported Contests - General Contest Logging

Contest 
Log-Typ
& 
Einstellungen

Bemerkungen

DX (General 
log) DX log Sendet RST, empfängt RST, Name- und 

Kommentar-Felder
DXPEDITION DXpedition Nur gesendetes und empfangenes RST 

DXSERIAL DXSERIAL Gesendetes und empfangenes RST, Nummernfeld, 
Kommentar, voreingestellte Multis und Punkte

DXSATELLIT DX satellite Nur drei Felder: Rufzeichen, Lokator und Satellit

VHFDX VHFDX Gesendetes und empfangenes RST, Lokator und 
Kommentar

VHFSERIAL VHFSERIAL 
Gesendetes und empfangenes RST, Seriennummer, 
Lokator. Für allgemeine VHF-Conteste, Kommentare 
möglich

2. CW- und SSB-Conteste auf Kurzwelle (Supported HF CW and SSB 
Contests)

Bei allen Contesten werden – wenn nicht anderes vermerkt - beide Seiten 
unterstützt: 

N1MM Supported HF CW and SSB Contests

Contest Name und 
Internet-Link 

Log-Typ
& 
Einstellungen 

Bemerkungen

9A CW contest (Croatian 
CW contest)   9ACW Nur CW, drittes WE im Dezember

All Asian DX contest CW / 
SSB   

ALLASIASSB
ALLASISCW 

CW : Dritter Sonnabend im Juni (48h)
SSB : Erster Sonnabend im 
September (48h)

Asian Pacific Sprint   APSCW
APSSSB Frühling, Sommer, Herbst (2h)

ARCI QRP Contests   ARCI Unterstützt 7 ARCI QRP Conteste
ARI International DX 
Contest   ARIDX Per version 4.0.63

ARRL 10 Meter contest   ARRL10M 
ARRL 160 Meter contest   ARRL160M 
ARRL Field Day contest   FD Dupe Sheets not always required for 

this contest, see ARRL Field Day 
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Setup instructions. Info by Dan 
Henderson, N1ND from the ARRL 
contest branch.

ARRL International DX 
contest CW /Phone   

ARRLDXCW
ARRLDXSSB 

ARRL November Sweep 
Stakes CW / SSB   

SSCW
SSSSB 

Asia-Pacific Sprint Contest 
CW / SSB   APSCW 

Baltic contest   BALTIC Vorletztes WE im Mai, eine Woche vor 
dem WPX CW Contest

CIS DX contest   CISDXCW
CISDXSSB Commonwealth of Independent States

CNCW Spanish contest   CNCW Lokaler Spanischer CW-Contest
CQ-M International DX 
contest   CQM Zweites Mai-WE

CQ World-Wide 160 Meter 
DX Contest - CW / Phone   

CQ160CW
CQ160SSB 

CQ World Wide DX contest - 
CW / SSB   

CQWWCW
CQWWSSB 

CW : Letztes November-WE (48h)
SSB : Letztes Oktober-WE (48h)

CQ World Wide WPX 
contest - CW / Phone   

CQWPXCW
CQWPXSSB 

Cup of the Russian 
Federation (RFC) contest 

RFCCW
RFCSSB 

Interner  russischen Contest im 
Januar

DARC 10 meter contest   DARC10M Zweites volles WE im Januar
DARC 
Weihnachtswettbewerb - 
XMAS contest   

XMAS Am 26. Dezember

European Sprint - CW / 
Phone   

EUSCW
EUSSSB 

Im April und Oktober (jeweils CW und 
SSB) (4 h)

DIG contest - CW / Phone 
(DIG QSO Party)   

DIGCW
DIGSSB 

SSB: Zweites März-WE
CW: Zweites April-WE
Auch Kurzconteste im Juni und 
Oktober

EU HF Championship   EUHFC Erster Sonnabend im August (12:00 - 
23:59 UTC).

FOC Marathon   FOCCW Erstes volles Februar-WE
GACW WWSA CW DX 
contest   GACW Zweites Juni-WE 

HA DX contest   HADX Drittes Januar-Wochen-WE
Helvetia Contest   HELVETIA 
High Speed CW Contest 
(HSC CW)   HSCCW 

Holyland contest   HOLYLAND 
IARU Radiosporting contest 
HF   IARU 

IARU Region 1 Fieldday 
contest 

FDREG1 Für Belgien, Deutschland, Germany, 
United Kingdom (SSB and CW), 
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Niederlande, Schweiz, Irland (nur 
CW), Italien, Slowenien (S5) und 
Russland (UA, UA2, UA9)

IOTA (RSGB) Islands On 
The Air contest   IOTA 

International Naval Contest  

JA-domestic JADOMESTIC Allgemeine Unterstützung für inner-
japanische Conteste

JIDX Contest   JIDXCW
JIDXSSB 

CW: Zweites April-WE
PH: Zweites volles WE im November
Sb. 0700 UTC - So. 1300 UTC

King of Spain contest   KINGEACW
KINGEASSB 

LOTW   LOTWCW
LOTWSSB 

LZ DX contest   LZDX WE im November vor dem CQWW 
CW

LZ Open and LZ Sprint 
contests   LZOPEN Für alle drei Conteste. LZ Open und 

beide Sprint-Conteste (40/80 meter)
Manchester Mineira All 
America   CWJFMM Süd- und Nord-Amerika, nur CW 

Michigan QRP Contest   ARCI Für die  4 Michigan QRP-Conteste. 

NA Sprint - CW / SSB   SPRINTCW
SPRINTSSB 

CW: Erster Sb in Februar
SSB: Sonntag des ersten vollen WE 
im Februar
CW: Sonntag nach dem ersten 
Montag des September
SSB: Zweiter Sonntag nach dem 
ersten Montag im September

Minitest CW Test   MINITESTCW CW: jeden Mittwoch 1800-1900Z
NCCC NS Ladder 
Competition   SPRINTLADD Jeden Dienstag 19:30-2000 PST

North American QSO 
Parties (NAQP) - CW / SSB  

NAQPCW
NAQPSSB 

CW: Zweites volle WE im Januar
SSB: Drittes volles Wochenende im 
Januar

NRAU-Baltic contest   NRAUCW
NRAUSSB Zweites volles WE im Januar

Oceania contest CW / 
SSB'OCEANIACW   OCEANIASSB SSB: Erstes WE im Oktober

CW: Zweites WE im Oktober
OK-OM DX contest   OKOMDX Zweites volles WE im November
PA-beker CW / SSB contest
  

PABEKERCW
PABEKERSSB 

Zweites volles WE im November 
PA-interner Contest in CW/SSB

PACC contest   PACC Erstes volles Februar-WE
Portugal Day Contest   PORTUGAL Zweiter Sonnabend im Juni
QSO parties (US and 
Canada) QSOPARTY Siehe unten

RAC Canada Day, Contest 
RAC Canada Winter Contest
  

RAC Beide Conteste haben die gleichen 
Regeln
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http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#Oceania_Contest
http://www.oceaniadxcontest.com/
http://www.oceaniadxcontest.com/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#NRAU_Baltic_Contest
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#NRAU_Baltic_Contest
http://www.sk3bg.se/contest/nrau.htm
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#North_American_QSO_Parties_CW_SSB_NAQP
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#North_American_QSO_Parties_CW_SSB_NAQP
http://www.ncjweb.com/naqprules.php
http://www.ncjweb.com/naqprules.php
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#NCCC_NS_Ladder_Competition
http://www.ncccsprint.com/rules.htm
http://www.ncccsprint.com/rules.htm
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#MiniTest_CW_Test
http://www.minitest.narod.ru/2009/2009.htm
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#NA_Sprint_CW_SSB
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#NA_Sprint_CW_SSB
http://www.ncjweb.com/sprintrules.php
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#Michigan_QRP_Contest
http://www.qsl.net/miqrpclub/contest.html
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#Manchester_Mineira_Contest
http://www.powerline.com.br/cwjf/
http://www.powerline.com.br/cwjf/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#LZ_Open_and_LZ_Sprint_Contests
http://www.lzopen.com/
http://www.lzopen.com/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#LZ_DX_Contest
http://www.qsl.net/lz1fw/contest/index.html
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#Logbook_of_the_World_Contest_CW_SSB
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#Logbook_of_the_World_Contest_CW_SSB
http://www.lotwcontest.com/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#King_of_Spain_Contest
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#King_of_Spain_Contest
http://www.sk3bg.se/contest/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#JIDX_contest
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#JIDX_contest
http://jidx.org/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#JA_domestic_contests
http://www.southgatearc.org/news/october2009/international_naval_contest.htm
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#IOTA_Islands_On_The_Air_Contest
http://www.rsgbiota.org/
http://www.rsgbiota.org/
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RAEM contest (E.T.Krenkel 
contest)   RAEM Viertes volles Dezember-WE

REF DX contest   REFCW
REFSSB 

CW: letztes Januar-WE
SSB: letztes Februar-WE

RF Championship   RFCHAMP 
RSGB 1.8MHz CW contests
  RSGB160CW Nur CW: Im Februar und November

RSGB 21/28 MHz contest   RSGB2128 
RSGB 80 Meter Club 
Championship   RSGB80MCC 

RSGB Affiliated Societies 
Team Contests (AFS)   

RSGBAFS-C
RSGBAFS-S 

RSGB Club Calls contest   RSGBCLUB 

RSGB Commonwealth 
Contest   RSGBJUBILE 

Der Contest hiess früher RSGB 
Jubilee contest. Er heisst jetzt RSGB 
Commonwealth Contest.

RSGB National Field Day, 
RSGB SSB Field Day   FDREG1 

Für Belgien, Deutschland, Germany, 
United Kingdom (SSB and CW), 
Niederlande, Schweiz, Irland (nur 
CW), Italien, Slowenien (S5) und 
Russland (UA, UA2, UA9)

RSGB Low Power Field Day
  RSGBLP 

RSGB ROPOCO   ROPOCO Internal RSGB contest
Russian District Award 
Contest (RDAC)   RDAC 

Russian DX   RUSSIANDX 

Russian YL/OM contest   RUSYLOM in 
Russian

SAC   SACCW
SACSSB 

Spanish Towns contest   CME 

SP DX contest   SPDX Erstes volles April-WE (15:00-15:00 
GMT)

Stew Perry Topband 
Distance Challenge   STEWPERRY Letztes volles Dezember-WE

UA1DZ Memorial Cup   DZCUP 

UBA DX Contest CW/SSB   UBACW
BASSB 

SSB: Letztes Januar-WE
CW: Letztes Februar-WE

UBA ON contest   UBAON 

Letzter September-Sonntag: 6 m 
Phone/CW
Erster Oktober-Sonntag: HF - 80 m 
SSB
Zweiter Oktober-Sonntag: HF - 80 m 
CW
Dritter Oktober-Sonntag: 2 m 
Phone/CW

UBA Low Band Winter 
Contest   UBAWINTER 160, 80 und 40 Meter

UBA Spring   UBASPRING Zweiter März-Sonntag: HF - 80m CW
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http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#UBA_Spring
http://www.uba.be/nl.html
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#UBA_Low_Band_Winter
http://www.uba.be/
http://www.uba.be/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#UBA_ON_contest
http://www.uba.be/nl.html
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#UBA_contest_CW_SSB
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#UBA_contest_CW_SSB
http://www.uba.be/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#UA1DZ_Memorial_Cup
http://www.qrz.ru/contest/detail/543.html
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#Stew_Perry_Topband_Distance_Challenge
http://jzap.com/k7rat/stew.rules.txt
http://jzap.com/k7rat/stew.rules.txt
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#SPDX_contest
http://www.contest.spdxc.org.pl/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#Spanish_Towns_contest
http://www.ure.es/hf/concursos/dme/concursodme.pdf
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#SAC_contest_CW_SSB
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#SAC_contest_CW_SSB
http://www.sk3bg.se/contest/sacnsc.htm
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#Russian_YL_OM_contest
http://www.radio.ru/cq/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#Russian_DX_contest
http://www.rdxc.org/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#Russian_District_Award_contest
http://www.rdaward.org/rda_contest1.htm
http://www.rdaward.org/rda_contest1.htm
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#RSBG_ROPOCO
http://www.vhfcc.org/hfcc/index.shtml
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#RSBG_Low_Power_Field_Day
http://www.vhfcc.org/hfcc/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#RSBG_SSB_Field_Day_RSGB_National_Field_Day
http://www.vhfcc.org/hfcc/
http://www.vhfcc.org/hfcc/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#RSGB_Commonwealth_contest
http://www.vhfcc.org/hfcc/
http://www.vhfcc.org/hfcc/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#RSGB_Club_Calls_contest
http://www.vhfcc.org/hfcc/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#RSGB_Affiliated_Societies_Team_Contests_AFS
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#RSGB_Affiliated_Societies_Team_Contests_AFS
http://www.vhfcc.org/hfcc/
http://www.vhfcc.org/hfcc/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#RSGB_80_Meter_Club_Championship
http://www.vhfcc.org/hfcc/
http://www.vhfcc.org/hfcc/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#RSBG_21_28_MHz_contest
http://www.vhfcc.org/hfcc/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#RSGB_1_8MHz_CW_Contests
http://www.vhfcc.org/hfcc/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#RF_Championship
http://www.qrz.ru/contest/detail/30.html
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#REF_contest_CW_SSB
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#REF_contest_CW_SSB
http://www.ref-union.org/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#RAEM_CW_contest
http://www.srr.ru/CONTEST/Cup_R%20A%20E%20M_En.htm
http://www.srr.ru/CONTEST/Cup_R%20A%20E%20M_En.htm
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Dritter März-Sonntag: VHF-6m 
Phone/CW
Vierter März-Sonntag: VHF-2m 
Phone/CW
Erster April-Sonntag: HF - 80m SSB

Ukrainian DX contest   UKRAINDX Erstes volles November-WE

UK DX Contest - CW/SSB   UKDXCW
UKDXSSB 

WAEDC-Contest   WAECW
WAESSB Start in die Contest-Saison

Worked All Germany (WAG) 
contest   WAG Drittes Oktober-Wochenende

World Wide Peace 
Messenger Contest   WWPMC 1200UTC Sb to 1200 UTC So an 

jedem ersten Februar-WE

WRTC WRTC World Radiosport Team 
Meisterschaft aller vier Jahre

YO DX HF contest   YOHFDX Letztes August-WE
Independence of Venezuela 
Contest   YV Erstes volles Juli-WE

3. QSO Parties (CW/SSB)

Die QSO-Parties werden von N1MMLogger unterstützt. Wählen Sie QSOPARTY und 
dann den korrekten Staat. Sie sehen dann ein Menüfenster. 

3.1. Vereinigte Staaten von Amerika (United States)
United States CW / SSB QSO Parties
State and
Website Link 

Setup
Link 

State and
Website Link 

Setup
Link 

State and
Website Link 

Setup
Link 

Alabama - AL   Alaska - AK   Arkansas - AR   
California - CA   Colorado - CO   Delaware - DE   

Florida - FL   FL 
qsop Georgia - GA   Hawaii - HI   

Indiana - IN   Setup Illinois - IL   Kansas - KS   

Kentucky - KY   Louisiana - LA   Maryland DC - 
MD   

Michigan - MI   Minnesota - MN   Missouri - MO   

Nebraska - NE   New England - 
NEWE   Setup New Mexico - 

NM   

New Jersey - NJ   North Carolina - 
NC   

North Dakota - 
ND   

Nevada - NV   Ohio - OH   Oklahoma - OK  

Oregon - OR   Pennsylvania - PA  PA 
qsop 

South Carolina - 
SC   

South Dakota - SD   Tennessee - TN   Texas - TX   
Vermont - VT   Virginia - VA   Wisconsin - WI  
Washington Salmon 
Run - WA   

West Virginia - WV
  

7th Call Area - 
7QP   Setup
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http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#Same_weekend_7QP_Indiana_QSO_Party_and_the_New_England_QSO_Party
http://www.7qp.org/
http://www.7qp.org/
http://www.qsl.net/wvarrl/wvqp2003.html
http://www.wwdxc.org/salmonrun/
http://www.wwdxc.org/salmonrun/
http://www.warac.org/wqp/wqp.htm
http://www.qsl.net/sterling/VA_QSO_Party/QSOParty.htm
http://www.ranv.org/vtqso.html
http://www.txqp.org/
http://www.k4ro.net/tcg/tqp.html
http://www.sk3bg.se/contest/
http://www.qsl.net/arrl-sc/sc_qso_party_page.htm
http://www.qsl.net/arrl-sc/sc_qso_party_page.htm
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#PA_QSO_party
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#PA_QSO_party
http://www.nittany-arc.net/paqso.html
http://www.codxc.com/new/Page.asp?content=oqp
http://www.okdxa.org/
http://www.oqp.us/
http://www.lvrj.com/communitylink/clubs/fars.html
http://www.w0cq.com/
http://www.w0cq.com/
http://www.w4nc.com/pages/2/index.htm
http://www.w4nc.com/pages/2/index.htm
http://www.qsl.net/w2rj/
http://pages.swcp.com/~n5zgt/nmqsoparty/
http://pages.swcp.com/~n5zgt/nmqsoparty/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#Same_weekend_7QP_Indiana_QSO_Party_and_the_New_England_QSO_Party
http://www.neqp.org/
http://www.neqp.org/
http://www.qsl.net/hdxa/neqso/neqso.htm
http://www.qsl.net/w0ma/contests.htm
http://www.w0aa.org/
http://www.miqp.org/
http://www.w3cwc.org/funcontest.htm
http://www.w3cwc.org/funcontest.htm
http://www.sk3bg.se/contesT/laqp.htm
http://www.qsl.net/ky4ky/kyqsopartyrules.html
http://www.sk3bg.se/contest/
http://my.core.com/~jematz/rams.html
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#Same_weekend_7QP_Indiana_QSO_Party_and_the_New_England_QSO_Party
http://www.hdxcc.org/inqp/rules.html
http://www.karc.us/hi_qso_party.html
http://gqp.contesting.com/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#FL_QSO_party
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#FL_QSO_party
http://www.floridaqsoparty.org/
http://www.fsarc.org/qso.htm
http://www.ppraa.org/coqp/index.php
http://www.cqp.org/
http://www.qsl.net/w5scr/arkansas_qso_party_2003.htm
http://www.sk3bg.se/contest/
http://www.alabamaqsoparty.org/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#Independence_of_Venezuela_Contest
http://www.radioclubvenezolano.org/
http://www.radioclubvenezolano.org/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#YO_HF_DX_contest
http://www.hamradio.ro/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#WRTC_contest
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#World_Wide_Peace_Messenger_Contest
http://www.s59dcd.si/english/
http://www.s59dcd.si/english/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#WAG_contest
http://www.darc.de/referate/dx/fedcg.htm
http://www.darc.de/referate/dx/fedcg.htm
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#WAEDC_contest_CW_SSB
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#WAEDC_contest_CW_SSB
http://www.waedc.de/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#UK_DX_contest_CW_SSB
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#UK_DX_contest_CW_SSB
http://www.srars.org/ukdxcruleseng.pdf
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#Ukrainian_DX_contest
http://www.ucc.zp.ua/
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3.2. Canada
Canadian CW / SSB QSO Parties
Province and Website Link Setup Link
Ontario - ON   ON qsop

4. Unterstützte UKW-Conteste (Supported VHF CW/SSB Contests)
Supported VHF CW/SSB Contests

Contest-Name und Internet-
Link

Log-Typ
& 
Einstellungen 

Bemerkungen

ARRL January VHF 
Sweepstakes   ARRLVHFJAN Januar

ARRL June VHF QSO Party  ARRLVHFJUN Juni
ARRL September VHF QSO 
Party   ARRLVHFSEP September

IARU Region 1 50 MHz 
contest VHFREG1 Nur 50 MHz - Juni

IARU Region 1 144 MHz 
September   VHFREG1 Nur 144 MHz - September

IARU Region 1 
UHF/Microwaves October   VHFREG1 UHF und Mikrowellen im Oktober

Other Region 1 VHF and up 
contests VHFREG1 2m und höher im März, Mai und Juli

Marconi CW contest 144 MHz 
/ 50 MHz   VHFREG1 

NRAU Activity Contest   VHFNAC 
REF Departments contest 50 
MHz   DDFM50 Nur 50 MHz

VHF/UHF Helvetia 26 contest
  VHFHELV26 Schweizer VHF/UHF-Contest

VHF HG OB contest VHFHGOB Ungarischer VHF-Contest
VRZA - Nederlandse Locator 
Contest   REGIOVHF WANLC : Monatlicher holländischer 

Contest: REGIOVHF
UKSMG sporadic-E 
competition   UKSMG 

5. Unterstützte RTTY/PSK-Conteste (Supported RTTY/PSK Contests)

Bei allen Contesten werden – wenn nicht anderes vermerkt - beide Seiten 
unterstützt: 

N1MM Supported RTTY and PSK Contests

Contest-Name und 
Internet-Link

Log-Typ
& 
Einstellungen

Bemerkungen

ANARTS WW RTTY contest
  ANARTSRTTY Zweites vollen Juni-WE

Anatolian RTTY contest   ANATOLRTTY Drittes Mai-WE
ARRL RTTY Roundup   ARRLRTTY Erstes volles Januar-WE (nicht am 
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http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#ARRL_RTTY_Roundup
http://www.arrl.org/contests/announcements/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#ANATOLIAN_RTTY_contest
http://www.qsl.net/ta9j/anatolian.htm
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#ANARTS_WW_RTTY_contest
http://www.anarts.com.au/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#UKSMG_sporadic_E_competition
http://www.uksmg.org/sporadic.htm
http://www.uksmg.org/sporadic.htm
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#VRZA_Nederlandse_Locator_Contest_WANLC
http://www.vrza.nl/
http://www.vrza.nl/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#VHF_HG_OB_contest
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#VHF_UHF_Helvetia_26_contest
http://www.uska.ch/e_index.htm
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#REF_Departments_contest_50_Mhz
http://www.ref-union.org/
http://www.ref-union.org/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#NAC_Activity_Contest
http://www.vushf.dk/Pages/contest/nac/nacopen.htm
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#Marconi_CW_contest
http://www.qsl.net/ik6ptj/marconi.htm
http://www.qsl.net/ik6ptj/marconi.htm
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#IARU_Region_1_contesting_50_MHz_VHF_UHF_Microwaves
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#IARU_Region_1_contesting_50_MHz_VHF_UHF_Microwaves
http://solair.eunet.yu/~s.ilic/iaru_uhf.txt
http://solair.eunet.yu/~s.ilic/iaru_uhf.txt
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#IARU_Region_1_contesting_50_MHz_VHF_UHF_Microwaves
http://solair.eunet.yu/~s.ilic/iaru_vhf.txt
http://solair.eunet.yu/~s.ilic/iaru_vhf.txt
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#IARU_Region_1_contesting_50_MHz_VHF_UHF_Microwaves
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#ARRL_September_VHF_QSO_Party
http://www.arrl.org/contests/announcements/
http://www.arrl.org/contests/announcements/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#ARRL_June_VHF_QSO_Party
http://www.arrl.org/contests/announcements/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#ARRL_January_VHF_Sweepstakes
http://www.arrl.org/contests/announcements/
http://www.arrl.org/contests/announcements/
http://n1mm.hamdocs.com/tiki-index.php?page=Contest+Setup+Instructions#QSO_Parties
http://cco.ve3xd.com/oqp/
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1.Januar)
BARTG RTTY Spring 
contest   BARTGSRTTY Drittes volles März-WE

BARTG RTTY Sprint contest
  BARTGRTTYS Ende Januar

CQ World Wide DX - RTTY  CQWWRTTY Letztes volles September-WE 48 h)
CQ World Wide WPX - 
RTTY   CQWPXRTTY Zweites volles Februar-WE

CIS DX RTTY contest   CISDXRTTY Commonwealth of Independent States
DL-DX RTTY contest   DLDXRTTY Erstes volles Juli-WE

EA PSK31 contest   EARTTY Wähle EARTTY als contest. Wähle 
Mode Control als "Always PSK31"

EA RTTY contest   EARTTY Erstes volles April-WE
EPC PSK World Wide DX 
(PSK125)   EPCWWDX 

EPC PSK63 QSO party   EPCPSK63QP 
EU PSK DX contest   EUPSKDX 
JARTS WW RTTY contest   JARTSWWRTY Drittes volles Oktober-WE
Makrothen RTTY contest   MAKRORTTY Zweites volle Oktober-WE

NA Sprint - RTTY   SPRINTRTTY Sonntag des zweiten vollen 
März/Oktober-WE

North American QSO 
Parties (NAQP) - RTTY   NAQPRTTY Letztes volles Februar-WE

OK DX RTTY contest   OKDXRTTY Drittes volles Dezember-WE
LOTW RTTY contest   LOTWRTTY 

Quick PSK63 contest SARTGRTTY PSK63 nach SARTG-Regeln. Erster 
Sb des September

Russian DX RTTY contest   RUSDXRTTY RTTY. Erster Sb des September
Russian Cup RTTY RUCUPRTTY Nur für russische Stationen
SARTG New Year RTTY   SARTGNYRTY Am 1.Januar
SARTG WW RTTY contest  SARTGRTTY Drittes August-WE
SCC RTTY Championship   SCCRTTY Letztes volles August-WE
SP DX RTTY contest   SPDXRTTY Viertes volles April-WE
TARA Grid Dip contest   TARAGRID RTTY and PSK. Erster Sb im August
TARA PSK Rumble   TARAPSK PSK31. Erster Sb im Oktober
TARA RTTY Melee   TARARTTY RTTY. Erster Sb im Dezember
Ukrainian DX RTTY contest  UKRAINRTTY Erstes volles November-WE
UK DX Contest - RTTY   UKDXRTTY Zweites volles Juli-WE
Volta RTTY contest   VOLTARTTY Zweites volle Mai-WE
WAEDC RTTY contest   WAERTTY Zweites volles September-WE
XE RTTY contest   XERTTY Erstes volles Februar-WE
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Contesteinstellungen (Contest Setup Instructions)

1. Überblick (General)

Abhängig von der Art des gewählten Contests (SSB, CW oder RTTY) wird die 
Kontrollnummer (Sent Exchange) automatisch an diese Sendeart angepasst. Wenn 
Sie z.B. den Contest CQWWSSB (CQ World Wide SSB contest) wählen wird die 
Sendeart auf SSB und der Rapport auf 59 eingestellt. Lassen Sie im Interesse eines 
korrekten Cabrillo-Logs diese Voreinstellung unverändert. Bei einem MIXED-Contest 
können Sie zwischen den Sendearten umschalten.  

N1MMLogger ist primär ein Contestprogramm. Sie können es aber durchaus für das 
allgemeine Loggen von QSOs in der Einstellung DX verwenden. Sie können ein 
beliebiges Log aus N1MMLogger als ADIF-Datei exportieren und in Ihr gewohntes 
Logprogramm importieren. 

Im Pseudo-Contest " DELETEDQS” werden die gelöschten QSOs abgespeichert. Sie 
können auch diese QSOs bearbeiten und exportieren.  

Die höchste serielle Nummer ist 99999 (für Conteste mit aufsteigender 
Seriennummer). Informieren Sie sich im Kapitel über erweiterte Funktionen und den 
Nummern-Server.  

 Lesen Sie die Contestregeln vor einem Contest! Dann wissen Sie, welche Daten 
im Contest auszutauschen sind, welche Länder Sie arbeiten dürfen und welche 
Arbeitszeiten einzuhalten sind. 

Hinweis DM3ML: Ich habe die nachstehenden Contesteinstellungen wegen des 
großen Umfangs von der Übersetzung ausgenommen. Sie sind selbsterklärend und 
zusammen mit den Contestregeln ohne Problem zu verstehen. Sie können mir gern 
eine Email schreiben, wenn Sie für einen speziellen Contest eine Übersetzung 
benötigen.

2. Allgemeine Contest-Logs (General contest logging)

2.1. DX log

Window: Select Log type 

• Log Type: DX 
• Mode Category: MIXED If you want to have the possibility of making SSB and 

CW contacts 

For general or DX logging. 

• Entered QSOs in General log (or DX log) don't need to have an exchange 
• Dupes are shown by the word Dupe! but the qso can be logged 
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2.2. DXpedition

Window: Select Log type 

• Log Type: DXPEDITION 
• Mode Category: MIXED If you want to have the capability of logging SSB and 

CW contacts 

For DXpedition logging 

• Entered QSOs in the DXPEDITION log don't need to have an exchange 
• Dupes are shown by the word Dupe! but the QSO can be logged 

2.3. DXSERIAL

Window: Select Log type 

• Log Type: DX SERIAL 
• Mode Category: MIXED If you want to have the possibility of making SSB and 

CW contacts. 

For general Serial Number contest logging 

• Entered QSOs in DXSERIAL don't need to have an comment 
• Dupes are shown by the word Dupe! but the QSO can be logged 
• 'Standard' points calculation; 1 point per qso, DXCC countries are counted 

o All other kind of multiplier and point calculations have to be done by 
hand 

o This for all not supported serial number contests 

2.4. DX satellite

Window: Select Log type 

• Log Type: DXSATELLIT 
• Mode Category: MIXED If you want the capability of logging SSB and CW 

contacts 

For Satellite logging. 

• Entered QSOs in the DXSATELLIT log don't have an exchange and don't 
need to have a grid 

• When a grid is entered it needs to be 4 or 6 characters long 
• Dupes are shown by the word Dupe! but the QSO can be logged 

2.5. VHFDX

Window: Select Log type 

• Log Type: VHFDX 
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• Mode Category: MIXED If you want to log both SSB and CW contacts 

For VHF and up logging. 

• Entered QSOs in VHFDX don't need to have a grid 
• When a grid is entered it needs to be 4 or 6 characters long 
• Dupes are shown by the word Dupe! but the qso can be logged 
• Bearing info is shown in the log window and saved in the Misc field 
• Distance info is shown in km in the log window and saved in the Points field 

2.6. VHFSERIAL

Window: Select Log type 

• Log Type: VHFSERIAL 
• Mode Category: MIXED If you want to log both SSB and CW contacts 

Comments needs to be added using Ctrl+N. There is no room left in the Entry 
Window to add a separate field for it. Comments will be shown in the log window and 
added to the Cabrillo and generic output reports 

For VHF and up logging 

• Entered QSOs in VHFSERIAL don't need to have a grid 
• When a grid is entered it needs to be 4 or 6 characters long 
• Dupes are shown by the word Dupe! but the QSO can be logged 
• Bearing info is shown in the log window and saved in the Misc field 
• Distance info is shown in km in the log window and saved in the Points field 

3. Gelöschte QSOs (Deleted QSOs)

DELETEDQS "contest" 

QSOs which are deleted from other logs using 'Edit Contact' are moved to this 
'contest'. This is especially important for multi-user support. The moved QSOs can be 
exported. 

4. Kurzwellen-Conteste in CW und SSB (HF CW/SSB contests)

4.1. 9A CW contest

The 9A (Croatian) CW contest is a CW only contest. 

• Window: Select Log type 
o Log Type: 9ACW 
o Mode Category: CW 
o Sent Exchange: 001 
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4.2. All Asian CW / SSB

The All Asian contest can be used by Asian stations and DX stations. 

• Window: Select Log type 
o CW 

 Log Type: ALLASIACW 
 Sent Exchange:Your age Example: 34 

 XYL and YL stations may give 00 
o SSB 

 Log Type: ALLASIASSB 
 Sent Exchange:Your age Example: 34 

 XYL and YL stations may give 00 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an Asian station or a non-Asian station. 

4.3. Asia-Pacific Sprint CW / SSB

The Asia-Pacific Sprint contest can be used by Asia-Pacific stations and DX stations. 

• Window: Select Log type 
o CW 

 Log Type: APSCW 
 Sent Exchange:001 

o SSB 
 Log Type: APSSSB 
 Sent Exchange:001 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an Asia-Pacific station or a DX station. 

4.4. ARCI QRP Contests & Michigan QRP Contest

The ARCI contest supports 7 ARCI QRP Contests. The Michigan QRP Contest 
almost has the same rules. 

• Window: Select Log type 
o Log Type: ARCI 
o Mode Category: 

 CW 
 for Spring QSO party ; HootOwl Sprint ; Summer 

Homebrew Sprint ; Fall Qso Party ; Holiday Spirits ; 
Michigan QRP Contest 

 SSB 
 for Winter Fireside 

 MIXED 
 for Topband Sprint 

o Sent Exchange: 
 First Part 
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 State abbreviation for USA stations. Example: CT 
 Province abbreviation for VE stations. Example: ONT 
 Country abbreviation for non US or VE stations. Example: 

DL 
 Second Part 

 ARCI number for ARCI members 
 Send power for non-ARCI members 

• Log Window: Mult = DXCC Mult2 = Section (State or Province) Example: CT 
• Power is recognized being a non numeric number. Example: 100W is power, 

100 is a member number 
• There is a check on provinces and states, no check on countries. The program 

will give a proposal for the country prefix if non VE or K 
• No calculations made for power multi or Bonus Points, this has to be done by 

the operator after the contest on the summary sheets 
• Select CW, SSB or MIXED as 'mode Category 'to have the multiplier window 

work correct 
• It is allowed by the program that stations work each other in the contests in 

both modes even when only CW or SSB is allowed according the rules. I 
assume the operator knows the rules... 

4.5. ARI International DX Contest

The ARI International DX contest can be configured for Italian stations and DX 
stations. 

• Window: Select Log type 
o Log Type: ARIDX 
o Sent Exchange: 

 001 for non-Italian stations 
 Your Province for Italian stations 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an Italian station or a DX station. 

4.6. ARRL 10 Meter contest

The ARRL 10M contest can be used by K/VE stations and DX stations. 

• Window: Select Log type 
o Log Type: ARRL10M 
o Sent Exchange: 

 Your state/province - for K/VE stations Example: NY 
 001 - for DX stations (non K/VE) 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX station or a W, KH6, KL7, VE station. 

All non-28 MHz spots are marked as unworkable. 
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4.7. ARRL 160 Meter contest

The ARRL 160M contest can be used by K/VE stations and DX stations. 

• Window: Select Log type 
o Log Type: ARRL160 (not ARRL160M if shown) 
o Mode Category: CW 
o Sent Exchange: 

 ARRL/RAC section - for ARRL/RAC stations Example: VI 
 <nothing> - DX stations don't need to enter anything here (non 

K/VE), DX stations only send a report, no further exchange. 

The callsign in the Station Information dialog (>Config >Change Your Station Data 
>Call) determines if you are a DX station or an ARRL/RAC station. The ARRL/RAC 
stations can be found at http://www.arrl.org/contests/sections.abv.html 
The contest module accepts for /MM and /AM stations as ITU zones: R1, R2 or R3.
All non-160 meter spots are marked as unworkable. 

4.8. ARRL Field Day contest

The ARRL Field Day contest can only be used by US (K, KL and KH) & Canada 
stations (i.e. there are more FD contests outside the US & Canada which are not 
supported). 

• Window: Select Log type 
o Log Type: FD 
o Sent Exchange: 

 Your Class Your section 

Here is word from Dan Henderson from the ARRL contest branch on using Cabrillo 
for your log submission. 

Field Day is not included in the Cabrillo format. It has no way to mark/indicate power 
sources, GOTA station callsigns, bonus points, NTS traffic messages, etc. Also, Field 
Day only requires Dupe Sheets, not full logs. It is perfectly acceptable to include the 
Cabrillo log in lieu of the Dupe Sheets, but Field Day must have a completely filled 
out Summary sheet that includes all necessary information. This can be done with a 
"reasonable facsimile" electronically. However, since "proofs of bonus" (i.e. copies of 
letters to newspapers, visitor logs, photos, etc) are abundantly provided, most people 
find it easier to do Field Day via the regular mail - and use a combined system of 
part-electronic added to the paper summaries. Anything received electronically for 
Field Day will be receipted but we may have to manually follow up if we can't get the 
basic required information from the email. 

73' Dan Henderson, N1ND 

4.9. ARRL International DX contest - CW / SSB

• Window: Select Log type 
o CW 
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 Log Type:ARRLDXCW 
 Mode Category: CW 
 Sent Exchange: Your state/province - for K/VE stations Example: 

NY 
 Sent Exchange: Power - for DX stations (non K/VE) Example: 

200 
o SSB 

 Log Type:ARRLDXSSB 
 Mode Category: SSB 

 Sent Exchange: Your state/province - for K/VE stations Example: 
NY 

 Sent Exchange: Power - for DX stations (non K/VE) Example: 
200 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX stations or a W/VE station.&&& The default power 
for DX stations is: 

• 100 Watts - Default 
• 200 Watts - For the following countries: UA, UA2, UA9, UK, UN, UR, R1FJ, 

R1MV 
• 400 Watts - For the following countries: G, GM, GI, GD, GM, GM/s, GW 
• 500 Watts - For the following countries: I, IS, IT9 

Give 'Space' when the cursor is in the callsign field to have the 'Power' field filled with 
the default power. The default power will only be entered when the Power filed is 
empty. If you type another power level, it will replace the default power that the 
program put in there. 

Some stations give K or KW for 1000 watts. You don't have to enter 1000, just type 
K. The log checking software from the contest committee will understand. 

Call History for DX stations: When Call History is selected and a file is imported 
with US callsigns and States, the bandmap will be checked against the log and the 
callhistory and colored for mults when needed. So incoming spots will be colored 
when they are a qso, dupe or mult and found in the log or callhistory. 

4.10. ARRL November Sweep Stakes - CW / SSB

• Window: Select Log type 
o CW 

 Log Type: SSCW 
 Mode Category: CW 
 Sent Exchange: Precedence Year first licensed ARRL/RAC 

section Example: B 70 EMA (and in this order!) 
 F5 key: ! 
 F2 key: Right click on the CW message buttons and 

change F2 to: # B 70 EMA. 

If you have separate run & S&P buttons, you may have to do it twice. 
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o SSB 
 Log Type: SSSSB 
 Mode Category: SSB 
 Sent Exchange: Precedence Year first licensed ARRL/RAC 

section Example: B 70 EMA (and in this order!) 
 F5 key: ! 
 F2 key: Right click on the SSB message buttons and 

change F2 to: #C:\Program Files\N1MM 
logger\wav\ssexch.wav or #C:\Program Files\N1MM 
logger\wav\number.wav#C:\Program Files\N1MM 
logger\wav\ssexch.wav&&& Then you need to record 
1.wav through 0.wav and put them in the directory set in 
the Files tab for the letters directory in the Configurer. It is 
pretty tough to get them as readable as real spoken serial 
numbers but if you need it, the capability is there. 

• Spaces are required in the exchange except between the Nr & Prec. You may 
put the exchange elements in out of order and repeat them. The last one will 
be used 

• The cursor is positioned at the end of the exchange when swapping radios 
• Ambiguous exchanges are shown in blue (Nr > 9 & Nr < 100) 

1. Select log type and mode 
2. In the contest selection dialog, enter B 55 CT or whatever you Prec, Ck & 

Section are 
3. Set up the F2 keys (Run and S&P) 
4. If you want or don't want leading T's for the numbers, check the appropriate 

box in the configurer 

Sweepstakes has different support in the logging program from any other contest 
because it is a five part exchange (call, nr, prec, ck, section). There are two text 
boxes for this and not six. The first is for the call. The second is for ALL five. The 
larger (second) textbox will allow you to enter any of the exchange elements in any 
order. There are some rules that are used to interpret ambiguous information, but 
you can always look at the frame above the textbox to tell what the program thinks 
you are trying to log. 

Here are some examples of exchanges and what they mean: 261 A 55 CT 261A 55 
CT 12B Q CT 61 12B 61 CT 12B Q CT 61 EMA 44 61Q 44 EMA CO CT 12 13 B 12B 
13 CT 12A W1XX CT 66 12A W1XX 66 CT W1XX overrides call in call textbox 

Also possible is for the check and section "68NM", as well as "68 NM". 

The rules are: (You must enter a space between parts, except between Nr & Prec.) 

1. Parse from RIGHT to LEFT 
2. When you find a token of a certain type, stop looking for that type 
3. Nr = 1 or 3+ digit number 
4. CK = 2 digit number 
5. Section = 2 character or more alpha token 
6. Prec = 1 digit alpha token 
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7. If there is one two digit and one three digit number, than the two digit is the ck 
& the three digit is the nr 

8. If there are just two numbers and they are both 2 digits, the first is the nr, the 
second the ck 

Try it. It's easier to use than it is to describe. 

Examples playing WAV files using ESM. 

Example 1- You speak the callsign from the station 

• Put a 'single space' in the callsign button (mostly F5). 
• Now what you do is speak the call, Nr 123, then press enter. Your exchange 

wav file should be something like "Bravo, N1MM, Check 61 Connecticut" 

Example 2 - The program speaks the callsign from the station 

• Put ! in for the callsign wav file. That will speak the call 
• Put #C:\Program Files\N1MM logger\wav\ssexch.wav in for the exchange wav 

file 
o Don't forget the #, this will send the nr 
o C:\Program Files\N1MM logger\wav\ssexch.wav will send your 

exchange file (obviously, substitute the name of your exchange wav 
file) 

o Now ESM will say when responding to W1AB this when pressing enter: 
Whiskey One Alpha Bravo One Two Three Bravo, N1MM, Check 61 
Connecticut 

4.11. Asia-Pacific Sprint Contest CW / SSB

• Window: Select Log type 
o CW 

 Log Type: APSCW 
 Mode Category: CW (spring and fall) 
 Sent Exchange: 001 

o SSB 
 Log Type: APSSSB 
 Mode Category: SSB (summer) 
 Sent Exchange: 001 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX stations or an Asia-Pacific station. 

4.12. Baltic contest

The Baltic contest can be configured for stations from the Baltic countries (ES, YL, 
LY) and DX stations. 

• Window: Select Log type 
o Log Type: BALTIC 
o Sent Exchange: 001 
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The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX station or a Baltic station. 

4.13. CNCW Spanish contest

The CNCW contest (EA CW NATIONAL CONTEST) is only for Spanish stations 
operating inside the national territory. 

• Window: Select Log type 
o Log Type: CNCW 
o Mode Category: CW 
o Sent Exchange: Spanish Province letters Example: SG 

4.14. CQ-M International DX contest

• Window: Select Log type 
o Log Type: CQM 
o Mode Category: Select what category you enter (SSB, CW or Mixed) 
o Sent Exchange: 001 

4.15. CQ 160 Meter DX contest - CW / SSB

• Window: Select Log type 
o CW 

 Log Type: CQ160CW 
 Mode Category: CW 

o SSB 
 Log Type: CQ160SSB 
 Mode Category: SSB 
 Sent Exchange: 

 Your state/province - for K/VE stations Example: NY 
 Your country abbreviation - for DX stations (non K/VE) 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX stations or a W/VE station. 

All non-160 meter spots are marked as unworkable. Spots are marked with state 
from call history lookup as mults (if needed) in Bandmap and Available windows. 

4.16. CQ World Wide DX contest CW / SSB

• Window: Select Log type 
o CW 

 Log Type: CQWWCW 
 Mode Category: CW 
 Sent Exchange: Your zone Example: 14 

o SSB 
 Log Type: CQWWSSB 
 Mode Category: SSB 
 Sent Exchange: Your zone Example: 14 
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• The default zone values for US (K,N,W,A) stations are 
o Zone 3 - If number in callsign is 6 or 7 
o Zone 4 - If number in callsign is 5 or 8 or 9 or 0 
o Zone 5 - If number in callsign is 1 or 2 or 3 or 4 

• The default zone values for Canadian (VE) stations are 
o Zone 1 - If callsign starts with: VY1 
o Zone 2 - If callsign starts with: VE2, VO2 
o Zone 3 - If callsign starts with: VE7, VC7 
o Zone 4 - If callsign starts with: VE3, VE4, VE5, VE6, VA3 
o Zone 5 - If callsign starts with: VO1, VE1, XJ1, VY2 

• Give 'Space' when the cursor is in the 'Callsign' field to have the 'Zone' field 
filled with the default value 

• The default zone will be selected, so that if you type another zone, it will 
replace the numbers that the program put in there 

• For US users, Ctrl+Up/Ctrl+Dn doesn't stop at US stations 
• US spots are not grayed out for Canadian users 
• Don't show and count own countries as workable in the Bandmaps and the 

Available window 
• A new zone will be shown in red in the Entry window 
• Band changes 

o The allowed band changes are 8 for all CQ Contests 
o The band change counter is reset to 0 on first contact after the top of 

the hour 
• The program will look up the zone if the call has been changed, provided no 

zone was typed by the user 

4.17. CQ World Wide WPX contest - CW / SSB

• Window: Select Log type 
o CW 

 Log Type: CQWPXCW 
 Mode Category: CW 
 Sent Exchange: 001 i.e Serial number Example: 001 

o SSB 
 Log Type: CQWPXSSB 
 Mode Category: SSB 
 Sent Exchange: 001 i.e Serialnumber Example: 001 

• Leading zeros are being forced on sent & received serial numbers 
• Multi-Single and Multi-Two entries have a single set of serial numbers across 

all bands 
• Band changes (per hour) 

o The allowed band changes are 8 for all CQ Contests 
o The band change counter is reset to 0 on first contact after the top of 

the hour 

4.18. CIS contest - CW / SSB

The Commonwealth of Independent States Contest where everybody can work 
everybody for QSO and multiplier credit. 
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• Window: Select Log type 
o Log Type: 

 CW: CISCW 
 SSB: CISSSB 

o Sent Exchange: 
 CIS stations: CIS area code Example for Moscow City: RU11 
 Non-CIS stations: 001 

4.19. Cup of the Russian federation RFC contest - CW / SSB

The RFC Contest is an internal Russian contest only between Russian stations. 

• Window: Select Log type 
o Log Type: 

 CW: RFCCW 
 SSB: RFCSSB 

o Sent Exchange:Grid Example: 115 

4.20. DARC 10 meter contest

• Window: Select Log type 
o Log Type: DARC10M 
o Mode Category: MIXED or CW (depends on the entry class) 
o Sent Exchange: 

 DL stations:DOK Example: A12 
 non DL stations: empty 

Call history lookup for DOK's is supported. Make a text file with Call and DOK and 
import this in the program. See the chapter Before the Contest for information how to 
use Call History and how to create the text file. During the contest "Call History 
Lookup" has to be enabled under the Config menu. When a station (which is in the 
Callhistory lookup table) is entered, pressing SPACE when the cursor is in the 
callsign field will enter the DOK in the section field. 

The contest manager from the DARC 10 meter contest approved and will accept the 
files made by N1MM logger and likes to receive: 

File How to make... Exported

Log file >File >Export >Export to File (Generic) >Generic File 
Output sorted by time [callsign].txt

Summary 
sheet >File >Export >Print Score Summary to File [callsign].sum

• Send the "Generic File Output sorted by time" as a txt-File named with your 
call like DL8WAA.TXT 

• Don't forget your used own call, category and if you are a DL station: own sent 
DOK. This can be put in the Email or sent in the Cabrillo file. 
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4.21. DARC Weihnachtswettbewerb - XMAS contest

The DARC Weihnachtswettbewerb is a contest on December 26 from 08.30-10.59 
UTC between any station on 40 and 80 meters. The DARC contest manager for the 
Xmas contest accepts the standard generic file as log together with the summary 
sheet.. 

• Window: Select Log type 
o Log Type: XMAS 
o Mode Category: MIXED 
o Sent Exchange: 

 DL stations:Serial number + DOK Example: 001 A12 
 Non-DL stations: Serial number Example: 001 

During the contest info about suspicious DOK's are shown in the info bar and written 
to the Notes filed.&&& After the contest check >View >Notes for the following 
situations: 

• "DL station non DARC member" - no DOK is given (DL station who is not a 
DARC member) 

• "DL station with DOK length 1" - DOK length is only one 
• "DOK with only numbers" - no letters in DOK 

4.22. DIG contest - CW / Phone

• Window: Select Log type 
o Log Type: 

 CW: DIGCW 
 SSB: DIGSSB 
 Sent Exchange: anything as it is not being used (DIG members 

could enter their DIG number here) 

4.23. European Sprint - CW/ SSB - EU sprint

• Window: Select Log type 
o CW 

 Log Type: EUSCW 
 Mode Category: CW 
 Sent Exchange: Serialnumber & Operator name Example: 001 

Tom 
o SSB 

 Log Type: EUSSSB 
 Mode Category: SSB 
 Sent Exchange: Serialnumber & Operator name Example: 001 

Tom 

Example: The Exchange key (F2) can look like this: de * # {Exch} where "#" is current 
QSO Number and "{Exch}" is the Operator name. 
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4.24. EU HF Championship

• Window: Select Log type 
o Log Type: EUHFC 
o Sent Exchange: Last two digits of the year of operator's first official 

amateur radio license Example: 82 (for 1982) 

4.25. Field Day Region 1

The Region I field day contest can be configured for Region 1 stations and DX 
stations. Supported are the rules for stations in Belgium, Germany, United Kingdom 
(**), Netherlands, Switzerland, Ireland (only CW), Italy, Slovenia (S5) and Russia 
(UA, UA2, UA9). 

• Window: Select Log type 
o Log Type: FDREG1 
o Sent Exchange: 001 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call) determines if you are a Region 1 supported station or not and if you are /P etc. 
or not.. 

N1MM Logger checks whether the callsign used is a portable or a fixed station by 
checking the callsign in the Station dialog under config! So using a /P, /M etc there 
could make a difference in scoring! 

United Kingdom: The ModeCategory selects the CW or the SSB version of the 
contest. The rules between the CW and the SSB version are very different. 

4.26. FOC marathon

• Window: Select Log type 
o Log Type: FOCCW 
o Sent Exchange:membership number 

The calculation of bonus points for working the same station on 5 (10 additional 
points) or on 6 bands (an extra 5 points) is not supported by the program.
Martin/OK1RR and John/G3WGV have posted contest routines to rescore the 
contest from a Cabrillo file to a fully correct (including the 5/6 band bonuses). 

4.27. GACW WWSA CW DX contest

The GACW WWSA CW DX contest can used by South American stations and DX 
stations. 

• Window: Select Log type 
o Log Type: GACW 
o Mode Category: CW 
o Sent Exchange: Your zone Example: 14 

• The rules are almost equal to the CQWW contests. 
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• Default zones for US (K,N,W,A) and Canadian (VE) stations apply 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a SA station or a DX station. 

4.28. HA DX Contest

The Hungarian DX Contest can be configured for HA stations and DX stations. 

• Window: Select Log type 
o Log Type: HADX 
o Sent Exchange: 

 non-HA stations: 001 
 HA stations 

 HADXC members: HADXC membership number 
Example: 101 

 Other HA stations: two letters county code. Example: GY 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a HA station or a DX station. 

4.29. Helvetia Contest

The Helvetia Contest can be configured for HB stations and DX stations. 

• Window: Select Log type 
o Log Type: HELVETIA 
o Sent Exchange: 

 001 for non-HB stations 
 001 Your Canton Example: ZH for HB-station 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX station or a HB station. 

4.30. High Speed CW Contest

The HSC CW contest can be configured for members and non-members. 

• Window: Select Log type 
o Log Type: HSCCW 
o Mode Category: CW 
o Sent Exchange: 

 Non-members: NM 
 Members: HSC-Membershipnumber 

4.31. Holyland Contest

The Holyland Contest can be configured for 4X stations and DX stations. 

• Window: Select Log type 
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o Log Type: HOLYLAND 
o Sent Exchange: 

 001 for non-4X stations 
 Your Area Example: E15RH 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX station or a 4X station. 

4.32. IARU Radiosporting contest HF

• Window: Select Log type 
o Log Type: IARU 
o Mode Category: CW or SSB or MIXED 
o Sent Exchange: IARU member society abbreviation for IARU member 

society HQ stations and IARU International Secretariat club station 
 AC for IARU Administrative Council 
 "R1," "R2," and "R3" for the three IARU regional Executive 

committees 
 ITU zone for all other stations Example: 27 

The zone is prefilled while typing the callsign to allow multipliers to be shown while 
typing the callsign. 

4.33. IOTA - Islands On The Air Contest

• Window: Select Log type 
o Log Type: IOTA 
o Sent Exchange:001 NA123 (default exchange) 

 Where the own IOTA reference has to be in the form XXYYY 
where XX = letters and YYY = numbers. 

NB. The syntax for an IOTA reference has to be in the form XXYYY where XX = 
letters and YYY = numbers. Example: 001 EU001 and not 001 EUTT1 or 001 EU1
If not the program can not determine the own IOTA reference and give correct points! 

• The received IOTA reference does not need the dash (-) when logged. 
Example: Enter EU123 in the IOTA field not EU-123. The Cabrillo output will 
automatically have the - added 

• The IOTA has many multipliers and therefor the program will only show 
worked IOTA references and add a new IOTA reference when a new multiplier 
is worked. In the Multiplier window, choose the tab "Sect" 

• When only an IOTA reference is entered the color of the IOTA reference and 
the color of the Available buttons for new island are updated, even if no 
callsign specified 
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4.34. International Naval Contest

4.35. JA domestic contests

This is a general contest class for Japanese domestic contests and only for use by 
JA stations. 

• Window: Select Log type 
o Log Type: JAdomestic 
o Sent Exchange: Section + class Example: 25M or 10L 

General rules: 

• Japanese stations may only work Japanese stations 
• Example exchange numbers in ALL JA contest with assuming as follows. 

o I am in Osaka with 100W output and another party is in Tokyo with 
10W.' send:59925M receive:59910L 

o I am in Okinawa with 1KW output and another party is in Sapporo in 
JA8 with 50W. send:59947H receive:599106M 

• Dupe and multiplier examples 
o 20 mtr JE1CKA 10H SSB 1 point + multiplier 
o 20 mtr JE1CKA 10H CW 0 points dupe, no multiplier 
o 20 mtr JE1CKA 10H SSB 0 points dupe, no multiplier 

• Same station should counts for 1 point only once on each band regardless of 
mode. 

• The multiplier counts once on each band regardless of mode. 
• When the SentExchange does not end on H, L, M or P then there is no 

Powercode check. 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a JA station. 

4.36. JIDX contest

This JIDX contest contest can be configured for Japanese stations and DX stations. 

• Window: Select Log type 
• CW 

o Log Type: JIDXCW 
o Mode Category: CW 
o Sent Exchange: 

 non-JA stations: CQ Zone number Example: 14 (01 to 40) 
 JA stations: Your Prefecture Example: 34 (01 to 50) 

• SSB 
o Log Type: JIDXSSB 
o Mode Category: SSB 
o Sent Exchange: 

 non-JA stations: CQ Zone number Example: 14 (01 to 40) 
 JA stations: Your Prefecture Example: 34 (01 to 50) 
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The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a JA or a DX station. 

4.37. King of Spain Contest

The King of Spain contest can be configured for EA stations and DX stations. 

• Window: Select Log type 
o CW 

 Log Type: KINGEACW 
 Mode Category: CW 
 Sent Exchange: 

 non-EA stations: 001 
 EA stations:Your Province Example: AV 

o SSB 
 Log Type: KINGEASSB 
 Mode Category: SSB 
 Sent Exchange: 

 non-EA stations: 001 
 EA stations:Your Province Example: AV 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX station or a EA station. 

4.38. Logbook of the World Contest - CW / SSB

• Window: Select Log type 
o Log Type: 

 CW: LOTWCW for the Digital part of the contest (LOTWRTTY) 
 SSB: LOTWSSB 

o Sent Exchange: 
 For North American stations: State/Province abbreviation 

Example: CT 
 For non North American stations: Countryprefix 

4.39. LZ DX Contest

The LZDX contest can be configured for LZ stations and DX stations. 

• Window: Select Log type 
o Log Type: LZDX 
o Sent Exchange: 

 non-LZ stations: ITU zone 
 LZ stations:Your District abbreviation Example: BU 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX station or a LZ station. 
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4.40. LZ Open and LZ Sprint Contests

Supports all three versions of the contest (LZ Open contest, LZ Open 40 meter Sprint 
contest and LZ Open 80 meter Sprint contest) 

• Window: Select Log type 
o Log Type: LZOPEN 
o Sent Exchange: 001 
o Select LZOPEN contest. The Sent Exchange in the "contest selection 

window" is 001 or #. 
o Your F2 exchange message should be: {EXCH}{LASTEXCH} or 

#{LASTEXCH} 
o Since it is required, the program will always send leading zeros for this 

contest. Unchecking the leading zeros box in Configurer will have no 
effect 

o When a callsign is in the Entry Window, the Info Window displays the 
time since you last worked the station 

o If you have a radio interface enabled, the bandmap colors of the 
callsigns will update when you can work the station again for points 

 Set the Bandmap Packet Spot Timeout greater than 30 minutes 
o Do not enter received cut letters into the exchange box. They will not be 

converted to numbers 
o Read the contest rules 
o Submit the contest results with the Cabrillo output 

The 30 minute time period is computed per the organizers instructions. That is to 
ignore the seconds of the logged QSO when computing the 30 minute interval. The 
30 minute interval is computed from the last QSO on the current band so it is not 
recommended to log a contact that will not produce any points. 

LZ Open and LZ Sprint contests display the sent exchange on the Entry Window 
status line. This addition expects that the {LASTEXCH} macro is used as required by 
these contests. 

4.41. Manchester Mineira Contest

The 'Manchester Mineira Contest by CWJF is the major CW contest in South 
America. Only South American stations are allowed to work each other. 

• Window: Select Log type 
o Log Type: CWJFMM 
o Mode Category: CW 
o Sent Exchange: M, YL, QRP or Space (not empty) 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a South American station. 
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4.42. Michigan QRP Contest

See the ARCI contest which uses almost the same rules.
Supported are: January CW Contest ; Memorial Day CW Sprint ; July 4th CW Sprint ; 
Labor Day CW Sprint 

4.43. MiniTest CW Test

Almost every week on Wednesday at 18 GMT and lasts only one hour. It has 6 time 
periods (10 minute each). Band: 3520 - 3570 kHz, mode: CW, exchange: 
RST+serial. Every QSO gives 1 point, multiplier: the number of unique calls during 
this hour of the contest. Classes: 1- club station, 2 - SO, A- power > 100 W, B - 
power <= 100 W, 3 - SWL. The results can be submitted at 19.00 GMT on 3720 KHz 
(SSB) or on 3541 KHz (CW). The submitted information (QSO number, multiplier, 
class) will look like this: "125 36 A". The results are published here: 
http://www.minitest.narod.ru/2009/2009.htm 

4.44. NA Sprint CW / SSB

• Window: Select Log type 
o Log Type: 

 CW: SPRINTCW 
 SSB: SPRINTSSB 

o Sent Exchange: 001 Tom CT 
 Serial number, your name and your location (state, province or 

country) Example: PA1M DE N1MM 123 TOM CT K 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a North American station or a non-North American 
station. 

• Example function keys can be found in the Example Function Keys chapter 
• Check out the Macros chapter. Great for Sprint are the macros {PGUP} and 

{PGDN}. 
o By Tom - W4BQF: Open config - Confiigure Ports.... - Other. Under the 

'Other' tab, look at the right-most column, where you will see "CW 
Up/Down Arrow" and "PgUp/PgDown". These can be configured to 
QSY. Configure the Up/Down Arrow keys to QSY, say 2 kHz each time 
you press your keyboard up or down arrow keys. Configure 
PgUp/Down to QSY 'x' kHz, and then use {PGUP} or {PGDN} as a 
macro assigned to any of the function keys. Example: F10 Freq UP, 
{PGDN} {run} F11 Freq DN, {PGUP}{run}
In my case "PgUp/Down" will move my frequency 5.5 kHz and the "CW 
UP/Down Arrow" keys set to QSY 1.5 kHz. A little tricky because 
{PGDN} actually moves you UP in frequency, but it works very well. 

• How to prevent callsigns in the frame of the callsign field 
o During the sprint you can turn off the bandmaps, they are not very 

useful in this contest 
o If that is not sufficient, you can turn off "Show non-workable spots". Be 

sure to turn it back on for other contests. Showing dupes and non-
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workable stations is one of the best features of the program (but, 
unfortunately, not for Sprint) 

o Use Alt+D to remove the spot from the bandmap & call frame 
o Do NOT turn on "QSYing wipes the call& spots QSO in bandmap 

(S&P)" for the Sprint. That is exactly what you don't want. It is a great 
feature, but only for contests where stations are allowed to run. It 
makes it easy to come back to a station that was taking too long to 
make a qso when you first found them 

NA Sprint CW by Kenny, K2KW 

North American Sprint CW is just a few hours away, and thought I would take a 
moment to help others get their CW messages ready. Your messages may differ 
slightly from mine, but I just wanted to highlight what's happening on the F2 and F3 
messages which are the key setup items for Sprint. The F2 exchange is set up to 
give you the correct sequence for this contest using ESM, and the exchange 
sequence varies based on if you are Calling CQ, or you answered someone while 
S&P. F3 is used to confirm the message, and change your state from S&P to 
Running, or Running to S&P. The {RUN} and S&P} macros are inserted at the end of 
the F3 message, and will automatically change your state, and thus exchange 
sequence. 

I have also changed the Up/Down Arrow to move 1.5 kHz, giving you an "instant 
QSY" per the rules. You may choose to use a wider QSY increment, but the goal was 
to offer you an idea for QSYing so you can abide by the rules. 

If you are not aware of the uniqueness of the Sprint exchange and QSY rule, check 
out: http://n6tr.jzap.com/sprint.html and http://www.ncjweb.com/sprintrules.php 

73 and CU in the contest, 

• Set the Exchange: 
o >File >Choose Which Contest to Log >Sent Exchange 

 # yourname yourstate 
 Example: # KEN CA 

• Set QSY distance: 
o In the >Config >Configurer >Other window, change the CW Up/Down 

Arrow Incr = 1.5 
 That gives me an instant QSY somewhat greater than the 

minimum QSY required after you leave a frequency. Any value 
over 1 kHz is recommended 

N1MM Logger Sprint Survival Tips - Version 0.3 

I thought I would share what I have learned about customizing N1MM Logger for this 
contest. I'm not going to try to explain how to operate the Sprint - for this, there is an 
excellent writeup at: http://n6tr.jzap.com/sprint.html 

What I will do is describe how to get the most out of N1MM Logger in the Sprint. My 
operation is SO2R, and my configuration is optimized for that mode. However, I'm 
sure you SO1R guys will pick up a few tricks from what I have done for SO2R. The 
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most important thing is to get your options, windows and function keys set up 
correctly before the Sprint starts. 

The Options - Start up N1MM Logger using version 9.6.0 or later, and create a new 
SPRINTCW contest. I assume that your radio(s) are interfaced to N1MM Logger, so 
that N1MM Logger will automatically track the frequency of each radio. If you do not 
have interfaced radios, this configuration and function key assignment will not work 
correctly for the Sprint. 

In the Config menu, select the following options:

• Enter sends message (ESM) 
• QSYing wipes the call & spots QSO in bandmap 
• Do not run on CQ frequency 
• Show non-workable spots 
• SO2R->Toggle CTRLFx Macro 

The “Toggle CTRLFx Macro” can also be toggled using Ctrl+Shift+L. This is handy if 
you need to turn off {CTRLFx} during the contest 

The Windows... These are the only windows I have on my screen:

• Entry Window (one for each radio) 
• Visible Dupesheet (one for each radio) 
• Info 
• Log 
• Score Summary 

They all fit nicely on my small monitor. My screen layout is shown at 
http://www.kkn.net/~n2ic/sprint.bmp.
The Visible Dupesheet is really nice once you get used to it. To see if a station is a 
dupe, you just scan the dupesheet with your eyes, rather than frantically type a call 
into the Entry Window.
Notice that I do NOT have the "Available Mults & Q's" nor the Bandmap windows 
open. 

Now, I'm about to temporarily contradict myself. Open a Bandmap window. Right 
click and select "Packet Spot Timeout". Change the packet spot timeout to 1 minute. 
That's right....1 minute. Hit OK. Now close the Bandmap window. Don't reopen it. It is 
of no value in Sprint, but it is important to change the packet spot timeout value to 1 
minute. (Side note: This option should really be called "Bandmap Timeout" not 
"Packet Spot Timeout". It controls how long calls stay on the bandmap and the 
appearance of calls in the "on deck" frame of the Entry Window. We're obviously not 
using packet in the Sprint.) 

Function Keys - Here are my function key definitions. I'll explain a few that aren't 
obvious.

NA Sprint CW Function Keys - by N2IC
Run S&P 
F1 CQ cq na cq na * na F1 S&&P CQ cq na cq na * na
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F2 Exc h * # steve nm F2 S&&P Exch ! # steve nm * {RUN}
F3 TU {CLEARRIT}t{END}{CONDJUMP} F3 S&&P tu tu
F4 
{MYCALL} * F4 S&&P 

{MYCALL} *

F5 his Call ! F5 S&&P his 
Call !

F6 QSO B4 qso b4 * F6 -
F7 Other 
Short {CTRLF10} F7 S&&P 

Other Short {CTRLF10} 

F8 Other 
Long {CTRLF11} F8 S&&P 

Other Long {CTRLF11}

F9 GoS&&P {S&P} F9 GoRun {RUN}
F10 Short 
CQ cq na * * na F10 Short CQ cq na * * na

F11 Long 
CQ cq na cq na * * na F11 Long CQ cq na cq na * * na

F12  {STOPTX}{CTRLF4} F12  {STOPTX}{CTRLF4}

• Important note: All function keys that start with {CTRLFx}, such as F7 above, 
must have a leading space before the {CTRLFx} 

• With the Run F3 key, my "thank you" message is sent. When you QSY, you 
will automatically be changed to S&P mode. Do not include the {S&P} macro 
here - it will cause the last station worked to get "stuck" in the on-call frame of 
the Entry Window 

• With the S&P F2 key, as soon as I send my exchange, it immediate switches 
to Run mode 

• I can also force myself into Run and S&P modes with the F9 key 
• The F7 and F8 keys send CQ's on the "other" radio. This is very useful when 

the other station is sending his exchange, and you are going to lose the 
frequency (i.e. it will become "his" frequency). You can send a CQ on the other 
radio, while he is sending his exchange. Then, when he finishes sending his 
exchange and you need to send your "thank you" message to finish the QSO, 
all you have to do is hit Enter, which will stop the CQ on the other radio, and 
send your Run F3 message on the active radio. However, you had better be 
ready to copy a new caller on the "other" radio. The {CONDJUMP} macro in 
the Run F3 message will move your entry focus to the "other" radio, so that 
you will be ready to copy a new caller 

• The F12 keys are used in conjunction with this AutoHotKey script: 
o NumpadEnter::F12 

• When I'm CQing on the active radio, but simultaneously doing S&P on the 
other radio, and hear a new station, I can just hit the enter key on the far right 
side of the keyboard (no fumbling !). This will stop the CQ, and send my call 
on the other radio. 

• Notice that there is a space before the F12 {STOPTX} macro 
o Yes, you need this space - don't leave it out, or this feature won't work 

• One thing you need to do is keep an eye on where your transmit and receive 
focus is (the red and green dots on the Entry Window). When you're doing 
SO2R in the Sprint, there will be times where your focus is not where you 
might expect it, or want it. Always be ready with the \ and Pause keys to jump 
between radios 
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• Yes, this takes lots of practice, and you will make mistakes. The Thursday 
night Sprints are good practice for this 

73 and see you in the Sprint ! Steve, N2IC 

4.45. NCCC NS Ladder Competition

Window: Select Log type 

• Log Type: 
o SPRINTLADD 

• Sent Exchange: 001 Tom CT 
o Serial number, your name and your location (state, province or country) 

Example: PA1M DE N1MM 123 TOM CT K 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a North American station or a non-North American 
station. 

See NA Sprint above for more information (these contests are almost alike). 

4.46. North American QSO Parties CW / SSB - NAQP

• Window: Select Log type 
o CW 

 Log Type: NAQPCW 
 Operator Category: SINGLE-OP or MULTI-TWO 

 For Multi-Two see the extra info below! 
 Mode Category: CW 
 Sent Exchange: 

 For North American stations - Operator name and station 
location (state, province, or country) Example: Tom CT 

 For non-North American stations - Operator name only 
Example: Thomas 

o SSB 
 Log Type: NAQPSSB 
 Operator Category: SINGLE-OP or MULTI-TWO 

 For Multi-Two see the extra info below! 
 Mode Category: SSB 
 Sent Exchange: 

 For North American stations - Operator name and station 
location (state, province, or country) Example: Tom CT 

 For non-North American stations - Operator name only 
Example: Thomas 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a North American station or a non-North American 
station. 

MULTI-TWO operating: When changing operator you have to use Ctrl+O to set the 
NAME (not Call) of the operator. This name set with Ctrl+O will be used in the 
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Cabrillo file. So from the Sent Exchange only the state is being used but the name is 
needed. (Example: Tom CT). The macro {OPERATOR} can be used to automatically 
switch WAV files (in SSB), for more info see the Macro section. 

4.47. NRAU - Baltic Contest

This contest is only for stations from the following countries: ES, JW, JX, LA, LY, OH, 
OHÃ?, OX, OY, OZ, SM, TF, and YL 

• Window: Select Log type 
o Log Type: 

 CW: NRAUCW 
 SSB: NRAUSSB 

o Sent Exchange: Section Example: AA 

When a station is logged the following checks are made: 

• Is the logged station from a valid country ( ES, JW, JX, LA, LY, OH, OHÃ?, 
OX, OY, OZ, SM, TF, and YL) 

• Is the entered section a valid section (from NRAU.sec) 
• A warning is given when a qso is made an another band than 7 or 3,5 MHz. A 

note is made with the logged qso. 

4.48. Oceania Contest

Supported are the CW and SSB version of the contest 

• Window: Select Log type 
o Log Type: 

 CW: OCEANIACW 
 SSB: OCEANIASSB 

o Sent Exchange: 001 

Note: The rules have special instructions for not complete portable callsigns so a 
prefix can not be deduced normally. Adding numbers like the rules state is not 
supported and should be done by editing the log file (afterwards). Example: 
N8BJQ/PA would be PA but is not a valid prefix and should become PA0 (add the 
zero). 

4.49. OK-OM DX contest

The OK-OM DX contest can be configured for OK/OM stations and DX stations. 

• Window: Select Log type 
o Log Type: OKOMDX 
o Mode Category: CW (it is a CW only contest) 
o Sent Exchange: 

 Non-OK/OM stations: 001 
 OK/OM stations: district abbreviation Example: BPZ 

11.04.2010



N1MM-Contest Logging Software Seite 362 von 470 Übersetzung der Hilfe von Eike, DM3ML

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an OK/OM station or a DX station. 

4.50. PA-beker contest

The PA-beker contest is a local Dutch contest on 40 and 80 meters. The text below is 
in Dutch. 

• Window: Select Log type 
o Log Type: 

 CW: PABEKERCW 
 SSB: PABEKERSSB 

o Sent Exchange: 
 QSL regio Voorbeeld: 27 (en niet R27) 

• QSL regio ingeven en invoeren zonder R dus 27 en geen R27 
• Log, Entry en Score summary geven de juiste scores. 
• De multiplier window (Ctrl+J) geeft onder 'Sect' de gewerkte QSL regios alleen 

daar wordt de eigen regio wel getoond indien gewerkt. 
• Er zit geen beperking op banden (dus let op dat je op 40 en 80 meter logt). 
• In te zenden log bestanden: 

File How to Make... Exported
Log file >File >Export >Export to File (Generic) [callsign].txt
Summary sheet >File >Export >Print Score Summary to File [callsign].sum

4.51. PACC contest

The PACC contest can be configured for PA stations and DX stations. 

• Window: Select Log type 
o Log Type: PACC 
o Sent Exchange: 

 001 for non-PA stations 
 Your province Example for PA-stations: DR 

PA stations have to import an adapted CTY.DAT file for the PACC contest so the 
right multipliers will be used. In the 'Entry window' go to 'Tools', and select 'Import 
country list from downloaded file'. This adapted country file can be downloaded from 
the N1MM website, under 'Downloads', select in the menu: 'Other Files'. Don't forget 
importing the original CTY.DAT file again when entering other after the PACC 
contests. 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX station or a PA station. 

The PACC contest committee approved and will accept the files made by N1MM 
logger and likes to receive: 

File How to Make... Exported
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Log file >File >Export >Export to File (Generic) [callsign].txt
Summary sheet >File >Export >Print Score Summary to File [callsign].sum

Note icon PA stations: Vergeet niet op het summarysheet te vermelden de klasse 
waarin je mee doet en de afdeling voor het afdelingsklassement! Note icon PA 
stations kunnen tijdens de PACC contest op 160 meter gelijktijdig meedoen aan de 
RSGB 1.8 MHz CW contest in de avonduren. N1MM acepeteert na het volgnummer 
ook de districtscode. Voorbeeld: 599 123AA (NB, geen spatie tussen het ontvangen 
volgnummer en de district code) 

4.52. Portugal Day Contest

The Portugal Day contest can be used for Portuguese stations (CT, CT3 or CU) and 
DX stations. 

• Window: Select Log type 
o Log Type: PORTUGAL 
o Exchange: 

 District or Autonome Region for Portuguese stations 
 001 for DX stations (serialnumber) 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a Portuguese station or DX. 

4.53. RAC Canada Day Contest / RAC Canada Winter Contest

With the same set of rules both contests are supported. These RAC contests can be 
used for VE stations and DX stations. 

• Window: Select Log type 
o Log Type: RAC 
o Exchange: 

 Province or territory for stations in Canada 
 001 for VEÃ?s and stations outside Canada (serialnumber) 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are from Canada, VE0 or outside Canada. 

4.54. RAEM CW contest

The RAEM Contest is CW only and has no multipliers, only points. These points are 
calculated based on QSO points and distance between the stations (based on 
exchanged coordinates). Extra points are added for polar stations. Extra bonus 
points for RAEM memorial stations are not added because the call RAEM has no 
number is will not be accepted by the program. Use RAEM99 or so and update the 
log and score (300 additional points) after the contest. 10 band changes per hour are 
permitted, and a band change counter is activated when this contest is selected. 

• Window: Select Log type 
o Log Type: RAEM 
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o Mode Category: CW (it is a CW only contest) 
o Sent Exchange: 001 & Coordinates Example: 001 53N6O 

 The own coordinates is the second token in Sent Exchange 
without spaces (one 'word') 

Coordinate rules: These rules apply for the 'Sent Exchange' and also when entering 
a coordinate in the Entry Window. 

• Own coordinates: Second token in Sent Exchange without spaces (one 
'word') 

• First part is the Longitude with at the end N or S Example: 53N 
• Second part is the Latitude with at the end W or O (not E) Example: 6O 
• As a total this makes: 53N6O 

Log and rescore: To generate the log use the Generic log file and the Score 
summary. Always rescore and check the log. If a qso has 1 point then the Received 
exchange is not correct. If there are QSOs who have gotten 2 points then your Sent 
Exchange is not correct. Update your Sent Exchange in the contest setup and 
rescore. Check again. 

Call History: The call history can be used but... the coordinates have to be entered 
in the Name field of the Call History table. This is the only field which is capable of 
handling all different coordinates 1N2W but also 67N169O 

4.55. REF contest - CW / SSB

The REFContest can be configured for stations in REF countries and DX stations. 

• Window: Select Log type 
o Log Type: 

 CW: REFCW 
 SSB: REFSSB 

o Sent Exchange: 
 For DX stations: 001 
 For stations in REF countries - Department (F and TK) or Prefix 

(all other REF countries) 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX station or a station in a REF country. 

4.56. RF Championship

The RF Championship is a contest for stations of the Russian Federation only. 

• Window: Select Log type 
o Log Type: RFCHAMP 
o Mode Category: Select mode used in contest (CW, SSB) 
o Sent Exchange: 001 

Please add the zone to sent in the Function keys. The points are calculated based on 
your callsign and the callsign received. 
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4.57. RSGB 1.8MHz CW Contests

The RSGB 1.8MHz CW Contests can be configured for RSGB stations and DX 
stations. 

• Window: Select Log type 
o Log Type: RSGB160CW 
o Mode Category: CW (it is a CW only contest) 
o Sent Exchange: 

 For DX stations: 001 
 For stations in the UK - 001 & District Example: 001 ZE 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are in the UK or not. 

Serial numbers must be logged from UK stations. There is no check by the program if 
a serial number is entered for non-UK stations. This because there are often several 
other EU contests going on at the same time and an entrant in those may not sent a 
serial number just an area code like DR (PACC) or a French department like 78. If a 
non UK station sends a serial number it must be logged in the received serial nr field, 
if it sends a code like DR is must be logged in the districts field. 

4.58. RSBG 21/28 MHz contest

The RSGB 21/28 MHz CW Contests can be configured for RSGB stations and DX 
stations 

• Window: Select Log type 
o Log Type: RSGB2128 
o Sent Exchange: 001 

4.59. RSGB 80 Meter Club Championship

The RSGB 80 Meter Club Championship can be configured for RSGB stations and 
DX stations 

• Window: Select Log type 
o Log Type: RSGB80MCC 
o Sent Exchange: 001 

4.60. RSGB Affiliated Societies Team Contests - AFS

The RSGB Affiliated Societies Team Contests can be configured for RSGB stations 
and DX stations 

• Window: Select Log type 
o Log Type: 

 CW: RSGBAFS-C 
 SSB: RSGBAFS-S 

o Sent Exchange: 001 
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4.61. RSGB Club Calls contest

The RSGB Club Calls contest can be configured for RSGB stations and DX stations 

• Window: Select Log type 
o Log Type: RSGBCLUB 
o Sent Exchange: 001 

4.62. RSGB Commonwealth contest

The RSGB Commonwealth contest can be configured for Commonwealth stations 
and DX stations. 

• Window: Select Log type 
o Log Type: RSGBJUBILE <---- Note: This is correct!!! select 

RSGBJUBILE 
o Exchange: 001 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are in the Commonwealth or not. 

4.63. RSBG SSB Field Day & RSGB National Field Day

The Region I field day contest can be configured for RSGB and DX stations. 

• Window: Select Log type 
•

o Log Type: FDREG1 <---- 
o Mode Category: The ModeCategory selects the CW or the SSB version 

of the contest. The rules between the CW and the SSB version are very 
different.. 

 CW for the CW Field day contest 
 SSB for the SSB Field day contest 

o Sent Exchange: 001 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a RSGB station or not and if you are /P etc. or not.. 

N1MM Logger checks whether the callsign used is a portable or a fixed station by 
checking the callsign in the Station dialog under config ! So using a /P, /M etc there 
could make a difference in scoring! 

4.64. RSBG Low Power Field Day

The RSGB Low Power Field Day can be configured for RSGB stations and DX 
stations 

• Window: Select Log type 
o Log Type: RSGBLP 
o Mode Category: CW (it is a CW only contest) 
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o Sent Exchange: 001 Power Example: 001 2W5 

4.65. RSBG ROPOCO

The RSGB ROPOCO is an internal RSGB contest and only available for G ,GD 
,GI ,GJ ,GM ,GU and GW stations. 

• Window: Select Log type 
o Log Type: ROPOCO 
o Mode Category: CW (it is a CW only contest) 
o Sent Exchange: Your postcode (taken from station info) 

NB. Use the macro {LASTEXCH} to sent the postcode from the previous qso. 
Example F2 key: <<<5nn>>>{LASTEXCH} 

4.66. Russian District Award contest

The Russian District Award contest can be configured for Russian stations and DX 
stations. 

• Window: Select Log type 
o Log Type: RDAC 
o Sent Exchange: 

 Non-Russian stations: 001 
 Russian stations: District code by RDA list (for example TB02) 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a Russian station or a DX station. 

4.67. Russian DX contest

The Russian DX contest can be configured for Russian stations and DX stations. 

• Window: Select Log type 
o Log Type: RUSSIANDX 
o Sent Exchange: 

 Non-Russian stations: 001 
 Russian stations: Your oblast code (two letters) 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a Russian station or a DX station. Example: Default 
RU1A would have SP, in the call hisotry RU1A could be added so it will give the 
corerct exception LO. When a station is found in Call history it will use the 
section/oblast from it. IIf not found in Call history it will use the default oblast. 

Example Call history
RA1AR,,,, LO
RU1A,,,,LO
RU6FA,,,,KM 
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Log submission notes: 

'CATEGORY-OVERLAY'. In the RDXC you can submit one log and have it scored as 
two single band entries. Like operating 10m during day time and 160m at night. Now, 
this is particular to this contest and you need to submit your log like this: 

CATEGORY-OVERLAY: operator-cat band-cat power-cat mode-cat The category 
overlay of the log submission when appropriate. In RDXC, two single band entries 
are allowed from one participant. In this case, one entry must be listed under 
CATEGORY tag, the other one under CATEGORY-OVERLAY, such as: 

• CATEGORY: SINGLE-OP 80M HIGH MIXED 
• CATEGORY-OVERLAY: SINGLE-OP 15M HIGH MIXED 

4.68. Russian YL/OM contest

• Window: Select Log type 
o Log Type: RUSYLOM 
o Sent Exchange: 

 73 for male stations (OM) 
 88 for female stations (YL) 

YL stations (female) may only work OM stations (male) and vice versa. 

4.69. SAC contest - CW / SSB

The Scandinavian Activity Contest can be configured for Scandinavian stations and 
DX stations. 

• Window: Select Log type 
o CW 

 Log Type: SACCW 
 Sent Exchange: 001 

o SSB 
 Log Type: SACSSB 
 Sent Exchange: 001 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a Scandinavian station or a DX station. 

4.70. Spanish Towns contest

The Spanish Towns contest can be configured for EA stations and DX stations. 

• Window: Select Log type 
o Log Type: CME 
o Mode Category: SSB 
o Sent Exchange: 

 non-EA stations: 001 
 EA stations: Your INE code Example: 18145 
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The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX station or a EA station. 

4.71. SPDX contest

The SPDX contest can be configured for Polish stations and DX stations. 

• Window: Select Log type 
o Log Type: SPDX 
o Sent Exchange: 

 001 for non-SP stations 
 Your province Example: B for Lubuskie 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a Polish station or a DX station. 

4.72. Stew Perry Topband Distance Challenge

The Stew Perry contest is CW only. 

• Window: Select Log type 
o Log Type: STEWPERRY 
o Power category: 

 HIGH when > 100 Watt 
 LOW when 10 - 100 Watt 
 QRP when less than 10 Watt 

o Sent Exchange: 
 Your four character grid Example: JO33 

The point calculation in the log is multiplied by a power multiplier for each qso point 
value. This factor depends on the selected Power category chosen. HIGH is 
multiplied by a factor 1, LOW by a factor 2 and QRP by a factor 4. 

4.73. UA1DZ Memorial Cup

The UA1DZ Memorial Cup can be used by St.-Petersburg and Leningrad region 
stations and DX stations. 

• Window: Select Log type 
o Log Type: DZCUP 
o Mode Category: Select mode used (CW, Mixed, SSB) 
o Sent Exchange: 

 For non-St.-Petersburg and Leningrad region stations: 001 
 For St.-Petersburg and Leningrad region stations: RDA 

(administrative area) 

4.74. UBA contest - CW / SSB

The UBA DX Contest can be configured for ON stations and DX stations. 
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• Window: Select Log type 
o Log Type: 

 CW: UBACW 
 SSB: UBASSB 

o Mode Category: CW 
o Sent Exchange: 

 For non-ON stations:001 
 For ON stations: 001 + Your province Example: 001 OV 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an ON station or a DX station. 

Log submitting for non Belgian stations: 

Before submitting your log look at the page from Franki, ON5ZO at 
http://users.pandora.be/on5zo/n1mmlogger.htm   
The information tells in English, Dutch and French how to update the category in the 
Cabrillo file so you are placed in the right category. The UBA contest manager 
approved and will accept the Cabrillo output made by N1MMLogger. 

IMPORTANT NOTE quoted from the rules as found on the UBA website, regarding 
log submission: 

Log submission info from UBA: The UBA likes to receive a Cabrillo file 

Special Setup for Belgian participants: 

How to include your province abbreviation in the Cabrillo output? This MUST be done 
for both SSB and CW contests! Go to Config > Change your Station Data > State 
field: fill in the abbreviation for your province (OV, VB etc). It is VERY IMPORTANT to 
do this, as it will determine what you have sent in the log (Cabrillo output), and it is 
needed by the UBA Contest Team. The official abbreviation (2 letters) for the Belgian 
Provinces is to be found on the UBA site, under the rules for HF contests. Non-
Belgian participants can leave this field 'as is', it is only used for Belgian contesters. 

How to send your province abbreviation after the serial number in CW? When you 
have selected to begin a new log for the UBA DX CW contest, you must change the 
F2 button message to send your province. This is done like this; go to: Config > 
Change Packet /CW/SSB/Digital Message buttons > Change CW buttons In the right 
column, second row, there is:<<<5nn>>>{EXCH} This means the incrementing serial 
number. Now you have to add your province abbreviation, preceded by a slash (/). It 
should look like this: <<<5nn >>>{EXCH}/OV or <<<5nn >>>{EXCH}/AN 

WARNING: Never change the '001' as the Sent Exchange value in the Select Log 
Type window, as the software will no longer send serial numbers!!! 

4.75. UBA ON contest

The UBA ON Contests (4 in total) can be configured for ON stations and DX stations. 

• Window: Select Log type 
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o Log Type: UBAON 
o Mode Category: Select mode used (CW, Mixed, SSB) 
o Sent Exchange: 

 For non-ON stations:001 
 For ON stations - Serial + Your UBA gewest Example: 001 AAA 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an ON station or a DX station. 

4.76. UBA Spring

The UBA Spring contest (4 in total) can be configured for ON stations and DX 
stations. 

• Window: Select Log type 
o Log Type: UBASPRING 
o Mode Category: Select mode used (CW, Mixed, SSB) 
o Sent Exchange: 

 For non-ON stations: 001 
 For ON stations - Serial + Your UBA gewest Example: 001 AAA 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an ON station or a DX station. 

4.77. UBA Low Band Winter

The UBA Low Band Winter contest (4 in total) can be configured for ON stations and 
DX stations. 

• Window: Select Log type 
o Log Type: UBAWINTER 
o Mode Category: Select mode used (CW, Mixed, SSB) 
o Sent Exchange: 

 For non-ON stations:001 
 For ON stations - Your UBA gewest Example: AAA 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an ON station or a DX station. 

4.78. Ukrainian DX contest

The Ukrainian DX contest can be configured for Ukrainian stations and non-Ukrainian 
stations. 

• Window: Select Log type 
o Log Type: UKRAINDX 
o Mode Category: MIXED 
o Sent Exchange: 

 Oblast for Ukrainian stations Example: CH 
 001 for non-Ukrainian stations 
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Note: Countries are counted per band for SSB, CW and RTTY, because RTTY is in a 
separate contest module they won't be counted correct when a station makes next to 
SSB and CW also RTTY q's or the other way around... 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an Ukrainian station or a non-Ukrainian station. 

4.79. UK DX contest CW / SSB

The UK DX contest can be configured for UK stations and non-UK stations. 

• Window: Select Log type 
o Log Type: 

 CW: UKDXCW 
 SSB: UKDXSSB 

o Sent Exchange: 
 Area code for UK stations Example: BS 
 001 for non-UK stations 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an UK station or a non-UK station. 

4.80. Independence of Venezuela Contest

• Window: Select Log type 
o Log Type: YV 
o Sent Exchange: 001 

The YV call areas are shown in the Multiplier window, choose the tab "Sect". 

4.81. WAEDC contest - CW / SSB

The WAEDC Contest can be configured for European stations and non-European 
stations. 

• Window: Select Log type 
o Log Type: 

 CW: WAECW 
 SSB: WAESSB 

o Sent Exchange: 001 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a European station or a non-European station. 

This contest has QTC Traffic: A QTC contains time, call sign and serial number of the 
reported QSO. Example: "1307/DA1AA/431" means that DA1AA was worked at 1307 
UTC and sent serial number 431 The QTC Status bar shows the number of QTC 
Exchanged with current callsign / Number left to send to that callsign / Total number 
of QTC left to be sent. 
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WAE DX CW / SSB by Franki, ON5ZO 

1. Introduction 

The main character of Worked All Europe (WAE), sponsored by the DARC is that 
Europe works non-Europe ('DX'), and stations outside of Europe work all countries on 
the WAE-list. So far, this is not an unusual contest. However, WAE has something no 
other contest has, that you'll either love or hate, being 'QTC'. What is a QTC? Well, 
the WAE rules give the following definition: A QTC is the report of a contest QSO 
back to a European station. Let's clear this up a bit. A QTC is a piece of traffic that 
can only be sent from outside EU ('DX') to EU ('WAE'). DX stations can offer to send 
them, EU stations will beg to get them. Why? Simply because for both sides each 
QTC is added to the QSO total. If N1MM makes a QSO with ON5ZO, then they both 
get 1 point for the QSO. If they decide to exchange 10 QTCs during this QSO, they 
both have 11 points, being 1 QSO + 10 QTCs. If after the contest, ON5ZO made 300 
QSOs, during which he got 500 QTCs, the total score will be 800, to be multiplied 
with the amount of multipliers. Hence the popularity of the QTCs. 

Now, what does a QTC look like? It has three main parts, being time, call and serial. 
When exchanging QSOs, the DX station will send the QSOs that are already in his 
log. He will transmit the three parts of the QSO that make up the QTC. Suppose that 
N1MM logged ON5ZO at 0123UTC, and ON5ZO gave '012' as his serial to N1MM. 
Later on in the contest, N1MM runs into 9A7P, who asks for a QTC. N1MM kindly 
willing to transmit a QTC, sends the following to 9A7P: 0123 ON5ZO 012 So, in other 
words, N1MM says to 9A7P that at 0123UTC, he logged ON5ZO who gave him 012. 
So the serial in the QTC is the number given by the EU station to the DX station in 
their earlier QSO! 

The rules say that a DX station can only send 10 QTCs to a EU station, and it is 
forbidden for the DX to send a QTC featuring a previous QSO with the same EU 
station he is currently giving QTCs to. No worries, the software takes care of that. 
Furthermore, each QSO can only be sent once as a QTC, so a DX station can never 
have more QTCs sent than QSOs logged. A EU station however, can have much 
more QTCs than QSOs, as each QSO can raise up to 10 QTCs. A DX station can 
choose to send 10 QTCs at once during a QSO, or if he has, let's say 100 QSOs in 
the log, of which 95 have already been sent once as a QTC, he can send 5 QTCs. 
The EU station can ask for another 5 QTCs later on in the contest, after another QSO 
on another band - or on the same band! More on this later. The maximum of 10 
QTCs can be reached with only 1 QSO, or with 5 QSOs on (5 bands), with each time 
2 QTCs. You see, everything is possible. You don't even need to make a QSO to get 
QTCs. Suppose that early in the contest, ON5ZO is running, and N1MM calls on 
20m. They have a regular QSO and exchange serial numbers. ON5ZO asks 'QTC?' 
but N1MM does want to make some QSOs first and wait to send QTCs towards the 
end of the contest. 40 hours later, N1MM is running on 20m and ON5ZO comes 
across, ON5ZO sees that N1MM is a dupe because they QSO'd in the beginning of 
the contests. However, they did't exchange QTCs, so ON5ZO asks 'QTC? de 
ON5ZO'. N1MM sees that they have worked but indeed: there were no QTCs 
exchanged in the first hours of the contests, and N1MM is now eager to send all his 
QSOs as QTCs. N1MM says 'QTC OK' and they exchange QTCs, but no serial 
number for the QSO - because there is no QSO anymore, only the exchange of 
QTCs. 
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But there is more. A series of QTC is to be numbered. The sending station (DX) will 
initiate the series of QTCs with a number like 'QTC xx/yy'. This means that the DX 
stations is sending QTCs for the xx'th time, and this will be a series containing yy 
QTCs. Suppose N1MM sends 'QTC 45/8', this means that it's the 45th time he's 
sending a series of QTCs, and this particular series will contain 8 QTCs. 

Now that we know what a QTC is, what it looks like and why it is sent, let's look at a 
real situation using the software. If you start a new contest using the WAE-module, it 
looks like a normal contest. You set it up with the usual parameters, like Power, 
Category etc. Don't forget to fill in '001' for the exchange! When this is done, you'll 
see that you have both entry windows. You can use these like you normally would, 
both in run mode and in S&P. 

2. WAE from EU-side 

This is what a WAE-QSO could look like including some QTCs, with ON5ZO running: 

CQ TEST ON5ZO N1MM N1MM 5NN 012 R 5NN 48 QTC? R QTC 12/5 QRV? QRV 
0123 PA1M 12 R 0124 G4BUO 03 R 0124 F6BEE 56 R 0125 DL6RAI 89 R 0126 
9A7P 102 R TU 

How does it work? After entering the normal QSO, where both stations exchange 
serial numbers, ON5ZO goes into QTC mode by pressing Ctrl+Z. This triggers the 
program to send the 'QTC?' message to ask N1MM if he wants to give QTCs. At the 
same time, you'll notice that the entry window changes a bit, and the cursor will be 
blinking the 'N/N' window. N1MM answers and gives the 'N/N' part, so ON5ZO logs 
'12/5'. Hitting spacebar moves to the next window, and you'll send 'QRV' (with your 
paddle, for the time being), so the DX knows you're ready to copy the QTCs. Each 
time you copy a part of the QTC and want to move to the next field, you press the 
spacebar. When you have a complete QTC, i.e. time/call/serial, you hit Enter and the 
program sends a confirming 'R', so the DX knows you got it OK and he can start 
transmitting the next QTC. If the series of QTCs is copied and you're done with this 
calling station, you press F3, which is the Thank You message, the program will send 
this TU message and close the QTC-mode, returning to normal QSO mode. Remark: 
Sometimes DX stations don't repeat the two digits representing the hour in the time 
part of the QTC. They just type the minutes, because the hour is the same for a 
bunch of QSOs that were logged in a short time span. When copying QTCs at 
36WPM or faster, you don't have the time to think things over so you just type what 
you copy. If you hear that after two numbers, the next character is a letter, you press 
space and begin typing the callsign. The software will automatically add the two digits 
of the hour. 

In S&P mode, the same keystroke, Ctrl+Z, activates QTC-mode here. There is little 
or no difference in the procedure. Only advice is to try everything well BEFORE the 
contest and report bugs ASAPâ?¦ 

3. WAE from DX-side 

From the other side of the contest, the 'DX' side, the main keystroke to activate QTC-
mode is also Ctrl+Z. You will then have a pop-up window, asking you how many 
QTCs you want to send to the EU-station. Hitting enter will send the 'QTC xx/yy' 
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message, the 'yy' part being the number of QTCs you agreed to send in the pop-up 
message. The second most important keystroke is Alt+Enter. This will repeat the last 
QTC sent, or if you're still in the 'N/N' stage, it'll resend this information. It will occur 
more than once that a EU station does not copy the first time you transmit, due to 
QRM, 'cockpit errors' or simply because you send too fast! So Alt+Enter will repeat 
the last part sent, should the EU station ask 'AGN' or something similar. On the 
bottom of the Entry window, you will see a message, indicating how many QTCs 
have already been sent to a given station. 

WAEDC Keyboard Assignments 

Ctrl+Z - activate QTC-mode and sends: QTC? and log QSOs if nr is greater than 0. 
Ctrl+Z cycles through QSO, receive QTC and send QTC modes. Alt+Enter - resend 
last QTC or it will resend QTC n/n if that was the last message sent. Alt+W - when 
used in a QTC leaves the sender's call and N/N so only wipes the 3 parts of the QTC 
= (equal sign) - resend sent QTC info 

Step-by-Step instructions 

• After you make a contact, first log the contact 
• If you want to send QTCs use Ctrl+Z, the log window will change to QTC 

mode 
• You get a screen asking how many QTCs you want to send. Enter a number 

of just hit Enter and the QTC count will go away. 
o At the bottom of the logging area the QTC number will be indicated, i.e. 

12/10, meaning the 12 QTC series and 10 QTCs 
• The first QTC will show up with the time call and number. 
• After the station acknowledges the QTC hit enter and the next QTC will show 

up. 
•

o Continue this until all QTCs have been sent. 
• Then do Ctrl+Z to return to normal logging. 

Other info 

• If only two digits of time are entered the program adds the first two hour digits 
from prior QTC. 

• The status line in the Entry window shows the total QTC Sent and Received 
from the station being worked. 

• The number of the QTC in the series sent is shown. Example: 5 from 10 
• When reediting a QTC the program will go back to QSO mode after editing. 
• When in QTC mode the letters "QTC" will be shown in big red letters where 

normally the dupe label goes. 
• Want to know how many QSOs and QTCs you have by band. 

•
o Try View/Statistics. Then use either Band by Exchange1 or Exchange1 

by Band. 

4.82. WAG contest

The WAG contest can be used by German stations and non German stations. 
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• Window: Select Log type 
o Log Type: WAG 
o Sent Exchange: 

 non-DL stations: 001 
 DL stations: 

 DARC member:DOK (example: V11) 
 non-DARC member:001 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a German station or a non-German station. 

Non DL stations may only give a number. DL stations give a DOK (DARC members) 
or a number (non DARC members) For stations not giving an exchange put '000â? in 
the exchange field 

- minimal DOK length is 2 - 0 is allowed to be entered 

Note: When updating a DOK in the log window you have to update not only the 
Exchange but also the Section by hand....only when the qso is in the Entry window 
the program strips the Section (V) from the Exchange (V11) automatically. 

4.83. World Wide Peace Messenger Contest

The Peace Messenger Contest can be configured for Peace Messenger Contest 
stations and non Peace Messengerstations 

• Window: Select Log type 
o Log Type: WWPMC 
o Mode Category: CW, SSB or Mixed 
o Sent Exchange PMC station: 001 PMC abbreviation Example: 001 ABI 
o Sent Exchange non PMC station: 001 NON Example: 001 NON 

4.84. WRTC contest

The World Radiosport Team Championship (WRTC) contest is fully supported. 

• Window: Select Log type 
o Log Type: WRTC 
o Sent Exchange: 001 i.e Serialnumber Example: 001 

The WRTC follows the rules for the WPX contest (please check above) with some 
additional WRTC specific changes below. 

• Check Partial is disabled from master.dta for this contest only. 
• Displaying "Unique" is disabled in the Check Partial window for this contest 

only. 
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4.85. YO HF DX contest

The YO HF DX contest can be used by Romanian stations and non Romanian 
stations. 

• Window: Select Log type 
o Log Type: YOHFDX 
o Sent Exchange: 

 non-YO stations: 001 
 YO stations: Romanian county abbreviation (two letters) 

Example: AR 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a Romanian station or a non-Romanian station. 

5. QSO Parties

The program supports many US and Canadian QSO parties. There are some scoring 
anomalies though (there is a score disclaimer). The QSO parties use a configuration 
file named 'QSOparty.sec' with the names of the counties for each qso party. The 
program recognizes whether you are operating from the selected contest state using 
the ARRL section in the station dialog, so make sure your ARRL section is entered in 
the station dialog. 

The list of county abbreviations has been taken from the official site for your contest, 
if available. This list of counties can be found in 'Config | Change Exchange 
Abbreviations | Change QSO Party Abbreviations'. Note that you may add 
abbreviations for counties. For example, say there is a county TOL. If you wanted to 
enter TOL for the county, you are all set. If you want to enter TOLLAND for TOL, then 
you should ADD a line TOLLAND TOL. Whether you enter TOL or TOLLAND, the 
qso will be logged with TOL. 

• Window: Select Log type 
o Log Type: QSOPARTY 

 After selecting QSO Party, a list box shows up in the right-hand 
part of the contest selection dialog box, with buttons below it for 
importing and editing the section list. Click on the down arrow to 
choose the QSO Party you want (example image shows Hawaii 
HI) . 

 Example: The entry in the list of QSO Parties for the New 
England QSO Party is "NEWE" ("NE" is for the Nebraska 
QSO Party). Most of the entries in this list are states or 
provinces, except for the NEWE (New England) and 
MAQP (Mid-Atlantic) entries. 

o Mode Category: MIXED 
o Sent Exchange: 

 The exchange depends on the QSO party. Mostly serial number 
and location 

 Inside the selected State/Province - See contest instructions 
 Outside the selected State/Province - See contest instructions 
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 If sent exchange is specified as "001" then a serial number will 
be sent 

• TheARRL SECTION entered and the State field in the Station Dialog will be 
used to determine if you are in or outside a state or province. 

o Your correct ARRL section must be specified in the station dialog. 
Please fill it out completely. 

 

Note: In QSO parties rovers and county line contacts need to be entered with /M. 

Many QSO parties have different scoring rules for in-state and out-of-state 
participants. When creating a new log for a QSO party, a message box will inform 
you whether you are an in-state, or out-of-state participant, based on your ARRL 
section. 

QSO party bonus stations support 

On program start (when a QSO party is selected) the current QSO party bonus 
stations are displayed and the list of stations shown can be modified. The command 
BONUS + Enter in the Entry window callsign box will also give this possibilty. 

Rover support 

N1MM Logger supports Rover and Mobile operations for QSO parties. Check the 
chapter Advanced Functions for the details. 

5.1. Same weekend: 7QP, Indiana QSO Party and the New England 
QSO Party

THREE major QSO parties - the 7QP (7th Call Area QSO Party), the Indiana QSO 
Party and the New England QSO Party - are all on the same weekend. Wondering 
how to operate in all three at the same time? Changing logs each time you find a 
station working one of "the other" QSO parties is cumbersome. A three-in-one list of 
sections will allow you to work counties in any of the three QSO parties (7QP, InQP 
and NEQP) and log them using N1MM Logger. Check out the website from VA7ST 
(Google for "va7st 7qp n1mm""). The scoring won't be correct, because you're 
logging all QSOs in the same log. However, you will be able to submit your all-in-one 
log to the 7QP and the NEQP. 

5.2. FL QSO party

Florida multiplier work around. Florida stations get a FL state multiplier for their first 
Florida QSO. Florida stations get no multipliers for Florida counties but get QSO 
point for Florida QSOs. To get the right multiplier change the exchange of the first 
Florida QSO to FLA, it forces the FL multiplier credit. 

11.04.2010



N1MM-Contest Logging Software Seite 379 von 470 Übersetzung der Hilfe von Eike, DM3ML

5.3. PA QSO party

Pennsylvania points work around. The logging program does not handle fractional 
points for QSOs like this contest uses. The points are doubled to make it easy to 
divide final score by two. Also, the rule to assign multiple counties to a single serial 
number is not supported. 

5.4. Updating and importing the QSO party sections

• Always try first on a test database. 
• The 'QSOparty.sec' file located in the program directory has listed all the 

sections per QSO party. 
• Importing is done automatically at the start of the program when the database 

has no QSO party section information (checked at startup). 
• If the 'QSOparty.sec' file has been changed (updated) after automatically been 

imported by the program it has to be imported into the database manually so 
the made changes are imported. 

• The load process deletes all the counties for a state before loading them. 
• The maximum length for a section is 5 characters. 

How it works 

If you want abbreviations for counties e.g. Tolland = TOLL then, Edit the Sections list, 
and TOLLAND in the abbreviation, and TOLL in the key. When you log Tolland, the 
program will substitute TOLL. 

Test the change 

• Open a TEST database 
• Create a new QSOPARTY contest 
• Choose Import (See image above) 
• Specify the location where you saved the attached file and "QSOparty.sec" 
• Import need only be done once (after an update/change). 
• You should now see 20+ states/provinces in the combo box. 
• Choose one and test.... 
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6. UKW-Contest (VHF and Up contests)

In VHF and up contest it is the norm to give accurate signal reports. Use the Tab to 
go from the callsign filed to the signal report fields. You will note that it highlights the 
strength to allow quick modification of that. 

 Feature 
When a is grid entered but no call, all QSOs with that grid will show in the lower part 
of log window 

6.1. ARRL January VHF Sweepstakes

• Window: Select Log type 
o Log Type: ARRLVHFJAN 
o Sent Exchange: Your four character grid Example: JO33 

Exchange of signal report is optional. Foreign stations work W/VE amateurs only.
Stations can be logged more than once from a different grid without being a dupe (for 
Rover stations).
Dupe check on first 4 characters of grid.
The score for Rover stations is not being calculated by the program! 

6.2. ARRL June VHF QSO Party

• Window: Select Log type 
o Log Type: ARRLVHFJUN 
o Sent Exchange: Your four character grid Example: JO33 

Exchange of signal report is optional. Foreign stations work W/VE amateurs only.
Stations can be logged more than once from a different grid without being a dupe (for 
Rover stations).
Dupe check on first 4 characters of grid.
The score for Rover stations is not being calculated by the program! 

6.3. ARRL September VHF QSO Party

• Window: Select Log type 
o Log Type: ARRLVHFSEP 
o Sent Exchange: Your four character grid Example: JO33 

Exchange of signal report is optional. Foreign stations work W/VE amateurs only.
Stations can be logged more than once from a different grid without being a dupe (for 
Rover stations).
Dupe check on first 4 characters of grid.
The score for Rover stations is not being calculated by the program! 
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6.4. IARU Region 1 contesting - 50 MHz, VHF, UHF/Microwaves

Region 1 contesting uses a serial number and gridsquare as exchange. The points 
per qso is the calculated distance between your sent gridsquare and the received 
gridsquare. 

• Station Information ('Config | Change Your Station data') 
o Grid Square: <gridsquare> Example: JO33fd 

 This grid square is used in calculating the distance between the 
stations (and is part of the exchange) 

• Window: Select Log type ('File | Choose Which Contest to Log') 
o Log Type: VHFREG1 
o Sent Exchange: 001 <gridsquare> 

 Example: 001 JO33fd 
 The sent exchange is not used by this specific contest otherwise 

the use in the macros for the function keys. 

This contest type has the possibility to use the CallHist table in which information can 
be stored which can be easy to have during a qso like name and gridsquares used in 
previous contests. This specific contest type uses the Name, Locator1 and Locator2 
fields from the CallHist table. Entering any information in this table is not necessary 
for the contest module to work but can be very handy. For this to work information 
has to be imported in the Call History table ('File | Import | Import Call History'), also 
this feature has to be enabled to work ('Config | Call History Lookup'). 

• When a callsign is entered and the SPACE or TAB key is pressed the program 
will check next to the normal things like dupe check the following: 

o Check the log if the callsign is known and if already worked the 
gridsquare is entered from the log in the Entry Window grid square 
exchange field. 

o If not found in the log file it will check the CallHist table. If the callsign is 
found it will place the content from Locator1 in the Entry Window grid 
square exchange field. The callsign is 'normalized' before searching in 
the CallHist table which means that /P, /A, /2 etc. will be removed 
before searching. Information in the CallHist table should be in its 
normalized form. 

• Information from the CallHist table i.e. Locator1, Locator2 and the name field 
will be shown below the function keys. 

• Normally this feature is not turned on (it gives a very short delay while 
searching the table), to turn it on select:'Config | Call History Lookup' 

• Note: Any information already typed in the grid square exchange will not be 
overwritten by the log file or CallHist table search. So first entering a grid 
square and afterwards a callsign is possible without overwriting the already 
entered grid square information. A callsign already worked will be shown in the 
bottom pane of the log window and marked with the dupe message. If the 
station is not worked before and is present in the CallHist table, this 
information will always be shown below the function keys. 

• More information about importing information in the CallHist table can be 
found in chapter VHF and Up contesting. A zip file with an import file for the 
'Call history' lookup function and a ready master file with known calls can be 
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downloaded from the N1MM website, select 'Other Files' under 'Downloads'. 
Don't forget to turn on the lookup function under 'Config | Call History Lookup' 

• More information about VHF related contesting and features can be found in 
chapter VHF and Up contesting 

A QSO can not be entered when

• The serial number is missing 
o Warning: "Missing Serial Number!" 

• The grid length is not 6 
o Warning: - "6 character grid required!" 

• The grid format is not correct. 
o Warning: - "Wrong format grid. Format = AA##AA" 

These checks will (only) be done: when trying to log the qso (mostly by pressing 
Enter) 

How VHFREG1 looks for a known grid square

• Look in the log if the station has been worked before (on any band) 
o If found show the grid and calculate distance and bearing 

• If not found look for the call sign in the 'call history' table including any /P /3 etc 
when applicable. 

o If found show the grid and calculate distance and bearing 
• If not found look for the call sign in the 'call history' table with the /P /3 etc 

removed (normalized callsign) 
o If found show the grid and calculate distance and bearing 

• If not found add the 'big grid' from the country when known by VHFREG1 
o If found show 'big grid' (no calculations done) 
o If not show nothing in grid square field 

• The check will (only) be done: When space is pressed and the cursor is in 
Callsign field 

Bearing and distance calculations

• When space is pressed and the cursor is in Callsign field 
• When trying to log the qso (mostly by pressing Enter) 
• The grid square length has to be 4 or 6 digits. 
• Bearing info is shown in the log window and saved in the Misc field. 
• Distance info is shown in km in the log window and saved in the Points field. 
• Use Rescore to have the bearing and distance (re)calculated. 

Check Grid with country

• When a grid is entered the program will check if the 'big grid' is a possible grid 
for the entered callsign. 

o Example: A Dutch station is always in JO. 
• When the callsign is entered with /MM the check will not be done. 
• The check will (only) be done: 

o When space is pressed and the cursor is in Callsign field 
o When trying to log the qso (mostly by pressing Enter) 
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Add 'big grid' to 4 digit grid (if last 4 digits entered)

• When a 4 digit grid is entered the program checks if these are the last four 
characters from a 6 digit grid. If so it will add the 'big grid' from the country (for 
a Dutch station it will add JO). 

• The check will (only) be done: 
o When space is pressed and the cursor is in Callsign field 
o When trying to log the qso (mostly by pressing Enter) 

Add 'big grid' when no grid is found (from log or 'call history' table)
When a station is entered in the callsign pressing SPACE will search the 'call history' 
table. When the entered callsign is not found the program will try to add the 'big grid' 
who belongs to that country. If more grids are possible it uses the grid which 
occupies the most space in the country (IO in England) or is the easiest workable 
grid from Western Europe (JP for Norway, most south grid. The Netherlands will 
always give JO because this is the only grid possible for PA. 

• The check will (only) be done: 
o When space is pressed and the cursor is in Callsign field 

For DL stations: The German contest manager hat informiert dass er die 
Logeinsendungen von N1MM gerne akzeptiert. Wie immer akzeptiert er den 
postalischen Versand des Logs, jedoch auch Email ist mÃ¶glich, lediglich mÃ¼ssen 
die Daten druckfÃ¤hig sein. Vorab also einige Hinweis: 

1. Jedes Log muÃ? mit dem Generic-File-Output als TXT-Format sortiert nach 
Zeit abgespeichert werden und als Bezeichnung "CALLBAND.TXT" lauten. 
Also DH5HV2m.txt zum Beispiel fÃ¼r einen Contest unter DH5HV auf 2m. 

2. Bei der Einsendung mehrerer BÃ¤nder sollte man diesbezÃ¼glich den 
Generic-File erstellen mit "sorted by Band" und dann mit einem Editor kurz 
bearbeiten, sodass man als Beispiel eine 2m-Datei, eine 70cm-Datei, eine 
23cm-Datei, etc. hat. Auch hier natÃ¼rlich dann DH5HV2m.txt und 
DH5HV70cm.txt und DH5HV23cm.txt erstellen bzw. benennen. 

3. Und wie bisher auch Ã¼blich wird fÃ¼r jedes Band ein seperates Deckblatt 
benÃ¶tigt, was nur komplett ausgefÃ¼llt gewertet werden kann. Man findet 
dies unter http://www.darc.de/referate/ukw-funksport/index.html   ganz 
unten als PDF- oder DOC-File. 

6.5. Marconi CW contest

The Marconi CW contest is CW only. For settings see the VHF Region 1 contest. 

• Window: Select Log type 
o Select: Log Type: VHFREG1 

6.6. NAC Activity Contest

As there is no serial number needed in the NAC contest exchange serial numbers 
are not shown and not added to the EDI output (opposed to VHFREG1). In the EDI 
output the scoring, bonus and multipliers are calculated. The grid locator from the 
station information is used in the calculations. Also the antennas, heights etc. are 
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taken from this dialog. For more settings and possibilities see the VHF Region 1 
contest. 

• Window: Select Log type 
o Select: Log Type: VHFNAC 
o Sent Exchange: Nothing specific needed but the 6 digit grid would be 

fine to used it in the Sent Exchange macros. 

6.7. REF Departments contest 50 Mhz

• Window: Select Log type 
o Log Type: DDFM50 
o Sent Exchange: Serial Number + Your four character grid Example: 001 

JO33 

6.8. VHF/UHF Helvetia 26 contest

• Window: Select Log type 
o Log Type: VHFHELV26 
o Sent Exchange: 001 

Local Swiss VHF/UHF and up contest. Uses almost the same rules as VHFREG1 but 
with an added field for Swiss stations for exchanging Cantons which are also 
multipliers for the contest All features mentioned above for VHFREG1 can be used in 
this contest. Use in the Multip0lier sheet the Sect tab to view the worked Cantons 
(select VHF and auto). 

6.9. VHF HG OB contest

• Window: Select Log type 
o Log Type: VHFHGOB 
o Sent Exchange: 001 

Local Hungarian VHF contest. Uses almost the same rules as VHFREG1 but dupes 
per mode CW or FM/SSB (station may be worked twice per band). All features 
mentioned above for VHFREG1 can be used in this contest. 

6.10. VRZA - Nederlandse Locator Contest - WANLC

• Window: Select Log type 
o Log Type: REGIOVHF (is dus nu de WANLC contest) 
o Sent Exchange: 001 

Only for Dutch stations. 

Noot: Deze contest kent een aantal mogelijkheden om extra multipliers te halen 
middels een soort 'Rover' stations. Dit wordt niet ondersteund door het programma 
en deze stations worden een DUPE! Ofwel: De multipliers en punten voor /M en /P 
stations gewerkt voor een tweede keer worden NIET door het programma 
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automatisch bepaald. Deze dupes dus WEL loggen en achteraf de score en 
multiplier aanpassen op 'generic log' en de 'summery sheet'. 

Cabrillo output wordt ondersteund (File, Export, Cabrillo). 

Voor stations in de secties B en J (Single Operator / Mixed mode) - Selecteer 
SINGLE-OP-ASSISTED (onder File, Choose Which Contest to Log, Operator 
Category) voor een doorlopende nummering over de banden heen! 

6.11. UKSMG sporadic-E competition

• Window: Select Log type 
o Log Type: UKSMG 
o Sent Exchange: Your four character grid Example: JO33 

Only the 6 meter band is shown in the Multiplier window. A 4 digit grid is required and 
6 digit grid is allowed to enter. 

7. Digitale Contest in RTTY und PSK (Digital contests - RTTY/PSK31)

When doing RTTY and PSK contests always check the Mode tab in Configurer for 
correct settings! 

{TIME2} - how it works 

The time will be set if 1. You have a call sign in Entry window 2. The contents of the 
database field that holds the time is empty for that callsign And one of the following is 
met.. 

• A. F2 is pressed or sent 
• B. Insert is pressed and the code that is run from the insert key sends the 

contents of the F2 macro 
• C. {TIME2} is contained in the macro string that is sent 

If you do not have a call in the entry window or the database field is not empty the 
{TIME2} macro will be replaced by the Last Sent Time. So if you have not sent the 
time and you are trying the macro out you will see 0000 printed on the screen. But if 
0512 was the last time sent then that is what the {TIME2} macro will send. {TIME2} 
stays locked until the contact is logged or the callsign wiped. 

7.1. ANARTS WW RTTY contest

• Window: Select Log Type 
o Log Type: ANARTSRTTY 
o Sent Exchange: Zone Example: 14 

7.2. ANATOLIAN RTTY contest

• Window: Select Log Type 
o Log Type: ANATOLRTTY 
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o Sent Exchange: 001 

7.3. ARRL RTTY Roundup

The ARRL RTTY Roundup can be used by K/VE stations and DX stations. 

• Window: Select Log Type 
o Log Type: ARRLRTTY 
o Sent Exchange: 

 Your state/province - for K/VE stations Example: NY 
 001 - for DX stations (non K/VE) 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a DX stations or a W/VE station. 

NB. US stations who work US "/MM" stations are also allowed to log serial numbers. 

7.4. BARTG RTTY Spring contest

• Window: Select Log type 
o Log Type: BARTGSRTTY 
o Sent Exchange:001 

Needed W,VE,JA,VK call area mults in bandmap and available window are 
highlighted. Added EXPERT to list of overlay categories choices. The EXPERT 
overlay category must be selected for the 5 minute band change counter to not be 
active for SINGLE-OP 

7.5. BARTG RTTY Sprint contest

• Window: Select Log type 
o Log Type: BARTGRTTYS 
o Sent Exchange:001 

Needed W,VE,JA,VK call area mults in bandmap and available window are 
highlighted. Added EXPERT to list of overlay categories choices. The EXPERT 
overlay category must be selected for the 5 minute band change counter to not be 
active for SINGLE-OP 

7.6. CQ World Wide DX contest - RTTY

• Window: Select Log type 
o Log Type: CQWWRTTY 
o Mode Category: RTTY 
o Sent Exchange: 

 North American/Canadian stations - Your zone plus the STATE 
or AREA Example: 05 NY 

 NB For cabrillo log submission the order must be: Zone 
first, then state (or province). 
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with no leading spaces, and ONLY ONE space between the zone and the state. 

 Other stations - Your zone Example: 14 

The default zone values for US (A,K,N,W) stations are 

• Zone 3 - If number in callsign is 6 or 7 
• Zone 4 - If number in callsign is 5 or 8 or 9 or 0 
• Zone 5 - If number in callsign is 1 or 2 or 3 or 4 

The default zone values for Canadian (VE) stations are 

• Zone 1 - If callsign starts with: VY1 
• Zone 2 - If callsign starts with: VE2, VO2 
• Zone 3 - If callsign starts with: VE7, VC7 
• Zone 4 - If callsign starts with: VE3, VE4, VE5, VE6, VA3 
• Zone 5 - If callsign starts with: VO1, VE1, XJ1, VY2 

The default section values for Canadian (VE) stations are 

• VE - If callsign starts with: VE1, VE2, VE3, VE4, VE5, VE6, VE7, VE8, VO1, 
VO2,VY 

• Give 'Space' when the cursor is in the 'Callsign' field to have the 'Zone' field 
filled with the default value. 

• The default zone will be selected, so that if you type another zone, it will 
replace the numbers that the program put in there. 

• Abbreviations for Canadian regions are allowed 
• When typing the section and the entered section is new it will be shown in 

RED. The Available window will also show if a section multiplier is needed on 
other bands 

• When pressing Space and the entered callsign is not US or VE, the cursor will 
skip the state/section field. 

• When submitting your log to the contest robot make sure you have in the Sent 
Exchange the correct order: Zone first, then state (or province). 

Cabrillo output The Cabrillo file must be in the order zone, state because that's how 
the official Cabrillo template for CQ WW RTTY is defined. However, this has 
*nothing* to do with how you operate during the contest, it only applies to the post-
contest log submission. During the contest, you can send in either order; all the rules 
say is you must send both. A lot of people seem to send zone, state.
However, the order state, zone is easier for people using N1MM because that's the 
order in the entry window. It's also easier for people using software that calculates 
the zone from the state (like N1MM logger does).
So: put zone, state in the contest setup dialog to ensure your Cabrillo file is OK, but 
you can please yourself about the order in your exchange macros; state, zone (e.g. 
599 ON ON 04-04) will make it easier for fellow N1MM users, so it's the 
recommended order on this reflector! 
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7.7. CQ World Wide WPX contest - RTTY

• Window: Select Log type 
o Log Type: CQWPXRTTY 
o Mode Category: RTTY 
o Sent Exchange: Serialnumber Example: 001 

Leading zeros are being forced on sent & received serial numbers. 

7.8. CIS contest - RTTY

The Commonwealth of Independent States Contest where everybody can work 
everybody for QSO and multiplier credit. 

• Window: Select Log type 
o Log Type: CISDXRTTY 
o Sent Exchange: 

 CIS stations: CIS area code Example for Moscow City: RU11 
 Non-CIS stations: 001 

7.9. DL DX RTTY contest

• Window: Select Log type 
o Log Type: DLDXRTTY 
o Mode Category: RTTY 
o Sent Exchange: 001 

7.10. EA RTTY contest / EA PSK31 contest

• Window: Select Log type 
o Log Type: EARTTY 
o Mode Category: RTTY 
o Sent Exchange: 

 For Spanish stations - Province Example: AL 
 For non-Spanish stations - Serialnumber Example: 0001 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a Spanish station or a non-Spanish station. 

For the EA PSK31 contest select EARTTY as contest and Set Mode Control as 
"Always PSK31". 

7.11. EPC PSK63 QSO party

1. Window: Select Log type 

• Log Type: EPCPSK63QP 
• Sent Exchange: 

o EPC member stations: EPC membership number Example: EPC0001 
o Non-EPC member stations: 001 
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7.12. EPC PSK World Wide DX contest

1. Window: Select Log type 

• Log Type: EPCWWDX 
• Sent Exchange: 

o EPC member stations: EPC membership number Example: EPC0001 
o Non-EPC member stations: 

7.13. EU PSK DX contest

• Window: Select Log type 
o Log Type: EUPSKDX 
o Sent Exchange: 001 

7.14. JARTS WW RTTY contest

• Window: Select Log type 
o Log Type: JARTSWWRTY 
o Sent Exchange:Your age Example: 34 

 XYL and YL stations may give 00 
 Multi-operator stations must send 99 as a operator age. 

7.15. Makrothen RTTY Contest

• Window: Select Log type 
o Log Type: MAKRORTTY 
o Mode Category: RTTY 
o Sent Exchange: 4 digit grid Example: JO33 

7.16. Logbook of the World Contest - RTTY/Digital

• Window: Select Log type 
o Log Type: 

 LOTWRTTY 
o Sent Exchange: 

 For North American stations: State/Province abbreviation 
Example: CT 

 For non North American stations: Countryprefix 

7.17. NA Sprint RTTY

• Window: Select Log type 
o Log Type: SPRINTRTTY 
o Mode Category: RTTY 
o Sent Exchange: 001 Tom CT 

 Serial number, your name and your location (state, province or 
country) Example: PA1M DE N1MM 123 TOM CT K 
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The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a North American station or a non-North American 
station. 

 Dupes on RTTY? 
For this RTTY contest only, the same station can be worked multiple times provided 
3 contacts separate the contact in both logs, regardless of band. 

7.18. North American QSO Parties RTTY - NAQP

• Window: Select Log type 
o Log Type: NAQPRTTY 
o Operator Category: SINGLE-OP or MULTI-TWO 

 For Multi-Two see the extra info below! 
o Mode Category: RTTY 
o Sent Exchange: 

 For North American stations - Operator name and station 
location (state, province, or country) Example: Tom CT 

 For non-North American stations - Operator name only Example: 
Thomas 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a North American station or a non-North American 
station. 

MULTI-TWO operating: When changing operator you have to use Ctrl+O to set the 
NAME (not Call) of the operator. This name set with Ctrl+O will be used in the 
Cabrillo file. So from the Sent Exchange only the state is being used but the name is 
needed. (Example: Tom CT). The macro {OPERATOR} can be used to automatically 
switch WAV files (in SSB), for more info see the Macro section. 

7.19. OK DX RTTY Contest

• Window: Select Log type 
o Log Type: OKDXRTTY 
o Mode Category: RTTY 
o Sent Exchange: CQ zone 

7.20. Quick PSK63 Contest

The contest uses the same rules as the SARTG WW RTTY contest so select that 
contest (SARTGRTTY). After the contest the Cabrillo output has to be updated (take 
SARTG WW out and replace with Quick PSK63) 

7.21. Russian DX RTTY contest

• Window: Select Log type 
o Log Type: RUSDXRTTY 
o Mode Category: RTTY 
o Sent Exchange: 
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 Non-Russian stations: WAZ zone Example: 14 for Western 
Europe 

 Russian stations: Your oblast code (two letters) 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a Russian station or a DX station. 

7.22. Russian Cup RTTY contest

• Window: Select Log type 
o Log Type: RUCUPRTTY 
o Mode Category: RTTY 
o Sent Exchange: 001 

This contest is for Russians only. 

7.23. SARTG New Year RTTY Contest

• Window: Select Log type 
o Log Type: SARTGNYRTY 
o Mode Category: RTTY 
o Sent Exchange: 001 + name + "Happy New Year" in your native 

language 

7.24. SARTG WW RTTY Contest

• Window: Select Log type 
o Log Type: SARTGRTTY 
o Mode Category: RTTY 
o Sent Exchange: 001 

7.25. SCC RTTY Championship

• Window: Select Log type 
o Log Type: SCCRTTY 
o Mode Category: RTTY 
o Sent Exchange: four-digit number of the year the amateur radio license 

was FIRST officially issued (e.g. 1983) to the operator. 

The score Summary window only shows your total score and the number of mults 
you have worked per band. There is no breakdown by points. In SCC there is one 
extra column of mults but that had to be there as the way things are setup to 
calculate the first multiplier (different years). Thus the name of the second mult is 
"N/A" . The only way to do a breakdown on points is to go thru your log and manually 
do it. 

7.26. SP DX RTTY contest

• Window: Select Log type 
o Log Type: SPDXRTTY 
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o Mode Category: RTTY 
o Sent Exchange: 

 001 for non-SP stations 
 Your province Example: B for Lubuskie 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a Polish station or a DX station. 

7.27. TARA Grid Dip contest

• Window: Select Log type 
o Log Type: TARAGRID 
o Mode Category: RTTY or PSK 
o Sent Exchange: name + 4 digit grid locator Example: Tom FN12 

7.28. TARA PSK Rumble

• Window: Select Log type 
o Log Type: TARAPSK 
o Mode Category: MIXED 
o Sent Exchange: Name and Location Example: Tom CT 

7.29. TARA RTTY Melee

• Window: Select Log type 
o Log Type: TARARTTY 
o Mode Category: RTTY 
o Sent Exchange: 

 State for USA stations Example: CT 
 Province for Canadian stations Example: NB 
 001 for all other stations (serial number) 

7.30. Ukrainian RTTY contest

• The Ukrainian DX contest can be configured for Ukrainian stations and non-
Ukrainian stations. 

o Window: Select Log type 
 Log Type: UKRAINRTTY 
 Mode Category: RTTY 
 Sent Exchange: 

 Oblast for Ukrainian stations Example: CH 
 001 for non-Ukrainian stations 

 Country Count 
Countries are counted per band for SSB, CW and RTTY, because RTTY is in a 
separate contest module they won't be counted correct when a station makes next to 
SSB and CW also RTTY q's or the other way around. 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an Ukrainian station or a non-Ukrainian station. 
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7.31. UK DX contest RTTY

The UK DX contest can be configured for UK stations and non-UK stations. 

• Window: Select Log type 
o Log Type: UKDXRTTY 
o Sent Exchange: 

 Area code for UK stations Example: BS 
 001 for non-UK stations 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an UK station or a non-UK station. 

7.32. VOLTA RTTY Contest

• Window: Select Log type 
o Log Type: VOLTARTTY 
o Mode Category: RTTY 
o Sent Exchange: QSO number + Your CQ Zone. Example: 001 15 

The four Band Multiplier count for this contest is displayed on info window. 

7.33. WAEDC contest

The WAEDC Contest can be configured for European stations and non-European 
stations. 

• Window: Select Log type 
o Log Type: WAERTTY 
o Sent Exchange: 001 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are an European station or a non-European station. 

Making QSOs in WAE RTTY by Rich, VE3KI. 

To start with, a QSO in WAE is just like a QSO in CQ WPX or SARTG, and I would 
suggest using the same function-key set. 

In CW and SSB WAE, QTCs can only be sent from non-EU to EU, but in RTTY there 
are many more possibilities. QTCs can be sent in either direction between any two 
continents (not with a station in the same continent). This makes WAE RTTY quite a 
bit more complex that WAE CW. 

First, let's suppose you are CQing. If you have a good run going you probably will not 
want to break your rhythm for QTCs. As long as there are people waiting to work you 
when you CQ, you are probably best off just adding to your QSO count. 

However, if your rate drops off, you might want to pick up your score with some 
QTCs. First, let's look at the case where you do not have many unsent QTCs to send 
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(that's previous QSOs that you have not already sent as QTCs). In this case, if you 
work someone who has a good clear signal and you have not yet exchanged QTCs 
with him, you may want to receive some. You can see how many QTCs you have 
exchanged with him and how many unsent QTCs are remaining in your log near the 
bottom of the entry window while the cursor is in the exchange (Nr) field. 

Start by asking him if he has any QTCs for you ("QSL TNX. ANY QTCS FOR ME?"). 
If he says yes, press Ctrl+Z once. That gets you to the RQTC window for receiving 
QTCs (it's in the right half of the digital interface window). After you tell him you are 
ready with RX Ready, he will send you a message whose first line is something like 
"QTC: 22/10 QTC: 22/10". The first number is the group number (the 22nd group he 
has sent), the second is the number of QTCs in the group (maximum 10, and 
especially in RTTY it is most efficient to sent only large groups). If you click on this in 
the RX window, it should transfer to the RQTC window. 

The heart of his message will be a set of 10 QTCs. Each QTC contains three 
elements: the time, the call sign, and the serial number. Each time you receive a 
QTC, left-click on it and the entire QTC should transfer into the corresponding panes 
in the RQTC window. You can also enter or edit elements by hand, or you can right-
click on a single element and then left-click in the box where you want it to go. After 
you have received all 10 QTCs, it may help to click on the green bar at the left of the 
RX window so you can freeze the RX window, scroll back and complete or fix any 
missing or garbled elements. Remember to click on the yellow bar when you are 
done so you can receive again. 

There are buttons in the RQTC window for asking for repeats for individual QTCs or 
for the whole series. Once you have them all, press Save QTC which will send an 
acknowledgement message to him and log the QTCs, and then you can start CQing 
again. 

Suppose instead that you do have a bunch of unsent QTCs ready to go. Then what 
you may want to do at the end of a QSO with a station with a good clear signal (if you 
have trouble copying someone's signal, you will not want to try QTCs with him) is to 
ask if he wants to receive QTCs ("QSL TNX. DO YOU WANT QTCS?"). If he says 
yes, press Ctrl+Z twice to get to the SQTC window. The buttons in this window 
should be self-explanatory; the main one is Send All, but if he asks for a repeat of #3, 
7 and 9 you can resend them by pressing Snd #3, Snd #7 and Snd #9. Once he 
acknowledges them all, press Save QTC and go back to CQing. 

If you get into the wrong QTC window by mistake, you can either press Cancel or just 
keep pressing Ctrl+Z until you get back to the normal digital interface receive 
window. 

S&Ping works the same, except usually it is better to let the running station decide if 
he wants to do QTCs or not, depending on how well his run is going. If he wants to 
send QTCs to you, you can either reply "SRI QRU" (not quite right, but he will get the 
message) or you can press Ctrl+Z once to get the RQTC window and press the RX 
Ready button to tell him you are ready, then receive QTCs the same as described 
above. 
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If he asks you whether you have QTCs for him, you have three options: press Ctrl+Z 
twice and press the R U QRV button to give him the cue to get ready; send "SRI 
QRU"; or send a message telling him you don't have any but are willing to receive 
some ("SRI QRU. ANY QTCS FOR ME?"). 

Most of the QTC messages are sent by buttons in the SQTC and RQTC windows. 
You can program the messages in these buttons from the Setup -> Settings menu in 
the digital interface window, under the third tab ("WAE RTTY Configuration"). 

There are a few additional messages you will want to program into the buttons at the 
bottom of the digital interface window, such as: {TX} QSL TNX. GOT ANY QTCS 
FOR ME? {RX} {TX} QSL TNX. DO YOU WANT QTCS? {RX} {TX} SRI QRU {RX} 
{TX} SRI QRU. ANY QTCS FOR ME? {RX} 

You may think of more - that's OK, there are up to 24 message buttons in the digital 
interface window. I often find myself changing them on the fly during a contest. You 
can get to the programming window by right-clicking on the button you want to 
change. Hope that helps. 

73, Rich VE3IAY 

NB. The QTC window for the RTTY contest is in the Digital Interface window. During 
the QTC send/receive process for WAE RTTY you should not be looking at the Entry 
window. 

The first time you press Ctrl+Z the Receive QTC window opens up in the right side of 
the Digital Interface. Down the right side you will see buttons labeled RX Ready, All 
AGN, AGN #1, AGN #2, ..., AGN #10, and across the bottom are Cancel, Save QTC 
and Clear buttons. 

If you want to send QTCs instead of receiving them, just press Ctrl+Z again and the 
Send QTC window takes the place of the Receive QTC window. The top two buttons 
change to R U QRV and Send All, and the rest stay the same. The data windows are 
automatically filled from your log. 

If you have used up your QTC quota with the station whose call sign is in the entry 
window, pressing Ctrl+Z the first time leaves you in QSO mode and does not open 
the QTC window. If you have not used up your quota with him but you do not have 
any QTCs ready to be sent, then pressing Ctrl+Z the first time displays the Receive 
QTCs window, and pressing it the second time returns you directly to QSO mode. 

• QTC Lines on the frame are broken up into separate boxes. This was done to 
allow error checking of any data that is input by hand and clicking on data in 
RX window. 

• If you click on data or enter data in the QTC windows if the routines detect bad 
data it will flag that data in red. So when you are receiving QTCs and you get 
one that is garbled, Click on it anyway and it will get placed into the QTC area. 
The boxes for that QTC will turn red. 

• Upon completion of the sending QTC's all you have to do is look at the QTC 
window and it will tell you by the red colors what QTC you need to RX again. 
You press the AGN # button and it sends your message out. At the same time 
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your message is going out the QTC line is cleared. Now when the station 
sends the repeat of the QTC you requested and you click on it and it will then 
be placed into that blank line that was just cleared. 

• When saving QTC if any of the data still hasn't been corrected it will send the 
received ok message but if there is an error in the Time or the Callsign the 
program will let you save the QTC and not care about it. But if there is an error 
in the serial number (If it contains anything besides a number) it will not let you 
save it. The reason for this is in the program the serial number needs to be a 
certain type of variable(numeric) and if it is not a numeric variable it will not 
save it. So the flow of it if there is an error in the serial section and you press 
save is: 

A. Sends the confirm string you have setup B. Tells you on the entry window there is 
a Format error C. Waits for you to fix it. D. So now you would have to scroll back to 
see what was sent of take out the extra letter your finger hit then hit save. By doing it 
this way you are not slowing down the other station..... 

• The program will not save info into the log until the bad data is fixed. Once 
fixed just click save again and it will save the data without sending the 
received message. A warning message is given in the Entry window status 
bar. 

• To select whole lines of received QTC just place the cursor over the line and 
left click. 

• To select individual QTC sections place the cursor over the item you want to 
select and right click on it. After the data is selected place the cursor over the 
text box you want the data to go into and left click it will be placed into it. 

• When pressing Ctrl+Z to switch modes the program will display the total QTC 
sent and received from the station being worked. When the QTC frame opens 
on the DI only the Needed amount of QTC boxes will be enabled. Example(if I 
have worked UT5XXX and received 5 QTCs from him, the next time I work 
him and I open up the Receive QTC frame only 5 QTC lines will be enabled to 
reach maximum QTC amount . 

• When pressing Ctrl+Z to switch modes if you have reached the MAX amount 
of QTC the QTC frame will close and give a warning message in Entry 
windows status bar. 

• When left clicking on a Received QTC line will split data on " ","/","-" 
separators if the routines can't split the data it will not copy the data over. You 
will have to click each item separate or hand type it in. 

• Selecting of individual QTC items can be done by right clicking on item. Left 
clicking on the box where the data to be placed places text. 

• Ctrl+Z cycles through QSO, receive QTC and send QTC modes. After you 
enter a callsign in the entry window pressing Ctrl+Z will cycle through the 
RQCT and SQTC modes. If you are receiving QTC press Ctrl+Z once and as 
the QTC appears in the digital window just click on it one time and it will 
transfer over to the QTC entry window. To send a QTC press Ctrl+Z one more 
time and it will show you all the QTCs you have available to send. 

• The status line in the Info window shows the total QTC Sent and Received 
from the station being worked. 

• Upon entering a callsign in the entry window and pressing the spacebar. The 
number of total QTC's exchanged with that callsign and the Total of all unsent 
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QTC is displayed on the entry window so you should be able to keep track 
easier of what your QTC numbers are. 

• If you work a station that is on your same continent and try to send them QTC 
or try to receive QTC from them the program will tell you you can not do that. 
Press enter and move on...... 

• On the WAE Tab located in the settings area will allow you to set the 
maximum number of QTC you want to send. Whatever this setting is set to is 
the number that will send unless you do not have that many QTC to send. This 
defaults to 10. 

• An error message is displayed when the serial number is blank when logging 
a contact 

• The total unsent QTC's is displayed along with # of QTC's exchanged with 
current callsign on the Entry window 

• Continent is checked when sending and receiving QTC's 
• Default number of QTC to send can be entered on the Tab WAE RTTY 

configuration under Settings in the menu from the DI interface. 
• The number of QTC sent and total QTC available ois shown in the Entry 

window upon Entering Callsign 
• Hover mode if disabled if the QTC window is open 
• The number of CR's between QTC's sent is configurable (Setup QTC) 
• Placing a QTC into the QTC window is possible by clicking in line of QTC 

boxes where you want QTC to be placed into. 
• When tuning in the bandmap the Entry Window will show the QTC status of 

the tuned callsign. 
• A warning message is shown when a recieved number is not entered 

For more information look at WAEDC for SSB/CW. However, there are 2 
fundamental differences between the RTTY and the SSB/CW version of the contest: 

1. Everyone can work everyone, so DX can work DX and EU can work EU 2. 
Everyone can both send and receive QTCs, however they can only be exchanged 
between stations in a different continent 

How do I know how much QTC I can receive from a station or how do I know 
the number to send to them? 

The program will do all this for you in a number of ways... 

• The first number that is displayed on the entry window by the QTCs title is the 
total number of QTC's you have exchanged with that station. If it says 8 then 
you can either receive or send 2 more 

• When you press Ctrl+Z to switch to RQTC mode the program already knows 
how many QTC you can receive and will only enable that many entry points on 
the QTC frame 

• When you press Ctrl+Z to switch to SQTC mode the program will either set the 
maximum number you want to send or however many QTC's you are still 
allowed to send to that station. (Whichever is smaller) 

7.34. XE RTTY Contest

• Window: Select Log type 

11.04.2010



N1MM-Contest Logging Software Seite 398 von 470 Übersetzung der Hilfe von Eike, DM3ML

o Log Type: XERTTY 
o Mode Category: RTTY 
o Sent Exchange: 

 Mexico: State. Example: AGS 
 Non-Mexico: 001 

The callsign in the Station Information dialog ( >Config >Change Your Station Data 
>Call ) determines if you are a Mexican station or a non-Mexican station. 

Last Modification: 22 December 2009 06:11:25 EST by n4zr. 
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Unterstützte Transceiver (Supported Radios)

Suchen Sie nach einem Interface zwischen Ihrem Rechner und Ihrem 
Transceiver? Die hier angegebenen Optionen sind auf alle angeführten Transceiver 
und Marken anwendbar. Soweit uns Probleme mit bestimmten Geräten bekannt sind, 
sind sie hier aufgeführt. Bitte informieren Sie uns, wenn Sie über Informationen 
verfügen, die hier aufgenommen werden sollten.  

1. Allgemeine Informationen (General Information)

• Wenn Sie ein selbstgebautes und aus der Schnittstelle mit Spannung 
versorgtes Interface verwenden, stellen Sie ein:  

o DTR - Always On 
o RTS - Always On 
o Vor allem bei ICOM-Kabeln 

• Alle Transceiver: Ein Bandwechsel während des Sendens ist nicht erlaubt! 
• Alle Transceiver: Die Totzeit ist auf 10 s voreingestellt (kann eingestellt 

werden). 
o Manche Transceiver benötigen Initialisierungskommandos beim 

Programmstart. Schalten Sie den Transceiver daher vor dem 
Programmstart ein. Funktioniert die Initialisierung nicht richtig, klicken 
Sie rechts in die Bandskala und wählen Sie im Menü Reset Radio um 
die Initialisierung erneut auszulösen.

o Verliert der Transceiver während des Programmbetriebs die 
Synchronisation klicken Sie rechts in die Bandskala und wählen Sie im 
Menü Reset Radio. 

o Wird innerhalb von 10s keine Synchronisation erreicht, erscheint eine 
Fehlermeldung. Überprüfen Sie dann Hardware und Configurer-
Einstellung. In der Bandskala muss die am Transceiver eingestellte 
Frequenz angezeigt werden. klicken Sie rechts in die Bandskala und 
wählen im Sie Menü Reset Radio.

• Alle Transceiver bis auf den FT-1000 werden während des CW-Sendens über 
die CAT abgefragt (polling). 

• Es kann vorkommen, dass die Tastatur-Pfeile hoch/runter und Bild hoch/runter 
nicht funktionieren und eine Frequenzänderung am VFO nicht angezeigt wird. 
Dafür können diese Ursachen infrage kommen: 

o Die bei N1MMLogger eingestellte Sprungweite ist kleiner als die vom 
Gerät realisierte Abstimmschrittweite. Der IC-751 übernimmt 10Hz-
Schritte, zeigt aber nur bis zu 100Hz an, die Frequenzänderung ist erst 
nach mehreren kleinen Schritten sichtbar. Bei anderen Geräten muss 
die Schrittweite unter N1MMLogger erhöht werden. 

o Die voreingestellte Schrittweite für CW  ist 10Hz. Ändern Sie sie in 
100Hz auf der Karteikarte Other im Configurer. 

• Kenwood, Orion, Icom, FT-1000MP : Die Kommandos zum Bandwechsel 
werden jetzt doppelt gegeben, um sie unter allen Bedingungen wirksam 
werden zu lassen. U.U. brauchen Sie damit etwas länger um wirksam zu 
werden. 
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• Memory-Modus: Moderne Transceiver (FT1000mp, TS2000) haben einen 
Memory-Modus, bei dem die Frequenzsteuerung über CAT nicht funktioniert. 
Stellen Sie Ihren Transceiver in den VFO-Modus. 

• Im Modus SO1V kann der VFOB nicht zum Empfang genutzt werden. 
Schließen Sie die zweite Bandskala und das dazu gehörende 
Logeingabefenster. 

2. Manueller Modus (Manual mode)

Im manuellen Modus ist kein Transceiver ausgewählt und mit dem Programm 
verbunden. Sie sollten diesen Modus aber nur bei älteren Geräten ohne CAT-
Steuerung einsetzen. Haben Sie neuere Geräte mit CAT-Steuerung sollten Sie in 
jedem Fall anstreben, das Gerät über ein CAT-Interface mit N1MMLogger zu 
koppeln. Müssen Sie manuell arbeiten, müssen Sie alle Einstellungen am 
Transceiver von Hand vornehmen und N1MMLogger über Frequenz und Sendeart 
informieren, so dass ein deutlich erhöhter Bedienaufwand entsteht.

3. Digitale-Information (Digital Information)

Die untenstehende Tabelle wurde von Rick, N2AMG, und John, K3CT, aufgestellt 
und gibt die Zuordnung der an den aufgeführten Transceivern einstellbaren 
Sendearten zu den unter N1MMLogger verwendbaren Sendeartenbezeichnungen 
an: 

 

4. Alinco

• DX-77 : wird unterstützt 
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5. Elecraft

• Elecraft mit einem USB-Seriell-Konverter an N1MMLogger 
 Verwenden Sie einen USB-Seriell-Konverter mit einem FTDI-

Chip. Diese Ausführung arbeitet mit N1MMLogger problemlos 
zusammen. Bei anderen Konvertern kann es Probleme geben. 
Tnx Thomas DK3DUA 

5.1. K2

o Verwendet Kommandos analog zu Kenwood, hat aber eine eigene 
Transceiver-Auswahl. Das Elecraft-spezifische KY-Kommando wird 
nicht unterstützt. 

o Verwenden Sie die voreingestellten Kenwood-Parameter, sie 
funktionieren in der Regel mit einem Stoppbit.  

o N1MMLogger unterstützt nicht die Option "virtual keying" mit an die K2-
Schnittstelle gesendete Kommandos. 

o Einstellung der Filter-Codes für "Wide" und "Narrow" 
 Setzen Sie die Filter-Codes für beide VFOs. Die Einstellung 

erfolgt mit einem Rechtsklick in die zugehörige Bandskala und 
den Menüpunkt „Set filter codes“. 

 Ersetzen Sie diesen dort für Kenwood eingestellten FL-Code 
Voreingestellt ist: K22;FW99991;K0; , damit wird das Filter FL1 
(SSB breit).des K2 eingestellt. Wenn Sie ein anderes Filter 
einstellen wollen, ändern Sie die Ziffer nach ‚9999’ auf 1,2,3 oder 
4. z.B. stellt das Kommando K22;FW99993;K0; das schmale 
CW-Filter FL3 ein. 

 Sie können diese Filter unabhängig von der Sendeart für CW, 
SSB und RTTY verwenden. Informieren Sie sich im Handbuch 
des K2 über die Kommandos.

Have fun es 73, Don N4HH 

o Für den K2 und den TS850 gibt es eine sinnvolle Option, wenn Sie im 
RUN-Modus arbeiten. Schalten Sie auf Splitbetrieb und verwenden Sie 
die Hauptabstimmung am VFO-B als RIT-Abstimmung. Gehen Sie zum 
Configurer und wählen Sie dort die Option "Reset RX Freq when 
Running Split". Dann wird nach Ende jedes QSOs die RX-Frequenz 
wieder auf die Sendefrequenz gezogen und Sie können neben der 
Frequenz anrufende Station optimal einstellen. 

5.2. K3

o Ein K3 mit einem Empfänger kann in den Modi SO1V oder SO2R 
verwendet werden. Eine K3 mit Zweitempfänger kann in allen Modi 
SO2V eingeschlossen verwendet werden. 

o Mit ALT+F12 schalten Sie den Zweit-RX ein und aus- Es hat die gleiche 
Wirkung wie die Taste SUB am K3. Soll der Zweitempfänger immer an 
sein, wählen Sie im Configurer die Option “Dual RX always on” 

 Haben Sie den Diversity-Modus am Transceiver gewählt, wird 
dieser Modus mit der SUB-Taste abgeschaltet. 
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o Im SO2V-Modus müssen Sie den Splitbetrieb über das Programm 
steuern. Mit der Taste Split am K3 geht die Synchronisation verloren.  

o N1MMLogger unterstützt die K3-Digital-Modi FSK D, AFSK A und 
DATA A 

 FSK D, AFSK A und DATA A werden bei N1MMLogger als 
RTTY, AFSK bzw. PSK angezeigt

 PSK D wird nicht von N1MMLogger unterstützt 
 Stellen Sie unter AFSK A und DATA A am K3 die ALC-Anzeige 

auf 4-5 Balken ein. Damit kann die Firmware des K3 die ALC so 
steuern, dass Spitzen nicht beschnitten und ein niedriger IMD 
erreicht wird. In PSK31 und anderen Digimodes, die eine hohe 
Linearität erfordern, setzen Sie die Leistungseinstellung auf 
unter 60 Watt. Bei AFSK RTTY können Sie ohne Probleme 100 
Watt verwenden. 

o RIT-Steuerung: Im RUN-Modus steuern die Rauf/Runter-Tasten die 
RIT-Frequenz, wenn die RIT am K3 zugeschaltet ist. Im S&P-Modus 
wird der VFO verstimmt. 

o WAV-Dateien in SSB mit dem K3 senden: 
 Schließen Sie das Mikrofon am Mic-Eingang der Soundkarte an 

und den Line-Ausgang der Soundkarte an dem Eingang Line-in 
hinten am K3. 

 Aktivieren Sie an der Soundkarte den Eingang Line In 
 Wählen Sie am K3 den Eingang LINE IN mit dem MENU:MIC 

SEL 
 Schalten Sie den K3 auf Senden und stellen Sie den MIC GAIN 

für den Eingang LINE IN auf einen ausreichenden Pegel ein
 Stecken Sie das Mikrofon an den K3 an 
 Wählen Sie am K3 für den Menüpunkt MIC die Einstellung 

MENU:MIC SEL 
 Schalten Sie den K3 auf Senden und regeln Sie den MIC GAIN 

mit besprochenem Mikrofon ein
 Wählen Sie jetzt den Menüpunkt MIC+LINE ON. Der K3 wird 

jetzt sowohl von der Soundkarte als auch vom Mikrofon 
moduliert. Der Regler MIC GAIN ist jetzt ausschließlich für das 
Mikrofon zuständig, für den LINE-IN-Eingang am K3 hinten wird 
unter dem Menüpunkt LINE IN eingestellte Pegel übernommen.  

o Der K3 akzeptiert die PTT-Tastung aus verschiedenen Quellen: 
Eingang PTT IN auf der Rückseite, von Winkey über RTS (pin 7) an der 
DB9-CAT-Buchse oder "Radio PTT via command" 

 Verwenden Sie keine parallele PTT-Tastung über verschiedene 
Eingänge, dann kann die PTT am Ende einer Nachricht 
klemmen und der Tcvr auf Senden bleiben 

 Prozedur für die K3-Einstellung über die RTS-Leitung an der 
DB9-Buchse: Gehen Sie zu CONFIG:PTT-KEY und setzen Sie 
sie auf OFF-OFF; Konfigurieren Sie N1MMLogger zur Steuerung 
der PTT über das Signal RTS der CAT-Steuerung. Setzen Sie 
die K3-CONFIG:PTT-KEY auf OFF-DTR. 

 Warnung: Wenn Sie RTS auf Always on im K3-CONFIG:PTT-
KEY setzen oder auf RTS-DTR, dann steht der K3 dauernd auf 
Senden. 
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o Der K3 akzeptiert die CW-Tastung über DTR (Pin 4) der DB9-CAT-
Buchse. Diese Methode können Sie verwenden wenn kein Winkey oder 
eine separate COM- oder LPT-Schnittstelle zur Verfügung steht.

 CW und CAT über die gleiche COM-Schnittstelle funktionieren 
nicht im SO2R-Modus 

 CW über DTR funktioniert nicht über gewisse USB-zu-Seriell-
Konverter mit Prolific-Chipset 

 CW über DTR kann zu Problemen führen, Sie verwenden es 
unter Ihrem eigenen Risiko 

 Prozedur: Setzen Sie am K3 den Menüpunkt CONFIG:PTT-KEY 
auf OFF-OFF; stellen Sue beim N1MMLogger die CW-Tastung 
auf DTR. Setzen Sie dann am K3 den Menüpunkt CONFIG:PTT-
KEY auf OFF-DTR 

 Warnung: Setzen Sie DTR nicht auf Always ON, wenn am K3 
auf CONFIG:PTT-KEY > OFF-DTR oder RTS-DTR eingestellt 
ist. Das ist gleichbedeutend mit einer dauernd gedrückten Taste.

6. FlexRadio

• SDR-1000 und SDR-5000A (verwenden Kenwood-Einstellungen) 
o Von Rob AB7CF 
o Einige Einzelheiten der Einstellungen werden nicht unbedingt benötigt, 

sollen aber zur Komplettierung angegeben werden. Ich verwende in der 
PowerSDR-CAT-Einstellung den ID "PowerSDR". Vermeiden Sie nach 
Änderung der Vcom-Konfiguration die Taste „Update Driver“ 
anzuklicken. 

o Beispiel: Verwenden des Vcom-Konfigrators unter Verwendung der 
Ports 4-5 und des VAC 

o Prüfen Sie, ob Sie bei VCom einen Haken beim Paar COM4 - COM5 
gemacht und dann auf Save Configuration geklickt haben. Stellen Sie 
sicher, dass Sie auf Update Driver geklickt und den Instruktionen 
gefolgt sind. Schließen Sie den Vcom-Konfigurator. Sehen Sie in der 
Windows-Systemsteuerung > System > Gerätemanager nach, ob die 
Schnittstellen eingerichtet worden sind. Die Schnittstellen dürfen kein 
gelbes Fragezeichen haben und sollten mit „Multi-port serial  
adapters." Bezeichnet sein.  

o Gehen Sie jetzt zum Programm PowerSDR und gehen Sie zum 
PowerSDR Setup, klicken Sie dort auf die Karteikarte CAT Control. In 
Machen Sie einen Haken bei Enable CAT . Wählen Sie für die PTT 
Port 4 und machen Sie keinen Haken bei RTS und DTR. Wählen Sie 
als ID: PowerSDR. Klicken Sie auf die Taste Apply. Schließen Sie das 
PowerSDR Setup. 

o Gehen Sie zu N1MMLogger. Wählen Sie Config > Configure Ports, 
Telnet Address,Other. Wählen Sie unter COM5: Kenwood. Lassen Sie 
CW/PTT unmarkiert. Klicken Sie auf die Taste Set. Stellen Sie hier 
4800 Baud, Parity: N DataBits: 8, Stop Bits: 1 DTR (pin 4) = 
Handshake. RTS (pin 7) =Handshake ein und eine 1 bei Radio/VFO. 
Lassen Sie das Feld "Radio PTT via command" frei. Wählen Sie "Allow 
external interrupts". Klicken Sie auf die Taste OK und verlassen Sie das 
Einstellmenü. 
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o Sie sollten jetzt mit dem SDR-Transceiver kommunizieren können. 
Wenn Sie auf eine Frequenz in der Bandskala klicken muss ich die 
Frequenz im SDR-Panadapter ändern Überprüfen Sie die 
verschiedenen Tasten der Tastatur zur Frequenzeinstellung in 
PowerSDR. 

7. Icom

7.1. ICOM-Überblick (General Icom information)

* 

o Fast alle ICOM-Transceiver benötigen ein CI-V-Interface wie das CT-17 
oder ein kompatibles. Ekki Plicht, DF4OR, hat dankenswerterweise 
eine große Übersicht zu ICOM-Interfaces auf seiner Homepage 
gemacht. 

o Die ICOM-Geräte verwenden keine Signale DTR und RTS. 
Verschiedene Stecker-Interfaces verwenden diese Signale, um die 
Stromversorgung mit DTR und/oder RTS auf "Always On" zu gewinnen. 
Überprüfen Sie, ob Ihr Interface diese Einstellung für DTR und RTS 
benötigt. 

o Setzen N1MMLogger auf: 
 ICOM-Adresse: siehe Handbuch des ICOM-Geräts und Liste 

weiter unten
 Baud Rate: 9600 oder 19200 entsprechend der am ICOM-Gerät 

eingestellten Baudrate 
 Datenbits:  8  
 Parität: Keine (None) 
 Stoppbits: 1  

o Stellen Sie an Ihrem Transceiver ein: 
 "CI-V Transceive" auf OFF : WICHTIG! Sonst gibt es Konflikte! 
 "CI-V with 731/735" auf OFF. ICOM-Standard sind 5 Daten-Byte. 

Nur der IC-735 verwendete noch 4 Daten-Byte. 
o ICOM hat nur einen beschränkten Kommando-Umfang und kann diese 

N1MMLogger-Kommandos über die Tastatur NICHT verarbeiten: 
SPLIT, DUALWATCH, CHANGE, VFO/MEMO, A=B, A<>B oder 
MAIN/SUB. ICOM meldet nur die Frequenz des aktiven VFOs. Bei der 
Initialisierung werden die beiden VFOs gezielt abgefragt.  

Verwenden Sie ALT+F7 für die Einstellung des Splitbetriebs. Der Splitbetrieb wird 
korrekt bei einem Klick in die Bandskala oder das Available-Fenster gesetzt und 
gelöscht. Um auf den VFOB (im SO2V-Modus) umzuschalten, verwenden Sie die 
Tasten PAUSE oder CTRL+linker/rechter Pfeil. Im SO2V-Modus wird auch mit einem 
Klick in die linke oder rechte Bandskala oder das Available-Fenster ausgewählt.  

o Frequenzen über 2 GHz werden ignoriert 
o Um CW zu tasten, wird ein Kabel mit Schaltransistor zwischen der 

seriellen Schnittstelle des Rechners und dem ICOM-Transceiver 
benötigt. Mit dem CI-V-Interfacekabel allein können Sie keine CW 
tasten.
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o Über das ICOM-CAT-Kabel (Signale TxD und RxD) wird nur die 
Frequenz, die Sendeart u.ä. ausgelesen und gesteuert. 

o Das Kommando ALT+F10 zum Austausch der VFOs ist während des 
SO2R-Modus für ICOM-Transceiver gesperrt, da es dort kein 
Kommando zum VFO-Tausch gibt und auch die am VFO-B eingestellte 
Frequenz nicht ausgelesen werden kann.  

• Diese ICOM-Modelle werden von N1MMLogger unterstützt:  

7.2. IC-271 / IC-471 / IC-1271

 Wählen Sie den IC-706 und stellen Sie die Hex-Adresse 48 ein. 
Teilen Sie uns mit, ob das Programm funktioniert. 

 Da im Kommandosatz eine Menge an Kommandos nicht 
enthalten sind, wird nur eine beschränkte Funktionalität erreicht. 
Es fehlen die VFO- und Splitkommandos.  

7.3. IC-275A/E/H mit der Adresse 10H und 9600 Baud

 Im CI-V-Kommandosatz fehlen die Split-Kommandos. 

7.4. IC-375 / IC-575 (alle Versionen)

 Wählen Sie den IC-706 und stellen Sie die Hex-Adresse 48 ein. 
Teilen Sie uns mit, ob das Programm funktioniert. 

 Da im Kommandosatz eine Menge an Kommandos nicht 
enthalten sind, wird nur eine beschränkte Funktionalität erreicht. 
Es fehlen die VFO- und Splitkommandos.  

7.5. IC-475A/E/H mit der Adresse 14H und 9600 Baud

 Da im Kommandosatz eine Menge an Kommandos nicht 
enthalten sind, wird nur eine beschränkte Funktionalität erreicht. 
Es fehlen die VFO- und Splitkommandos.  

7.6. IC-703 mit der Adresse 68H und 19200 Baud

7.7. IC-706 mit der Adresse 48H und 19200 Baud

7.8. IC-706MKII mit der Adresse 4EH und 19200 Baud

7.9. IC-706MKIIG mit der Adresse 58H und 19200 Baud

7.10. IC-718 mit der Adresse 5EH und 19200 Baud

 Setzen Sie  N1MMLogger auf 19200 Baud und stellen Sie den 
Transceiver auf "AT" (AuTo). 
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7.11. IC-725 mit der Adresse 28H und 9600 Baud

7.12. IC-728 mit der Adresse 38H und 19200 Baud

7.13. IC-729 mit der Adresse 3AH und 19200 Baud

7.14. IC-735 mit der Adresse 04H und 9600 Baud

 Da im Kommandosatz eine Menge an Kommandos nicht 
enthalten sind, wird nur eine beschränkte Funktionalität erreicht. 
Es fehlen die VFO- und Splitkommandos.   

 Stellen Sie den IC-735 von der Fabrikeinstellung (1200 Baud, 
transceive ON) auf 9600 Baud um, sonst ist die Bandskala sehr 
langsam. Der Jumper J22 befindet sich auf der Leiterplatte der 
PL-Unit (obere Seite unter der PA). Das Diodenfeld ist nicht 
bezeichnet. Informieren Sie sich über die Modifikation im 
Internet. Schalten Sie Transceive auf OFF und die Baudrate auf 
9600 Baud um. 

Die Diodenbestückung für Jumper J22 mit 9600 Baud, Transceive OFF und Adresse 
04 sieht von links nach rechts und Frontplatte vorn so aus:  

1 2 3 4 5 6
ON OFF OFF OFF ON OFF

Baud rate Baud Rate Address Address Address CI-V transceive

Mit dieser Einstellung funktioniert der IC-735 mit N1MMLogger (trx IC735 /Baudrate 
9600 / 8 Databits / no Parity / 1 Stoppbit). DTR und/oder RTS werden vom ICOM-
Interface nicht benutzt. Sie können mit ‘Always ON’ zur Spannungsversorgung des 
Interfaces verwendet werden oder CW und/oder PTT tasten, wenn Sie nur wenige 
COM-Schnittstellen an Ihrem Rechner haben.
Patrick F6IRF 

7.15. IC-736 mit der Adresse 40H und 9600 Baud

7.16. IC-737/737A mit der Adresse 3CH und 9600 Baud

 Da im Kommandosatz eine Menge an Kommandos nicht 
enthalten sind, wird nur eine beschränkte Funktionalität erreicht. 
Es fehlen die VFO- und Splitkommandos.  

7.17. IC-738 mit der Adresse 44H und 9600 Baud

7.18. IC-746 mit der Adresse 56H und 19200 Baud

 VFO-B ist ein virtueller VFO solange er nicht aktiviert ist. Die 
Skala wird nicht vom VFO-B des Transceivers gesteuert. Er wird 
zu aktiven VFO, wenn er aktiviert wird. Der IC-746 wird auf den 
VFO-B geschaltet und seine Frequenz wird in der Bandskala B 
angezeigt. 
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7.19. IC-746 PRO mit der Adresse 66H und 19200 Baud

 Die Sendearten USB-D / LSB-D werden unterstützt. 

7.20. IC-751/751A mit der Adresse 1CH und 9600 Baud

 Da im Kommandosatz eine Menge an Kommandos nicht 
enthalten sind, wird nur eine beschränkte Funktionalität erreicht. 
Es fehlen die VFO- und Splitkommandos.  

Um mit dem Transceiver zu kommunizieren muss die Baudrate, die Funktion 
Transceive und die Bytezahl für die Frequenz korrekt eingestellt werden. Die 
Einstellung erfolgt über DIP-Schalter auf dem ICOM-Interface UX-14. Die Einstellung 
ist im Handbuch auf Seite 11 beschrieben. Setzen Sie die Schalter in der Reihe S1 
Nummer 1…6 auf  'On - Off - Off - Off - Off – On’. Diese Einstellung bewirkt eine 
Baudrate von 9600 Baud, eine Frequenzangabe mit 5 Byte und Transceive OFF. 
Falls der Transceiver die Baugruppe Piexx UX-14 CI-V enthält, stellen Sie die DIP-
Schalter anhand des Piexx-Handbuchs auf die gleichen Werte ein.

7.21. IC-756 mit der Adresse 50H und 19200 Baud

 Informieren Sie sich über die Tastenzuordnung zu Alt+F12 und 
die Einstellung 'Dual Rx always on' im Config-Menü. 

7.22. IC-756 PRO mit der Adresse 5CH und 19200 Baud

 Informieren Sie sich über die Tastenzuordnung zu Alt+F12 und 
die Einstellung 'Dual Rx always on' im Config-Menü. 

7.23. IC-756 PRO II mit der Adresse 64H und 19200 Baud

 Informieren Sie sich über die Tastenzuordnung zu Alt+F12 und 
die Einstellung 'Dual Rx always on' im Config-Menü. 

 USB-D / LSB-D digital modes supported. 

7.24. IC-756 PRO III mit der Adresse 6EH und 19200 Baud

 Informieren Sie sich über die Tastenzuordnung zu Alt+F12 und 
die Einstellung 'Dual Rx always on' im Config-Menü. 

 Die digitalen Modi USB-D / LSB-D werden unterstützt 

7.25. IC-761 mit der Adresse 1EH und 9600 Baud

 Da im Kommandosatz eine Menge an Kommandos nicht 
enthalten sind, wird nur eine beschränkte Funktionalität erreicht. 
Es fehlen die VFO- und Splitkommandos. 

Um mit dem Transceiver zu kommunizieren muss die Baudrate, die Funktion 
Transceive und die Bytezahl für die Frequenz korrekt eingestellt werden. Die 
Einstellung erfolgt über DIP-Schalter auf dem ICOM-Interface UX-14. Die Einstellung 
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ist im Handbuch auf Seite 11 beschrieben. Setzen Sie die Schalter in der Reihe S1 
Nummer 1…6 auf  'On - Off - Off - Off - Off – On’. Diese Einstellung bewirkt eine 
Baudrate von 9600 Baud, eine Frequenzangabe mit 5 Byte und Transceive OFF. 
Falls der Transceiver die Baugruppe Piexx UX-14 CI-V enthält, stellen Sie die DIP-
Schalter anhand des Piexx-Handbuchs auf die gleichen Werte ein. 

7.26. IC-765 mit der Adresse 2CH und 9600 Baud

7.27. IC-775/775DSP mit der Adresse 46H und 19200 Baud

 Informieren Sie sich über die Tastenzuordnung zu Alt+F12 und 
die Einstellung 'Dual Rx always on' im Config-Menü. 

7.28. IC-781 mit der Adresse 26H und 9600 Baud

 Informieren Sie sich über die Tastenzuordnung zu Alt+F12 und 
die Einstellung 'Dual Rx always on' im Config-Menü. 

7.29. IC-910H mit der Adresse 60H und korrekter Baudrate

 Informieren Sie sich über die Tastenzuordnung zu Alt+F12 und 
die Einstellung 'Dual Rx always on' im Config-Menü. 

Das Kommando ALT+F10 tauscht die VFOA/B in Frequenz und Sendeart nur im 
Modus SO1V und SO2V. 

7.30. IC-1275A/E mit der Adresse 18H und 9600 Baud

 Da im Kommandosatz eine Menge an Kommandos nicht 
enthalten sind, wird nur eine beschränkte Funktionalität erreicht. 
Es fehlen die VFO- und Splitkommandos.  

7.31. IC-7000 mit der Adresse 70H und 19200 Baud

7.32. IC-7200 wird unterstützt

 Die USB-Codecs von IC-7600 und IC-7200 werden unterstützt. 
Nutzer des IC-7600 können ein USB-Kabel für die CAT-
Steuerung, AFSK RTTY, PSK, die Aufzeichnung von 
Sprachmitteilungen, das Abspielen von Sprachmitteilung und 
das Mitschneiden von QSOs verwenden. Der IC-7200 kann 
keine Sprache im Flug aufzeichnen. In CW wird nur der 
empfangene Teil aufgezeichnet. Dadurch entstehen 
Einschränkungen.  

 Sie finden ausführliche Angaben zur USB-Kommunikation in 
the File Gallery. 
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7.33. IC-7400 wird nicht direkt unterstützt

 Der Transceiver wird nicht direkt unterstützt. Stellen Sie ihn wie 
einen IC-746 PRO ein, mit dem er voll kompatibel ist. 

7.34. IC-7600 wird unterstützt

 Die Modi USB-D / LSB-D werden unterstützt. 
 Die USB-Codecs von IC-7600 und IC-7200 werden unterstützt. 

Nutzer des IC-7600 können ein USB-Kabel für die CAT-
Steuerung, AFSK RTTY, PSK, die Aufzeichnung von 
Sprachmitteilungen, das Abspielen von Sprachmitteilung und 
das Mitschneiden von QSOs verwenden. 

 Sie finden ausführliche Angaben zur USB-Kommunikation in 
the File Gallery. 

7.35. IC-7700 mit der Adresse 74H und 19200 Baud

 Die Modi USB-D / LSB-D werden unterstützt. 

7.36. IC-7800 mit der Adresse 6A hex und 9600 Baud

 Informieren Sie sich über die Tastenzuordnung zu Alt+F12 und 
die Einstellung 'Dual Rx always on' im Config-Menü. 

 Die Modi USB-D / LSB-D werden unterstützt. 

8. Kenwood

8.1. Überblick zu Kenwood (General Kenwood information)

o Es werden alle Modelle unterstützt. 
 Neuere Modelle werden über ein RS-232-Kabel angeschlossen. 
 Für ältere Modelle benötigen Sie das Interface Kenwood IF-10 

und/oder das IF-232C-Interface. Informieren Sie sich im 
Handbuch Ihres Transceivers. 

 Bei sehr alten Transceivern wie den TS-940S, TS-440S, 
TS-811, und TS-711 müssen Sie einen Chipsatz 
nachinstallieren. 

 Die Firma PIEXX (www.piexx.com) stellt einen Konverter 
für den TS-940 und eine Ersatzlösung für den TS-930 
her. 

o Die Kenwood-Transceiver verwenden meist ein Hardware-Handshaking 
Dabei muss DTR= Always auf on oder Handshake und RTS = Always 
auf on oder Handshake stehen. 

 Sie können mit einer Brücke auf der Transceiverseite zwischen 
CTS und RTS auf der Rechnerseite die Signale DTR und RTS 
für CW und PTT verwenden. 

o Die Kenwood-Interfaces (IF-232 für die älteren x40 and -x50-Serien) 
und das direkte RS-232-Kabel der neueren TS-480/570/870/2000 
benötigen ein Handshake. Eine Ausnahme ist der TS-570, bei dem Sie 
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einen Jumper zwischen CTS und RTS am RS-232-Eingang setzen 
können.  

o Der Jumper für das “unechte” Handshake lenkt das Signal RTS für die 
PTT frei, zusätzlich dazu kann DTR für CW verwendet werden. Sie 
können auch RTS auf Always On setzen und DTR für PTT oder CW 
verwenden. DTR wird im Interface nicht verwendet. 

o Während des Sendens wird die RX/TX-Information vom Transceiver 
nicht verwendet, um Störungen zu vermeiden. 

o Kenwood verwendet voreingestellt in allen Transceivern: 
 Baudrate: 4800, 8 Datenbits, 2 (!!) Stoppbits, kein Prüfbit (N) und 

Handshaking für RTS und DTR. 
 Beim Splitbetrieb wird für beide VFOs die gleiche Sendeart 

erzwungen. 
 Die folgenden Kenwood-Transceiver  werden unterstützt: 

8.2. TS-480

 "PTT via radio command" wird nicht unterstützt, 
wenn "AFSK" über die Datenbuchse gemacht wird. 
TS-480-Nutzer haben zwei Möglichkeiten:  

 Verwenden Sie das Hardware-PTT (RTS) von der 
digitalen Buchse verbunden mit dem Pin 3 (DTR) 
der DATA-Schnittstelle für das digitale PTT. 
Konfigurieren Sie bei MMTTY und/oder MMVARI 
so, dass DTR für PTT verwendet wird. 

 Speisen das NF-Signal für AFSK/PSK an der 
Mikrofon-Buchse ein. Dort funktioniert das "PTT via 
radio command". 

8.3. TS-570

 Wählen Sie Kenwood
 Wenn Sie die Buchse ACC2 verwenden, müssen 

Sie die NF und die PTT dort einspeisen. 
 Den PTT-Anschluss an der Mikrofonbuchse 

können Sie nicht verwenden, wenn Sie die NF an 
der ACC-Buchse einspeisen. 

 SO2V: 
9600,N,8,1,handshake,handshake,radio/VFO=1 

8.4. TS-950sdx

 Wählen Sie Kenwood
 Einige ältere TS-950SDX nehmen die Leistung 

zurück, wenn Sie von einem Logprogramm 
abgefragt werden. 

 Das Problem liegt bei der Firmware im 
Geräte-ROM des TS-950SDX. 

 Ersetzen Sie den Schaltkreis und das 
Problem ist behoben. Die Kosten belaufen 
sich auf $27 und Sie benötigen 10 Minuten. 
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 Wechseln Sie auch gleich die Batterie aus, 
sie sitzt rechts neben dem Schaltkreis. 

 Baudrate 4800 Baud; Parity: N ;Databits: 8; 
Stopbits: 2 (!) 

8.5. TS-850

 Wählen Sie Kenwood
 Schalten Sie AI auf OFF mit der Initialisierung 
 Speed: 4800 Baud; Parity: N ;Databits: 8; Stopbits: 

2 (!) 

8.6. TS-50, TS-140, TS-440, TS-680,TS-711,TS-790,TS-811,TS-940

Wählen Sie die Option Kenwood-Slow anstelle von LKenwood. 

8.7. TS-2000

 Wählen Sie den TS-2000. Sie können eine getrennte 
Empfangsantenne anschließen und steuern. 

 Voreingestellt sind 9600 Baud; Parity: N ; 8 Databits und 1 
Stoppbit. DTR= Handshake and RTS = Handshake 

 Bei der Verwendung von 4800 Baud müssen Sie zwei 2 
Stoppbits verwenden! 

 Diese Geschwindigkeit kann mit dem Menüpunkt 56 
eingestellt werden 

 Er arbeitet auch auf Frequenzen über 100 MHz 
 Verwenden Sie den Modus "auto-mode" nicht. Diese 

ändert automatisch die Transceiversendeart. 
 Verwenden Sie den VFO-Modus und nicht den Memory-

Modus. 

8.8. N1MMLogger verliert den Kontakt mit dem Transceiver (TS-850, 
TS-950 u.a.) N1MM logger loses communication with the 
radio (TS-850, TS-950 etc.)

Das Problem wird vom Mikroprozessor des Transceivers verursacht. Einige ältere 
Transceiver können nicht mit dem Rechner verkehren, wenn an der Abstimmung 
gedreht wird. Verwenden Sie dann die Einstellung Kenwood-Slow. Unter Umständen 
müssen Sie die 'transceiver timeout time' mit einem Rechtsklick in die Bandskala 
bis auf 120 Sekunden erhöhen. 

9. TenTec

9.1. Überblick zum Ten Tec (General TenTec information)

 Die unten stehenden Modelle werden unterstützt, andere 
Modelle werden nicht unterstützt. 
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9.2. ARGONAUT V

9.3. JUPITER

 Verwenden Sie 1 Stoppbit und DTR und RTS 'Always on'. 
Verwenden Sie nicht die CW-Tastung über die Schnittstelle. 

9.4. OMNI-VI

 Beim Omni VI+ muss der Punkt "Cde" unter Menü 2 auf OFF 
gestellt werden. Sonst gibt es Kollisionen mit den N1MM-
Abfragen, weil der Transceiver ungefragt Daten sendet. 

9.5. OMNI-VII

 Der Omni-VII unterstützt die Antennenumschaltung im "radio"-
Modus nicht. Sie kann nur im "remote"-Modus verwendet 
werden. Die Nutzer des Omni-VII können die Antennenschalt-
Makros nicht verwenden. 

 Alt+F10 (VFOs tauschen) und CW-Reverse werden unterstützt. 
 Der Omni-VII kann nicht auf VFO-B empfangen. 

9.6. Orion

 Verwenden Sie die voreingestellten 56000 Baud, ein Stoppbit 
und Hardware-Handshaking. 

 Benötigt wird Firmware Version 1.363 und höher 
 Beachten Sie, dass der Orion die PTT-Umschaltung per CAT-

Kommando in CW nicht unterstützt. Es funktioniert in SSB, aber 
für CW brauchen Sie eine Steuerleitung von der seriellen oder 
parallelen Schnittstelle für die PTT. Gehen Sie an Pin 3 der 
AUX-Buchse des Orion. Das ist die schwarze RCA-Buchse de 
AUX-Kabels. Sie können mit einem Y-Adapter die PTT-Leitung 
und einen Fußschalter parallel schalten.  

 Wenn Sie PTT und CW über eine serielle oder parallele 
Schnittstelle steuern, müssen Sie im Orion CW-Menü den Punkt 
"PTT in CW“ auf den Wert „Mox" setzen. 

 Voreingestellte Bandbreiten sind: CW: 300/800; SSB: 
2000/2800; RTTY 250/400 

 CW wird am Hauptempfänger als LCW empfangen 
 Die Sprachsteuerung (Digital Voice Keying (DVK)) über die 

Buchse AUX wird unterstützt. Die NF muss über die AUX-
Buchse und nicht über das Mikrofon eingespeist werden.

 Wenn DVK nicht spezifiziert ist, wird die 
Mikrofonverstärkung an der Frontplatte auf 0 eingestellt. 

 Microkeyer-Nutzer: Informieren Sie sich im Kapitel 
Supported Hardware über die Stummschaltung des 
ORION-Mikrophon-Eingangs. 

 Wenn die DVK spezifiziert ist, wird die 
Mikrofonverstärkung in der Regel nicht verändert. 
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 Mit die Tasten Pfeil nach oben/unten gedrückt sind, schalten Sie 
bei S&P die RIT ein und in RUN aus.  

 Löschen Sie die RIT durch Setzen auf 1 Hz, nicht auf 0, das 
verhindert das Ausschalten der RIT. 

 Setzen Sie die schmale  SSB-Bandbreite auf 1990 Hz um die 
Verwendung des 2.4 kHz-Filters im Modus Auto zu erreichen. 

 Die RIT kann mit den Tasten Pfeil nach oben/unten verändert 
werden, wenn die RIT aktiv ist. Sie müssen die RIT über das 
Programm einschalten.  

 Tauschen Sie die VFOs mit Alt+F10 aus. Die Speicherplätze 199 
und 200 werden überschrieben. 

 Beispiel für eine Einstellung FSK/CW/SSB 
 In FSK oder SSB verwendet das Programm den PTT-

Eingang des Geräts 
 In CW verwendet das Programm die PTT als CW-Taste 

 Digitale Einstellung und MMTTY: 
 N1MM Config / Config Ports / Karteikarte 

Hardware:  
 Wählen Sie für die Leitung DTR 

(Pin4) die Einstellung CW  
 MMTTY Setup / Setup MMTTY / Karteikarte 

TX  / Taste Radio command : 
 Wählen Sie PTT unter DTR/RTS. 

 Interface-Anschlüsse 
 LINE OUT (74) (RCA connector) liefert einen 

ungeregelten NF-Ausgang 
 Verbinden mit Eingang LINE IN der Soundkarte 
 Die gelbe Phono-Buchse geht an Pin4 des  AUX 

I/O-Kabels 
 Das ist ein kombinierter Ausgang für beide 

Empfänger, verwenden Sie am AUX I/O die 
getrennten Ausgänge (Pin 4 und 6) 

 AUX I/O port (80): AUX IN (Pin 1) wird mit dem Ausgang 
LINE OUT der Soundkarte verbunden. 

 Die AUX-Verstärkung wird im SSB-Menü 
eingestellt 

 Stellen Sie die AUX-Verstärkung auf 65 und regeln 
Sie den Sendepegel mit dem Windows-Mixer Ihres 
Rechners auf 100 Watt für RTTY. 

 AUX port: PTT (pin 3) 
 Sie benötigen einen Schalttransistor für die 

Steuerung über die serielle oder parallele 
Schnittstelle Ihres Rechners 

 Funktioniert gut bei digitalen Sendearten und auch bei 
Aufzeichnung und Wiedergabe über den DVK 

 Schalten Sie zwischen MIKE und AUX über das Menü 
um. 
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10. Yaesu

10.1. Überblick zu YAESU (General Yaesu information)

 Die unten aufgezählten Modelle werden unterstützt, andere 
Modelle werden nicht unterstützt.

 Benötigte Interfaces: 
 Neuer Modelle werden direkt über ein RS-232-Kabel 

verbunden 
 Für ältere Modelle benötigen Sie das Interface Yaesu FIF-

232C CAT oder eine kompatible Lösung. 
 Alle Modelle verwenden Software-Handshaking  
 Die YAESU-Standardeinstellung ist Datenrate: 4800 Baud, kein 

Prüfbit (Parity: N), 8 Datenbits, 2 (!) Stoppbits 

10.2. FT-100(D)

 Der interne Jumper zwischen CAT/TUNER oder LINEAR muss 
auf CAT/TUNER gesetzt sein. 

 Stellen Sie für den FT-100 das Interface auf  4800 Baud, 
Datenformat 8N2,  Handshake, Tx=1, DTR=Always on oder off, 
RTS=Always on oder off. 

 Sie brauchen ein FT-100 CAT-Kabel (CT-62). 

10.3. FT-736

 Nicht unterstützt. Es sieht so aus, wenn das Gerät einmal per 
CAT gesteuert wurde, kann es nicht mehr von Hand gesteuert 
werden.  (Anmerkung DM3ML: So schlimm ist es nicht, es ist nur 
ziemlich alt und kann sehr wenig)

10.4. FT-450

 Unterstützt

10.5. FT-757

 Wählen Sie FT-757GXII und setzen Sie das Timeout in der 
Bandskala auf 0.  

 Der FT-757GX sendet NICHTS an den Rechner und ist dadurch 
in seiner Steuerbarkeit sehr eingeschränkt.  

10.6. FT-757GXII

 Unterstützt 
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10.7. FT-817

 19200, N, 8, 1, Handshake, Handshake. FT-817 CI-V Baud "Hi". 
Wenn Sie einen USB-Seriell-Adapter verwenden setzen Sie 
DTR auf 'Always on' und RTS auf 'Always off'. 

 Die Bandbreitentaste in der Bandskala wird nicht unterstützt und 
wird auch nicht angezeigt 

 Die CAT-Kommandos sind wie beim Yaesu FT-817, FT-857 und 
FT-897 eingeschränkt:

 Lesen Sie sich dazu die Liste der CAT-Kommandos auf 
den Seiten 72 (FT-817), 62 (FT-897) oder 115 (FT-857) 
Ihres Handbuchs durch. 

 VFO A/B : Sie können nur von einem VFO auf den 
anderen umschalten, das Programm weiß aber nicht, ob 
es sich um VFO-A oder VFO-B handelt.  

 Schmales CW-Filter : Es gibt kein CAT-Kommando, um 
diese Filter umzuschalten. 

10.8. FT-840

 Unterstützt 

10.9. FT-847

 Die Split-Funktion funktioniert nicht, weil es dafür keine CAT-
Kommandos gibt. Sie muss vom OP manuell eingestellt werden. 

 RIT und XIT in der Bandskala funktionieren nicht, sie werden 
vom FT-847 nicht unterstützt. 

 Sie können auf Frequenzen über 100 MHz arbeiten 
 Der Modus CW-R wird unterstützt 

10.10. FT-857

 Wählen Sie den FT-897 als Transceiver 
 Beim FT-857 und FT-897 kann N1MMLogger nicht die VFOs 

auswählen, so dass es zu Einschränkungen kommt 

10.11. FT-890

 Unterstützt 

10.12. FT-897

 Unterstützt 
 Die Bandbreiteneinstellung über die Bandskala ist unwirksam 

und wird nicht angezeigt. 
 Beim FT-857 und FT-897 kann N1MMLogger nicht die VFOs 

auswählen, so dass es zu Einschränkungen kommt 
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10.13. FT-900

 Unterstützt 

10.14. FT-920

 PTT über CAT wird unterstützt 
 Zur Filtereinstellung siehe unten 

10.15. FT-950

 Unterstützt 

10.16. FT-990

 Der FT-990 und der frühe FT-1000 hatten ein Problem mit dem 
CAT-Interface. Das funktionierte mit einem Offenen-Kollektor-
Transistor über eine serielle Leitung. Es funktionierte mit einem 
TTL HIGH (+5 V), aber manche TTL-zu-RS232-Interfaces 
lieferten nicht genug Strom und das Interface erzeugte einen 
schwimmenden Pegel zwischen 3 und 3.5 V. Die Lösung war, 
einen 1.5K Ohm-Widerstand von "serial out" nach Masse zu 
schalten. Wenn Sie die Schaltung aus dem ARRL-Handbuch 
verwenden, dann ist der 1.5k-Widerstand zwischen Pin 1 des 
7417 nach Masse zu schalten.

 Zur Filtereinstellung siehe unten 

10.17. FT-1000(D)

 Die CAT-Steuerung funktioniert nicht mit der FT-1000D-
Firmware unter Version 6. Sie brauchen eine Aktualislierung! 

 Zu einem weiteren CAT-Problem siehe FT-990 weiter oben. 
 Klappt die Bandskalaanzeige nicht, schalten Sie MEM aus und 

VFO ein. Das Programm initialisiert die Einstellung auf den VFO-
Modus 

 Zur Filtereinstellung siehe unten 
 Sehen Sie sich die Tastenzuordnung zu Alt+F12 an 

10.18. FT-1000MP (Mark-V)(Field) (nicht verwenden mit einer 
SteppIR-Antenne)

 Sehen Sie sich die Tastenzuordnung zu Alt+F12 an 
 Das Programm kann keine CW über das serielle MP-Kabel 

tasten. Sehen Sie in das Kapitel Hilfe zum Bau eines externen 
CW-Interfaces. 

 Klappt die Bandskalaanzeige nicht, schalten Sie MEM aus und 
VFO ein. Das Programm initialisiert die Einstellung auf den VFO-
Modus 

 Der Indikator sollte VFO anzeigen 
 Verwenden Sie ein 1:1-serielles Kabel 
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 4800,N,8,2 und DTR und RTS = "Always Off" 
 Ein großes Problem beim FT-1000MP ist, dass Sie nicht den 

VFO-B als RX zuschalten können. Sie können ihn zwar 
zuschalten, haben aber keine Kontrolle darüber, ob Sie dual 
oder nur mit VFO-B hören. Sie können es ermitteln, aber nicht 
einstellen. Der Nutzer muss den Main-RX-Knopf drücken um den 
Haupt-RX abzuschalten, um allein mit VFO-B zu hören. Mit 
ALT+F10 können Sie die Frequenzen von VFO-A und VFO-B 
vertauschen. Das ist sehr nützlich in diesem Fall.

 Eine optimale Konfiguration gibt es für Nutzer von AFSK 
und/oder PSK. Die Anzeigedifferenz beträgt 85 Hz gegenüber 
RTTY, das ist vernachlässigbar.  

PKT schaltet auf LSB und verschiebt die Frequenzskala um 2.125 KHz (oder den 
vom Nutzer eingestellten Wert des Menüs 6-4). Es wählt als NF-Eingang die Buchse 
PACKET an der Geräterückseite, schaltet den Kompressor aus und tastet das 
Mikrofon stumm. Zusätzlich schaltet es die schmalen Filter ein und schiebt sie an die 
richtige Stelle wie im Menü 6-5 festgelegt. 

 QMB-Speicher verwenden 
 Wenn Sie ein QMB RCLl machen, drücken Sie  M>A bis 

es die QMB-Frequenz in den VFO lädt. Sie verlieren aber 
dadurch die im VFO-A eingestellte Frequenz. 

 Zur Filtereinstellung siehe unten 

10.19. FT-1000MP mit SteppIR

 Wählen Sie diesen FT1000MP, wenn Sie eine SteppIR-Antenne 
verwenden. 

 Diese Kombination wurde für die Kombination 
FT1000MP<>SteppIR optimiert 

10.20. FT-1000-Serie, FT-990 und FT-920-Filtereinstellung

Klicken Sie rechts in die Bandskala und wählen Sie den Menüpunkt "Set transceiver 
filter codes" . Sie haben sechs Submenüs: CW Wide, CW Narrow, SSB Wide, SSB 
Narrow, Digi Wide und Digi Narrow.  

• Die Einstellungen funktionieren mit den Transceivern FT-1000, FT-1000D, FT-
1000MP, FT-1000MP/MKV und FT-1000MP/MKV Field oder einer 
Kombination von  zwei Geräten aus der FT-1000-Familie im Modus SO2R  

BandWidth VFO-A (main) VFO-B (sub) Filter Bemerkungen

2.4 kHz 0 0 0 0 140 0 0 0 128 140 SSB Wide oder Digi 
Wide — 

2.0 KHz 0 0 0 1 140 0 0 0 129 140 SSB Narrow oder 
Digi Narrow

2.4 kHz für VFO-
B 

500 Hz 0 0 0 2 140 0 0 0 130 140 CW Wide oder Digi 
Wide — 

250 Hz 0 0 0 3 140 0 0 0 131 140 CW Narrow oder 500 Hz für VFO-B 
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Digi Narrow
6.0 KHz 
(thru) 0 0 0 4 140 0 0 0 132 140

 Beim VFO-B (sub) können Sie nur die Bandbreiten  6.0 KHz, 2.4 
KHz und 500 Hz verwenden 

 Für SO2R (zwei Geräte) konfigurieren Sie beide Bandskalen 
übereinstimmend 

 Hinweise: 
 "Duplicates default filter settings" gibt es nur beim FT-

1000 MK/V und Field. Der FT-1000/D/MP erlaubt eine 
flexiblere Filter-Auswahl 

 Beim FT-920 gibt es keine 2.0 KHz und 250 Hz Filter. Es 
macht mehr Sinn CW und Digi auf 2.4/500 Hz (0 0 0 0 
140 and 0 0 0 2 140) einzustellen. 

 Der FT-920 hat keinen Zweitempfänger, man kann aber 
unterschiedliche Bandbreiten für die VFOs wählen. Die 
CAT-Kommandos sind die gleichen wie bei der 1000er-
Serie: 0 0 0 130 140 wählt 500 Hz und 0 0 0 128 140 
wählt 2.4 KHz. 

 Die FT-990-Kommands sind die gleichen wie beim VFO A 
in der "1000"-Transceiver-Serie. 

10.21. FT-2000

 Voreingestellt auf  4800 Baud, 8 Datenbits, kein Prüfbit, zwei 
Stoppbits. Setzen Sie DTR auf ‘Always off’ und RTS auf ‘Always 
on’. 

 Falls es nicht funktioniert, versuchen Sie es mit DTR auf 
‚Always on’. 

 Wenn Sie ein 3-Draht-Kabel (TX, RX und Masse) verwenden, 
setzen Sie CAT RTS=disable on radio (voreingestellt ist 
enable). Das Kabel überträgt sie Signale DTR und RTS nicht. 
Andere Transceivereinstellungen wie CAT TIME OUT = 10 
msec und CAT RATE=4800 können so bleiben, wie 
voreingestellt. Das 3-Draht-Kabel funktioniert auch mit USB-
Seriell-Adaptern. 

10.22. FTDX-9000

 Unterstützt. 

Andere Marken werden bis jetzt nicht unterstützt.

Last Modification: 30 December 2009 10:27:46 EST by ve3ki. 

Programme von Drittanbietern (Third Party Software)

Alle angeführten Programme sind Freeware! 
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1. Integration mit anderen Programmen (Integration with other programs)

Bei neueren Ausgaben wird N1MMLogger das UDP-Interface für die Kopplung mit 
anderen Anwendungen benutzen. Mit diesem Interface kann es Daten an andere 
Programme senden und von ihnen empfangen. Dann brauchen zwei Nutzer nicht am 
gleichen Computer zu sitzen, sie brauchen nur über ein LAN verbunden sein.  

Das externe Programm erhält automatisch die Ergebnisse von N1MMLogger oder 
kann andere Logdaten verarbeiten.  

2. Athena (von Carel, PC5M)

Athena hat diese Eigenschaften: 

• Anzeige von Echtzeit-Contest-Statistiken 
• Grafiken mit der Stundenraten, aufsummierten Ergebnissen und Zielen
• Auswählbare Grafiken mit der QSO-Zahl, Multis, Punkten und Ergebnissen
• Grafiken per Operator und Band
• Numerische Statistiken über alles mit Angabe aller wie viel Minuten ein neuer 

Multi dazu kommt
• Import von Zieldaten von früheren N1MM-Contesten
• Einfache Anpassung der Zieldaten an den aktuellen Contest

Athena wurde für die Echtzeitauswertung eines laufenden Contests entwickelt. Es 
zeigt an, wie viel QSOs und Multis gearbeitet wurden und welche aktuelle Punktzahl 
sich ergibt. Die Daten werden pro Band oder über alles angezeigt. Die für einen 
Operator spezifischen Daten zeigen die aktuelle Leistung an. Zielvorgaben können 
importiert und mit den aktuellen Ergebnissen verglichen werden. Dabei werden die 
Athena-Daten den beschränkten von N1MMLogger gelieferten Daten vorgezogen.

Athena übernimmt nur Daten von N1MMLogger und ändert das Log von N1MM nicht. 
Die Statistik wird in Echtzeit berechnet und abgespeichert. Nur die erzeugten 
Zielvorgaben werden mit Dateisystem als XML-Datei gespeichert. Die Daten von 
Athena werden im Nutzerverzeichnis gespeichert.
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3. Thucydides (von Carel, PC5M)

Mit Thucydides werden die aktuellen Contest-QSOs in der Rufzeichengeschichte 
aktualisiert. Thucydides ist ein getrenntes Programm, das mit N1MMLogger und 
seiner Rufzeichengeschichte gekoppelt wird. Es übernimmt die Daten aus dem 
aktuellen Contest und baut sie in die Rufzeichengeschichte z.B. bezüglich Lokator, 
Staat, CK usw. 

Der Nutzer kann eine separate Datenbank mit MS-Access aufbauen, in die die Daten 
der aktuell geloggten QSOs von N1MMLogger und andere (ältere) Rufzeichendaten 
importiert werden. Der Nutzer kann das Verhalten des Programms in einem weiten 
Bereich beeinflussen und vorgeben und Daten als EXCEL-Datei importieren.

 

Thucydides stellt diese Eigenschaften zur Verfügung:  

• Erzeugung von contestspezifischen und optimierten Rufzeichengeschichten 
• Aktualisierung der Rufzeichengeschichte mit aktuellen geloggten QSOs
• Anzeige der Datenbank von ausgewählten Contesten und 

Rufzeichengeschichten 
• Es werden alle Contest von N1MMLogger unterstützt

Lesen Sie sich das Handbuch des Programms durch. Sie finden es über einen Link 
im Kapitel Links . 

4. AB_Umschalter für SO2R ohne LPT-Schnittstelle (AB_Switcher (for 
SO2R without using an LPT-port))

Mit dem AB_Switcher können Sie die Transceiver A/B ohne Verwendung einer 
Parallel-Schnittstelle auf Ihrem Rechner umschalten.  Im Prinzip überwacht das 
Programm die Pegel der Windows-Mixer der Soundkarten und schaltet das Signal 
DTR auf der ausgewählten Schnittstelle zusammen mit dem RX-Fokus um. 
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Das Programm unterstützt sowohl die Umschaltung des RX-Fokus als auch des TX-
Fokus. Das funktioniert unter N1MMLogger im Modus $5S02R. Benötigt wird eine 
zweite serielle Schnittstelle, um mit den Signalen DTR und RTS die externe S02R-
Box umzuschalten. 

Es kann auch eine zweite Soundkarte überwachen und über einen zweiten COM-
Port Informationen über den RX-Fokus liefern (Links/Rechts/Split). Es macht das 
durch Überwachung der Stummschaltung für die ausgewählten Eingänge. AB-
Switcher Version 2 stellt eine Kombination aller drei SO2R-Steuersignale zur 
Verfügung. Wenn nur zwei der drei Signale benötigt werden, kommt AB Switcher mit 
einem einzelnen COM-Port aus. Es verarbeitet auch COM über COM8.

Mit Dan's Treiber können Sie jetzt die microHAM MK2R/MK2R+ SO2R-Kontroller 
effektiv mit N1MMLogger an einem "Nur USB“-Rechner verwenden. Die Eingänge 
SW Synth und CD Audio am zweiten Codec (USB Audio CODEC) beim MK2R+ 
können Sie als Links/Rechts-Audioquellen für den Modus "$5 SO2R" verwenden und 
so das USB Audio CODEC als ideales Ziel für "$5 SO2R“ einsetzen. 

Lesen Sie sich die Homepage von N1MMLogger. Sie finden es über einen Link im 
Kapitel Links . 

5. I8NHJ-Internetinterface (I8NHJ web interface)

I8NHJ hat ein nettes Internet-Interface für die N1MMLogger-Datenbank geschrieben. 
Sie erhalten eine Statistik über den Contest, die gearbeiteten Station und vieles 
andere in Echtzeit. Lesen Sie die Datei WebInterface_Howto.txt aus der ZIP-Datei. 
Es wurde unter Windows NT/W2K/XP getestet. Sie benötigen MS Office und MS 
Access 2000. MS-Office  wird nicht für N1MMLogger, aber für das Internetinterface 
benötigt. 

Aus der Datei HowTo.txt file und weitere Informationen von Max, I8NHJ 

Dieses Programm wurde geschrieben, um ein einfaches, leistungsfähiges und 
anpassungsfähiges Interface zu einem von N1MMLogger erzeugten Log während 
eines Contests oder einer Dxpedition bereitzustellen. Es wird als AS.IS unter GUI-
Lizenzbedingungen vertrieben. Es kann frei benutzt und verbreitet werden, es sollte 
aber auf mich (I8NHJ) und den Programmierer (AGO) hingewiesen werden, der die 
erste Version 1.0. vom November 2002 geschrieben hat.

Das Web-Interface wurde unter Verwendung von tiefen ASP-Techniken geschrieben 
und benötigt volle ASP-Unterstützung. Sie sollten nach einer guten ASP-
Unterstützung für eine andere Plattform als Microsoft suchen . Wir verwenden hier 
Linux, haben aber noch keine ASP-Unterstützung gefunden und darüber hinaus kann 
eine solche Lösung zu komplex für einen durchschnittlichen Nutzer werden.

Um eine volle Funktionalität des Werkzeugs zu erreichen, muss auf der Serverseite 
das Microsoft-Office-Paket installiert sein. MS-Access wird nicht unbedingt benötigt, 
denn einige grafische Eigenschaften werden durch Komponenten von Excel und 
Word bearbeitet. Falls Sie auf der Serverseite kein MS-Office installiert haben, läuft 
zwar das Web-Interface, aber es erfolgen keine grafischen Ausgaben.
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Erläuterung von Franki, ON5ZO 

Max, I8NHJ, hat dieses Interface für das Programm N1MMLogger und seine 
Datenbank (*.mdb-Dateien) geschrieben. Dankenswerterweise hat er es an die 
N1MMLogger-Nutzer weitergegeben. 

Sie können sich das Programm von der N1MM logger web site   unter 'Downloads', 
im Menü 'Other Files' holen. Sein Name ist 'webinterface1-x.zip'.  Es ist kein 
Programm, dass Sie allein stehend starten können. Es ist eine Art von Web-Seite. 
Sie müssen einen Webserver auf Ihrem Rechner zu Hause laufen haben. Dafür gibt 
es mehrere Möglichkeiten:  

1. Sie wissen alles über Server und ASP und haben einen ASP-Server laufen. Sie 
wissen mehr als ich ….
2. Sie haben Windows 2000 / NT / XP Pro zu laufen > dazu gibt es eine Ding mit 
dem Namen IIS, dass Sie mit einer CD installieren und mit Windows Setup > 
Komponenten hinzufügen (Add components) starten.
3. Bei Win XP Home kommt IIS dummerweise nicht mit der gelieferten Version. Sie 
können: 

• Zu http://www.15seconds.com/issue/020118.htm  gehen. Bei manchen 
funktioniert es, bei manchen – wie bei mir – funktionierte es nicht.

• Einen freien NICHT-Microsoft-Server installieren und eine ASP-Unterstützung 
hinzufügen (siehe Information von Dave, G3VGR, weiter unten)

4. Falls Sie noch unter Windows 98 arbeiten, gehen Sie zu 
http://coveryourasp.com/PWS.asp  . Arbeiten Sie dort die Schritte 1 bis 7 ab. 

Haben Sie die Optionen 1 oder 2 oder 3 oder 4  erfolgreich abgearbeitet und der 
Server (IIS oder PWS) läuft, dann folgenden Síe den Richtlinien von Max in seiner 
ZIP-Datei.  

73' Franki 

Einige ergänzende Informationen von Dave, G3VGR 

Ich habe gerade das I8NHJ-Interface mit dem Freeware-Abyss-Web-Server von 
http://www.aprelium.com/   zum Arbeiten bekommen. Die ASP-Unterstützung habe 
ich durch die Freeware ActiveHTML von seliSoft realisiert 
(http://www.selisoft.com/en/ahtml/). Auf der  Aprelium-Webseite kann man eine 
Hilfe finden: http://www.aprelium.com/abyssws/asp.html   

Ich habe bisher aber nur ein kleines Testlog ausprobiert, um die Funktion zu 
überprüfen.  

73, Dave 

Einige ergänzende Informationen von Uffe, PA5DD 

Ich habe gerade mein ganzes System auf Windows 2000 (entspricht XP etc.) 
umgestellt. Alles lief gut, bis ich das I8NHJ-Webinterface testen wollte. Der Zugriff zu 
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der von N1MMLogger genutzten Datenbank ‚.mdb wurde abgewiesen. N1MMLogger 
öffnet diese Datenbank “exklusiv". Das ist eine Frage der Zugriffsrechte. Nach der 
Installation des Web-Interfaces benötigen Sie Zugriffsrechte sowohl für N1MMLogger 
als auch für das I8NHJ-Interface. Informieren Sie sich zu diesem Problem über den 
Link http://www.aspemporium.com/aspemporium/tutorials/permdenied.asp 

Der Webserver sollte die Datei default.asp im Verzeichnis Default Document list 
haben. Alternativ können Sie die Seite direkt erreichen unter: 
http://localhost/logger/default.asp   

73 Uffe PA5DD 

Personal Web server 

Wenn Ihr Rechner unter Windows 95 läuft, können Sie den Microsoft Personal Web 
Server aus dem Optionspaket von Windows NT 4.0 installieren. Sie können das 
Option Pack von der Microsoft-Webseite holen. Der Microsoft Personal Web Server 
ist auch unter "Add-on\pws" auf der Win98SE-Installations-CD zu finden (mindestens 
auf der Win98SE upgrade CD, US-Version). 

Einige ergänzende PWS-Informationen von Frans, PA5CA 

Ich habe die PWS-Software für Win98se installiert. Sie müssen zuvor eine der unten 
stehenden DLL-Dateien installieren (oder überschreiben), bevor Sie die Installation 
ausführen. Es hat einige Zeit gedauert, bis ich die ASP-Statistik zum Laufen gebracht 
habe, aber jetzt funktioniert sie. Ich habe diese Links verwendet: 

http://support.microsoft.com:80/support/kb/articles/Q246/0/81.ASP   

http://support.microsoft.com/default.aspx?scid=fh;NL;w98   

73' Frans PA5CA 

6. Auto-Kurzrufe (AutoHotkey)

Mit AutoHotkey können Sie Kurzrufe für die Tastatur, den Joystick und die Maus 
erzeugen. Sie können die Kurzrufe neu zuordnen und praktisch aus jeder Taste auf 
der Tastatur, dem Joystick oder der Maus einen Kurzruf zuordnen.  

Wenn Sie das Programm AutoHotkey installiert haben, müssen Sie eine 
Beschreibung mit einem Editor erzeugen. Sie mit einer Endung *.ahk versehen und 
mit einem Doppelklick darauf starten. Windows ordnet das Script dem Programm 
AHK zu und ist so lange wirksam, bis Sie es beenden. Sie können das Script 
editieren, die Hilfe dazu lesen und das Script nach jeder Änderung mit einem 
Rechtsklick auf das Logo reaktivieren.

So sieht ein Modell für N1MMLogger aus, bei dem Sie mit einer Taste eine 
Kombination mehrerer F-Tasten über das Nummernfeld senden können: 

Script Beschreibung 
#UseHook 
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SetNumlockState, 
AlwaysOn Nummer-Feld immer ein

Numpad7::Send !{F9} Numeric key 7 – schaltet die Antennen pro Band um
Numpad8::Send ^+i Numeric key 8 – Erweitertes SO2R ein/aus
Numpad4::Send ^b Numeric key 4 – Duell-CQ ein/aus
Numpad9::Send !r Numeric key 9 – CQ wiederholen ein/aus
Numpad5::Send ^{F1} Numeric key 5 - sendet CQ auf dem inaktiven Tcvr
Numpad6::Send !w Numeric key 6 – Eingabefeld löschen

Numpad0::Send {ESC}\`` Numeric key 0 –zurück vom S&P um eine Station am 
RUN-Tcvr zu arbeiten

Numpad1::Send \`` Numeric key 1 – zurück zum S&P-Tcvr
Return 

Beispiel für eine AutoHotkey-Anwendung zum Erfassen von Multis für VFO-A und 
VFO-B. 

Script Beschreibung 
#UseHook 
SetNumlockState, 
AlwaysOn Nummer-Feld immer ein 

Numpad7::Send ^!{Up} Numeric key 7 - VFO A > nächster Multi in der Bandskala 
nach oben

Numpad1::Send ^!{Down} Numeric key 1 - VFO A > nächster Multi in der Bandskala 
nach unten

Numpad9::Send ^+!{Up} Numeric key 9 - VFO B > nächster Multi in der Bandskala 
nach oben

Numpad3::Send ^+!
{Down} 

Numeric key 3 - VFO B > nächster Multi in der Bandskala 
nach unten

Return 

Beispiel für eine AutoHotkey-Anwendung zum CW-Senden über einen Kurzruf: 

Script Beschreibung 
Numpad1::Send ^k testing?^k Sendet über das CW-Eingabefenster einen Text. 

Ein Programm, das etwa das gleiche oder noch etwas mehr macht ist 'AutoIt' Version 
3. Sehen Sie unter   Links   nach.  

Sie können auch das Scrollrad der Maus verwenden, z.B. mit WheelUp::Send {Up} 
WheelDown::Send {Down} 

7. AR Cluster User (von Lee, VE7CC)

Das Programm AR Cluster User von Lee, VE7CC ist ein voll ausgebautes 
Programm für Telnet und TNC in Verbindung mit einem AR Cluster oder DX Spider. 
Es hat Telnet- und RS-232-Ausgänge für Log- und Contestprogramme wie 
N1MMLogger. Es läuft unter Windows 95 bis Windows XP, stellt automatische eine 
abgebrochene Verbindung wieder her und besorgt verloren gegangene DXSpots. 
Das Programm kann Spots sowohl von connecteten als von nicht connecteten 
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Packet-Knoten empfangen, es reicht, wenn andere Stationen über diesen Knoten 
Pakete empfangen. 

Setting up AR User with N1MM logger 

• AR Cluster einstellen 
o Connecten Sie Ihren Packet-DXCluster mit AR User 
o Gehen Sie zu Configuration > Ports/Logger Program 
o Aktivieren Sie "Telnet" Logging Program Connection, wählen Sie 

sowohl Node Connection als auch Logging Program Connection 
• Öffnen Sie N1MM Logger 

o Gehen Sie zu Config > Change Telnet Cluster List 
 Fügen Sie – falls noch nicht vorhanden - AR User hinzu 
 Verwenden Sie 127.0.0.1:7300, falls AR User und N1MM auf 

dem gleichen Rechner laufen

Informieren Sie sich auf der Webseite, wenn Sie mehrere Rechner verwenden. 

• Öffnen Sie das Telnet-Fenster und connecten Sie den AR User 
• Sie sollten die vom AR User kommenden DXSpots bei N1MMLogger sehen 

Informieren Sie sich auf der AR Cluster User-Webseite unter    Links   . 

Last Modification: 30 October 2009 07:50:16 EDT by K8UT. 

Oft gestellte Fragen (Frequently Asked Questions)

Sie erreichen die FAQs über Menu >FAQs im Internet.

Ergänzungen (Appendices)
Beispiele für F-Tasten (Example Function Keys)

 Hinweis 1 
In der Liste der Funktionstasten darf keine Zeilen frei gelassen werden. Die Tasten 
müssen nacheinander in der Liste stehen. Nur am Ende im S&P-Bereich müssen 
nicht alle Tasten belegt sein, an ihrer Stelle werden dann die im RUN-Bereich 
programmierten Tasten verwendet. Belegen Sie alle 12 Tasten (F1-F12) des RUN-
Bereichs und dann im S&P-Bereich so viel Tasten wie Sie benötigen, z.B. 12 RUN + 
3 S&P-Tasten.

 Hinweis 2 
Der Texteintrag in der Taste dient nur zu Ihrer Information. Sie können hier jeden 
Text Ihrer Wahl eintragen. Die Texte werden so wie sie in der Tabelle stehen den 
Tasten zugeordnet. 1.Eintrag = RUN-F1, 2.Eintrag=RUN F2 bis z.B. 17.Eintrag=S&P-
F5.  

 Hinweis 3 
Wenn Sie die Definition der Tastenbelegung abspeichern, werden alle aktuellen 
Änderungen in die aktuelle Datenbank übernommen. Wenn Sie einen neuen Contest 
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starten, werden die bisherigen Tastenbelegungen für den neuen Contest 
übernommen.

Jede N1MMLogger-Datenbank hat separate Tabellen für die Tastenbelegungen für 
CW, SSB und RTTY. Wurden Sie einmal angelegt oder über das Menü File > Import 
> Import function keys from file geladen, bleiben Sie in der Datenbank, bis sie 
ersetzt werden. Wollen Sie die Tastenbelegung für einen bestimmten Contest 
aufbewahren, speichern Sie diese Tastenbelegung getrennt ab und laden Sie sie für 
diesen Contest wieder.

1. SSB

Die WAV-Dateien können an einer beliebigen Stelle auf Ihrer Festplatte stehen. Der 
exakte Pfad und Dateiname muss in der F-Taste stehen, z.B. C:\Program 
Files\N1MM logger\wav\Dateiname. Sie können auch ein contestbezogenes 
Verzeichnis z.B. für den ARRL DX wie arrldx\Dateiname anlegen. 

1.1. Beispiel für den WPX SSB (WPX SSB example)

Nachstehend finden Sie eine F-Tasten-Belegung für den WPX SSB im ESM-Modus. 
Bitte beachten Sie, dass die ersten 12 Zeilen zum RUN-Modus gehören und die 
weiteren 12 Zeilen zum S&P-Modus. Bei den WAV-Dateien werden sowohl die 
Seriennnummern als auch das Rufzeichen der Gegenstation aus einzelnen WAV-
Dateien zusammengesetzt. Um eine Pause zwischen Rufzeichen und Seriennummer 
zu erzeugen, ist eine kurze Datei ‚pause.wav’ eingebaut, die keinen Sprachinhalt 
hat.  

Im Tastentext müssen dazu Macros und WAV-Dateinamen gemischt werden. Sehen 
Sie sich die Schreibweise genau an. Sie enthält keine Leer- oder Satzzeichen, aber 
sie funktioniert. 

Tasten-Titel WAV-Datei 
F1 CQ C:\Program Files\N1MM logger\wav\cq general.wav 
F2 Exch C:\Program Files\N1MM logger\wav\59.wav# 
F3 TU C:\Program Files\N1MM logger\wav\tnx.wav 
F4 {MYCALL} C:\Program Files\N1MM logger\wav\mycall.wav 
F5 His Call !C:\Program Files\N1MM logger\wav\pause.wav 
F6 Rpt Exch C:\Program Files\N1MM logger\wav\number.wav# 
F7
F8
F9
F10
F11
F12
F1 C:\Program Files\N1MM logger\wav\mycall.wav 
F2 Exch
F3 TU
F4{MYCALL}
F5 His Call
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F6 Rpt Exch
F7
F8
F9
F10
F11
F12

2. CW

2.1. Voreingestellte CW-Tastenbelegung (CW program default)

Unten sehen Sie eine voreingestellte Tastenbelegung. Die Tasten F3 bis F12 im 
S&P-Bereich sind nicht belegt. Wenn Sie eine der Tasten im S&P-Modus drücken, 
wird der Tasteninhalt der RUN-Tasten gesendet. 

Tasten-Titel CW-Nachricht 
F1 CQ cq~test~de~* 
F2 {Exch} <<<5nn >>>{EXCH} 
F3 TU TU de * 
F4 {MYCALL} * 
F5 His Call ! 
F6 QSO B4 QSO B4 de * 
F7 ? ? 
F8 Agn Agn 
F9
F10
F11
F12
F1 {MYCALL} * 
F2 5NN {EXCH} <<<<5nn>>>>{EXCH} 
F3
F4
F5
F6
F7
F8
F9
F10
F11
F12

2.2. Beispiele für einen CW-Sprint-Contest (Sprint CW examples)

2.2.1. Beispiel 1

Dieser Tastensatz stammt von Kenny, K2KW 
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(Anmerkung DM3ML: Nach jedem QSO muss die Frequenz gewechselt und von 
RUN auf S&P und wieder zurück geschaltet werden)

Tasten-Titel CW-Nachricht 
F1 CQ * * <<<NA>>> 
F2 Exch * {EXCH} 
F3 TU EE{S&P} 
F4 {MYCALL} * 
F5 His Call ! 
F6 QSO B4 B4 E E 
F7 ? ? 
F8 Agn AGN 
F9
F10
F11
F12
F1 CQ **<<<NA>>> 
F2 Exch ! {EXCH} * 
F3 TU EE{RUN} 
F4{MYCALL} * 
F5 His Call ! 
F6 QSO B4 B4 E E 
F7 ? ? 
F8 Agn AGN 
F9
F10
F11
F12

Nachrichten im RUN-Modus 

• Zu F2: Vor dem * steht ein Leerzeigen, d.h."<space> * {EXCH}" 
• Zu F3: "EE" bestätigt das QSO. Sie können auch TU verwenden.  
• Nach dem "EE" wird in den {S&P}-Modus umgeschaltet. Drücken Sie dann auf 

die Taste Pfeil nach oben/unten um ein QSY zu machen.  
• Mit F6 wird {EXCH} wiederholt, falls nötig. 

Nachrichten im S&P-Modus 

• Beachten Sie den Unterschied bei der F2-Taste gegenüber dem RUN-F2 
• Die F3-Taste schaltet mit dem Macro {RUN} zurück in den RUN-Modus.
• Mit F6 wird {EXCH} wiederholt, falls nötig. 

2.2.2. Beispiel 2

Dieser Tastensatz wurde von Pete, N4ZR, geschickt und von Rich, VE3KI, 
modifiziert: 
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Tasten-Titel CW-Nachricht 
F1CQ * * NA{CLEARRIT} 
F2 Exch * {EXCH}
F3 TU E~E {CLEARRIT} 
F4 {MYCALL} * 
F5 His Call ! 
F6 QSO B4 B4 * 
F7 Rpt Exch {EXCH} 
F8 ? ? 
F9
F10
F11
F12
F1 CQ * * NA{CLEARRIT} 
F2 Exch ! {EXCH} * {RUN} 
F3 NR # 
F4 {MYCALL} * 
F5 His Call ! 
F6 Name PETE 
F7 State WV 
F8 ? ? 
F9
F10
F11
F12

Beachten Sie diese beiden Punkte:  

1. Hier steht das {RUN}-Macro in der Taste S&P-F2, nicht F3. Damit wird mit ENTER 
die S&P-Kontrollnummer gesendet, das QSO geloggt und auf {RUN} mit dem Cursor 
im Rufzeichenfeld umgeschaltet. Ein Druck auf F3 ist daher überflüssig. Probleme 
gibt’s nur, wenn jemand die Kontrollnummer nicht verstanden hat, dann hilft ein Griff 
zur Taste. 

2. Es gibt kein Macro {S&P} in dem Satz. Nach dem Ende eines RUN-QSOs muss 
man QSY machen und kommt dadurch automatisch in den S&P. Wenn man "QSYing 
wipes the call & spots QSO in bandmap" aktiviert, steht auch der Cursor nach dem 
QSY an der richtigen Stelle und das Rufzeichenfeld wurde geleert. 

Ein Vorschlag wäre, nach dem E E oder R und dem Umschalten auf S&P auch gleich 
ein QSY um 1.5 kHz zu machen, aber es gibt kein Macro wie {QSY:+1.5}. Man muss 
daher am Transceiver drehen oder mit den Pfeiltasten ein QSY machen.  

73, Rich VE3KI 

2.2.3. Beispiel 3 

In diesem Beispiel wird der Rufzeichenspeicher in CW benutzt. Es kommt von John, 
K3CT. 
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Tasten-Titel CW-Nachricht 
F9 Stack {SOCALLSTACK} 
F10 Log Pop {LOGTHENPOP} TU NW {F5}{F2} 
F11
F12 Wipe {WIPE}

DX4Win verwendet F12 zum Löschen, daher benutze ich auch hier F12. Mit farbigen 
Marken auf den Tasten finde ich sie schneller. 

2.2.4. Beispiel 4

Anpassung von N1MMLogger an den North American CW Sprint von Steve, 
N2IC 

Sie finden weitere Erläuterungen unter http://n6tr.jzap.com/sprint.html zum Sprint-
Contest. Ich habe N1MMLogger im Sprint-Contest im SO2R-Modus betrieben und 
die Konfiguration dafür optimiert. Sicher können auch SO1R-Ops die Angaben 
verwenden. 

Optionen

Sie benötigen N1MMLogger ab Version 8.9.0. Erzeugen Sie einen neuen 
SPRINTCW-Contest. 

Wählen Sie diese Optionen 

• ESM-Modus  
• QSYing wipes the call & spots QSO in bandmap 
• Kein RUN auf der CQ-Frequenz 
• Zeige nicht arbeitbare Spots an 

Öffnen Sie diese Fenster: 

• Logeingabefenster für beide Transceiver  
• Doppelanzeige (Dupesheet) für beide Transceiver
• Info 
• Log 
• Score Summary 
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Das Doppelfenster (Visible Dupesheet) ist eine feine Sache. Sie sehen mit den 
Augen schneller eine Doppelstation als durch eine Eingabe in das Rufzeichenfeld. 
Ich habe weder die Bandskala noch das Fenster "Available Mults & Q's" geöffnet.  

Hier muss ich mir widersprechen. Ich habe doch die Bandskala kurz geöffnet und die 
Verfallszeit (Packet Spot Timeout) auf eine Minute eingestellt und die Bandskala 
dann dauernd wieder geschlossen. Damit verhindere ich, dass mir über dem 
Rufzeichenfeld dauernd unaktuelle Rufzeichen angeboten werden. Es lohnt sich 
nicht, im Sprint-Contest Packet zu verwenden.

F-Tasten .... 

Tasten-Titel CW -Nachricht 
F1 CQ cq na cq na * na 
F2 Exch * # steve nm 
F3 TU {CLEARRIT}T{S&P} 
F4 (MYCALL} * 
F5 His Call ! 
F6 QSO B4 QSO B4 * 
F7 Other Short {CTRLF10} 
F8 Other Long {CTRLF11} 
F9 Go S&&P {S&P} 
F10 CQ CQ NA * * NA 
F11 Long CQ CQ NA CQ NA * * NA 
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F12 STOP {STOPTX}{CTRLF4} 
F1 S&&P CQ CQ NA CQ NA * NA 
F2 S&&P Exch ! # STEVE NM {RUN} 
F3 S&&P TU TU 
F4 S&&P{MYCALL} * 
F5 S&&P His Call ! 
F6 S&&P Name - 
F7 S&&P Other Short {CTRLF10} 
F8 S&&P Other Long {CTRLF11} 
F9 Go Run {RUN} 
F10 CQ CQ NA * * NA 
F11 Long CQ CQ NA CQ NA * * NA 
F12 STOP {STOPTX}{CTRLF4}

Mit der RUN-F3-Taste schalte ich nach "thank you" unmittelbar in den S&P-Modus. 
Mit der Taste S&P F2 schalte ich zurück in den RUN-Modus. Mit der F9-Taste kann 
ich selbst hin und her schalten.  

Die Tasten F7 und F8 senden CQ's auf dem anderen Transceiver. Das ist sehr 
nützlich, wenn die andere Station gerade ihre Kontrollnummer sendet und Sie die 
CQ-Frequenz an ihn verlieren. Sie können CQ am anderen Transceiver senden, 
während Sie die Kontrollnummer empfangen. Sie brauchen dann nach dem TU nur 
ein ENTER drücken, das das CQ am anderen Transceiver beendet mit der Taste F3 
das CQ am aktiven Transceiver startet. Sie brauchen nur in der Pause aufzupassen, 
ob jemand am anderen Transceiver anruft.  

Die Taste F12 wird in Verbindung mit dem AutoHotKey-Script NumpadEnter::F12 
verwendet. Wenn ich CQ am aktiven Transceiver rufe, aber simultan dazu S&P 
machen am anderen Transceiver mache und ich eine neue Station höre brauche ich 
nur die ENTER-Taste ganz rechts drücken. Damit wird der CQ-Ruf beendet und 
mein Rufzeichen wird auf dem anderen Transceiver gesendet. Beachten Sie, dass 
vor dem F12 {STOPTX}-Macro ein Leerzeichen steht, ohne das Leerzeichen 
funktioniert das Macro nicht.  

Sie müssen beim SO2R-Betrieb die beiden LEDs im Logeingabefenster im Auge 
behalten. Wenn Sie SO2R im Sprint-Contest machen, gibt es Zeiten, in denen der 
Fokus nicht dort ist, wo Sie ihn erwarten. Halten Sie sich bereit mit der Taste \ und 
der Taste Pause den Fokus dorthin zu holen, wo Sie ihn benötigen. Sie brauchen 
eine Menge an Praxis und Sie werden Fehler machen. Die Sprints am 
Dienstagabend sind eine gute Zeit um Erfahrungen zu sammeln.

73 and see you in the Sprint ! Steve, N2IC 

3. RTTY

3.1. Allgemeines RTTY-Beispiel (General RTTY example)

Mit der folgenden Tastenbelegung werden Sie in vielen RTTY-Contesten ohne 
Änderungen arbeiten können. Wie Sie mit den Macros in einer speziellen Situation 
hinkommen, hängt von Ihrer Station, Ihren Antennen und Ihrem QTH ab. 
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Tasten-Titel Nachrichtentext 
F1 CQ {TX} CQ TEST DE * * CQ {RX} 
F2 EXCH 599{EXCH} ! BK {RX} 
F3 TU {TX}{ENTERLF} ! TU DE * QRZ? {RX} 
F4 {MYCALL} {TX} DE * K {RX} 
F5 His Call{TX}{ENTERLF} 
F6 QSO B4 {TX} B4 DE * CQ {RX} 
F7 Rpt Exch {TX} {EXCH} {EXCH} {EXCH} {EXCH} K {RX} 
F8 {TX} AGN AGN DE * K {RX} 
F9
F10
F11
F12
F1 CQ {TX} CQ TEST DE * * CQ {RX} 
F2 EXCH {TX}{ENTERLF} DE * TU 599 {EXCH} {EXCH} BK {RX} 
F3 TU {TX} ! TU {RX} 
F4 Call Him {TX} DE * * * K {RX} 
F5 1x1 {TX} ! DE * K {RX} 
F6 0x1 {TX} DE * K {RX} 
F4 Call Him {TX} DE * * * K {RX} 
F5 1x1 {TX} ! DE * K {RX} 
F6 0x1 {TX} DE * K {RX} 
F7 Rpt Exch {TX} {EXCH} {EXCH} {EXCH} {EXCH} {EXCH} BK {RX} 
F8 Agn {TX} AGN AGN de * K {RX} 
F9
F10
F11
F12

Für die Tastenbelegung ist vorausgesetzt, dass ESM angeschaltet ist. Die RUN-
Tasten F5, F6 und F7 sind im S&P-Modus nicht besonders nützlich, ich habe Sie 
deswegen im S&P-Modus anders programmiert.  Zusätzlich zu diesen F-Tasten 
können Sie noch 24 zusätzliche programmierbare Tasten über die Maus auslösen 
und z.B. 0x1, 0x2, 0x3 und 0x4-Rufe, einfache, doppelte und dreifache 
Kontrollnummern, Anfragen für Zonen, Staaten und Nummern programmieren usw. 

73, Rich VE3KI 

3.2. Beispiel für einen RTTY-Contest mit Zeitausgabe (wie ANARTS 
(Example RTTY where the time is part of the exchange (like 
ANARTS))

Im folgenden Beispiel sehen Sie nur die Tasten, die durch die Zeitangabe ergänzt 
werden müssen: 

Tasten-Titel Gesendeter Text 
RUN and S&P
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F2 Exch {TX}599 {TIME2} {TIME2} {EXCH} ! KN {RX} 
F7 Rpt Exch {TX} 599 {TIME2} {TIME2} {TIME2} {EXCH} {EXCH} K{RX}

73, Rich VE3KI 

Last Modification: 31 October 2009 07:44:51 EDT by n4zr. 
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Rufzeichenprüfung (Call Checking)

Der Code zur Rufzeichenprüfung von Dave Robbins, K1TTT, wurde in 
N1MMLogger eingebaut.  Wenn Sie ein Rufzeichen eingeben, wird anhand eines 
Musters geprüft, ob es sich um ein gültiges Rufzeichen handelt. Wenn die Prüfung 
negativ ausfällt, wird eine Warnung ausgegeben. Diese Mitteilung erscheint im 
Rufzeichenprüffenster (check window). 

 

 Nur für HF:
Die Rufzeichenprüfung funktioniert nur auf den HF-Bändern (nicht für WARC) und 
nur in CW und SSB. Sie ist unwirksam in RTTY und auf UKW.  

 Warnung 
Gehen Sie nicht davon aus, dass die Prüfung 100% zuverlässig ist und dass das 
Rufzeichen nicht gespeichert oder aus dem Log gestrichen werden muss. Es kann 
durchaus Änderungen in einigen Ländern geben, die noch nicht berücksichtig sind, 
oder spezielle Rufzeichen, die seriös ausgegeben worden sind. 

1. Muster aktualisieren (Updating the pattern file)

Die Regeln für die Rufzeichenbildung stehen in der Datei callsign.pat. Wegen 
laufender Änderungen müssen auch die Regeln regelmäßig aktualisiert werden. 
Helfen Sie uns, wenn Sie Abweichungen und neuen Regeln feststellen.

Beachten Sie diese Hinweise: 

• Zeilen, die mit einem ! anfangen, sind Kommentare 
• In den Zeilen steht am Anfang ein Text, der als Fehlermeldung angezeigt wird.
• Auf den Text folgt eine kryptischen Zeile, die die Regel enthält und vom 

Rechner verarbeitet wird. 

Wie diese kryptische Zeile arbeitet, können Sie dem dazu gehörenden Text 
entnehmen, der eine Erklärung enthält. Verwenden Sie nach Möglichkeit eine 
Formulierung dieser Art, wenn Sie uns über eine neu eingeführte Bildungsregel 
informieren wollen. Führen Sie die Zeile auch an, wenn diese Regel nicht mehr gültig 
ist.

Im Moment enthält die Datei an die 200 Regeln und kann leicht erweitert werden. 
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Bitte machen Sie die Änderung nicht nur in Ihrer eigenen Datei, sondern teilen Sie 
uns Ihre Lösung mit, damit sie allen Nutzern zugute kommen kann.

2. Die Muster-Datei (The Pattern File)

Die Regel 'pattern' beschreibt ein fehlerhaftes Rufzeichen Zeichen für Zeichen. So 
lange das Rufzeichen in dieses Muster passt, läuft die Prozedur weiter. Wenn das 
Rufzeichen das Muster nicht erfüllt, wird es als ‚gut’ angenommen.  

3. Komponenten (Components)

Die Komponenten einer Regel sind:  

Einzelne Zeichen: 

Einzelnes Zeichen Dieses Zeichen stimm überein mit .. 
A Dem Buchstaben 'A'
1 Der Ziffer '1'

usw. 

Wiederholungszeichen 
Muss gefolgt werden 
von einer 
Typspezifikation  

Funktion 

: Übereinstimmung mit einem N
Stimmt mit jedem 
Zeichen (A-Z, 0-9) 
überein

:D 
Stimmt mit einer 
beliebigen Stelle 
überein

+ Stimmt mit einem oder 
mehreren überein A

Stimmt mit einem 
beliebigen Buchstaben 
überein (A-Z) 

+A Stimmt mit einer oder 
jeder Stelle überein

* Stimmt mit Null oder mehr 
überein D

Stimmt mit einer 
beliebigen Ziffer überein 
(0-9) 

*N 
Stimmt mit Null oder 
mehreren Buchstaben 
oder Ziffern überein 

- Optionale Übereinstimmung -D Stimmt optional mit 
einer Ziffer überein

Gruppen, die übereinstimmen Funktion 
[ 
] übereinstimmen [ABCDFXZ] Stimmt mit A,B,C,F,X ODER 

Z überein

! Stimmen nicht mit einem Zeichen der 
Liste überein [!ABC] Alle Zeichen außer A,B 

ODER C

- Stimmen nicht mit einem Zeichen in 
einem Bereich überein [!A-R] Alles Zeichen außerhalb des 

Bereichs A bis R

4. Beispiele (Examples)

Hier sehen Sie Beispiele für eine Übereinstimmung und für keine Übereinstimmung:  

Muster Stimmt überein Stimmt NICHT überein
:A:D A1 Z0 Q8 AA 19 1A
+A:D A1 AA1 ABC1 AA 19 1A
*A:D 1 19 A1 AA1 ABC1 AA 1A
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F:D F1 F2 F9 A1 Z0 1A
[ABC]B:D AB1 CB1 BB9 AC1 DB9 CZ0
[!ABC]B:D ZB1 DB9 QB0 AC1 AB1 CB1 BB9 CZ0

5. Was wollen wir zur Übereinstimmung bringen? (What are we trying to 
match?)

Was machen wir bei einer Übereinstimmung?  Wenn eine Übereinstimmung 
festgestellt wird, erfolgt eine Ausgabe im Prüffenster. Wir müssen Regeln aufstellen, 
wann ein Rufzeichen fehlerhaft ist, wie : 

1. Rufzeichen, die mit drei Buchstaben anfangen 
2. Rufzeichen, die mit einem B anfangen und andere Prefixe als BT, BV, BY, BZ 

haben (Anmerkung DM3ML: total überholt..)
3. Französische Rufzeichen mit einer 1 oder 6, aber weniger als drei Buchstaben 

im Suffix.
4. DDR-Rufzeichen mit einem anderen Buchstaben am Ende als A bis O (das ist 

nur ein Beispiel, East Germany existiert nicht mehr)

Unglücklicherweise haben verschiedene Verwaltungen es noch komplizierter 
gemacht und bestimmte Rufzeichen dürfen nur auf bestimmten Bändern und 
bestimmten Sendearten arbeiten, so wird der Prefix HJ nur in CW und auf 40m und 
80m in SSB ausgegeben. Daher muss noch das Band berücksichtig werden. Hier ein 
Beispiel: "BY1AA=4S" wobei das '=' dem Rufzeichen zur Band- und 
Modekennzeichnung hinzugefügt wird. Dabei sind 1=160m, 2=80m, ... 6=10m und 
S=SSB, C=CW, O=Andere Sendearten. 

Beispiele dafür sind:

=3C bedeutet, das Rufzeichen darf nicht auf 40m (=3) und CW (=C) auftauchen "C" 
=4 bedeutet, das Rufzeichen darf nicht auf 20m (=4) auftauchen
=:DS bedeutet dass alle Bänder (=:D) für SSB (=S) gesperrt sind.
=[1456]S bedeutet, das SSB auf 160, 20, 15 oder  nicht erlaubt sind 

Bevor ein Rufzeichen in die Prüfung geschickt wird, werden alle Zusätze wie 
/QRP, /A, /MM, /CT3 usw. entfernt.  

1. Mit drei Buchstaben beginnende Rufzeichen (Calls that start with 3 letters)
Das Muster lautet einfach : :A:A:A. Sobald diese Übereinstimmung festgestellt wird, 
ist das Rufzeichen fehlerhaft unabhängig davon, was dann kommt. 

2. Rufzeichen mit B und anderen Prefixen als BT, BV, BY, BZ (Call with first 
letter B with prefix other than BT, BV, BY, BZ)
Das Muster lautet: B[!TVYZ]. Auf das B darf kein weiterer Buchstabe als TVYZ 
folgen, auch hier ist der Rest des Rufzeichens uninteressant.

3. Französisches Rufzeichen mit 1 oder 6 und einem Suffix kürzer als 3 
Buchstaben (French calls with a 1 or 6 that don't have 3 character suffix)
Das Muster kann: F[16]:A-A= lauten. Werden die weiteren Prefixe FB, FD, FE und 
FF berücksichtigt lautet das Muster F[BDEF]16:A-A=. 
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4. Ostdeutsche Rufzeichen mit anderer Endung als A bis O (East German calls 
that don't end in A to O)
Nur als Beispiel, nicht mehr aktuell…Hier ergeben sich abhängig von der 
Rufzeichenlänge drei Möglichkeiten: 
Y[2-9]:D[!A-O]= mit einem Ein-Buchstaben-Suffix
Y[2-9]:D:A[!A-O]= mit einem Zwei-Buchstaben-Suffix
Y[2-9]:D:A:A[!A-O]= mit einem Drei-Buchstaben-Suffix 

Wenn Sie sich die Datei CALLSIGN.PAT ansehen, sehen Sie alle Regeln, die mir 
unterkommen sind. Jede Regel hat eine ergänzende Erklärung, die dann als 
Meldung im Prüffenster erscheint, wenn das geprüfte Rufzeichen mit einer Regel 
übereinstimmt. 

Es kommen durchaus Rufzeichen vor, die sich mit den Regeln nicht fassen lassen. 
Bei dem Rufzeichen "HI500ABC" bekommen Sie z.B. die Meldung "CALL TOO 
LONG" . Es kann aber solche Rufzeichen als Ausnahme geben. Es sollte besser 
sein, den OP auf einen möglichen Rufzeichenfehler hinzuweisen. Er kann dann 
entscheiden, ob er dieses Rufzeichen in das Log übernimmt oder lieber noch einmal 
genau hinhört.

Last Modification: 30 October 2009 17:12:33 EDT by K8UT. 
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Links

1. N1MM-Links

1.1. Die Homepage von N1MMLogger (N1MM Free Contest Logger 
Home Page)

http://pages.cthome.net/n1mm   

• Überblick mit den neuesten Informationen zu dem Programm
• Ansehen und Abholen der Hilfe-Dateien und des Handbuchs in verschiedenen 

Sprachen 
• Meldung von Fehlern und Anfragen zu möglichen Optionen 
• Testimonials 
• mehr 

1.2. N1MMLogger-Diskussionsgruppe ( N1MM logger General 
discussion group)

http://groups.yahoo.com/group/N1MMLogger  
http://groups.yahoo.com/group/N1MMLogger/join   

• In dieser Gruppe werden Probleme und Lösungen zum allgemeinen 
Programm diskutiert, Sie werden eingeladen hier mitzumachen. Sie müssen 
sich zuerst bei der Gruppe anmelden. 

1.3. N1MMLogger-Digitale Diskussionsgruppe (N1MM logger Digital 
discussion group)

http://groups.yahoo.com/group/n1mmlogger-Digital  
http://groups.yahoo.com/group/n1mmlogger-Digital/join   

• In dieser Gruppe werden Probleme und Lösungen zum digitalen Teil von 
N1MMLogger diskutiert, Sie werden eingeladen hier mitzumachen. Sie 
müssen sich zuerst bei der Gruppe anmelden. 

1.4. Abholen (Download)

http://pages.cthome.net/n1mm/html/English/Installation.htm   

• Grundinstallation mit dem N1MM-FullInstaller.exe 
o Enthält Treiber für serielle, parallele und USB-Schnittstellen für 32-Bit-

Windows (PORT95NT.EXE) 
• Programmaktualisierungen N1MM-NewexeVx.x.xxx.exe 
• Weitere Dateien wie Länderdatei und Master Callsign-Dateien
• Windows-Hilfe - N1MMLoggerHelp.chm 
• Englisches Handbuch im PDF-Format - N1MMLogger.pdf 
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• RTTY-Maschine - MMTTY 

1.5. N1MM-Videovorführung von N6NC (N1MM video display by 
N6NC)

Holen Sie sich die Dateien von der Seite 1 (alle etwa 5 MB groß) 

• Part 1: http://www.pi4dec.nl/n1mm/video/N1MM%20Video%20Part
%201.wmv   

• Part 2: http://www.pi4dec.nl/n1mm/video/N1MM%20Video%20Part
%201.wmv   

• Part 3: http://www.pi4dec.nl/n1mm/video/N1MM%20Video%20Part
%201.wmv   

• Part 4: http://www.pi4dec.nl/n1mm/video/N1MM%20Video%20Part
%201.wmv  

Oder

Von der Seite 2 (alle etwa 5 MB groß) 

• Part 1: http://www.pa6z.nl/DOWNLOADS/N1MM_Video_Part_1.wmv   
• Part 2: http://www.pa6z.nl/DOWNLOADS/N1MM_Video_Part_2.wmv   
• Part 3: http://www.pa6z.nl/DOWNLOADS/N1MM_Video_Part_3.wmv   
• Part 4: http://www.pa6z.nl/DOWNLOADS/N1MM_Video_Part_4.wmv   

• Erklärung der Bilder:  
o Part 1 : Schirmgestaltung mit zwei Monitoren 
o Part 2 : Packet/Telnet-Fenster, Available Mults and Q's-Fenster, 

Bandskalen 
o Part 3 (erster Teil) : Multiplier-Fenster, Info-Fenster 

• Demonstration eines Contestbetriebs mit N1MMLogger 
o Part 3 (zweiter Teil): Betriebsfenster (VFO A/B), ESM-Modus, Multis 

jagen mit dem Fenster Available Mults and Q's  
o Part 4. Bandskala und Multi-Jagd,  VFO B-Fenster, Packet/Telnet-

Fenster und -Funktionen 

2. Dateien zur Unterstützung (Support file links)

2.1. HF-Länderdateien (HF Country files (by Jim Reisert, AD1C))

http://www.country-files.com/cty/   

• Länderdateien cty.dat oder wl_cty.dat. Die bessere Wahl ist wl_cty.dat .
• Importieren Sie die Datei mit dem Menü Tools > Import country list from 

downloaded file 
• Laden Sie nach N1MMLogger  
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2.2. Rufzeichenliste für HF-Conteste (Super Check Partial Database 
Files for HF contests)

http://www.supercheckpartial.com   

• Randy, K5ZD, erzeugt ein paar Mal im Jahr seine Master-Dateien in diesen 
Ausführungen 

o Master.dta  für alle internationalen Conteste (alle Rufzeichen) 
o masterdx.dta : für DX-Conteste OHNE US/VE-Rufzeichen 
o masterusve.dta: für US/VE-Conteste nur mit W/VE-Rufzeichen 
o masterss.dta : für die ARRL-Sweepstakes-Conteste 

• Kopieren Sie die Dateien in das N1MMLogger-Verzeichnis und geben Sie den 
Dateinamen bei der Einrichtung eines Conteste unter 'Associated Files' im 
Menüpunkt 'File > Open Log in Database'  an. 

• Die passenden vollständigen Rufzeichen erscheinen nach der 
Rufzeicheneingabe von mindestens zwei Zeichen im Prüffenster (Check 
window).  

2.3. Rufzeichenliste für UKW-Conteste in Nordamerika (Super 
Check Partial Database Files for VHF and up contests (North 
America only))

http://www.qsl.net/k1tr/master.htm   

• Kopieren Sie – falls von Interesse - die Dateien in das N1MMLogger-
Verzeichnis und geben Sie den Dateinamen bei der Einrichtung eines 
Conteste unter 'Associated Files' im Menüpunkt 'File > Open Log in 
Database'  an. 

• Die passenden vollständigen Rufzeichen erscheinen nach der 
Rufzeicheneingabe von mindestens zwei Zeichen im Prüffenster (Check 
window).  

2.4. Echtzeit-Ergebnisanzeige (Real time scoring)

K1TTT-Programm zum Hochladen: 
http://www.k1ttt.net/software/realtimescore.zip  
K1TTT-Programm mit dem Quellcode: 
http://www.hornucopia.com/xml4contestresults.html  

• Das Programm von Dave, K1TTT, arbeitet mit N1MMLogger automatisch 
zusammen und meldet den aktuellen Punktestand 

• Der Quellcode ist frei 
• Bemühungen zur Standardisierung der Echtzeitmeldungen finden Sie unter: 

http://www.hornucopia.com/xml4contestresults.html   

2.5. Thucydices für die Rufzeichengeschichte (Thucydides “A 
history manager for N1MM logger” by Carel, PC5M)

http://www.xs4all.nl/%7Ekvgog/projects/thucydides.html   
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• Mit diesem Programm können Sie aus vorhergehenden Contesten Dateien zur 
Rufzeichengeschichte für N1MMLogger erzeugen. 

• Sie finden nähere Einzelheiten zu Thucydices im Kapitel Programme von 
Drittanbietern. 

2.6. Echtzeit-Conteststatistik Athena (Athena “Display real-time 
contest statistics” by Carel, PC5M)

http://www.xs4all.nl/%7Ekvgog/projects/athena.html   

• Athena zeigt nahezu in Echtzeit, wie Sie auf verschiedenen Strecken im 
Contest Fortschritte machen (QSO-Zahl, Multis, aktuelle Punktzahl, per Band, 
gesamt).

• Sie finden nähere Einzelheiten zu Athena im Kapitel Programme von 
Drittanbietern. 

2.7. Rufzeichengeschichte (MakeHistory by Howard, N4AF)

http://www.pi4dec.nl/n1mm/files/makehistory.zip   

Mit Makehistory können Sie callhistory.txt-Dateien für den Import aus Cabrillo-
Logs erzeugen, die sonst nicht an N1MMLogger übergeben werden können. Auch 
ASCII-Logs werden verarbeitet. Wurde ein Log bereits nach N1MMLogger importiert, 
verwenden Sie Thucydides. 

2.8. AB_Switcher by Dan, WR0DK

http://wr0dk.home.comcast.net/abswitcher.html   

Mit dem AB_Switcher können Sie Ihre A/B-Transceiver über eine serielle 
Schnittstelle ohne die Verwendung einer Parallel-Schnittstelle umschalten. Das 
Programm überwacht die Pegel der Spundkarten-Mixer und leitet daraus das 
Steuersignal DTR zu Umschaltung des TX-Fokus ab.  

3. Rotorsteuerung-Links (Rotator interfacing links)

Von N1MMLogger unterstützte Rotorsteuerungen:  

3.1. Antenna Rotator System ( ARS ) by EA4TX

http://www.ea4tx.com/inde.htm   

• ARS-Universelles Interface für Antennenrotoren von EA4TX 

3.2. LP-Rotor by Larry Phipps - N8LP

http://www.telepostinc.com/LP-Rotor-Html/   

• Alleinstehendes Rotorsteuerprogramm unter Microsoft Windows. 
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• Kann zusammen mit Hy-Gain DCU-1 oder RotorEZ-Interfaces für Hy-Gain-
Rotoren verwendet werden oder als Interface für YAESU-Rotoren. 

4. Hardware-Links (Hardware links)

Von N1MMLogger unterstützte Hardware:  

4.1. Ham Radio Solutions

http://www.hamradiosolutions.com/   

• EZmaster 
o Mit seriellem WinKey-CW-Geber 
o Banddecoder 
o SO1R & SO2R -Controller 

4.2. K1EL

http://www.k1el.com   

• WinKey-CW-Geber  

4.3. microHAM

http://www.microham.com/   

• Banddecoder (seriell und parallel) 
• USB Micro keyer unter Verwendung des WinKey-CW-Gebers von K1EL 
• SO2R-Umschalter 
• und vieles mehr 

4.4. Top Ten Devices, Inc.

http://www.qth.com/topten/   

• Banddecoder 
• DX Doubler SO2R-Controller 

4.5. Interfacing links

• Soundkartenanschluss: http://www.qsl.net/wm2u/interface.html   
• Einfache CW, RTTY-Schnittstellen: 

http://users.skynet.be/ON4AOI/keyer.shtml   

5. Links zu interessanten Programmen (Programm-Links (Software 
links))

5.1. MM-Programmseite (MM Software Page (Freeware))

5.1.1. MMTTY
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http://groups.yahoo.com/group/MMTTY   

• Die MMTTY-Maschine wird von N1MMLogger verwendet. 
• Offizielle englische Website für JE3HHT (MMTTY) 
• Internetgruppe von Bill, KB4IJ 

5.1.2. MMVARI

http://mmhamsoft.amateur-radio.ca/   

• Die MMVARI-Maschine wird von N1MMLogger verwendet. 

5.2. Schnittstellentreiber(Port I/O Driver (freeware))

http://www.driverlinx.com/DownLoad/DlPortIO.htm   

• Einfache Nutzer-DLL und NT-Kernel-Treiber für den direkten Zugriff zur I/O-
Hardware. Wird von Port95NT.exe genutzt. 

• Freeware von Scientific Software Tools, Inc 

5.3. Rufzeichenlisten-Editor (Master.dta Editor (freeware))

http://www.netvampire.com/ham/   

• Zum Ansehen und Editieren der Master Callsign-Datenbank, die in 
verschiedenen Contestprogrammen verwendet wird. Rufzeichen können 
importiert und exportiert und aus angekündigten Dxpeditionen gewonnen 
werden. Großes Programm von Alex, VE3NEA. 

5.4. Zeitsynchronisation (Dimension 4 (freeware))

http://www.thinkman.com/dimension4   

• Synchronisiert Ihren Rechnern mit Internet-Standard-Zeitstationen. Erfolgreich 
von vielen N1MMLogger-Nutzern verwendet. 

• Funktioniert nicht direkt mit Windows XP, Fehlerbehebung siehe FAQ. 

5.5. Zeitsynchronisation (AboutTime (freeware))

http://www.arachnoid.com/abouttime/   

• Synchronisiert Ihren Rechnern mit Internet-Standard-Zeitstationen. Erfolgreich 
von vielen N1MMLogger-Nutzern verwendet. 

• Funktioniert nicht direkt mit Windows XP, Fehlerbehebung siehe FAQ. 

5.6. Audiodateien editieren (Audio-Editor (Cool Edit (shareware)))

http://www.syntrillium.com/   
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• Leistungsfähiger Audio-Editor für MP3-Dateien und andere Formate. Sehr 
viele Optionen.  

5.7. Audiodateien behandeln (Audio-Programm (Audacity 
(freeware))

http://audacity.sourceforge.net/   

• Audacity ist ein freier Audio-Editor. Sie können Audiodateien aufzeichnen, 
bearbeiten und wiedergeben. Der Import und der Export der Formate WAV, 
AIFF und MP3 und weiterer ist vorgesehen. Sie können Audiodateien 
schneiden, komprimieren, den Frequenzgang beeinflussen und Effekte 
einbauen. 

• Eignet sich gut zur Erzeugung und der Bearbeitung von WAV-Dateien für 
einen Contest. Setzen Sie die Samplerate auf 000 und legen Sie los! 

5.8. Mixereinstellungen speichern (QuickMix (freeware))

http://www.msaxon.com/quickmix/   

• Mit QuickMix können Sie die Einstellungen Ihres Windows-Mixers in einer 
Datei speichern und wieder abrufen, wenn Sie die Einstellungen brauchen.  

• Machen Sie die Einstellungen für Pegel, Kanäle, Stummschaltung u.a. und 
speichern Sie sie in einer Datei mit der Endung *.qmx 

5.9. Mixereinstellungen speichern (Sound Mixer (freeware from 
PA1ARE))

http://www.qsl.net/pa1are/software.html   

• Mit Mixer können Sie Einstellungen einer Soundkarte speichern und wieder 
abrufen.  

• Es gibt zwei Möglichkeiten:
o Öffnen Sie den Windows-Mixer und machen Sie die gewünschten 

Einstellungen. Sie können die Einstellungen speichern und wieder 
abrufen

o Speichern Sie die Einstellungen in einer Batch-Datei und geben Sie die 
Marke an, mit der gestartet werden soll. Mixer stellt die Einstellungen 
her und wird dann wieder beendet.  

5.10. Audiodateien aufzeichnen (Audiograbber (freeware))

http://www.audiograbber.com-us.net/   

• Das Program zeichnet alles auf, was die Soundkarte abspielt, auch MP3-
Dateien und unterschiedliche Bitraten. 

• Tipps von Patrick, F6IRF 
o Erzeugen Sie den Fahrplan 1 für eine Stunde von 00:00:00 bis 

00:59:55 
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o Die Dateien werden unter einem Namen aus Datum und Zeit 
abgespeichert 

o MP3-11 kb/s ist mehr als ausreichend für SSB, CW und RTTY 
 Benötigt werden 3MB je Stunde für Mono und 6MB je Stunde für 

Stereo z.B. für SO2R. 
o Wenn Sie ein "Fraunhofer"-Codec auf Ihrem Rechner haben, 

verwenden Sie es, es bietet die beste Qualität. 

5.11. Kurzrufe erzeugen (AutoHotKey (freeware))

http://www.autohotkey.com/   

• Autohotkey kann Kurzrufe aus der Tastatur, dem Joystick und der Maus 
erzeugen. Siehe Kapitel Drittanbieter. 

5.12. Kurzrufe erzeugen (AutoIt version 3 (freeware))

http://www.autoitscript.com/autoit3/   

• Autohotkey kann Kurzrufe aus der Tastatur, dem Joystick und der Maus 
erzeugen. Siehe Kapitel Drittanbieter. 

5.13. Tasten zuordnen (KeyTweak (freeware))

http://webpages.charter.net/krumsick/   

• Ordnet Codes ausgesuchten Tasten zu 

5.14. DXCluster (AR Cluster User (freeware from Lee, VE7CC))

http://www.bcdxc.org/ve7cc/default.htm   

• Das Programm gibt Ihnen mehr Kontrolle über die einlaufenden DXSpots. Es 
kann auf Ihrem lokalen Rechner oder einem anderen Rechner laufen. Es lässt 
sich über den Port 7300 in Ihr Logprogramm einbinden. 

• Es wurde speziell für den AR-Cluster entwickelt, arbeitet aber auch mit 
anderer Cluster-Software zusammen. 

5.15. AGWPE-Koppler (TelMgr (freeware from LU7DID))

http://www.qsl.net/lu7did/   

• Interface zwischen N1MMLogger und AGWPE (Packet über die Soundkarte). 

5.16. AGWPE-Koppler (Telnet interface (freeware from IZ4AFW))

http://www.qsl.net/iz4afw   

• Interface zwischen N1MMLogger und AGWPE (Packet über die Soundkarte). 
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5.17. Statistikprogramm (CBS (freeware from K5KA))

http://www.kkn.net/~k5tr/software/Cbs.exe   

• Erzeugt nach dem Contest eine Statistik  
• Kann Cabrillo-Logs verarbeiten 
• Erzeugt gute Stunden-Statistiken 

5.18. Statistikprogramm (SH5 (freeware from UA4WLI))

http://www.tr4w.com/sh5   

• Erzeugt nach dem Contest eine Statistik aus Cabrillo-Dateien 
• Analyse nach möglicherweise falsch aufgenommenen Rufzeichen 
• Suche nach Teil-Rufzeichen 
• Viele gute Eigenschaften…

6. Links zu Contestkalendern (Contest Calendar links)

6.1. ARRL-Contestkalender (ARRL Contest Calendar Page)

http://www.arrl.org/contests/   

6.2. SM3CER-Contestseite (SM3CER Contesting service)

http://sk3bg.se/contest/

6.3. VK4DX-Contestkalender (VK4DX Contest Calendar)

http://www.vk4dx.net/   

6.4. WA7BNM-Contestkalender (WA7BNM Contest Calendar Main 
Page)

http://www.hornucopia.com/contestcal/   

7. Digimode-Links (RTTY links)

7.1. RTTY-Conteste (RTTY contesting (by Don AA5AU))

http://www.rttycontesting.com/   

Don AA5AU, hat auch ein sehr gute Hilfe zur Einführung in RTTY unter MMTTY 
geschrieben: 
http://aa5au.com/gettingstarted/rtty_start_intro.htm   

Zusatz DM3ML: Sie finden die deutsche Übersetzung dieser Hilfe unter

http://dl0tud.tu-dresden.de/Translate/AA5AU_RTTY_PDF.zip
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7.2. World RTTY Contest Scene (by DJ3NG)

http://www.rtty-contest-scene.com/   

7.3. RTTY.com

http://www.rtty.com/   

7.4. Jim's Gazette

http://www.n2hos.com/digital/   

Last Modification: 14 November 2009 14:15:43 EST by Thomas. 
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DXCluster (DX Clusters)

Es gibt verschiedene Typen von DXClustern, die Sie während eines Contests 
verwenden können. Bei den meisten stimmen die wichtigen Kommandos mit dem 
Original von AK1A überein, z.B. SH/DX. Es gibt aber auch Abweichungen. 
Informieren Sie sich über die Hilfe bei Ihrem lokalen DXCluster.

1. Überblick (Overview)

DXCluster AR-
Cluster CLX DXnet DX

Spider 
Win
cluster Clusse PacketCluster(

tm) 

Autor AB5K 
DJ0ZY 
und 
DL6RAI 

F5MZN G1TLH KH2D OH7
LZB AK1A

Betriebs
system 

Window
s
32 bits 

Linux 

Linux, 
Dos
Window
s 

Linux
Window
s 

Windows
32 bits DOS DOS

Kommando-
Satz SH/DX SH/DX SH/DX SH/DX SH/DX Own SH/DX

Verwendete 
Version 5.04 4.3b9 1.51 2.3.8 1.0 Nicht gefunden

Wird noch 
gepflegt Ja Ja Ja Ja Ja Nein Nein

Freeware $$$ Free
ware 

Free
ware 

Free
ware $$ Free

ware $$

Mehr
sprachig ? ? Ja Ja Nein Ja ?

Website Websit
e   

Websit
e   

Websit
e   

Website
  

Website
  

Website
  keine

Hilfe Web   Web   
Nicht 
gefunde
n 

Web 
help  
PDF 
help  
from 
FRC 

Nicht 
gefunde
n

Nicht 
gefunde
n

Nicht gefunden

Hilfe zu 
DXSpots Web   Web   

Nicht 
gefunde
n

Web   
Nicht 
gefunde
n

Nicht 
gefunde
n

Nicht gefunden

Hilfe zu 
Filtern Web   

Web 
pg1  
Web 
pg2   

Nicht 
gefunde
n

Web 
help  
PDF 
help  
by 
W3BG 

Nicht 
gefunde
n

Nicht 
gefunde
n

Nicht gefunden

Kommando- Web   Web   Nicht Web   Nicht Nicht Nicht gefunden

11.04.2010

http://www.dxcluster.org/main/usermanual_en-12.html
http://clx.muc.de/user/english/html/userman-20.html
http://www.ab5k.net/ArcDocs/UserManual/ArcCmdSummary.htm
http://www.gofrc.org/pdf/Filter%20Primer.pdf
http://www.gofrc.org/pdf/Filter%20Primer.pdf
http://www.dxcluster.org/main/usermanual_en-10.html
http://www.dxcluster.org/main/usermanual_en-10.html
http://clx.muc.de/user/english/html/userman-13.html
http://clx.muc.de/user/english/html/userman-13.html
http://clx.muc.de/user/english/html/userman-12.html
http://clx.muc.de/user/english/html/userman-12.html
http://www.ab5k.net/ArcDocs/UserManual/ArcFilters.htm
http://www.dxcluster.org/main/usermanual_en-4.html
http://clx.muc.de/user/english/html/userman.html
http://www.ab5k.net/ArcDocs/UserManual/ArcDx.htm
http://www.gofrc.org/pdf/dxspider.pdf
http://www.gofrc.org/pdf/dxspider.pdf
http://www.dxcluster.org/main/usermanual_en.html
http://www.dxcluster.org/main/usermanual_en.html
http://clx.muc.de/user/english/html/userman.html
http://www.ab5k.net/ArcDocs/UserManual/ArcUserManual.htm
http://hes.iki.fi/clusse/
http://kh2d.net/software/wc/
http://www.dxcluster.org/
http://www.dxnet.free.fr/
http://www.dxnet.free.fr/
http://clx.muc.de/
http://clx.muc.de/
http://www.ab5k.net/
http://www.ab5k.net/


N1MM-Contest Logging Software Seite 450 von 470 Übersetzung der Hilfe von Eike, DM3ML

Verzeichnis gefunde
n

gefunde
n

gefunde
n

2. Kommandos (Commands)

Aktion AR-
Cluster CLX DXnet DXSpider Wincluste

r 
Cluss
e 

Kommando-
Satz SH/DX SH/DX SH/DX SH/DX SH/DX List

Nutzer 
anzeigen 

SH/USER
S SH/USERS SH/USERS SH/USER

S 
SH/USER
S 

Show WWV SH/WWV SH/WWV SH/WWV SH/WWV SH/WWV 
Netzwerk-
Konfig SHow/Conf 

Filter 
anzeigen 

show/filter
s show/filters SHow/Filter show/filter 

Filter setzen set/filter 
[..] set/filter 5 

EinzelnesFilt
er 
rücksetzen 

set/nofilter 1 clear/spot
s 1 

Alle Filter 
rücksetzen set/nofilter set/nofilter SET/NOFilter clear/spot

s all 
Zeilenzahl 
auf 0 setzen

SET/PAG
E 0 

Herkunft des 
DXSpots 
anzeigen 

SHOW/DXDE
DX 

Herkunft-
Filter setzen SET/DXDEDX 

Herkunft-
Filter 
löschen 

SET/NODXDE
DX 

Show other 
languages 
Andere 
Sprachen - 

Hilfe suchen apropos 
<string> 

2.1. Kommandosatz SH/DX (SH/DX command set)

• SET/FILTER 
• SHow/Filter 
• SET/NOFilter 
• SET/DX_announcements 
• SET/NODx_announcements 
• SET/Announcements 
• SET/NOAnnouncements 
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• SET/nodx : Sie bekommen keine DXSpots (z.B. für nicht assistierte 
Stationen), können aber welche abschicken 

3. Filter und andere Beispiele (Filter and other examples/features)

Die Einstellung von Band/Sendearten-Filtern ist nicht zu empfehlen, da sie oft 
Splitbetrieb auf den unteren Bändern blockieren.  

Sie finden Filterbeispiele für AR-Cluster und DX-Spider beim Yankee Clipper 
Contest Club  (YCCC). 

3.1. AR-cluster

Einzelheiten finden Sie unter: 
http://www.ab5k.net/ArcDocs/UserManual/ArcFilters.htm   

Wollen Sie nur in den US generierte Spots sehen, nehmen Sie: set/filter k/pass 
oder wollen Sie nur in den USA (K)oder Kanada (VE) generierte Spots sehen, dann 
nehmen Sie: set/filter k,ve/pass. 
Mit set/filter dxbm/reject vhf,uhf werden VHF- und UHF-Spots unterdrückt. 
Alle Filter werden abgeschaltet mit: set/nofilter
Sie können sich Ihre Einstellungen ansehen mit: show/filters 

3.2. CLX

Einzelheiten finden Sie unter:

http://clx.muc.de/user/english/html/userman.html   

SET/FILTER <nr1,nr2,..,nrX>

Mit diesen Kommandos können Sie Filter mit einer Nummer adressieren. Diese 
Nummern sind: 
--
1 VHF 144.000 MHz und höher
2 HF 30.000 MHz und tiefer
3 TOP 1.800-2.000 MHz
4 alle CW-Band-Segmente
5 alle SSB-Band-Segmente
6 alle RTTY-Band-Segmente
7 alle WARC-Bänder
--
Ihr Sysop kann Filter entfernen oder andere Filter einbauen. Fragen Sie die 
Möglichkeiten mit SHOW/FILTERS ab. Wählen Sie die Filter nach Ihren Wünschen 
aus, z.B. mit SET/FILTER 4,6
Damit werden die CW- und RTTY-Filter gesetzt und nur die SSB-DXSpots 
durchgelassen. Geben Sie dann das Kommando SET/FILTER 1,3, jetzt die Filter 
1,3,4 und 6 wirksam, Sie bekommen nur noch SSB-DXSpots von den Bändern von 
80 bis 10 m einschließlich der WARC-Bänder.  
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SET/DXDEDX und SET/NODXDEDX
Mit diesem Kommando können Sie die so genannten Internet-DXSpots abschalten 
und nur die DXSpots aus Ihrer Region sehen. Das Kommando dazu lautet 
SET/NODXDEDX. Ihr Sysop stellt die zu berücksichtigenden Zonen ein. Sie können 
Sie sich mit dem Kommandos SHOW/DXDEDX ansehen. Wenn Sie wieder alle 
DXSpots sehen wollen, geben Sie SET/DXDEDX. 

SET/DX_ANNOUNCE und SET/NODX_ANNOUNCE
Mit diesen Kommandos wird der Empfang von DXSpots ein- oder ausgeschaltet. Sie 
können mit dem Kommando SET/NODX_ANNOUNCE DX-Spots abschalten, die Sie 
beim Lesen einer längeren Nachricht stören. Schalten Sie die DXSpots mit 
SET/DX_ANNOUNCE wieder zu. 

SET/LOGIN_ANNOUNCE
Wollen Sie sehen, wer sich bei Ihrem DXCluster ein- oder ausloggt, geben Sie 
dieses Kommando. Sie bekommen diese Ausschriften: 
Login at 1929Z: DL6RAI
Logout at 1930Z: DK2OY

3.3. DXSpider

Einzelheiten finden Sie unter http://www.dxcluster.org/main/usermanual.html  
oder holen Sie sich die PDF-Datei von FRC von 
http://www.gofrc.org/pdf/dxspider.pdf   

Eine PDF-Datei zu den vom Nutzer einstellbaren DXSpot-Filtern beim DXSpider hat 
Jim Samuels, W3BG, bei http://www.gofrc.org/pdf/Filter Primer.pdf  veröffentlicht. 

Mit SET/USSTATE kann der US-Staat automatisch vor oder nach dem Zeitfeld 
eingefügt werden. Die Information dazu kommt aus der FCC-Datenbank. 

Das grundlegende Format für ein DXSpot-Filter ist: 

accept/spots <pattern>
reject/spots <pattern> 

accept : Diese DXSpots möchte ich empfangen
reject : Diese DXSpots möchte ich nicht empfangen 

Im <pattern> werden die Wünsche beschrieben, z.B. "by k1xx" oder "by a VE" oder 
"by someone in Maine" 

Die exakte Syntax ist:

by_zone : Spotter in CQ-Zone 1-40
by_dxcc : Spotter in W oder VE oder F oder G
by_state : Spotter im US-Staat ME, CT, RI, NH

Mit "Call" werden die Eigenschaften des Spotters angezeigt: 
call_zone : die Zone des Spotters
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call_dxcc : das Land des Spotters
call_state : der US-Staat des Spotters 

Beispiele:

accept/spots by_dxcc w,ve : akzeptiere DXSpots nur von W & VE-Stationen
accept/spots by_zone 5 : akzeptiere DXSpots nur aus Zone 5
accept/spots by_state me : akzeptiere DXSpots nur aus Maine
reject/spots call_dxcc G : weise DXSpots aus G ab
reject/spots call_zone 14 : weise Spots aus der Zone 14 ab
reject/spots call_state md : weise DXSpots aus Maryland ab 

accept/spot 0 info rtty : Nur Spots, in denen "RTTY" im Kommentar steht, werden 
angezeigt 

Mit clear/spots all werden alle Filter abgeschaltet. Die Filter bleiben so lange aktiv 
bis sie gelöscht werden, auch wenn Sie sich neu einloggen. 

Sie können auch Frequenzen einbauen: 
accept/spots by_dxcc w,ve and on 10m : nur 10m-DXSpots aus W & VE anzeigen
reject/spots call_zone 25 and on 160m : keine DXSpots von JAs auf 160m 
erwünscht 

4. Links

DX PacketCluster WebNet http://www.dxcluster.info/  
Webcluster und weitere nützliche Informationen http://hamgallery.com/clusters/  
OH2AQ WebCluster (DX-Summit) http://oh2aq.kolumbus.com/dxs/   

Last Modification: 07 December 2009 09:17:31 EST by K8UT. 
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Anpassen der DXCC-Liste (Customizing the DXCC List)

1. Aktualisierung der Länderdatei (Updating the country file - CTY.DAT)
 Hinweis 

Sie werden die folgenden Information kaum benötigen, denn Jim Reisert, AD1C, ist 
sehr pünktlich und stellt neue Versionen der Länderdatei rechtzeitig vor großen 
Contesten zur Verfügung.  
Das Programm verwendet eine Länderdatei, die alle Informationen zur CQ-Zone, zur 
ITU-Zone, Kontinent. Länge, Breite usw. Enthält. Diese Datei heißt CTY.DAT, sie 
wird aber nicht direkt verwendet, sondern muss in die Datenbank eingelesen werden. 
N1MMLogger holt sich seine Daten aus der Datenbank und nicht direkt von der 
Länderdatei.  

Wenn Sie ein Rufzeichen in das Logeingabefenster eintragen, erscheinen die zu 
dem Rufzeichen gehörenden Daten zu Prefix, Ländername, CQ-Zone und Kontinent. 
Weitere Informationen werden im Info-Fenster angezeigt wie Antennenrichtung, 
Entfernung, Sonnenauf- und untergang am Zielort.  

Für eine Reihe an Stationen, die nicht an dem ihrem Rufzeichen entsprechenden 
Standort zu finden sind, wurde separate Einträge in die Länderdatei aufgenommen. 
Ein Beispiel ist K2KW, der in Kalifornien (Zone 3) sitzt und nicht in New York (Zone 
5). 

Sie können die Länderdatei so aktualisieren:  

• Gehen Sie ins Menü Tools > Download latest country file (wl_cty.dat)
(Internet)

• Ein Internetbrowser öffnet sich. Wählen Sie zum Abholen die neueste Datei 
wl_cty.dat und speichern Sie im N1MMLogger-Verzeichnis

• Importieren Sie dann diese Datei in die Datenbank von N1MMLogger mit dem 
Menü 'Tools > Import country list from downloaded file'. 

Das Format der Datei CTY.DAT sieht so aus: 

Spalte Länge Beschreibung 
1 26 Ländername, abgeschlossen mit einem Doppelpunkt 
27 5 CQ-Zone, abgeschlossen mit einem Doppelpunkt. 
32 5 ITU-Zone, abgeschlossen mit einem Doppelpunkt. 

37 5 Kontinent (2 Buchstaben), abgeschlossen mit einem 
Doppelpunkt 

42 9 Breite in Grad, + für Nord, abgeschlossen mit einem 
Doppelpunkt  

51 9 Länge in Grad, + für West, abgeschlossen mit einem 
Doppelpunkt

61 9 Zeitdifferenz gegenüber GMT, abgeschlossen mit einem 
Doppelpunkt 

69 6 Primärer DXCC-Prefix, abgeschlossen mit einem Doppelpunkt 
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Folgende 
Zeile(n)

Liste der möglichen Prefixe, getrennt durch ein Komma und 
abgeschlossenen mit einem Semikolon

Die Felder sind in Spalten angeordnet und nur zur besseren Lesbarkeit getrennt. Der 
Doppelpunkt wird als Feldbegrenzung verwendet. 

Die Alias-DXCC-Prefixes (einschließlich des ersten Prefixes) stehen in weiteren 
Zeilen durch ein Komma getrennt. Folgelinien beginnen mit einem &. Das Semikolon 
schließt die Prefixliste ab.

Falls das Land über mehrere Zonen geht, folgen auf das Prefix die CQ-Zone in 
runden Klammern und die ITU-Zone in eckigen Klammern. Dabei steht die CQ-Zone 
vor der ITU-Zone.  

• Sonderzeichen können zu einem Prefix hinzugefügt werden: 
(#) Überschreibt die CQ-Zone, wobei # die Zonennummer ist. 
[#] überschreibt die ITU-Zone, wobei # die ITU-Zone ist 

2. Länderdatei von Writelog (Writelog country file)

N1MMLogger kann auch die Länderdatei WL_CTY.DAT von WriteLog verwenden, 
bei dem zusätzliche Informationen zur CQ-Zone für Länder wie Kanada, Australien 
und China enthalten sind. Da sich diese Länder über mehrere Zonen erstrecken, hat 
WL_CTY.DAT zusätzliche Macros zur Beschreibung der Prefixeigenschaften 
eingebaut. Siehe Beispiele weiter unten. 

Der Import der Datei wl_cty.dat ist der normalen Datei  cty.dat vorzuziehen. 

* : Mit diesem Zeichen werden Länder markiert, die nur für spezielle Conteste wie 
den CQWW und WAE als getrennte Länder gültig sind. Entfernen Sie die Markierung 
* * nicht, wenn Sie eine Länderdatei überarbeiten.

Andere Probleme machen Rufzeichen wie FR5ZQ/J. Sie passen nicht in das 
Schema und müssen getrennt zugewiesen werden, hier zum Prefix "FR/J".

Für KG4-Stationen gilt: Wenn es sich um ein KG4-Rufzeichen mit 2x2 Buchstaben 
handelt, wird es Guantanamo zugeordnet, sonst sind es US-Rufzeichen (K (2x1 oder 
2x3)). In einem anderen Fall muss das exakte Rufzeichen in der cty_dat-Datei 
stehen. 

Die Niederlande machen keine Probleme, auch wenn eine Reihe neuer Prefixe wie 
PA, PB, PC ausgegeben wurden. Die Niederlande gehören in die CQ-Zone 14, die 
ITU-Zone 28 und liegen in EU. Die Notierung für die Niederlande lautet:

Netherlands: 14: 27: EU: 52.40: -4.90: -1.0: PA: PA,PB,PC,PD,PE,PF,PG,PH,PI; 

Grönland: Normalerweise verwenden die Stationen in Grönland den Prefix OX. Das 
Rufzeichen XP1AB gehört eigentlich zu Dänemark, funkte aber aus Grönland und 
wurde als dediziertes Rufzeichen unter Grönland notiert:

Greenland: 40: 05: NA: 62.50: 45.00: 3.0: OX: OX,XP1AB; 
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Afrikanisch-Italien: Die zur Zone 33 gehörenden italienischen Inseln IG9 vor der 
libyschen Küste haben ein Prefix mit einem * davor, sie zählen getrennt nur für die 
CQWW-Conteste: 

African Italy: 33: 37: AF: 35.40: -12.50: -1.0: *IG9: IG9,IH9,IQ9L,IZ9; 

Weitere Beispiele können Sie für VE und UA9 finden.  

Beispiel für ein Writelog-Macro: Die Macros beginnen mit einem # und enden beim 
nächsten ; 
Für China gilt der Summeneintrag:

China: 24: 44: AS: 40.00: -116.40: -8.0: BY:

mit der Aufteilung  

#BY: BY3G(23),BY3H(23),BY3I(23),BY3J(23),BY3K(23),BY3L(23), 
BY9A(23),BY9B(23),BY9C(23),BY9D(23),BY9E(23),BY9F(23),BY9G(23), 
BY9H(23),BY9I(23),BY9J(23),BY9K(23),BY9L(23),BY9T(23),BY9U(23), 
BY9V(23),BY9W(23),BY9X(23),BY9Y(23),BY9Z(23),BY0(23); 
3H,3I,3J,3K,3L,3M,3N,3O,3P,3Q,3R,3S,3T,3U,BG,BT,BW,BY,BZ,XS; 

Last Modification: 31 October 2009 10:59:26 EDT by K8UT. 

Technische Informationen zu N1MMLogger (Technical Information)

N1MMLogger ist ein Contestprogramm. Es ist in Microsoft Visual Basic 
geschrieben und verwendet eine Microsoft Access 2000-Datenbank zum 
Abspeichern der Daten. Die Daten werden in die und aus der Datenbank mit SQL 
(Structured Query Language) übertragen. In dem Installationspaket von 
N1MMLogger sind alle benötigten Dateien enthalten. Aktualisiert wird N1MMLogger 
durch die Dateien NewExeVx.x.x. 

Sie benötigen die folgenden Informationen NICHT, um mit N1MMLogger zu arbeiten. 

 Warnung 
Ändern Sie die Daten in der Datenbank nicht, wenn Sie nicht ganz sicher sind, was 
und wie Sie es machen. Wenn Sie Fehler machen, können Sie N1MMLogger 
unbrauchbar machen. Machen Sie vorher eine Sicherungskopie der Datenbank und 
kehren Sie im Zweifelsfall wieder dorthin zurück. Wir können Ihnen in so einem Fall 
nicht helfen. Es ist allein Ihr Problem!

Hinweis: Es besteht keinerlei Notwendigkeit, die Datenbank oder *.ini-Dateien zu 
ändern. Das ist die zweite und letzte Warnung! 

Wenn Sie in der Struktur der Datenbank interessiert sind, benötigen Sie Microsoft 
Access 2000 oder den Access 2000 V auf Ihrem Rechner. 
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Warum wird diese Information gegeben? (Why is this information given?) 

Sie können als Sachkundiger aus der Datenbank Informationen gewinnen, die von 
N1MMLogger nicht direkt unterstützt werden. 

Beispiele: 

• Sie können Auswertungen machen, die nicht als Standard vom Programm 
angeboten werden. Falls Sie sich mit SQL und Access auskennen, können 
Sie eigene Auswertungen machen. 

• Die Änderung von Informationen in der Datenbank lässt sich mitunter direkt 
einfacher machen als über das N1MMLogger-Programm. 

 Hinweis 
Wenn Sie QSO-Daten ändern, müssen Sie anschließend ein Rescore machen. Die 
Daten zu Multis und QSO-Punkten werden mit einem Rescore neu berechnet und die 
direkten Änderungen dazu in der Datenbank gehen verloren. Sie müssen dann auch 
das Cabrillo-Log neu erzeugen, die Änderungen betreffen nur die Datenbank. 
Zusatz: Sie können über die Datenbank keinen neuen Contest erzeugen. Die 
Contestregeln stehen im Hauptprogramm N1MM logger.exe und sind nicht in der 
Datenbank oder anderen Dateien.  

1. Verzeichnis-Struktur (Directory structure)

Voreingestellt ist die Installation des Programms im Verzeichnis 'Program Files' (in 
Deutsch: Programme) auf der Festplatte im Laufwerk C:. ). Unterhalb des 
N1MMLogger-Verzeichnisses werden die WAV-Dateien für die Digitale 
Sprachausgabe (Digital Voice Keying (DVK)) abgelegt. 

C:\Program Files\N1MM Logger Programmverzeichnis 

C:\Program Files\N1MM Logger\Wav
Enthält die WAV-Dateien für die 
Sprachausgabe in SSB. Sie müssen diese 
Dateien selbst erzeugen.

2. Wo steht die Programminformation? (Where is the program 
information stored?)

Die Programminformation ist wie folgt aufgeteilt:  

• Access-Datenbank 
o Als erste Datenbank wird HAM.MDB installiert.
o Sie können weitere Datenbanken anlegen, umbenennen oder löschen 
o Allgemeine Contestdaten 

 Contest-Information 
 Stationsinformation 
 Während des Contests gemachte QSOs 
 Eingelaufene DXSpots 
 Belegung der Funktionstasten 
 Länderdaten 
 usw. 

• N1MM logger.ini-Datei 
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o Programmeinstellungen, Konfiguration. Die Einstellungen ersetzen die 
Voreinstellung mit der Ursprungsdatei 'Default Settings.ini' 

o Bildschirmeinstellungen (screen setup) 
• Default Settings.txt 

o Voreinstellungen, die vom Programm genutzt werden
• Configuration files 

o Einstellungen für externe TNCs 
o MMTTY-Einstellungen 

• Andere Dateien 
o WAV-Dateien 
o Exportierte Logdateien im Format Cabrillo, ADIF, allgemeines Log und 

Summenlisten 
o Sektionsdateien für spezielle Conteste (*.sec) 

3. Die ACCESS-Datenbank (The Access database)

Eine Datenbank hat verschiedene Tabellen mit den Daten: 

Tabelle Inhalt 
Antennen Einstellungen auf der Karteikarte Antennas (Config) 
BandModeFrequency Radio(VFO)-Nummer, Frequenz, Sendeart beim Bandwechsel 
CallHist Rufzeichengeschichte 
Contest Alle möglichen Conteste des Programms
ContestInstance Im Contestdialog angezeigte Conteste 
CTYDAT Länderinformation mit CQ/ITU-Zone, Kontinent, Länge, Breite, 
DXLOG QSOs aller unter ContestInstance angezeigten Conteste 
Lookup F-Tasten, Staaten, Provinzen usw. 

PacketSpots Alle eingelaufenen DXSpots, sie werden in den Bandskalen 
angezeigt

PacketSpotsTest Test-Packet-Spots für die Programmentwicklung
Prefixes Vom Programm erkannte Prefixe mit Landeszuordnung
SectionsWorked Sektionsmultis zur Anzeige im Multiplikator-Fenster
Settings Vom Programm benutzte Einstellungen
Station Stationsdaten. 
ValidCalls Nicht benutzt (leer)

4. Die Datei N1MM Logger.ini (The "N1MM logger.ini" file)

Die Datei "N1MM logger.ini" enthält alle vom Nutzer gemachten Einstellungen, die in 
der Datei "Default Settings.txt" nicht enthalten sind. Einstellungen, die in der Datei 
Default Settings.txt stehen, sind in der Datei N1MM logger.ini nicht noch einmal 
aufgeführt.

• Die Datei "N1MM logger.ini" ist nach der Funktion (Sektion oben in der Datei) 
und nach Fenstern (Sektion unten in der Datei) organisiert. 

• Die Attribute der Sektion Funktion können gelöscht werden. An ihrer Stelle 
werden voreingestellte Werte verwendet. 

• Die Sektion Fenster enthält die Positionen und andere Informationen zu den 
Fenstern. Diese Daten sollten generell nicht geändert werden. 
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• Halten Sie die Ordnung in der Datei wie vorgegeben bei. Dadurch werden die 
Dinge bei Diskussionen einfacher. 

• Kommentare in der Datei beginnen mit einem Semikolon 
• Wenn Sie die Datei „N1MM logger.ini' löschen, wird an ihrer Stelle die Datei 

'Default Settings.txt' verwendet und die Datei 'N1MM logger.ini' wird neu 
angelegt.  

4.1. Funktionen (Functions)

Die Funktionsnamen aus der unten stehenden Tabelle erscheinen in der Datei in 
eckigen Klammern. Wenn Sie die Datei editieren, verwenden Sie die zugehörige 
Überschrift aus der Tabelle, um sie leichter zu finden.

Mögliche Funktionsnamen sind: 

Com1 Com2 Com3 Com4 Com5 Com6 Com7 
Com8 Lpt1 Lpt2 Lpt3 MutiplierWindow SO2R/V Files 

Digital1 Digital2 MMTTY Function 
Keys Other Winkey Mode 

Control 

Antennas SO2R/V 
Setup Available Packet Configurer ConfigurerDialog 

CW 
Window

Digital 
Interface

Digital 
Interface 
Setup

DigitalIO2 EditContact EditLookupTable

Beispiele 

[Packet] 

Packet Tab=1 > das Telnet-Fenster wird angezeigt. Falls entfernt, wird das Packet-
Fenster angezeigt. 

[Configurer] 

Database Name=C:\Program Files\N1MM Logger\PI4GN-Maart-2004.mdb > aktuell  
ausgewählte Datenbank 

Contest Type=VHFREG1 > aktuell ausgewählter Contest in der Datenbank 

Contest NR=1 > Nummer des Contest in der aktuellen Datenbank 

Recent Contest 1=VHFREG1:6-3-2004:C:\Program Files\N1MM Logger\PI4GN-
Maart-2004.mdb > zuletzt ausgewählter Contest 

4.2. Fenster (Window Section)

Diese Fenster können angewählt werden: 

EntryWindow EntryWindow2 GraphicalBandMap 1 GraphicalBandMap 
2 
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InfoWindow Log LogTypeSelectionDialog MultsByBand 
PacketWindow PSKEngine ScoreSummary StationDialog 
SuperCheckPartial AvailableMultsAndQs BandMap

Beispiele 

[EntryWindow] 

Top=3825 

Left=2985 

Height=3330 

Width=5370 

Die Angaben definieren die Lage des Fensters auf dem Computerbildschirm 
(Bezugspunkt oben links und  Höhe+ Breite)

[PacketWindow] 

WindowState=0 > Fenster geschlossen (0)

Top=9000 

Left=3270 

Height=2550 

Width=12105 

Telnet Port=K1TTT.NET > ausgewählter Telnet-DXCluster  

[BandMap] 

CW Wide - 1=*RMF400CW Narrow - 1=*RMF250 

[InfoWindow] 

WWVMessagesVisible=False ''WWV-Nachrichten werden nicht im Info-Fenster 
angezeigt”' 

Nach der Installation werden die Daten im N1MMLogger-Verzeichnis abgespeichert. 

 

5. Programm-Dateien (Program files)

Löschen Sie niemals diese Dateien !!  

• arrow.bmp : Pfeil-Icon in der inaktiven Bandskala 
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• ClearRegistry.bat : löschte bis zur Version 4 die vom Programm belegte 
Registry (wird nicht mehr benötigt) 

• cty.dat : die voreingestellte Länderdatei. Sollte mit dem Menüpunkt 'Tools 
/Import country list from downloaded file' auf den neuesten Stand gebracht 
werden 

• CW IF.exe : ist eine Active X-Komponente und erzeugt CW 
• cyanarrow.bmp - Pfeil-Icon in der aktiven Bandskala
• Default Settings.txt : voreingestellte Einstellungen, Abweichungen davon 

stehen in der Datei N1MM Logger.ini. 
• dirswap.BAT: Umbenennen des WAV-Verzeichnisses (Beispiel) 
• empty.wav : Datei zum Abschluss einer WAV-Datei 
• led_Red.bmp : Achtungs-LED für eine Mitteilung 
• master.dta . Rufzeichenliste für das Prüffenster 
• N1MMLoggerHelp.chm : Windowshilfe, wird mit ALT+H gerufen 
• N1MM Logger.exe : Contestprogramm N1MMLogger  
• N1MM logger.ini : Enthält Konfigurationsdaten. Vorsicht beim Editieren!! 
• N1MM logger.ini.init ; Mit einer Datei NewExe mitgelieferte Einstellungsdatei. 

Wird in N1MM Logger.ini umbenannt, wenn es diese Datei noch nicht gibt
• N1MMlogger.pdf : englisches Handbuch im PDF-Format. Wird mit 'Help > 

Manual' aufgerufen. 
• N1mmWave.ocx : Datei für das Aufzeichnen und Abspielen von WAV-Dateien 
• reddot.gif : Icon für Warnmeldungen im Logeingabefenster 
• RevisionHistory.htm : N1MMLogger-Entwicklungsgeschichte 
• *.sec - text files: Hilfsdateien für bestimmte Conteste, die Daten zu 

Provinzen/Sektionen/Bezirken u.ä. benötigen(z.B.SAC.sec, REF.sec usw). 
• style.css : Formblatt benötigt unter 'RevisionHistory.htm'. 
• ST6UNST.LOG : Daten für die De-Installation von N1MMLogger 
• Suncalcs.dll - dll used by the program. 
• Update Log.wri : Überblick über letzte Programmänderungen, wird nicht mehr 

benötigt und gepflegt, kann entfernt werden 
• Upgrade.bat : Registriert die Datei CW IF.exe unter Windows (wird 

normalerweise automatisch vom Programm übernommen) 
• *.init : Dateien, die während der Installation verwendet werden, werden 

danach nicht mehr benötigt, sollten aber stehen bleiben. 

6. Datenbanken

• ham.mdb : voreingestellte Datenbank. NICHT löschen!! 
• new.mdb : neue vom Nutzer eingerichtete Datenbank. NICHT löschen!! 
• *. MDB : Unter File > New Database neu angelegte Datenbank 

Wenn Sie eine Datenbank löschen, verlieren Sie damit alle Contest-QSOs, die darin 
gespeichert waren. Sinnvoll ist, für einen oder eine Gruppe von Contesten, an denen 
Sie regelmäßig teilnehmen, eine eigene Datenbank anzulegen, z.B. PACC2002.MDB 
.

7. Von Ihnen selbst angelegte Dateien (Files created on your command):

• <YOURCALL>.ADI : Contest-QSO-ADIF-Datei angelegt mit 'File > Export > 
Export ADIF to file...' 
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• <YOURCALL>.LOG : Contest-Cabrillo-Datei angelegt mit 'File > Export > 
Export Cabrillo to file...' 

• <YOURCALL>.SUM : Contest-Gesamtübersicht (Summen-Blatt)  angelegt mit 
'File > Export > Print Score Summary to File' 

• <YOURCALL>.TXT : Contest-Log in Listenform angelegt mit 'File > Export > 
Export to File (Generic)...' 

• *.MC : Abgespeicherte Tastenbelegung (F-Tasten)  
• *.TXT : Abgespeicherte andere Dateien, wie die Packet/Telnet-Tasten 

8. RTTY-Dateien (RTTY files)

Die zu MMTTY gehörenden Dateien sind nicht Bestandteil des N1MMLogger-
Installationspakets und müssen bei Bedarf von der MM-Seite geholt werden: 

• MMTTY.exe : das MMTTY-Programm 
• MMTTY.ini : die MMTTY-Konfigurationsdatei 
• MMTTY.* : weitere Dateien aus dem MMTTY-Programm 
• XMMT.ocx : wird von MMTTY.exe benötigt 
• Settings.txt : Beispiel für die Einstellung eines AEA PK-232-Kontrollers 
• UserPara.ini : MMTTY-Einstellungen 

9. PSK und andere Sendearten (PSK and other modes)

Die MMVARI-Maschine ist Bestandteil des N1MM-Installers. Sie brauchen das 
MMVARI-Paket nicht getrennt zu laden. 

• MMVARI.ocx : die MMVARI-Maschine 
• Varicode.tbl : die von MMVARI benutzte Kodiertabelle

10. PSKCore-Dateien (nicht mehr benötigt) (PSKCore files (all obsolete))

Alle PSKCore-Dateien werden unter N1MMLogger nicht mehr benötigt. Sie können - 
falls noch vorhanden - gelöscht werden: 

• PSKCore.dll  
• XMMT.ocx 
• PSK63.dll 
• WINPSKX.dll 
• PSK.pal : Farbeinstellung für WINPSK dll 
• WINPSKX.oca

11. ADIF-Felder (ADIF fields)

N1MMLogger hält sich an den jeweils neuesten ADIF-Standard. In den Datenbanken 
von N1MMLogger sind aber mehr Informationen gespeichert als für den ADIF-Export 
benötigt werden. Diese Daten werden mit für N1MMLogger spezifischen 
Schlüsselworten ebenfalls exportiert und dienen dem Austausch zwischen 
N1MMLogger-Programmen. Die Daten entstammen alle der DXLOG-Tabelle. Mit 
einem Rescore werden die Punktzahl und die Multis neu bestimmt und die korrekten 
Werte angezeigt.
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Die N1MMLogger-spezifischen ADIF-Schlüsselworte sind:  

• APP_N1MM_EXCHANGE1 – Inhalt des Felds Exchange1 
• APP_N1MM_POINTS – Inhalt des Punkt-Felds 
• APP_N1MM_RADIO_NR : Inhalt des Felds RadioNr 
• APP_N1MM_MISCTEXT : Inhalt des Felds MiscText 
• APP_N1MM_CONTINENT : Inhalt des Felds Kontinent
• APP_N1MM_CONTACTTYPE IN : Inhalt des Felds ContactType 
• APP_N1MM_RUN1RUN2:1 : Inhalt des Felds Run. 1= Tcvr 1 war RUN-Tcvr, 

2 = Tcvr 2 war RUN-Tcvr 

12. Rufzeichenprüfung bei den digitalen Sendearten (Callsign checking 
in the Digital Interface)

Zuerst wird die Länge des Rufzeichens geprüft (länger als 2 und kürzer als 11). Dann 
wird geprüft, ob eine der ersten 6 Zeichen eine Ziffer ist und ob das Rufzeichen 
verbotene Sonderzeichen enthält. Wird diese Prüfung bestanden, geht das 
Rufzeichen zum Busted Call Checker. Zeigt der Busted Call Checker einen Fehler 
an, ist das Rufzeichen ungültig, sonst wird das Rufzeichen akzeptiert.  

Der empfangene Text läuft im RX-Fenster des Digimode-Programms ein und wird in 
einem Pufferspeicher aufbewahrt. Wenn ein Trennzeichen (Zwischenraum (Space), 
ein Wagenrücklauf (CR) oder eine Zeilenschaltung (LF)) im Puffer erkannt wird, 
sendet das Programm den Text zur Prüfung auf ein Rufzeichen. Wird ein gültiges 
Rufzeichen gefunden, sieht das Programm bis zu 25 Zeichen rückwärts im Text im 
RX-Fenster nach und markiert das Rufzeichen farbig. Der Pufferspeicher wird nach 
dem Trennzeichen geleert und ist für die nächste Prüfung bereit. Die Prüfung 
benötigt nur Millisekunden. Für die Rufzeichenprüfung wird kein DE vor dem 
Rufzeichen wie bei anderen Programmen benötigt. Wichtig ist, dass ein 
Trennzeichen erkannt worden ist.

Sehen Sie sich diesen empfangenen Text an:  

A QWSCFGTWA5TTT WA5TTT UR 599 XXXXXXXXXX 

Das Programm weißt den ersten Teil "QWSCFGTWA5TTT" als ungültig ab, findet 
aber im zweiten Teil nach dem dritten Leerzeichen die Zeichenkette WA5TTT und 
beurteilt sie als gültiges Rufzeichen. Das Programm sieht nun rückwärts im 
empfangenen Text nach der Zeichenkette WA5TTT, markiert sie farbig und überträgt 
das Rufzeichen zusätzlich in das Fangfenster (Grab window). 

Wie beim Klick auf ein Rufzeichen läuft die gleiche Prüfung ab. Probleme kann es mit 
dem Busted Call Checker geben, wenn ihm die Bildungsregeln gar zu exotischer 
Rufzeichen nicht bekannt sind. Andererseits befreit er den Text von einer Menge an 
Datenmüll und übernimmt nur sinnvollen Text als Rufzeichen.

13. Router und Firewall (Routers and Firewalls)

Ein Router bietet schon eine Verteidigungsbastion gegen das wilde Internet. Jeder, 
der ins Internet will, sollte einen Router davor schalten. 
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Der Software-Firewall (wie Windows XP-Firewall, Zone Alarm u.a. ) schützen Sie vor 
anderen Rechnern hinter Ihrem Router. Sie können daher einen Windows-Firewall 
bei einem Rechnerverbund in einer Conteststationen im Prinzip abschalten. 

Router bieten Ihnen eine wichtige als Netzwerkadressenübersetzer (Network-
Address-Translation) (NAT) bezeichnete Funktion. Wenn Sie auf Ihren Rechner die 
IP-Adressen 192.168.x.y (oder 10.x.y.z) sehen, sind das interne Adressen Ihres 
lokalen Netzes, die nicht über das Internet geroutet werden können. 

Wenn Sie sich mit einem Laptop in offenen Netzen, z.B. bei einem Starbuck-Cafe 
einloggen, benötigen Sie unbedingt einen Software-Firewall, der Sie vor den 
virenverseuchten anderen Rechnern und dem Internet schützt. Auch wenn Sie im 
eigenen Haus in einem Netz mit mehreren Rechnern arbeiten und z.B. Ihre lieben 
Kleinen alles Mögliche einschleppen, sollten Sie auf einen Firewall nicht verzichten. 
Arbeiten Sie mit einem WLAN, sichern Sie Ihr eigenes Netz mit Paßwörtern und 
einem sicheren Zugriffsverfahren, damit nicht Ihr lieber Nachbar seine Ebay-
Rechnungen über Ihren Computer bezahlt. 

Robert K5PI. 

13.1. N1MM zum Windows-Firewall hinzufügen (Adding N1MM to the 
Windows firewall)

Wollen Sie den internen Firewall nicht abschalten, fügen Sie N1MM zu Ihrer 
Ausnahmeliste hinzu und geben Sie internen Subnetzadressen wie 192.168.1.0 
(255.255.255.0)) als zugelassene Ausnahmen bekannt.  

Last Modification: 31 October 2009 17:18:54 EDT by n4zr. 

Externe UDP-Mitteilungen (External UDP Broadcasts)

Die externen Mitteilungen können von Drittprogrammen für aktuelle 
Contestauswertungen und Übermittlung des Ergebnisstandes an eine Internetseite 
genutzt werden. Die UDP-Mitteilungen bleiben im eigenen Subnetz und gelangen 
nicht direkt ins Internet. Sie sollten auch nur intern verwendet werden. Ein Beispiel 
für die UDP-Meldungen sind das N1MM-Rotorprogramm und das Ergebnis-
Programm.

Es gibt eine größere Anzahl an UDP-Meldungen, sie sind aber kaum für Nutzer 
interessant und es sollen hier nur die wichtigen Meldungen erläutert werden.

1. Hauptprogramm (Main program)

In die Datei N1MM logger.ini können einige Zeile, die sich auf externe UDP-
Mitteilungen beziehen, mit einem Texteditor eingebaut werden. Hinzugefügt wird die 
Sektion [ExternalBroadcast] – falls sie nicht schon existiert. Ein Beispiel ist: 

[ExternalBroadcast] 
DestinationIPs=127.0.0.1 192.168.1.56
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DestinationPort=12060
IsBroadcastAppInfo=True
IsBroadcastContact=True
IsBroadcastRadio=True
Schlüsselwort Kommentar 

DestinationIPs= 

IP-Adresse, zuerst die des eigenen Rechners 127.0.0.1, 
dann weitere IP-Adressen getrennt durch einen 
Zwischenraum. Sie können die Nachricht nur an einen 
Bestimmungsort schicken.

DestinationPort= Zu verwendender UDP-Port. Voreingstellt ist 12060
IsBroadcastAppInfo=True Broadcast Application Info: voreingestellt auf False
IsBroadcastContact=True Broadcast Contact Info: voreingestellt auf False
IsBroadcastRadio=True Broadcast Radio Info: voreingestellt auf False

Die Punkte (dots) im Beispiel für UDP broadcasts sind TAB-Zeichen. 

1.1. IsBroadcastAppInfo=True

Dieser Code wird an den Empfänger (Destination)-Port (12060) geschickt, wenn 
IsBroadcastAppInfo=True in der Sektion ExternalBroadcast in der Datei N1MM 
logger.ini eingestellt ist, und der Select Contest-Dialog mit einem OK 
abgeschlossen wird und ein Contest geladen und auf dem Bildschirm angezeigt wird: 

Example UDP broadcast 
<?xml version="1 .0"?>
<appinfo>
.<dbname>C:\Program Files\N1MM logger\contests-2007.MDB</dbname>
.<contestnr>71</contestnr>
.<contestname>CQWWSSB</contestname>
</appinfo>

1.2. IsBroadcastContact=True

Dieser Code wird nach dem Abloggen eines QSO abgeschickt, wenn in der Sektion 
[ExternalBroadcast] der Datei N1MM logger.ini der Eintrag 
IsBroadcastContact=True steht.  

Example UDP broadcast 
<?xml version="1.0"?>
<contactinfo>
.<contestname>CQWWSSB</contestname>
.<contestnr>71</contestnr>
.<timestamp>22-6-2008 7:04:00</timestamp>
.<mycall>PA1M</mycall>
.<band>14</band>
.<rxfreq>1420100</rxfreq>
.<txfreq>1420100</txfreq>
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.<operator>PA1M</operator>

.<mode>USB</mode>

.<call>K1TTT</call>

.<countryprefix>K</countryprefix>

.<wpxprefix>K1</wpxprefix>

.<stationprefix>PA1M</stationprefix>

.<continent></continent>

.<snt>59</snt>

.<sntnr>233</sntnr>

.<rcv>59</rcv>

.<rcvnr>0</rcvnr>

.<gridsquare></gridsquare>

.<exchange1></exchange1>

.<section></section>.

.<comment></comment>

.<qth></qth>

.<name></name>

.<power></power>

.<misctext></misctext>

.<section>14</section>

.<zone>5</zone>

.<prec></prec>

.<ck>0</ck>

.<ismultiplier1>1</ismultiplier1>

.<ismultiplier2>0</ismultiplier2>

.<ismultiplier3>0</ismultiplier3>

.<points>3</points>

.<radionr>1</radionr>
</contactinfo>

1.3. IsBroadcastRadio=True

Dieser Code wird nach einem Frequenz- oder Transceiverwechsel abgeschickt, 
wenn in der Sektion [ExternalBroadcast] der Datei N1MM logger.ini der Eintrag 
IsBroadcastRadio=True steht. Für RadioNr steht bei SO2R die Transceivernummer 
und bei SO1V/SO2V die VFO-Nummer.

Example UDP broadcast 
<?xml version="1.0"?>
<RadioInfo>
.<RadioNr>2< /RadioNr>
.<Freq>2120000</Freq>
.<TXFreq>2120000</TXFreq>
.<Mode>CW</Mode>
.<OpCall>PA1M</OpCall>
.<IsRunning>False</IsRunning>
</RadioInfo>
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2. Programme, die die N1MMLogger-Nachrichten verwenden (Programs 
using the N1MM Logger Broadcasts)

Als Beispiel sei das folgende Programm angeführt, das die N1MM logger UDP 
broadcasts verwendet: 

Das Freeware-Programm von LA0FA schickt die QSOs von N1MMLogger direkt an 
den DXLab-DXkeeper von AA6YQ: 

http://www.la0fa.com/show_article.asp?Article_ID=48  

ADIF-Info dazu : http://www.dxlabsuite.com/ADIF.htm   

Last Modification: 31 October 2009 11:17:01 EDT by K8UT. 

Außerhalb des offiziellen Programms, aber nett zu wissen (Off 
Topic, But Nice to Know)

In diesem Kapitel finden Sie die Zusammenfassung einiger im N1MMLogger-
Reflektor diskutierten Probleme. Sie gehören nicht unbedingt zum Contestprogramm, 
sind aber durchaus von allgemeinen Interesse. 

1. Stationen doppelt arbeiten oder nicht? (Working Dupes or Not?)

Zu Zeiten der Papierlogs wurde man bestraft, wenn man zu viele Doppel-QSOs im 
Log hatte und diese nicht als solche markiert waren und man Punkte dafür haben 
wollte. Mir ist aber kein Fall bekannt, dass man bestraft wurde, wenn man Doppel-
QSOs im Log hatte, diese aber markiert hat und KEINE Punkte dafür haben wollte.
Es ist schon ein bisschen ironisch, dass es im Cabrillo-Logformat keine Möglichkeit 
gibt, Doppel-QSOs zu markieren. Der Contestveranstalter lässt alle Logs durch sein 
Contestauswerteprogramm laufen und berechnet die Punktzahlen nach seinen 
Regeln, so dass Sie sich über Doppel-QSOs keine Gedanken mehr machen müssen.
Nun zu Ihrer Frage ; ON5ZO  arbeitet 6Y2A, trägt aber BY2A ins Log ein. 6Y2A loggt 
richtig ON5ZO. 6Y2A bekommt das QSO anerkannt, so lange nicht noch ein Log von 
BY2A kommt. Schickt aber BY2A ein Log, das Log wird mit ON5ZO verglichen und 
das QSO nicht gefunden, so wird es gestrichen. Schickt aber BY2A kein Log, bleibt 
das QSO gültig.
Ruft ON5ZO während des Contests 6Y2A noch einmal und nun mit richtigem 
Rufzeichen an, wird er von 6Y2A mit QSOb4 abgewiesen .ON5ZO ist sich keiner 
Schuld bewusst, bei ihm steht ja BY2A. Hätte man bei 6Y2A den Schalter „logge 
DUPES“ auf EIN gestellt, wäre jetzt ON5ZO noch einmal im Log, bei ON5ZO würde 
beim Vergleich auch 6Y2A gefunden und beide bekämen ihre Punkte.

Lassen Sie also ruhig Doppel-QSOs zu. Sie sind dann auf der sicheren Seite und 
überlassen Sie es dem Auswerteprogramm des Contestveranstalters, sie 
anzuerkennen oder auszusortieren.

David Robbins, K1TTT
e-mail: k1ttt@arrl.net
web: http://www.k1ttt.net   
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2. Arten des Funkbetriebs (Types of Operating)

2.1. RUN-Modus (Running)

Hier haben Sie in der Regel nur ein Auge auf neue Multis unter den DX-Spots. Sie 
können die Filter so einstellen, dass Ihnen nur neue Multis angezeigt werden, die Sie 
zwischendurch arbeiten und dann wieder zu Ihrer CQ-Frequenz zurückkehren. 

2.2. S&P-Modus (Search and Pounce)

Sie suchen das Band ab und prüfen jedes Signal, das Sie hören. Hier helfen die 
Bandskalen, in denen Sie eine Station identifizieren und sie als neues QSO, neuen 
Multi oder Dupe einordnen können.  

2.3. Der neue von Packet unterstützte S&P-Modus (The 'New' Packet 
Assisted S&P Mode)

Sie starten an einem Bandende und springen von einem DX-Spot zum anderen und 
arbeiten das Angebot ab. Bei den hohen Melderaten ist dieses Verfahren recht 
effektiv. Speziell für Stationen im SO2V oder SO2R-Betrieb, die auf einem Band CQ 
rufen und mit auf dem anderen Band Multis sammeln, ist es das geeignete 
Verfahren. 

David Robbins, K1TTT 

Eingabe schneller machen (How is Your Typing Speed?)
2.

Ich bin mit CT groß geworden. Wenn Sie dort die Einfg (Insert) – Taste drücken wird 
das Rufzeichen der Gegenstation und der Rapport gesendet.
Um der Gegenstation schneller antworten zu können, gebe ich nur das Prefix ein, 
behalte den Suffix im Kopf, drücke sofort die Einfg-Taste und gebe dann das Suffix 
ein. Die Gegenstation muss nicht warten, bis ich das komplette Rufzeichen 
eingegeben habe und ich komme sofort für sie zurück und ihr Rufzeichen wird auch 
komplett gesendet. Sie sparen eine Menge Zeit und können mehr Station der 
Zeiteinheit arbeiten.
Dieser Trick funktioniert auch im ESM-Modus, Sie können aber unter N1MMLogger 
die Insert-Taste ebenfalls programmieren.

73 es CU in contest!
Franki ON5ZO 

4. Ist GMT gleich GMT? (GMT is GMT, or Not?)

Nein, nicht ganz. Die schmucken Entwickler von Bill Gates hatten Schwierigkeiten, 
die Greenwich Mean Time (GMT) von der Ortszeit in Greenwich zu trennen. Wenn 
Sie Ihren PC auf GMT, das heißt die Ortszeit für  Dublin, Edinburgh, Lissabon, 
London einstellen, haben Sie während der Sommerzeit eine Differenz von einer 
Stunde plus gegen die „echte“ GMT. Wenn Sie diese „echte“ GMT auf Ihrem PC 
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haben wollen, wählen Sie unter Zeitzone GMT für Casablanca und Monrovia, hier 
gibt es keine Sommerzeit-Effekte.

Unter N1MMLogger können Sie Ihren PC aber beruhigt mit Ihrer Ortszeit laufen 
lassen, das Betriebssystem übernimmt, daraus die jeweils richtige GMT zu machen.

73, Rich VE3IAY

5. Sommerzeit in Nordamerika (USA and Canada Daylight Savings Time 
Changes)

Seit 2007 haben die USA & Kanada die Zeit für die Umstellung auf Sommer- und 
Winterzeit geändert. Wenn Sie in einem dieser Länder wohnen, müssen bei Ihrem 
Rechner diese Änderungen vornehmen, wenn Sie die lokale Zeit anzeigen:  

Windows XP: Installieren Sie die neueste Windows XP-Aktualisierung spätestens 
kurz vor der Zeitumstellung (zweites Wochenende im März). Die Änderung erfolgt 
dann automatisch. 

Ältere Windowsversionen (Older versions of Windows): 

• Option 1: Lesen Sie diesen Artikel und ändern Sie Ihr Windows: 
http://support.microsoft.com/kb/914387   

• Option 2: Stellen Sie Ihren Rechner auf die Zeitzone von Casablanca. Dann 
geht er immer nach GMT und es gibt keine Probleme mit der Zeitumstellung. 
Schalten Sie in Ihrem Betriebssystem die Zeitumstellung ab, wenn es dafür 
eine Einstellmöglichkeit gibt.  

• Option 3: Lassen Sie alles wie bisher. Dann wird zwar die lokale Zeit falsch, 
aber die GMT/UTC-Zeit richtig angezeigt und für das Loggen verwendet. 

6. Welchen Monitor verwenden? (Which Monitor to Choose)

Ich mich eine Zeit lang mit dem Monitor-Problem befasst und habe einige Punkte 
gefunden, die einer näheren Betrachtung wert sind:  

Wenn Sie langsam in das Brillenalter kommen, ist die Pixel-Größe fast genauso 
wichtig wie die Schirmgröße. Die meisten 17"- und 19" Monitore sind auf 1280 mal 
1024 eingestellt. Die Differenz zwischen 17" und 19" liegt weniger bei der 
Schirmgröße als bei der Pixelgröße. Die 17"- und 19"-Monitore zeigen die gleiche 
Pixelzahl an, aber beim 19-Zoller sind sie größer. Deswegen empfehle ich einen 19”-
Monitor.  

Weiterhin scheinen mir Breitwand-Monitore für etwa das gleiche Geld die bessere 
Lösung zu sein. Aber beachten Sie: Ein Breitwand-19“-Monitor mit einer Auflösung 
von 1680 mal 1050 hat kleinere Pixel als ein 19“-Monitor mit einer Auflösung von 
1280 * 1024. Stellen Sie sicher, dass Ihre Videokarte so einen Monitor ansteuern 
kann. Mein zwei Jahre alter Dell-PC kann es nicht! 

Die fallenden Preise machen auch Auflösungen von 1600 * 1200 bei 20"- und 21"-
Monitoren interessant. Sie sind in der Regel Breitwand-Monitore. Auch hier 
benötigen Sie die richtige Video-Karte in Ihrem Rechner. 
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Stellen Sie vom analogen Ausgang der Videokarte auf den digitalen Ausgang um. 
Der Text ist schärfer und besser zu lesen. Auch die ClearType-Software von 
Microsoft kann helfen.  

Suchen Sie nach einem Display mit großen Pixeln (0.27mm). Für mich ist dann diese 
Lösung die beste:  

Zwei 19"er Monitore mit einer Auflösung von 1280 * 1024 
Ein 20"er oder 21"-Monitor mit  einer Auflösung von 1600 * 1200 
Ein noch größerer Monitor mit 22" und mehr im Breitformat 

Gerald Boutin, VE6WA 

Last Modification: 31 October 2009 11:38:50 EDT by K8UT. 
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